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1 MechDesigner & MotionDesigner Help -17.1.130

Motion is a concept that you can experience or witness, but you cannot physically

hold. You cannot use eBay® or Alibaba® to buy a motion!

However,  to design a multi-axis machine, you must be able must and weave to-

gether the motions for all of its interacting mechanisms.

There are three ways to represent, edit, and optimize the motions for a machine:

1. List each motion as a series of positions ...see NotePad®, Excel® , ...

Good luck!

2. Plot each motion and its motion-derivatives (P, V, A, J) with a graph ...

see MotionDesigner 

Plot and edit the motion for each machine axis, over a machine-cycle. 

3. Simulate the motions with moving parts ... see MechDesigner 

Simulate a complete machine cycle, with all of its mechanisms synchron-

ized to the master machine axis.

When you can see all of the mechanisms in your machine interact with each other,

it is much easier to see how to improve your design before you start to manufac-

ture critical parts and build a machine.

MotionDesigner and MechDesigner  ...

... together, they are a powerful combination

Mechanisms, Motions, Cams, Mechanisms, Gears, Racks, Ball-

Screws, Pulleys, Belts, ...

Analyze > Scrutinize > Optimize

Note on Intel Graphics-Cards:  MechDesigner will not work with ... ... Intel GPUs

that are integrated with the CPU on Laptops. After you install MechDesigner, you MUST
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make sure you can change the system's or graphic-card's setting to force MechDesigner

to use an nVidia or AMD GPU. 

Reference Help

The instructions for:

MechDesigner Reference and Interface  - to add, edit and analyze the ele-

ments that represent the physical elements in your machines.

MotionDesigner Reference and Interface  - to design the motions for the

mechanisms in your model.

Tutorials on the Web

You need an internet connection to connect to:

MechDesigner Tutorials

MotionDesigner Tutorials 

General Information

System Requirements

Firewall, Virus Checkers, ...

Known Bugs after Latest Release

Text Formatting

Menu / Toolbar ; Commands  - e.g. Kinematic elements toolbar ; Add Part

ELEMENT : objects you add to the model - e.g. 2D-CAM

ELEMENT DIALOG : the interface that we use to edit an element parameters -

e.g. 2D-CAM DIALOG

DIALOG SEPARATOR : click to collapse/expand different PARAMETER groups in a

dialog-box  - e.g. MATERIAL PROPERTIES

PARAMETERS : values that you can edit and options you can select in an ELE-

MENT'S DIALOG-BOX - e.g.  RADIAL-CLEARANCE

SUB-ELEMENT : elements we do not explicitly add, but are in the model - e.g.
START-POINT

Derived-Name : a descriptive name we use for elements  - e.g. rotating-Part

USER-INTERFACE : areas of the working application - e.g. PROJECT-EXPLORER

Important Word : a word in an instruction that is important - e.g. not

PSMotion Ltd © 2004 - 2025 1/30/2025

25

681

13

17

20

http://mechdesigner.support/index.htm?mechdesigner-getting-started-tutorials.htm
http://mechdesigner.support/index.htm?motiondesigner-gettingstartedtutorials.htm
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1.1 System-Requirements, Windows-Settings, ...

System Requirements

Operating System : Windows 7, 10, 11

64-bit only

PC Memory : Minimum : 4 GB of RAM 

Recommended : 8 GB or more

Hard Drive Space : 1GB of available space

Recommended : 20 GB or more - keep your drive

healthy.

Graphics Card : High-performance Graphics Card for CAD or Gam-

ing.

OpenGL 4.5+

Minimum : 1 GB card memory

Recommended : 4 GB card memory

Important Message:

There is a graphics problem with Intel Graphic

Card, particularly on laptops. 

We do not have a solution to this problem. If your

laptop also has a different graphics-card (e.g.

nVidia or AMD), force MechDesigner to use the

other graphics-card. 

Windows Permissions

Installation : Administrator Rights and Internet Connection.

Downloads: Administrator Rights to download latest help

1. Right-click MechDesigner application start icon

 

2. Click Run as Administrator in the contextual-

menu

3. Click Help menu > Download Local Help |

Examples | Tutorials

General Running : You do not need Administrator Rights to use

MechDesigner.

You do need an internet connection, as

MechDesigner check your license with CopyMinder

every week, approximately.
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Recommended Windows Settings

Display Resolution : Minimum : 2560 × 1440 pixels

Recommended : 4K (3840 × 2160 pixels)

Windows D.P.I. : Screen Resolution : 2560 × 1440 pixels, set Windows

DPI to 100%

Screen Resolution : 3840 × 2160 pixels, set Windows

DPI to 150%

Note: To change your screen settings, right-click

your screen desktop, and select Display Settings.

Anti-Virus

PSMotion recommends that you:

· Use a trusted anti-virus product. Update it with the latest anti-virus defin-

ition/signature file. 

· Add exemptions for MechDesigner file-types and folder locations. 

Software Protection

We use CopyMinder® for our software protection. It uses the internet to

check your license details.

· If you have a Trial License, you need to verify an email from verifica-

tion@copyminder.com before you run. You do not need to know the Li-

cense-Key.

· If you have a Standalone License, you need a License-Key. You need the

License-Key to run MechDesigner the first time. Keep the License-Key

safe.

· If you have a Network-License (also called a Floating-License), your I.T.

department needs the License-Key to run an application on the server. 

They should keep the License-Key it safe. 

Uninstall

· If you want to remove MechDesigner completely, then use the Windows

> Uninstall utility.

· You must remove MechDesigner CXL, MTD, ZXL, and LXL file-types

manually.

1.2 File Locations

The default paths are:

<Install Directory>:  C:\Program Files\PSMotion\MDxx Pro64\

<CommonAppData>: C:\ProgramData\PSMotion\

<LocalAppData>: C:\users\<user-name>\AppData\Local\PSMotion\
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<User-name>: for example 'Adam'

File-types and File-Locations

SOLIDWORKS Type Library:

yyyy = SOLIDWORKS release-date. 

<Install Directory>\

SW_TLByyyy_64 \

Database files:

See also: Help menu > Edit Lan-

guage Database

<CommonAppData>\ DBase \

Local Help:

See also: Help menu > Open Local

Help / Download Latest Help

<CommonAppData>\ Help \ 

Library files:

See also:  File menu > Import Library

Files

<CommonAppData>\ Library \ 

Theme and settings:

See also: Edit menu > Application

Settings : Save / Load buttons

<CommonAppData> \ Style \

Example Models: 

See also: Help menu > Internet sub-

menu > Download Example Models

<LocalAppData> \ Examples \

MechDesigner.INI ;

MechDesigner.XML

These two files are your user-settings. If

they get corrupted, MechDesigner can

be unstable. You can delete these at

any time to reset MechDesigner to its

factory settings. 

<LocalAppData> \ Inifiles \

Timing Diagrams: <CommonAppData> \ Timing

Diagram.xlsm

<LocalAppData> \ Timing Dia-

gram.xlsm

Tutorials: 

See also : Help menu > Download

Tutorial Videos

<LocalAppData> \ Tutorials\

*.mp4

CopyMinder Software Protection Text Files:

Email to PSMotion these two files if you have problems with

CopyMinder:

C:\ProgramData\HW\MD32_0_0\cm\mechdesigner.exe.cm.ini

C:\ProgramData\HW\MD32_0_0\cm\mechdesigner.exe.cm.log
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Notes: 

ProgramData and AppData are hidden by default.

To show these paths :

1. Click Start (Windows) > Documents or File-Explorer 

The Documents or File Explorer interface opens.

2. Click the View tab 

3. Click the Hidden Items check-box in the Show/hide group

Be careful. Hidden files are 'hidden' to prevent you accidentally moving

or deleting them and because they are important !

Other Files:

<user account>_*.memopad

The name for the Memo you can add to the Model and Mechanism

name-tabs
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1.3 Firewall, Virus-Checkers, ...

Firewalls, Virus Checkers

Occasionally, your Virus Checker, Firewall, or Network Administrator, may not

allow you to:

· Download MechDesigner from our website

· Install MechDesigner

· Check your License Key and License with the CopyMinder® database

You may need to:

· Restore a MechDesigner file from Quarantine

· Add exception paths

· Add files to trust, to your white-list

· Add IP addresses for the CopyMinder® database servers to your white-list

· Run MechDesigner with Administrator privileges 

Exception Paths

After you install MechDesigner, 

1. Add these paths as exceptions to your Virus Checker: 

· C:\ProgramData\PSMotion

· C:\ProgramData\HW\ - this is the path for CopyMinder® related

files.

2. Add this file as an exception to your Virus Checker:

· C:\ProgramData\HW\MD32_0_0\CM\MechDesigner.exe.cm64.exe

or, for a Trial installation:

· C:\ProgramData\HW\MDTRL\CM\MechDesigner.exe.cm64.exe

CopyMinder Servers

MechDesigner checks your License-Key settings on a CopyMinder® server*

, over the internet.

There are two IP addresses for the CopyMinder® servers*. One is a back-up.

· Primary Server :       89.200.137.136

· Secondary Server:    92.60.122.223

1. Add these two IP addresses to your Firewall white-list. 

* These servers are run by Microcosm Ltd, the developer of the

CopyMinder® software protection system.

Example Norton Notices

Download Insight

https://www.microcosm.com/software-protection/copyminder
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When you install MechDesigner, it is possible that your virus-checker, or

your Windows© settings may decide that a file is a threat.

Please click Run the program anyway.

FIREWALL ALERT : Norton: Suspicious Network Activity.

· MechDesigner.exe may be detected as a threat

· MechDesigner.ex.cm64.exe maybe detected as a threat

Please use Allow Always, or Allow this Instances.
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ACTION REQUIRED: Threat Detected!

If this pop-up shows, then please use the 'Exclude' in the drop-down list

to exclude CopyMinder as a threat.

Norton 'How to restore MechDesigner from Quarantine'

Norton:

1. Open your Norton product 

2. On the main window click Tasks on the Security History option

3. On the opened window click on the menu and select Quarantine

4. On the list, find the file you want to restore - MechDesigner.xxx
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5. Click on More Details 

6. On the new window click on Options (bottom)

7. Click on Restore file

8. Check the Do not detect it again option during the restore

9. Close the windows

1.4 Known bugs after latest release

16.1.338

Laptop with some Intel Graphic-Cards

When does it happen?

1. When you start to add elements after you start MD.

Result

Everything is selected all of the time. You cannot model anything!

Or, You cannot add a new element after the first few.

1. Look in Help > About | Graphics-Card tab. 

If the graphics-card you are using is the Intel GPU, you must change it to

an nVidia or an AMD graphics-card.

You must re-direct your settings, so that it does NOT use the Intel graphics

Card.

For example:

1. Start the NVIDIA or AMD graphics-card control panel (or other high

performance graphic-card control panel) 

2. Change the Preferred graphics processor from ‘Auto Select’ to, for

example, “High-performance NVIDIA processor.”

No other solution.

16.1.336

MechDesigner hangs after you open a Library model.

When does it happen?

1. Open a Library file with File toolbar > Import Library Model

Result

You cannot select anything with your mouse.

The model seems to hang.

Temporary Solution:

1. Press the ALT+C keyboard combination, to cycle the model. 

2. Press ALT+C again to stop the model.

Version when corrected:

Corrected in 16-1-342+
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16.1.328

Lighting - Ambient increases to the Maximum

When does it happen?

1. Add a PROFILE 

2. Enable Show Solids in Mechanism-Editors

3. Disable Show Solids in Mechanism-Editors

Result

The Ambient Lighting increases to a maximum

Solution:

1. Save the model if not already saved 

2. Click the MODEL element at the top of the Assembly-Tree

3. Right-click the MODEL element

The MODEL-OPTIONS DIALOG is now open

4. Drag the AMBIENT LIGHTING SLIDER to almost the minimum.

Version when corrected:

Not yet corrected.

16-1-230

Crash if you drag a FB past a Kinematic-Vector

Release : 16-1-230

Corrected : 16-1-264

Release Date : 15-July-2022

Bug : Drag a Function-Block over a Velocity or Accelera-

tion-Vector and the FB flies along the Vector!

Result : Angry modeller.

Corrected 16.1.250

16-1-146

Blurry elements

Release : 16-1-146

Release Date : 22-March-2022

Bug : Blurry, Smokey Elements?

Details : Especially if you load a Library File. The elements

look 'washed-out', or blurred.

The Ambient Lighting is set to zero.

To correct the Bug: 1. Save the Model 
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2. Right-Click the Model element at the top of the

Assembly-Tree

3. In the Model Options dialog-box > Lighting tab,

increase the Ambient Lighting by sliding its

slider to the right.

16-1-102

Known Bug 1

Release : 16-1-102

Release Date : 04-02-2022

Bug : Blend-Curve Drag-Handles reset Blend-Curve to de-

faults when you lock the Drag-Handle

Details : After you lock a Drag-Handle (double-click to edit,

double-click again to lock), the Blend-Curve Resets

to its default shape.

To correct the Bug: Do not use Drag-Handles, use dialog-box only

Double-Click Blend-Curve to edit and open the dia-

log.

15-1-58

Known Bug 1 - corrected 16-1-120

Release : 15-1-50

Release Date : 10-October-2021

Bug : Theme - not saved after you run MD the first time

ever.

Details : When you run MechDesigner the first time, you are

asked: Do you want to use the Dark theme?

If you answer Yes, you will see the Charcoal Dark

Slate theme, which is the Dark theme.

However, the next time you run MechDesigner, you

will actually see the Windows10 theme, which is a

Light theme.

To correct the Bug:  Do :

1. Edit menu > Application-Settings > General

tab > Themes

2. Select the Charcoal Dark Slate theme in the

drop-down box

3. Restart MechDesigner.
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Known Bug 2

Release : 15-1-50

Release Date : 10-October-2021

Bug : Solids are active the first time you run

MechDesigner

Details : When you Add a Mechanism-Editor, a Plane hides

the axes of the Base-Part.

The Planes show when Visibility toolbar > Show

Solids in Mechanisms is active.

To correct the Bug:  Do :

1. Add a MECHANISM-EDITOR 

2. Deselect Visibility toolbar > Show Solids in

Mechanisms 

3. Save the model with File menu > Save as

4. Restart MechDesigner.

Known Bug 3

Release : 15-1-50

Release Date : 10-October-2021

Bug : Display menu > Show / Hide elements 

Details : After you use Display toolbar > Hide 'element'

Toggle Switches to Hide elements, they do not

show when you click the same button to Show the

element again.

To correct the Bug:  Do : If the elements do not show again:

1. Click the MODEL NAME-TAB 

2. Click the Mechanism name-tab again.

OR

3. Start the PART-EDITOR

4. Exit the PART-EDITOR

Known Bug 4 - corrected 16-1-100

Release : 15-1-50

Release Date : 10-October-2021

Bug : Delete a Joint will also delete Motion-Dimension

FB, even though the joint is not associated with the

Motion-Dimension FB
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Details : Delete a Joint (from a Line) that is not associated

with a Motion-Dimension FB, the Motion-Dimen-

sion FB is also deleted!

To correct the Bug:  No way out! 

Add the Motion-Dimension FB again - sorry.

This should be corrected in the next release - Cor-

rected in MD16.

Known Bug 5

Release : 15-1-50

Release Date : 10-October-2021

Bug : If a Plane references a Line, and you edit the Posi-

tion of the Line, the Plane does not move to the

new location of the Line.

Details : To build 3D models, you will often want to add a

Plane to a Line.

If, later, you want to move the Line and the Plane,

the Plane does not move.

To correct the Bug: 1. Edit the PLANE element that references the

LINE. 

The PLANE DIALOG-BOX is now open.

2. Edit one angle from ROTATE THE X, Y, OR Z-

AXIS parameters

3. Immediately return the X, Y or Z-axis to its

original angle

4. Click  to close the PLANE DIALOG-BOX

This bug should be corrected in the next release
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1.5 MechDesigner Reference & User Interface

User Interface - Visual Reference

Menus and Toolbars

NEW - Shortcut Menu: commands and toggles that you may use

many times.

Menus- with the commands in a pseudo-ribbon, at the top of the applica-

tion window.

Toolbars - above, below, left, and right of the workspace . 

The active Menus and Toolbars are also contextual to the active editor.

Notes: You can show the Menus only, Toolbars only, or both - see Applica-

tion-Settings > Accessibility tab > 

Workspace

The workspace is the graphics-area with its name-tab.

There are three editors. Each editor has the same workspace.

· Model-Editor  

· Mechanism-Editor

· Part-Editor

You add different elements to each editor, to build your model.

Project-Explorer is to the left of the graphics-area.

It is a summary of the element in your model.

See more: Project-Explorer

Feedback-Area is below the graphics-area.

79

88

257

308
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It provides messages, hints, Slider to move your model to different posi-

tions in the machine cycle.

See more: Feedback-Area  

MotionDesigner is docked (default) to the right of the graphics-area. 

See more: MotionDesigner  

Memo : a memo opens when you start MechDesigner the first time. 

To turn the Memo off, deselect the OPEN AUTOMATICALLY AT START check-box at

the bottom and left of the memo form.

See more: Memo  

1.5.1 Keyboard-Shortcuts

Keyboard Shortcuts

ZOOM SCROLL-WHEEL

Zoom-In : 

Zoom-Out :  

The center of the Zoom is at your mouse-

pointer. 

PAN

If I want to move PAN - say to the right - I place my mouse-pointer to the

right, Zoom-Out with my Scroll-Wheel, then move my mouse-pointer to the

middle and Zoom-In again with my Scroll-Wheel - this is frequently easier.

Pan : CTRL + Drag

PAN Left or Right : CTRL + (scroll wheel)

PAN up or down : SHIFT + (scroll wheel)

SPIN

Free-Spin : SHIFT + Drag 

10º spin :  ,  ,  or  

30º spin :  CTRL +  ,  ,  or  

90º spin : SHIFT +  ,  ,  or  

Mouse-Button Shortcuts

Double-Click : ... an ELEMENT, if the element has a dialog, open its dialog,

and edit its parameters, .

Click : ... an ELEMENT, to show the element in the SELECTION-WIN-

DOW.

326
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CTRL + Click : ... an ELEMENT, to show the kinematic and dynamic proper-

ties of the element in the ELEMENT-PROPERTIES DIALOG.

Alt + Click : ... in the graphics-area, to show a bulls-eye target of con-

centric rings. It has a scale to approximate the distance

between elements - to a minimum of 0.1mm - if you look

closer than 0.1 mm you should always check the actual di-

mension with a MEASUREMENT FB

Right-Click : ... an ELEMENT, to see the shortcut menu that is contextual

to the ELEMENT

Right-Click : ... an ELEMENT, to complete the active command in the
COMMAND-MANAGER

Right-Click : ... the graphics-area, to cancel the active command, or

complete the command if there are ELEMENTS are in all

Selection-Boxes in the COMMAND-MANAGER 

Right-click : ... the graphics-area, to see the shortcut menu for each ed-

itor-type.

Keyboard Shortcuts

F1 : Hover over a toolbar icon, then press the F1 key (FN+F1 on

a laptop) to read the help for the command.  See also Help

menu > Download Latest Help

INSERT : Press to start the Add Part command

ALT+C : Continuous Cycle

ALT+F : One Machine-Step Forward

ALT+B : One Machine-Step Backward .

ALT+H : Stop Continuous Cycle and move the MASTER-

MACHINE-ANGLE to 0º.

CTRL + Z : Undo - This is quite powerful

ESC : Cancel the active command

58
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1.5.2 Known-Bugs

16.1.386

Spin-Boxes in MotionDesigner

When does it happen?

When you open the Segment Editor or the Blend-Point Editor, the Spin-

Box tool does not show in the Motion-Value data-boxes

Result

Nothing

Solution:

In each data-box that does not show the Spin-Box tool:

1. Double-click, and 

2. Double-click, again.

Version when corrected:

It is weird, and we are not sure why this happens.

16.1.386

Continuous Crank Fails if the motion ...

When does it happen?

If the Motion of the Tool-Part has a dwell that is not at the maximum or

minimum of its motion-range, then the CONTINUOUS-CRANK FB will

not work as expected. 

Result

The Crank changes to the incorrect length.

Temporary Solution:

None

Version when corrected:

Coming Soon

16.1.336

Hangs after Importing Library Model

When does it happen?

1. Open a Library file with File toolbar > Import Library Model

Result

You cannot select anything with your mouse.

The model seems to hang.

Temporary Solution:

1. Press the ALT+C keyboard combination to Cycle the model.

2. Press ALT+C again to stop the model cycling.
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Version when corrected:

16.1.342

16.1.336

SOLIDWORKS 2018.

When does it happen?

Help about > Type Libraries are SOLIDWORKS 2018 - and all good to go.

1. Start SOLIDWORKS 2018, and open a Part document. 

2. In MD: Edit a CAD-LINE 

3. Import SOLIDWORKS document...crash

Result

Will not open a SW2018 document - my 16-1-336 tries to activate

SOLIDWORKS 2020!

Temporary Solution:

None - can you use a different release of SOLIDWORKS?

Version when corrected:

16-1-342 - not yet released.

16.1.328

Lighting - Ambient increases to the Maximum

When does it happen?

1. Add a PROFILE 

2. Enable Show Solids in Mechanism-Editors

3. Disable Show Solids in Mechanism-Editors

Result

The Ambient Lighting increases to a maximum

Solution:

1. Save the model if not already saved

2. Click the MODEL element at the top of the Assembly-Tree

3. Right-click the MODEL element

The MODEL-OPTIONS DIALOG is now open

4. Drag the AMBIENT LIGHTING SLIDER to almost the minimum.

Version when corrected:

Not yet corrected.
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1.5.3 1: Menu bar and General Toolbars

NEW in MD17 - Quick Access Tools

NEW (MD17) Quick Access menu for frequently-used commands

NEW (MD17+): The Quick Access toolbar are above the menu bar. It shows al-

ways.

Menu bar and/or Toolbars

New options in MD17+: 

You can choose to show :

· Menu bar only (MD17 style) - an icon and short hint for each command in

a pseudo ribbon

OR

· Toolbars only (MD16 style) - an icon for each command in a toolbar that

you can expand and collapse

OR

· Menu bar (MD17 style) AND Toolbars (MD16 style)

See Application-Settings > Accessibility tab .

 Menu bar

Menu bar and File commands

If you show the menu bar, 

· the commands in File, Edit, Filters, View, Internet, and Help are common

to most CAD applications.

· the commands in Function-Blocks , Mechanism , Geometry ,

Forces , MD-Solids , Visibility , Run  are those that you use to

build and cycle your MechDesigner model. 

· the menus that are active are a function of the editor-type.

General toolbars

If you show toolbars: 

· the General toolbars are directly above and below the graphics-area. 

· the toolbars are collapsed when you start MechDesigner. 

57

165 90 257

226 239 60 58
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General toolbars ABOVE the graphics-area

General toolbars BELOW the graphics-area

1.5.3.1 File

File

The File menu and toolbar provide the tools to manage your model files.

File menu

If you show menus: 

MD17 - File menu

File toolbar

If you show toolbars, the File toolbar is ABOVE the graphics-area.
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File toolbar 

1.5.3.1.1  File | New

File > New

Start a new model.

File menu > New

File toolbar > New

Notes:

Shortcut:

CTRL+N

If the active model is different from the model on your hard drive, you must

decide what to do before you start the new model.

Yes: Save the active model and

start a new model

No: Do not save the active model

and start a new model

Cancel: Do not save the active

model and do not start a new

model

1.5.3.1.2  File | Open

File > Open

Open a model that is on your hard-drive.

File menu > Open

File toolbar > Open
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When you enable Auto-Save , we save your model after 10 commands (de-

fault). 

To make sure you do not overwrite an important model, either 

· Disable Auto-Save, or

· Save the model to a new file-name.

Open these file-types:

CXL

The CXL is the file-type for the MechDesigner model.

The MTD is the file-type for the MotionDesigner motions. 

The CXL and the MTD file-types should be in the same-path.

OLD MODELS: MechDesigner may find a sketch-element that is over-con-

strained.

A pop-up asks you if we can delete for you the constraint so that we can

solve the sketch. Click YES if you want to open the file! Check important

sketches after you open the model, then save the model again.

See also: Why so many CXL and MTD files?

LXL

LXL - the file-type for a Library file.

There are three options when you open a Library file. 

· Preselect a Plane - the Library file adds a new MECHANISM-EDITOR.

The model in the Library file opens on the XY-Plane of the new MECH-

ANISM-EDITOR.

· Preselect a Part - the Library file opens on the PART. The Library file is

a child to the PART.

· Preselect nothing - the Library file is opened and merged with the

active MECHANISM-EDITOR.

See more: Open LXL File

See also: Save as > LXL file-type

ZXL

ZXL - the file-type for a MechDesigner ZIP file - see Save as > ZXL

The file-types that may be in a ZXL file are:

· CXL and MTD

· STL, SLDPRT, SLDASM

· DXF

Note:

You can choose the path to which you want to extract ZXL file-types:

341

638

35

39

40
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See: Application Settings | General tab |  FILE OPTIONS > Extract ZXL

files to : 

¤ CREATE SUB-DIRECTORY AUTOMATICALLY - All files extract to a sub-dir-

ectory to the ZXL file.

¤ SPECIFY ZXL OUTPUT DIRECTORY - enter the path for the files.

I prefer SPECIFY ZXL OUTPUT DIRECTORY. I usually extract the files the same

path as that of the ZXL file itself. You can also select or make a new path.

See more: File menu > Save as > ZXL file-type.

DXF

When you open a file of the DXF file-type you add a DXF-ELEMENT to the

ASSEMBLY-TREE as a child to the MODEL. The DXF ELEMENT is a container for

one DXF-Drawing. 

MD17+ :The name of the DXF-ELEMENT in the ASSEMBLY-TREE in now the

name of the DXF-Drawing.

You must link the DXF-ELEMENT to a CAD-LINE to show the DXF-Drawing in

the graphics-area. Thus, to show the DXF-Drawing, do:

STEP 1. File > Open > DXF file-type to add a DXF-ELEMENT to the

ASSEMBLY-TREE. 

STEP 2. Edit a CAD-LINE (that is a child to a PART) to open the CAD-LINE

DIALOG

STEP 3. In the CAD-LINE DIALOG > DXF tab, select the DXF-ELEMENT

The DXF-Drawing shows in the graphics-area. 

See more: CAD-Line dialog > DXF tab  

MEC [Camlinks]

MEC is a Camlinks file-type.

See more: Open MEC files

341

341

39
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1.5.3.1.2.1  Open LXL file-type

File > Open > LXL file-type

See also Save as Library File .

See also > NEW in MD16 Import Library File

To open a Library File with File > Open

1. Click to select a PLANE, a PART; or select Nothing: 

If you:

· Select a Plane - the Library file opens onto a new Mechanism-Editor

as a child to the Plane 

· Select a PART - the Library fie opens onto the PART as a child to the

PART. 

· Select nothing - the Library fie opens and merges with the active

MECHANISM-EDITOR.

2. Click File > Open 

The Windows® File Open interface starts.

3. In the Files of type drop-down, select Library files (*.LXL) 

4. Select, a Library File 

5. Click the Open button

You should now see the Library file as a new MECHANISM-EDITOR, as a child

to a PART, or merged with the active MECHANISM-EDITOR.

39

45
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1.5.3.1.2.2  Open DXF File

File > Open > DXF file-type

Do File menu > Open > DXF file of type to add a DXF-ELEMENT to the

ASSEMBLY-TREE. 

The DXF-ELEMENT in the ASSEMBLY-TREE is the container for the DXF-Draw-

ing.

The DXF-ELEMENT does not show the DXF-Drawing in the graphics-area.

To show the DXF-Drawing, you must edit a CAD-LINE and, in the CAD-LINE

DIALOG > DXF tab, link the DXF-ELEMENT and DXF-Drawing to the CAD-LINE. 

See CAD-Line dialog > DXF tab

To show/display a DXF-Drawing:

STEP 1 : File menu > Open > DXF file-type

1. Click File menu (or toolbar) > Open 

Make sure the File of type filter is .DXF

2. Browse to a DXF file-type

3. Click the Open button

A DXF-ELEMENT shows in the ASSEMBLY-TREE.

The element-name of the DXF-ELEMENT is the file-name of the DXF-

Drawing.

STEP 2 : Show the DXF-Drawing

1. Edit a CAD-LINE to open its CAD-LINE DIALOG 

2. Select the DXF tab

3. Select the DXF-element

See CAD-Line dialog > DXF tab 

Options 

Edit the DXF-ELEMENT in the ASSEMBLY-TREE to:

· Link the DXF-ELEMENT with a different DXF-Drawing file

· Select the units of the DXF-Drawing. Usually, select the units of the

original DXF-Drawing.

See also: DXF-Element dialog  

Top-Tips

In your original CAD software, before you save the DXF-Drawing:

· Use (or equivalent): Remove Hidden Lines

· Use (or equivalent): Hide Tangent Edges, Remove Tangent Edges

Finally:

· Save the DXF-Drawing as Release 12 or as early as possible.

371
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1.5.3.1.2.3  Open MEC file-type

Why we recommend that you re-build Camlinks models in MechDesigner. 

· You will remember your design decisions.

· We must add elements from the Camlinks model that you do not need in

the MechDesigner model.

· We cannot support you with your Camlinks models. 

· We want to help you use MechDesigner.

· We can guarantee MechDesigner will run with Windows® 10, 11, ... .

· We cannot guarantee that the MechDesigner will represent the Camlinks

model in every respect.

· We continue to improve MechDesigner in many new ways.

IMPORTANT: LOCKED-POINTS: After you open a .MEC file, Points in the model

you import are LOCKED.

To edit the Position of a Locked-Point:

1. Double-click the Locked-Point to open the POINT PROPERTIES DIALOG  

2. Click PART COORDINATES (READ-WRITE) and 

3. Edit the x and y values

To add and edit dimensions to edit the Position of the a Point:

1. Double-click the LOCKED-POINT to open the POINT PROPERTIES DIALOG  

2. Click PART COORDINATES (READ-WRITE)

3. Click EDIT IN PART-EDITOR radio-button 

4. Click  to close the dialog.

5. Edit the PART in the PART-EDITOR in the normal way.

History Note for Camlinks, and Camlinks Import Limitations.

MOTION: Camlinks4 vs Camlinks3

1. 'Camlinks4': Mechanisms and motions are a MEC file-type. The motions

were defined with segment and motion parameters. Open a 'MEC' file in

MechDesigner to recreate the motions with motion segments in Mo-

tionDesigner.

2. 'Camlinks3': Mechanisms and motions use also a MEC file-type. However,

motions were defined with a list of numbers. Open a 'MEC' file in

MechDesigner to recreate the motion, but with a Z Raw Data List Seg-

ment-Type in MotionDesigner.

3. To help you recreate the motion design (with segments), save the Z Raw

Data List Segment-Type, and use the Overlay Motion tool to design a

new motion MotionDesigner: Overlay Trace.

Throw Motion-Law

These are available in Camlinks but not imported into MotionDesigner.

However, it is possible to design the Throw Motion-Law with two(2) seg-

ments and the correct Blend-point Control Button conditions. We can give a

Video on request.

543
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Auto-Adjust

Auto-Adjust is not recreated. However, we have a better tool, which we call

Magnetic-Joint .

View Outline On/Off as a Function of the Master Machine Angle

MechDesigner uses the Pattern Element - Release 7+

Camlinks Outlines

Camlinks Outlines are DXF-Drawings that you have imported onto Parts in

Camlinks. The lines and arcs in the DXF-Drawing were converted to 'Camlinks

Outlines'. They were 'dumb'. You could not edit them in Camlinks. 

When you open a Camlinks file with 'Outlines' in MechDesigner, you have

three options available. See below .

SSR

We do not import these dyads. 

You can design the SSR and SSP dyads in MechDesigner.

RamR and RamP Dyads

We do not import these dyads. If you use these dyads, MechDesigner will

crash (23-03-2013).

Forces, Forcebars, Torquebars

Use MechDesigner to add and show forces and torques in your kinematic-

chains.

Cams

When a Follower-Roller has 0mm diameter in Camlinks – to define the Pitch-

Center of the Cam – MechDesigner will re-define it as 0.1mm, not as 0.0mm.

You must edit the 0.1mm dimension to make it equal to the real Follower

Radius. Then, to show the Pitch-Curve, use the Pitch-Circle-Path check-box in

the 2D-Cam dialog .

1.5.3.1.3  File | Save

File > Save 

Save your model to your hard-drive.

File menu > Save

File toolbar > Save

If the model does not have a file-name, the Save as dialog  opens.

Notes:

Keyboard Shortcut: 

CTRL+S

We always save two files:

99
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· CXL - for the MechDesigner model

· MTD - for the MotionDesigner motions 

Note: 

Auto-save starts only when the model has a file-name. 

MOTIONDESIGNER. 

You can save motions with:

MotionDesigner > File toolbar > Save Active Motion, or Save all Mo-

tions, or Save as.

See also: 

File menu > Save as  

Edit menu > Application-Settings > General Tab > File Options: Auto-

Save

1.5.3.1.4  File | Save as

File > Save as

Save your model to your hard-drive with a new file-name and/or file-type.

File menu > Save as

File toolbar > Save as

Save as:

CXL

We always save two files:

· CXL file-type for the model in MechDesigner.

· MTD file-type for the motions in MotionDesigner.

LXL

See also: Open Library File , Import Library File  and User-Library Direct-

ory

The LXL file-type is a Library File. 

In the Save as dialog:

1. Browse to a path - typically the User-Library Directory.

2. Select Save as Type: Library Files (.lxl) 

3. Enter a file-name

Note: 

You cannot save the model in the active MECHANISM-EDITOR to an LXL

file if the active MECHANISM-EDITOR has a child MECHANISM-EDITOR 

39
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The Library List of Non-relatives dialog shows when you cannot save the

LXL file.

ZXL 

IMPORTANT - save any SOLIDWORKS documents that you have imported

onto a CAD-LINE and exit SOLIDWORKS before you do File > Save as a ZXL

file-type.

Note:

You can also use Win-Zip® to un-zip a ZXL file.

You should save the model as a CXL file-type before you save it with the

ZXL file-type.

We add these file-types to the ZXL file when they are in the model:

· SLDPRT*

· SLDASM*

· STL

· DXF 

· TXT (used with a Point-Cloud).

Save as ZXL file-type - to include SOLIDWORKS documents

When the ZXL save interface opens, you can choose to select:

þ Select all

þ Select STL files

þ Select SOLIDWORKS files

Click  to close the interface and save the ZXL file.

DXF
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The DXF file we save for you has the CAD-LINES, LINES, ARCS, and PART-AXES. 

Save these elements in one PART or all PARTS in a MECHANISM-EDITOR:

1. Click, in the ASSEMBLY-TREE, a MECHANISM ELEMENT OR a PART ELE-

MENT 

The MECHANISM or PART element must show in the SELECTION-WINDOW.

2. Click File menu > Save as 

3. Select DXF as the File of type

4. Enter a file name.
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1.5.3.1.5  File | Print

File > Print

See also : Printer Setup

Click File toolbar > Print

OR

Click File menu > Print

Use to:

· Print a screenshot of the graphics-area.

· Save a screenshot of the graphics-area as a JPG, BMP, PNG, or GIF file-

type.

The screenshot is a 1:1 scale of the graphics-area. 

Re-size the graphics-area to increase or decrease the area of the screenshot. 

1.5.3.1.6  File | Printer Setup

File > Printer Setup 

See also: Print  

Click File menu > Print Setup

Use the Windows® dialog to select the Printer name, and other Printer proper-

ties.

Print Setup dialog

1.5.3.1.7  File | Movie

File > Movie

See also Movie dialog

Click File toolbar > Movie

42
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OR

Click File menu > Movie

The movie dialog opens immediately.

See Movie dialog  

Notes:

Use the MOVIE DIALOG to: 

· edit the size, position, and number-of-frames to record as a movie

· browse to a path and enter a file-name for the movie

You can record and save:

· a movie as a GIF file-type

OR 

· a sequence of images as JPEG, JPG, PNG, and BMP file-types

We append for you a number to each image. The numbers are 000, 001,

002, ... 

OR 

· save one image as a snapshot of the model.

Notes:

The GIF format produces a large file when the size and the number of

frames are large.

Top-Tip - Before you start the Movie command, move the Master-Machine-

Angle to zero(0).

1.  Run menu > Home 

OR 

1. Use the ALT+H keyboard shortcut. 

1.5.3.1.8  File | Save Timing Diagram

File menu> Save Timing Diagram

When you save a Timing Diagram:

· Each motion has a Motion name-tab 

· The graphs are above each other.

· There is a straight-line between the position values of each BLEND-

POINT.lines between the position values of each BLEND-POINT in the Mo-

tion.

How to export and show a Timing Diagram in Excel

STEP 1: MechDesigner - Save the Timing-Diagram.

A: Do: File menu > Save Timing Diagram

605
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We save for you a CSV file-type with the data to display a timing

diagram with the Excel® workbook: Timing Diagram.xlsm - see STEP

2, below

We save the:

· MOTION NAME 

· BLEND-POINT: X-axis and Y-axis position values 

We do not save the:

· Motion-Law (Cam-Law)

· Motion derivative data

STEP 2: Microsoft Excel

A. Open the Excel Macro-Enabled Worksheet: Timing-Diagram.xlsm 

Timing Diagram.xlsm is located in:

 <LocalAppData> \ TimingDiagram.xlsm

and

<CommonAppData> \ Timing Diagram.xlsm

B. If necessary, enable macros 

There are two buttons on the Motion data worksheet.

C. Press button 
1: Open Timing Diagram.csv File 

 

Find, and open, the CSV file you have saved to your hard drive with

MechDesigner : File menu > Save Timing Diagram - see STEP 1,

above

NOTE - reformatting maybe required: 

The format of the Y-axis of Motion0 moves the plot of the Timing-

Diagram slightly to the right.

Change the format of all numbers with Excel > Home tab > Gen-

eral group > Format drop-down box to “GENERAL”. 

D. Press button  
2: Create Timing Diagram 

 

E. Look at the worksheet Timing Diagram to see the timing diagram for

each motion.

See Note in “C.” if the format of the Y-axis of Motion0 is not correct.
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Typical Timing Diagram with 2 Motions

1.5.3.1.9  File | Import Library Model

File menu > Import Library File

A Library-File is a model to import as a new MECHANISM-EDITOR, or merge

with the active MECHANISM-EDITOR. 

A Library-File has the LXL file-extension. 

Use the Import Library File interface to review the Library File before you im-

port it.

See also: 

File menu > Open > file of type .LXL

File menu > Save as > Save as type .LXL

Warnings

Warning 1: You cannot undo Import Library File. 

Warning 2: If you import a Library file as a new model, Auto-save  only

starts after you save the model to your hard-drive. 

To Import a Library File:

STEP 1: Click to select the Model-Editor, or Mechanism-Editor, or edit a

Part

Model-Editor: To add the Library File to a new MECHANISM-EDITOR on

the Front PLANE.

Mechanism-Editor: To merge the Library File with the active MECHAN-

ISM-EDITOR. 

Remember, you can add a MECHANISM-EDITOR to a PLANE that refer-

ences a moving LINE in a PART - see Add Plane to Line

Part: If the Library File is Geometry ONLY, then edit a PART to import

the Geometry onto the PART.

STEP 2: File menu or toolbar > Import Library-File

32
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The Import Library File interface  opens.

STEP 3: Use the Import Library File interface (see below) to open a

Library file: 

Standard Library - PSMotion provides these Library files.

When you select a Library file from the Standard Library, you see:

- an image that is a preview of the Library-File 

- a note that describes the function of the Library File and which di-

mensions or parameters to edit.

User Library - to open a Library-File that you have saved to your User

Library Path 

To edit your User Library Path, see Application-Settings > General

tab > File Options .

See also: File menu > Save as > library-file .lxl

STEP 4: Click the LOAD button 

The Load button is at the upper left of the Image window. 

We load the Library File immediately into the Mechanism-Editor or Part

- see STEP 1

STEP 5: Click   to close the dialog 

Click   at the top right of the dialog

Import Library-File interface and User Library Files

46
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Import Library File interface

User Library Files:

 User Library - Library files that you save to your User Library Path or

its sub-paths, with File menu > Save as > file-of-type .LXL.

When your Library file needs a motion, save the motion from Mo-

tionDesigner > File toolbar > Save Active Motion to the same path

as the Library file

Optional - but very helpful:

To get the maximum use from your User Library and the Import

Library-File interface, add these files to your User Library Path or sub-

path:

 LibraryFilename.PNG - an image - ideal size is 480 x 360 that is a

snapshot of the model in the Library file. 

To save a 480×360 image, use File menu > Movie : File-type:

PNG ; File-path: User Library Path ; Frame Size: 430 × 360 ; Press

SINGLE SHOT button.

 LibraryFilename.RTF - typically, use Word® to describe the function

of the model, and what to edit with a Design-Set  

 LibraryFilename24.PNG - an icon that is to the left of each Library-

File

Use an image-editor to make an image that has exactly 24x24

pixels, with a transparent background.

42
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1.5.3.1.10  File | Exit

File > Exit

To close MechDesigner.

If the model has changed since you last saved it, the Information box shows:

Click:

Yes: Save the active model.

No: Do not save the active model.

Cancel: Do not save the active

model and do not exit.
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1.5.3.2 Edit

Edit

The Edit menu and the toolbar provide the tools to manage settings, ele-

ments, and the status of your model.

Edit menu

Edit menu - MD17

Edit toolbar

The Edit toolbar is ABOVE the graphics-area.

Edit Toolbar

1.5.3.2.1  Edit | Auto Rebuild

Edit > Auto Rebuild

See also Rebuild Now

Auto Rebuild is a toggle button.

Auto-Rebuild - enabled 

The model should be up-to date - see also Top-Tip below.

However, it is slower to add new elements when the model is large or

complex.

Auto-Rebuild - disabled

The model will not be up-to-date. It will not rebuild with all com-

mands - see also Top-Tip below

However, it is faster to add new elements

50



50

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Top-Tip

To make sure a complex model is up-to-date:

1. Click Rebuild Now . 

2. If enabled, click to disable Auto Rebuild, and then click again to enable

Auto-Rebuild.

3. Move the Master-Machine-Angle to 0. Do ALT+H or Run menu >

Home.

4. Edit a PART, then exit the PART-EDITOR. This also rebuilds the model.

5. If there is a 2D-CAM in the model, edit the 2D-CAM, then close the 2D-CAM

DIALOG.

6. Click Rebuild Now  again.

1.5.3.2.2  Edit | Rebuild Now

Edit > Rebuild Now

See also Auto Rebuild

The Rebuild Now button has two states. 

The two states of the Rebuild Now button are:

Model is up-to-date

The state of the Rebuild Now button (and the “fort” icon) when the

model is up-to-date.

Model is not up-to-date

The state of the Rebuild Now button (and the “fort” icon) when the

model is not up-to-date.

1. Click Rebuild Now to rebuild the model (and the fort).

Top-Tip

To make sure a complex model is up-to-date:

1. Click Rebuild Now 

2. If enabled, click to disable Auto Rebuild , and then click again to en-

able Auto-Rebuild.

3. Move the Master-Machine-Angle to 0. Do ALT+H or Run menu >

Home.

4. Edit a PART, then exit the PART-EDITOR. This also rebuilds the model.

5. If there is a 2D-CAM in the model, edit the 2D-CAM, then close the 2D-CAM

DIALOG.

6. Click Rebuild Now again.

50
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1.5.3.2.3  Edit | Command History

Edit > Command-History

Use the Command-History dialog to undo or to redo more than one com-

mand at a time. 

To open the Command-History dialog:

1. Click Edit toolbar > Command History 

or

1. Click Edit menu > Command History 

The Command-History dialog is now open.

See also: 

Undo

Redo

Command-History dialog

Command-History dialog

The most recent command is at the

top of the list. 

To Undo commands:

1. Select a command in the list

2. Click YES to con-

firm you want to

undo the com-

mands.

Wait until we undo

the commands.

55
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Command History dialog

To Redo commands:

1. Select a command in the list

of undone commands

Wait until we redo the com-

mands.

Warning: 

If you do a new command before

you Redo command, the new

command will be at the top of

the list.

Then, you cannot redo the ori-

ginal commands.
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1.5.3.2.4  Edit | Edit Element

Edit > Edit element

Note: You cannot edit all element-types - for example, you cannot edit a LINE.

To edit an element:

1. Click the ELEMENT in: 

· the graphics-area, or

· the ASSEMBLY-TREE, or 

· the SELECTION-WINDOW  

2. Click Edit toolbar > Edit Element 

OR

2. Click Edit menu > Edit Element 

When it is possible to edit the element-type, the dialog to edit the ELEMENT is

now open.

See also: 

Delete element

Rename element

How to open a dialog

310
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1.5.3.2.5  Edit | Delete Element

Edit > Delete Element

Delete element commands:

Click Edit toolbar > Delete element

OR

Click Edit menu > Delete element

You can also use the Delete key on your keyboard.

How to use the Delete element command.

To delete elements with Edit menu > Delete element:

1. Click one or more elements in the graphics-area 

OR

2. Click one element in the ASSEMBLY-TREE

One or more elements are now in the SELECTION-WINDOW.

To delete ALL of the elements that are in the SELECTION-WINDOW:

2. Click Edit toolbar > Delete Element 

If there are dependent elements, the Delete Dependent elements

opens.

Be careful! Only click  in the Delete Dependent element form if you

are sure.

To delete ONE of the elements that is in the SELECTION-WINDOW:

2. Click in the SELECTION-WINDOW  the element that you want

to delete. 

3. Click Edit toolbar > Delete Element

If there are dependent elements, the Delete Dependent elements

opens.

Be careful! Only click  in the Delete Dependent element form if you

are sure.

Notes:

· You cannot delete an element that is in a DESIGN-SET . You must re-

move the element from the DESIGN-SET before you can delete it from the

model.

· You cannot delete a 2D-CAM after you add to it a POLYLINE. You must

edit the Cam-Part to delete the POLYLINE, then you can delete the 2D-

CAM from the model.

617
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1.5.3.2.6  Edit | Undo

Edit > Undo

To undo commands:

Click Edit toolbar > Undo

OR

Click Edit menu > Undo

The most recent command is now undone.

Click Undo again to undo another command.

See also: 

Command History , Redo

Notes: 

· Keyboard shortcut: CTRL+Z

· To redo  a command, do not do a new command.

1.5.3.2.7  Edit | Redo

Edit > Redo

To redo commands you have undone:

Click Edit toolbar > Redo

OR

Click Edit menu > Redo

The command that you have undone is now redone.

See also: 

Command History , Undo

Notes: 

· Keyboard shortcut: CTRL+R

· To redo  a command you have undone, do not do a new command.

51 55

55

51 55

55



56

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.3.2.8  Edit | Machine-Settings

Edit > Machine-Settings 

Machine-Settings: MACHINE-SPEED (RPM), NUMBER-OF-STEPS in a Machine-

Cycle, and the ENGINEERING UNITS.

See Machine Settings dialog

To open the Machine-Settings dialog:

Click Edit toolbar > Machine-Settings

OR

 Click Edit menu > Machine-Settings

The MACHINE-SETTINGS DIALOG is now open.

351
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1.5.3.2.9  Edit | Application-Settings

Edit > Application Settings

Application Settings: colors, number-formats, element sizes, ... and many

more settings.

See Application-Settings dialog  

To open the Application-Setting dialog:

Click Edit toolbar > Application-Settings 

OR

Click Edit menu > Application-Settings 

The APPLICATION-SETTINGS DIALOG is now open 

Notes: 

When you exit MechDesigner, we save your Application-Settings automatic-

ally in these files:

· <LocalAppData>\IniFiles\MechDesigner.INI 

· <LocalAppData>\IniFiles\ MechDesigner.XML 

Delete these two files to revert to factory-settings.
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1.5.3.3 Run

Run

The Run menu and toolbar provide the commands to run or pause, step, and

reset the machine-angle and Revs (Revolutions) o to zero.

Run menu

If you show menus, the Run menu is at the top.

MD17 - Run menu

Run toolbar

The Run toolbar is ABOVE the graphics-area. 

Run toolbar

Run menu: Commands and shortcuts

ICON COMMAND SHORTCUT

Toggle: Run / Pause

Toggle on to continuously cycle the model at a

constant-rate - see Machine-Settings >

Cycle/Minute

Toggle off to pause the model at the Master

Machine-Angle.

ALT+C

Step Forward

Click to increase the MMA by 360 / Number-of-

Steps

CTRL+ALT+F

Step Backward

Click o decrease the MMA by 360/ Number-of-

Steps

ALT+B

Home (Reset) “Home” key on

your keyboard

351
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ICON COMMAND SHORTCUT

Click to move the MMA and Revs to Zero, and to

stop the model.

To edit the MMA, approximately or exactly, see Master-Machine-Angle (MMA).



60

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.3.4 Visibility

Visibility

The Visibility menu and toolbars toggle on and off the display of different

element-types that represent the solid and kinematic element in the graphics-

area.

You can also dock or float MotionDesigner.

Visibility toolbar

When you show toolbars, the Visibility toolbar is above the graphics-area.

Toggle the icons in the toolbar to show or hide kinematic and solid element-

types.

You can also dock or float MotionDesigner.

Visibility toolbar

Visibility toolbar - more details

Visibility controls for SOLIDS 

 - Enable “Force-Vectors: Display” - See More

 - Disable: “Force-Vectors: Display”

 - Enable “Show other Kinematic and Sketch elements” - See

More

 - Disable “Show other Kinematic and Sketch elements”

 - Solids as “Shaded AND Wireframe edges” - See More  

 - Solids as “Wireframe”

237
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 - Solids as “Shaded”

 - Enable “Show Solids in Mechanism-Editor” - See More   

 - Disable “Show Solids in Mechanism-Editor” 

- MotionDesigner is “Docked” : See More

 - MotionDesigner is “Floating”

 - “Solids in ACTIVE Mechanism-Editor ONLY” - See More

 - “Solids in ALL Mechanism-Editors”

 - “Orthonormal View” - See More

 - “Perspective View"

Element-Visibility toolbar

When you show toolbars, the Element-Visibility toolbar is BELOW the graph-

ics-area. 

Toggle the icons in the toolbar to show or hide different element-types.

66
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Display Filters toolbar 

[Default: All Filters Selected to Display ALL element-types]

Element Visibility toolbar - more details

Show or Hide PLANES from the graphics-area. 

Note: An active MECHANISM-EDITOR shows only those PLANES that are

its 'children'.

Show or Hide MODEL AXES from the graphics-area. 

Show or Hide PART-OUTLINES and Joints from the graphics-area.

Show or Hide POINTS from the graphics-area.

Show or Hide SKETCH-ELEMENTS AND PART-AXES from the graphics-

area.

Show or Hide PROFILES from the graphics-area.

Click to hide CAD-Lines, all DXF Outlines and CAD-SOLIDS from the

graphics-area.

Show or Hide DXF POINTS in DXF-Drawings from the graphics-area.

Other DXF Entities stay in the graphics-area.

DXF Points show at the ends of DXF Entities in a DXF-Drawing that

you import. If there are many DXF Points, they can hide the DXF-

Drawing.
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Show or Hide CAMLINKS OUTLINES from the graphics-area.

CAMLINKS was a 2D kinematics software package.

Show or Hide FUNCTION-BLOCKS from the graphics-area. 

Show or Hide:

· MOTION-DIMENSIONS and MOTION-DIMENSION FBS 

· DIMENSIONS

Show or Hide GEAR-PAIRS 

Show or Hide 2D CAM

Show or Hide 3D-CAMS

1.5.3.4.1  Display Force-Vectors

Visibility > Force-Vectors: Display

See Force toolbar > Force-Vectors: Display

1.5.3.4.2  Show Other Kinematic and Sketch elements

Visibility > Show “other Kinematic and Sketch ele-

ments” (Global Switch)

Control the visibility of Kinematic elements and Sketch elements in the

graphics-area.

Use this “Global Switch” together with the “Local Switch” Light-Bulb  in

each Mechanism name-tab.

When you enable Visibility toolbar > Show “other kinematic and sketch-

elements”, you can see: 

... all Kinematic elements and Sketch elements that in the ACTIVE MECH-

ANISM-EDITOR when you edit a PART

AND

... those Kinematic elements and Sketch elements that are in OTHER

MECHANISM-EDITORS that have their Light-Bulbs ON

Global Switch

Visibility toolbar > Show other Kinematic and Sketch elements

Visibility toolbar > Hide other Kinematic and Sketch elements

Local Switch for each Mechanism-Editor : Light-Bulb

237
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There is a Light-bulb in each Mechanism name-tab. 

The Light-bulb must be ON to show from other MECHANISM-EDITORS those

kinematic and sketch-elements that are in this MECHANISM-EDITOR.

Mechanism name-tab : Light-bulb switch is ON

Mechanism name-tab : Light-bulb switch is OFF

To turn a Light-bulb switch to on  :

1. Right-click the Mechanism name-tab  of any MECHANISM-EDITOR 

2. Click Show with "other kinematic and sketch elements" .

Note: You can also Edit color of “other kinematic and sketch-elements ”

in each MECHANISM-EDITOR.

Example 

Visibility when Global-Switch is OFF

Kinematic and sketch-elements in

active Mechanism-Editor ONLY.

Visibility toolbar (or menu) > Show “other Kinematic and Sketch elements”

is OFF

Visibility when Global-Switch is ON

Kinematic and sketch-elements in

active and other Mechanism-Editors.
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Thee Kinematic and Sketch-Elements of other Mechanism-Editors when

their Light-Bulb is also ON.

Visibility toolbar (or menu) > Show “other kinematic and sketch elements”

is ON

 A PART-OUTLINE symbol in a different MECHANISM-EDITOR that also has its

Light-Bulb ON

 A LINE or CAD-LINE in a different MECHANISM-EDITOR that also has its

Light-Bulb ON

You can control the color of the elements if you right-click the Mechanism

name-tab. 

In the image there are three colors. 

· Green is the color of elements that are kinematically-defined in the

active MECHANISM-EDITOR

· Blue / Red are the colors of elements that are in other MECHANISM-

EDITORS

TOP-TIP : 

When you show other kinematic and sketch-elements in other MECHANISM-

EDITORS, you can use you mouse-point to:

Identify Parts

· Single-Click a PART-OUTLINE (or JOINT, or CAD-LINE) to identify in the

SELECTION-WINDOW and ASSEMBLY-TREE the name of the PART (or

JOINT, or CAD-LINE) and the MECHANISM-EDITOR to which it is a child.

· Single-Click a sketch-element to identify, in the SELECTION-WINDOW,

the name of the sketch-element and the PART to which the sketch-

element is a child.

Jump to a different Mechanism-Editor

· Double-Click a PART-OUTLINE or sketch-element to jump to the

MECHANISM-EDITOR in which the PART or sketch-element is a child.

1.5.3.4.3  Solids Display Mode

Visibility > SOLIDS Display Mode

To change how you view SOLIDS.

This switch has three states.

Visibility toolbar > Solids as Shaded AND Wire-Frame

Visibility toolbar > Solids as Wire-Frame ONLY (hidden lines visible)

Visibility toolbar > Solids as Shaded ONLY

MUST also be enabled:
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· Visibility toolbar> Show Solids in Mechanisms

OPTIONS:

· Visibility toolbar > Show Solids in Active or All Mechanisms

· Visibility toolbar > Show Solids as Orthonormal or as a Projection View

1.5.3.4.4  Show Solids in Mechanisms

Visibility > Solids in Mechanisms

This command is a toggle between Show and Hide Solids in Mechanism-Ed-

itors.

Visibility toolbar > Solids in Mechanisms - Enabled

Visibility toolbar > Solids in Mechanisms - Disabled

PLANES also show when you show Solids in Mechanisms, which can be in-

convenient.

To hide PLANES, use:

· Element-Visibility toolbar > Show or Hide Planes

Use Solids in Mechanisms with:

Visibility menu > Show Solids in Active or All Mechanism-Editors

Visibility menu > Solids Display Mode

Visibility menu > Show Solids as Orthonormal or Projection View

1.5.3.4.5  Dock or Float MotionDesigner

Visibility > Dock / Float MotionDesigner

This command has two(2) states:

Visibility toolbar > MotionDesigner is Docked

Visibility toolbar > MotionDesigner is Floating

1.5.3.4.6  Solids In Active or All Mechanisms

Visibility > Show Solids in Active or All Mechanism-Editors

This command relates to SOLID and PLANE elements.

Visibility toolbar > Show Solids that are in the active Mechanism-Ed-

itor ONLY

Visibility toolbar > Show Solids that are in all of the Mechanism-Ed-

itors

To see the SOLIDS, you must also enable:

· Visibility toolbar> Solids in Mechanisms

66
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OPTIONS:

· Visibility toolbar > Solids Display Mode:  Shaded, Wire-Frame, or

Shaded AND Wire-Frame

· View toolbar > Orthonormal or Perspective View

1.5.3.5 Filters

Filters

Selection Filters help you to select different types of elements in the graphics-

area. For example, select the filter for POINTS so that you can select only

POINTS.

Filter menu 

When you show menus, use Filters to help you select different element-types.

MD17 - Filter menu

Filter toolbar (+Element-Visibility and View toolbars)

When you show toolbars, the Selection Filters  toolbars are BELOW the

graphics-area. 

Display Filters & Selection Filters (and View)

toolbars - collapsed

65
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1.5.3.5.1  Selection-Filters

Filters menu and Selection Filters toolbar

The Selection Filters toolbar is BELOW the graphics-area. 

When you toggle an icon to ON, you can: 

· select that type of element in the graphics-area

· select and edit the type of element from the ASSEMBLY-TREE

Special Case and default: Disable OR Enable ALL Filters to select ALL element-

types.

Selection Filters toolbar

[All filter elements selected]

Selection Filter icons

Filter for PLANES

Filter for PART-OUTLINES (to select a PART).

Filter for POINTS

Filter for LINES, CAD-LINES, X-axes, and Y-axes of a PART.

Filter for CIRCLES and ARCS

Filter for Dimensions:

· DIMENSIONS  in the PART-EDITOR

· MEASUREMENT DIMENSIONS  and MEASUREMENT FBS

· MOTION-DIMENSIONS  and MOTION-DIMENSION FBS

269
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Filter for PROFILES

Filter for FUNCTION-BLOCKS 

Filter for PIN-JOINTS , SLIDE-JOINTS and BALL-JOINTS.
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1.5.3.6 View

View

Use the View menu and toolbar to manipulate and control how to display the

graphics area.

View menu

When you show menus, use the View menu to help you manipulate and con-

trol how to display the graphics area.

View menu - MD17

View toolbar

When you show toolbars, the View toolbar is above the graphics-area.

Use the buttons to control how to display the graphics area.

The View toolbar is BELOW the graphics-area. 

View toolbar

View toolbar - more details

 

View from the: Front ; Back ; Left ; Right ; Top ; Bottom

Front-View is the XY-Plane of the active MECHANISM-EDITOR

Press F3 on your keyboard as the short-cut key for the Front-View.

View Align

· PART-EDITOR : Click View Align to rotate the Part so that the X-

axis is horizontal 

· MECHANISM-EDITOR : Click View Align to rotate the BASE-PART

so that the X-axis is horizontal.

View Normal to a Plane

To make the view normal( ) to a PLANE:

1. Click View Normal to Plane 

2. Click a PLANE

3. Click  in the COMMAND-MANAGER
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SPIN

Spin button + Drag in the graphics-area

Shortcut 

SHIFT + Drag in the graphics-area

Shortcuts and keyboard arrow-keys

10º Spin : LEFT / RIGHT and UP / DOWN keyboard arrow-keys

30º Spin : CTRL + LEFT / RIGHT and UP / DOWN keyboard ar-

row-keys

90º Spin : SHIFT + LEFT / RIGHT and UP / DOWN keyboard ar-

rows-keys

Note: Make sure your mouse-pointer does not hover above an ele-

ment before you drag your mouse.

PAN 

Pan button + Drag in the graphics-area

Shortcut:

CTRL + Drag in the graphics-area

Note: Make sure your mouse-pointer does not hover above an ele-

ment before you drag your mouse.

Zoom Extents 

To display the complete model.

If the complete model does not show, do Front-View(F3), then

Zoom-Extents.

Zoom In 

SHORTCUT: Mouse Wheel: Zoom in/out at your mouse position.

 Zoom Out 

SHORTCUT: Mouse-Wheel: Zoom in/out at your mouse position.

Zoom Windows 

With your mouse, drag a window as the extents of the new model

view.
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1.5.3.7 Help

Help

The Help menu (no toolbar) has the tools to find different help formats.

Help menu - MD17

Help menu - MD17

Help menu commands

Open Local Help

We put the Local Help in <CommonAppData>\ Help \ - when you in-

stall MechDesigner.

To get contextual help:

· Click Help menu > Open Local Help, AND/OR 

· Click the  icon in a dialog , AND/OR 

· Press the F1 key when you move your mouse over a command but-

ton.

On-line Help

You need an Internet connection.

We open for you the MechDesigner's Help Welcome Page.

The On-Line help has many tutorials.

Download Latest Help...

You MUST start MechDesigner with Administrator Rights 

Download the Local Help to make sure you have the latest version.

1. Click Help menu > Download Latest Help... 

2. Click Download Now button 

Download Example Models

1. Click a model from the list of Examples 

Wait for the model to download.

332
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Some models are large. Please be patient to make sure the file

downloads.

To show MD-SOLIDS and any CAD-SOLIDS, click:

· Edit toolbar > Auto Update / Rebuild  

· Visibility toolbar > Show Model in Mechanisms  to show
SOLIDS

· Element-Visibility toolbar > Show/Hide Planes to hide PLANES

that may hide other elements in the model.

Toggle Hints

Use to show tool-tips next to your mouse-pointer.

1. Click to Toggle Off (You may need to click this two(2) times)

2. Click again to Toggle On

See also Application Settings

MechDesigner YouTube

1. Click to see the MechDesigner YouTube channel.

Internet sub-menu  >

About dialog tabs:

MechDesigner  E.g.: 17.1.54: (Release.Version.Build)

Graphics - your Graphics Card Supplier, OpenGL Version, Graphics

Card Model, OpenGL Extensions

Type-Libraries: Last used version of SOLIDWORKS and installed version

of SOLIDWORKS Type-Libraries

Protection Key - Your License Settings

See About dialog

49
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1.5.3.7.1  About

Help > About dialog

There are four tabs: 

MD XXX V-R-B tab

Version: MechDesigner XXX V.R.B

XXX = PRO - Professional ; STD = Standard ; TRL = Trial

V. R . B : Version - Release - Build

Type : Win64

Features: FULL Version

Release Date: dd-mm-yyyy

Graphics tab
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Graphics Card Supplier: For example: NVIDIA Corporation

OpenGL Version: For example: 4.5.0 NVIDIA 361.91

Graphics Card Model For example: GeForce GTX 970/PCIe/SSE2

OpenGL Extension For example: GL...AMD_multi_draw_indirect,

GL_AMD,_.... and others.

Type Library tab

SOLIDWORKS® Type-Libraries / Installed Version of SOLIDWORKS

Each version of SOLIDWORKS uses a different Type Library file.

In the image :

· SOLIDWORKS Type Library: 2021

· Installed Version of SOLIDWORKS: 2021

When the year is the same, you are All good to go. 

If the versions are not the same, then Run as Administrator when you start

MechDesigner, and check again.

Note: From MD15 - the correct Type Libraries are installed automatically with your in-

stallation, and it checks which version of SOLIDWORKS you are using each time you

start MechDesigner.
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Protection Key

MechDesigner Software Key Mdxx_x_x-xxxx-xxxx-xx

Program Expiry Date Lifetime / Expiry Date

Support Have Support + Expiry date / Without Sup-

port

Code Features PREM, STAN, LITE (TEST (code testing only))

License Duration Lifetime / Annual

1.5.3.8 Internet

Internet

The Internet menu (no toolbar) provides some ways to download help, email

us, and download example models. You need an internet connection.

PSMotion Home Page

A link to: psmotion dot com in your web-browser

Send Mail

Report Bug / Feature Request

Please send all Bugs and Feature Requests to support at psmotion dot

com

General Mail

Send emails to sales at psmotion dot com

Download Example Models
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MechDesigner YouTube

1. Click to see the MechDesigner YouTube channel.
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1.5.4 2.1 Model-Editor

 Model-Editor 

What is the Model-Editor?

The MODEL-EDITOR shows the SOLID and PLANE elements in your model.

You can cycle the model continuously or position it at any machine angle.

In the MODEL-EDITOR, you can:

· add PLANES to PLANES 

· add MECHANISM-EDITORS to PLANES*

· edit SOLID elements

* You MUST use the MODEL-EDITOR to add a minimum of one MECHAN-

ISM-EDITOR to a PLANE.

See Model elements > Add Mechanism

Model-Editor workspace

Model-Editor: Reference Triad and fixed

Planes

Graphics-area :

The Reference Triad shows the directions of the Global XYZ-axes.

The direction of each axis uses the right-hand rule. 

The elements in the MODEL-EDITOR are:

· Three fixed PLANES:

o Front PLANE, which is co-planar with the Global XY-axes

o Top PLANE, which is co-planar with the Global ZX-axes

o Right PLANE, which is co-planar with the Global YZ-axes

· Other PLANES you may have added

· SOLIDS that you have added to PARTS

Name-tab  : 

The default element name of the MODEL-EDITOR and name-tab is

Model

85
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Menu and Toolbar

Menu - the commands that you can use in the MODEL-EDITOR are in the

Mechanism menu

Toolbar - the commands that you can use in the MODEL-EDITOR are in the

Model elements toolbar .

See also:

Model Options dialog

90
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1.5.4.1 Model elements

Model element commands

There are only two commands in the Mechanism menu that you can use in

the MODEL-EDITOR. The two commands arrange the basic layout of your ma-

chine.

The two commands are:

· Add Plane

· Add Mechanism  * 

* You MUST do Add Mechanism  to add a minimum of one MECHANISM-ED-

ITOR.

The two commands are in the Mechanism menu and the Model elements

toolbar.

Mechanism menu > Model elements

Mechanism menu > Model elements (MD17)

Model elements toolbar

The Model elements toolbar is to left of the graphics-area.

Model elements toolbar

82
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1.5.4.1.1  Add Plane in Model-Editor

What is a Plane?

A PLANE is a flat surface, defined by its Local XYZ-axes. The PLANE is coin-

cident with the XY axes. The Z-axis follows the usual Right-Hand-Rule.

You add PLANES to arrange the layout of your machine. 

You add MECHANISM-EDITORS to PLANES.

Add Plane (Model-Editor)

In the MODEL-EDITOR, you offset a new PLANE along the Z-axis of a PLANE you

select.

STEP 1: Start the Add Mechanism command:

1. Click Mechanism menu >

Add Plane 

OR

1. Click Model elements tool-

bar  > Add Plane 

Add Plane dialog: 

FORMAT 1: Add Plane to Plane

The ADD PLANE DIALOG opens, imme-

diately.

If you have not pre-selected a

PLANE, we select for you the FRONT

PLANE as the default reference ele-

ment.

In the MODEL-EDITOR, the format of

the ADD PLANE DIALOG is:

  Name - of new PLANE, and the

Parent element (MECHANISM in the

dialog)

PLANE PARAMETERS

  Plane Definition :

OFFSET FROM PLANE (always

in the MODEL-EDITOR)

  Parameter to define the new

Plane : 

DISTANCE TO NEW PLANE

[mm]

The distance from the refer-

ence element, PLANE.

81
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  Element box - the reference

PLANE for new PLANE (default

Front)

STEP 2: Select a Plane 

Click a Plane in the Assembly-Tree

1. Click a PLANE in the graphics-

area 

OR 

1. Click a PLANE in the ASSEMBLY-

TREE 

When you click a PLANE, it shows in

the Element box  of the ADD

PLANE DIALOG

A preview of the new PLANE is also

in the graphics-area.

STEP 3: Edit the Parameter 

There is one parameter to edit:

Edit the DISTANCE TO NEW

PLANE

The DISTANCE TO NEW PLANE is from

the reference PLANE in the Element-

box .

STEP 4: Complete the Command 
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New Plane in the Graphics-Area

To complete the command:

Click  in the ADD-PLANE DIA-

LOG

RESULT 

New Plane in the Graphics-Area

RESULT

The new PLANE  is in the graph-

ics-area and the ASSEMBLY-TREE. 

The The new PLANE has shows its

XYZ-axes. 

The XY-axes are coplanar with the

new PLANE.

Note:

If you cannot see the new PLANE try:

View menu > Zoom-Out  ( or use your mouse scroll wheel)

View menu > Spin model  (or use the keyboard arrow keys)

View menu (or Display toolbar) > Display Planes

Videos (YouTube): Double-click to watch Video

Add Plane in Model-Editor

70

70

67
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1.5.4.1.2  Add Mechanism in Model-Editor

Mechanism and Mechanism-Editor?

What is a MECHANISM and a MECHANISM-EDITOR?- See here .

Why add a MECHANISM? - See here .

Important - Read if this Is this the first Mechanism-Editor.

Gravitational Vector ( g = 9.81665 m/s/s )

You cannot edit the direction or the magnitude

of the Gravity Vector.

Therefore, add the first MECHANISM-EDITOR to a

PLANE that represents the layout of your ma-

chine. 

GRAVITY VECTOR - its direction is in the “global”

negative Y-axis direction 

For example, if your machine is a horizontal, rotating table, you should add

the first MECHANISM-EDITOR for the table to the TOP PLANE, or a PLANE

that is parallel to the TOP PLANE.

Add Mechanism

STEP 1: Start the Add Mechanism command:

Model elements toolbar

1. Click Mechanism

menu > Mechan-

ism 

OR

1. Click Model ele-

ments toolbar

> Add Mechan-

ism 

STEP 2: Select a Plane 

Command-Manager

The COMMAND-MANAGER (left of

graphics-area) has one selection-box. 

You must select a PLANE.

1. Click a PLANE in the graphics-area 

OR 

1. Click a PLANE in the ASSEMBLY-TREE 

The PLANE is now in the selection-

box in the COMMAND-MANAGER.

88

88
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Command-Manager - Plane element

To see PLANES: Enable Show Solids in

Mechanisms . Enable: Visibility menu

> Display Planes.

STEP 3: Complete the command

Command-Manager - 'OK'

You must click the 'tick' to complete the

command.

In the COMMAND-MANAGER:

1. Click the  below the selection-

box.

RESULTS

1. The COMMAND-MANAGER closes. 

2. You jump immediately to a new MECHANISM-EDITOR workspace - with a

Mechanism tab, graphics-area, BASE-PART, and toolbars. 

3. There is a new MECHANISM element in the ASSEMBLY-TREE.

The MECHANISM element is a child to the PLANE you select.

See also: The Base-Part does not show correctly!  

RESULT: Workspace

Mechanism-Editor workspace  

The new MECHANISM-EDITOR:

  BASE-PART WITH A RECTANGULAR PART-OUTLINE

  Mechanism name-tab 

  Toolbars (left and right of the graphics-area) 

  Graphics-area

  Local XY-axes of the MECHANISM-EDITOR and BASE-PART

The XY-Plane of the PLANE you select, the new MECHANISM element,

and the BASE-PART are coplanar and coincident.

66

659
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 RESULT: Assembly-Tree

Hieratchy of new Mechanism in

Assembly-Tree

The hierarchy of the new Mechanism element 

PLANE4 - that you selected to add the MECHANISM element:  

(New) MECHANISM2 - is a child to PLANE4, and coplanar with the XY

axes of PLANE4.

(New) BASEPART2 - is the name the PART that you edit to add sketch-

element. It is the machine-frame of MECHANISM2. 

The XYZ-axes of PLANE4, MECHANISM2, and the BASE-PART2 are all coin-

cident.

Video

 

Add Mechanism-Editor in the

Model-Editor
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1.5.5 2.2 Mechanism-Editor

 Mechanism-Editor 

What is a Mechanism-Editor?

To do Add Mechanism you must select a PLANE.  

When you do Add Mechanism, we add for you a:

· MECHANISM element to the ASSEMBLY-TREE as a child to the PLANE

you select,

and a

· MECHANISM-EDITOR workspace with its name-tab, graphics-area,

XY-axes, and a BASE-PART.

Why add a Mechanism-Editor?

You build you model in the MECHANISM-EDITOR workspace with kinematic

elements , Solid elements, Function-Blocks, ... .

You must add a minimum of one MECHANISM-EDITOR. 

Mechanism-Editor workspace

Mechanism-Editor- Example

The Mechanism-Editor workspace:

Graphics-area : to which you add Kinematic and Machine elements,

Kinematic and Modeling Function-Blocks, Solid elements, Force ele-

ments, and other elements.

Name-tabs : each MECHANISM-EDITOR has a name tab.

The BASE-PART (not shown in the image above) is a child to the MECH-

ANISM-EDITOR. It represents the frame, or the stationary part, of the

Mechanism workspace. The XYZ-axes of the BASE-PART are coincident

with the XYZ-axes of the PLANE you select when you add the MECHAN-

ISM-EDITOR.

98



89

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Menus and Toolbars

The commands in the toolbars are also in the Mechanism menu, Function-

Blocks menu, Forces menu, and MD-Solids menu. 

Mechanism menu

Model elements toolbar  - left of the graphics-area - add PLANES and

add MECHANISM-EDITORS to PLANES

Kinematic elements toolbar  - left of the graphics-area - add the basic

kinematic elements to build kinematic-chains

Machine elements toolbar  - left of the graphics-area - add more com-

plex elements

Function-Blocks menu  :

Kinematic Function-Blocks toolbar  - right of the graphics-area - plan

and measure the motion of each kinematic-chain, analyze and calculate

cam-coordinates

Modeling Function-Blocks toolbar  - above the graphics-area - tools to

help you do more complex modeling

Forces menu

Force elements toolbar  - right of the graphics-area - measure force,

torque, and power that is required to drive each kinematic-chain

MD-Solids menu

MD-Solids toolbar  - above the graphics-area - extrude Solids from

sketch-loops, add Holes, add extrusions to all or one PART

90
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1.5.5.1 Mechanisms

Mechanism menu

The Mechanism menu combines the commands from three toolbars. The three

toolbars are to left of the graphics-area.

Model elements   - to add elements that arrange the layout of your ma-

chine.

Kinematic elements  - to add the elements that represent the moving parts

on your machines. E.g. Parts, Joints, ... .

Machine elements   - to add elements that represent the hardware com-

ponents you frequently find on industrial machines. E.g. Cams, Gears, Pul-

leys, .... .

91

98
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1.5.5.1.1  Model elements

Model elements

Model elements arrange the layout of your machine. 

There are only two commands - Add Mechanism-Editor and Add Plane.

The two commands are in the Mechanism menu and the Model elements

toolbar.

MD17 : Mechanism menu > Model elements

Mechanism menu > Model elements (MD17)

Model elements toolbar

The Model elements toolbar is to left of the graphics-area.

Model elements toolbar
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1.5.5.1.1.1  Add Plane in Mechanism-Editor

What is a Plane?

A PLANE is a flat surface, defined by its Local XYZ-axes. The XY axes are co-

planar with the PLANE. The Z-axis follows the usual Right-Hand-Rule.

Use Visibility toolbar > Show Solids in Mechanisms  to see PLANES in MECHAN-

ISM-EDITORS. 

See also: Add Plane - Model-Editor

Add Plane (Mechanism-Editor)

In a MECHANISM-EDITOR, you can add a new PLANE:

· that is parallel to a PLANE you select. You can control the distance from the

reference PLANE - see FORMAT 1

· whose origin is at the START-POINT of a LINE* and the PLANE to which the

LINE is descendant. You can rotate the new PLANE about the XYZ axes of

the PLANE - FORMAT 2

FORMAT 1: Add Plane to a Plane

STEP 1: Start the Add Plane command

Mechanism menu > Plane 

OR

Model elements toolbar  > Add

Plane 

FORMAT 1: Add Plane to Plane

The Add Plane dialog opens, immedi-

ately

In the MECHANISM-EDITOR, the default

format is:

  New Plane Name - PLANE6

PLANE PARAMETERS

  Plane Definition - (default

format)

OFFSET FROM PLANE (default

definition)

  Parameter to define the new

Plane : 

DISTANCE TO NEW PLANE 

66

82
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  Element box - the name of the

element(s) that are referenced by

the new PLANE.

STEP 2: Click a Plane.

Click a PLANE in the graphics-area

or the ASSEMBLY-TREE.

When you click a PLANE, it shows in

the Element box  of the ADD

PLANE DIALOG.

A preview of the new PLANE is also

in the graphics-area immediately.

STEP 3: Edit the Parameter

Edit DISTANCE TO NEW PLANE  

DISTANCE TO NEW PLANE - to PLANE

6  from PLANE5

STEP 4. Complete the Add Plane

command

Click  in the ADD-PLANE DIALOG

RESULT

The new PLANE  is in the graphics-

area and ASSEMBLY-TREE. 

It is on Local Z-axis of the PLANE

you select to add the new PLANE.

The new PLANE has its own Local

XYZ-axes. 

FORMAT 2: Add Plane to a Line (CAD-Line, Part's X-axis or Y-axis)

STEP 1: Start the Add Plane command

Mechanism menu > Add Plane 

OR
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Model elements toolbar  > Add Plane 

FORMAT 1: Add Plane to Plane

The Add Plane dialog opens, immedi-

ately

In the MECHANISM-EDITOR, the default

format assumes you will select a PLANE.

  New Plane Name - PLANE6

PLANE PARAMETERS

  Plane Definition - (default

format)

OFFSET FROM PLANE (default

definition)

  Parameter to define the new

Plane : 

DISTANCE TO NEW PLANE  

  Element box - the name of the

element(s) that the new PLANE ref-

erences.

STEP 2: Click a Line*.

Click a LINE* in the graphics-area

* LINE, CAD-LINE, or a PART'S X-axis or

Y-axis

When you click a LINE, the LINE and

the PLANE (see below) to which the

LINE is descendant (great-grand-

child - PLANE > MECHANISM > PART

> LINE ) show in the Element box

There is a preview of the new PLANE

in the graphics-area, immediately.

Note: Default ROTATE AROUND X-AXIS =

90.

81
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FORMAT 2: Add Plane to Line

STEP 3. Edit the parameters  

 ANGLE - rotate the new PLANE

around the X–AXIS

and

 ANGLE - rotate the new PLANE

around the Y–AXIS

and

 ANGLE - rotate the new PLANE

around the Z–AXIS

Optional (for Bevel Gearboxes)

 MOVE PLANE TO END-POINT -

move the new PLANE to the end of

the LINE in the Element box.

If you enable MOVE PLANE TO END-

POINT, (and the ROTATE AROUND

X,Y,Z parameters are zero(0)), the

Local X-axis is from the END-

POINT to the START-POINT, the

Local Y-axis is on the new PLANE,

and the Local Z-axis follows the

Right-Hand-Rule.

STEP 4. Complete the Add Plane

command

Click  in the ADD-PLANE DIALOG

RESULT

The new PLANE  is in the graphics-

area and ASSEMBLY-TREE. 

The new PLANE shows its XYZ-axes. 

Video: Double-click to watch Video

1.5.5.1.1.2  Add Mechanism in Mechanism-Editor

Mechanism and Mechanism-Editor?

What is a MECHANISM and a MECHANISM-EDITOR?- See here .

Why add a MECHANISM? - See here .

Add Mechanism

STEP 1: Start the Add Mechanism command:

88

88
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Model elements toolbar

1. Click Mechanism menu >

Mechanism 

OR

1. Click Model elements tool-

bar  > Add Mechanism 

The COMMAND-MANAGER starts. 

STEP 2: Select a Plane 

Command-Manager

Command-Manager - Plane element

The COMMAND-MANAGER has one se-

lection-box. 

You must select a PLANE.

If you cannot see a PLANE: Enable Show

Solids in Mechanisms . 

1. Click a PLANE in the graphics-area 

OR 

1. Click a PLANE in the ASSEMBLY-TREE 

The PLANE is now in the selection-

box in the COMMAND-MANAGER.

STEP 3: Complete the command

Command-Manager - 'OK'

You must click the 'tick' to complete the

command.

1. Click  in the COMMAND-MANAGER

 

RESULT

1. The COMMAND-MANAGER closes. 

2. You jump immediately to a new Mechanism-Editor workspace

3. The MECHANISM element is a new element in the ASSEMBLY-TREE. It is a

child to the PLANE you select.

RESULT: Workspace

81

66
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Mechanism-Editor workspace  

The workspace of each MECHANISM-EDITOR:

 : BASE-PART with a rectangular PART-OUTLINE

 : Mechanism name-tab 

 : Toolbars (left and right of the graphics-area) 

 : Graphics-area

 : Local XY-axes of the MECHANISM-EDITOR and BASE-PART

 RESULT: Assembly-Tree

Hieratchy of new Mechanism in

Assembly-Tree

The Mechanism element in the Assembly-Tree:

PLANE4 - that you selected to add the Mechanism element: 

(New) MECHANISM2 - is a child to PLANE4, and coplanar with the XY

axes of PLANE4.

(New) BASEPART2 - is the name the PART that you edit to add sketch-

element. It is the machine-frame of MECHANISM2. 

The XYZ-axes of PLANE4, MECHANISM2, and the BASE-PART2 are all coin-

cident.

Video: Add Mechanism
Double-click to watch 'Add Mechanism to Plane'


AddKinematicElements-1280x720

PSMotion Ltd

KE-AddMechPlane1280x720.mp4
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1.5.5.1.2  Kinematic elements

Kinematic elements

Kinematic elements are coplanar with the XY-Plane of the active MECHAN-

ISM-EDITOR*.

Kinematic elements  symbolically represent the moving parts in your machine.

You join PARTS to each other to build kinematic-chains (mechanisms, link-

ages).

Kinematic elements are NOT solid bodies and they do NOT have shape or

form**. 

* The exception is a PART that has a BALL-JOINT at its START-POINT and END-POINT.

** To add a solid body to a PART, you must add a PROFILE to a PART, and/or im-

port a SOLIDWORKS part/assembly document, or import an STL file from other

CAD.

 Mechanism menu > Kinematic elements

Mechanisim menu > Kinematic-elements (MD17)

Kinematics elements toolbar

The Kinematic elements toolbar is to the left of the graphics-area.

Kinematic elements toolbar



99

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.5.1.2.1  Add Magnetic-Joint

Magnetic-Joint

See also: Magnetic-Joint dialog  ( YouTube Video : http://youtu.be/IME9Eb4mpQE )

Use MAGNETIC-JOINTS ONLY for special modeling - for example, to re-

verse-engineer the motion of a Follower from the shape of an imported

Cam.

MAGNETIC-JOINTS use iterative, root-finding techniques. All other kin-

ematic joints use closed-form equations for exact and fast evaluations.

Therefore, a model with a MAGNETIC-JOINT is ~100+ times slower to solve

than a model with SLIDE-JOINTS, PIN-JOINTS, and/or BALL-JOINTS. Most mod-

els (99%?) do NOT need a MAGNETIC-JOINT.

Terminology

MAGNETIC-JOINT : A MAGNETIC-JOINT pulls a circular PROFILE to be in

continuous contact with an irregular PROFILE (or

CURVE). 

The circular PROFILE and irregular PROFILE (or

CURVE) are in different kinematic-chains. After you

add a MAGNETIC-JOINT, the motion of the two kin-

ematic-chains are related by the contact between

the circular and irregular PROFILES (or CURVE).

Irregular Shape : The Irregular Shape can be PROFILE from a sketch-

loop, or a CURVE that we calculate from a Point-

Cloud. 

Point-Cloud : X-Y or coordinates. Use a POINT-CLOUD FB to

import the Point-Cloud coordinates.

CURVE : The smooth shape that we calculate for you from

the Point-Cloud coordinates - see POINT-CLOUD

DIALOG .

Preparation for Add Magnetic-Joint (Typical)

The MAGNETIC-JOINT pulls a Circular-

Profile  onto the outside or inside of

an Irregular-Profile .

 A PART (and kinematic-chain) to

which the Irregular-Profile  is

a child.

 An Irregular-Profile, which is a 

· PROFILE that you have ad-

ded to a sketch-loop

OR 

· CURVE that you have fitted

to a Point-Cloud

560

484

http://youtu.be/IME9Eb4mpQE


100

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

 A PART (and kinematic-chain) to

which the Circular Profile  is a

child.

 The MOTION-DIMENSION FB to

drive by the action of the MAG-

NETIC-JOINT. 

Add Magnetic-Joint

STEP 1: Pre-Position the Circular Pro-

file

1. HOME the model 

Select the Home key, or use the

ALT+H keyboard shortcut, or

do Run menu/toolbar >

Home. 

2. Edit the MOTION-DIMENSION FB

 | BASE-VALUE so that the: 

Distance from the Circular-

Profile  to the Irregular-Pro-

file  ...

... < 0.5 × Radius of Circular-

Profile

Note: See also Magnetic-Joint

dialog > ADVANCED

STEP 2: Start the Add Magnetic-Joint

command

1. Mechanism menu > Add Mag-

netic-Joint 

OR

1. Kinematic elements

toolbar > Add Mag-

netic-Joint 

STEP 3: Select the elements:

1. Click the Irregular Profile

2. Click the MOTION-DIMENSION

FB  that you want to 'drive'

with the Magnetic-Joint.

3. Click Circular Profile

STEP 4: Complete the Command 

560 563
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1. COMMAND-MANAGER: Click  in

the COMMAND-MANAGER. 

RESULT: (usually)

The MAGNETIC-JOINT pulls the Cir-

cular-Profile  to be in contact

with the Irregular-Profile . 

A Point Symbol  is at the con-

tact. 

The MAGNETIC-JOINT FB  is near

to the Point-Symbol

There is a MAGNETIC-JOINT ICON

 below and right of the MOTION-

DIMENSION FB  that is driven by

the MAGNETIC-JOINT.

STEP 5: Open the Magnetic-Joint dia-

log  

Video: Double-click to watch Video

560


ME-AddMagJoint.gif
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1.5.5.1.2.2  Add Pin-Joint

Pin-Joint

See also: Edit-Pin-Joint  ( Servomotor and Gearbox Sizing )

Pin-Joints in MechDesigner

Pin Joint: Connecting-Rod

and Piston
Pin-Joint in CAD model.

Terminology

PIN-JOINT : A PIN-JOINT makes a POINT* in a PART to be coincident with a

POINT* in a different PART.

A PIN-JOINT allows two PARTS to rotate relative to each other.

A PIN-JOINT removes two degrees-of-freedom from the model.

rotating-Part : A PART that can rotate relative to a different PART.

Revolute-Joint : The kinematic and technical term of a PIN-JOINT.

KINEMATICS-TREE : In Dyads, we represent a PIN-JOINT with the letter R, which is

from the kinematic term: Revolute-Joint.

* POINT, START-POINT, END-POINT, or CENTER-POINT.

Pin-Joints in the graphics-area

A PIN-JOINT has two symbols.

 - a PIN-JOINT between a PART

and the BASE-PART.

  - a PIN-JOINT between two(2)

added PARTS and they can move rel-

ative to the BASE-PART. 

Simple Case - Add Pin-Joint

STEP 1: Start the Add Pin-Joint com-

mand

Mechanism menu > Add

Pin-Joint 

OR

Kinematic elements toolbar

> Add Pin-Joint 

592
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Two Pin-Joints

STEP 2: Select two(2) Points:

At least one POINT must be in a FREE

PART.

1. Click a POINT  in a free PART 

2. Click a POINT  in a different

PART 

The two(2) POINTS are coincident at

the PIN-JOINT.

If the SELECT-ELEMENTS DIALOG opens,

see Special-Case .

See also:

Add Slide-Joint

Add Ball-Joint

Add Motion-Dimension FB  

VIDEO : Add Pin-Joint - Simple-Case

DOUBLE-CLICK FOR VIDEO

Special-Case - Add two or more coincident Pin-Joints

Frequently, a design has PIN-JOINTS that are coincident, to join more than

two PARTS.

Example:

You want to join POINTS(#1,#2,#3), in PARTS(#1,#2,#3). with PIN-

JOINTS(#1,#2).

Say, PIN-JOINT#1 is between POINTS #1 and #2 (in PARTS #1 and #2)

When you add PIN-JOINT#2, you have two(2) options:

· Option A: PIN-JOINT#2 is between POINTS #3 and #1 (in PARTS #3 and

#1)

OR

· Option B: PIN-JOINT#2 is between POINTS #3 and #2 (in PARTS #3 and

#2)

To select Option A or Option B is important if you also select the PIN-JOINTS

to add MOTION-DIMENSION FBS . 

103
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114
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KE-AddPin-Joint-A-1280x720.gif
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Preparation example:

 LINE in the BASE-PART (any PART

that is kinematically-defined )

 Part that is completely-free

 Part that is free

PIN-JOINT  joins the START-POINT

of LINE  to the START-POINT of
PART

You want to join PART  that is

completely-free with a PIN-JOINT

that is coincident with PIN-JOINT .

STEP 1: Add Pin-Joint #2 

1. Click Kinematic ele-

ments toolbar > Add

Pin-Joint

1. Click POINT  at the end of

the Completely-Free-Part

2. Click the PIN-JOINT  to se-

lect a POINT - see below

You have actually clicked a total of

three(3) POINTS.

· One POINT at 

· Two POINTS at 

However, the PIN-JOINT is between

two(2) POINTS. 

Therefore, there is ambiguity ... 

... Which two(2) POINTS, of the

three(3) POINTS, do you want the

PIN-JOINT to select?

Definition:

Ambiguity: we are not clear

which element(s) to select to add

a new element. 
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Select-Elements dialog

When there is ambiguity as to

which elements you want to se-

lect, the Select Elements dialog

opens.

In this model, there are three(3)

possible POINTS from which you

want to select two(2) POINTS.

· POINT11 (the START-POINT

of the PART  that is com-

pletely-free)

· POINT5 (the POINT  at the

left of the LINE in the BASE-

PART)

· POINT7 (the START-POINT

of the PART that is free)

TOP-TIP

The element at the top of the list is

the first element you click. There-

fore, if possible, click the element

you know you need before you

click the other elements. Then, you

know you need to select the top

element plus one other.

OPTION A

STEP 2: Select the Points in the

Select-Elements dialog:

1.  key down

2. Click the two POINTS you

want to use for the PIN-

JOINT

3.  key up

The  colorizes only when you

select the elements that are

compatible .

4. Click  at the top, right of

the dialog

Which two POINTS do you select

from the three POINTS?
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There are three options to select

two(2) ELEMENTS from three(3)

elements.

· Option A: Two elements are

compatible or NOT compat-

ible.

· Yes, you can select POINT11

and POINT5 

OPTION B

OR

· Option B: Yes, you can select

POINT11 and POINT7.

OPTION C

Option C: No, you cannot select

POINT5 and POINT7.

Why? Because POINT5 and

POINT7 are joined with a PIN-

JOINT, already.

Note: In the image to the left, see

the word 'not' in the message that is

below the element-box 

 “Two selected elements are not

compatible”

Option A

STEP 2: To confirm again, select

the TWO Points:

1.  key down 

2. Click the two POINTS you

want to use for the PIN-

JOINT

3.  key up

The  colorizes only when you

select the elements that are

compatible .

4. Click  at the top right of

the dialog
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The SELECT-ELEMENTS DIALOG

closes. 

The POINTS (and completely free-

Part) are coincident, at the new PIN-

JOINT.

TOP-TIP: 

If the SELECT-ELEMENTS DIALOG opens, the ELEMENT you click first is at the

top of the list. 

Therefore, if I know there will be ambiguity, I click the ELEMENT that I know

I need to select before the elements that cause the ambiguity. Then, when

the SELECT-ELEMENTS DIALOG open, the element I click first will at the top of

the list.

VIDEO - Add Pin-Joint - Special-Case:

Double-click to Video


AddPinJoint-Special.gif
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1.5.5.1.2.3  Add Part

Part

See also: Edit Part

Part Images

Part in MechDesigner
A Part in SOLIDWORKS

A physical part/link

Terminology

PART : PARTS represent a fixed or moving component in a ma-

chine.

Use the Part-Editor  to edit the length of the PART,

and to add sketch-elements and constraints to the

sketch-elements.

BASE-PART : The PART we add for you. It is the fixed frame for each

Mechanism-Editor. Note: a Mechanism-Editor can

move with a PLANE that you have added to a moving

PART.

Part-Outline : The Part-Outline is the symbol you select to edit a

PART.

Part-Outlines have two shapes:

· Oval: symbol of a PART that you add to the model

· Rectangular: symbol of the BASE-PART 

A PART has TWO possible kinematic-states. 

Not kinematically-defined : The state of a PART when it has one or more degrees-

of-freedom.

Other terms: Free-Part, Completely-Free Part, a Part

that is not solved.

The Part-Outline is approximately Blue

kinematically-defined : The state of a PART when its Mobility is Zero(0).

Other term: is a Part that is solved.

The Part-Outline is approximately Green

IMPORTANT: All of the PARTS in your model must be kinematically-defined before

you can analyze kinematic (motion) and kinetostatic (force) data in your model.

A Part in the graphics-area.

259

257
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 Part-Outline: the symbol of the

PART you select to edit the PART with

the PART-EDITOR

You cannot edit the shape of the

PART-OUTLINE.

 START-POINT and  END-POINT

of the PART

 CAD-LINE from the START-POINT to

the END-POINT

 X-axis and Y-axis: at the START-

POINT (origin)

TOP-TIP: 

You can hide PART-OUTLINES (Display Filters - Part-Outlines). 

Select the Y-axis to edit the PART. 

Add Part

STEP 1. Start the Add Part command

Mechanism menu > Add

Part

OR

Kinematic elements tool-

bar > Add Part

OR

Click the INSERT key on

your keyboard as a short-

cut key

STEP 2. To add the Part 

DRAG: in the graphics-area :

Mouse-button down, ... move

your mouse, ... mouse-button

up.

The PART is now in the graphics-

area.

Add Part is not a persistent command.

Do STEP 1 and STEP 2 again to add a

new PART. 

Video:Double-click to watch Video Clip


KE-AddPart-1280x720.gif
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1.5.5.1.2.4  Add Slide-Joint

Slide-Joint

Slide-Joint in MechDesigner Slide-Joint - THK Slide-Joint in SOLIDWORKS

Terminology

SLIDE-JOINT : A SLIDE-JOINT forces a LINE* in a PART to be collinear with a

LINE* in a different PART.

A SLIDE-JOINT removes two degrees-of-freedom from the model.

A SLIDE-JOINT lets a PART move relative to a different PART with a

rectilinear translation motion.

Prismatic Joint : The kinematic and equivalent term for a SLIDE-JOINT. 

KINEMATICS-TREE : Joints in a Dyad use the letter P to represent a SLIDE-JOINT. - for

example: R-R-P dyad

* LINE or CAD-LINE.

Derived Names:

sliding-Part : a PART that you join with a SLIDE-JOINT to a different PART.

A Slide-Joint in the graphics-area

Slide-Joint

The symbol for a SLIDE-JOINT:

 A Narrow Rectangle that is equal

to the length of the LINE in one of the

PARTS.

 A Wide Rectangle that is equal to

the length of the LINE in the other

PART.

 An Arrowhead that is the Positive-

Direction* of the SLIDE-JOINT.

* The Positive-Direction is important if

you want to add a MOTION-DIMENSION

FB to the SLIDE-JOINT.

See Positive direction of Slide-Joints and

Motion-Dimension .

IMPORTANT: To calculate reaction FORCES on a Slide-Joint:

The length and position of the LINES should be equivalent to actual

length and position of the Slide-ways and Bearings. 

188
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Add Slide-Joint:

Select two Lines

A New Slide-Joint

STEP 1: Start the Add Slide-Joint

command

Mechanism menu > Add

Slide-Joint

OR

Kinematic elements toolbar

> Add Slide-Joint

STEP 2: Click the two(2) Lines 

1. Click a LINE  in a free-Part 

2. Click a LINE  in a different
PART

The two(2) LINES are collinear at the

SLIDE-JOINT.

The Positive Direction of the SLIDE-

JOINT is identified by the small ar-

rowhead.

If the SELECT-ELEMENTS DIALOG opens,

see Slide-Joint Special Case

VIDEO: Add Slide-Joint - Simple-Case

Double-click to watch: Add Slide-Joints - Simple-Case

Special Case: two(2) or more collinear Slide-Joints

Frequently, a machine design has two(2) collinear SLIDE-JOINTS between

three PARTS. 

You must decide which two(2) LINES from which of two(2) PARTS you want to

select for each SLIDE-JOINT. 

For example:

There are a total three PARTS. You must add two(2) SLIDE-JOINTS:

SLIDE-JOINT#1 - joins LINES 1 and 2 (in PARTS 1 and 2), 

SLIDE-JOINT#2: joins 

OPTION A: LINES 3 and 1 (in PARTS 3 and 1)

OR

OPTION B: LINES 3 and 2 (in PARTS 3 and 2)

OPTION A or OPTION B is important when you also add a MOTION-DIMENSION

FBS  to control the motions of the two(2) PARTS.

111
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KE-AddSLideJointBasic.gif
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Preparation example:

 LINE in the BASE-PART 

 CAD-LINE along the center of a SLID-

ING-PART

 CAD-LINE in a PART that is COM-

PLETELY-FREE

You want to join the PART that is com-

pletely-free  to be collinear with the

existing SLIDE-JOINT.

STEP 1: Add Slide-Joint 

Mechanism menu > Add

Slide-Joint 

OR

Kinematic elements toolbar

> Add Slide-Joint 

STEP 2: Select two(2) Lines:

1. Click the CAD-LINE  in the

COMPLETELY FREE PART. 

2. Click LINES  at 

You have clicked a total of three(3)

LINES.

However, the SLIDE-JOINT is between

two(2) LINES. 

Therefore, there is AMBIGUITY. Which

two(2) LINES do you want for the SLIDE-

JOINT?

“AMBIGUITY” : when MechDesigner

does not know which elements you

want to select.

When there is ambiguity, the
SELECT ELEMENTS DIALOG

opens.

<<< SELECT-ELEMENTS DIALOG
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Two Lines are Compatible

STEP 3: Select the TWO Lines

in the Select-Elements

dialog

1. Click a LINE (CAD-LINE2)

at the top of the Element

list (CAD-LINE2) 

2. key down

AND

3. Click one other LINE in

the Element list.

You CAN select:

CAD-LINE2 AND CAD-LINE

are compatible

OR

CAD-LINE2 AND CAD-

LINE3 are compatible

You CANNOT select:

CAD-LINE and CAD-LINE3

are NOT compatible (im-

age below)

Why not CAD-LINE and CAD-

LINE3 ? 

There is a SLIDE-JOINT

between CAD-LINE and

CAD-LINE3 already.

Two Lines are Compatible

Two Lines are NOT Compatible

STEP 5: Close the Select-Elements

dialog 

SELECT-ELEMENTS DIALOG: Click 

to close the SELECT-ELEMENTS DIA-

LOG. 

There are now two(2) SLIDE-JOINT

between three(3) LINES
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1.5.5.1.2.5  Add Ball-Joint

Ball-Joint

2x Ball-Joints in

MechDesigner

Rod-End Bearing 2 x Ball-Joint in

SOLIDWORKS

Terminology: 

BALL-JOINT : A BALL-JOINT makes a POINT in a Connecting-Part

coincident with a POINT in a different PART.

You must add a BALL-JOINT to each end of a Con-

necting-Part :

· 1 x BALL-JOINT between POINTS in different

PARTS that are in the active MECHANISM-EDITOR

· 1 x BALL-JOINT between POINTS in different

PARTS that are in different MECHANISM-EDITORS

Spherical-Joint : The kinematic and equivalent term for a BALL-JOINT. 

KINEMATICS-TREE : Dyads R-S-S, P-S-S - the joints in a dyad use the letter

S for a BALL-JOINT. 

Derived Names: 

Connecting-Part : A PART with a BALL-JOINT at its START-POINT and at

its END-POINT.

Part that is Completely-Free : A PART with 3 degrees-of-freedom (no joints).

Part that is Free : A PART with 1 or 2 degrees-of-freedom. 

See also: Ball-Joint dialog , Connecting Part Length and Diameter .

See also Ball-Joint configurations

Preparation

A typical preparation:

559 117
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A typical prerpation for Add Ball-Joint

Mechanism A

Usually, Mechanism A is perpendicular( ) to Mechanism B

· PART  is kinematically-defined - in the image, PART  is Pink 

Mechanism B - the active MECHANISM-EDITOR

Three PARTS: 

1 x PART is usually the BASE-PART - it is kinematically-defined.

2 × PARTS  are not kinematically-defined. 

· PART  is a PART that is free. It has a PIN-JOINT to join it to the BASE-

PART.

· PART  is a PART that is Completely Free. It does not have any joints

before you do Add Ball-Joint.

Notes:

The MECHANISM-EDITORS cannot be parallel to each other. They are

usually perpendicular( ) to each other.

As you add the PART that is Completely-Free, try to estimate its length.

If it is too short or too long, the BALL-JOINTS cannot join the Completely

Free PART to PART  and PART  - you do not get the expected result. 

Add Ball-Joint × two(2)

Do Add Ball-Joint two(2) times. One time to each end of the COMPLETELY

FREE PART. 

STEP 1: Start the Add Ball-Joint com-

mand

Mechanism menu > Add

Ball-Joint

OR

Kinematic elements tool-

bar > Add Ball-Joint

STEP 2: Add Ball-Joint #1 
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MECHANISM-EDITOR B is active. 

1. Click POINT  at the end of

the PART that is Com-

pletely-Free 

2. Click POINT  at the end of

the PART that is Free.

If you cannot select the POINTS to

add a BALL-JOINT, disable the

Auto-Update tool , and try

again.

After you do Add Ball-Joint #1 you

can see the Ball-Joint symbol.

However, POINTS  do not snap

together. You must do Add Ball-

Joint #2.

STEP 3: Add Ball-Joint #2 

1. Click POINT  at the other end

of the PART that is Completely-

Free 

2. Click POINT  - the Pink Point -

 at the end of the PART that is

kinematically-defined in

MECHANISM-EDITOR(A)

RESULT - Graphics-Area

The BALL-JOINTS  snap to the

POINTS in MECHANISMS A and B.

The PARTS that were Completely-

Free and Free are now kinematic-

ally-defined

If the arrangement of the PARTS that

were Completely-Free and Free is not

correct, then see Change-Dyad Clos-

ure

49

119
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RESULT - Kinematics-Tree

In the KINEMATICS-TREE , 

There is a new Dyad - the R-S-S

dyad. 

The three Joints in the Dyad are:

· PIN-JOINT  is the R joint -

R is for Revolute-Joint

· BALL-JOINTS  are the S

Joints - S is for Spherical-

Joint

Connecting-Part: Edit Length, Rod Diameter, Ball-Diameter

Notes: 

· You cannot add SOLIDS to Connecting-Parts. 

To edit the LENGTH of the CONNECT-

ING-PART

1. MECHANISM-EDITOR: Double-

click the symbol for the Con-

necting-Part 

It is now open in the PART-EDITOR.

2. PART-EDITOR: Edit the Length

dimension of the Connecting-

Part

3. Exit the PART-EDITOR

To edit the SYMBOLIC RADIUS of the

CONNECTING-PART

1. MECHANISM-EDITOR: Double-

click the symbol for the Con-

necting-Part 

It is now open in the PART-EDITOR.

2. PART-EDITOR: Add a LINE or

CIRCLE 

3. PART-EDITOR: Add a dimension

to the LINE or CIRCLE

4. Exit the PART-EDITOR

318
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The dimension of the LINE or

CIRCLE is the Radius of the Con-

necting-Part.

To edit the symbolic diameter of the

BALL-JOINT - see Ball-Joint dialog

Notes: 

In the PART-EDITOR, when the view

is not the Front View, the CAD-

LINE, Axes, sketch-elements and

dimensions may show in unusual

places! If you cannot add or edit a

dimension: do View toolbar >

Front Plane (F3)

To see the symbol of the BALL-

JOINT: enable Visibility toolbar >

Show Solids in Mechanisms

559

66
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1.5.5.1.2.6  Change Dyad Closure

Change Dyad Closure / Change Configuration Assembly of a

Dyad

Terminology

 Dyad : A dyad is an assembly of two PARTS and three joints.

Each Joint can be a SLIDE-JOINT, a PIN-JOINT, or a BALL-JOINT.

- One joint joins the two PARTS together

- The other two joints join the two PARTS to two other PARTS that

are kinematically-defined.

The two PARTS in a dyad are kinematically-defined.

Assur Groups : A different name for a dyad. 

Dyad Closures : The different ways you can assemble the two PARTS of a dyad

“Configuration of the Dyad's Assembly” is a different way to express “Dyad Closure”.

 

Types of Dyad : Planar Dyads: R-R-R, R-R-P, R-P-R*, R-P-P, P-R-P

Spatial Dyads: S-S-R, S-S-P

R : Revolute Joint = Pin-Joint

P : Prismatic Joint = Slide-Joint

S : Spherical Joint = Ball-Joint

* This dyad does not correctly change its closure if the PIN-JOINT(R)

are offset from the SLIDE-JOINT and along the y-axis of each PART

in the dyad.

See more: Dyads

Change Dyad Closure

RRR Dyad

Closure 1

Command-Manager: Change Dyad

Closure

STEP 1: Start the Change Dyad Clos-

ure command

1. Mechanism menu >

Change Dyad Closure 

OR

1. Kinematic elements

toolbar > Change-

Dyad Closure 

The COMMAND-MANAGER indicates

you must select a PART in the Dyad.

STEP 2: Select one Part in the Dyad

2. Click the PART-OUTLINE of a

PART in the Dyad whose as-

sembly-configuration (Dyad-

Closure) you want to change. 

STEP 3: Complete the Command 

102

110

114
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RRR Dyad

Closure 2

3. Click  in the COMMAND-MAN-

AGER 

The configuration of the assembly

(Dyad Closure) should now be dif-

ferent. 

<<< compare the bottom image with

the top image.

STEP 4: Do again, if needed 

4. If necessary, do 1 to 3 again

and again to find the configur-

ation of the assembly you want

to apply to your design. 

Top-Tip:

When there are many dyads in the model, it is sometime difficult to see

which dyad whose closure you need or want to change.

1. KINEMATICS-TREE: Click to expand each Kinematic-Chain in the

KINEMATICS-TREE 

2. KINEMATICS-TREE: Click each dyad

The color of the five elements in the dyad (2 PARTS + 3 JOINTS) change

to the SELECTED COLOR (usually red) in the graphics-area.

Assembly-Configurations of the R-R-P Dyad

The joints in the R-R-P Dyad are: Revolute – Revolute – Prismatic.

In MechDesigner, the joints are: Pin-Joint – Pin-Joint – Slide-Joint.

There are 4 possible assembly configurations (Dyad Closures) for this dyad.

The image below shows an Offset-Slider-Crank mechanism.

4 x Assembly Configurations of an Offset-Crank-Slider

PART  is the Crank - to illustrate the 4 dyad closures. The Crank is not in

the Dyad.

Dyad: The PARTS in the R-R-P dyad are PARTS  and . 
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To imagine the four assembly-configurations, we imagine we have not yet

added the PIN-JOINT (R2) between PART  and PART .

PART  : can rotate around the PIN-JOINT, R1, at the end of the Crank. 

Therefore, PIN-JOINT R2 can ONLY be on the red circle at the end of PART

.

PART  : can only slide along the SLIDE-JOINT, P1, along LINE .

IMPORTANT: The POINT in PART  for PIN-JOINT (R2) is offset from the SLIDE-

JOINT and not on the SLIDE-JOINT. 

Therefore, PIN-JOINT R2 can ONLY be on one of the red lines that are off-

set from the SLIDE-JOINT.

The red circle intersects the red lines at 4 places.

Therefore, the PIN-JOINT R2 can be at 4 places. 

Therefore, the Offset Slider-Crank and the R-R-P dyad has 4 possible as-

sembly configurations (Dyad Closures).
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1.5.5.1.2.7  Add Trace-Point

Trace-Point

Terminology:

TRACE-POINT : the locus, or path, of a moving POINT* relative to the MECHANISM-

PLANE for one machine-cycle.

* POINT, START-POINT, END-POINT, CENTER-POINT, MOTION-POINT

Add Trace-Point

Add Trace-Point does NOT add a POINT to your model. 

You must select a POINT * that is already in your model.

* POINT, START-POINT, END-POINT, CENTER-POINT, MOTION-POINT.

Three example Trace-Points

STEP 1: Start the Add Trace-Point com-

mand

1. Mechanism menu > Trace-Point 

OR

1. Kinematic elements toolbar

> Add Trace-Point 

STEP 2: Click a Point

2. Click a POINT* in the graphics-area.

 

For example, in the image, POINTS 

* START-POINT, END-POINT, CENTER-POINT,

POINT, or MOTION-POINT

See below: How to drag a Point with a Trace-

Point.

If the SELECT-ELEMENT DIALOG  opens, you have clicked more than one POINT.

 1.a.  CTRL + click a POINT in the SELECT-ELEMENTS DIALOG 

123

616
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 1.b. Click  to close the SELECT-ELEMENTS DIALOG

STEP 3: Complete the command 

3. Click  in the Command-Manager

The TRACE-POINT is now in the graphics-area. 

Video: 

Double-click to watch Video

 How to drag a Trace-Point

Normally, when the MECHANISM-EDITOR is active, you cannot drag a sketch-

element.

However, as a special-case, you can move a POINT** with a TRACE-POINT, if

the Point does not have any constraints.

In this special case, it is easier to search for a “good” TRACE-POINT. 

** NOT a START-POINT, END-POINT, CENTER-POINT or MOTION-POINT

To drag a POINT in the MECHANISM-EDITOR:

In the PART-EDITOR:

1. Do Add Point 

Do not add a dimension or a constraint to the POINT

2. Exit the PART-EDITOR

In the MECHANISM-EDITOR:

3. Do Add Trace-Point and select the POINT 

4. Drag the POINT!

Note:

To make it easier to drag the POINT:

· Reduce the NUMBER-OF-STEPS to ~60 - see Machine Setting dialog  

and / or

· Drag the POINT but do not lift your mouse-pointer until the TRACE-

POINT also moves

To add a Trace-Point of a Point relative to a Part that is NOT the Base-

Part

A TRACE-POINT is the locus of a POINT in a moving PART relative to the BASE-

PART. To see the locus of a POINT in a moving PART relative to a different

moving PART, you can add a 2D-CAM, and show only the path of the PITCH-

CENTER.

1. Edit the PART with the POINT whose locus you want to see relative to

a moving PART. 

56


KE-AddTracePoint-1280x720.gif
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2. Add a CIRCLE, and add a Coincident constraint between the CENTER-

POINT of the CIRCLE and the POINT. 

3. Exit the PART-EDITOR

4. Add a PROFILE to the CIRCLE 

Add 2D-Cam - you must select two elements:

5. Cam-Part: Select the PART in which you want to show the locus of the

POINT 

6. Follower Profile: Select the PROFILE of the CIRCLE

To show the locus of the POINT

7. Edit the 2D-CAM.

8. In 2D-CAM DIALOG > Display tab > CAM-VISIBILITIES > Enable PITCH-

CENTER.

The locus of the PITCH-CENTER is the locus and TRACE-POINT of the POINT rel-

ative to the Cam-Part.
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1.5.5.1.2.8  Add Reference Geometry

Reference Geometry

Terminology: 

Reference Geometry : General term for a sketch-element that we copy from a dif-

ferent MECHANISM-EDITOR to the active MECHANISM-ED-

ITOR. 

Source Sketch-Element : A sketch-element, in a moving or stationary PART, in a dif-

ferent MECHANISM-EDITOR.

Reference Sketch-Element : A copy of the Source sketch-element, and its motion, to a

PART in the active MECHANISM-EDITOR.

Preparation 

Preparation example: 

Two(2) MECHANISM-EDITORS:

· Source 

· Reference  - the active editor

In the image, there is a CIRCLE  in the

“source MECHANISM-EDITOR”.

To see the sketch-elements and PARTS in the “source MECHANISM-EDITOR”

when the “reference MECHANISM-EDITOR” is active:

· Visibility toolbar (or menu) > Show other Kinematic and

Sketch elements

AND

· Right-click MECHANISM NAME-TAB of the “Source MECHANISM-

EDITOR” and select Show with 'other Kinematic and Sketch

elements' . 

AND

· View toolbar > Spin or use your arrow keys on your keyboard

to spin the model to see the two editors.

Add Reference Geometry

STEP 1: Start the Add Reference-Geo-

metry command

1. Mechanism menu >

Add Reference Geo-

metry 

OR

63

63
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1. Kinematic elements

toolbar > Add Refer-

ence Geometry 

The COMMAND-MANAGER indicates you

must select two(2) elements

STEP 2: Select the two elements in

the graphics-area 

1. Click a sketch-element in the

Source REFERENCE-EDITOR. 

e.g. Click the CIRCLE  in the

Source MECHANISM-EDITOR .

2. Click a PART in the Reference

MECHANISM-EDITOR 

In this case there is only one PART -

the BASE-PART - in the Reference

MECHANISM-EDITOR.

STEP 3: Complete the Command 

4. Click  in the COMMAND-MAN-

AGER.

RESULT : 

The REFERENCE GEOMETRY  is now

in the reference MECHANISM-ED-

ITOR.

We also transfer the motion of the

sketch-element from the source

MECHANISM-EDITOR  to the refer-

ence MECHANISM-EDITOR. 

Video:

Double-click to watch Video Clip


KE-AddReferenceGeometry.gif
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1.5.5.1.3  Machine elements

Machine elements

Machine elements are the hardware components that you install on industrial

machines.

Mechanism menu > Machine elements

Mechanism menu > Machine elements (MD17)

Machine elements toolbar

The Machine elements toolbar is to the left of the graphics-area.

Machine elements toolbar
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1.5.5.1.3.1  Add 2D Cam

2D-Cam

See also: 2D-Cam dialog

Add 2D-Cam does NOT remove a degree-of-freedom from the model.

We calculate for you the shape of a 2D-CAM from the relative motions of a

Cam-Part and a Follower-Part, together with the shape of the Follower-Pro-

file. 

Add the Cam-Part, Follower-Part, and Follower-Profile to the model before

you do Add 2D-Cam.

Cam-Terminology / 2D-Cam Work-flow

Cam Terminology

Terms : Definitions

Cam (or Cam-Part) : 
The PART to which you add the  (2D-CAM) to gen-

erate the shape of the Cam-Profile.

Cam-Shaft :

 

The most common Cam-Part. It is a rotating-Part

(a shaft), to which you add the 2D-CAM (or 3D-

CAM) as a Cam-Profile. A Cam-Shaft usually ro-

tates with a constant angular-velocity.

Cam-Profile : 
The Cam-Flank and surface that is an extrusion of

a 2D-CAM (or 3D-CAM) which is in continuous con-

tact with the Follower-Profile.

Track-Cam or Groove-Cam : 
A groove that is cut into a Cam-Blank with an

Outer and an Inner Cam-Profile. A Follower-Roller

fits in the groove.

Follower (or Follower-Part) : The PART that supports the Follower-Profile. 

Follower Kinematic-Chain 

(or Kinematic Mechanism) : 

The Follower-Part and the other PARTS that you

join to the Follower-Part, to move the Tooling or

Tool-Part.

Follower-Profile : 
The surface of a machine component that is rigidly

connected to the Follower-Part. The surface is in

continuous contact with the Cam-Profile.

Follower-Roller : 
A Follower-Profile that is cylindrical or barrel-

shaped that is rigidly connected to the Follower-

Part.

Flat-faced Follower : 
A Follower-Profile that is a flat surface that is ri-

gidly connected to the Follower-Part.

Translating Follower : 
A Follower-Part that that moves along a straight

axis.

Reciprocating Motion : 
A Translating Follower with a non-progressive

motion.

Rotating Follower : A Follower-Part that rotates about a fixed axis.

Oscillating Motion : A rotating-Part with a non-progressive motion.

401
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Terms : Definitions

Progressive Motion : 
A motion, usually followed by a Dwell, that moves

the Follower-Part progressively in one direction.

Non-Progressive Motion : 
A motion that returns the Follower-Part to its ori-

ginal position after each machine cycle.

 Indexing : A progressive motion, usually rotating.

Indexer : 

A device whose input is a constant-speed (usually)

Cam-Shaft and output is a rotating-Part with a

progressive motion. The input rotates one time to

index the output one time. The index-angle is such

that 360º/(Index-Angle) is an integer. 

Cam-Blank : 
The material from which you cut the shape of the

Cam-Profile.

Cam Work-flow

Action Help Topic

1. Add a 2D-Cam  see Add 2D-Cam

If the new 2D-CAM is one of a pair of Conjugate-Cams, or it is one flank of a

Groove-Cam:

 1.a. Add a CONJUGATE-CAM FB see Add Conjugate Cam FB  

 1.b. Edit the CONJUGATE-CAM FB to se-

lect the two 2D-CAMS.

see Conjugate-Cam dialog

2. Select a 2D-CAM or a CONJUGATE-

CAM FB as the Power Source for the

kinematic-chain that includes the Fol-

lower 

see Configure-Power Source  

3. Review the 2D-CAM : Display, Proper-

ties, Roller-Life, Cam-Life, ...

see 2D-Cam dialog  

4. Add a Cam-Data FB see Add Cam-Data FB  

5. Edit the CAM-DATA FB to link it to a

2D-CAM - close the dialog 

see Cam-Data dialog

6. Connect wires from the output-connectors of the CAM-DATA FB to a GRAPH FB 

7. Analyze the 2D-CAM see Cam-Data dialog : Cam Ana-

lysis

8. Edit the CAM-DATA FB again to calcu-

late the Cam's Coordinates 

see Cam-Data dialog : Cam-Coordin-

ates

128

165

436

589

401

199

440

440

446
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Prepare to add 2D-Cam (typical):

Preparation for Add 2D-Cam

The elements you need in the model

before you can do Add 2D-Cam:

Cam-Part  - any PART that is kin-

ematically-defined

Follower-Part  - any other PART

that is kinematically-defined

Follower-Profile  - a PROFILE in

the Follower-Part

The Cam-Part usually moves, but it

may be stationary.

The Follower-Part usually moves,

but it may be stationary.

The Cam-Part and the Follower-

Part must move relative to each

other.

The Cam-Part and Follower-Part

are usually in different kinematic-

chains, but they may be in the

same kinematic-chain.

See also Follower-Profile Shapes.

Do Add 2D-Cam: 

STEP 1: Click Add 2D-Cam 

1. Mechanism menu >

Add 2D-Ca 

OR

1. Machine-elements

toolbar > Add 2D-Cam 

The COMMAND-MANAGER indicates you

need to select two elements.

STEP 2: Select the two elements 

Element 1 is the PART to which you

want to add the 2D-CAM - the

Cam-Part.

1. Click the PART-OUTLINE  in

the graphics-area, or the PART

element in the ASSEMBLY-TREE 
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Element 2 is the Follower-Profile

in the Follower-Part.

2. Click the PROFILE  in the

graphics-area or the PROFILE

element in the ASSEMBLY-TREE

Typically, the Follower-Profile is a Fol-

lower-Roller or a Flat-Faced Follower.

STEP 3: Complete the Command 

3. Click  in the COMMAND-MAN-

AGER. 

It may be necessary to do Rebuild

Now - see Quick Access menu

RESULT : 

Graphics-area

The INNER and OUTER 2D-CAMS

show in the graphics-area.

RESULT : 

Assembly-Tree

A Cam-Plate  as a child to PART

 (Cam-Part).

The 2D-CAM  is a child to the

Cam-Plate . 

The icon for the 2D-CAM element in the ASSEMBLY-TREE may warn you that it

is a “Bad Cam”.

We warn you that a 2D-CAM is a “Bad Cam” when its minimum Radius-

of-Curvature is less that than a preset percentage of the radius of the

Follower-Roller. There is a default percentage and a percentage we

can set for a each 2D-CAM.

Default Percentage - see Application-Settings

Each 2D-CAM - see 2D-Cam dialog > Cam Range and Radius  

341

403
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YOU must make sure the cam is suitable for your needs, even if it is a

“Good Cam”.

“Good Cam”

“Bad Cam”

Next Steps: see 2D-Cam Work-Flow .

Video (EN):

Double-click to watch Add a 2D-Cam

128


ME-Add2DCam.gif
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1.5.5.1.3.2  Add 3D Cam

3D-Cam

See also: 3D-Cam dialog

Add 3D-Cam does NOT remove a degree-of-freedom from the model.

We calculate for you the shape of a 3D-CAM from the relative motions of a

Cam-Part and Follower-Part, together with the shape of the Follower-Pro-

file. 

You must also add the shape of the Cam-Blank and its rotating-axis. The

elements are in different 3 or 4 MECHANISM-EDITORS. 

We recommend you do  Tutorial 6C: Barrel and Globoidal Cams before you

use this command the first time.

Terminology

 3D-CAM : A 3D-CAM has complex and twisting Cam-Surfaces

(Cam-Flanks) that interact with Follower-Rollers. 

The rotating-axis of the Cam-Part is not parallel with the

rotating-axis of the Follower-Part. 

There many variants of a 3D-CAM.

Barrel, Cylindrical, and Globoidal Cams are different types of 3D-CAMS. 

Globoidal Cams are also known as Roller-Gear-Drives and Ferguson Cams.

There are also Face, Groove, and Rib types. The CAM-PART, or the FOLLOWER-PART,

can be stationary. or rotate with a constant, or a non-constant angular-velocity.

Prepare for Add 3D-Cam (typical)

ALL PARTS are kinematically-defined before you do Add 3D-Cam.

You must select 5 elements, from 3 or 4 MECHANISM-EDITORS.

The five elements are:

 PART : Follower

 PROFILE : Follower-Roller

 PART : Cam (in the active MECH-

ANISM-EDITOR)

 PROFILE : Cam-Blank

 LINE : Cam-Blank Rotational-

Axis

To see the five elements in the graphics-area:

· Visibility toolbar (or menu) > Show other Kinematic and

Sketch elements  

AND

384

63

http://mechdesigner.support/index.htm?md-barrel-globoidal-cams.htm
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· Right-click the Mechanism name-tab of each MECHANISM-ED-

ITOR and click Show with 'other Kinematic and Sketch ele-

ments' . 

AND

· View toolbar > Spin, or use your arrow keys on your keyboard,

to spin the model to see the 5 elements in the 3 or 4 MECHAN-

ISM-EDITORS.

It is also easier if you hide SOLIDS:

Deselect : Visibility toolbar (or menu) > Show Solids in Mechan-

isms  

Add 3D Cam

STEP 1: Click Add 3D-Cam 

1. Mechanism menu > Add

3D-Cam 

OR

1. Machine-elements tool-

bar > Add 3D-Cam 

There are five elements to select in

the COMMAND-MANAGER.

STEP 2: Click the five elements in the

graphics-area or Assembly-

Tree.

 PART: Follower: the Cyan PART-

OUTLINE

 PROFILE: Follower-Roller: the

Pink PROFILE

 PART: Cam: the Green PART-

OUTLINE in the active Mechan-

ism-Editor

 PROFILE: Cam-Blank Profile: the

Yellow Profile (contour)

 LINE: Cam-Blank Rotational

Axis: the Yellow Line

STEP 3: Complete the command

1. Click  in the COMMAND-MAN-

AGER. 

STEP 4: Edit and save the 3D-Cam 

1. Open the 3D-Cam dialog  

Elements to add a 3D-Cam:

63

66

384
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Edit the 3D-CAM parameters, ex-

port the XYZ surface data-points,

or save the 3D-Cam as a STEP file.

 

RESULT

You can see the 3D-CAM in the

graphics-area.

See 3D-Cam dialog

The 3D-CAM has four surfaces,

which enclose the solid volume

that you cut from a Cam-Blank.

The four surfaces are:

· Cam Flank × 2 - one flank for

each working side of the Fol-

lower-Roller

· Floor Surface - a surface to

connect the bottom edges of

the Cam-Flanks

· Top Surface - a surface to con-

nect the top edges of the Cam-

Flanks. This surface should be

outside of the Cam-Blank. 

Video:

Double-click to watch Video

384


ME-Add3DCam.gif



136

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.5.1.3.3  Add Rack-Pinion - Ball-Screw

Rack-Pinion / Ball-Screw

See also: Rack-Pinion dialog

Add Rack-Pinion removes ONE degree-of-freedom from the model.

Before you do Add Rack/Pinion, the PINION OR the RACK is kinematically-

defined.

After you do Add Rack/Pinion, the PINION AND the RACK are kinematic-

ally-defined.

We calculate for you:

· the motion of a RACK from the motion of a PINION 

OR 

· the motion of a PINION from the motion of a RACK

Terminology

RACK -PINION : A RACK-PINION is the term for a sliding, straight, linear-gear

(RACK) that is in mesh with a rotating, circular, gear-wheel (PIN-

ION). 

The motions of the two PARTS are kinematically related by the

module and number-of-teeth on the PINION.

BALL-SCREW : A BALL-SCREW is a device in which a Screw rotates to move a Nut,

or vice-versa. The Linear-Motion of the Nut and the rotation of the

Screw are related by the lead of the screw-thread. 

sliding-Part : A PART that is joined to another PART with a SLIDE-JOINT.

rotating-Part : A PART that is joined to another PART with a PIN-JOINT.

How to prepare for Add Rack-Pinion (typical)

There are two model types.

A: The motion of the Rack is from the motion of a Pinion:

Elements before you do Add Rack-Pin-

ion

LINE  - in a rotating-Part that is kin-

ematically-defined

LINE  - in a Sliding-Part that is not

kinematically-defined

LINE or CAD-LINE

B: The motion of the Pinion is from the motion of a Rack

577
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Elements before you do Add Rack-Pin-

ion

LINE  - in a sliding-Part that is kin-

ematically-defined

LINE  - in a rotating-Part that is not

kinematically-defined

LINE or CAD-LINE

Add Rack-Pinion

A: If the motion of the Rack is from the motion of a Pinion

STEP 1: Click Add Rack-Pinion 

1. Mechanism menu >

Rack-Pinion 

OR

1. Machine-elements tool-

bar > Add Rack-Pinion 

In the COMMAND-MANAGER, there

are two elements to select.

STEP 2: Select the two elements in

the graphics-area

1. Click LINE  in the PART that is

kinematically-defined. 

2. Click LINE  in the PART that is

NOT kinematically-defined. 

STEP 3: Complete the Command 

1. Click  to complete Add Rack-

Pinion.

RESULT : 

The PINION is on the Rotating-

Part. 

The rotating-axis of the PINION

is coincident with the PIN-

JOINT.

The RACK is on the Sliding-Part. 

The RACK is parallel with the

SLIDE-JOINT. 

The Pitch-Line of the RACK is off-

set from the center of the PINION
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by the Pitch-Circle Radius of the

PINION.

The sliding-Part is now a PART that

is kinematically-defined.

B: If the motion of the Pinion is from the motion of a Rack

STEP 1: Add Rack-Pinion 

1. Mechanism menu > Add

Rack-Pinion 

OR

1. Machine-elements tool-

bar > Add Rack-Pinion 

In the COMMAND-MANAGER, there

are two elements to select.

STEP 2: Select the two elements in

the graphics-area 

1. Click LINE  - it is in the PART

that is kinematically-defined. 

2. Click LINE  - it is in the PART

that is NOT kinematically-

defined. 

STEP 3: Complete the Command 

4. Click  in the COMMAND-MAN-

AGER. 

The RACK-PINION is now in the

ASSEMBLY-TREE and graphics-area.

RESULT : 



139

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

The PINION is on the Rotating-

Part. 

The rotating-axis of the PINION

is coincident with the PIN-

JOINT.

The RACK is on the Sliding-Part. 

The Pitch-Line of the RACK is

parallel to the SLIDE-JOINT and

sliding-Part. 

The rotating-Part is now a PART

that is kinematically-defined.

Kinematics-Tree of Rack-Pinion

 If the motion of the Pinion is from

the motion of the Rack 

Before you do Add Rack-Pinion,

there is a sliding-Part that is kin-

ematically-defined and a rotating-

Part that has one degree-of-free-

dom.

After you do Add Rack-Pinion, the

sliding-Part(Rack) and the rotat-

ing-Part (Pinion) are kinematic-

ally-defined.

 If the motion of the Rack is from the

motion of the Pinion

Before you do Add Rack-Pinion,

there is a rotating-Part that is kin-

ematically-defined and a sliding-

Part that has one degree-of-free-

dom.

After you do Add Rack-Pinion, the

rotating-Part (Pinion) and the slid-

ing-Part (Rack) are kinematically-

defined, and in one kinematic-

chain.
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Video of Add Rack-Pinion

Double-click to watch Video


ME-AddRackPinion-A.gif



141

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.5.1.3.4  Add Gear-Pair

Gear-Pair

See also: Gear-Pair dialog , Add Bevel Gear-Pair

Add Gear-Pair removes ONE degree-of-freedom from the model.

Before you do Add Gear-Pair, 

· the Driving-Part, which will be the input PINION, is kinematically-

defined.

· the Driven-Part, which will be the output WHEEL, is NOT kinematic-

ally-defined.

After you do Add Rack/Pinion, 

· the Driving-Part AND the Driven-Part are kinematically-defined.

· we add a Gear to the Driving-Part  

· we add a Gear to the Driven-Part

Gear Terminology

Gear-Wheel (or Gear) : A rotating-Part with gear-teeth at a fixed diameter. You

control its diameter with the number-of-teeth and module.

GEAR-PAIR : Two inter-locking gear-wheels. Their teeth have External or

Internal mesh. The angular velocity of each gear-wheel is

related by the number-of-teeth on each gear-wheel, and the

type of mesh.

Driving Part : The rotating-Part that is kinematically-defined, and whose

motion you control (even if it is stationary) before you do

Add Gear-Pair.

Driven Part : The rotating-Part whose motion you control by the motion

of the Driven-Part, the NUMBER-OF-TEETH on each gear-

wheel in the GEAR-PAIR, and the MESH.

Gear-Mesh (or Mesh) : Inter-locking gear-teeth of a GEAR-PAIR that transmit torque

and motion from the Driving Part to the Driven Part.

External Mesh : The gear-teeth of the two gear-wheels point outwards from

their centers-of-rotation.

Internal Mesh : The gear-teeth of one gear-wheel point inwards towards its

center-of-rotation.

Simple Gear-Pair : Two gear-wheels that rotate about two fixed centers.

Epicyclic Gear-Pair : One gear-wheel orbits around the center of the other gear-

wheel.

Prepare to Add Gear-Pair

A : Simple Gear-Pair

566 146
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3 × PARTS ; 3 × LINES ; 2 × PIN-

JOINTS

LINE  and LINE  and PARTS are

kinematically-defined 

LINE  and PART is not kinematic-

ally-defined

LINES  are joined with PIN-

JOINTS to each end of LINE

LINE  has a DIMENSION  (in the

PART-EDITOR)

B : Epicyclic Gear-Pair

3 × PARTS ; 3 × LINES ; 2 × PIN-

JOINTS

LINE  and LINE  and PARTS are

kinematically-defined

LINE  and PART is not kinematic-

ally-defined. 

LINES  are joined with PIN-

JOINTS to each end of LINE

LINE  has a DIMENSION  (in the

PART-EDITOR)

Add Gear-Pair

A : Simple Gear-Pair

STEP 1: Click Add Gear-Pair (Simple)

1. Mechanism menu >

Gear-Pair 

OR

1. Machine-elements tool-

bar > Add Gear-Pair 

There are four elements to select in the
COMMAND-MANAGER
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STEP 2: Select the four elements 

1. MECHANISM-EDITOR > Click LINE

 

2. MECHANISM-EDITOR > Click LINE

3. MECHANISM-EDITORS : Click LINE

 

STEP 2: continued... 

The PART-EDITOR opens automatic-

ally.

4. PART-EDITOR: Click the DIMEN-

SION  

The PART-EDITOR closes automatic-

ally.

STEP 3: Complete the Command 

5. Click  in the COMMAND-MAN-

AGER. 

RESULT: 

The GEAR-PAIR is in the graphics-

area.

The default GEAR-PAIR has an Ex-

ternal Mesh and the gears have an

equal number-of-teeth.

The length of the LINE between the

centers of the gears - called the

Line-of-centers - is now a Driven-

Dimension.

The length of the Line-of-Centers

= (# Gear-Teeth 1 + # Gear-Teeth

2) × Module

The output PART is a Geared-

Rocker in the KINEMATICS-TREE .

To edit the GEAR-PAIR parameters: see

Gear-Pair dialog

B : Epicyclic Gear-Pair

318

566
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STEP 1: Click Add Gear-Pair (Epicyc-

lic)

1. Mechanism menu >

Gear-Pair 

OR

1. Machine-elements tool-

bar > Add Gear-Pair 

There are four elements to select in the
COMMAND-MANAGER

STEP 2: Select the four elements 

2. MECHANISM-EDITOR > Click LINE

 

3. MECHANISM-EDITOR > Click LINE

4. MECHANISM-EDITOR > Click LINE

 

STEP 2: continued... 

The PART-EDITOR opens automatic-

ally.

4. PART-EDITOR: Click the DIMEN-

SION  

The PART-EDITOR closes automatic-

ally.

STEP 3: Complete the Command 

5. Click  in the COMMAND-MAN-

AGER. 
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RESULT: 

The GEAR-PAIR is in the graphics-

area.

The default GEAR-PAIR has an Ex-

ternal Mesh and the gears have

same number-of-teeth.

The length of the LINE between the

Gear centers - called the Line-of-

centers - is a Driven-Dimension. 

The length of the Line-of-Centers

= (# Gear-Teeth 1 + # Gear-Teeth

2) × Module)

The output PART is a Geared-

Rocker in the KINEMATICS-TREE .

To edit the GEAR-PAIR parameters, see

Gear-Pair dialog

Kinematics-Tree of Gear-Pair

Add Gear-Pair removes one degrees-of-freedom.

Kinematics-Tree

Before you do Add Gear-Pair:

· a rotating-Part(1) that is

kinematically-defined 

· a rotating-Part(2) that is

NOT kinematically-defined

- it has one degree-of-free-

dom.

After you do Add Gear-Pair: 

· the two rotating-Parts(1

&2) are kinematically-

defined

· the rotating-Part(2) is now

a Geared-Rocker

Videos of Add Gear-Pair

Simple Gear-Pairs: Double-click to watch 'Add Gear-Pair - Simple'

Epicyclic Gear-Pairs:Double-click to watch ' Add-Gear-Pair - Epicyclic'

318

566


ME-AddGearPair-Simple.gif


ME-AddGearPair-Epicyclic.gif
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1.5.5.1.3.5  Add Bevel Gear-Pair

Add Bevel Gear-Pair

See also: Gear-Pair dialog  

Add Bevel Gear-Pair and Degrees of Freedom

Add Bevel Gear-Pair removes one(1) degrees-of-freedom.

What is a Bevel Gear-Pair?

When you do Add Bevel Gear-Pair, you add two gears that are in mesh, with

intersecting, PERPENDICULAR, rotating-axes. 

When you do Add Gear-Pair, you add two gears that are in mesh, with inter-

secting, PARALLEL, rotating-axes. 

We find for you the motion of the Driven-Gear from the motion of the Driv-

ing-Gear, the number-of-teeth, and the mesh (internal or external).

Kinematics-Tree of Bevel Gear-Pair

Add Bevel Gear-Pair removes one degrees-of-freedom.

Bevel Gear-Pair

Before you do Add Bevel Gear-

Pair, there is a 

· rotating-Part that is kin-

ematically-defined, and a 

· rotating-Part that has one

degree-of-freedom in a

different Mechanism-Editor

After you do Add Bevel Gear-Pair,

the rotating-Parts are kinematic-

ally-defined.

A Bevel-Pair is a child to the

Geared-Rocker.

Prepare Bevel Gear-Pair

To add a Bevel Gear-Pair is more complex than to add a Gear-Pair.

The PARTS you add for the two Bevel-Gears are on two different MECHANISM-

EDITORS.

The Mechanism-Planes of the two(2) MECHANISM-EDITORS must intersect. They

are frequently perpendicular to each other. 

Below, for convenience, the names of the two MECHANISM-EDITORS are MECH-

ANISM-A and MECHANISM-B.

566
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PREPARATION A1: MECHANISM A

LINE  and LINE  are in PARTS that

are kinematically-defined 

LINES  are joined with a PIN-

JOINT

LINE  has a DIMENSION (in the

PART-EDITOR)

See  Tutorial 1: Add a Rotating-Part.

Preparation A2: Add a Plane to the

Line in the Base-Part

1. Click Mechanism menu or

Model elements toolbar >

Add Plane 

2. Click the LINE  in the BASE-

PART

In the ADD PLANE DIALOG: 

1. Enable MOVE PLANE TO END-

POINT  

2. Enter 90º in the ROTATE

AROUND THE Z-axis

3. Enter 90º (default value) is in

ROTATE AROUND THE x-axis .

See  Tutorial 1: Add a Rotating-Part.

New Plane for Mechanism-B

Preparation A3: Add Mechanism-B to

the new Plane

1. Click Mechanism menu or

Model elements toolbar >

Add Mechanism-Editor 

2. Click the new PLANE

You jump to the new MECHANISM-

EDITOR - MECHANISM-B

http://mechdesigner.support/index.htm?mechdesigner-tutorial-1-add-crank.htm
http://mechdesigner.support/index.htm?mechdesigner-tutorial-1-add-crank.htm
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A) Enable Visibility toolbar > Show

other Kinematic and Sketch ele-

ments

AND

B) Right-click the Mechanism name-

tabs Light-Bulb > Enable Show with

other Kinematic and Sketch-Ele-

ments  

C) Spin the model to show the other

kinematic and sketch-elements 

Preparation B1: Add a new Part and

Pin-Joint 

1. Click Kinematic elements tool-

bar > Add Part | Drag to add

the PART  

2. Click Kinematic elements tool-

bar > Add Pin-Joint

a. Click the START-POINT of the

new PART

b. Click the END-POINT  of

the LINE in MECHANISM-A

The PIN-JOINT does not move the POINTS together. The PART  moves to a

new place!!! 

See also: Geared-Rocker, Dyads and Kinematics-Tree

Add Bevel Gear-Pair

NOTE: Click MECHANISM-A to make it

the active MECHANISM-EDITOR.

STEP 1: Click Add Gear-Pair  

1. Mechanism menu > Add

Gear-Pair 

OR

1. Machine-elements tool-

bar > Add Gear-Pair 

There are four elements to select in

the COMMAND-MANAGER.

STEP 2: Select the four elements 

63

63

318
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 The LINE along the center of the

rotating-Part in MECHANISM-A

 The LINE along the center of the

rotating-Part in MECHANISM-B

 The LINE in BASE-PART

... 

The PART-EDITOR opens to show LINE

and its dimension .

...

 Click the arrowhead, or the di-

mension line.

STEP 4: Complete the Command 

Click  in the COMMAND-MAN-

AGER. 

RESULT: 

The BEVEL GEAR-PAIR is in the

graphics-area.

The default BEVEL GEAR-PAIR has

an External Mesh and the gears

have an equal number-of-teeth.

All PARTS are kinematically-

defined.

BEVEL GEAR PART is in the KINEMAT-

ICS-TREE as a Geared-Rocker.

To edit the BEVEL-GEAR-PAIR paramet-

ers:  see Gear-Pair dialog
566
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1.5.5.1.3.6  Add Scroll

What is a scroll?

A SCROLL feeds products, typically bottles or cans, into a Rotating Machine.

The products are in a buffer as they move into the start of the Scroll. At the

end of the scroll, the products move into a star-wheel. The star-wheel feeds

the products into a rotating machine. 

The pitch of the products in the buffer, at the start of the scroll, is the same as

the length of the product. The products are moved apart by the scroll until

their pitch is the same as the pockets in the star-wheel, that is at the end of

the scroll. The pitch of the products on the star-wheel is the same as the pitch

of the products on the Rotary Machine. 

Other names for a SCROLL are: Feedscrew, Worm.

Add Scroll

Machine Elements toolbar > Add Scroll

Menu : Add menu > Mechanism sub-menu > Add Scroll

What to do : You must do the Preparation  before you can do Add Scroll.

You need five elements:

1. A PART for the moving 'Pack'. 

A sketch-loop is the cross-section of the 'Pack'. You must

also add a MOTION-PATH FB (see 5) and generate a number

of MOTION-POINTS to the sketch-loop.

2. A PART that is the rotating SCROLL.

3. A sketch-loop and PROFILE that is the cross-section of

the SCROLL.

4. A LINE to be the SCROLL'S axis-of-rotation.

5. A MOTION-PATH FB.

 Result : A SCROLL in the graphics-area.

 Preparation : There is a significant amount of preparation.

You must prepare five elements in 2 MECHANISM-EDITORS. See

Preparation  

When you click Add Scroll, you see five selection-boxes in the

COMMAND-MANAGER. 

Preparation for 'Add Scroll'

STEP 1: Pack: Shape; Motion, and Motion-Points 

The Pack moves along a line that is parallel to the scroll's rotation-axis. It is

also possible to rotate the Pack on its own axis as it moves from the entry to

150

133
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the exit of the scroll.

1. Add a Mechanism to

a 'Plane' - the 'Front'

Plane - in the Model-

Editor. 

2. Rename the Mechan-

ism-Editor to 'Pack'.

In the new Mechanism-

Editor:

3. Add a Slider with a

motion to define the

axial motion of the

Pack 

If the Pack rotates as it

moves along the scroll:

4. Add a Rocker to the

Slider Part, and a

motion to define the

rotation of the

Rocker / Pack

5. Then add the shape

of the Pack to the

Slider or Rocker.

The shape of the Pack

must be a sketch-loop. If

the Pack is not prismatic,

then the shape should

represent the its cross-

section at the height of

the scroll's rotational-

axis.

The Motion for the Axial and Rotation of the Pack
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Click to Expand and Collapse

Pack Axial Motion

The motion usually has a

'Constant Velocity Seg-

ment' as its first and last

segment.

Thus, there are two(2)

Velocities you must con-

sider.

Start Velocity, (SV)

Packs are usually adja-

cent '(bunched up',

'back-to-back')

SV = Product-Length ÷

Time for scroll to rotate

one time

Final Velocity, (FV)

Packs should be at the

same pitch as the star-

wheel or circular pitch of

the Rotary Machine

FV = Rotary Pitch ÷ Time

for scroll to rotate one

time

'Time', or 'Number of

Machine Degree', for

Scroll to rotate one time.

This is a function of the

number-of-times the

scroll rotates. Thus, of

the length of the Scroll

The first constant velo-

city is the speed of the

bottle at its entry.

The last constant velo-

city is the speed of the

bottle at its exit.

You need to edit the

motion later.
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Pack Rotation

The Pack rotates by 90º

as it moves from the

entry to the exit.

The duration of the seg-

ment that rotates the

pack is the same dura-

tion as the segment that

accelerates the pack.

Motion-Path, Motion-Points. 

In order to calculate the

shape of the scroll, you must

define the contact between

the Pack and the Scroll.

Rather than a Profile, you

add Motion-Points to the

shape of the Pack. Each Mo-

tion-Point define a 'Rim'

along the scroll - as you see.

1. Click Add Motion-

Path 

2. Click one of the

sketch-elements that

give the shape to the

Pack 

One Motion-Point

shows at the start-Point

of the sketch-element

that you click.
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1. Double-click the Mo-

tion-Path FB to open

the Motion-Path dia-

log 

2. Edit the '# Motion-

Points' to 10 - we can

edit this number

later, if necessary.

3. Click the 'Re-generate

Motion-Points'.

4. Edit the 'Range' of

the Motion-Points to

160º (use the Range

option in degrees).

5. Edit the 'BASE-VALUE'

of the MOTION-

POINTS until they are

only in the half of the

sketch-loop for the

Pack that 'faces' the

rotation-axis.

The Motion-Points must

be in the 'Green Area'

The MOTION-POINTS can-

not be in the 'Red Area'.

A Motion for the Motion-Points

As the Pack rotates, we must

also rotate the Motion-

Points in the opposite direc-

tion so that they remain in

the half of the Pack that

faces the rotation-axis.

1. Connect a wire from

the output-connector

of the MOTION-DI-

MENSION that rotates

the Pack to the input-

connector of the Mo-

tion-Path.

You may need to add a

GEARING FB, with a ratio of -

1, to move the Points in the

opposite direction.

STEP 2: Add the Scroll rotation-section and its rotation-axis.
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(Note: I have rotated the Pack by 180º

on the rotating Part. This helps later)

We must add a sketch-loop that repres-

ents the rotation-section of the scroll.

1. Edit the BASE-PART 

2. Click Visibility toolbar >

Show/Hide other Kinematic and

Sketch elements - this shows the

shape of the Pack .

3. Add a rectangle , that repres-

ents the section-of-rotation of

the Scroll-Blank. 

The rotation-section needs a rotation-

axis.

4. Add a LINE  that represents the

rotation-axis of the scroll. 

This should be along the X-axis of the
BASE-PART.

We must also add a PROFILE to the ro-

tation-section .

1. Close the PART-EDITOR 

2. Add a PROFILE  to the rectangle

When we send the rotation-section and

rotation-axis to SolidWorks, SolidWorks

makes a 'revolved-section'.

STEP 3: Add a Plane, Mechanism, add the Scroll Part

We add the scroll in a different Mechanism-Editor. We must add a new

Plane for the new Mechanism-Editor. 

The Plane to which we add the new Mechanism-Editor must be orientated in

a particular direction. If the Plane is not in the correct orientation, we cannot

add the scroll.

Add the new Plane

1. Spin the model with your key-

board arrow keys 

2. Click Add Plane

3. Click the arrowhead of the X-axis

at the Origin of the Base-Part

(you can also click the Y-axis)

The image shows the default position

of the new Plane.
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We must use the Add Plane dialog

to re-orientate the Plane.

It is possible to use the Add Plane

dialog to edit the orientation of the

new Plane now. 

However, I find it easier to 'Add a

new Mechanism' to the Plane now,

and then edit the Plane for the new

Mechanism later.

4. Close the Add Plane dialog 

5. Click Add Mechanism

6. Click the new Plane

7. Click OK in the COMMAND-MAN-

AGER

You 'jump' to the new Mechanism-

Editor. Rename the new Mechan-

ism-Editor to 'Scroll'

8. Click the 'Pack' Mechanism

name-tab to return to the Pack

Mechanism-Editor. 

9. Click Tools menu (or toolbar) >

'Show Sketches in Mechanism'

You can now see the new Plane and the

Base-Part  (in Grey) to give the orient-

ation of the new Mechanism-Plane. The

XY-axes of the Base-Part are coplanar

with Mechanism-Plane.

10.  Edit the new Plane - double-

click it to open the Plane dialog 

MechDesigner Rules - relative orienta-

tion of the new Plane with respect to

the orientation of the Pack's Mechan-

ism Plane.

· The Z-axis of the Scroll Mechan-

ism's Base-Part must be co-axial

with the X-axis of the Pack

Mechanism's Base-Part

· The Y-axis of the Scroll Mechan-

ism's Base-Part must be co-axial

with the Y-axis of the Pack

Mechanism's Base-Part
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If you clicked the X-axis to add the

new Plane, then the X, Y and Z-axis

rotations are 90,90,90 respectively.

If you clicked the Y-axis to add the

new Plane, then the X, Y and Z-axis

rotations are 0,90,90 respectively.

The image shows the new orienta-

tion of the Base-Part and Mechan-

ism-Plane of the 'Scroll' Mechanism.

11. Click the Scroll Mechanism

name-tab 

We now add the Part that represents

the 'scroll'.

12. Add a rotating Part . 

Make sure the Origin of the Part is at

the Origin of the Base-Part.

Add a Gearing FB, and edit its Gear-

ing Ratio parameter so that the

Scroll Part rotates many times in a

machine-cycle.

I suggest a Gearing Ratio of 'x8' as

the first estimate.

13. Click ALT+H keyboard shortcut

to Home the model, in which the

MMA is at 0 

14. Rotate the view so you can see

the elements in the two(2)

Mechanism-Editors.

15. Click Add Scroll. 

Select the five elements in order.

 The Follower is the 'Pack' Part

 The Part to carry the Feed-Screw is

the 'Scroll', in the active Mechanism-Ed-

itor

 The Profile is the 'rotation-section' -

the Profile element 

 The Line for the 'revolve axis' is the

'rotation-axis'

 The MOTION-PATH FB in the graphics-

area
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Click OK

You may need to click the Model-

Editor to force a full model rebuild.

MechDesigner creates a surface for

the part of the scroll that becomes

in contact with the Pack, as the Pack

advances.

STEP 4: Transfer the Scroll to SOLIDWORKS

To transfer the Scroll to SOLIDWORKS,

we need to edit the Scroll element.

1. Double-click the Scroll in the

graphics-area 

or

1. Double-click the Scroll element

in the Assembly-Tree 

The Scroll Element dialog (Also called

the Feed Screw - dialog).

The important separators are:

Cam (that is: Scroll) Surface Mesh

Density

· Edit the number of Points along

each Rim.

· Typically 500 to 1500.

Flank-Length

The Flank Length is with respect to

the MMA.

· Typically, set to 0 to 360 

Display

· color

· Transparency - applies to view in

the Model only

· Show as Solid (Surface) and

Rims check-boxes.



159

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

SOLIDWORKS Data Transfer

1. Start SOLIDWORKS, add a new

Part, and Save it. 

2. You can click each button in turn

If the Scroll Surface is not cut from the

Scroll Blank, there may be a couple of

things you should look at.

1. The end of the Scroll Surface is

outside the ends of the Scroll

Blank.  

In the image, you can see that the

Scroll-Blank extends past the start

of the Scroll Surface.

Edit the Scroll-Blank in

SOLIDWORKS or MechDesigner.

1. Move the left end of the sketch

to the right by a small amount.

 

When the Scroll Surface is cut from the

Blank, then hide the Scroll Surface.
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1.5.5.1.3.7  Add Pulley

Add Pulley

See also : Pulley dialog

Pulley / Belt Terminology

Term : Definition

PULLEY : When you do Add Pulley, we add for you the outline of a

PULLEY, with teeth, to a rotating-Part - see also Types of

Pulley

The rotating-Part of a PULLEY must rotate about the CEN-

TER-POINT of an ARC that is on the sketch-path of a Belt.

Belt : A sketch-path to represent the path of the Belt. The mo-

tion of a MOTION-POINT along the sketch-path repres-

ents the motion of the Belt. 

We relate the angular motion of each PULLEY to the linear motion of the Motion-Point

on a Belt by the radius of each PULLEY. 

To control the radius of each PULLEY, you can control its NUMBER-OF-TEETH and the

TOOTH-PITCH of the Belt. 

Types of Pulley

You can do Add Pulley to a rotating-Part that is kinematically-defined (Type 1) or is

not kinematically-defined (Type 2). 

Type 1: A Driving-Pulley : Before you do Add Pulley, the rotating-Part is kinematic-

ally-defined.

After you do Add Pulley, we control the linear motion of

a Belt from the angular motion of the rotating-Part (Driv-

ing-Pulley).

Add a maximum of one Driving-Pulley to a Belt.

Type 2: A Driven-Pulley : Before you do Add Pulley, the rotating-Part is not kin-

ematically-defined.

After you do Add Pulley, we control the angular motion

of a rotating-Part (Driven-Pulley) from the linear motion

of the Belt.

581
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Kinematics-Tree of Pulley

Driven-Pulley

It is a PULLEY-ROCKER in the

Kinematics-Tree after you do Add

Pulley.

A PATH-JOINT is a child to the PUL-

LEY-ROCKER.

Driving-Pulley 

It is a PART that is kinematically-

defined in the Kinematics-Tree

before you do Add Pulley.

For example, a Driving-Pulley

in the KINEMATICS-TREE is a

Rocker.

Prepare to Add Pulley (TYPICAL)

STEP 1: Add the sketch-path for the Belt.

Sketch-loop as the path of the Belt.

STEP 1: Add a sketch-path to represent

the path of the Belt. 

The sketch-path should include only

 LINES and ARCS. Usually, add TAN-

GENT constraints between each LINE

and ARC. Do not add EQUAL con-

straints to the ARCS. The sketch-path

is usually a closed sketch-loop. It is

usually helpful to fully define the

geometry of the sketch-path.

1. MECHANISM-EDITOR: Edit the

BASE-PART (usually) or PART 

2. PART-EDITOR: Add a sketch-

path with LINES and ARCS to

represent the path of the Belt.

You need one ARC for each

PULLEY.

3. PART-EDITOR: Add TANGENT

constraints between each LINE

and ARC 

4. PART-EDITOR: Add a dimension

to the radius of each ARC. (Do

not add EQUAL constraints

between ARCS)

A Line for a Motion-Dimension FB
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IF the rotating-Part is a Rocker for a

Driving-Pulley - see STEP 3A:

5. PART-EDITOR: Add a LINE from

the CENTER-POINT of the ARC

that is the rotating-axis of the

Rocker / PULLEY 

Why? You need the LINE to add a

MOTION-DIMENSION FB to the rotat-

ing-Part.

STEP 2: Add the Motion-Path FB to the sketch-path

STEP 2: Add a MOTION-PATH FB

Add ONE MOTION-PATH FB to the

sketch-path.

1. Click Function-Blocks menu >

Add Motion-Path FB.

2. Click a sketch-element in the

sketch-path

The MOTION-PATH FB is in the

graphics-area.

And, a MOTION-POINT is at the

START-POINT of the sketch-element

you click. 

STEP 3: Add a Rotating-Part for a Pulley

A PULLEY is a Driving-Pulley or Driven-Pulley. It is a rotating-part. 

rotating-Part for a Driving-Pulley

STEP 3A: Type 1 - Driving-Pulley

A Driving-Pulley is a rotating-Part

that is kinematically-defined before

you do Add Pulley.

Add a maximum of ONE Driving-

Pulley to a Belt. 

1. Add a Rocker with its PIN-

JOINT at the CENTER-POINT of

the ARC with a LINE (see PRE-

PARATION 1: 5, above) 

OR 

1. Add PARTS to the model, in

which there is a rotating-Part

with its PIN-JOINT at the CEN-

TER-POINT of the ARC in the
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sketch-path of the Belt - and it

is kinematically-defined.

rotating-Part for a Driven-Pulley

STEP 3B: Type 1 - Driven-Pulley

A Driven-Pulley is a rotating-Part

that is not kinematically-defined

before you do Add Pulley.

The motion of the BELT and the Pul-

ley's Pitch-Circle Diameter of the

control the motion of a Driven-Pul-

ley.

1. Add a rotating-Part with its

PIN-JOINT at the CENTER-POINT

of each ARC with a Driven-Pul-

ley. 

Add Pulley

STEP 1: Click Add Pulley  

1. Mechanism menu > Add

Pulley 

- or -

1. Machine-elements tool-

bar > Add Pulley 

There are four elements to select in the
COMMAND-MANAGER

STEP 2: Click the four elements  

1. Click a PIN-JOINT at the center

of a rotating-Part*. 

2. Click the MOTION-PATH FB.

The PART-EDITOR opens

3. Click the dimension that con-

trols the radius of the ARC.

The PART-EDITOR closes

4. Click the rotating-Part* that

has a PIN-JOINT (see 1) at the

CENTER-POINT of the ARC (see

3)

* If the rotating-Part is :

· is kinematically-defined - the

motion of the PULLEY moves the

BELT (Driving-Pulley).

1 x Driving-Pulley (Purple)

1 x Driven-Pulley (Magenta)

Do Add Pulley to add 1 x PULLEY.

The image shows two PULLEYS after

you do Add Pulley two times.
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· is not kinematically-defined -

the motion of the BELT moves

the PULLEY (Driven-Pulley).

STEP 3: Complete the Command 

5. COMMAND-MANAGER: Click  in

the COMMAND-MANAGER. 

RESULT:

The schematic of the PULLEY shows

in the graphics-area.

· Use the MOTION-PATH DIA-

LOG  to edit the TOOTH-PITCH

and LENGTH of the Belt.

The PULLEY has an integer number-

of-teeth.

· Use the PULLEY DIALOG  to

edit the NUMBER-OF-TEETH on

each PULLEY.

Video: Add Pulley:

 Double-click to watch Video

469

581
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1.5.5.1.3.8  Add Conjugate Cam FB

Add Conjugate Cam FB

See Function-Blocks menu > Conjugate-Cam FB  

See Conjugate-Cam dialog

1.5.5.2 Function-Blocks

Function-Blocks menu

The Function-Blocks menu is active ONLY in MECHANISM-EDITORS.

Function-Blocks menu

Function-Block toolbars

The Function-Blocks menu combines the commands from two toolbars:

Kinematic FB toolbar  - it is to the right of the graphics-area.

Modeling FB toolbar  - it is above the graphics-area.

See also: Function-Blocks: Connecting, and Data-Types and Channels

222

436

169

206

166
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1.5.5.2.1  Function-Blocks | Connecting, Data-Types & Channels

What is a Function-Block?

FUNCTION-BLOCKS control, measure, and analyze data.

Kinematic FUNCTION-BLOCKS are elements you add:

· to control the motion of Motion-Parts and Motion-Points

· to measure and plot the motion of POINTS and PARTS

· to analyze and export cam-coordinates and cam performance data

Modeling FUNCTION-BLOCKS are those elements you add:

· to provide special functions for more complex modeling

· to analyze data from the output of Kinematic FUNCTION-BLOCKS

· to control the model behavior

· to increase your productivity

Function-Blocks: Wires and Connectors

FUNCTION-BLOCKS (most) have input-

connectors  and/or output-connect-

ors .  

When you cycle the model, data flows

instantly along wires  and through the

FUNCTION-BLOCKS that you connect

together.

Video - Connecting FBs

To connect FUNCTION-BLOCKS with a

wire , ...

... hover then drag your mouse-

pointer from the output-connector

of a FUNCTION-BLOCK to 

... hover and drop at the input-con-

nector of a different FUNCTION-

BLOCK.

Video: How to connect Function-Blocks

with wires

All Data has a data-type. 

For example: the data-type that controls the motion of a Slider is the Lin-

ear data-type.

The color of a wire is a function of its data-type

For example: the wire color of the Linear data-type is Blue.

Each Data-Type has up to three Data-Channels.

643
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For example: the Data-Channels of the Linear data-type are Position, Ve-

locity, and Acceleration.

How to arrange the wires that connect Function-Blocks

This image is a schematic of how you can connect with wires the FUNCTION-

BLOCKS from the Kinematic Function Blocks toolbar. 

Schematic: Function-Block Wires and Connectors

 Kinematic Function-Blocks: Data-Types and Data-Channels

LINEAR-MOTION FB 

Output DATA-TYPE = ROTARY : 

DATA-CHANNELS: Master Machine Angle, Angular-Velocity, and Angu-

lar-Acceleration. The Angular Velocity is proportional to the CYCLES / MIN

 - see Machine-Settings dialog .

GEARING FB

Output DATA-TYPE = Input DATA-TYPE 

DATA-CHANNELS: Linear or Angular Position, Velocity, and Acceleration

MOTION FB

Input DATA-TYPE =  ROTARY OR LINEAR

Output DATA-TYPE =  ROTARY OR LINEAR

DATA-CHANNELS: Linear or Angular Position, Velocity, and Acceleration

MOTION-DIMENSION FB

Input DATA-TYPE =  ROTARY OR LINEAR

Output DATA-TYPE = ROTARY if Rocker ; LINEAR if Slider 

DATA-CHANNELS: Linear or Angular Position, Velocity, and Acceleration

351
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MOTION-PATH FB

Input DATA-TYPE = ROTARY OR LINEAR

Output : no connector

DATA-CHANNELS: Linear or Angular Position, Velocity, and Acceleration

MEASUREMENT FB

Output DATA-TYPE = ROTARY OR LINEAR

DATA-CHANNELS: Linear or Angular Position, Velocity, and Acceleration

POINT-DATA FB

Output DATA-TYPE = LINEAR

DATA-CHANNELS: Linear or Angular Position, Velocity, and Acceleration

MATH FB (in Modeling toolbar )

Input DATA-TYPE = LINEAR, ROTARY, FORCE, or TORQUE

Output DATA-TYPE = ANY

DATA-CHANNELS: different Data-Types with different data-channels, See

Math FB dialog

FORCE DATA FB (in Forces toolbar )

Output DATA-TYPE = TORQUE or FORCE

DATA-CHANNELS: Force or Torque, X-Force component, Y-Force com-

ponent

206

510

226
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1.5.5.2.2  Kinematic Function-Blocks

Kinematic Function-Blocks (FB)

Use KINEMATIC FBS to plan and control the motion* of kinematic-chains; to

measure and plot linear or angular motion over a machine-cycle; and to cal-

culate and export Cam-Coordinates.

* Motion - Position, Velocity, and Acceleration, with Linear or Angular motion-

units .

See also How to connect FBs

Kinematics FB toolbar

The Kinematic FB toolbar is to the right of the graphics-area.

Kinematic FB toolbar

352

643
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1.5.5.2.2.1  Add Linear-Motion FB

Linear-Motion FB

See also: Linear Motion dialog

Terminology

MASTER MACHINE ANGLE (MMA) : The MMA is the Master machine-clock, that, when

you run your model, increases at a constant rate

from 0 to 360, again and again. One cycle of the

MMA (from 0 to 360) and machine is one ma-

chine-cycle.

The MMA is at the bottom and left of the

MechDesigner application. 

LINEAR MOTION FB : The default output from a LINEAR-MOTION FB is

equal to the MMA (0 - 360). 

You can edit the LINEAR-MOTION FB to add or

subtract a value from the default output.

The LINEAR-MOTION FB is usually the first of the

FBS that you connect together with wires.

Linear-Motion FB function

The function of the LINEAR-MOTION FB is:

Output = MMA ± 

Use the LINEAR-MOTION DIALOG  to edit 

Add Linear-Motion FB

STEP 1: Add a Linear-Motion FB to the graphics-area 

1. Click Kinematics FB toolbar  > Linear-Motion FB 

OR 

1. Click Function-Blocks menu > Linear-Motion (FB)

2. Click the graphics-area 

The LINEAR-MOTION FB is now in the graphics-area (and ASSEMBLY-TREE).

For most models, the default output from the LINEAR-MOTION FB (equal to the

MMA) is correct.

If you want to change the output relative the MMA by a constant:

STEP 2: Open the Linear-Motion dialog: 

1. Double-click the LINEAR-MOTION FB in the graphics-area. 

OR

1. See How to Open a dialog  

The LINEAR-MOTION DIALOG is now open.

458

458

169

627
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Dialog : STEP 3: See Linear-Motion dialog  458
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1.5.5.2.2.2  Add Gearing FB

Gearing FB

See also: Gearing FB dialog

Terminology

GEARING FB : The GEARING FB modifies motion-values with a linear

equation / function. 

The function has 3 parameters that you can edit in the

Gearing FB dialog

Gearing FB function

The flow from the input, through the GEARING FB, to the output is:

Or, you can say:

    

Use the GEARING FB DIALOG  to edit , , and .

Add Gearing FB

What to do: STEP 1: Add a Gearing FB to the graphics-area 

1. Click Kinematics FB toolbar  > Gearing FB 

OR

1. Click Function-Blocks menu > Gearing (FB)

2. Click the graphics-area 

The GEARING FB is now in the graphics-area (and ASSEMBLY-

TREE).

STEP 2: Open the Gearing FB dialog 

1. Double-click a GEARING FB in the graphics-area, or

the ASSEMBLY-TREE 

OR

1. See How to Open a dialog  

Dialog : STEP 3: See Gearing FB dialog  

Notes: 

· The default parameters do not change the motion-data.

· Connect a GEARING FB to the input of a MOTION FB to change the frequency

of a motion by the Gearing-Ratio

· Connect a MOTION FB to the input of a GEARING FB to change the amplitude

and/or direction of a motion by the Gearing-Ratio.

459

459

459

169

627

459
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1.5.5.2.2.3  Add Motion FB

Motion FB

See also: Motion FB dialog

Terminology

MOTION FB : The MOTION  FB is a link to one motion-design, in Mo-

tionDesigner.

Motion name-tab : In MotionDesigner, the tab at the top of each motion

that you can click to switch to that motion.

Motion FB function

The MOTION FB has a link with one Motion in MotionDesigner. 

You can edit the MOTION FB to select which Motion - identified by its Mo-

tion name-tab.

The motion-values at the input-connector to the MOTION FB correspond to

the X-axis of the Motion. 

The motion-values at the output-connector from the MOTION FB corres-

pond to the Y-axis values of the Motion.

Add Motion FB

What to do: STEP 1: Add a Motion FB to the graphics-area. 

1. Click Kinematics FB toolbar  > Motion FB 

OR 

1. Click Function-Blocks menu > Motion (FB)

2. Click the graphics-area 

The MOTION FB is now in the graphics-area and ASSEMBLY-

TREE.

STEP 2: Open the Motion FB dialog 

1. Double-click the MOTION FB in the graphics-area or

ASSEMBLY-TREE 

OR

1. See How to Open a dialog   

The MOTION FB DIALOG is now in open.

Dialog : STEP 3: See Motion FB dialog  

462

169

627

462
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1.5.5.2.2.4  Add Motion-Dimension FB

Motion-Dimension FB

See also: Motion-Dimension dialog

Terminology

Motion-Part : A PART whose angular or linear position and motion rel-

ative to a different PART you control with a MOTION-DI-

MENSION FB.

Rocker : A Motion-Part that rotates.

Slider : A Motion-Part that slides.

MOTION-DIMENSION FB : Add this FUNCTION-BLOCK to a PART that has one de-

gree-of-freedom to change it to a Motion-Part: Rocker

or Slider.

BASE-VALUE : The parameter we use to offset the Motion-Part. 

Add Motion-Dimension FB - ROCKER

Prepare the model with these elements. 

ROCKER

Element # Element Type Rules

#1 PIN-JOINT Is between POINTS that are in two different

PARTS 

· each POINT is the START-POINT or END-POINT

of a LINE (or CAD-LINE)

#2 LINE · This LINE radiates from the PIN-JOINT (see
ELEMENT #1)

· AND this LINE is a child to a PART that IS kin-

ematically-defined

#3 LINE · This LINE also radiates from the PIN-JOINT

(see ELEMENT #1)

· AND this LINE is in a PART that IS NOT kin-

ematically-defined

Preparation: Motion-Dimension - Rocker (typical)

Preparation example: 

· Two(2) PARTS. In this case the

BASE-PART  and a ROTATING-

PART .

· LINES  in each PART

· PIN-JOINT  joins the START-

POINT and/or END-POINTS of

each LINE

· PART  is kinematically-defined

466
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· PART  is not kinematically-

defined

See Add Line , Add Part , Add Pin-

Joint

Add Motion-Dimension FB (Rocker)

STEP 1: Select the Add Motion-Di-

mension FB command 

1. Click Kinematics FB

toolbar  > Motion-

Dimension FB 

OR 

1. Click Function-Blocks

menu > Motion-Di-

mension FB 

The COMMAND-MANAGER indicates that

there are three elements to select:

STEP 2: Select the three elements in

the graphics-area

ELEMENT #1: PIN-JOINT

1. Click a PIN-JOINT  

The PIN-JOINT must be a joint

between two(2) PARTS, and:

· One PART must be kinemat-

ically-defined

· The other PART must be

free and joined with a PIN-

JOINT to the PART that is

kinematically-defined

ELEMENTS #2 and ELEMENT #3:

LINES 

Each LINE must be a child to a

POINT and also a child to the PIN-

JOINT. (ELEMENT #1)

2. Click LINE  in the PART that is

kinematically-defined  

3. Click LINE  in the free PART

STEP 3: Complete the Command 

1. Click  in the COMMAND-MAN-

AGER to complete Add Motion-

277 108

102

169
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Dimension FB (Rocker).

RESULT: 

The Mobility of the kinematic-chain

is now Zero(0).

PART  is now a PART that is kin-

ematically-defined.

The MOTION-DIMENSION  and

MOTION-DIMENSION FB  controls

the angle between the LINES

The MOTION-DIMENSION FB icon

 in the graphics-area for a

ROCKER.

Note: In the graphics-area:

· To move the MOTION-DIMENSION  :

CTRL+ DRAG the FB icon

· To move the MOTION-DIMENSION FB
 : DRAG the FB icon

Dialog : STEP 3: Open the dialog - See Motion-

Dimension dialog  

Kinematics-Tree - Motion-Dimension (Rocker)

When you add a MOTION-DIMENSION FB

to a PIN-JOINT, you add a Rocker to the

KINEMATICS-TREE.

The kinematic elements are:

Part + Pin-Joint + Mo-

tion-Dimension = 

ROCKER

Add Motion-Dimension FB and SLIDER

Prepare the model with these elements.

466
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SLIDER

Element # Element type  Rules

#1 SLIDE-JOINT The SLIDE-JOINT between LINES* that

are in two different PARTS

· Each LINE* is a child to a different

PART 

(* LINE and/or CAD-LINE )

#2 START-POINT

or END-POINT

The START-POINT or END-POINT of a LINE

 in the SLIDE-JOINT (ELEMENT #1),

· the LINE is in a PART that IS kin-

ematically-defined

#3 START-POINT

or END-POINT

The START-POINT or END-POINT of the

other LINE in the SLIDE-JOINT (ELEMENT

#1)

· the LINE is in a PART that is IS

NOT kinematically-defined

Preparation: Add Motion-Dimension - Slider (typical)

Preparation example:

1. Two(2) PARTS  

One PART is kinematically-

defined ...the BASE-PART

The other PART that is free 

2. The PARTS are Joined... with

a SLIDE-JOINT

3. START POINT  (or END-

POINT) of a LINE in the PART

that is kinematically-

defined

4. START-POINT  (or END-

POINT) of a LINE in the PART

that is free

The LINES are those that you select

for the SLIDE-JOINT .

See Add Line , Add Part , Add Pin-

Joint

Add Motion-Dimension FB (Slider)

277 108

102
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STEP 1: Add the MOTION-DIMENSION

FB 

1. Click Kinematics FB

toolbar  > Motion-

Dimension FB 

OR 

1. Click Function-Blocks >

Add Motion-Dimen-

sion FB 

STEP 2: Select three elements in the

graphics-area

ELEMENT #1: SLIDE-JOINT

1. Click a SLIDE-JOINT  

The SLIDE-JOINT must be a joint

between two(2) PARTS, and:

· One PART is kinematically-

defined 

· The other PART is free 

ELEMENTS #2 and ELEMENT #3:

POINTS 

Each POINT must be a child to a

LINE that is also a child to the

SLIDE-JOINT. (ELEMENT #1)

2. Click the POINT  in the PART

that is kinematically-defined

 

3. Click the POINT  in the PART

that is free

STEP 3: Complete the Command 

1. Click  in the COMMAND-MAN-

AGER to complete Add Motion-

Dimension FB (Slider).

RESULT : 

The free PART is now kinematic-

ally-defined.

The MOTION-DIMENSION  and

MOTION-DIMENSION FB  controls

the distance between the POINTS

169
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The MOTION-DIMENSION FB icon

 in the graphics-area for a

SLIDER.

Note: In the graphics-area:

· To move the MOTION-DIMENSION

: CTRL + DRAG the FB icon

· To move the MOTION-DIMENSION

FB : DRAG the FB icon

STEP 4: Open the dialog - See Motion-

Dimension dialog  

Kinematics-Tree - Motion-Dimension (Slider)

When you add a MOTION-DIMENSION FB

to a SLIDE-JOINT, you add a Slider to the

KINEMATICS-TREE.

The kinematic elements are:

Part + Slide-Joint + Mo-

tion-Dimension = 

SLIDER

Videos: Add Part, Add Joint, Add Motion-Dimension FB:

Add Motion-Dimension FB to a Pin-Joint Double-click to watch Video

(Rocker)

Add Motion-Dimension FB to a Slide-Joint Double-click to watch Video

(Slider)

Special Methods 

Frequently, in a machine, PIN-JOINTS can be coincident (co-axial) and SLIDE-

JOINTS can be collinear.

There are two or more rotating-Parts that rotate about one center, or two or

more sliding-Parts that slide along one axis.

466
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Special Method: Coincident Pin-Joints

If you want to control the motion of each rotating-part with a different MO-

TION-DIMENSION FB, you must carefully plan as to which POINTS you select

when you add the PIN-JOINTS. 

Then, when you add the MOTION-DIMENSION FBS, the MOTION-DIMENSIONS can

reference the correct PARTS. 

The POINTS you select when you add the PIN-JOINTS determine between which

two PARTS you can add the MOTION-DIMENSION FB.

Special Method: Coincident Slide-Joints

If you want to control the motion of each sliding-part with a different MO-

TION-DIMENSION FB, you must carefully plan as to which LINES you select when

you add the SLIDE-JOINTS. 

Then, when you add the MOTION-DIMENSION FBS, the MOTION-DIMENSIONS can

reference the correct PARTS. 

The LINES you select when you add the SLIDE-JOINTS determine between which

two PARTS you can add the MOTION-DIMENSION FB.

Special Method 1

 The methods and principles described below apply to Rockers and Sliders.

However, the descriptions below are given for Rockers only.

Result of Special Method 1:

The model shows

· Two MOTION-DIMENSION FBS 

· They reference the same LINE

in the BASE-PART.

You can see the dimension of the

two MOTION-DIMENSIONS FBS

start at the green horizontal LINE.

STEP 1: Add Pin-Joints two times

There are two added PARTS 

There is an added PART. As always, it

has a CAD-LINE, with a START-POINT

and an END-POINT.

There is also LINE. This LINE is in the

BASE-PART, which you cannot see.

There are three(3) LINES in three(3)

PARTS in total.

The START-POINTS of the LINES are 5,

7 and 11.
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Note: You can select the START-

POINTS and/or the END-POINTS.

However, when possible, use the

START-POINTS.

ADD PIN-JOINT #1 

In the image to the left, PIN-JOINT #1

is between POINT 7 and 5

Now, add a PIN-JOINT. #2

ADD PIN-JOINT #2

Add PIN-JOINT #2 between POINTS 11

and 5.

Q: Why POINTS 11 and 5 and not 11

and 7 ? 

A:  You want the MOTION-DIMEN-

SIONS to reference the horizontal

LINE in the BASE-PART.

Add Pin-Joint : 

1. Click Point 11 and then try to

click Point 5.

The SELECT-ELEMENTS DIALOG opens!

Why? Because there is ambiguity.

POINTS 5 and 7 are at the same

position. You have actually

clicked three POINTS (11, 7 and 5).

 

You must select the two POINTS

for the PIN-JOINT.

About the SELECT ELEMENTS DIALOG:

· Is a list of ALL of the ele-

ments that you have clicked

· The element that you selec-

ted first is always at the top

of the list.

· None of the elements are

selected.



182

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

2. CTRL + CLICK ALL of the ele-

ments you need to complete

the command.

In this image, select POINT 11 and
POINT 5

1. CTRL + CLICK

Point11 AND

Point5

2. Click  

Now, the two PARTS are joined

with a PIN-JOINT to one POINT in

the BASE-PART.

STEP 2: Add Motion-Dimension FB two times

The two PARTS are now joined to the

BASE-PART with two PIN-JOINTS

Now, use the MOTION-DIMENSION FB

two times

ADD MOTION-DIMENSION 1

1. Click Function-Block toolbar >

Add Motion-Dimension FB. 

The COMMAND-MANAGER show that

you must select three elements , 

and . 

The first-element must be a PIN-

JOINT or SLIDE-JOINT.

There are two PIN-JOINTS!
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When you click the PIN-JOINTS in the

graphics-area the SELECT-ELEMENTS

DIALOG opens as there are two PIN-

JOINTS.

In the SELECT-ELEMENTS DIALOG:

Click the PIN-JOINT.

Now, select two LINES.

Click the horizontal LINE  as the

second element.

Click the CAD-LINE  along one the

PARTS with which the PIN-JOINT is

made.

This image shows the three elements

in the Command-Manager boxes.
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The first Rocker MOTION-DIMENSION

FB.

ADD MOTION-DIMENSION #2

You must now select another three

elements,

 Function-Block Toolbar > Motion-

Dimension FB again.

These are the elements.

 JOINT: PIN-JOINT2. 

Now, there is no ambiguity. There is

only one PIN-JOINT available.

 LINE – Solved: select the hori-

zontal LINE. 

 LINE – Free: select the CAD-LINE

along the center of the Blue

PART.

Here, you can see the result.

Both MOTION-DIMENSIONS FBS use

the Horizontal LINE in the BASE-PART

as a reference for the motion-di-

mension.

Note: When you add two MOTION-

DIMENSIONS, the FBS may be on top

of each other.

Drag each FB so you can see them.

Special Method 2: 

Result of Special Method 2

· MOTION-DIMENSION 1: 

From the LINE in the BASE-

PART 

To a LINE in 'PART 1'

· MOTION-DIMENSION 2: 

From the LINE in 'PART 1'

To the LINE in 'PART 2'
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STEP 1: Add Pin-Joint two times

Again, there are two PARTS and a

LINE in the BASE-PART.

The POINTS at the ends of the LINES

are 5, 7 and 11.

You want to:

· Add a PIN-JOINT between

'POINT7' and 'POINT5', and 

· Add a PIN-JOINT between

'POINT11' and 'POINT7'.

In the image to the left, POINT7 is

joined to POINT5

CONDITION 2

Add the second PIN-JOINT

between POINT11 to POINT7.

· Q: Why POINT7 and not

POINT5 ?

· A: Because POINT7 is a child

to CAD-LINE , you want this

MOTION-DIMENSION to refer-

ence CAD-LINE . 

· We do not want the MOTION-

DIMENSION to reference the

LINE in the BASE-PART. That

was Method 1, above.

Select POINT11.

Then try to select POINT7

There is ambiguity between POINT5

and POINT7. Hence, the SELECT ELE-

MENTS DIALOG opens.

· ALL the elements you need

for the command are made

available to you

· The first element you select is

at the top of the list.
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In the image to the left, we have se-

lected for you POINT11 and POINT7.

1. CTRL + CLICK Point11 AND

Point7

2. Click 

STEP 2: Add Motion-Dimension FB two times

The two PARTS are joined with a PIN-

JOINT.

Do Add Motion-Dimension FBs two

times.

You must select three elements to

do Add Motion-Dimension FB 

ELEMENT 1: A Joint.

There is NO ambiguity when you

select the PIN-JOINT.

There is only ONE PIN-JOINT

between a POINT in the PART that

is kinematically-defined and the

other POINT in the PART that is

free.

The SELECT ELEMENTS DIALOG

does NOT open.
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ELEMENTS 2 and 3: Two LINES – a

Solved LINE  then a Free LINE

Select the Horizontal LINE  and

the CAD-LINE

The three elements in the COM-

MAND-MANAGER

Click  in the COMMAND-MAN-

AGER

You can see the First MOTION-DIMEN-

SION FB.

Add the second Motion-Dimension.

You must select three elements,

These are the element-types

1. PIN-JOINT5, there is no am-

biguity because the existing

Motion-Dimension FB uses

Pin-Joint2. 

2. CAD-LINE10: you must select

this CAD-LINE because it is a

child to a PART that IS kin-

ematically-defined and its

START-POINT is referenced

by PIN-JOINT6

3. CAD-LINE11: you must select

this CAD-LINE because it is a

child to a PART that IS NOT

kinematically-defined and
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its START-POINT is refer-

enced by PIN-JOINT6

This image shows the end result.

MOTION-DIMENSION FB #1: uses

the Horizontal LINE that is a child

to the BASE-PART as a reference

Line.

MOTION-DIMENSION FB #2: uses

the CAD-LINE along the center of

the added PART as the reference

Line. The CAD-LINE is kinematic-

ally-defined after you add MO-

TION-DIMENSION FB #1 - see

Method 1

Note: When you add two MOTION-

DIMENSIONS, the FBs may be on top

of each other.

DRAG each FB so you can see each

of them.

Positive' Direction of Slide-Joints and Slider

The nursery rhyme : She swallowed a cat, that swallowed a mouse, that swal-

lowed a spider, that swallowed a fly... comes to mind!

A Slider

To add a MOTION-DIMENSION FB (for a Slider) you must select a SLIDE-

JOINT, and then one POINT from each of the two LINES that define the

SLIDE-JOINT.

· The properties of the MOTION-DIMENSION FB are determined by the

properties of the SLIDE-JOINT. 

· The properties of the SLIDE-JOINT are determined by the properties of

the LINES you select to add the SLIDE-JOINT. 

· The LINES are defined by their START-POINTS and END-POINTS.

Therefore, the positive-direction of the MOTION-DIMENSION for a SLIDER

is defined by the START-POINT and END-POINT of the two LINES in the

SLIDE-JOINT.

If the positive-direction of the MOTION-DIMENSION is not as you want,

you need to add the LINES and SLIDE-JOINT again.

Top-Tip - Try to Plan ahead as you add the different elements. Drag LINES

and PARTS from the START-POINT to the END-POINT in the same positive dir-

ection of the MOTION-DIMENSION.

Always, the Positive Direction of a MOTION-DIMENSION for a SLIDER : 
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'...is the Positive Direction of the LINE, or CAD-LINE, that is a child to the

PART that is kinematically-defined before you add the MOTION-DIMEN-

SION FB to the SLIDE-JOINT.

What is the Positive Direction of a Line, CAD-Line, or Part?

The direction in which you drag - from its START-POINT to its END-POINT -

when you add the LINE, CAD-LINE, or PART.

EXAMPLES: positive direction of SLIDERS

· LINE 1 is a child to a PART that IS kinematically-defined before you

add the MOTION-DIMENSION FB 

· LINE 2 is a child to a PART that IS kinematically-defined after you add

the MOTION-DIMENSION FB 

I have used the red arrows to show the direction in which I dragged my

mouse-point to add the LINES and PARTS.

· LINE 1 – L1 in the BASE-PART-

Drag up to the right

· CAD-LINE/PART 2 – L2 - Drag up

to the right

The MOTION-DIMENSION is 11.9mm. 

If you Increase the MOTION-DIMEN-

SION value, you move the SLIDER up

to the right.

The small arrowhead shows the pos-

itive direction of the SLIDER.

· LINE 1 – L1 in the BASE-PART -

Drag up to the right

· CAD-LINE/PART 2 – L2 - Drag

down from the left

The MOTION-DIMENSION is 34.1mm. 

If you increase the MOTION-DIMEN-

SION value, you move the SLIDER up

to the right.

The small arrowhead shows the

positive direction of the SLIDER.
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· LINE 1 – L1 in the BASE-PART -

Drag down from the right

· CAD-LINE/PART 2 – L2 - Drag up

from the left

The MOTION-DIMENSION is 23mm. 

If you increase the MOTION-DIMEN-

SION value, you move the SLIDER

down to the left.

The small arrowhead shows the

positive direction of the SLIDER.

· LINE 1 – L1 in the BASE-PART -

Drag down Right to Left

· CAD-LINE/PART 2 – L2 - Drag

from Right to Left

The MOTION-DIMENSION is 13.2mm. 

If you increase the MOTION-DIMEN-

SION value, you move the SLIDER

down to the left.

The small arrowhead shows the

positive direction of the SLIDER.
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1.5.5.2.2.5  Add Motion-Path FB

Motion-Path FB

See also: Motion-Path dialog

Terminology

MOTION-PATH FB : A FB that adds a MOTION-POINT to a sketch-path - see

sketch-loop

MOTION-POINT : The motion-values at the input-connector to the MOTION-

PATH FB control the motion of the MOTION-POINT along the

sketch-path.

Applications of a Motion-Path FB:

To control the motion of a robot along a sketch-path.

To control the motion of a chain or belt along a sketch-path.

To control the motion of an extending-cylinder to raise a scissor-lift.

Add Motion-Path FB

What to do: STEP 1: Start the Add Motion-Path FB command

1. Click Kinematics FB toolbar  > Motion-

Path FB 

OR 

1. Click Function-Blocks menu > Motion-Path

(FB)

The COMMAND-MANAGER has one selection-box. 

2. Click a sketch-element from a sketch-path 

3. Click  in the COMMAND-MANAGER

The MOTION-PATH FB is now in the graphics-area (and

ASSEMBLY-TREE).

AND

A Motion-Point is at the START-POINT of the sketch-ele-

ment you click from the sketch-path.

STEP 2: Open the Motion-Path dialog 

1. Double-click a MOTION-PATH FB in the graphics-area

 

OR

1. See How to Open a dialog  

The MOTION-PATH DIALOG is now open.  

Dialog : Motion-Path dialog  

Compare a Motion-Path FB to a Motion-Dimension FB

469

169

627

469



192

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

FUNCTION-BLOCK MOTION-PATH FB
MOTION-DIMEN-

SION FB

Motion Element MOTION-POINT MOTION-PART

Constraint SKETCH-PATH JOINT

Input
MOTION-DATA AT IN-

PUT-CONNECTOR

MOTION-DATA AT IN-

PUT-CONNECTOR

SUMMARY

· A Motion-Point is

constrained by

sketch-elements

along a sketch-

path.

· Motion-data at

the input to the

Motion-Path FB

controls the posi-

tion, velocity, and

acceleration of

the Motion-Point.

· A Motion-Part is

constrained by a

joint to rotate or

slide. 

· Motion-data con-

trols at the input

to the Motion-Di-

mension FB con-

trols the position,

velocity, and ac-

celeration of the

Motion-Part.
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1.5.5.2.2.6  Add Measurement FB

Measurement FB

Use a MEASUREMENT FB to measure between sketch-elements in the same or

different PARTS.

You can measure the:

· Length of a LINE, CAD-LINE 

· Radius of a CIRCLE, ARC 

· Distance between two POINTS** §

· Distance between a LINE* and a POINT** 

· Distance between two parallel LINES*

· Angle between two POINTS** §

· Angle between two LINES*

· Angle between three POINTS**

The output from the MEASUREMENT FB includes the dimension and its first

and second motion derivatives.

§ - There are two(2) output-connectors when you measure between two

POINTS* - see more details below

* - LINE, CAD-LINE, X-AXIS, Y-AXIS.

**  - POINT, START-POINT, END-POINT, CENTER-POINT, and/or MOTION-POINT.

Add Measurement FB

Measurement FB between two Points

1. Click Kinematics FB tool-

bar  > Measurement FB 

OR 

1. Click Function-Blocks menu

> Measurement (FB)

2. Click the sketch-element 

OR

2. Click the sketch-elements that you

want to measure 

3. Click the graphics-area.

The MEASUREMENT FB  and DIMENSION

are now in the graphics-area.

In this example, the MEASUREMENT FB  and

DIMENSION  is between two POINTS

Note: 

In the graphics-area, to move the:

194

169
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· Measurement FB  – Drag the FB  

· Dimension  – CTRL + Drag the FB  or the DIMENSION .

Measurement FB

Linear Distance

* LINE, CAD-LINE, X-axis, Y-axis

** POINT, START-POINT, END-POINT, CENTER-POINT, MOTION-POINT.

Image Sketch-Elements Measurement Dimension

Length or Radius

1. Click a LINE or

CAD-LINE 
Length of the LINE*

1. Click a CIRCLE or

ARC 

Radius of the CIRCLE or

ARC.

Distance - Point & Line

1. Click a POINT** 

2. Click a LINE* 

Perpendicular Distance

between the Line and

Point.

Distance - 2 Points

1. Click a POINT** 

2. Click a POINT** 

Linear Distance AND

Angle of two Points.

A MEASUREMENT FB between two POINTS** has

two output-connectors:

 - Top output-connector: distance between two

POINTS, and first and second motion-derivatives

 - Bottom output-connector: angle between two

POINTS, and first and second motion-derivatives

Angle between two(2) Points 

Distance - 2 Points

1. Click a POINT** 

2. Click a POINT** 

Linear Distance AND

Angle of two Points.

A MEASUREMENT FB between two POINTS** has

two output-connectors:

 - Top output-connector: distance between two

POINTS, and first and second motion-derivatives

 - Bottom output-connector: angle between two

POINTS, and first and second motion-derivatives
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Angle between three(3) Points 

Angle between three(3) POINTS** - Internal Angle and External Angle.

** POINT, START-POINT, END-POINT, CENTER-POINT

Image Sketch-Elements Measurement

Dimension

Internal Angle - 3 Points

Three POINTS

1. Click 'Apex' POINT**  

2. Click POINT** 

3. Click POINT**  

Internal Angle

The angle

is from 

to  in a

Counter-

Clockwise

direction.

External Angle - 3 Points

Three POINTS

1. Click 'Apex' POINT**  

2. Click POINT** 

3. Click POINT**  

External Angle

The angle

is from 

to  in a

Counter-

Clockwise

direction.

Angle between Two Lines

Image Sketch-

Elements

Measurement

Angle - 2 Lines

Two
LINES

1. Clic

k a
LINE

* 

2. Clic

k
LINE

** 

Angle - from eight(8) possible

Angles.

To display one of eight angles:

Before you click in the graphics-area to place the MEASUREMENT DIMEN-

SION and FB ...

... move your mouse-pointer around the APEX of the two LINES:

CASE 1: COUNTER-CLOCKWISE : 4 angles < 180° : the Acute, Obtuse,

Supplementary and Vertical angles

CASE 2: CLOCKWISE : 4 angles > 180° : the reflex angles - or the angles

that are external to those angles of CASE 1.
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Video: Eight Measurement Angles between two Lines:

Double-click to watch Video

How to use the Measurement FB:

You can connect a wire from the output-connector of a MEASUREMENT FB:

... to plot the Position, Velocity and Acceleration of the dimension with

a GRAPH FB  - see Note 1 below

... to the input-connector of a MOTION FB. The motion-data from the

MEASUREMENT FB is the independent variable for a Motion in Mo-

tionDesigner, More usually, the independent variable is the output

of a LINEAR-MOTION FB  - see Note 2 below

... to the input-connector of a MOTION-DIMENSION FB - see Note 2 below

Note 1:

To plot the Position, Velocity and Acceleration of the Dimension in the

same graph.

1. Drag a wire from the same output-connector of the MEASUREMENT FB

three times to different input-connectors of a Graph FB , 

2. Use the Y–AXIS DISPLAY OPTIONS in the Graph Interface to display the

three different motion-derivatives.

Note 2: 

Check the messages in the Feedback-Area . 

“1 Mechanism dependencies detected”. This means, that the motion of a

kinematic-chain is a function of (dependent on) the motion (measure-

ment) of a different kinematic-chain. It is usually called Motion-Depend-

ency.

202

170

202

326


MeasurementFB-twoLines-8Angles.gif
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1.5.5.2.2.7  Add Point-Data FB

Point-Data FB

See also Point-Data dialog

Use a POINT FB to measure the motion of a POINT* with respect to the

MECHANISM PLANE.

It has three output-connectors. From top to bottom, the motion-data at the

output-connectors are the:

è Motion of the POINT* parallel to the X-axis

è Motion of the POINT* parallel to the Y-axis

è Magnitude of the motion equal to:

o  (X2 + Y2)

Note: Motion includes: Position, Velocity, and Acceleration of the POINT*.

* POINT, START-POINT, END-POINT, CENTER-POINT, MOTION-POINT.

The POINT must be a child to a PART that is kinematically-defined.

Add Point-Data FB

STEP 1: Add a Point-Data FB to the graphics-area 

1. Click Kinematics FB toolbar  > Point-Data FB 

OR 

1. Click Function-Blocks menu > Point-Data (FB)

Then:

2. Click the graphics-area 

The POINT-DATA FB is now in the graphics-area (and ASSEMBLY-TREE).

STEP 2: Open the Point-Data dialog:

1. Double-click the POINT-DATA FB in the graphics-area 

OR

See How to Open a dialog  

Point-DATA FB - with no  Point

STEP 3: Select a Point

When the box is SELECT A POINT:

1. Click a POINT* in the graphics-

area.

* POINT, START-POINT, END-POINT, CENTER-

POINT, MOTION-POINT.

The box is now: SELECTED POINT IS:

484

169

627
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Point-Data FB- with a Point

STEP 4: Close the Point-Data dialog

1. Click  in the POINT-DATA DIALOG 

The motion-data of the POINT is now at the

output-connectors of the POINT-DATA FB.

How to use the Point-Data FB:

You can connect a wire from the output-connector of a POINT-DATA FB:

... to plot the Position, Velocity and Acceleration of the Point with a

GRAPH FB  - see Note 1 below

... to the input-connector of a MOTION FB. The motion-data from the

POINT-DATA FB is the independent variable for a Motion in Mo-

tionDesigner, More usually, the independent variable is the output

of a LINEAR-MOTION FB  - see Note 2 below

... to the input-connector of a MOTION-DIMENSION FB - see Note 2 below

Note 1:

To plot the Position, Velocity and Acceleration of the POINT in the same

graph.

1. Drag a wire from the same output-connector of the POINT-DATA FB

three times to different input-connectors on a Graph FB , 

2. Use the Y–axis display options in the GRAPH INTERFACE to display the

three different motion-derivatives.

Note 2: 

There is a message in the Feedback-Area: '1 Mechanism dependencies

detected'. 

You should Click Rebuild Now  when the number of dependencies is

more than 1 if the data is critical, before you use the data for a Cam, for

example.

202

170

202

50
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1.5.5.2.2.8  Add Cam-Data FB

Cam-Data FB

See also: Cam-Data FB > Cam Analysis  ; Cam-Data FB > Cam Coordinates

Why should I use a Cam-Data FB?

When you link a 2D-CAM to a CAM-DATA FB you can use the CAM-DATA

FB to:

· Calculate and save coordinates for the 2D-CAM cam-profile - see

Cam-Coordinates , Cam-Coordinates File Formats

· Analyze five design parameters for the 2D-CAM - see Cam Analysis  

Cam: Cam Terminology and 2D-Cam Work-flow.

Cam Terminology

Terms : Definitions

Cam (or Cam-Part) : 
The PART to which you add the  (2D-CAM) to gen-

erate the shape of the Cam-Profile.

Cam-Shaft :

 

The most common Cam-Part. It is a rotating-Part

(a shaft), to which you add the 2D-CAM (or 3D-

CAM) as a Cam-Profile. A Cam-Shaft usually ro-

tates with a constant angular-velocity.

Cam-Profile : 
The Cam-Flank and surface that is an extrusion of

a 2D-CAM (or 3D-CAM) which is in continuous

contact with the Follower-Profile.

Track-Cam or Groove-Cam : 
A groove that is cut into a Cam-Blank with an

Outer and an Inner Cam-Profile. A Follower-Roller

fits in the groove.

Follower (or Follower-Part) : The PART that supports the Follower-Profile. 

Follower Kinematic-Chain 

(or Kinematic Mechanism) : 

The Follower-Part and the other PARTS that you

join to the Follower-Part, to move the Tooling or

Tool-Part.

Follower-Profile : 
The surface of a machine component that is ri-

gidly connected to the Follower-Part. The surface

is in continuous contact with the Cam-Profile.

Follower-Roller : 
A Follower-Profile that is cylindrical or barrel-

shaped that is rigidly connected to the Follower-

Part.

Flat-faced Follower : 
A Follower-Profile that is a flat surface that is ri-

gidly connected to the Follower-Part.

Translating Follower : 
A Follower-Part that that moves along a straight

axis.

Reciprocating Motion : 
A Translating Follower with a non-progressive

motion.

Rotating Follower : A Follower-Part that rotates about a fixed axis.

Oscillating Motion : A rotating-Part with a non-progressive motion.

440 446

446

440
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Terms : Definitions

Progressive Motion : 
A motion, usually followed by a Dwell, that moves

the Follower-Part progressively in one direction.

Non-Progressive Motion : 
A motion that returns the Follower-Part to its ori-

ginal position after each machine cycle.

 Indexing : A progressive motion, usually rotating.

Indexer : 

A device whose input is a constant-speed (usually)

Cam-Shaft and output is a rotating-Part with a

progressive motion. The input rotates one time

to index the output one time. The index-angle is

such that 360º/(Index-Angle) is an integer. 

Cam-Blank : 
The material from which you cut the shape of the

Cam-Profile.

Cam Work Flow

Cam Work-flow

Action Help Topic

1. Add a 2D-Cam  see Add 2D-Cam

If the new 2D-CAM is one of a pair of Conjugate-Cams, or it is one flank of a

Groove-Cam:

 1.a. Add a CONJUGATE-CAM FB see Add Conjugate Cam FB  

 1.b. Edit the CONJUGATE-CAM FB to se-

lect the two 2D-CAMS.

see Conjugate-Cam dialog

2. Select a 2D-CAM or a CONJUGATE-

CAM FB as the Power Source for the

kinematic-chain that includes the Fol-

lower 

see Configure-Power Source  

3. Review the 2D-CAM : Display, Prop-

erties, Roller-Life, Cam-Life, ...

see 2D-Cam dialog  

4. Add a Cam-Data FB see Add Cam-Data FB  

5. Edit the CAM-DATA FB to link it to a

2D-CAM - close the dialog 

see Cam-Data dialog

6. Connect wires from the output-connectors of the CAM-DATA FB to a GRAPH FB

 

7. Analyze the 2D-CAM see Cam-Data dialog : Cam Ana-

lysis

8. Edit the CAM-DATA FB again to calcu-

late the Cam's Coordinates 

see Cam-Data dialog : Cam-Coordin-

ates
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Add Cam-Data FB

Cam-Data FB in

Graphic-Area

STEP 1: Add a CAM-DATA FB to the graphics-area 

1. Click Kinematics FB toolbar  >

Cam-Data FB 

OR 

1. Click Function-Blocks menu > Cam-

Data (FB)

2. Click the graphics-area 

The CAM-DATA FB is now in the graphics-area and

ASSEMBLY-TREE.

The CAM-DATA FB is “Not Assigned” - 

This means you have not yet assigned (or linked) the

CAM-DATA FB  to a 2D-CAM.

You must edit the CAM-DATA FB and select a 2D-CAM

in your model.

See more Cam-Data dialog

169
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1.5.5.2.2.9  Add Graph FB

Graph FB

Terminology:

GRAPH FB : Connect wires to the input-connector of a GRAPH FB to plot, over a complete

machine-cycle, any data that is available at the output-connectors of other

FUNCTION-BLOCKS.

Data-Chan-

nel : 
Each wire provides three parallel streams of data. For example, the data is

linear or angular position, plus the first and second motion-derivatives.

Each stream of data on a wire is a Data-Channel.

Add Graph FB

STEP 1: Add a Graph FB to the graphics-area 

1. Click Kinematics FB toolbar  > Graph FB 

OR 

1. Click Function-Blocks menu > Graph (FB)

Then :

2. Click the graphics-area 

The GRAPH FB is now in the graphics-area.

STEP 2: Connect wires to the input-connectors of the GRAPH GB 

The GRAPH FB has five(5) input-connectors.

From the top, the input-connectors are:

· 1 – 4: Y-axis inputs  - See below: Y-axis Data-Channel Options

· 5: X-axis input - See below: X-axis Data-Channel Options

Note: Data-Values at the input-connector for the X-axis (#5 input-con-

nector)

OPTION 1: no data (not connected). The X-axis is equal to the MASTER-

MACHINE-ANGLE

OPTION 2: data increases steadily. For example, the output-connector

of a LINEAR-MOTION FB, or GEARING FB

OPTION 3: data increases and/or decreases within a range of values.

For example, the output-connector of a MOTION FB, MEASUREMENT FB,

or POINT-DATA FB

Note: if there is a fly-back across the graph, click Rebuild Now  - this

command may remove the fly-back. 

If Rebuild Now does not remove the fly-back, increase the number-of-

steps to 360 - see Machine-Settings > Number-of-Steps

STEP 3: Open the GRAPH FB 

1. Double-click the GRAPH FB in the graphics-area 
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OR 

See How to open a dialog

The GRAPH DIALOG is now open.

STEP 4: See: Graph FB Interface .

To review the kinematic, kinetostatic, and/or Cam data that you can plot

with a GRAPH FB.

See also: Application Settings | Number Format | DATA FORMAT

 Graph FB Interface

Graph FB:

 Y–axis : Scales

· Maximum 4 scales, that correspond to motion-value at input-con-

nectors Y1 to Y4 

· The color of the Y–axis and the plot-line are the same. 

 Y–axis : Digital Readout (D.R.O.)

· The X-axis and the Y1 – Y4-axis values at the position of the vertical

cursor . 

· The Number-Format for the X–axis, Y–axis, and data in Clipboard

are configured in Application Settings | Number Format tab.

X-axis and Y-axis Data-Channel Selector

· Each wire that is connected to a Y-axis orthe X-axis input-connector

has up to 3 Data-Channels 
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· Select the Data-Channel in the drop-down box - see Data-Channel

Selectors

  The Graph Area:

· The color-coded graphs for each Y–axis input

· Vertical-Cursor  - see more below 

 Toolbar:

· Save, Print, Graph Settings , Zoom Extents, Pan Left, Pan Right, Copy

Graph Data to Clipboard – see  below

 Vertical-Cursor

When you click in the area of the Graph , the Vertical Cursor  snaps to

your mouse pointer

When you drag your pointer in the graph :

· the Vertical-Cursor follows your pointer

· the Digital Readouts  continuously updates to indicate the Y-axis

values 

· the MASTER MACHINE ANGLE updates to the position of the Vertical

Cursor

· the kinematic-chains that are kinematically-defined move to a posi-

tion that is defined by the MASTER MACHINE ANGLE.

 Copy Graph Data to Clipboard

· When you click the right-most icon in the toolbar , the graph data is

copied to the Clipboard .

· Paste this data to Excel, or

· To MotionDesigner in the DATA TRANSFER TABLE. You can plot it as an

OVERLAY or use it as a MOTION (use Z Raw-Data).

Notes: 

· Configure the Number-Format for the X–axis, Y–axis, and 'Data in

Clipboard' in Application Settings | Number Format tab.

  Data-Channel Selectors: 

Each wire you connect to the GRAPH FB has three Data-Channels. The data-

channels that are available are a function of the FB from which you con-

nector the wire to the GRAPH FB INPUT-CONNECTOR. 

Use the Data-Channel Selectors to select which of the three data-channels

to plot.

The data-channels from a:

· Function-Block  (LINEAR-MOTION, GEARING, MOTION, MOTION-DI-

MENSION):

o Linear position, velocity, acceleration.

o Angular position, velocity, acceleration.
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· Measurement FB  or Point-Data FB :

o Linear position, velocity, acceleration of the Measurement dimen-

sion or Point's position.

o Angular position, velocity, acceleration of the Measurement di-

mension.

· Cam-Data FB

o Pressure-Angle. 

You can plot three Pressure Angles – See Pressure Angle

o Cam Radius-of-Curvature. 

You can plot Radii-of-Curvature for Inner Cam and the Outer Cam.

o Contact Cam-Force

o Maximum Contact-Shear-Stress. 

You must know the material-properties to obtain this data - See

2D-Cam dialog .

o Entrainment Velocity

The Entrainment-Velocity for the Inner Cam and the Outer Cam.

· Force-Data FB

If the FORCE-DATA FB references a:

o Pin-Joint that is a Power-Source, you can plot Application-

Torque for a Servomotor and Gearbox.

o Slide-Joint that is a Power-Source, you can plot the Application-

Load for a Linear Servomotor.

o PIN-JOINT or SLIDE-JOINT that is NOT a Power-Source:

§  - Force in the X-axis direction : 

§  - Force in the Y-axis direction: 

o 2D-CAM: you can plot the Contact Force between the Cam-Profile

and the Follower-Profile.

o SPRING FB: you can plot the Total Force, the X Force and the Y

Force acting on the anchor-Point of the Spring.

TOP-TIP:

To show all three Data-Channels from the same output-connector of a

Function-Block, 

1. Drag three wires from the same output-connector of the Function-

Block to three(3) different GRAPH FB input-connectors. 

2. Select the different Data-Channels with the Y-axis Data-Channel

Selector drop-down (right-side of graphs)
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1.5.5.2.3  Modeling Function-Blocks

Modeling Function-Blocks

Use Modeling Function-Blocks to improve your model in different ways, such

as: to optimize its kinematic performance with a DESIGN-SET FB; to improve

its visualization with a PATTERN FB and or PARAMETER-CONTROL FB; to im-

port data for reverse-engineering with a POINT-CLOUD FB; to overcome a

difficult inverse-kinematics problem with a CONTINUOUS-CRANK FB; to

design new motions with a MATH FB, ... .

See also How to Connect FBs

Function-Blocks menu > Modeling FBs

Function-Blocks menu > Modeling FBs - MD17

Modeling FB toolbar

The Modeling FB toolbar is above the graphics-area.

Modeling FB toolbar

1.5.5.2.3.1  Add Point-Cloud FB

Why should I use a Point-Cloud FB?

You can use a POINT-CLOUD FB to, for example, reverse-engineer the shape

of a Cam and then find the motion of a Follower.

Terminology and Definitions

643
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Point-Cloud : Data-points that represent the planar shape of a

body. The data-points can be cartesian ( ) or po-

lar ( ) coordinates.

Curve : A smooth, continuous function that we fit to the

Point-Cloud to replace the data-points. From the

continuous function, we can evaluate the coordinates

of the planar shape at any machine-angle.

POINT CLOUD FB : A FUNCTION-BLOCK that you add to a PART. 

Use the POINT-CLOUD DIALOG to: 

· to import coordinates of a planar shape,

and 

· to fit a Curve to replace the coordinates

See also : Point-Cloud dialog

Add Point-Cloud FB 

STEP 1 Add a Point-Cloud FB to a Part 

1. Click Function-Blocks menu > Point-Cloud

OR

1. Click Modeling FB toolbar  > Add Point-Cloud FB 

The COMMAND-MANAGER has one selection box. You must select a

PART.

2. Click a PART in the graphics-area or ASSEMBLY-TREE 

3. Click  in the COMMAND-MANAGER

The POINT-CLOUD FB is now in the graphics-area.

STEP 2 Open the Point-Cloud dialog: 

1. Double-click a POINT-CLOUD FB in the graphics-area or ASSEMBLY-

TREE 

OR

See How to Open a dialog . 

The POINT-CLOUD DIALOG is now open.

STEP 3 See Point-Cloud dialog . 

Video : See YouTube: http://youtu.be/IME9Eb4mpQE 
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1.5.5.2.3.2  Add Briefcase FB

Why should I use a Briefcase FB?

When a model is complex, and there are many kinematic-chains in each

MECHANISM-EDITOR, it is more difficult to identify which FUNCTION-BLOCKS

control which Kinematic-Chain.

Example uses of a BRIEFCASE FB:

· Use a BRIEFCASE FBS to hide all of the FUNCTION-BLOCKS from the

graphics-area.

· Use a BRIEFCASE FB to hide different groups of FUNCTION-BLOCKS. -

E.g. Function-Blocks that control one kinematic-chain.

You can:

· Name each BRIEFCASE FB to help remind you which FBS are in which

BRIEFCASE FB.

· Edit each FUNCTION-BLOCK directly from the BRIEFCASE FB interface.

· Add a BRIEFCASE FB to hide a different BRIEFCASE FB.

See also : Briefcase FB dialog

Add Briefcase FB

STEP 1: Add a Briefcase FB to the graphics-area: 

1. Click Function-Blocks menu > Briefcase

OR

1. Modeling FB toolbar  > Add Briefcase FB 

Then:

2. Click the graphics-area 

The BRIEFCASE FB is now in the graphics-area.

STEP 2: Open the Briefcase FB dialog 

1. Double-click the BRIEFCASE FB in the graphics-area or ASSEMBLY-

TREE 

OR

See How to Open a dialog

The BRIEFCASE FB DIALOG is now open.

STEP 3: See Briefcase FB dialog
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1.5.5.2.3.3  Add Statistics FB

Why should I use a Statistics FB?

Statistical data may include: RMS, Maximum, Minimum, ... values of a vari-

able (wire data-channel). 

Use a STATISTICS FB to list the Statistical data for the data that is available

at the output of a FUNCTION-BLOCK.

See also : Statistics dialog

Add Statistics FB

STEP 1: Add a Statistics FB to the graphics-area 

1. Click Function-Blocks menu > Statistics

OR

1. Click Modeling FB toolbar  > Add Statistics FB 

Then:

2. Click the graphics-area 

The STATISTICS FB is now in the graphics-area

STEP 2: Connect a wire to its input-

connector

1. Drag a wire from a different FB

to the input-connector of the

STATISTICS FB 

A wire is now connected to the input-

connector of the STATISTICS FB.

STEP 3. Open the Statistics dialog

1. Double-click a STATISTICS FB in the graphics-area 

OR

1. See How to Open a dialog  

The STATISTICS DIALOG is now open.

STEP 4: See Statistics dialog

Notes:

Wires that connect FUNCTION-BLOCKS have 3 Data-Channels (in most

cases).

The 3 Data-Channels are usually:

· Position, Velocity, Acceleration (Angular or Linear), 

OR

· Total Force, Force X, Force Y (relative to the MECHANISM-PLANE)
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See Data-Channels  for more information.

Compare a GRAPH FB with a STATS FB:

· GRAPH FB : to plot data over one machine-cycle.

· STATS FB : to summarize a machine-cycle of data with different

statistical parameters.

167
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1.5.5.2.3.4  Add Polynomial-Fit FB

Why should I use a Polynomial-Fit FB?

Typically, you design a motion (with MotionDesigner) for a Tool/End-Ef-

fector. Then, typically, you add more parts, which you join to the Tool-Part,

to create a more complex kinematic-chain. Finally, you use a servomotor to

drive a part in the kinematic-chain, that has a different motion to the Tool-

Part.

To plot the motion for the servomotor you can use a Measurement FB ,

add a Graph FB , and then export a list of positional data-points for the

servo-controller. 

While this is frequently satisfactory, it is preferable to export to the servo-

controller a series of polynomials rather than a list of data-points.

The output from the POLYNOMIAL FIT FB is the best-fit motion to the data

at its input-connector, but defined as a series of 5th order Polynomials.

You can export the Polynomials directly to MotionDesigner. In Mo-

tionDesigner, you can further manipulate the Polynomials, as required.

See also : Polynomial-Fit dialog

Add Polynomial-Fit FB

STEP 1: Add a Polynomial-Fit FB to the graphics-area 

1. Click Function-Blocks menu > Polynomial-Fit

OR

1. Click Modeling FB toolbar  > Add Polynomial-Fit FB 

Then:

2. Click the graphics-area 

The POLYNOMIAL-FIT FB is now in the graphics-area

STEP 2: Connect a wire to its input-

connector.

1. Drag a wire from a different FB

to the input-connector of the

POLYNOMIAL-FIT FB 

A wire is now connected to the in-

put-connector of the POLYNOMIAL-

FIT FB.

STEP 3. Open the Polynomial-Fit dialog: 

1. Double-click a POLYNOMIAL-FIT FB in the graphics-area 

OR

1. See How to Open a dialog  
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The POLYNOMIAL-FIT DIALOG is now open.

STEP 4: See Polynomial Fit dialog  

Notes:

Wires that connect FUNCTION-BLOCKS have 3 Data-Channels (in most

cases).

The three(3) Data-Channels are usually:

· Position, Velocity, and Acceleration, or

· Total Force, Force X, and Force Y

See Data-Channels  for more information.
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1.5.5.2.3.5  Add Pattern FB

Why should I use a Pattern FB?

When there are SOLIDS in your model, you can use a PATTERN FB to make an

array of one or more of the SOLIDS.

The PATTERN FB is more capable than the Add Array tool as found in your

CAD. 

The PATTERN FB can anticipate the motion of each SOLID at each instant of

the machine-cycle,

When you use the PATTERN FB to make an array of a SOLID, and hide a Copy

at different phases in the machine-cycle, you also remove its MASS-PROPER-

TIES.

See also: Pattern dialog

Add Pattern FB

STEP 1 Add a Pattern FB to the graphic-data 

1. Click Function-Blocks menu > Pattern

OR

1. Click Modeling FB toolbar  > Add Pattern FB 

Then:

2. Click the graphics-area 

The PATTERN FB is in the graphics-area.

STEP 2 Open the Pattern dialog

1. Double-click a PATTERN FB in the graphics-area (or ASSEMBLY-TREE )

OR

See How to Open a dialog . 

The PATTERN DIALOG is now open.

STEP 3 See Pattern-FB dialog . 

Note: Pattern FB and a Driving Pulley: 

A Driving Pulley is one in which you apply the motion to the PULLEY and

not to the MOTION-PATH FB.

If the PULLEY makes one rotation in a machine-cycle, the Motion-Point (that

represents the motion of the Belt) will not move along the complete length

of the sketch-path in one machine-cycle.

If you want to use a PATTERN FB to model an array of SOLIDS along the com-

plete length of a Belt, you must make changes to the rotation of the PULLEY.
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1. Add a GEARING FB to the input-connector of the MOTION-DIMENSION

FB that controls the motion of the PULLEY 

2. Open the GEARING FB DIALOG

3. Edit the GEARING RATIO = Belt-Length / Pulley-Circumference

The PATTERN of the SOLID elements should now be at equal spaces along the

complete Belt-Length.
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1.5.5.2.3.6  Add Math FB

Why should I use a Math FB?

A MATH FB allows you to develop new functions that may not be available with

other FBs.

Examples:

· Mechanism-Synthesis, when combined with Measurement FBs  and

Parameter-Control FBs .

· Add two or more Motions to create a new Motion - for example, add a

Modified-Sinusoid motion-law to a Constant-Velocity motion-law to

give a Starting-Velocity and Ending-Velocity that are not zero.

· Define Parametric equations for Piggyback Sliders. 

See also : Math FB dialog

Add Math FB

STEP 1 Add a Math FB to the graphic-data 

1. Click Function-Blocks menu > Math

OR

1. Click Modeling FB toolbar  > Add Math FB 

Then:

2. Click the graphics-area 

The MATH FB is in the graphics-area.

STEP 2. Open the Math dialog 

1. Double-click the MATH FB in the graphics-area 

OR

See How to Open a dialog . 

The MATH DIALOG is now open.

STEP 3. See Math FB dialog
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1.5.5.2.3.7  Add Parameter-Control FB

Why should I use a Parameter-Control FB?

Use a PARAMETER-CONTROL FB to:

· control the DIMENSION (length or radius) of a sketch-element

· control the EXTRUSION DEPTH of an MD-SOLID*

· control the EXTRUSION-OFFSET of an MD-SOLID*

Apply a PARAMETER-CONTROL FB for Mechanism-Synthesis, or animations with

more realistic effects.

* When a PARAMETER-CONTROL FB controls the EXTRUSION-DEPTH or EXTRUSION-

OFFSET of an EXTRUSION that has many facets, the model is slower to cycle. 

See also : Parameter-Control dialog

Add Parameter-Control FB

STEP 1 Add a Parameter-Control FB to the graphic-data 

1. Click Function-Blocks menu > Parameter-Control

OR

1. Click Modeling FB toolbar  > Add Parameter-Control FB 

Then:

2. Click the graphics-area 

The PARAMETER-CONTROL FB is in the graphics-area.

STEP 2: Open the Parameter-Control dialog 

1. Double-click the PARAMETER-CONTROL FB in the graphics-area or

ASSEMBLY-TREE 

OR

1. See How to Open a dialog . 

The PARAMETER-CONTROL DIALOG is now open.

STEP 3: See Parameter-Control dialog  
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1.5.5.2.3.8  Add Design-Set FB

Why should I use a Design-Set?

Use DESIGN-SETS to edit a number of dimensions and parameters in one place -

the DESIGN-SET.

Add to a DESIGN-SET those dimensions and parameters that you believe to be

important to the outcome of a design-objective. When dimensions are in a

DESIGN-SET, you cannot edit them in the model. You can add more than one

DESIGN-SET to the model.

Different DESIGN SETS can be used for different purposes. A Design-Set to help

make changes to a machine for a packaging size change. 

A Design-Set should also remind you, or instruct other design engineers, which

dimensions and parameters to edit. 

You can even add to a DESIGN-SET those dimensions that you do not want to

edit. Give it the Label - Do Not Edit! In this way, you cannot accidentally edit the

dimensions that you want to protect.

See Design-Set dialog

Add Design FB

STEP 1 Add a Design-Set FB to the graphic-data 

1. Click Function-Blocks menu > Design-Set

OR

1. Click Modeling FB toolbar  > Add Design-Set FB 

Then:

2. Click the graphics-area 

Design-Set in graphic-area

The DESIGN-SET FB is in the graphics-area.

STEP 2: Open the Design-Set dialog 

1. Double-click the DESIGN-SET FB in the graphics-area or ASSEMBLY-TREE.

OR

See How to open a dialog
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Double-click the Design-Set

The DESIGN-SET DIALOG is now open.

STEP 3: See Design-Set dialog

Notes : 

When you add a dimension to a DESIGN-SET, you can edit the dimension only

in the DESIGN-SET.

The dimension-lines and extension lines of a Dimension that you add to the

DESIGN-SET are gray in the PART-EDITOR.

A MOTION-DIMENSION FB is gray if you add the BASE-

VALUE parameter of the MOTION-DIMENSION to a DESIGN-

SET. 

Also, it includes a small icon at its bottom,right corner, to

remind you its value has been added to the DESIGN-SET.

See also:  Online Video : Tutorial 7: Design-Sets

528
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1.5.5.2.3.9  Add CAD-Control FB

Why should I use a CAD Control FB?

Use a CAD CONTROL FB to synchronize the motion of one or more parts that

are in a SOLIDWORKS® Assembly with the motion of same PARTS in a

MechDesigner model/assembly.

Question:  Why do this when MechDesigner is perfect to synchronize the

motions of all of the PARTS in a model?

Answer:   Because SOLIDWORKS® has useful tools. For example, Collision

Verification, Interference Detection, ...

The Clearance Detection tool in SOLIDWORKS® evaluates the exact gap between

parts. You can use this tool to check that a 3D-CAM you export to SOLIDWORKS

has the same Clearance as the Radial Clearance that you enter in the 3D-CAM

DIALOG.

After you configure the CAD CONTROL DIALOG, motion-data that controls PARTS

in MechDesigner model/assembly are piped to the SOLIDWORKS Distance or

Angle mates that define the position of a Part in the assembly in SOLIDWORKS®. 

See also: CAD Control dialog

Add CAD Control FB

STEP 1 Add a CAD-Control FB to the graphic-data 

1. Click Function-Blocks menu > CAD-Control

OR

1. Click Modeling FB toolbar  > Add CAD-Control FB 

Then:

2. Click the graphics-area 

The CAD-CONTROL FB is in the graphics-area.

STEP 2: Open the CAD-Control dialog: 

1. Double-click a CAD-CONTROL FB in the graphics-area 

OR

2. See How to Open a dialog . 

The CAD-CONTROL DIALOG is now open.

STEP 3: See CAD Control dialog

Note: 

Angle mates in SOLIDWORKS® cannot be negative, but they can be in

MechDesigner. Thus, you may need to use GEARING FBS to add a constant to
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the output values so that they have the same minimum and maximum values

as those in SOLIDWORKS®.
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1.5.5.2.3.10  Add Continuous Crank FB

Why use a Continuous-Crank FB?

In a Cam mechanism, you can design the oscillating or reciprocating motion for

a Tool-Part and let MechDesigner do the inverse-kinematics to calculate the

oscillating motion of a swinging Follower-Part. Typically, the Follower-Part

must rotate by an angle that is less than 60º, usually less than 45º, and ideally

less than 30º.

In a Servo mechanism, you can design the motion for a Tool-Part and let

MechDesigner do the inverse-kinematics to calculate the motion of a rotating

servo-axis. However, the rotation of a servo-axis is not limited. It can even oscil-

late by 180º, or even continually rotate with a modulated motion, to give the

motion you have designed for the Tool-Part. 

This is one application of the CONTINUOUS-CRANK FB - it automatically calcu-

lates the correct length and motion of a servo-axis to give the motion you have

designed for a Tool-Part.

See also: Continuous-Crank FB dialog

Add Continuous Crank FB

STEP 1: Add a Continuous-Crank FB to the graphics-area 

1. Click Function-Blocks menu > Continuous-Crank 

OR

1. Click Modeling FB toolbar  > Continuous-Crank FB 

Then:

2. Click the graphics-area 

The CONTINUOUS-CRANK FB is now in the graphics-area and ASSEMBLY-

TREE.

STEP 2: Open the Continuous-Crank dialog:

1. Double-click a CONTINUOUS-CRANK FB in the graphics-area 

OR

See How to Open a dialog . 

The CONTINUOUS-CRANK DIALOG is now open.

STEP 3: See Continuous-Crank FB dialog

535
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627

535
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1.5.5.2.3.11  Add Conjugate Cam FB

Add Conjugate Cam FB

See also Conjugate-Cam dialog

Other names for “Conjugate cams” are “cognate cam”, “double cams”, “comple-

mentary cams”, “main and counter cams”, “working and return cam”.

What is a Conjugate Cam? What are the advantages of a Conjugate

Cam?

A Conjugate Cam pair

Typically, Conjugate Cams are at least

two Cams that rotate on one cam-shaft,

with each cam in contact with one Fol-

lower-Roller, and in which the two Fol-

lower-Rollers are rigidly attached to

one Follower-Part.

For example: In the image, the blue and

orange Cams rotate together on one

axis (the shaft is not in the image). The

blue Cam-Profile is in continuous con-

tact with the blue Follower-Roller, and

the orange Cam-Profile is in continuous

contact with the orange Follower-

Roller. The Follower-Rollers are rigidly

attached to the green Follower-Part,

The green Follower-Part oscillates on

an axis that is parallel with the rotating

axis of the Cams.

Why Advantages of Conjugate Cams:

· does not need a Spring or Cylin-

der to make sure the Follower-

Roller does not 'jump' off the

Cam. This reduces the load on

the 

· eliminate backlash, with an ec-

centric on one Follower-Roller,

or by reducing the distance

between the Cam-Shaft and Fol-

lower axis.

Conjugate Cams

The design of all cam-systems must make sure a Follower-Profile is in con-

tact with the Cam-Profile for the machine-cycle, at all machine-speeds. 

There are two designs:

436
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A. Force-Closed - an external force pushes or pulls the Follower-Part

and Follower-Profile against the Cam-Profile.

Example external forces are: Spring, Air-Cylinder, Gravity, Magnet, ... 

B. Body-Closed - a design in which two (or more) Follower-Profiles

(e.g. Rollers) are rigidly mounted to a Follower-Part such that the

Follower-Profiles cannot move away from two Cam-Profiles that are

rigidly mounted to a Cam-Part (e.g. a Cam-Shaft).

Example Body-Closed cam-systems are: Groove-Cams (Track-Cams),

Rib-Cams, Globoidal Indexers, Parallel Indexers, ...

Body-Closed cam-systems are examples of Conjugate Cams.

Why use a Conjugate Cam FB?

You need to add a CONJUGATE CAM FB to analyze Forces when two or

more 2D-CAMS drive, in a Body-Closed design arrangement, two or more

Follower-Profiles. mounted to one Follower-Part.

Cam Terminology and Typical Work-Flow.

Cam Terminology

Terms : Definitions

Cam (or Cam-Part) : 
The PART to which you add the  (2D-CAM) to gen-

erate the shape of the Cam-Profile.

Cam-Shaft :

 

The most common Cam-Part. It is a rotating-Part

(a shaft), to which you add the 2D-CAM (or 3D-

CAM) as a Cam-Profile. A Cam-Shaft usually ro-

tates with a constant angular-velocity.

Cam-Profile : 
The Cam-Flank and surface that is an extrusion of

a 2D-CAM (or 3D-CAM) which is in continuous

contact with the Follower-Profile.

Track-Cam or Groove-Cam : 
A groove that is cut into a Cam-Blank with an

Outer and an Inner Cam-Profile. A Follower-Roller

fits in the groove.

Follower (or Follower-Part) : The PART that supports the Follower-Profile. 

Follower Kinematic-Chain 

(or Kinematic Mechanism) : 

The Follower-Part and the other PARTS that you

join to the Follower-Part, to move the Tooling or

Tool-Part.

Follower-Profile : 
The surface of a machine component that is ri-

gidly connected to the Follower-Part. The surface

is in continuous contact with the Cam-Profile.

Follower-Roller : 
A Follower-Profile that is cylindrical or barrel-

shaped that is rigidly connected to the Follower-

Part.

Flat-faced Follower : 
A Follower-Profile that is a flat surface that is ri-

gidly connected to the Follower-Part.

Translating Follower : 
A Follower-Part that that moves along a straight

axis.
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Terms : Definitions

Reciprocating Motion : 
A Translating Follower with a non-progressive

motion.

Rotating Follower : A Follower-Part that rotates about a fixed axis.

Oscillating Motion : A rotating-Part with a non-progressive motion.

Progressive Motion : 
A motion, usually followed by a Dwell, that moves

the Follower-Part progressively in one direction.

Non-Progressive Motion : 
A motion that returns the Follower-Part to its ori-

ginal position after each machine cycle.

 Indexing : A progressive motion, usually rotating.

Indexer : 

A device whose input is a constant-speed (usually)

Cam-Shaft and output is a rotating-Part with a

progressive motion. The input rotates one time

to index the output one time. The index-angle is

such that 360º/(Index-Angle) is an integer. 

Cam-Blank : 
The material from which you cut the shape of the

Cam-Profile.

Cam Work-flow

Action Help Topic

1. Add a 2D-Cam  see Add 2D-Cam

If the new 2D-CAM is one of a pair of Conjugate-Cams, or it is one flank of a

Groove-Cam:

 1.a. Add a CONJUGATE-CAM FB see Add Conjugate Cam FB  

 1.b. Edit the CONJUGATE-CAM FB to se-

lect the two 2D-CAMS.

see Conjugate-Cam dialog

2. Select a 2D-CAM or a CONJUGATE-

CAM FB as the Power Source for the

kinematic-chain that includes the Fol-

lower 

see Configure-Power Source  

3. Review the 2D-CAM : Display, Prop-

erties, Roller-Life, Cam-Life, ...

see 2D-Cam dialog  

4. Add a Cam-Data FB see Add Cam-Data FB  

5. Edit the CAM-DATA FB to link it to a

2D-CAM - close the dialog 

see Cam-Data dialog

6. Connect wires from the output-connectors of the CAM-DATA FB to a GRAPH FB

 

7. Analyze the 2D-CAM see Cam-Data dialog : Cam Ana-

lysis

8. Edit the CAM-DATA FB again to calcu-

late the Cam's Coordinates 

see Cam-Data dialog : Cam-Coordin-

ates

128

165
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Prepare to Add Conjugate Cam FB

Preparation Example:

· Two(2) 2D-CAMS in one kin-

ematic-chain - e.g. a Cam-

Shaft

· Two(2) or more Follower-Pro-

files* in a different kinematic-

chain - e.g. a Rocker

· Edit each 2D-CAM to display

one Cam-Profile - the INNER or

the OUTER - see 2D-Cam dialog >

Display tab

* Follower-Roller and/or Flat-Faced

Follower. See also Follower-Profile

Shapes.

Add Conjugate Cam FB

STEP 1: Add the Conjugate-Cam FB

1. Mechanism menu >

Conjugate-Cam

OR

1. Machine-elements tool-

bar > Add Conjugate-

Cam FB 

The CONJUGATE-CAM-FB is now in

the graphics-area. 

STEP 2: Edit the Conjugate-Cam FB

1. Double-click the CON-

JUGATE-CAM FB in the

graphics-area 

OR 

1. See How to open a dia-

log  

The CONJUGATE-CAM DIALOG is now

open. 

STEP 3: See Conjugate-Cam dialog

407

627
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1.5.5.3 Forces

Forces

The commands in the Forces menu and Forces toolbar add, measure, and con-

figure kinetostatic forces*. We will use the generic term Forces.

In MechDesigner, to calculate correctly the Forces that act on a PART:

· the kinematic-chain that is kinematically-defined,  

· a minimum of one PART in the kinematic-chain has Mass, and usually a

Mass Moment of Inertia - see Mass Properties, below

· the Power flows correctly through the kinematic-chain from the correct

Power Source - see Configure Power Source .

* Norton calls it the “Inverse Dynamics Problem”.

Mass Properties

PARTS have three sources of Mass and a Mass Moment of Inertia. The

sources are:

· PROFILE / EXTRUSIONS - see Extrusion > Mass Properties  

· USER MASS PROPERTIES - see CAD-Line > Mass Properties tab > User

Mass Properties

· SOLIDWORKS MASS PROPERTIES - see CAD-Line > Mass Properties tab >

SOLIDWORKS Mass Properties

We add together the three sources of Mass Properties.

Note:

If a PART has Mass but does not have Mass Moment of Inertia, it is called

a Point-Mass (or a Black Hole!). In reality, a Mass is distributed, and so

the body must also have a Mass Moment of Inertia. 

However, you can, if you wish, add a Point-Mass to a PART without a

Mass Moment of Inertia. For very slow moving machines, or for PARTS

that mainly translate (rotate only a small amount), this may provide the

accuracy you need.

 On-line Tutorial: Tutorial 13: Forces Introduction 

Force menu

 
Forces menu (MD17)

Force toolbar

The Force toolbar is to the right of the graphics-area.

232

363

368

369

http://mechdesigner.support/index.htm?md-using-forces.htm
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Forces toolbar

Buttons to Scale Force and Torque Vectors in the graphics-area.

Vector scaling

F: Force Vectors, T: Torque Vectors

“Force Vectors” include both the Force Vectors and Torque Vectors.

If, after you display Force Vectors, the arrowheads of the vectors are outside

of the graphics-area, you must use the Scale buttons to decrease the length of

the Force Vectors and/or Torque Vectors - see Feedback Area > Vector Scaling

buttons

Force definitions - as defined by IFTOMM International Federation on

the Theory of Machines and Mechansims :

FORCE

Action of its surroundings on a body tending to change its state of rest or

motion.

LINE OF ACTION OF A FORCE

The line along which the vector that represents a given force lies.

MAGNITUDE OF A FORCE

Number of units of force obtained by comparing a given force with a

standard, taken as unit force -(SI units : Newtons)

ACTIVE [APPLIED] FORCE

Force capable of producing motion.

REACTION

Force arising in a constraint and acting upon a constrained body due to

the action of an active force upon that body.

CENTRIPETAL FORCE

327
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FORCE

Force causing the centripetal acceleration of a particle.

INERTIA FORCE

Product of the mass of a particle and the negative of its acceleration. Fol-

lowing D'Alembert, the inertia force can be regarded as being in equilib-

rium with the resultant of all the forces acting on the particle.

CENTRIFUGAL FORCE

Inertia force of a particle moving uniformly along a circular path.

CORIOLIS FORCE

Inertia force equal to the product of the mass of a particle and the negat-

ive of its Coriolis component of acceleration.

GRAVITATIONAL FORCE

Force equal to the product of the mass of a particle and the Gravitational

Acceleration on Earth - taken as 9.806m/s/s.

Acceleration Definitions:

We calculate for you those Forces that result from these Accelerations :

CORIOLIS ACCELERATION

Component of the absolute acceleration of a point due to its velocity rel-

ative to a rotating frame of reference. It equals twice the vector product

of the angular velocity of the moving frame of reference and the relative

velocity of the given moving point.

CENTRIPETAL ACCELERATION

Acceleration of a point towards the center of curvature of its path as it

moves along a fixed curve.

TANGENTIAL ACCELERATION

Component of acceleration of a point collinear with its velocity.

NORMAL ACCELERATION

Component of acceleration of a point normal to its velocity.

ANGULAR ACCELERATION

Rate of change of angular velocity with respect to time.
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1.5.5.3.1  Calculate Force-Vectors

Calculate Forces-Vectors:

Click to toggle “Calculate” and “Do not Calculate” the Force Vectors.

Forces toolbar > Force Vectors: Calculate

Forces toolbar > Force Vectors: Do not Calculate 

Forces menu > Force Vectors: Calculate

Note:

To calculate Forces Vectors:

· The kinematic-chains must be kinematically-defined.

· A minimum of one PART has a Mass and/or a Mass Moment of Inertia

· Select the correct element as the Power-Source - see Configure Power

Source .

AND / OR 

· A SPRING FB applies an external force to the kinematic-chain

See also: 

Force-Vectors: Display

Kinetostatic Servomotor and Gearbox selection

589

237

592
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1.5.5.3.2  Add Force-Data FB

Why add a Force-Data FB?

See also: Force-Data FB dialog

Use a FORCE-DATA FB to measure, over a machine-cycle, the force* that acts

ON a POINT at a JOINT, SPRING, 2D-CAM, PULLEY, or RACK-PINION.

Use a GRAPH FB to plot force over a machine-cycle.

See also:

Configure the Power Source

* Force: 

The term we use for Kinetostatic Force and Torque data. 

Kinetostatic Forces are those that arise in parts and at joints that have mass

and mass moment of inertia, when the parts move with a prescribed motion.

The moving parts and machine frame are perfectly rigid, there is no backlash

in the joints, and the pre-scribed motion is followed perfectly. 

Dy

See also: Dynamics for Dynamic Forces and Torques.

Add Force-Data FB

Force-Data FB in graphic-area

STEP 1: Add the Force-Data FB to the

graphics-area.

1. Click Forces menu > Force-

Data 

OR

1. Click Forces toolbar  >

Add Force-Data FB 

Then:

2. Click the graphics-area 

The FORCE-DATA FB is now in the graphics-

area.

Doube-click to edit Force-Data FB

STEP 2. Open the Force-Data FB dialog 

1. Double-click the FORCE-DATA FB to

open the FORCE-DATA DIALOG. 

OR

See 'How to open a dialog'

541
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Force-Data FB dialog

STEP 3. Link the Force-Data FB to a

Force-Element and a Point 

A. Select a Force-Element

1. Click a Force-element in the graph-

ics-area or the ASSEMBLY-TREE 

Force-elements include: JOINT, 2D-

CAM, SPRING, PULLEY, RACK-PINION, 

A list of AVAILABLE POINTS shows in the box

below.

B. Select a Point in the box of Available

Points

Even if a POINT shows in the SELECTED

FORCE OUTPUT ELEMENT box:

1. Click a POINT in the box below

AVAILABLE POINTS 

If you select a:

· PIN-JOINT - there are two(2) AVAIL-

ABLE POINTS

One POINT on each PART of the
PIN-JOINT

· SLIDE-JOINT - there are four(4)
AVAILABLE POINTS

Two POINTS on each LINE of the
SLIDE-JOINT

· 2D-CAM  - zero(0) AVAILABLE

POINTS

CONTACT POINT is selected

· SPRING FB  - two(2) AVAILABLE

POINTS 

The SPRING'S Anchor POINTS

· RACK-PINION  - two(2) AVAILABLE

POINTS 

The CONTACT-POINTS between the
RACK AND PINION

C. Complete the command 

3. Click  to close the FORCE-DATA

FB 

128

234

136
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1.5.5.3.3  Configure Power Source

Why Configure Power Source?

Each degree-of-freedom in a kinematic-chain has a power-source.

In the default case, the power-source is a motor at the joint whose motion

you control with a MOTION-DIMENSION FB. Frequently, the motor is at a dif-

ferent joint, or a Cam provides the power to move a kinematic-chain.

If the power-source for a degree-of-freedom is not the correct element, you

must use the CONFIGURE POWER SOURCE DIALOG to move it to the correct

element.

The elements that can be a power-source are: PIN-JOINTS, SLIDE-JOINTS,

2D-CAMS, SPRINGS, and PULLEYS.

To identify the Power-Source

In the default case, the Power-Source is at the joint whose position and mo-

tion you control with a MOTION-DIMENSION FB. 

A Motor-Symbol  represents a Power-Source at the joint.

To see the Motor-Symbol, toggle on:

· Forces toolbar > Force-Vectors: Calculate

· Force toolbar > Force-Vectors: Display

To open the Configure Power-Source dialog
There are two methods to open the CONFIGURE POWER-SOURCE DIALOG.

METHOD 1 - shortcut menu or keyboard

229
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Configure Power Source from

Kinematics-Tree

1. Click the KINEMATICS-TREE in

the Element-Explorer  

2. Click the Kinematic-Chain for

which you want to control the

Power-Source. 

The Kinematic-Chain should be Blue.

3. Right-click the  Kinematic-Chain

 in the Kinematics-Tree

4. Click Configure Power Source in

the shortcut menu (see image,

left)

OR

3. Press the ALT+P keyboard short-

cut 

The CONFIGURE POWER SOURCE DIALOG is now open.

See Configure Power Source dialog .

METHOD 2 - command icon

In the Kinematics-Tree:

1. Click the KINEMATICS-TREE in the Element-Explorer  

2. Click the Kinematic-Chain

The  Kinematic-Chain  should be Blue.

3. Click Force toolbar  (or menu) > Configure Power Source icon.

 

OR

3. Forces menu > Configure Power Source

The CONFIGURE POWER SOURCE DIALOG is now open.

See Configure Power Source dialog .

315
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1.5.5.3.4  Add Spring FB

Why add a Spring FB?

See also: Spring FB dialog

Use a SPRING FB to add a force between two POINTS*. The POINTS* are usu-

ally in different PARTS.

* POINT, START-POINT, END-POINT, CENTER-POINT.

One SPRING FB can superimpose these forces:

· SPRING FORCE - a force proportional to the dimensional difference

between the Spring's ANCHOR-POINTS and its FREE-LENGTH.

· CONSTANT FORCE - a constant force that pulls or pushes the Spring's AN-

CHOR-POINTS, throughout the machine-cycle.

· COULOMB CONSTANT-FORCE - a constant force that acts in the direction

that is opposite to the relative velocity between the SPRING'S ANCHOR-

POINTS.

· DRAG-FORCE - a force that is proportional to the relative velocity

between the Spring's ANCHOR-POINTS.

· DRAG FORCE-SQUARED - a force that is proportional to the square of the

relative velocity between the Spring's ANCHOR-POINTS.

· FORCE-FUNCTION - a force-function that you add to the input-connector

of the SPRING FB.

The Forces values are superimposed (added) together to give the Total-Force

at the output-connector of the SPRING FB.

Terminology:

Anchor-Points : 

The two(2) POINTS that define the axis through which the

SPRING FB applies its Force.

You select the two POINTS when you add a SPRING FB.

Force element : A SPRING FB is a Force-Element. 

Linear Motive Force : 

The SPRING FB can be a Power-Source. It calculates the Ap-

plication Load.

A Linear Motor would provide the Linear Motive Force

equal to the Application Load.

538
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Add Spring FB

Spring FB in the graphic-area

STEP 1: Start the Add Spring FB com-

mand

1. Click  Forces menu >

Spring FB  

OR

1. Click Forces toolbar

> Add Spring FB 

STEP 2: Select the Anchor-Points

1. Click two different POINTS - the

ANCHOR-POINTS - in two differ-

ent PARTS. 

The distance between the two

POINTS shows next to your mouse-

pointer.

2. Click the graphics-area to place

the dimension and the SPRING

FB. 

The SPRING FB is now in the graph-

ics-area.

STEP 3: Open the Spring FB dialog

SPRING FB in the graphics-area:

SYMBOL FB - see SPRING FB CONNECTORS

SYMBOL SPRING between the ANCHOR-POINTS

DIMENSION between the ANCHOR-POINTS

NOTE: Positive (Negative) force values Pull (Push) the Anchor-Points to-

gether (apart).

Spring FB States:

The SPRING FB can be in three different states.

STATE 1: The Spring FB is enabled.

The default state. The SPRING FB exerts a Force that is defined by the para-

meters in the Spring FB dialog .

226
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Spring FB - Enabled

STATE 2: The Spring FB is not enabled

To enable/disable the SPRING FB

1. Edit the SPRING FB to open the SPRING FB DIALOG  

In the SPRING FB DIALOG

2. Select / deselect the ENABLE CHECK-BOX.

3. Click  to close the dialog.

Spring FB > Not enabled

STATE 3: The Spring FB is a Linear Motor 

To change the SPRING to a Linear-Motor

1. Open the Configure Power Source dialog of the kinematic-chain

for which the SPRING FB will be Linear-Motor. 

In the CONFIGURE POWER SOURCE DIALOG:

2. Click the MOTION-DIMENSION FB that applies the motion to the kin-

ematic-chain

3. Click the SPRING FB as the POWER SOURCE,

The SPRING FB is now a Linear Motor.

4. Close the CONFIGURE POWER SOURCE DIALOG.

See - Configure Power Source

538
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Spring FB > Linear Motor

1.5.5.3.5  Display Force-Vectors

Display Force-Vectors

Click the button to toggle “Display” and “Do not Display” Force Vectors.

Forces toolbar > Force-Vectors: Display

Forces toolbar > Force-Vectors: Do not Display

Forces menu > Force-Vectors: Display: Enable or

Disable 

Force-Vectors show ONLY when...

· You enable: Force toolbar > Force-Vectors: Calculate

AND

· You enable: Force toolbar > Force-Vectors: Display

AND

· A minimum of one PART is kinematically-defined and it has a

mass(kg) - see CAD-LINE DIALOG | MASS PROPERTIES .

AND/OR

· A SPRING FB  applies a Force between two POINTS and the PARTS

are kinematic-defined.

AND

· You enable: Display Filters toolbar > Display Part-Outlines (de-

fault)

Force-Vectors in the graphics-area 

Each Force-Vector is the Force that ACTS-ON a PART at a Joint in a kin-

ematic-chain.

Vector Location: rays from POINTS at PIN-JOINTS, SLIDE-JOINTS,

SPRINGS, CAM CONTACTS, GEAR CONTACTS, BELTS. 

Vector Direction: in the direction of the Force-Vector

Vector Length: scaled to the magnitude of the Force - see Vector

Scale buttons
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Vector Magnitude: that acts on the POINT is at the arrowhead at the

end of each Force vector

Vector Color: see below Colors: Part-Outlines and Force-Vectors .

Rotary Driving Moment / Driving Torque

The Torque-Vector is the Application-Torque that a motor and gear-

box must be able to drive. 

Location: at a PIN-JOINT that you select to drive the kinematic-chain

- see Configure Power Source

Length: proportional to the magnitude of the Torque.

IMPORTANT:

The Torque-Vector does NOT include the torque to accelerate the

inertia of a Servomotor or Gearbox

To select and include a Servomotor and Gearbox - see Kinematic

Servomotor and Gearbox Sizing .

Linear Driving-Force

The Driving-Force is the instantaneous Force to drive the kinematic-

chain. 

Location: at a SLIDE-JOINT that you select to drive the kinematic-

chain - see also: Configure Power Source )

Length: proportional to the magnitude of the Driving-Force.

IMPORTANT:

The Driving-Force does NOT include a Linear Servomotor to drive

the kinematic-chain.

There is NOT a database of Linear Servo-motors.

Colors: Part-Outlines and Force-Vectors 

When you enable Force-Vectors: Display, we  color of each PART-OUT-

LINE is changed. 

The color of the PART-OUTLINE of each PART is the same color as the

Force-Vectors that ACTS-ON the PART, at a POINT in the PART.

TOP-TIP

To help identify which Force-Vectors act on a PART: 

1. Hover above a PART-OUTLINE 

The PART-OUTLINE AND the Force-Vector that ACTS-ON the PART

change to the selected color, usually RED. 

Use Configure Power Source  to edit the color of each Force-Vector,

and/or to hide Force-Vectors that act on different PARTS.

See also: Kinetostatic Torque and Speed dialog
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1.5.5.4 MD-Solids

 MD-Solid 

The commands in the MD-Solids menu and MD-Solids toolbar relate to MD-

SOLIDS only.

Terminology and Definitions

SOLIDS : Generic name for MD-SOLIDS and CAD-SOLIDS.

MD-SOLIDS : Those SOLIDS that you add to a PART with the Add Profile and

Add Auto-Profile commands.

CAD-SOLIDS : Those SOLIDS that you import from your 3D-CAD onto a CAD-

LINE.

To see MD-SOLIDS and CAD-SOLIDS, you must enable Visibility toolbar > Show

Solids in Mechanisms  

MD-Solids menu

Solids menu (MD17)

MD-Solids toolbar

The MD-Solids toolbar is above the graphics-area

Solids toolbar

66
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1.5.5.4.1  Auto-Layer

What is 'Auto-Layer'?

The Auto-Layer commands edits for you, by different values, the EXTRU-

SION-OFFSET and PART-OFFSET parameters (in EXTRUSION DIALOGS) to

move ALL EXTRUSIONS in the active MECHANISM-EDITOR along the Z-axis, by

different distances.

After you do Auto-Layer, EXTRUSIONS should not collide with each other

when you cycle the model. 

Auto-Layer should save you time. However, Auto-Layer is not perfect! If,

after you use Auto-Layer, EXTRUSIONS do collide, you need to edit manually

the EXTRUSION-OFFSET and PART-OFFSET parameters for each EXTRUSION

that collides.

Warning: The Auto-Layer command is not a toggle - the offset distances do

not UNDO if you click Auto-Layer again.

See also: Auto-Profiles (Mechanism) , Auto-Profile (Part) , Profile, Extrusion dia-

log

Note:

Before you do Auto-Layer, you usually add AUTO-PROFILES and/or PROFILES.

See:

· MD-Solids menu > Auto-Profile (all Parts)

· MD-Solids menu > Auto-Profile (Part)

· MD-Solids menu > Profile

To see MD-SOLIDS

· Enable Visibility menu > Show Solids in Mechanisms

Auto-Layer

Before 'Auto-Layer'

244 242
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After 'Auto-Layer'

STEP 1: Do the Auto-Layer command.

1. Click MD-Solids menu > Auto-Layer

OR

1. Click MD-Solids toolbar > Auto-Layer

Video:
Double-click to watch Solids menu > Auto-Layer


AutoLayer.gif
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1.5.5.4.2  Auto-Profile (Part)

What is an Auto-Profile?

An AUTO-PROFILE is an MD-SOLID.

When you do Add Auto-Profile (Part) and/or Auto-Layer (all Parts), we add

or remove for you a quasi-sketch-loop and an AUTO-PROFILE / EXTRUSION to

one PART.

See also 

Auto-Profile (all Parts)

Notes:

To see MD-SOLIDS in MECHANISM-EDITORS, enable Visibility toolbar > Show

Solids in Mechanisms  

To edit an EXTRUSION, see How to open the Extrusion dialog .

Auto-Profile (Part)

STEP 1: Start the Add Auto-Profile command:

1. Click MD-Solids menu  > Add Auto-Profile (Part) 

OR

1. Click MD-Solids toolbar > Add Auto-Profile (Part) 

STEP 2: Select a Part:

The COMMAND-MANAGER has one selection-box.

In the graphics-area or ASSEMBLY-TREE:

1. Click the PART-OUTLINE to add or delete an AUTO-PROFILE to or from a

PART. 

Command-Manager

Add Auto-Profile

STEP 3: Complete the Command:

1. Click  in the COMMAND-MANAGER.

RESULT

244
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Auto-Profile in Mechanism-Editor

The shape of the quasi-sketch-loop is a function of the JOINTS in the PART and

the Bearing Sizes in the APPLICATION-SETTINGS > AUTO-PROFILE DIALOG

The image shows the AUTO-PROFILE (Pink) around a SLIDE-JOINT and a PIN-JOINT.

RULE:

IF the PART does not have an AUTO-PROFILE: 

Add a quasi-Sketch-loop and AUTO-PROFILE / EXTRUSION to the SKETCH-

LOOP ...

... to the ONE PART 

ELSE

IF the PART has an AUTO-PROFILE: 

Delete the AUTO-PROFILE and quasi-sketch-loop ...

... from the ONE PART 

Quasi-Sketch-Loops

Original quasi-Sketch-Loop after Add

Auto-Profile

Increased Radius of a quasi Arc.

Quasi-sketch-loops control the shape of the AUTO-PROFILES.

They have these properties:
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· They do not have START-POINTS or END-POINTS.

· You cannot select, edit, delete quasi-Arcs or quasi-Lines.

· You cannot add a joint between a PART and a quasi-Line.

· There is no Tangent constraint between the quasi-Arc and quasi-Line

sketch-elements.

However,

· You can edit the Radius (dimension) of each quasi-Arc.

Image above: after you edit the Radius of a quasi-Arc you can see the Tan-

gent constraint is missing between the quasi-Arc and quasi-Line.

To edit an Extrusion - Special-Case

Edit Extusion and shortcut menu

To edit an Extrusion when you cannot see the Extrusion in the model.

1. SHIFT + Click the AUTO-PROFILE in the graphics-area 

The AUTO-PROFILE and EXTRUSION are in the SELECTION-WINDOW.

2. Right-click the EXTRUSION in the SELECTION-WINDOW

A shortcut menu shows next to your pointer.

3. Click Edit element in the shortcut menu

The EXTRUSION DIALOG opens.

 See Extrusion dialog  for more information.

1.5.5.4.3  Auto-Profiles (all Parts)

Auto-Profiles (all Parts)

Add Auto-Profile (all Parts) to ADD AUTO-PROFILES to all PARTS in the

MECHANISM-EDITOR.

OR

Add Auto-Profile (Mechanism) to DELETE AUTO-PROFILES from all PARTS in

the MECHANISM-EDITOR.

Notes:

· Enable Visibility toolbar > Show Solids in Mechanisms  to see MD-

SOLIDS in MECHANISM-EDITORS.

360

66
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· The sketch-loops that control the shape of each AUTO-PROFILE have lim-

ited properties - see Quasi Sketch-Loop.

· AUTO-PROFILES have Mass and Mass Moment of Inertia properties.

Add Auto-Profiles (all Parts)

STEP 1: Do Add Auto-Profile (all Parts)

1. Click MD-Solids menu  > Add Auto-Profile (all Parts) 

OR

1. Click MD-Solids toolbar  > Add Auto-Profiles (all Parts) 

Then:

2. Click the graphics-area 

RESULT

Parts with Auto-Profiles.

RULE

IF # of PARTS with AUTO-PROFILES 50% 

Add quasi-sketch-loops and AUTO-PROFILES / EXTRUSIONS ...

 ... to ALL PARTS in the active MECHANISM-EDITOR.

ELSE 

IF # of PARTS with AUTO-PROFILES > 50%

Delete AUTO-PROFILES and quasi-sketch-loops ...

... from ALL PARTS in ALL kinematic-chains in the active MECHANISM-EDITOR.

Video : Add Profiles (all Parts)

Double-click for a Video

Quasi-Sketch-Loops

239

239
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Original quasi-Sketch-Loop after Add

Auto-Profile

Increased Radius of a quasi Arc.

Quasi-sketch-loops control the shape of the AUTO-PROFILES.

They have these properties:

· They do not have START-POINTS or END-POINTS.

· You cannot select, edit, delete quasi-Arcs or quasi-Lines.

· You cannot add a joint between a PART and a quasi-Line.

· There is no Tangent constraint between the quasi-Arc and quasi-Line

sketch-elements.

However,

· You can edit the Radius (dimension) of each quasi-Arc.

Image above: after you edit the Radius of a quasi-Arc you can see the Tangent

constraint is missing between the quasi-Arc and quasi-Line.

1.5.5.4.4  Add / Update Polyline

Why add a Polyline?

A POLYLINE sketch-element is a sketch-loop* that is a copy of the shape of a

2D-CAM and GEAR-PAIR.

You can add PROFILE/EXTRUSIONS to a sketch-loop.

Therefore, you can model 2D-CAMS and GEAR-PAIRS as MD-SOLIDS.

* If a 2D-CAM is “Open”, or the gears in a GEAR-PAIR are “Gear-Segments”, you

must edit the PARTS after you add a POLYLINE to add sketch-elements to close the

sketch-loop.

Add Polyline / Update Polyline

STEP 1: Put the MMA to Zero degrees
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1. Press ALT+H or the Home key on your keyboard

STEP 2: Start the Add Polyline command:

2. Click MD-Solids menu  > Add Polyline 

OR

2. Click MD-Solids toolbar  > Add Polyline 

The COMMAND-MANAGER has one selection-box.

Command-Manager

STEP 3: Select a 2D-Cam or Gear-Pair 

To ADD a POLYLINE to a 2D-CAM or GEAR-PAIR:

1. Click a 2D-CAM or GEAR-PAIR in the graphics-area or ASSEMBLY-TREE 

Add Polyline

OR ...

To UPDATE the shape of the POLYLINE to the new shape of a 2D-CAM or GEAR-

PAIR:

1. Click the new shape of a 2D-CAM or GEAR-PAIR in the graphics-area or

ASSEMBLY-TREE 

Update Polyline

239
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The 2D-CAM or GEAR-PAIR is in the COMMAND-MANAGER selection-box.

2D-Cam element in the Selection-Box

STEP 4: Complete the command

1. Click  in the COMMAND-MANAGER 

If necessary:

2. Click Rebuild Now  to make sure the POLYLINE is correct.

The POLYLINE is now a sketch-element in the PART that is the shape of the 2D-

CAM or GEAR-PAIR.

50
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1.5.5.4.5  Show/Hide Extrusion

What does this tool do?

You can show or hide an EXTRUSION element with the EXTRUSION DIALOG.

Also, you can use this tool as a shortcut to show or hide an EXTRUSION.

To see EXTRUSIONS in the graphics-area, you must enable:

· Visibility toolbar  > Show Solids in Mechanisms

Show-Hide Extrusion

Toggle Visibility of Extrusion

If you CANNOT see the EXTRUSION, but you can see the PROFILE, in the graphics-

area:

1. SHIFT + CLICK the PROFILE in the graphics-area 

2. Click MD-Solids menu  >  Show-Hide Extrusion

The COMMAND-MANAGER has one selection-box - the EXTRUSION is

selected.

Click  in the COMMAND-MANAGER

Now, you can see the EXTRUSION

If you CAN see the EXTRUSION in the graphics-area.

1. CLICK the EXTRUSION in the graphics-area 

2. Click MD-Solids toolbar  >  Show-Hide Extrusion

The COMMAND-MANAGER has one selection-box - the EXTRUSION is

selected.

Click  in the COMMAND-MANAGER

Now, you cannot see the EXTRUSION

Element icon for Hidden Extrusion

Note:

60 66
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239
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Toggle Visibility of Extrusion

If you CANNOT see the EXTRUSION, but you can see the PROFILE, in the graphics-

area:

1. SHIFT + CLICK the PROFILE in the graphics-area 

2. Click MD-Solids menu  >  Show-Hide Extrusion

The COMMAND-MANAGER has one selection-box - the EXTRUSION is

selected.

Click  in the COMMAND-MANAGER

Now, you can see the EXTRUSION

If you CAN see the EXTRUSION in the graphics-area.

1. CLICK the EXTRUSION in the graphics-area 

2. Click MD-Solids toolbar  >  Show-Hide Extrusion

The COMMAND-MANAGER has one selection-box - the EXTRUSION is

selected.

Click  in the COMMAND-MANAGER

Now, you cannot see the EXTRUSION

When you hide the EXTRUSION the color of the EXTRUSION element-icon in

the ASSEMBLY-TREE and the SELECTION-WINDOW is gray. 

Note: 

Other methods to control the Visibility of an Extrusion:

1. SHIFT + Click a PROFILE in the graphics-area. 

The EXTRUSION shows in the SELECTION-WINDOW

2. RIGHT-CLICK THE EXTRUSION

In the shortcut menu

3. Select Show or Hide Solid Elements

239

239
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1.5.5.4.6  Add Hole

What is a Hole?

A HOLE cuts the shape of a SKETCH-LOOP through a PROFILE / EXTRUSION (MD-

Solid) that is in the model.

Note: To see the HOLE through the PROFILE / EXTRUSION, enable Visibility toolbar

> Show Solids in Mechanisms

Add Hole

STEP 1: Start the command Add Hole:

1. Click MD-Solids menu  >

Add Hole 

OR

1. Click MD-Solids toolbar >

Add Hole 

The COMMAND-MANAGER starts.

There is one selection-box.

STEP 2: Select the two elements for the

Command-Manager

1. Click a SKETCH-LOOP , all of which

is inside the bounds of PROFILE  

2. Click PROFILE  through which you

want to cut the HOLE

The SKETCH-LOOP and the PROFILE are

now in the selection-boxes in the COM-

MAND-MANAGER

Hole through Profile / Extrusion

STEP 3: Complete the Command 

1. Click  in the COMMAND-MANAGER 

RESULT:

Assembly-Tree: the HOLE element is a

child to the PROFILE element. 

Graphics-area: the HOLE cuts through the

PROFILE / EXTRUSION.

<<< image, in the MODEL-EDITOR, of the

HOLE that is cut through the MD-SOLID.

See also: Sketch-Loop, Profile, Command-Manager

66
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Video:
Double-click to watch 'Add Hole'


AddHole.gif
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1.5.5.4.7  Add Profile / Extrusion

What is a Profile / Extrusion?

A PROFILE/EXTRUSION is an MD-SOLID.

Use Add Profile/Extrusion to add a PROFILE to a sketch-loop. We also add for

you an EXTRUSION element as a child to the PROFILE.

You can add many PROFILE/EXTRUSIONS to the same sketch-loop.

Note: 

The Follower-Profile you select when you Add 2D-Cam / Add 3D-Cam is a

PROFILE element.

See also: Shape of the Follower-Profile.

Terminology:

Sketch-Loop : A series of sketch-elements, that you join end to end to form a

closed loop. The START-POINTS and END-POINTS where the

sketch-elements join together must be merged to one POINT.

Sketch-loops cannot cross over each other and the cannot

branch.

PROFILE : Two offset contours that are a copy of the sketch-loop you select

when you do Add Profile.

EXTRUSION : The SOLID between the two offset contours.

Preparation for Add Profile / Extrusion

3x Sketch-Loops in a Part

Three example sketch-loops in the model

before you do Add Profile:

A SKETCH-LOOP is in a PART

Add Profile / Extrusion

STEP 1: Start the Add Profile command

1. Click  MD-Solids menu >

Add Profile

OR

1. Click MD-Solids toolbar >

Add Profile

The COMMAND-MANAGER starts.
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3x Sketch-Loops in a Part

STEP 2: Select a sketch-element that be-

longs to a sketch-loop

1. Click a SKETCH-ELEMENT  that is in

one sketch-loop, or a POLYLINE 

The name of the sketch-element is in the

COMMAND-MANAGER.

3 x Profile Contours in graphic-area

STEP 3: Complete the command:

1. Click  in the COMMAND-MANAGER.

 

We add for you a PROFILE and EXTRU-

SION to the sketch-loop that you select.

Do 1 - 3 again to add a PROFILE to a differ-

ent, or the same, sketch-loop.

RESULT : graphics-area

We add for you the Primary and Sec-

ondary contours of the PROFILE ele-

ment, which are copies of the sketch-

loop, and the EXTRUSION, which is the

SOLID between the PROFILE contours.

The default position of the Primary

Contour is coplanar with the sketch-

loop that you select. 

Use the EXTRUSION DIALOG to move the

contours and EXTRUSION relative to the

sketch-loop, as required.

To see the EXTRUSION, enable Visibility

toolbar  > Show Solids in Mechan-

isms  

See also How to open the Extrusion

dialog

The image shows 3 PROFILE and EXTRUSION

elements.

The default color of the EXTRUSION is

Blue.

3 x Extrusions in graphic-area

60

66
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Profile and Extrion elements in the

Assembly-Tree

RESULT : Assembly-Tree

The PROFILE is a child to the PART in

which there is the sketch-loop. 

The EXTRUSION is a child to the PROFILE.

 

See also : 

Tutorial 4: Add Profile (external link)

Add Auto-Profile , Add Auto-Profiles , Polyline Sketch-Loop

Video Add Profile:Double-click to watch the Video

How to edit an Extrusion

To EDIT an EXTRUSION ELEMENT - with the

SELECTION-WINDOW.

In the graphics-area:

1. SHIFT + CLICK the PROFILE 

The PROFILE and EXTRUSION show in the

SELECTION-WINDOW.

In the SELECTION-WINDOW:

2. Right-click the EXTRUSION

In the shortcut menu

3. Click Edit element

The EXTRUSION DIALOG opens.

See Extrusion dialog

OR

SELECTION-WINDOW: Right-Click

ASSEMBLY-TREE - 

Right-click Extrusion

To EDIT an EXTRUSION ELEMENT - in the
ASSEMBLY-TREE

In the ASSEMBLY-TREE 

1. Click the PROFILE to expand and see

the EXTRUSION element - a child to

the PROFILE element 

2. Click the EXTRUSION to make sure it

has a square ORANGE box around

the EXTRUSION icon

3. Right-click the EXTRUSION

In the shortcut menu

242 244

360

http://mechdesigner.support/index.htm?md-qst4-create-solids.htm

AddProfile.gif
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4. Click Edit element.

How to delete a Profile

ASSEMBLY-TREE -  Delete Profile

To DELETE a PROFILE ELEMENT

In the graphics-area

1. CLICK the PROFILE 

The PROFILE shows in the SELECTION-

WINDOW.

In the SELECTION-WINDOW:

2. Right-click the PROFILE

In the shortcut menu

3. Click Delete

We delete for you the PROFILE and the EX-

TRUSION elements from the model.
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1.5.6 2.3 Part-Editor

 Part-Editor 

What is a Part?

A PART represent any rigid-body in your machine.

PARTS in MechDesigner include the:

· BASE-PART : the fixed frame of each MECHANISM-EDITOR. 

· PARTS : the PARTS you add to the model. 

Derived names for PARTS include:

· Connecting-Part : a PART in a spatial mechanism 

· Free, Completely-Free, not kinematically-defined, or not solved : a

PART whose Mobility > 0

· Kinematically-defined and solved : a PART whose Mobility = 0

· Motion-Part, Rocker, and Slider : a PART whose motion you control

with a MOTION-DIMENSION FB

What is the Part-Editor?

The PART-EDITOR is the workspace to edit a PART. 

It includes the Part name-tab, the graphics-area, and the XY-axes at the ori-

gin of the PART.

The commands are in the Geometry menu (New MD17), the Geometry tool-

bar, and the Constraints toolbar.

Why edit a Part?

Use the PART EDITOR to add sketch elements, constraints, and dimensions

to a PART.

See more: Why edit a Part .

See also: How to start the Part-Editor  and How to exit the Part-Editor

Part-Editor workspace

When you edit a PART, the PART-EDITOR workspace replaces the MECHAN-

ISM-EDITOR workspace in which the PART is a child. To edit a different PART,

you must first close the PART-EDITOR, and then edit the different PART.

674

259 263
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Part-Editor: Example

Graphics-area : shows the XY-Axes of the PART, the sketch-elements, and di-

mensions that you add to the PART.

Name-tab : is above the graphics-area. The name of the tab changes from

the name of the MECHANISM-EDITOR to the name of the PART.

Note:

We do not show in the graphic-area the Constraints you add to or

between sketch-elements - see How to delete a constraint .

Menus and Toolbars:

See also: How to start the Part-Editor  and How to exit the Part-Editor

Geometry menu

Geometry menu : Add sketch-elements, constraints, and dimensions

The Geometry menu has the commands that are in the Geometry toolbar

and Constraints toolbar.

Geometry toolbar  (left (<<) of workspace and graphics-area)

The commands to add sketch-elements and dimensions

Constraints toolbar  (right (>>) of workspace and graphics-area)

The commands to add constraints to and between sketch-elements.

297
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1.5.6.1 How to start (open) the Part-Editor

How to start (open) the Part Editor

Use the PART-EDITOR to edit one PART at a time. 

To edit a different PART:

1. Exit (close) the PART-EDITOR - see also How to exit (close) the Part-Editor

2. Select and edit a different PART.

Video: How to start the Part-Editor:

Double-click to watch

How to start the Part-Editor - more details

Do one these methods.

METHOD 1: Edit-Part tool 

STEP 1: Click a PART-OUTLINE  in the

graphics-area 

STEP 2: Click Edit toolbar >  Edit Part

 (MD17: Toggle "Part-Ed-

itor")

You can now use the PART-EDITOR to

add, edit, or delete sketch-elements

and constraints in the PART-EDITOR. 

See How to delete Constraints

Note: The (MD17: Toggle "Part-Editor") icon is to the left of the

graphics-area.

See also: How to close the Part-Editor: Method 1

METHOD 2: Selection-Window  

STEP 1: Click a Part-Outline 

STEP 1: Select the Part

In the graphics-area: 

1. Click the PART-OUTLINE  ( or

at  with some graphic-cards).

OR

Assembly-Tree:

1. Click the PART element 

STEP 2: In the Selection-Window 

1. Find the PART from the list of

elements in the SELECTION-WIN-

DOW  

263

672
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STEP 2: Right-click the Part in the

Selection-Window, Click Edit element

2. Right-click the PART element

In the shortcut menu

3. Click Edit Element 

The PART is now open in the PART-ED-

ITOR.

METHOD 3: Double-Click 

Double-click a Part-Outline in the

graphic-area

STEP 1:

Double-click ... in the graphics-

area:  

1. Double-click the PART-OUTLINE

 

OR

1. Double-click a LINE, ARC, or

CIRCLE SKETCH-ELEMENT  that

is in the PART 

OR

1. Double-click the Y-AXIS  of

the PART 

The PART is now open in the PART-

EDITOR.

OR

Double-click ... in the Assembly-

Tree: 

1. Double-click the PART element 

The PART is now open in the PART-

EDITOR.

Double-click a Part in the

Assembly-Tree

If you double-click a:

CAD-Line  ... the CAD-Line dialog  opens

Blend-Curve  ... the Blend-Curve dialog  opens

Point  ... the Point Properties dialog  opens

More than one element ... nothing happens.

METHOD 4: Right-Click

364

549
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Hover+ Right-click a Part-Outline in the

graphic-area

In the graphics-area:

1. Move your mouse above the

PART-OUTLINE 

Note: With some graphic-cards, move

your mouse to the arc at the end of the

PART-OUTLINE near to the START-POINT

of the PART and CAD-LINE.

2. Right-Click the PART-OUTLINE 

3. Click Toggle “Part-Ed-

itor” (MD16: Edit in Part-Editor)

from the shortcut menu.

The PART is now open in the PART-ED-

ITOR.

Occasionally, there is a problem with a Graphic-Card

With some graphics cards, you cannot select the PART-OUTLINE to edit a

PART. Try these methods:

Select the Part-Outline near start-Point.

METHOD 1: Graphics-area

1. Move your mouse-pointer above

the arc of the PART-OUTLINE near

to the Part-axes -(see image) 

2. Double-click your mouse

METHOD 2: Selection-Window

1. Move your pointer above the arc

of the PART-OUTLINE - see image

 

2. Click your mouse one time.

In the SELECTION-WINDOW:

3. Right-Click the PART

4. Click Edit element

OR Double-click the Y-axis

METHOD 3: 

OR

1. Double-click the Y-axis.
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Select a Part in the Assembly-Tree

Method 4:

OR

In the ASSEMBLY-TREE

1. Right-Click the PART 

2. Select Edit element in the short-

cut menu.
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1.5.6.2 How to exit (close) the Part-Editor

How to exit (close) the Part-Editor

See also : How to Start the Part-Editor

When you close the PART-EDITOR, you return to the MECHANISM-EDITOR. 

To close the PART-EDITOR, do one of these methods.

METHOD 1: Deselect the Edit-Part icon

1. Click the Geometry toolbar > Edit Part (MD17: Toggle "Part-Ed-

itor") icon, at the left of the graphics-area. 

METHOD 2: Double-click a sketch-element

1. Double-click a LINE, CIRCLE, or ARC sketch-element that is a child to the

PART that is open in the PART-EDITOR.

Note: If you double-click a...

CAD-Line  ...the CAD-Line dialog  opens

Blend-Curve  ...the Blend-Curve dialog  opens

Point  ...the Point Properties dialog

opens

More than one element: ... nothing happens.

METHOD 3: Double-click the Y-axis

1. Double-click the Y-axis. 

Note: 

We recommend the Y-axis because the X-axis is collinear with the CAD-

LINE element. 

And, if you double-click the CAD-LINE, then the CAD-LINE DIALOG opens.

METHOD 4: Right-click

1. Right-click the graphics-area 

259
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The shortcut menu shows.

2. Click the Edit Part (MD17: Toggle "Part-Editor" ) in the shortcut menu. 

METHOD 5: Double-click element in Assembly-Tree

1. Double-click the PART in the ASSEMBLY-TREE. 
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1.5.6.3 Geometry

Part-Editor - Geometry menu and toolbar

Use the commands in the Geometry menu and Geometry toolbar: 

· to edit the length of a PART 

· to add sketch-elements to a PART

· to add dimensions to, or between, sketch-elements

· to import a SOLIDWORKS sketch onto a PART

· to use the Merge-Points command to merge two POINTS into one

TOP-TIP:

Add each sketch-element so that it is clearly not constrained (other than for a

sketch-loop) For example, add a LINE that is not Horizontal. Then add the Ho-

rizontal constraint.

See also: Constraints menu and toolbar

Geometry menu > Geometry commands

The Geometry menu has the commands to add sketch-elements to a PART.

Geometry menu > Geometry elements (MD17)

Part-Editor: Geometry toolbar

The Geometry toolbar is to the left of the graphics-area.

296
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Geometry toolbar

[Click text to see more...]

 SKETCH-ELEMENTS and the BASE-PART

Before you can add a joint between the BASE-PART and a PART, you must

edit the BASE-PART to add to it a minimum of one sketch-element.

The first sketch-element in the BASE-PART?

Add a LINE as the first sketch-element.

Why? 

A LINE gives you the most flexibility. 

Why?

After you add a PART to the model:

· You can select the START-POINT or END-POINT of the LINE to add a

PIN-JOINT. Then, you can reference the LINE to add a MOTION-DIMEN-

SION FB for a Rocker.

· You can select the LINE to add a SLIDE-JOINT. Then, you can reference

the START-POINT or END-POINT of the LINE to add a MOTION-DIMEN-

SION FB for a Slider.



267

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

ABOUT GEOMETRY

Different names for POINTS:

· POINT - the SKETCH-ELEMENT you add to the PART with Add Point.

· START-POINT - the POINT where you mouse-button down at the start of

the drag action to add a LINE, CAD-LINE, ARC, or BLEND-CURVE.

· END-POINT - the POINT where you mouse-button up at the end of the

drag action to add a LINE, CAD-LINE, ARC, or BLEND-CURVE.

· CENTER-POINT - the POINT where you mouse-button down at the start of

the drag action to add a CIRCLE.

· CENTER-POINT - the POINT at the center of an ARC after you mouse-but-

ton up at the end of the drag action to add an ARC.

Colors of sketch-elements in the

Part-Editor

Typical Colors of Sketch-Elements

Part-Editor

· Blue (typically) sketch-elements

are under defined

· Green: (typically) sketch-ele-

ments are fully defined

· Red: (typically) sketch-elements

that are over defined.

Colors of sketch-elements in the

Mechanism-Editor

Mechanism-Editor: 

· Green: PART is solved, is kinemat-

ically-defined

· Blue: PART is not solved (not kin-

ematically-defined

Trouble-shoot - Geometry

· CTRL+Z should return the geometry to the previous state. 

· If a sketch-element is Green but it should be Blue: delete the sketch-

element, and add the sketch-element again.

Trouble-shoot - Constraints

To delete a Constraint that you think is a problem:

1. SHIFT + Click a sketch-element, or POINT, with a Constraint

The sketch-element, or POINT, and all Constraints that you have added to

the sketch-element show in the SELECTION-WINDOW.

2. Delete the Constraint from the SELECTION-WINDOW.

Trouble-shoot - Dimensions

· Delete an angle dimension if you cannot edit to be more than 180º.

Move the sketch-element, and add the angle dimension again.

· Delete a dimension if it does not pass through 0, (angular or linear

dimension), and add the dimension again.
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Fix Constraint

To FIX a POINT, START-POINT, END-POINT, or CENTER-POINT: use the LOCK

AND SPECIFY check-box in the Point Properties dialog .

However, you cannot FIX a POINT with the LOCK AND SPECIFY check-box if

the POINT is constrained with a Constraint or a Dimension.

543
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1.5.6.3.1  Add Dimension

Add Dimension 

Dimensions you can add:

· Distance between POINTS* 

· Length of a LINE**

· Radius of a CIRCLE or ARC

· Perpendicular (shortest) Distance from a POINT* to a LINE**, X-AXIS, or Y-

AXIS

· Angle between two LINES, or the Angle from the X-AXIS or Y-AXIS to a

LINE**

· Angle between three POINTS*

* POINT, START-POINT, END-POINT, and CENTER-POINT.

** LINE or CAD-LINE

Notes:

Usually, do not make a dimension zero. It is better to add a constraint. See

Sketch-Constraints  

See How to add dimensions , How to edit a dimension .

See also: Number-Format: Precision and Digits , Dimension Font Size , Show Di-

mension Names

296
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Add Dimension - menu or toolbar

To Add a Dimension:

1. Click Geometry toolbar > Add Dimension (left of

graphics-area) 

OR

1. Click Geometry menu > Dimension 

2. Click the sketch-element, or sketch-elements, to add a linear or

angular dimension - see below How to Add a Dimension  

The DIMENSION shows near to your mouse-pointer.

3. Click in the graphics-area to place the dimension-line and exten-

sion-lines next to your mouse-pointer.

The DIMENSION DIALOG opens.

4. Edit the DIMENSION in the

DIALOG 

Negative Dimensions? 

Do not delete the negative

sign from a negative di-

mension.

See: Why a dimension is neg-

ative .

5. Click  to close the DIMEN-

SION DIALOG 

The DIMENSION is now in the graphics-area.

How to EDIT a dimension:

1. Disable all other commands 

2. Double-click the arrowhead of a dimension-line 

Why the arrowhead?

· It is easier to click the arrowhead than the dimension-line or exten-

sion-line. 

AND

· nothing happens if you click the dimension-number

Add dimension:

* POINT, START-POINT, END-POINT, and CENTER-POINT

** LINE or CAD-LINE

Locate a Point

There are two methods to locate a POINT.

270
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METHOD 1: Add Dimensions 

Examples Dimension How? Selection-Win-

dow / Geometry-

Tree

Between 2 Points

· Minimum

distance

between

two

POINTS* 

· Click each

POINT* 

DimPtoPn

Perpendicular

Distance

· Perpen-

dicular

distance

between

a POINT*

and a

LINE**, X–

AXIS, or
Y–AXIS

· Click the POINT*

then the LINE** 

DimPtoLn

METHOD 2: Use the Point Properties dialog

This method is possible:

· ONLY with a POINT sketch-element

It is not possible with a START-POINT, CENTER-POINT, CENTER-POINT

 AND 

· NOT possible if the POINT has a dimension or constraint
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Example Dimension Selection-Win-

dow / Geo-

metry-Tree

Point Properties dialog

· LOCK AND SPE-

CIFY the exact

location of a

POINT* in a

PART.

Pointn

How?

1. Double-Click

a POINT* in

the PART-ED-

ITOR 

OR

1. Double-Click

a POINT* in

the MECHAN-

ISM-EDITOR 

The Point Prop-

erties dialog

opens - see left

Expand POINT

COORDINATES 

2. Select the
LOCK AND

SPECIFY

check-box.

3. Enter 'x' and

'y' values for

the POINT*,

with Part

Coordinates

* in this case,

ONLY a POINT

sketch-element.

Distance

543
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Example Dimension: How? Selection-Win-

dow / Geo-

metry-Tree

· Length of a

LINE** 

1. Click the LINE** Dimn

· Distance

between two

parallel LINES** 

· Distance from Y-

axis (or X-axis)

to a Vertical (or

Horizontal)

LINE**

1. Click a POINT*

at one end of

the LINE** 

2. Click the other

LINE** (or axis).

DimLtoLn

· Shortest dis-

tance between

two POINTS*

1. Click each

POINT* 

DimPtoPn

· Horizontal

Distance

between two

POINTS* 

1. Add a Vertical

LINE** from one

of the POINTS* 

2. Click the

POINT** and

then the Vertical

LINE**

· Vertical Distance

between

POINTS* 

1. Add a Hori-

zontal LINE**

from one of the

POINTS* 

2. Click the POINT*

then the Hori-

zontal LINE**

· Shortest dis-

tance between a

POINT* and a

LINE** (or axis)

1. Click the POINT*

then the LINE**

(or axis)

DimPtoLn

Radius
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Example Dimension: How? In Selection-

Window as:

· Radius of a

CIRCLE 

· Click the Circum-

ference of a

CIRCLE 

DimRadiusn

· Radius of an ARC

 

· Click the Radius

of an ARC 

DimRadiusn

Angle

Example Dimension: How? In Selection-

Window as:

· Angle between

three POINTS*

· Click the POINT*

that is the apex

of the angle, fol-

lowed by the

other two

POINTS*.

The angle is the

clockwise angle

from the second

POINT* to the third

POINT* you click.

DimAngPPPn

· Angle between

two LINES** 

· Angle between

an axis and a

LINE**

The LINES** do

not need to cross.

· Click each

LINE** 

The angle that we

display for you has

rules. 

See RULES, below

DimAngLtoLn

RULES: There are eight possible angle dimensions:

Before you click your mouse again to fix the angle dimension between

the LINES**, you can select which angle to display.

· Move your mouse counter-clockwise around the apex of the

two LINES**, to show the acute, obtuse, supplementary, or the

vertical angle <180°.

· Move your mouse clockwise around the apex of the two

LINES**, to show the reflex angles to the other angles.

Video: Double-click to watch Add an Angle


DimensionAngles-8-1280-720.gif
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1.5.6.3.2  Add Point

Add Point

1. Click Geometry toolbar > Add Point (left of graphics-area) 

 OR

1. Click Geometry menu > Point 

2. Click the graphics-area 

The POINT is now in the graphics-area.

DIFFERENT POINT SYMBOLS

 : POINT sketch-element 

 : START-POINT or END-POINT - at the end of

an ARC or a LINE

 : CENTER-POINT - at the center of an ARC or a

CIRCLE 

 : CENTER-POINT - merged with a START-POINT

or END-POINT of an ARC or LINE

 : CENTER-POINT - coincident with a START-

POINT or END-POINT

 : LOCKED-POINT - see POINT PROPERTIES DIA-

LOG  

 : MOTION-POINT - added with Add Motion-

Path FB .

 : MOTION-POINT - coincident with a POINT,

START-POINT or END-POINT.

To locate the position of a Point in a Part:

Part-Editor:

Add dimensions and/or constraints - see Add Dimension

OR

Edit the POINT, edit the x,y coordinates in the Point Properties dialog  >
LOCK AND EDIT HERE 

OR

Mechanism-Editor

Edit the POINT, edit the x,y coordinates in the Point Properties dialog  >
LOCK AND EDIT HERE 

OR

SPECIAL-CASE: Add a TRACE-POINT to a POINT, that is free from constraints

and dimensions, and Drag the Point (see Add Trace-Point ).

Example

543

191

270

545

545

122
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How: Selection-Window

· Click the graphics-area

to add the POINT.

Pointn
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1.5.6.3.3  Add Line

Add Line

1. Click Geometry toolbar > Add Line (left of graphics-area) 

 OR

1. Click Geometry menu > Line 

2. Drag in the graphics-area from the START-POINT to the END-POINT of

the LINE. 

Drag: mouse-button-down (START-POINT), move your mouse-pointer,

mouse-button-up (END-POINT).

The LINE is now in the graphics-area.

To Add Line with a free START-POINT and/or END-POINT.

Do NOT HOVER above a different POINT* before you mouse-but-

ton-down or mouse-button-up to add the LINE.

See also: How to Delete a Constraint

To Add Line with a merged START-POINT and/or END-POINT.

Do HOVER above a different POINT* before you mouse-button-

down or mouse-button-up to add the LINE.

See: Hover+Drag Video

* POINT, START-POINT, END-POINT, CENTER-POINT.

Coordinate System of a Line / CAD-Line

The Origin (0,0,0) of the Coordinate-System is the START-POINT of the LINE /

CAD-LINE

The +X–AXIS is from the START-POINT to the END-POINT of the LINE / CAD-LINE

The +Y-AXIS is at +90º from the +X-AXIS, and on the MECHANISM-PLANE.

Example

How:

· Drag from the START-

POINT to the END POINT

of the LINE 

Selection-Window:

· Linen +

· PointN at each end of

the LINE

297

291



278

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.6.3.4  Add Circle

Add Circle

1. Click Geometry toolbar > Add Circle (left of graphics-area) 

OR

1. Click Geometry menu > Circle 

2. Drag in the graphics-area from the CENTER-POINT to approximate its

radius 

Drag: mouse-button-down (CENTER-POINT), move your mouse-pointer,

mouse-button-up

The CIRCLE is now in the graphics-area.

To Add Circle with a FREE CENTER-POINT

Do NOT HOVER above a POINT* before you mouse-button-down

See also: How to Delete a Constraint

To Add Circle with a MERGED CENTER-POINT

Do HOVER above a different POINT* before you mouse-button-

down

See: Hover+Drag Video  

* POINT, START-POINT, END-POINT, CENTER-POINT.

Notes : A CIRCLE is a sketch-loop.

A CIRCLE is the most basic shape of a Follower-Profile.

Top tip : Add the dimension to define the Radius of the CIRCLE before

you add other constraints.

Example

How... Selection-Window

1. Mouse-button-down at

its CENTER-POINT... 

2. Drag to estimate the ra-

dius of the CIRCLE, and ...

3. Mouse-button-up

Circlen +

Pointn at the CENTER-

POINT

297
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1.5.6.3.5  Add CAD-Line

Add CAD-Line 

See also CAD-Line dialog

We add for you a CAD-LINE between the START-POINT and the END-POINT of each

PART you add to the model.

You can also edit a PART* to add one or more CAD-LINES to the PART in the

PART-EDITOR.

* PART and BASE-PART.

Use the CAD-LINE DIALOG to:

· Import and display a SOLIDWORKS Part

· Import and display an STL File

· Import SolidWorks Mass-Properties  

· Edit the User Mass-Properties  of the CAD-LINE

· Display a DXF-Drawing  - before you can display the DXF-Drawing,

you must File menu > Open DXF File

· Change how to display the CAD-SOLID

364

365

365

369

368

371

36
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Add CAD-Line

1. Click Geometry toolbar > Add CAD-Line (left of graphics-

area) 

 OR

1. Click Geometry menu > CAD-Line 

2. Drag in the graphics-area from the START-POINT to the END-POINT. 

Drag: mouse-button-down (START-POINT), move your mouse-pointer,

mouse-button-up (END-POINT).

The CAD-LINE is now in the graphics-area.

See CAD-Line dialog

To Add CAD-Line with a free START-POINT and/or END-POINT.

Do NOT HOVER above a different POINT* before you mouse-but-

ton-down or mouse-button-up to add the LINE.

See also: How to Delete a Constraint

To Add CAD-Line with a merged START-POINT and/or END-POINT.

Do HOVER above a different POINT* before you mouse-button-

down or mouse-button-up to add the LINE.

See: Hover+Drag Video

* POINT, START-POINT, END-POINT, CENTER-POINT.

Note :  You can open the CAD-LINE DIALOG from the:

·  PART-EDITOR, the MECHANISM-EDITOR, and, if you import a

CAD-SOLID to the CAD-LINE, the MODEL-EDITOR 

The CAD-Line in the graphics-area and Assembly-Tree

364

297

291
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CAD-Lines in an Added-Part

In the graphics-area:

MECHANISM-EDITOR : Add-Part - a CAD-Line

along the center of the Part.

PART-EDITOR : Add CAD-Line to add one or more

CAD-LINE  to a PART

CAD-LINES have a COORDINATE SYSTEM, which is

important to orientate CAD files that you import

· +X–AXIS: from its START-POINT  to its END-

POINT

· +Y–AXIS: at +90º from the +X–AXIS

· +Z-AXIS: perpendicular to the MECHANISM

PLANE (towards you in the default view

(FRONT-VIEW))

In the Assembly-Tree:

· The CAD-LINE is the only SKETCH-ELEMENTS

that show in the ASSEMBLY-TREE.

· The CAD-LINE is a child to a PART.
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1.5.6.3.6  Add Arc

Add Arc

1. Click Geometry toolbar > Add Arc 

 OR

1. Click Geometry menu > Arc 

2. Drag in the graphics-area from the START-POINT of the ARC to the

END-POINT of the ARC 

3. Drag again between the START-POINT and END-POINT to approximate

the radius of the ARC

Drag: mouse-button-down (CENTER-POINT), move your mouse-pointer,

mouse-button-up

The ARC is now in the graphics-area.

To Add Arc with a free START-POINT and/or END-POINT.

Do NOT HOVER above a different POINT* before you mouse-but-

ton-down or mouse-button-up to add the ARC.

See also: How to Delete a Constraint

To Add Arc with a merged START-POINT and/or END-POINT.

Do HOVER above a different POINT* before you mouse-button-

down or mouse-button-up to add the ARC.

See: Hover+Drag Video

* POINT, START-POINT, END-POINT, CENTER-POINT.

Top

tip : 

Add a Dimension  to define the RADIUS of the ARC before you

drag it or add other CONSTRAINTS  

Example

Example How: Selection-Window

You must Drag Two times.

Refer to the image to the

left:

1. FIRST DRAG: from the

START-POINT to the END-

POINT of the ARC, then

release you mouse. 

2. SECOND DRAG: Position

your pointer between

the START-POINT and

END-POINT of the ARC,

and Drag towards the

apex of the ARC as you

Circlen +

Pointn 

At each end of the ARC.

297
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Example How: Selection-Window

intend it to be drawn,

then release your mouse.

The ARC has a CENTER-POINT, a

START-POINT and END-POINT.

Video

Double-click to watch 'How to Add an Arc'


AddArc.gif
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1.5.6.3.7  Add Spline

Add Spline

1. Click Geometry toolbar > Add Spline 

 OR

1. Click Geometry menu > Spline 

2. Click in the graphics-area to add the first Nodes for the SPLINE 

3. Continue to click at different places* to add more nodes 

To end Add Spline:

4. Click the first node again to add a CLOSED SPLINE 

OR

Click the last node again to add an OPEN SPLINE. 

* Click a POINT (POINT, START-POINT, END-POINT, CENTER-POINT) of a dif-

ferent sketch-element to merge it with a node.

The SPLINE curve is now in the graphics-area.

Edit a Node's Position

PART-EDITOR: Add dimensions  or Constraints

OR 

PART-EDITOR: Drag the node 

OR 

MECHANISM-EDITOR or PART-EDITOR : Use the Point Properties dia-

log  

Edit the Spline's Angle at a Node

1. MECHANISM-EDITOR or PART-EDITOR : Click the SPLINE to show the

SPLINE-HANDLES 

2. MECHANISM-EDITOR or PART-EDITOR : Drag the arrowhead of a

SPLINE-HANDLE around its NODE

3. MECHANISM-EDITOR or PART-EDITOR : Click the SPLINE again to

hide the SPLINE-HANDLES 

Edit the Spline's Curvature at a Node

1. MECHANISM-EDITOR or PART-EDITOR : Click the SPLINE to show the

SPLINE-HANDLES 

2. MECHANISM-EDITOR or PART-EDITOR : Drag the arrowhead of a

SPLINE-HANDLE further from or nearer to a NODE

3. MECHANISM-EDITOR or PART-EDITOR : Click the SPLINE again to

hide the SPLINE-HANDLES

269
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Spline-Handles of an Open-Spline and

a Closed-Spline

Notes:

· The direction of the SPLINE at a NODE is

normal to its SPLINE-HANDLES

· The Radius-of Curvature of the SPLINE

at a NODE is proportional to the length

of its SPLINE-HANDLE

· The Radius-of-Curvature of the SPLINE

at a NODE is symmetrical to the two

sides of its SPLINE-HANDLE.

· You can add Constraints to Nodes, but

not the SPLINE'S curve.
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1.5.6.3.8  Add Blend-Curve

Add Blend-Curve

See also: Blend-Curve dialog

1. Click Geometry toolbar > Add Blend-Curve 

 OR

1. Click Geometry menu > Blend-Curve 

2. Drag in the graphics-area from the START-POINT to its END-POINT. 

Drag: mouse-button-down (START-POINT), move your mouse-pointer,

mouse-button-up (END-POINT).

The BLEND-CURVE is now in the graphics-area.

To Add Blend-Curve with a free START-POINT and/or END-POINT.

Do NOT HOVER above a POINT* before you mouse-button-down or

mouse-button-up.

See also: How to Delete a Constraint

To Add Blend-Curve with a merged START-POINT and/or END-POINT.

Do HOVER above a POINT* before you mouse-button-down or

mouse-button-up.

See: Hover+Drag Video

Note:

The BLEND-CURVE automatically adjusts its ANGLE, CURVATURE, and

CURVATURE-RATE to equal those of the sketch-element with which

you merge the BLEND-CURVE.

* POINT, START-POINT, END-POINT, CENTER-POINT.

Example

How: Selection-Window

Assembly-Tree

· Drag from the START-

POINT  to the END POINT

 of BLEND-CURVE 

Blend-Curven 

Pointn at each end of

the CAD-Line

The Blend-Curve is a

child to the Part. 

The default ANGLE, CURVATURE and CURVATURE RATE at the

START-POINT and END-POINT of the BLEND-CURVE are zero.

The images to the left and above are default BLEND-CURVES.

· The BLEND-CURVE in the upper image has been added by

dragging from lower-left to upper-right. 

549

297
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· The BLEND-CURVE in the image to the left has been added

by dragging from upper-left to lower-right.

· Hover+Drag from the END-POINT of a different sketch-ele-

ment to merge the START-POINT of a new BLEND-CURVE.

· The BLEND-CURVE matches the ANGLE, CURVATURE and

CURVATURE RATE with the other sketch-element.

What is a Blend-Curve?

Continuous Curvature AND Curvature

Rate

A BLEND-CURVE is a useful sketch-ele-

ment for smooth sketch-paths.

You can control these parameters at its

START-POINT AND END-POINT:

· ANGLE 

· CURVATURE 

· CURVATURE-RATE

· VELOCITY SCALING

Why use a Blend-Curve?

ARCS: Tangent Arcs are NOT Smooth

This path is NOT smooth - Tangent

ARCS (with different Radii) have

discontinuous CURVATURE.

Use a Blend-Curve to give a smooth

sketch-path. See also Smoothness .

If the Blend-Curve is to guide a MO-

TION-POINT which also guides a PART, it

is important that:

· The motion along a sketch-path

does not have discontinuities in

position, velocity, acceleration,

and jerk.

AND 

· The shape of the sketch-path

does not have discontinuities in

angle, curvature, and rate-of-

change of curvature.

Smoothness definitions

287
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Smoothness of Sketch-elements.

You are frequently concerned with the smoothness of a sketch-path. 

The smoothness at the transition between sketch-element is important when

a MOTION-POINT moves along the sketch-elements.

Angle Curvature

Curvature

Rate

Line joins a Line Can 'kink',

be the same

angle (why

two Lines?)

NA NA

Arc joins a Line Keep the

same Angle

Keep the

same

Curvature

(or Radius)

NA

Arc joins an Arc Keep the

same Angle

Keep the

same

Curvature

(or Radius)

NA

Blend-Curve joins a Line Keep the

same Angle

Keep the

same

Curvature=0

(infinite Ra-

dius)

Keep at 0

Blend-Curve joins an Arc Keep the

same Angle

Keep the

same

Curvature;

Radius

Keep at 0

Blend-Curve joins a Blend-Curve Keep the

same Angle

Keep the

same

Curvature;

Radius

Keep the

same

Curvature

Rate
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1.5.6.3.9  Add Import SOLIDWORKS Sketch FB

Import a SOLIDWORKS sketch 

To save you time, you can import a SOLIDWORKS sketch directly onto a PART. 

Limits: 

· Imports Lines and Arcs 

· Cannot import Blocks, Parabolas, Ellipses, ...

· Maximum of approximately 20 sketch-elements

· Construction and center-lines import as Lines

· Constraints do not import 

· By default, we lock the points at the ends and center of Lines, and Arcs.

To unlock the Points, see Point Properties dialog .

Note: 

If you do not have SOLIDWORKS, you can open a DXF file , link it to a CAD-

Line, and convert the DXF-Entities to LINES and ARCS.

See also : Import SW Sketch dialog

Add Import SOLIDWORKS Sketch FB

1. Click Geometry toolbar > Add Import SOLIDWORKS sketch

FB 

 OR

1. Click Geometry menu > Import SW sketch FB 

2. Click the graphics-area 

The IMPORT SOLIDWORKS SKETCH FB is now in the graphics-area.

See : Import SW Sketch dialog

545

36

555

555
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1.5.6.3.10  Merge Points

About Merge-Points

Merge-Points is a command that combines two POINTS* at the ends of differ-

ent sketch-elements into one POINT.

When do you need to Merge-Points?

· To sketch a sketch-loop for a PROFILE / EXTRUSION ( MD-SOLID ).

· To sketch a sketch-path for a MOTION-POINT ( with Add Motion-Path FB ).

· To merge the POINTS* at the ends of different Lines-of-Centers so that you

can add two or more GEAR-PAIRS as a Gear-Train.

* START-POINTS, END-POINTS, CENTER-POINTS, and/or POINTS.

Merge-Points - menu or toolbar

Merge-Points :

1. Click Geometry toolbar > Merge-Points 

 OR

1. Click Geometry menu > Merge-Points 

IF the POINTS* are not coincident:

2. Click a POINT* at the end of a sketch-element 

3. Click a POINT* at the end of a different sketch-element

IF the POINTS* are coincident, you must first delete the Coincident-Con-

straint.

1. SHIFT + Click the coincident POINTS* 

In the SELECTION-WINDOW :

2. Right-click the Coincident Constraint

3. Click Delete element in the shortcut menu 

Now: start the Add Merge-Points command, and click the POINTS*.

The two POINTS* are now one POINT.

* POINTS : START-POINT, END-POINT, CENTER-POINT

Notes:

· You CANNOT merge a POINT* with the START-POINT (origin) of the

CAD-LINE along the X-axis of a PART. 

· You CAN, however, merge a START-POINT or END-POINT of a sketch-

element if you drag to or from the START-POINT or END-POINT of

the CAD-LINE.

Merge-Points - video of Hover Technique.

Video of 'Efficient Hover Technique to Merge-Points'


PSMotion Ltd

Hover-TechniqueONLY-1280x720.mp4



292

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Merge-Points - example

Before After Select: In Selection-Win-

dow /

Geometry-Tree

Free Points Merged Points

Note: we recommend

the Hover-Technique.

Or, 

· Start the Geo-

metry menu or

toolbar >

Merge-Points

command

· Click a POINT

and then a

POINT in a dif-

ferent sketch-

element.

RESULT: 

The POINTS move

together and then

we delete one

POINT (Compare

with Coincid-

entPtoP)

PointN

306
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1.5.6.3.11  Add Transition Curve

The Transition-Curve is not available with the Trial License.

It is ONLY available with the Premium License.

About Transition-Curve

The PSMotion Transition-Curve© is used to eliminate the:

· Polygonal-Action, also referred to as Chordal-Action 

AND 

· Linear velocity discontinuity 

as a chain-link moves onto the chain-sprocket from the span between chain-

sprockets.

Polygonal-Action (Chordal Action) and Chains

4-Tooth Sprocket and Polygonal Action

The image shows a schematic of a chain wrapped around a sprocket with 4

teeth.

Radius:

In the top image, the chain is tangent with the Pitch-Circle of the Sprocket -

at a radius of 

As the sprocket rotates, the component of horizontal velocity reduces.

The minimum  the chain gets to the center of the sprocket is

.
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Therefore, as the chain moves up and down, the effective radius of the

sprocket changes to give an uneven, non-constant chain velocity.

Linear Speed (horizontal)

The linear speed of the chain is a maximum in the top image:

 

The linear speed of the chain is a minimum in the bottom image:

 

With 4 teeth, the minimum to maximum velocity changes by approximately 30%

!

Linear Velocity Variation with 4 Teeth

Linear Velocity Discontinuity

As each new chain-link engages with a sprocket tooth, the linear-accelera-

tion of the chain is discontinuous.

You can see that the slope of the velocity instantly changes as each new

tooth engages with the sprocket. 

This is an acceleration-discontinuity.

Polygonal-Action: Problems

The main problems are:

· Tension variation in the Chain

As a chain link engages with a tooth, the chain suffers a step change in ac-

celeration. Thus, there is a tension variation.

· The pitch of the chain link is not constant. 

Usually, it is recommended that you use more than 17 teeth on a standard

sprocket. Bicycle sprockets have fewer, rarely less than 11 teeth. Also, the derail-

leur compensates for the tension-variation.
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Add Transition-Curve

Toolbar : Geometry toolbar > Transition-Curve

Menu : Geometry menu > Transition-Curve

To add a Transition-Curve

1. Click Geometry toolbar > Transition-Curve 

2. Drag to add a LINE

You can see that the Transition Curve is easy to add. However, it is used with

Pulleys or Chains.

A Tutorial will show you how to apply the Transition Curve to a Long-Link

Chain.
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1.5.6.4 Constraints

Part-Editor - Geometry menu and Constraint toolbar

Use the commands in the Geometry menu or Constraints toolbar to add Con-

straints:

o to a sketch-element

o between two sketch-elements 

o between a sketch-element and the X-axis or Y-axis 

See also: How to Delete a Constraint

See also: Why cannot I add another Constraint?

See also: Geometry toolbar

Geometry menu

The Geometry menu includes the commands to add Constraints to or between

sketch-elements.

Constraints toolbar

The Constraints toolbar is to the right of the graphics-area.

Constraints toolbar

297

297

265
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How to Delete a Constraint

You cannot see Constraints in the graphics-area. 

To DELETE a Constraint:

1. SHIFT + CLICK a sketch-element or a POINT* that has a constraint you

want to delete. 

All of the Constraints that apply to the sketch-element or POINT* are

now in the SELECTION-WINDOW

In the SELECTION-WINDOW:

2. Right-click the Constraint you want to delete  

3. Click Delete element in the shortcut menu

* POINT, START-POINT, END-POINT, or CENTER-POINT

About Merge-Points and Coincident Constraint between Points

Add MERGE-POINTS moves two POINTS* together, and deletes one of the

POINTS.

Add Coincident Constraint is between two POINTS*. The command does

NOT delete one of the POINTS*. 

You CAN delete a Coincident constraint- see How to delete a constraint .

Usually, add a Coincident constraint for construction geometry.

* POINTS, START-POINTS, END-POINTS, CENTER-POINTS.

Why cannot I add a Constraint to a sketch-element?

You cannot OVER-constrain a sketch-element.

For example, a POINT* has only two degrees-of-freedom.

If you:

1. Add a Coincident constraint between a POINT* and a LINE 

You cannot:

2. Also add a  Coincident constraint between the same POINT* and the

START-POINT or END-POINT of the same LINE.

Why?

You cannot remove three degrees-of-freedom from a POINT.

You remove one degree-of-freedom from the POINT. when you do '1'. 

You attempt to remove two more degrees-of-freedom from the POINT in

'2'.

 What do I need to do?

1. Delete the Coincident constraint between the POINT* and the LINE -

see How to Delete Constraint   

2. Add the Coincident constraint between the POINT* and the START-

POINT or END-POINT of the LINE.

297
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1.5.6.4.1  Add Horizontal Constraint

Add Horizontal

There are two types of Horizontal constraint.

Two Points (HorizontalPtoP)

1. Click Constraints toolbar > Add Horizontal

(right of graphics-area) 

 OR

1. Click Geometry menu > Horizontal 

Then:

2. Click a POINT* 

3. Click a different POINT*

The two POINTS* are Horizontal with each

other - parallel with the X-axis

* POINT, START-POINT, END-POINT, or CENTER-POINT

Line (HorizontalL)

1. Click Constraints toolbar > Add Horizontal 

OR

1. Click Geometry menu > Horizontal 

Then:

2. Click a LINE** 

The LINE** is now Horizontal - parallel with

the X-axis

** LINE or CAD-LINE

Delete Horizontal 

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a POINT or LINEin the graphics-area.

If the sketch-element has a HorizontalL or HorizontalPtoP constraint, it

shows in the SELECTION-WINDOW.

2. Right-click the HorizontalL or HorizontalPtoP constraint in the SELEC-

TION-WINDOW

3. Click Delete element in the shortcut menu
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1.5.6.4.2  Add Vertical Constraint

Add Vertical

There are two types of Vertical constraint.

Two Points (VerticalPtoP)

1. Click Constraints toolbar > Add Vertical (right

of graphics-area) 

 OR

1. Click Geometry menu > Vertical 

Then:

2. Click a POINT*

3. Click a different POINT* 

The two POINTS* are now VERTICAL, and paral-

lel with the Y-AXIS

* POINT, START-POINT, END-POINT, or CENTER-POINT

Line (VerticalL)

1. Click Constraints toolbar > Add Vertical 

OR

1. Click Geometry menu > Vertical 

Then:

2. Click a LINE**

The LINE** is now VERTICAL, and parallel with

the Y-AXIS

** LINE or CAD-LINE.

Delete Vertical

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a POINT or LINE in the graphics-area.

If the sketch-element has a VerticalL or VerticalPtoP constraint, it shows in

the SELECTION-WINDOW.

2. Right-click the VerticalL or VerticalPtoP constraint in the SELECTION-WIN-

DOW

3. Click Delete element in the shortcut menu
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1.5.6.4.3  Add Tangent Constraint

Add Tangent

There are two types of Tangent constraint.

Line and Circle / Arc (TangentCtoL)

1. Click Constraints toolbar > Add Tangent (right

of graphics-area) 

 OR

1. Click Geometry menu > Tangent 

Then:

2. Click a CIRCLE or ARC 

3. Click a LINE* 

The CIRCLE/ARC is now tangent with the LINE*

or axis.

They have a TangentCtoL constraint.

* LINE, CAD-LINE, X-AXIS, or Y-AXIS

Circle/ Arc and Circle / Arc (TangentCtoC)

1. Click Constraints toolbar > Add Tangent 

OR

1. Click Geometry menu > Tangent 

Then:

2. Click a CIRCLE or ARC 

3. Click a different CIRCLE or ARC

The CIRCLES and/or ARCS are Tangent with each

other

They have a TangentCtoC constraint.

Delete Tangent

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a CIRCLE, ARC, or LINE in the graphics-area.

If the sketch-element has a TangentCtoL or TangentCtoC constraint, it shows

in the SELECTION-WINDOW.

2. Right-click the TangentCtoL or a TangentCtoC constraint in the SELEC-

TION-WINDOW

3. Click Delete element in the shortcut menu
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1.5.6.4.4  Add MidPoint Constraint

Add Mid-Point

There is one type of Mid-Point constraint.

Point and Line (MidPoint)

1. Click Constraints toolbar > Add Mid-Point

(right of graphics-area)  

OR

1. Click Geometry menu > Mid-Point 

Then:

2. Click a POINT*

3. Click a LINE**

The POINT* is at the Mid-Point of the LINE**. 

They have a MidPoint constraint.

* POINT, START-POINT, END-POINT, or CENTER-POINT

** LINE or CAD-LINE

Delete Mid-Point 

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a LINE or POINT in the graphics area

If the sketch-element has MidPoint constraint, it shows in the SELECTION-

WINDOW.

2. Right-click the MidPoint constraint in the SELECTION-WINDOW

3. Click Delete element in the shortcut menu



302

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.6.4.5  Add Perpendicular Constraint

Add Perpendicular

There is one type of Perpendicular constraint.

Line and Line (Perpendicular)

1. Click Constraints toolbar > Add Perpendicular

(right of graphics-area) 

OR

1. Click Geometry menu > Perpendicular 

Then:

2. Click a LINE* 

3. Click a different LINE* 

The two LINES are perpendicular with each

other.

They have a Perpendicular constraint.

* LINE, CAD-LINE, X-AXIS, or Y-AXIS

Delete Perpendicular 

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a LINE or POINT in the graphics area.

If the sketch-element has a Perpendicular constraint, it shows in the SELEC-

TION-WINDOW.

2. Right-click the Perpendicular constraint in the SELECTION-WINDOW.

3. Click Delete element in the shortcut menu.
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1.5.6.4.6  Add Parallel Constraint

Add Parallel

There is one type of Parallel constraint.

Line and Line (Parallel)

1. Click Constraints toolbar > Add Parallel (right

of graphics-area) 

OR

1. Click Geometry menu > Parallel 

Then:

2. Click a LINE* sketch-element

3. Click a different LINE* sketch-element

The two LINES, or a LINE and an axis, are paral-

lel with each other.

They have a Parallel constraint.

* LINE, CAD-LINE, X-axis, or Y-axis

Delete Parallel 

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a LINE or POINT in the graphics area. 

If the sketch-element has a Parallel constraint, it shows in the SELECTION-

WINDOW.

2. Right-click the Parallel constraint in the SELECTION-WINDOW.

3. Click Delete element in the shortcut menu.
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1.5.6.4.7  Add Equal Constraint

Add Equal

Line and Line (Equal)

1. Click Constraints toolbar > Add Equal (right of

graphics-area)  

OR

1. Click Geometry menu > Equal 

Then:

2. Click a LINE* 

3. Click a different LINE* 

The Lengths of the two LINES are now Equal

* LINE or CAD-LINE

Circle or Arc and Circle or Arc (Equal)

1. Click Constraints toolbar > Add Equal  

OR

1. Click Geometry menu > Add Equal 

Then:

2. Click a CIRCLE* sketch-element

3. Click a different CIRCLE* sketch-element

The Radii of the two CIRCLES* are now Equal

* CIRCLES or ARCS

Delete Equal 

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a CIRCLE, ARC, or LINE in the graphics area. 

If the sketch-element has an Equal constraint, it shows in the SELECTION-WIN-

DOW.

2. Right-click the Equal constraint in the SELECTION-WINDOW.

3. Click Delete element in the shortcut menu.



305

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.6.4.8  Add Concentric Constraint

Add Concentric

Circle or Arc and Circle or Arc (Concentric)

1. Click Constraints toolbar > Add Concentric

(right of graphics-area)  

OR

1. Click Geometry menu > Concentric 

Then:

2. Click a CIRCLE (or ARC) 

3. Click a different CIRCLE (or ARC) 

The CIRCLE and/or ARC are Concentric

Delete Concentric 

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a CIRCLE or ARC in the graphics area. 

If the sketch-element has a Concentric constraint, it shows in the SELECTION-

WINDOW.

2. Right-click the Concentric constraint in the SELECTION-WINDOW.

3. Click Delete element in the shortcut menu.
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1.5.6.4.9  Add Coincident Constraint

Add Coincident

Line and Line (CoincidentLtoL)

1. Click Constraints toolbar > Add Coincident

(right of graphics-area)

 OR

1. Click Geometry menu > Coincident 

Then:

2. Click a LINE*

3. Click a different LINE*

The LINES* are now Collinear.

* LINE, CAD-LINE, X-AXIS, or Y-AXIS

Before Coincident

LtoL

After:

CoincidentLtoL

Point and Point (CoincidentPtoP)

1. Click Constraints toolbar > Add Coincident 

OR

1. Click Geometry menu > Add Coincident 

Then:

2. Click a POINT* 

3. Click a different POINT*

The POINTS* are now Coincident.

* POINT, START-POINT, END-POINT, or CENTER-POINT

Before

CoincidentPtoP

CoincidentPtoP

Point and Line (CoincidentPtoL) ; Point and Circle (CoincidentPtoC)

1. Click Constraints toolbar > Add Coincident 

OR

1. Click Geometry menu > Add Coincident 

Then:

2. Click a POINT* 

Then:

3. Click a LINE** 

The POINT* is now Coincident with the ray of

the LINE**

OR 

After 

CoincientPtoL
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3. Click a CIRCLE or ARC 

The POINT* is now Coincident with the circum-

ference of the CIRCLE or ARC

* POINT, START-POINT, END-POINT, or CENTER-POINT

** LINE, CAD-LINE, X-AXIS, or Y-AXIS

After

CoincidentPtoC

Delete Coincident

We do no show constraints in the graphics-area. You must find the constraint

you want to delete.

1. SHIFT + Click a CIRCLE or ARC in the graphics area. 

If the sketch-element has a CoincidentPtoP,  CoincidentPtoL, or Coincid-

entPtoC constraint, it shows in the SELECTION-WINDOW.

2. Right-click the CoincidentPtoP,  CoincidentPtoL, or CoincidentPtoC con-

straint in the SELECTION-WINDOW.

3. Click Delete element in the shortcut menu.

Note: Coincident Constraints, Points, Lines, and Degrees-of-Freedom

COINCIDENT CONSTRAINT, POINTS, and DEGREES-OF-FREEDOM

A POINT* has two degrees-of-freedom. You cannot remove three degrees-

of-freedom from a POINT*.

For example:

You add a Coincident Constraint between a POINT* and a LINE** (Coin-

cidentPtoL) you remove 1 degree-of-freedom. 

Then, it is not possible to add a Coincident Constraint between the same

POINT and the START-POINT or END-POINT of the LINE** (CoincidentPtoP)

as that attempts to remove 2 more degrees-of-freedom, a total of three

degrees-of-freedom.

It is not possible to remove three(3) degrees-of-freedom from a POINT*. 

To correct the problem, you must delete the CoincidentPtoL - see How to

delete a Constraint

* POINT, START-POINT, END-POINT, or CENTER-POINT

** LINE, CAD-LINE, X-AXIS, or Y-AXIS

296
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1.5.7 3: Project Explorer

 Project-Explorer

The panel that is to the left of the graphics-area is the PROJECT-EXPLORER.

It has three sections.

SELECTION-WINDOW  

The SELECTION-WINDOW shows the list of elements that you CLICK or

SHIFT + Click in the graphics-area or ELEMENT-EXPLORER (see below).

COMMAND-MANAGER  

The COMMAND-MANAGER opens when you need to select other elements

from the model to add a new element.

It has a selection-box for each element you need to select. 

310
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You can select the elements from the graphics-area or the ELEMENT-EX-

PLORER (see below).

ELEMENT-EXPLORER  

Explore the ELEMENT-EXPLORER to see the elements that are in the MODEL-

EDITOR and MECHANISM-EDITORS.

The ELEMENT-EXPLORER has three trees. You can see two trees at a time.

You can explore one tree at a time.

In the MODEL-EDITOR and MECHANISM-EDITORS, the two trees you can see

are the:

· ASSEMBLY-TREE

· KINEMATICS-TREE  - if necessary, click Rebuild Now  to compile

the KINEMATICS-TREE

In the PART-EDITOR, the two trees are the:

· ASSEMBLY-TREE

· GEOMETRY-TREE  - if necessary, click Rebuild Now  to compile the
GEOMETRY-TREE

315
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1.5.7.1 Selection-Window

Selection-Window

The SELECTION-WINDOW is at the top of the PROJECT-EXPLORER.

The SELECTION-WINDOW shows the list of the elements that you Click or

Shift + Click in the graphics-area or select in the Element-Explorer .

Click ...

... To list elements

Elements in the Selection-Window

Selection list  (to the left)

The list of elements that you

Click with your mouse in the

graphics-area or ELEMENT-EX-

PLORER .

Owner list  (to the right)

“Mechanism”: when the ele-

ment is a child to a MECHAN-

ISM-EDITOR.

“Part”: when the element is a

child to a PART.

Shift + Click ...

... sketch-elements to list constraints added to them.

You cannot see any Constraints in the graphics-area after you add them to

sketch-elements.

You can, however, list the Constraints in the SELECTION-WINDOW.

To list the Constraints in the SELECTION-WINDOW: 

1. SHIFT + Click a sketch-element to list the sketch-element and any

Constraints that you have added to the sketch-element.

Constraints in the Selection-Window with

SHIFT+CLICK

Selection list 

The sketch-element that you

SHIFT + Click, AND 

Constraints that you have ad-

ded to the sketch-element - for

example TangentCtoL, AND 

Constraints that you have ad-

ded between sketch-elements -

for example, Perpendicular.

Owner list 

Part - the PART to which you

have added the sketch-element

or Constraint.

315
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... Profiles to list Extrusion

To list an EXTRUSION in the SELECTION-WINDOW:

SHIFT + CLICK the PROFILE to list the PROFILE and the EXTRUSION that is a

child to the PROFILE.

You can EDIT the Extusion

or DELETE the Profile

Selection list 

The PROFILE that you SHIFT +

Click

The EXTRUSION that is a child to

the PROFILE.

Owner list 

Part: the PART to which the PRO-

FILE is a child.

Shortcut menu

Shortcut menu in Selection-Window

To show the shortcut menu

1.
 
Right-click 

 
an element

Use the shortcut menu to:

· Show Element References -

see below  

· Edit element

· Delete element

· Rename element

· Show or Hide Extrusion - if

you right-click an EXTRUSION

Show Element References

Many elements need other elements to exist in the model. The other ele-

ments are Reference Elements.

For example, the Reference Elements of a:

· LINE are its START-POINT and END-POINT

· PIN-JOINT are two POINTS, which may be the START-POINT or END-

POINT of a LINE or the CENTER-POINT of a CIRCLE.

311
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Reference Elements for a Pulley

The columns in the dialog identify the element's:

References - the name of the Reference Elements. For example, PROFILE

 

Element Type - the type of element. For example, POINT

Element Owner - to which the Reference Element is a child. For ex-

ample, PART
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1.5.7.2 Command-Manager

Command-Manager

The COMMAND-MANAGER shows in the PROJECT-EXPLORER when you select

other elements to add a more complex element.

Select the other elements from the graphics-area, ASSEMBLY-TREE , and/or

the SELECTION-WINDOW .

Command-Manager example : 

Command-Manager - 

Before you select elements

Add Motion-Dimension FB

 Name of the Command and

Short Instruction

 Selection-Boxes - each Selec-

tion-Box:

 Above : the type of the ele-

ment you must select

 Left : an icon to help you

identify the type of element

 Right :   the icon when an

element is in the selection-box 

OR

 Right :  the icon when an

element is not in the selection-

box

Command-Manager -

Select elements from top to bottom

continued:

To select the elements for each selec-

tion-box:

1. Click an element of the correct

type  for the top selection-box

 

The next selection-box  is auto-

matically now is active.

2. Continue to click elements of

the correct type for each selec-

tion-box 

To complete the command:

When the bottom selection-box

has an element, the   is color-

ized.

To complete the command:

316
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1. Click   

OR

1.   Right-click in the graphics-

area (usually recommended). 

To exit or start the command again:

1. Click   to exit the com-

mand, but do not add the new

element. 

OR 

1. Click   to clear the ele-

ments from all selection-boxes.

You must select all of the ele-

ment again. 
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1.5.7.3 Element-Explorer

Element-Explorer

The ELEMENT-EXPLORER is at the bottom of the PROJECT-EXPLORER .

It shows most of the elements that are in the model.

Element-Explorer example:

Example Elements in the Assembly-Tree

ASSEMBLY-TREE

This tree is available in all editor-

types.

It is a chronological and hierarch-

ical list of the elements that you

have added to the model.

KINEMATICS-TREE

This tree is available when the

MODEL-EDITOR or any MECH-

ANISM-EDITOR is active.

When possible, it compiles the

kinematically-defined PARTS into

kinematic-chains that consist of

Motion-Parts, Dyads, Geared-

Rockers, Pulley-Rockers and sim-

ilar kinematic-elements.

GEOMETRY-TREE  (not in image)

This tree is available when the

PART-EDITOR is active.

It is a list of the constraints and

dimensions that you have added

to or between sketch-elements.

It does not list the sketch-ele-

ments.

Element-Explorer and the Graphics-

Area

If you click an element in the

ELEMENT-EXPLORER it changes

to the selected-color in the

graphics-area.

If you click an element in the

graphics-area, you also select the

element in the ELEMENT-EX-

PLORER.

308
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Open the Application-Settings dia-

log (see Edit menu ) to edit the

colors of different element-types.

See: Application-Settings dialog >

Graphics tab > Display Colors  

1.5.7.3.1  Assembly-Tree

Element-Explorer - Assembly-Tree

Names of the elements you add to the model are in the ASSEMBLY-TREE. 

Each element has an Element Icon and an Element Name.

Assembly-Tree in Explorer-Explorer

Element Hierarchy

The elements are in the order you

added the elements to the model.

The elements also have a hierarchy.

For example:

MECHANISM elements are chil-

dren to PLANE elements.

PARTS, FUNCTION-BLOCKS, JOINTS,

GEARS, BELTS, ... are children to

MECHANISM elements.

CAD-LINES, PROFILES, 3D-CAMS,

and 2D-CAMS are children to

PARTS elements.

PARTS 

To the left of each PART, an icon

identifies if the kinematic-chain to

which it is associated, is solved,

broken, or unsolved.

  Solved Part and solved kin-

ematic-chain: Mobility is zero AND

all PARTS remain joined for all posi-

tions of the machine-cycle.

  Solved but broken kin-

ematic-chain. Mobility is zero BUT

PARTS cannot remain joined at all

positions of the machine-cycle.

  Unsolved kinematic-chain.

Mobility is greater than zero(0).

Selected Elements

When you click an element  :

49

341
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· a square  shows around the

icon, and 

· the element shows in the
SELECTION-WINDOW

Shortcut menu:

Right-click an element in the

ASSEMBLY-TREE, to show a shortcut

menu . 

You can use the shortcut menu

to:

· Show Element References

· Edit Element

· Delete (element)

· Rename ... (element)

310
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1.5.7.3.2  Kinematics-Tree

Element-Explorer - Kinematics-Tree

See also: Kinematic-Symbols , and Configure-Power Source/ Change Dyad Closure

The KINEMATICS-TREE is the kinematic-structure of each kinematic-chain in

the active MECHANISM-EDITOR.

Note: 

If you cannot explore the elements KINEMATICS-TREE , click Rebuild now .

We compile for you the KINEMATIC-TREE from the Kinematic and Machine

elements that you add to your model.

If you click on any kinematic-chain, and then move your mouse to the graph-

ics-area, the kinematic-chain show as the selected elements in the graphics-

area.

You can right-click on any kinematic-chain to Configure the Power Source

 This icon is at the top of the KINEMATIC-TREE to the left of the name

“Mechanisms”.

Note: If you cannot see “Mechanisms”, or explore the KINEMATICS-TREE,

click Rebuild now .

The structure of the Kinematics-Tree is:

Ö Mechanisms:

Ö Kinematic-Chains

Ö Kinematic Sub-assemblies

Ö Kinematic Elements

ÖUnsolved Mechs

 Kinematic-Chain 

The MOBILITY of these kinematic-chains is zero(0). They are kinematic-

ally-defined (solved).

You can explore the kinematic-chains to find Kinematic Sub-Assemblies

and kinematic elements (see below) 

 Unsolved Mechs 

These kinematic-chains have a mobility that is greater than zero(0). The

kinematic-chains are not kinematically-defined.

319 323
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Example: Kinematics-Tree in

Element-Explorer

KINEMATIC-SUB-ASSEMBLIES (Solved

Mechanisms ONLY):

These are compiled as:

1. Motion-Parts 

a. Rockers

b. Sliders

2. Dyads

The type of Dyad is identified by its

three joints, denoted with a letter:

R = Revolute-Joint = PIN-JOINT

P = Prismatic-Joint = SLIDE-JOINT

S = Spherical-Joint = BALL-JOINT

a.  R-R-R 

b.  R-R-P

c.  R-P-R

d.  P-R-P

e.  R-P-P

f.  Ram-R

g.  Ram-P

h.  S-S-R

i.  S-S-P

4. Geared-Rockers 

5. Rack-Pinion / Pinion-Rack

6. Geared-Pulley

1.5.7.3.2.1  Kinematic-Symbols

Kinematics-Tree Structure and Symbols

 Symbol at top of KINEMATICS-TREE

TOP-LEVEL

Symbol State Mobility

Kinematic-Chain

(Solved Mech)
M = 0

The

kin-

emati

c-

chain: 

 - is

solve

d

 - is

kin-

emat-
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ically-

define

d

Unsolved Mechs M > 0 

The

kin-

emati

c-

chain :

 - is

not

fully

define

d

 -

can-

not

solve

its

kin-

emati

c-data

SUB-ASSEMBLY LEVEL

Kinematic Sub-Assemblies

· Motion-Parts (Rockers, Sliders)

· Geared-Rockers

· Dyads

· Pulley-Rockers

· Rack-Pinions

Sub-assembly Symbols:

 : the kinematic-chain solves for the complete machine-cycle.

 : the kinematic-chain is solved now, but not for the complete ma-

chine-cycle.

 : the kinematic-chain is not solved now, at this machine-angle.

Example. 

3 Kinematic-Chains

Explored Kinematic-Chain with three

sub-assemblies: 

· Rocker, 

· R-P-R Dyad

· Geared-Rocker
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EXAMPLE 1 : A Dyad that never Breaks

...

The Symbol is  : 

The Dyad is solved for a machine-cycle

(0-360 of the Master Machine Angle).

EXAMPLE 2 : A Dyad that Breaks ...

The Symbol is  : 

The Dyad is solved now, but it does not

solve for ALL positions of the machine-

cycle (0-360 of the Master Machine

Angle).

EXAMPLE 3 : -The Dyad is broken

The Symbol is  : 

The Dyad is not solved at this position

of the machine-cycle (0-360 of the

Master Machine Angle).

ELEMENT LEVEL

You can explore the fundamental kinematic elements of each kinematic-

chain.

At this level you can see:

· Parts

· Joints

· Motion-Dimensions

· Gear-Pairs

· Pulley-Joints

The symbol, , also shows next to the elements in each sub-assembly.

Example 1 : A Dyad that does not Break

The symbol is  to show the Dyad is solved

for a machine-cycle.

The symbol  is next to each element in the

dyad to show they are solved for a machine-

cycle.
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Example 2 : A Dyad that does Break

The symbol is  to show the dyad does not

solve for a period in the machine-cycle.

The symbol  also shows next to the ele-

ments in the dyad that do not solve for a

period in the machine-cycle.

Example 2 : A Dyad that is Broken...

The symbol is  to show the joints in the

dyad do not solve at this instant in the ma-

chine-cycle.

The symbol  also shows next to the ele-

ments in the dyad that do not solve at this in-

stant in the machine-cycle.

A typical Kinematics-Tree

This KINEMATICS-TREE has four(4)

Kinematic Defined Chains, identified by

the  icon. 

A Rocker is expanded to show three

elements:

· PIN-JOINT, PART, MOT-DIM

ROCKER 

The R-R-R Dyads is expanded to show

it is assembled from:

· Three(3) PIN-JOINTS , two(2)

PARTS 

Dyad and Joint Symbols: 

 This symbol is to the left of a

Dyad and Joint when it solves for

the machine-cycle.

 This symbol is to the left of a

Dyad and Joint if a Joint does not

solve for period of the machine-

cycle.

 This symbol is to the left of a

Dyad and Joint if a Joint does not

solve at this instant of the machine-

cycle.
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1.5.7.3.2.2  Configure Power Source / Change-Dyad-Closure

Kinematics-Tree - shortcut menu

Configure Power Source

See also : Forces toolbar > Configure Power Source

To open the Configure Power-Source dialog:

1. Click a kinematic-chain so that a Red or Orange square encloses the

icon 

2. Right-click to show 'CONFIGURE POWER SOURCE' 

3. Click the 'CONFIGURE POWER SOURCE' text to open the dialog. 

Change Dyad Closure

See also : Kinematic elements toolbar > Change Dyad Closure  - it is more

convenient and easier to use.

To change the closure of a dyad from the KINEMATICS-TREE:

1. Click the Dyad so that a Red or Orange square encloses its icon 

2. Right-click the icon to show Change Dyad Closure next to you

mouse-pointer

3. Click the Change Dyad Closure text to change the closure of the

Dyad

The SELECT ELEMENTS DIALOG shows - you must select a PART.

4. Click a PART in the SELECT-ELEMENTS DIALOG 

5. Close  to close the SELECT-ELEMENTS DIALOG 

6. Click  in the COMMAND-MANGER to change the closure of the Dyad 

232
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1.5.7.3.3  Geometry-Tree

Element-Explorer - Geometry-Tree

Note: If you cannot explore the GEOMETRY-TREE, click Edit menu > Rebuild

now .

The GEOMETRY-TREE replaces the KINEMATICS-TREE when you start the PART-

EDITOR.

Example Geometry-Tree

Example: Geometry in

Element-Explorer

What is a Constraint-Loop?

A Constraint-Loop (labeled Con-

straints) is a list of the constraints that

are between a set of sketch-elements. 

If you add a Constraint between sketch-

elements that are in different Con-

straint-Loops, they combine to give one

Constraint-Loop.

For example:

· Add Horizontal Constraint to

Line1 = Constraint Loop #1

· Add Horizontal Constraint to

Line2 = Constraint Loop #2

· Add a Horizontal Constraint

between a Point in Line 1 and a

Point in Line 2 =  1 × Constraint

Loop

Constraints and the Selection-Window

If you:

· Click a LINE :

the LINE shows in the SELECTION-

WINDOW

· SHIFT + Click a LINE :

the LINE AND any CONSTRAINTS

that have been added to the LINE

show in the SELECTION-WINDOW.

50
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1.5.8 4: Feedback Area

 Feedback-Area

The FEEDBACK-AREA is below the graphics-area.

It has five areas.

 Extended Hints AND Element Properties 

Extended Hints:

When you move your mouse above a command in a toolbar, or many of

the Function-Blocks in the graphics-area, a tool-tip shows in the EXTEN-

DED HINTS box .

Element-Properties:

When you move your mouse above an element in the graphics-area, it

shows the element's kinematic-properties and/or kinetostatic-properties.

Notes:

You do not need to enable HINTS AND TOOL-TIPS to see the Extended Hints.

To see all of the Extended Hint and/or Element-Properties, you may need

to drag the separator-bars  upwards and/or to the right a short distance.

 Messages

The most recent message is at the top of the list. 

Message information:

Count : The message number.

Topic : Importance Level:  – Information;   –

Warning;   – Error - save your work now! 

Message : The message that you should read!

Time : When the message was displayed.

To clear the messages:

1. Right-Click, with your mouse-pointer in the Messages area 

2. Click Clear Messages in the shortcut menu

Message sounds:

If you enable sounds (Application Options | Accessibility tab ), you

hear a honk with each new message.

347
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 Master-Machine-Angle (MMA): Scale, Digital Angle Indicator, and

Revs

MASTER-MACHINE-ANGLE (MMA):

The value of the MMA is the independent input to all kinematic-chains in

your model. 

The MMA increases at a constant-rate from 0 to 360, again and again,

when you cycle/run the model - see the Run menu .  One machine-cycle

is one cycle of the MMA, from 0 to 360.

You can read and edit the MMA in two ways:

ARROWHEAD + MMA SCALE - Read / “Write” (Drag)

APPROXIMATE Master Machine Angle.  

The orange triangle ( ) below the scale indicates, approximately,

the MMA on the scale.

To edit the MMA approximately:

Mouse-button-down and move you mouse to the left or right, with

your mouse-pointer INSIDE the Master Machine Angle Slider to

change the machine angle.

The orange triangle ( ) below the scale moves with your

mouse-pointer. 

DIGITAL MMA INDICATOR  - Read / Write

EXACT Master Machine Angle

The value in the DIGITAL MMA INDICATOR box is the exact MMA.

To edit the MMA exactly:

To an exact MMA angle:
Enter a value for the MMA, from 0

to 360.

To Inch 

Click the Spin-Box one time to in-

crease or decrease the MMA by one

Spin-Increment.

To Jog 

Press and Hold the Spin-Box to

continuously increase or decrease

the MMA.

REVS - Read only

Number of machine-cycles since you reset the model to zero with Run

menu > Home

 Vector Scale buttons

58

58



328

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Click the up / down arrow buttons to increase or decrease the length of the

VELOCITY, ACCELERATION, FORCE, and TORQUE vectors that you can show

in the graphics-area.

Velocity (V)  and Acceleration (A)  Vector buttons

Click the up /down arrow-buttons to the right of: 

· V -  - to increase or decrease the length of Velocity vectors

· A -  - to increase or decrease the length of Acceleration vec-

tors

See Point Properties dialog  to show the Velocity Vector and Accelera-

tion Vector of a moving POINT.

Force (F)  and Torque ( )  Vector buttons

Click the up /down arrow-buttons to the right of: 

· F  -  -  to increase or decrease the length of Force vectors

·  -  -  to increase or decrease the length of Torque vectors

See Force-Vectors: Calculate  and Force-Vectors: Display  to show

Force vectors and Torque/Moment vectors.

See Configure Power Source  to make sure the Power flows through the

model correctly.

 Animation-Speed Slider

Use the ANIMATION SPEED SLIDER to speed-up or slow-down the Anima-

tion Speed of the model.

Mouse-button-down and move you mouse to the left or right, with your

mouse-pointer INSIDE the Animation-Speed Slider to change the an-

imation speed.

The Animation-Speed does not change the kinematic or force analysis, or

motion synchronization between kinematic-chains.

To edit the Simulation Speed or machine-speed: see Edit menu > Machine-Set-

tings  >  CYCLING PARAMETERS.

See also: Run >Cycle

543
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1.5.9 5: MotionDesigner

 MotionDesigner

Use MotionDesigner to add and design motions for Motion-Parts and Motion-

Points. Each motion you add has a Motion name-tab.

Use a MOTION FB to link a motion from MotionDesigner to a Motion-Part or

Motion-Point that is in your model in MechDesigner.

To Link a Motion to a Motion-Part

STEP 1: Add a Motion FB to the graphics-area 

1. Click Function-Block menu  > Motion FB 

2. Click in the graphics-area

The MOTION FB is now in the graphics-area and ASSEMBLY-TREE.

STEP 2: Open the Motion FB dialog 

1. Double-click the MOTION FB in the graphics-area or ASSEMBLY-TREE 

OR

1. See How to Open a dialog   

The MOTION FB DIALOG is now open. 

STEP 3: Edit the Parameters

MOTION PARAMETERS 

SELECT MOTION

Select a Motion from the list of

Motion names in the SELECT

MOTION drop-down list box.

Now, the Motion name has a

link with the MOTION FB.

AFTER EACH MOTION CYCLE

· RESET OUTPUT : Default (use

in most cases)

· ACCUMULATE OUTPUT :

Select when the motion is a

progressive motion - for ex-

ample, the motion is index-

ing.

See more details : Motion FB dia-

log

OUTPUT DATA-TYPE

· MOTION : Default (use in

most cases)

165

627

464
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· LINEAR or ROTARY : Select

one if you connect the MO-

TION FB to a MOTION-PATH

FB or a MATH FB.

PATTERN FB

Not normally used.

QUERY

Enter a Y-axis value to find the

X-axis value(s) for the motion

you select in SELECT MOTION.

STEP 4: Click  to close the Motion FB dialog

STEP 5: Connect wires to the input-connector and from the output-con-

nector of the Motion FB

1. Connect a wire to the input-connector of the MOTION FB 

Usually, (but not always), connect a wire from the output of a LIN-

EAR-MOTION FB or a GEARING FB to the input-connector of the MO-

TION FB.

When you cycle the model, motion-data at the input-connector con-

trols the X-axis value for the Motion you select in STEP 3 and SELECT

MOTION, above.

2. Connect a wire from the output-connector of the MOTION FB

Usually (not always), connect a wire from the MOTION FB to the input

of a MOTION-DIMENSION FB or a MOTION-PATH FB.

When you cycle the model, the motion-data at the output-connector

is the Y-axis value, that corresponds to the X-axis value at its input-

connector, for the Motion you select in STEP 3, and SELECT MOTION,

above.
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1.5.10 6: Memo Interface

 Memo Interface

The Memo is a Windows-style NotePad® interface that opens automatically

when you start MechDesigner.

The MODEL-EDITOR and each MECHANISM-EDITOR can have its own Memo. We

save the Memos for you with the model file.

To open the Memo Interface at another time:

1. Right-click the MODEL NAME-TAB or any MECHANISM NAME-TAB 

2. Click Open Memo in the shortcut menu.

If you do not want the Memo to open automatically:

1. Clear the Automatically Open on Start check-box, at the bottom of the

interface . 

Memo dialog
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1.5.11 Dialogs

Dialogs

We use dialogs to edit those elements that have parameters to modify its proper-

ties.

After you add an element, you can open its dialog immediately or at any time

later. 

Therefore, the steps to build a model are typically:

STEP 1: Add an ELEMENT - see Model Editor  ; Mechan-

ism Editor  ; Part-Editor

STEP 2: Open the ELEMENT'S DIALOG - see How to open a dialog

STEP 3: Edit the ELEMENT'S PARAMETERS - see How to edit a Parameter in

a dialog

STEP 4: Close the ELEMENTS'S DIALOG Close the dialog before you

start a different command to

add a new ELEMENT.

Do Steps 1 to 4, again, and again, ... .

Two exceptions: Add Dimension and Add Plane. Their dialogs open imme-

diately.

Dialogs

Element or Dialog

name

Dialog Function & Main Parameters

General Purpose Dialogs

RENAME Replace an “Old Element Name” with a “New Element

Name”

MODEL OPTIONS / MECH-

ANISM OPTIONS  
Lighting,  Synchronize CAD-SOLIDS

APPLICATION SETTINGS Working Environment, Number-Format, Auto-Profiles, Ac-

cessibility, Element Colors, ...

MACHINE SETTINGS  Machine Speed, # Steps in Machine-Cycle, Engineering Un-

its

ELEMENT PROPERTIES Read-only - an element's properties at the Machine Angle,

e.g Position, Velocity, Acceleration, Angle, Coordinates,

MODEL-EDITOR

ADD OR EDIT PLANE Edit X,Y,Z ANGLE OF PLANE or OFFSET OF PLANE

PROFILE / EXTRUSION Edit the EXTRUSION - an MD-SOLID

CAD: DXF, SOLIDWORKS

DXF-ELEMENT Select a different DXF Drawing File, change the Units of the

DXF Drawing

CAD-LINE

> DXF Import DXF File, Convert Entities to MD Sketch-Elements.

79

88 257

627

631

335

337

341

351

609

356

360

354

364

371
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>> DXF LAYERS

> SOLIDWORKS  >  Import SOLIDWORKS file-type - a CAD-SOLID

> MASS PROPERTIES  > User Mass-Properties, SOLIDWORKS Mass-Properties,

Total Mass Properties.

> STL IMPORT  > Import an STL file - a CAD-SOLID

> DISPLAY OPTIONS  > Edit the Color, Transparency, ...

CAMS: 2D and 3D

2D-CAM 2D-Cam:

>> PARAMETERS  >> Edit the Start-Angle and Range (defaults are 0 and 360),

Enable Lifetime, Edit Life Safety-Factor. 

>> DISPLAY  >> Display Cam as: Cam-Profile, Pressure-Angle, Contact-

Force, Shear-Stress. Edit Color, Line thickness.

>> ROLLER LIFE  >> Select Roller bearing, factors for ISO 281 calculations

(Lubricant Viscosity, Temperature, Contamination and Reli-

ability)

>> CAM LIFE  >> Select Steel type, quality, heat-treatment, hardness -

Read Life in Cycles, Hours, Years (Stress)

CONJUGATE CAM FB Required for Force Analysis, Cam-Life, Roller-Life with Con-

jugate-Cams and Groove-Cams.

CAM-DATA FB Plot Contact-Force, Hertzian Shear-Stress, Radius-of-

Curvature, Pressure-Angle, or Sliding-Velocity

CAM-COORDINATES Calculate and Export 2D-Cam Coordinates, Save as STEP,

TXT, DXF, SLDCRV

3D-CAM Calculate and Export 3D-Cams - Barrel, Cylindrical,

Globoidal. Save as STEP, TXT, SLDCRV

FUNCTION-BLOCKS

LINEAR-MOTION FB Output is 0 - 360, again and again - a machine clock.

GEARING FB Modify motion-values with a Linear function.

MOTION FB  Link a Motion in MotionDesigner to a Motion-Part.

MOTION-DIMENSION FB Edit the BASE-VALUE (angle or position) of a Motion-Part.

MOTION-PATH FB Edit the starting position of a Motion-Point, Control the

length of a sketch-loop

POINT-DATA FB Measure a Point's Position, Velocity, and Acceleration relat-

ive to the Mechanism-Plane.

MEASUREMENT FB Measure Linear or Angular Position, Velocity, and Accelera-

tion.

GRAPH FB Plot up to 4 graphs as a function of one X-axis 

> GRAPH SETTINGS > Graph Display

SPRING FB Define a force-function for a Spring

FORCE-DATA FB Measure Force or Torque

CAD CONTROL FB Control SOLIDWORKS mates from MechDesigner

MAGNETIC-JOINT Glue Profiles/Curves together

MATH FB User defined functions

376

365

367

376

381

401

403

407

411

428

436

440

446

384

458

459

462

466

469

197

193

477

480

538

541

486

560

509
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STATISTICS FB Statistical values for motion-values or force-values

POLYNOMIAL FIT FB Fit Polynomials to data at its input-connector, save as Poly

Coefficients, or export directly to MotionDesigner.

PARAMETER-CONTROL

FB

Control the length of a 'static-dimension', Extrusion-Depth,

Extrusion Offset with motion-values at its input-connector.

CONTINUOUS CRANK FB Make a Crank rotate fully with a modulated speed, as a

function of the motion of a different part in the kinematic-

chain.

MODELING TOOLS

DESIGN-SET Add different dimensions and parameters to one dialog

BRIEFCASE FB Put other FBs in a Briefcase - to make you model easier to

review

MAKE MOVIE Produce a GIF file, or a series of PNG, JPG, of BMP images

for a machine-cycle.

POINT-CLOUD Import XY data, convert to a smooth curve feature.

PATTERN Copy CAD-SOLIDS and/or MD-SOLIDS multiple times and

phase-shift in space and time.

OTHER DIALOGS

POINT PROPERTIES Read / Write the Position of a POINT. Display its Velocity

and/or Acceleration Vectors.

BLEND-CURVE Edit the Angle, Curvature, and Curvature-Rate at the START-

POINT and END-POINT of a BLEND-CURVE

BALL-JOINT  3D Joint for Spatial Mechanisms. Edit its offset from the

Mechanism-Plane.

GEAR-PAIR Edit the module, number-of-teeth, mesh, ...

RACK-PINION  / BALL-

SCREW
Edit the module, number-of-teeth, ...

PULLEY Number-of-Teeth on the Pulley

KINETOSTATIC: SERVOMO-

TOR AND GEARBOX SIZ-

ING

Size a Gearbox and Servomotor for the Application.

CONFIGURE POWER

SOURCE

To move a motor or other power source to the correct joint

or cam.

DIMENSION Edit an Angular or Linear Dimensional Value.

MISCELLANEOUS

TUTORIAL VIDEOS Play Tutorial Video

EXAMPLE MODELS Help menu

SELECT ELEMENTS Choose one or more elements from a list of elements

DEPENDENT ELEMENTS Show those elements that you also delete 

VIEW REFERENCES Elements that are referenced by another elements

488

491

497

535

528

518

605

521

500

543

549

559

566

577

581

592

589

547

620

616

617

618
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1.5.11.1 Dialog: Rename Element

Rename

You can rename all elements. 

If you rename an element, you must use the element-icon to identify the ele-

ment-type. In the SELECTION-WINDOW and ASSEMBLY-TREE, the element-icon is

to the left of the element-name.

To Rename an element:

There are three(3) methods to rename an element:

METHOD 1: Rename Element dialog

Use this method if you can select the element in the graphics-area or the

ELEMENT-EXPLORER.

Selection-Window: shortcut menu

STEP 1: Open the Rename Element

dialog:

1. Click the element in the graph-

ics-area or the ASSEMBLY-TREE. 

The element is now in the SELEC-

TION-WINDOW.

In the SELECTION-WINDOW:

2. Right-click the element that

you want to rename

3. Click Rename element in the

shortcut menu

The RENAME ELEMENT DIALOG is now

open.

STEP 2: Enter a “New Name” to re-

place the “Old Name”:

The Old Name is Line10 

1. Enter a New Name 

The New Name is CRANK-

LENGTH

2. Click  to close the RENAME

ELEMENT DIALOG.

Rename dialog

METHOD 2: Rename the element in its dialog
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Rename element:

An open dialog

Use this method when a dialog is

open:

1. Double-click the element-

name at the top of the dialog

< see image 

2. Enter a new element-name E.g.

Coupler-A

3. Press the Enter key ( ) on

your keyboard.

Unfortunately, not all element-types

have a dialog with which to rename the

element.

METHOD 3: Rename the element in the Element-Explorer

Rename element:

From the Assembly-Tree

Do the Windows® method:

1. Click, pause, and click again the

element-name in the ELEMENT-

EXPLORER or the SELECTION-

WINDOW 

2. Enter a new element-name 

3. Press the Enter key ( ) on

your keyboard

Unfortunately, not all element-types

show in the ASSEMBLY-TREE or SELEC-

TION-WINDOW.
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1.5.11.2 Dialog: Model / Mechanism Options

Model / Mechanism Options

See known bugs - 16.1.268

Use the MODEL-OPTIONS DIALOG to confirm the file-name and path of CAD-

SOLIDS that you have imported onto CAD-LINES - see Synchronize CAD-Files

tab

Also, use the MODEL-OPTIONS DIALOG to change the lighting of the graphics-

area - see Lighting tab

Terminology:

CAD-SOLID : A CAD model that you have imported onto a CAD-LINE -

see CAD-Line dialog

How to open the Model Options dialog

1. Double-click the Model or Mechanism element in the ASSEMBLY-TREE 

OR

1. Right-click the MODEL or MECHANISM element at the top of the

ASSEMBLY-TREE 

2. Click Edit element in the shortcut menu

The MODEL OPTIONS DIALOG is now open.

Model Options dialog.

Model Options dialog

There are two tabs. 

Synchronize CAD Files

There is a list of the CAD-SOLIDS that you have imported onto CAD-LINES with

the CAD-Line dialog .

28

337

339

364

364
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Background

CAD-SOLID: the term for a 3D CAD model that you have imported onto

a CAD-LINE.

You can import CAD-SOLIDS:

· directly from SOLIDWORKS (see CAD-Line dialog >

SOLIDWORKS tab ), or 

· as an STL file (see CAD-Line dialog > STL Import tab ).

CAD files you save to disc have a time-stamp.

When you open the Model Option dialog, we compare for you: 

· The Time-stamp at the time you linked it to the CAD-LINE 

· The Time-stamp of the CAD file that is on disc.

CAD models:

If you have imported a CAD-SOLID onto a CAD-LINE, we list for you:

Element-Name

The CAD-LINE , with a status icon:

 - the CAD file on your hard-drive is newer than SOLIDWORKS

document on the CAD-LINE.

 - the CAD file is not on your hard-drive in the place expected

 - the time-stamp is the same as that of the CAD file on your

hard-drive.

SOLIDWORKS CAD File name

The CAD file is either:

  - Not found on your hard drive 

 
 - Found on your hard drive

STL File name

The STL file that has a link to the CAD-LINE.

We check for you that the STL file is in the path, as expected.

Model Option dialog

365

376
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Control Buttons:

Use the control buttons to re-import or find SOLIDWORKS files if they are not

up-to-date.

Synch. all files 

1. Click Synch. all files button to check you have the most up-to-

date SOLIDWORKS files. 

The files import again, if needed.

Synchronize Selected Files 

In the Element Name list:

1. CTRL + Click each of the CAD-LINE that you want to make sure

has the latest CAD-SOLID 

2. Click Synch. Selected Files 

We re-import for you the files on each CAD-Line you select.

Find Selected File 

1. Click a CAD-LINE in the list 

2. Click Find Selected File... button

3. Browse to find a file that MechDesigner cannot find.

Lighting

GROUP LIGHTS EDITOR 

Model Options > Lighting tab

The sliders control those AFFECTED LIGHTS that have a check in the

check-box

1. Click each AFFECTED LIGHT check-box to make lights active. 

2. Use the sliders to change their: 

· AMBIENT, DIFFUSE, and SPECULAR LIGHT Levels

2. Move your mouse-pointer over the graphics-area to update the

lighting 

Note: 



340

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

It is frequently better to decrease Ambient Light Levels, and increase Dif-

fuse and Specular Light Levels to view MD-SOLIDS and CAD-SOLIDS.

 INDIVIDUAL LIGHT EDITOR 

To turn on or off each light and to control its source point:

1. Use the drop-down box to select a light (Light 1 to 6) 

2. Click the check-box to turn the light that is in the drop-down list on

or off.

3. Enter numbers into the X, Y, Z and W Position boxes to change the

direction of the light in the drop-down box.

· ±X, ±Y ±Z directions for each light

· W - not sure how this works!

4. Move your mouse-pointer over the graphics-area to update the

lighting 

An External link to Light : Good Luck!

http://www.glprogramming.com/red/chapter05.html#name2
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1.5.11.3 Dialog: Application-Settings

Application-Settings

Use Application-Settings to edit the working environment.

See also: Application-Settings, Themes, Styles, and the Save and Load buttons

How to open the Application-Settings dialog

Click Edit toolbar > Application-Settings 

OR

Click Edit menu > Application-Settings 

The APPLICATION SETTINGS DIALOG is now open.

Application-Settings dialog:

Application Settings dialog

General

624
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 FILE OPTIONS  See also: ZXL file-type.

EXTRACT ZXL FILES TO: 

¤ SUB-DIRECTORY OF ZXL FILE: Auto-

matically, we add for you a sub-

directory to that of the ZXL file in

which to extract files that are in

the ZXL file.

¤ SPECIFY DIRECTORY: You specify a

path in which to extract files that

are in the ZXL file.

þ  ENABLE AUTO-SAVE:

Enable to automatically save the act-

ive model, after # COMMANDS TO

AUTO-SAVE,  AND overwrite the act-

ive model in RAM.

Note: also, to enable Auto-Save, save

a new model with a file-name.

MAXIMUM # OF BACKUP FILES 

When you ENABLE AUTO-SAVE: 

The total number of backups.

The names of backup files are: CXL.1,

MTD.1 ; CXL.2, MTD.2 ; ... CXL.#,

MTD.# ; ...

See: Why so many file-names?

# COMMANDS TO AUTO-SAVE

When you ENABLE AUTO-SAVE: 

The number of commands between

each Auto-Save. We:

1. Rename file-name. CXL and file-

name.MTD to file-name.~CXL

and file-name.~MTD 

2. Save file-name. CXL and file-

name.MTD to RAM.

USER LIBRARY DIRECTORY - click the

box to specify the path for your USER

LIBRARY DIRECTORY 

ALLOW INTERNET DOWNLOADS : En-

able to allow downloads.

 THEME OPTIONS 

638
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ACTIVE THEME: After you select a TAR-

GET THEME, the box shows the Theme. 

TARGET THEME: Select from:

· CHARCOAL DARK STYLE, WINDOWS,

AQUA LIGHT SLATE, WINDOWS10

DARK, TABLET DARK, SLATE CLAS-

SICO, WINDOWS 10 SLATE GRAY,

and WINDOWS 10.

Note: In this help documentation, the

Theme is CHARCOAL DARK SLATE.

 CAD LINEAR UNITS 

IMPORTED DXF FILES: UNITS

We use these units to scale the DXF-

Drawing.

The scale is 1:1 when the units are

equal to those of the original DXF-

Drawing that you import.

See also: Open DXF File, Edit DXF-Ele-

ment

 CAM ROC WARNING  

If | Radius of the Cam-Profile | < % ×

Radius of Follower-Roller 

· The Cam-Profile is more likely to

be Undercut

· The Cam-Profile is red in the

graphics-area

It is a WARNING ONLY - a soft-limit.

Number Format

354
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Note: Precision of calculations do not

change if you edit these parameters.

 DATA OUTPUT FORMAT 

Data-format of data you can calculate

and save to your hard disk. E.g. Data

from a GRAPH FB or a CAM-COORDIN-

ATES FB.

FLOAT NUMBER FORMAT: See  In-

ternet Link here about number

formats

PRECISION and DIGITS - see below

LIST SEPARATOR (READ-ONLY) - the

regional character that separates

values.

For example, “,” in a CSV file.

DECIMAL SEPARATOR (READ-ONLY) -

the character that separates the in-

teger and fractional parts of a num-

ber.

For example, “.” in 12.3456

List Separator Options:

Select the separate you want to use

for data in a file that you save to

your hard disk.

 DIMENSION FORMAT 

þ  SHOW DIMENSION NAMES 

Top-tip: Rename the DIMENSION if you

add the DIMENSION to a DESIGN-SET  -

see Rename element  

Data-format of dimensions, in the

graphics-area:

· PRECISION and DIGITS - see be-

low

· DIMENSION FONT SIZE  - experi-

ment (typically 14)

· DIMENSION FONT SIZE - the Win-

dows font picker opens. Experi-

ment with the font.

Notes: 

528

335

http://docwiki.embarcadero.com/Libraries/XE4/en/System.SysUtils.TFloatFormat
http://docwiki.embarcadero.com/Libraries/XE4/en/System.SysUtils.TFloatFormat
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PRECISION: The total number-of 'useful'

digits in the real number before and

after the decimal mark.

DIGITS: The number-of-digits after the

decimal separator.

Usually, set : PRECISION DIGITS +3, .

However, it depends on your model re-

quirements.

LIST SEPARATOR OPTIONS - read-only

PRECISION AND DIGITS

Example

~ 1234.56789

DIGITS

2 4 6 8

PRECISION

2 1.2E03 1.2E0003 1.2E3 1.2E3

4 1,235.00 1,234.0000 1,234.000000 1,235.00000000

6 1,234.57 1,234.5700 1,234.570000 1,234.57000000

8 1,234.57 1,234.5679 1,234.567900 1,234.56790000

Graphics tab



346

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

 DISPLAY COLORS 

Edit the color of the symbols in the

graphics-area.

Standard colors: 

· Part Not Solved (equivalent

term is : not kinematically-

defined) is blue 

· Part Solved ( equivalent term

is: kinematically-defined) is a

green

XY-axes in the MECHANISM-EDITOR

and PART-EDITOR are:

· Orange: X–axis

· Green: Y–axis

XYZ-axes (RGB) at the Origin in

MODEL-EDITOR:

· Red: X–axis, 

· Green: Y–axis, 

· Blue: Z-Axis

DISPLAY OPTIONS 

There are two sliders 

<< LOW (SKETCH QUALITY) HIGH

>>

Slide the handle to the left to de-

crease, and to the right to in-

crease, the number of facets

around the CIRCLE and ARC sketch-

elements. 

<< LOW (EXTRUSION QUALITY)

HIGH >>

Slide the handle to the left to de-

crease, and to the right to in-

crease, the number of facets

around EXTRUSIONS 

þ SHOW FUNCTION-BLOCK

NAMES (see images left)

Enable to show the names of each

FUNCTION-BLOCKS above the FB in

the graphics-area.
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This is more helpful if you rename

FUNCTION-BLOCK - see Rename ele-

ment

þ ENABLE ANTI-ALIASING*

Enable to remove the jagged

edges from the symbols of ele-

ments in the graphics-area.

LINE-WIDTH

Edit the LINE-WIDTH to increase or

decrease the thickness of sketch-

elements.

* I find ANTI-ALIASING is good for

LINES, bad for ARCS, CIRCLES, and very

bad for GEARS. I do not ENABLE ANTI-

ALIASING.

Do not display Function-Block names

Display Function-Block names

Rename and Display Function-Blocks

Accessibility tab

335
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MENUS 

TEXT SIZE

Text size in menus and dialogs. 

Large - too big ? ; Medium - re-

commended ; Small - OK?

Each is relative to the ICON SIZE (see

below)

 Select a font for dialogs - for example,

Tahoma

COMMANDS (NEW MD17)

Both (Menus and Toolbars) ; Menus

only, Toolbars only.

ICON SIZE

Large - size is 48×48 pixels (too

big?) 

Medium - size is 32×32 pixels (OK,

recommended)

Small - size is 24×24 pixels (OK, re-

commended)

Tiny - size is 16×16 pixels (too

small?)

Note : If the icons in the toolbars do

not show correctly after you change the

ICON SIZE, then reset the ICON-SIZE to

Medium and, if necessary, re-start

MechDesigner.

LANGUAGE (An English Joke about lan-

guage)

Languages: English, Italian, German,

French, Spanish, Portuguese, Dutch,

Polish, Russian, Japanese, Chinese.

Note: If you change languages, please

wait ~10seconds.

ENABLE HINTS WITH TOOL TIPS

After a short pause, we show the

Hint for a command as you move

your mouse over the icon. However,

the hints frequently get in the way

of the command icon!

We also show the hints in the Feed-

back Area .
326
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See also Help menu

 GRAPHICS 

SYMBOL DISPLAY SIZE (PIXELS): 

The size of symbols that represent

the elements in the graphics-area.

SYMBOL SELECTION SIZE (PIXELS): 

The size of the pointer pin-head. In-

crease to make it easier to select an

element, but, at the same time, you

may also select more than one ele-

ment.

 SOUNDS 

þ SOUNDS ENABLED 

Enable the check-box to hear a dif-

ferent sound with each message in

the Feedback-Area . There are

many messages!

Click the buttons to hear the sound

for the three types of messages.

Auto-Profile tab

 DEFAULT SIZES 

DEFAULT PART-OFFSET (default = 0)

The default offset of all PROFILE/EX-

TRUSIONS you add to a PART.

DEFAULT BALL RADIUS 

The default size of the BALL-JOINT

symbol.

See also: Add Ball-Joint  ; Ball-Joint dia-

log

DEFAULT BEARING DIA. (dia. = dia-

meter)

DEFAULT GROUND BEARING DIA. (dia.

= diameter)

The default dimension given to

ARCS at moving and fixed (with

BASE-PART) PIN-JOINTS when you do

Add Auto-Profile(s).

See also: Add Auto-Profiles

DEFAULT EXTRUSION DEPTH

72

326

114

559

244
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The default EXTRUSION-DEPTH para-

meter in the EXTRUSION DIALOG. 

See also: Add Auto-Profile  ; Add Auto-

Profiles  ; Extrusion dialog

242

244 360
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1.5.11.4 Dialog: Machine-Settings

Machine-Settings

Use the Machine-Settings dialog to edit the MACHINE SPEED, NUMBER-OF-

STEPS in a machine-cycle, and to edit the ENGINEERING UNITS.

How to open the Machine-Settings dialog

Click Edit toolbar > Machine-Settings

OR

 Click Edit menu > Machine-Settings

The Machine-Settings dialog is now open.

Machine Settings dialog

Machine Settings dialog

 CYCLING PARAMETERS 

Cycling Parameters

CYCLES MIN: (RPM) ( See also Note 1  ) 

RPM - Revolutions per Minute.

It is the model's Simulation-Speed. 

It is the rate-of-change of the MASTER-MACHINE-ANGLE. 

MotionDesigner reads and uses this parameter. For example:

Degrees: A MOTION-WIDTH of 360º is one machine cycle in degrees

Seconds: A MOTION-WIDTH of (60/RPM) is one machine-cycle in seconds

NUMBER-OF-STEPS: ( See also Note 2  ) 

Number of calculation points in a machine-cycle.

Notes:

· NUMBER-OF-STEPS and Cam Accuracy - no relationship

353
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Do not increase the NUMBER-OF-STEPS to increase the accuracy of a Cam.

Use the Cam-Coordinates dialog  to calculate and save a Cam with any

number of points and accuracy.

· NUMBER-OF-STEPS is the number of facets along a Cam in the graphics-

area

· NUMBER-OF-STEPS is the number of data-points along a graph - see Graph

FB

· NUMBER-OF-STEPS is the number of facets along the curve of a Trace-

Point - see Trace-Point

· NUMBER-OF-STEPS is the number of points/dots on the Motor Torque and

Speed Curves

· Usually, 120 is good. More than 360 is not usually needed.

See also: Run menu > Step Forward / Step Backward  

 ENGINEERING UNITS 

Engineering Units

ENGINEERING UNITS : ( See also Note 3  )

LINEAR: mm, cm, meters, inch.

ROTARY: deg, radians, cycles

FORCE: N, lbf (pound-force)

TORQUE: N.m, N.mm, ft.lbf

446
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STRESS: Pa(N m2), MPa(N mm2), PSI(lbf in2).

MASS: kg, gms (grams), lb, oz

More about Machine Settings parameters.

Note 1:

CYCLES MIN does not change the animation-speed. 

Change the animation-speed with the Animation Speed Slider . 

Note 2: 

Do NOT increase Machine-Settings >Number-of-Steps  to increase the

accuracy of a 2D-CAM! Use the Cam-Coordinates dialog  to increase the

accuracy of a 2D-CAM you export for manufacture.

Number-of-Steps = 120 is ideal. 360 should be the maximum, for nearly

all models.

To move the model with small steps (increments), we recommend you

use the Spin-Box  in the MASTER MACHINE ANGLE.

Note 3: 

If you change the dimension units, you do not change the size of the

model. 

For example: 100 mm is 3.94 inches if you change dimension units from

mm to inches.

For example: 100 degrees is 1.75 radians if you change dimension units

from degrees to radians.

In all cases, we do not show you the units in the graphics-area.

328
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1.5.11.5 Dialog: DXF-Element

DXF-Element

A DXF-ELEMENT is an element that you add to the ASSEMBLY-TREE when you

do File menu > Open > File of type : DXF

One DXF ELEMENT in the ASSEMBLY-TREE is a container for one DXF-Drawing.

You can edit the DXF-ELEMENT in the ASSEMBLY-TREE to:

· Link the DXF-ELEMENT to a different DXF-Drawing.

· Apply different LINEAR UNITS to the DXF-Drawing.

Note: 

To display a DXF-Drawing in the graphics-area, you must edit a CAD-LINE, and

select the DXF-ELEMENT in the CAD-Line dialog > DXF tab .

How to open the DXF-Element dialog

Editing the DXF-Element from the

Assembly-Tree

Note: To add a DXF-ELEMENT to the

ASSEMBLY-TREE, you must open a DXF

file with File > Open.

To edit the DXF-Element

1. Find a DXF-ELEMENT  in the

ASSEMBLY-TREE 

2. Right-click the DXF-ELEMENT

In the shortcut menu:

3. Click Edit Element

 OR

See How to open a dialog

The DXF-Element dialog is now open.

36
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DXF-Element dialog

FILE NAME, PATH, AND UNITS

DXF-DRAWING FILE-NAME ; PATH

Click the BROWSE button to find and

select a DXF-Drawing. 

DXF-DRAWING UNITS

To show the DXF-Drawing to the cor-

rect scale, select the DXF UNITS of the

original DXF-Drawing.

 To apply the new DXF-Drawing and Units

to the DXF-ELEMENT:

1. Click APPLY  to link the DXF-

Drawing with the DXF-ELEMENT.

2. Click  to close the dialog.
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1.5.11.6 Dialog: Plane

Plane

See also: Model Editor > Add Plane  and Mechanism-Editor > Add Plane

PLANES define the layout of your machine. 

You add other PLANES and MECHANISM-EDITORS to PLANES. 

How to open the Plane dialog-box

Edit Plane

The PLANE DIALOG opens when you

start the Add Plane command. 

To open a PLANE DIALOG you add to

the model at a different time:

1. Right-click a PLANE in the

ASSEMBLY-TREE 

2. Click Edit-element in the short-

cut menu

OR

1. See How to Open a dialog  

Note:

You cannot edit the FRONT, TOP, or

RIGHT planes.

The PLANE DIALOG is now open.

Plane dialog

The PLANE DIALOG has two formats, which you can identify by the PLANE DEFIN-

ITION parameter.

The format is a function of the element you select to add the new PLANE.

 FORMAT 1: Offset from Plane

When you select a PLANE, the PLANE DEFINITION is “OFFSET FROM PLANE”.

82 92
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 New Plane: PLANE6

PLANE PARAMETERS

 PLANE DEFINITION: OFFSET FROM

PLANE

The new PLANE is offset along the Z-

axis of the PLANE you select.

 Element box (bottom of dialog): the

PLANE you select.

Parameter to edit:

 DISTANCE TO NEW PLANE  

The distance from the PLANE you se-

lect (e.g. FRONT ) to the new PLANE

.

New Plane in the Graphic-Area

Notes:

In the image, the new PLANE  is

offset along the Z-axis of PLANE

  by the linear distance equal to

DISTANCE TO NEW PLANE.

FORMAT 2: Angle from Line

When you select a LINE, the X-axis, or the Y-axis of a PART, the PLANE

DEFINITION is “ANGLE FROM PLANE”.
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 New Plane: PLANE5 

PLANE PARAMETERS

 PLANE DEFINITION: ANGLE FROM

LINE 

 Element box (bottom of dialog):

the LINE you select, and the PLANE to

which the LINE is a great, great, grand,

... child?

Parameters to edit:

 MOVE PLANE TO END-POINT

Enable o move the origin of the

new PLANE from the START-POINT

to the END-POINT of the LINE that

is in ELEMENT box .

The X-axis of the new PLANE is

now from the END-POINT to the

START-POINT of the LINE.

Usually, do not enable. However, you

must enable MOVE PLANE TO END-

POINT to add a BEVEL GEAR-PAIR .

 ROTATIONAL AXES

· ROTATE AROUND X-AXIS :

Rotate the new PLANE around

the X-axis direction of the LINE

 

· ROTATE AROUND Y-AXIS :

Rotate the new PLANE around

the Y-axis direction of the LINE

· ROTATE AROUND Z-AXIS :

Rotate the new PLANE around

the Z-axis direction of the LINE

Notes:

When you select a LINE (Format 2) :

The ORIGIN of the new PLANE is:

· at the START-POINT of the LINE, OR

· at the END-POINT of the LINE, if you enable MOVE PLANE TO END-POINT

in the PLANE dialog.

The default +ve X-AXIS of the new PLANE is:

· from the START-POINT to the END-POINT of the LINE, OR

146
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· from the END-POINT to the START-POINT of the LINE, if you enable

MOVE PLANE TO END-POINT.

Related topics

Model toolbar > Add Plane  (in the MODEL-EDITOR tab)

Model toolbar > Add Plane  (in a MECHANISM-EDITOR tab)

How to open a dialog

How to edit a parameter

82

92

627
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1.5.11.7 Dialog: Profile/Extrusion

Profile / Extrusion

See Add Profile/Extrusion

Use the EXTRUSION DIALOG to edit the properties of an EXTRUSION. 

Each EXTRUSION is a child to a PROFILE.

How to edit an Extrusion / How to open the Extrusion dialog

If you CAN see the Extrusion in the graphics-area

Double-click Extrusion

To open the EXTRUSION DIALOG

1. Double-click the EXTRUSION in

the GRAPHICS-AREA 

or 

1. See How to open a dialog  

If you CANNOT see the Extrusion in the graphics-area

SHIFT-CLICK Profile

Profile/Extrusion in Selection-Window

STEP 1: In the graphics-area 

 SHIFT + Click the (Pink)

PROFILE 

STEP 2: In the Selection-Window 

The PROFILE and EXTRUSION

show in the SELECTION-WINDOW

 SELECTION-WINDOW: Right-

click the EXTRUSION element 

In the shortcut menu:

 Click Edit Element. 

Alternatively, if you CANNOT see the Extrusion in the graphics-area

CLICK Profile

STEP 1: In the graphics-area 

 CLICK a (Pink) PROFILE 

The ASSEMBLY-TREE expands

to identify the PROFILE  and
EXTRUSION

253
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Profile/Extrusion in Assembly-Tree

STEP 2: In the Assembly-Tree 

1. ASSEMBLY-TREE: Click the

EXTRUSION  

The  Element  name is now

blue, the ICON has an orange

box

2. ASSEMBLY-TREE: Right-Click

the EXTRUSION  

A shortcut menu shows next to

your pointer:

3. SHORTCUT MENU: Click Edit

Element  

The EXTRUSION DIALOG is now open.

 The Extrusion dialog

Extrusion dialog

There are three separators in the

EXTRUSION DIALOG. 

DEPTH AND OFFSET 

COLOR, OPACITY AND QUAL-

ITY 

MASS PROPERTIES  

Create STEP File
 

Click this button to save the

EXTRUSION as a STEP file-

type.

 DEPTH AND OFFSET 

Extrusion dialog | Depth and Offset

EXTRUSION-DEPTH  (default = see

Application-Settings> Auto-Profile

tab )

The distance to the Secondary

contour  from the Primary con-

tour , along the +Z-axis  of the

PART. 

EXTRUSION-DEPTH must be posit-

ive. Minimum value = 0.001mm

EXTRUSION-OFFSET (default = 0)

The distance to the PRIMARY CON-

TOUR from the dimension that is

specified by PART-OFFSET.

349
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Sketch-Loop and Profile contours

EXTRUSION-OFFSET can be negative

or positive.

PART-OFFSET  (default = 0)

Applies to ALL EXTRUSIONS in a

PART.

The distance to the PRIMARY CON-

TOUR from the Mechanism-Plane

to which we add the distance spe-

cified by the EXTRUSION-OFFSET

parameter.

PART-OFFSET can be negative or

positive. 

Note: Distance to Primary contour

from MECHANISM-PLANE = PART OFF-

SET + EXTRUSION OFFSET

The Primary and Secondary Contours of the PROFILE:

 Sketch-Loop 

 Primary-Contour

 Secondary-Contour

 Z-axis is perpendicular( ) to the Mechanism-Plane

 COLOR, OPACITY, QUALITY 

SHOW EXTRUSION

To show or hide the EXTRUSION

Note: To hide PROFILE contours,

see Display toolbars > Show/Hide

Profiles 

COLOR 

Button to select the color of the

EXTRUSION with the Windows® Co-

lor-Picker 

TRANSPARENCY (slider)

Slider to change the TRANSPAR-

ENCY (1/Opacity) of the EXTRUSION

in the graphics-area 

GRAPHICS QUALITY (slider)

Slider to change the GRAPHICS QU-

ALITY of the EXTRUSION 
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Low Quality     High Quality

Note: To update to a different GRAPH-

ICS QUALITY, you may need to edit the

PART in the PART-EDITOR and then close

the PART-EDITOR immediately.

See also: Application Settings | Graph-

ics

 MASS PROPERTIES 

DENSITY 

The MASS and INERTIA properties

(below) change as you edit the

DENSITY.

MASS (read-only) 

MASS = DENSITY × area of sketch-

loop × EXTRUSION DEPTH.

The mass is uniformly distributed.

The center-of-mass is on the

MECHANISM-PLANE. 

The position of the center-of-mass

is a function of the shape of the

sketch-loop you select to add the

PROFILE. 

INERTIA (read-only) 

INERTIA (Mass Moment of Inertia)

is calculated with respect to the

center-of-mass. 

See also CAD-Line dialog > Mass

Properties tab

345
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1.5.11.8 Dialog: CAD-Line >

CAD-Line

A CAD-LINE is a child to a PART.

· Each PART you add to the model has a CAD-LINE from the START-POINT to

the END-POINT of the PART.

· You can also add CAD-LINES to PARTS and the BASE-PART - see Add CAD-

Line

Use the CAD-LINE DIALOG to:

· Import a CAD-SOLID from SOLIDWORKS, OR import an STL file from other

CAD.

· IMPORT MASS-PROPERTIES from SOLIDWORKS, AND enter USER MASS-

PROPERTIES

· Display a DXF-Drawing, and edit its color.( Note: You must first import

the DXF-Drawing with File menu > Open DXF  )

· Change how to display a CAD-SOLID - Color, Transparency, Edge, ...

How to open the CAD-Line dialog

Double-Click a CAD-Line to open the 

CAD-Line dialog

To open the CAD-LINE DIALOG

1. Double-click a CAD-LINE in the

graphics-area of the MECHAN-

ISM-EDITOR, PART-EDITOR, or

the ASSEMBLY-TREE. 

OR

1. See How to Open a dialog  

Double-Click a CAD-Solid to open the

CAD-Line dialog

OR

1. Double-click a CAD-SOLID in

the MODEL-EDITOR, MECHAN-

ISM-EDITOR, or PART-EDITOR. 

OR

1. See How to Open a dialog  

The CAD-LINE DIALOG is now open.

CAD-Line dialog

279
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CAD-Line dialog

CAD-Line dialog

tabs:

SOLIDWORKS

Mass Properties

DXF

STL Import

Display Options

1.5.11.9 -> SOLIDWORKS tab

CAD-Line > SOLIDWORKS tab

See also: Mass-Properties tab , DXF tab , STL Import tab , Display Options

tab . 

Use the CAD-Line > SOLIDWORKS tab to:

· Import a SOLIDWORKS Part/Assembly document ( SOLIDWORKS refers to

their CAD files as "documents" ).  onto a CAD-LINE as a CAD-SOLID.

· Control the surface accuracy of the CAD-SOLID when you import it from

SOLIDWORKS.

· Remove a SOLIDWORKS Part/Assembly document from a CAD-LINE.

· Reopen a SOLIDWORKS Part/Assembly document in SOLIDWORKS that

has been (previously) imported onto a CAD-LINE.

· Rename the CAD-LINE to the name of the active SOLIDWORKS

Part/Assembly document.

CAD-Line dialog

SOLIDWORKS tab

CAD-Line dialog> SOLIDWORKS tab

Before you import a document from SOLIDWORKS:

· Make sure the SOLIDWORKS Part/Assembly document you want to im-

port is open in SOLIDWORKS and it is the active document. 

· Make sure the SOLIDWORKS Part/Assembly document has a file-name.

365
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· Usually, add a Coordinate-System feature to the SOLIDWORKS

Part/Assembly document to align with the CAD-LINE.

· Usually, simplify the SOLIDWORKS document to reduce the complexity

of the model.

Warning: The SOLIDWORKS Part/Assembly document does not import into

MechDesigner if, in SOLIDWORKS, you use a Chinese Traditional font to

name a Configuration.

Rename the Configuration feature with a Western font.

 IMPORT FROM SOLIDWORKS 

CAD-Line dialog > SOLIDWORKS tab

STEP 1: Click the READ  button

WAIT until the:

· SOLIDWORKS® PART/ASSEMBLY

NAME (read-only) shows in box

· SOLIDWORKS CONFIGURATION

(read-only) shows in box 

· MODEL STATUS (read-only)

shows in box 

Model Status:

 Unavailable - before you import

SolidWorks® document the first

time.

 Out of Date - the file in box  is

older than the current date/time. 

 Up to Date - the date/time of file

in box  is the equal to the

date/time when imported.

STEP 2: If there is more than one

Coordinate-System, select a

COORDINATE-SYSTEM .

STEP 3: Click the IMPORT  But-

ton

WAIT - a large model can take

time to import.

OPTIONAL BUTTONS( )

Button  : REMOVE the

SOLIDWORKS® document in

box  from the CAD-LINE

Button  : OPEN the

SOLIDWORKS® document in

box  (that you have previ-
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ously imported) in
SOLIDWORKS®

Button  : RENAME CAD-LINE

to the file-name of the

SOLIDWORKS document in box

.

CAD-SOLID FILE QUALITY 

¤ Fine: more vertices

¤ Coarse: fewer vertices

¤ Custom : you can edit:

· LINEAR DEVIATION :

Maximum =0.5mm;

Minimum =0.014mm -

see Warning 

· ANGULAR DEVIATION :

Maximum =30º; Min-

imum =0.4º - see

Warning

Warning : The Number-of-

Vertices  increase rapidly

as you reduce the LINEAR/AN-

GULAR DEVIATION to give a

large STL file. A large STL file

slows down MechDesigner.

Also, the display of the CAD-

SOLID in MechDesigner may

not always improve as you

reduce the LINEAR/ANGULAR

DEVIATION. Experiment! See:

Edge Angle Limit .

1.5.11.10 -> Mass Properties tab

CAD-Line > Mass Properties tab

See also : CAD-Line dialog

Use the CAD-Line > Mass-Properties tab to:

· Enter user-defined mass properties

· Import the mass-properties of a SOLIDWORKS document

· Review the total mass-properties of a PART

381
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CAD-Line dialog

Mass Properties tab

CAD-Line dialog > Mass- Properties tab

 USER MASS PROPERTIES 

MASS (Units: )

CENTER-OF-MASS: X–AXIS (  )

CENTER-OF-MASS: Y–AXIS (  )

MOMENT OF INERTIA ( ) - ( 

 NOT ) 

The Mass Moment of Inertia about

the Center-of-Mass.

You can enter the: 

RADIUS-OF-GYRATION , 

OR 

MOMENT-OF-INERTIA  

Note: 

MOMENT OF INERTIA is should al-

ways read as MASS MOMENT OF IN-

ERTIA

The X-axis is the CAD-LINE, the Y-

axis is at +90º on the Mechanism-

Plane.

The 0,0 is at the START-POINT of

the CAD-LINE.

Moment-of-Inertia: Radius-of-Gyration, and Point-Mass. 

CASE 1: 

If you enter a MASS but do NOT enter a RADIUS-OF-GYRATION or MO-

MENT-OF-INERTIA, the MASS is termed a “Point Mass”. 
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The x,y position of the MASS relative to the CAD-LINE is at CENTER-OF-

MASS: X–AXIS, and CENTER-OF-MASS: Y–AXIS.

CASE 2:

If you enter a MASS and a MOMENT-OF-INERTIA, then the RADIUS-OF-GYRA-

TION,  :

CASE 3:

If you enter a MASS and a RADIUS-OF-GYRATION, then the MOMENT-OF-IN-

ERTIA,  is:

PARALLEL AXIS THEOREM

We use for you the Parallel Axis Theorem to calculate the Mass Mo-

ment-of-Inertia about the PART'S instantaneous center-of-rotation.

 

 = distance to the Center-of-Mass from the center-of-rotation.

 SOLIDWORKS MASS PROPERTIES 

When you import a SOLIDWORKS document onto a CAD-LINE, you can also

import its Mass-Properties.

Button  IMPORT / UPDATE

SOLIDWORKS MASS PROPERTIES

Note: Before you click button , make

sure the active SOLIDWORKS docu-

ment is on the CAD-LINE. 

MASS (kg)

MASS of the active SOLIDWORKS

document.

CENTER-OF-MASS - X-AXIS (mm)

The distance to the CENTER-OF-

MASS along the X-axis from the

START-POINT of the CAD-LINE.

CENTER-OF-MASS - Y-AXIS (mm)

The distance to the CENTER-OF-

MASS along the Y-axis from the

START-POINT of the CAD-LINE.

MOMENT-OF-INERTIA 
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The MASS MOMENT OF INERTIA

with respect to the CENTER-

OF-MASS

Button  REMOVE SOLIDWORKS

MASS PROPERTIES

 TOTAL MASS PROPERTIES 

Note: 

You can add many CAD-LINES to a PART. If you import SOLIDWORKS doc-

uments onto more than one CAD-LINE in a PART, we recommend that

the START-POINT and X-axis of all CAD-LINE'S are coincident and collin-

ear, respectively.

Total Mass Properties:

The Total Mass Properties include, for each PART, ALL of those:

· Mass and Mass-Properties that we calculate for you for ALL PRO-

FILE/EXTRUSIONS in the PART 

· User Mass-Properties as you define for ALL CAD-LINES in the PART

· SOLIDWORKS Mass-Properties that you import for ALL CAD-LINES in

the PART

NOTES:

Parallel-Axis Theorem 

Mass Moment of Inertia about

Part's Rotational-Axis = 

Total Mass Moment of Inertia

about center-of-Mass 

+ Total Mass  × (Distance to

Part's Rotational-Axis)2

Relationship between Mass Mo-

ment-of-Inertia and Radius of

Gyration

Total Mass Moment of Inertia

(about center-of-Mass) = 

Total Mass × (Radius-of-Gyra-

tion)2

Total Mass of Part = 

Mass of all Extrusions  

+ Total mass of all CAD-Lines

in the same Part

363
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Total Mass Moment of Inertia

about the Part's center-of-Gravity

= 

Mass Moment of Inertia of all

Extrusions 

+ Total Mass Moment of Iner-

tia of all CAD-Lines in the same

Part

1.5.11.11 -> DXF tab >

CAD-Line > DXF tab

See also: Open DXF-File , DXF-Element

Use the DXF tab to:

· Display* a DXF-Drawing

· Align the DXF-Drawing with the CAD-LINE 

· Edit the color of the DXF-Drawing

· Convert DXF Entities in the DXF-Drawing to MechDesigner sketch-ele-

ments

· Remove the DXF-Drawing from the CAD-LINE

* Before you can display a DXF-Drawing, you must use File menu > Open DXF

file  to import a minimum of one DXF-ELEMENT. The container for the DXF-

Drawing is the DXF-ELEMENT in the ASSEMBLY-TREE.

DXF Terminology 

Term : Definition

DXF : Drawing eXchange Format. DXF is a CAD data file format designed

for sharing drawing data universally across CAD applications.

DXF-Drawing : The drawing that you want to import from your CAD and to display

in the graphics-area in MechDesigner.

DXF-ELEMENT : The DXF-ELEMENT is the container for the DXF-Drawing that you

import when you do File menu > Open | *.DXF file-type

When you open a DXF file, we add a DXF-ELEMENT to the

ASSEMBLY-TREE.

CAD-LINE : The element you edit to select a DXF-ELEMENT to display a DXF-

Drawing. 

DXF-Outline : The efficient sketch that we use to display a DXF-Drawing. You

cannot edit a DXF-Outline. 

DXF-Entity : Points, Arcs, and Lines are DXF-Entities in the sketch of the DXF-

Outline. 

You can use the CAD-LINE DIALOG to convert Arc and Line DXF-

Entities to regular MechDesigner ARC and LINE sketch-elements.

36 354
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CAD-Line dialog

DXF tab

CAD-Line dialog > DXF tab

 SELECT DXF-ELEMENT 

SELECT DXF-ELEMENT: drop-down

list-box

1. Click the drop-down arrow to se-

lect a DXF-ELEMENT 

The DXF-Drawing is now in the

graphics-area immediately.

Notes:

· We show DXF-Points ONLY

when the CAD-LINE DIALOG is

open. 

· See here  if you cannot see

the DXF-Drawing in the

graphics-area.

· See File > Open > DXF file-

type, if you cannot see a DXF-

ELEMENT in the drop-down.

Optional buttons:

EDIT DXF LAYERS : 

To open the DXF LAYERS DIA-

LOG  to show or hide different

LAYERS in the DXF-Drawing.

See SOLID COLOR (below) to

change the color of the DXF-

Drawing. 

REMOVE DXF : 

373
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To remove the DXF-Drawing

from the CAD-LINE.

SOLID COLOR: 

To edit the color of the DXF-

Drawing.

DXF-ELEMENT

For example: DXF : PCD-3.DXF 

DXF is the name of the DXF-ELEMENT that you add to the ASSEMBLY-TREE

when you do File menu > Open DXF file-type . It is the container for

the DXF-Drawing.

PCD-3.DXF is the name of the DXF-Drawing that is “in” the DXF-ELEMENT.

If you cannot see the DXF-Drawing:

· Change the background color of the graphics-area.

See Application Settings | color tab

· The size of the DXF-Drawing may be very large/small relative to the

graphics-area.

See View menu > Zoom-Out  (or use the wheel button on you

mouse)

· The scale of the DXF-Drawing may not be correct. 

Check the LINEAR UNITS of the DXF-Drawing. It is normal to use the

same LINEAR UNITS as the original DXF-Drawing.

See Edit DXF-Element dialog  > DXF-DRAWING UNITS

 ALIGN DXF TO CAD-LINE 

Align the DXF-Drawing with the CAD-

Line, select two(2) DXF-Points.

DXF POINT TO CAD-LINE'S ORIGIN

1. Click in the box to make the box

ORANGE - see Note #1

2. Click the DXF-Point in the DXF-

Drawing that you want to move to

the START-POINT of the CAD-LINE -

see Note #2

The DXF-POINT shows in the box

and the box is Green

DXF POINT TO CAD-LINE

3. Click in the box to make the box

ORANGE 

4. Click a DXF-Point in the DXF-

Drawing that you want to move to

34
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the X-axis of CAD-LINE - see Note

#2

The DXF-Drawing moves to align with

the CAD-LINE.

Notes: 

#1 - If you can see the DXF-Draw-

ing but cannot see DXF-

Points, then make sure Dis-

play DXF-Points in the Dis-

play Filter toolbar is enabled.

#2 - DXF-Points do not show as

“selected” when you mouse-

over them, but do click it!

 CONVERT DXF ENTITIES TO MD LINES AND ARCS 

You cannot edit the DXF entities (DXF Line, DXF Arc, and DXF Point) - they

are dumb. 

You can use this separator to copy the shape of DXF entities to

MechDesigner LINE, ARC, and POINT sketch-elements. 

After you convert them to MechDesigner sketch-elements, you can option-

ally remove the original DXF entities.
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OWNER PART

This box controls the PART onto which

to copy DXF entities as sketch-ele-

ments.

Default the OWNER PART is the same

PART as that of the CAD-LINE. To

change the OWNER PART: 

1. Click the OWNER PART box to make

it ORANGE 

2. Click a PART in the graphics-area

or the ASSEMBLY-TREE.

The PART should now be in the

OWNER PART box. The box should

be GREEN

DXF ENTITY

This box controls the DXF-ENTITY you

convert to a sketch-element.

3. Click the DXF ENTITY box to make it

ORANGE 

You may want also want to: 

· Click the SELECT-LOOP radio-

button so that, if possible, you

convert a number of DXF-Entit-

ies to a sketch-loop

· Click the LOCK POINTS radio-

button to lock/fix the POINTS in

the sketch-elements to the

PART, after you convert the DXF

entities to sketch-elements

· Optionally, edit the MERGE RA-

DIUS value to help make a

sketch-loop with those DXF en-

tities inside the MERGE-RADIUS'

value - I have never found a

reason to edit MERGE RADIUS.

4. Click a DXF ENTITY (a DXF LINE or

DXF ARC) in the graphics-area 

The DXF-ENTITY box should now be
GREEN

5. Click the CONVERT TO MD ENTIT-

IES button 

Repeat 1 to 5 again to convert other

DXF Entities to MD sketch-elements.
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TOP-TIPS: 

After you CONVERT DXF TO MD LINES AND ARC, you can click the REMOVE

DXF button in SELECT DXF ELEMENTS.

You can double-click a DXF ENTITY to open the CAD-LINE DIALOG.

1.5.11.12 -> -> DXF Layers

CAD-Line > DXF tab > DXF Layers

DXF-Drawings frequently use Layers for different drawing information. 

Use the DXF LAYERS DIALOG to show or hide each Layer in a DXF-Drawing.

To open the DXF LAYERS DIALOG:

1. Click the EDIT LAYERS button in the CAD-Line dialog > DXF tab  

DXF Layers dialog

To Show or Hide a Layer:

1. Click a  (or  ) in the Show

column 

2. Click the Layer Visible (or Layer Hid-

den) check-box

To change the color of a Layer:

This option does not work!

See Solid Color in the DXF tab

1.5.11.13 -> STL Import tab

CAD-Line > STL Import tab

See also : CAD-Line dialog

Use the CAD-Line dialog > STL Import tab to:

· Import an STL file - to import 3D CAD models as a CAD-SOLID when you

do not have SOLIDWORKS.

· Edit the STL FILE UNITS to be equal to those of the linear units of the ori-

ginal STL file.

· Edit the EDGE ANGLE LIMIT to remove “ghost” lines in MechDesigner on

the CAD-SOLID that represents the original STL file.

See more : STL Files

Prepare and save the STL file in your CAD software:

Before you save the STL file in your CAD software:

Rotate the model to align its XY-Plane with the XY-Plane of the MECHAN-

ISM-EDITOR.

371
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In the Save as... dialog in your CAD software:

Select Binary as the STL file-type.

Edit, and remember, the Linear units of the STL file. 

If you cannot edit the Linear units of the STL file, they are usually SI units

- meters (m).

After you import an STL file:

See CAD-Line Display Options tab  to move the STL file in the X, Y, Z-axis

directions.

CAD-Line dialog

STL Import tab

CAD-Line dialog > STL Import tab

 IMPORT STL FILE 

To import an STL file:

1. Click the BROWSE button 

2. Explore and select an STL file

3. Select the Linear Units (to

equal those of the STL file)

4. Click the IMPORT button, or

edit the EDGE ANGLE LIMIT - see

below

5. Close the dialog

Note: To see the CAD-SOLID, enable Vis-

ibility toolbar > Show Solids in Mech-

anisms

EDGE ANGLE LIMIT

1. Enter a Value in the EDGE-ANGLE

LIMIT box 

383
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Image with too many Facet-Edges

This parameter can change the ap-

parent quality of the STL file in the

graphics-area.

EDGE ANGLE LIMIT analyzes the

acute angle between two adjacent

facets of the tessellated CAD-Solid

that represents the STL file of the

original CAD model.

· If the acute angle between two

adjacent facets is less than(<)

the EDGE ANGLE LIMIT, we do

not show a line at the edge of

the two facets.

· If the acute angle between two

adjacent facets is greater than

(>) the EDGE ANGLE LIMIT, we

do show a line at the edge of

the two facets.

SOLID COLOR button - to edit the

color of the STL file:

1. Click the SOLID COLOR button 

2. Select a color in the Windows Co-

lor Picker® 

3. Click OK in the Windows Color

Picker®

STL FILE UNITS

1. Select the units of the original STL

file. 

Try meters, [m], if you are not sure.

Top-Tip 

I find these options are a good

compromise of display quality,

display accuracy, and STL file-size.

EDGE ANGLE LIMIT =80 (STL

Import tab)

LINEAR DEVIATION = 0.14

(SOLIDWORKS tab)

ANGULAR DEVIATION =30

(SOLIDWORKS tab)

Image with Facet-Edges OK
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STL Files

FILE-SIZE

The STL file tessellates to approximate the surfaces of the original CAD

model as a mesh of triangles. Each triangle is a small face, also called a fa-

cet. The number of facets is a function of: 

· the complexity of the original CAD model, and 

· how accurately you want the STL file to tessellate the original CAD

model.

If you want to import many STL files, you also want a:

SMALL file-size for each STL file,

... AND each STL file to appear to be equal to the original CAD model,

... AND to see only those facets that are real edges in the CAD model.

Strategies to reduce the STL file-size.

STRATEGY 1: Reduce the complexity of the original CAD Model to reduce

the STL file-size

Add a new configuration for the CAD model. In the new configuration:

· Do a geometry check to find if it has any small gaps or whiskers

· Suspend external fillets and internal fillets, especially if they do not

have a function

· Replace fillets with chamfers if functional

· Suspend all fasteners

· Suspend fastener holes and hole features

· Suspend all cosmetic details

· Replace complex models you may have downloaded from the inter-

net with simplified models, e.g. bearings.

STRATEGY 2: Reduce the accuracy of the STL file

There parameters are in the CAD-Line > SOLIDWORKS tab.

LINEAR DEVIATION : 

The maximum LINEAR DEVIATION (distance) between the surface of the

original CAD model and the tessellated surface of the STL file. 

ANGULAR DEVIATION : 

The maximum ANGULAR DEVIATION between adjacent facets of the tes-

sellated surface of the STL file.

If you do not have SOLIDWORKS, find these parameters in your 3D-CAD

before you save your model as the STL file. It is possible LINEAR and AN-

GULAR DEVIATION are options in the Save as > STL file-type dialog.

STRATEGY 3: Use the EDGE ANGLE LIMIT parameter - see  IMPORT STL FILE

 above
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STL files will show their facets if the angle in EDGE ANGLE LIMIT is less than

the facet of the CAD-SOLID. Experiment. Import the model again each

time you edit EDGE ANGLE LIMIT (try 80 degrees).

EXAMPLES

Below, the two images are of the same SOLIDWORKS part. 

They appear to be identical. However, there is a large difference in the

number of facets and vertices.

STL: Large number of Vertices

BAD - many facets

· Linear Deviation = 0.014mm and

· Angular Deviation = 0.4º

There are 

· 119132 vertices 

· ~40000 triangles

· The STL file size is 3.5 Mega

Bytes

STL: Few number of Vertices

GOOD - few facets

· Linear Deviation = 0.5mm and 

· Angular Deviation = 5º

There are:

· 7533 vertices 

· ~2500 triangles

· The STL file size is 0.365 Mega

Bytes

Save as STL file-type : Options in SolidWorks
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1.5.11.14 -> Display Options tab

CAD-Line > Display Options tab

Use Display-Options tab to:

· Edit the color and transparency of a CAD-SOLID.

· Toggle the Show or Hide a CAD-SOLID .

· Move a CAD-SOLID in the X, Y, Z-axis directions.

CAD-SOLIDS are those CAD models you import onto a CAD-LINE with the
CAD-Line dialog

CAD-Line dialog

Display Options tab

CAD-Line dialog > Display Options tab

 DISPLAY OPTIONS 
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SHOW SOLID (check-box)

Click the SHOW SOLID check-box to

show or hide the CAD-SOLID that is

on the CAD-LINE.

Note: Enable Visibility toolbar >

Show Solids in Mechanisms  to

show CAD-SOLIDS in MECHANISM-EDIT-

ORS.

TRANSPARENCY:

Drag the TRANSPARENCY slider-bar

to change the transparency of the

CAD-SOLID on the CAD-LINE. Exper-

iment!

SOLID COLOR:

Click the SOLID COLOR button to

open and edit the color of the

CAD-SOLID with the Windows®

color picker, 

NUMBER OF VERTICES: (read-only)

Complex files have more vertices.

MechDesigner may be slow to re-

spond to new commands when

there are many CAD-SOLIDS, each

with many NUMBER-OF-VERTICES.

How many is too many? Try to

make NUMBER-OF-VERTICES <

10,000.

Experiment with the FINE, COARSE

and CUSTOM radio-buttons in the

SOLIDWORKS tab . 

TOP TIPS: 

Make the model is as simple as possible. E.g. remove screws, screw

holes, cosmetic threads,  ...

Make a new SOLIDWORKS Configuration, and in the new configuration:

· Remove cosmetic fillets

· Remove non-functional internal or external fillets (rounds) 

· Optionally, replace fillets with chamfers

Simplify CAD files and models you download from OEMs or CAD file

services (e.g. Trace-Parts), For example:

· Bearings: remove or suppress balls, rollers, seals, shields, cage,

and replace with a simplified solid section. 

· Motors: replace with a simplified solid section.

66
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· Aluminum extrusions: replace with a simplified section.

 CAD SOLID XYZ POSITION 

MOVE CAD-SOLID - X (or Y, or Z)-

AXIS

If your CAD-SOLID is not in the cor-

rect place use the MOVE CAD-SOLID

- X (or Y, or Z) to translate the

CAD-SOLID.

You cannot rotate the CAD-SOLID.

Notes: 

Before you import a CAD-SOLID:

If you use the STL Import tab to

import your CAD model, rotate

your mode in your CAD software

If you use the SOLIDWORKS tab to

import your CAD model, add a

Coordinate System feature such

that the X-axis aligns with the CAD-

LINE and the Origin is coincident

with the start-Point of the CAD-LINE

 before you import it.
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1.5.11.15 Dialog: 3D-Cam

3D-Cam

See Add 3D Cam

Note: 

We do NOT immediately calculate the surfaces of 3D-CAMS when you open

a model that has 3D-CAMS. To see the 3D-CAM surfaces, you must edit and

rebuild the 3D-CAMS with the 3D-CAM DIALOG. 

You must find the 3D-CAM in the ASSEMBLY-TREE, as a child to the MECH-

ANISM-EDITOR that includes the Cam-Part - e.g. a Cam-Shaft.

How to open the 3D-Cam dialog-box ...

If you cannot see the 3D-CAM in the

graphics-area. 

STEP 1: Find the Cam-Part

The 3D-CAM is a child to the

Cam-Part.

1. Click the Mechanism-name-

tab  that has the Cam-Part

as a child. 

In the graphics-area:

2. Click the PART-OUTLINE  of

the Cam-Part that has the 3D-

CAM as a child. 

Or, in the ASSEMBLY-TREE 

2. Click the Cam-Part that has the

3D-CAM as a child.

To the left, in the ASSEMBLY-TREE, the

Cam-Part (Cam-Shaft1 ) is selected.

STEP 2: In the Assembly-Tree

1. Explore the Cam-Part(Cam-

Shaft1 ) in the ASSEMBLY-TREE

to show its child elements 

The 3D-CAM is a child to the

Cam-Part.

2. Right-click the 3D-CAM element

In the shortcut menu:

3. Click Edit Element

The 3D-CAM DIALOG is now open.

133



385

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

3D-Cam dialog

3D-Cam dialog

There are two buttons at the top of the

3D-CAM DIALOG:

Rebuild
 

Save Cam
 

Click the  button to, show,

and/or re-build the 3D-CAM after you

edit any of the parameters in the 3D-

CAM DIALOG, or after you open a

model with 3D-CAMS.

See more below .

There are three tabs:

Cam  

Display

Export

CAM tab

 CAM SURFACE MESH DENSITY 

Rims along the Cam-Flanks (Purple),

the Top and Bottom (Orange), and

Points along each Rim.

PREAMBLE:

Four(4) Cam Surfaces

A 3D-CAM has four(4) surfaces. The

four(4) surfaces are the:

· 2 × Working Surfaces: these are

the Cam-Flanks that are in con-

tact with the Follower-Roller

· Root Surface: the floor is deeper

in the cam to be clear of the end

of the Follower-Roller

· Top: you do not need this sur-

face in the actual cam. We add it

to close the 3D-CAM.

Rims and Points

Rims: are along the length of each

surface. We distribute Rims equally

across each surface so that are ap-

proximately parallel with each

other.

Points: are along the length of each

Rim. We distribute Points equally

along each Rim.

394
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You control the number of Rims and

the number of Points along the

Rims in the CAM MESH DENSITY sep-

arator.

# POINTS PER RIMS: 

The number of Points along each

Rim

# RIMS PER FLANKS: 

The number of Rims across each

Cam-Flank (working surface) of the

3D-CAM.

# RIMS PER TOP / ROOT: 

The number of Rims across the Root

and Top surfaces (non-working sur-

face) of the 3D-CAM.

# HOOPS (FOR CAD)

Hoops wrap around the 3D-CAM . They

connect each Rims at the same Point #.

We use Hoops to help SOLIDWORKS

model the surfaces.

 ROLLER PARAMETERS 

PREAMBLE: 

These parameters are for Tapered Follower-Rollers.

 [ Linear Velocity ( ) = Radius( ) × Angular Velocity ( ) ]

Cam Flank Velocity: different points on the cam-flank surface are at differ-

ent radii from the cam's rotational axis.

Therefore, a point that is at a large radius from the Cam's rotational-axis has

a greater velocity than a point that is at a small radius. 

Cylindrical Follower-Roller Velocity: all points on the surface of a cylindrical

follower bearing are at equal radii from its rotational-axis. Therefore, the
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tangential velocities of all points on the surface of a cylindrical roller are

identical. 

The velocity of the cam's surface and the follower's surface can only be

equal to each other at one radius from the center of the Cam. The follower-

roller must be skidding at all other points!

Tapered Follower Velocity: the surface velocity of a tapered-roller increases

as its radius increases. If its apex is coincident with the rotational-axis of the

cam, it can have a surface speed that is equal to the surface speed of the

cam. Thus, it can roll on the cam surface as the cam rotates. This is possible

during the dwell periods.

Nevertheless, cylindrical or barrel rollers are usually used as they are readily

available, cheap, and they can withstand high loads. 

Two Extrusions - different

Extrusion-Offset

The Roller Diameter of a Tapered Roller?

First, review the EXTRUSION-OFFSET and EXTRUSION-DEPTH parameters that

define the PROFILE EXTRUSION of the Follower-Roller.

Use the EXTRUSION DIALOG  to make the EXTRUSION-DEPTH parameter

equal to the actual Width (or Length) of the Follower-Roller (frequently,

the 'B' parameter in bearing catalogs).

Extrusion dialog:  (Note: PART-OFFSET parameter = 0 mm).

EXTRUSION-OFFSET (mm): Position (Z-axis) to the Primary-Contour  from

the Mechanism-Plane.

EXTRUSION-DEPTH (mm): = Dimension between the Primary  and Sec-

ondary  -Contours. Positive value ONLY

360
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TAPER-ANGLE of the Follower-Roller.

Taper-Angle (degrees) inclines the

Flanks of the 3D-CAM. The taper

angle pivots about the Secondary-

Contour . 

This is not as convenient as the

Primary-Contour , for which we

apologize.

With reference to the image to the

left, you can see that a Negative

TAPER ANGLE  decreases the dia-

meter of the Roller in the +Z-axis

direction.

Whereas, a Positive TAPER ANGLE,

increases the diameter of the Roller

in the +Z-axis direction.

Z OFFSET FOR DEBUG - ignore.

C = Actual Roller

Width

Recommendation , if you want to use the TAPER-ROLLER parameter:

Edit the parameters so that Secondary-Contour of the Profile for the Fol-

lower-Roller is on the Mechanism-Plane.

STEP 1

Edit the Follower-Profile (Extrusion) with the EXTRUSION DIALOG 

The EXTRUSION-OFFSET  should be the negative of the EXTRUSION-DEPTH

. 

EXTRUSION-DEPTH(mm) = ACTUAL ROLLER WIDTH(mm) (Equal to dimension

C in SKF catalog

EXTRUSION-OFFSET (mm) = – EXTRUSION-DEPTH(mm) (Equal to negative of

dimension C in SKF catalog.

The Secondary Profile  is now on the MECHANISM-PLANE . The TAPER-

ANGLE  parameter rotates and pivots on the MECHANISM-PLANE.
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STEP 2:

Use the ROLLER CLEARANCES separator (see below  ) to edit the ROOT-

CLEARANCE and TOP-CLEARANCE to extend the flanks as you need for the

actual roller and 3D-CAM

 ROLLER CLEARANCES 

PREAMBLE:

There must be a small clearance for

a Follower-Roller to roll between

the Cam's flanks.

Also, you must make sure the Fol-

lower-Roller does not touch the

Root/Floor of the Cam-Blank.

Thus, CLEARANCES are practical con-

siderations.

To calculate the basic 3D-CAM (without

Roller Clearances), we use for you the:

· Radial dimension of the CIRCLE

that represents the Follower-

Roller.

· EXTRUSION-DEPTH of the CIRCLE as

the depth of the Cam-Flanks

· PART-OFFSET + EXTRUSION-OFFSET

of the EXTRUSION from the MECH-

ANISM-PLANE to locate the Cam-

Flanks.

You should use the actual dimensions of

the Follower-Roller, and use ROLLER

CLEARANCES to give the clearances you

need. 

RADIAL-CLEARANCE (mm)

389
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IMPORTANT: Total Clearance = 2 ×

RADIAL CLEARANCE. 

A positive RADIAL CLEARANCE moves

the cam-flanks out, from the Fol-

lower-Roller. 

A negative RADIAL CLEARANCE moves

the cam-flanks in, towards the Fol-

lower-Roller.

ROOT-CLEARANCE (see also Note)

A positive value moves the Root-Face towards the center of the Cam -

see Note. 

Add ROOT-CLEARANCE to make sure the Follower-Roller does not touch

the actual Root (the floor) of the cam-groove/track.

Note: 

Stud Crowned/Barrel Follower-Roller bearings have a zero to quite a

large negative tolerance (e.g. 0 to –0.05mm)

Stud Cylindrical Follower-Roller bearings have a small tolerance, (e.g. h5

fit )

TOP-CLEARANCE (see also Note)

A positive value moves the Top-Face away from the center of the Cam -

see Note.

Add TOP-CLEARANCE to make sure the top-face of the model is outside

the Cam-Blank

Note: 

The Top-Face may be the Root-Face of the Cam - vice-versa!

To find which is which, Experiment! Enter a value for the ROOT-CLEARANCE

and click the REBUILD button. Observer in the model which face moves.

 FLANK LENGTH 
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PREAMBLE:

FLANK LENGTH parameters apply to

Indexing Cams. 

When you add a 3D-CAM, we calcu-

late for you the cam over a complete

machine-cycle, 0 – 360. However,

Follower-Rollers of indexing cams

are not in contact with the cam for a

complete machine-cycle, 0 – 360.

The Follower-Rollers progressively

engage, then disengage with the

cam, in a similar way to gear teeth.

You use the parameters in the FLANK-

LENGTH separator to calculate the

cam for the period in which the Fol-

lower-Roller is engaged with the

cam.

FLANK-LENGTH:

START-ANGLE

END-ANGLE

These angles are with respect to the Master-Machine-Angle.

When you edit the START-ANGLE and END ANGLE, we re-calculate for you the

Cam from the START-ANGLE to the END-ANGLE. 

The number-of-points along the cam do not change. Thus, the points along

each rim are nearer to each other.

DISPLAY tab

 DISPLAY IN GRAPHIC-AREA 
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PREAMBLE: 

The Display tab controls how you show

the 3D-CAM in the graphics-area. 

SOLIDS* | HOOPS | RIMS.

þ  SOLIDS*: show or hide, 3D-CAM as an

MD-SOLID

þ  HOOPS: show or hide a hoop at each

Point - see # Points

þ  RIMS: show or hide the Rims along the

3D-Cam

* You must enable the SOLIDS check-box

to see the 3D-CAM in other MECHANISM-

EDITORS and the MODEL-EDITOR

COLOR

· Use the Windows® color-picker

to select a color of the 3D-CAM 

TRANSPARENCY

· Use the slider to change the

TRANSPARENCY of the 3D-CAM.

DISPLAY CAM CONTOUR AS...

· PRESSURE-ANGLE

· CAM-PROFILE

When you show the 3D-CAM as PRES-

SURE ANGLE, the faces have a color-

code.

· Red identifies a high PRESSURE-

ANGLE

· Blue identifies a low PRESSURE-

ANGLE

MINIMUM / MAXIMUM

By default, the color-code scales to

the maximum and minimum values

of the PRESSURE-ANGLE

If you want to change the scale, use

the Maximum Value and Minimum

Value boxes.

AUTO-SCALE button

Click the AUTO-SCALE button to reset

to the maximum and minimum val-

ues again.

FLANK 1 VISIBLE, ROOT VISIBLE, FLANK

2 VISIBLE, TOP VISIBLE

385
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Show or hide each surface.

EXPORT tab

NOTE: From MD13.2, it is easier to save the 3D-CAM as a STEP file with the

Save button .

 SOLIDWORKS PATHS 

PREAMBLE: 

After you export a 3D-CAM to

SOLIDWORKS, copy the path and file-

name of the SOLIDWORKS document

into this dialog. Then, later, you can

use this dialog to open the CAD

model of the 3D-CAM again.

GET CAD PART PATH button

If the SOLIDWORKS document has a

Part name, click the button to copy

the path and file-name into the PATH

OF SLDPRT (CAM) box.

OPEN CAM PART button

In the future, click the button to open

in SOLIDWORKS the SOLIDWORKS doc-

ument that is in the PATH OF SLDPRT

( CAM ) box.

 SOLIDWORKS DATA TRANSFER 

PREAMBLE:

We recommend you use the Save but-

ton to save the 3D-CAM as a STEP file -

See Rebuild and Save buttons

Alternatively, you can use these buttons

to transfer the Cam-Blank, and the 3D-

CAM to SOLIDWORKS.

Before you click these buttons:

1. Open SOLIDWORKS 

2. Start and save a new

SOLIDWORKS part document

(.SLDPRT) and make sure it is the

active document.

TRANSFER CAM BLANK button

· We export for you the sketch of the Cam-Blank and its Axis-of-Rota-

tion to SOLIDWORKS.

394

394
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· We instruct SOLIDWORKS to use the Cam-Blank and Axis-of-Rotation

to add a revolved feature.

TRANSFER 3D-CAM button

· We export for you the points along each Rim and Hoop

· We instruct SOLIDWORKS to:

o use the points along the Rims to create an XYZ Curve features

o create surfaces from the Curve features for each Cam-Flank, and

the Top, and the Bottom faces.

o Knit the four surfaces together with the Knit surface feature.

CUT 3D-CAM INTO CAM-BLANK  button

· We instruct SOLIDWORKS to:

o Cut the Knit the surfaces feature from the Cam Blank revolved

feature.

o Hide the Knit-surfaces feature.

You may need to edit the Surface Cut feature to reverse the direction of

the cut

REBUILD and SAVE buttons

Rebuild and Save Cam buttons

Export tab

Rebuild

Click the  button:

· to recalculate the 3D-CAM

with updated parameters

· before you transfer the 3D-

CAM to SOLIDWORKS

· before you save the 3D-CAM

Save Cam

Click the  button:

· to save the cam as a STEP,

TXT, or a SLDCRV file-type.

Note:

STP file-type is the STEP file-type

and recommended ...

... you can open a STEP file-type in

most 3D-CAD programs.

.... see METHOD 1 below Export the

3D-Cam as a STEP file, below.

Rims along the Cam-Flanks (Purple),

the Top and Bottom (Orange), and

Points along each Rim.
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TXT and SLDCRV file-types

We save for you the XYZ coordinates

of each Rim to a different file.

In the image, left, there 20 Rims. We

save for you 20 files, one file for each

Rim.

Export 3D-CAM

METHOD 1: Export the 3D-Cam as a STEP file (RECOMMENDED)

IN MECHDESIGNER:

In the 3D-CAM DIALOG:

1. Click the  button  

2. Click the  button 

3. Select .stp as the file-type, and

save the cam - for example,

CAM.STP

SOLIDWORKS

STEP 1: Create a Solid from the 3D-

Cam surfaces.

1. Open Cam.STP file in

SOLIDWORKS® 

2. If you are prompted, do not do

“Import Diagnostics”

3. If “Import Diagnostics” starts

automatically, do NOT “At-

tempt to Heal ”

4. Save Cam.STP as a

SOLIDWORKS® Part (.SLDPRT)

file-type. E.g. Cam.SLDPRT

In SOLIDWORKS® you may also

need to:

1. Right-Click Cam.STP in the

Feature Manager

2. In the shortcut menu: Click

Dissolve Feature or Break

Link and click Yes, break

the link

AND:

"Dissolve Feature"
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1. Right-Click - again - the

CAM.STP in the Feature-

Manager

2. In the shortcut menu: Click

Import Diagnostics

In the Import Diagnostics dia-

log:

3. Disable Attempt to Heal All

button, and then close the

Import Diagnostics com-

mand.

AND:

1. Add end-caps to the four

surfaces of the 3D-Cam -

see Insert menu> Surface

> Boundary Surface 

2. Knit the 6 surfaces together

- see Insert menu > Sur-

faces > Knit. 

Select the check-box

“Create-Solid”, and the OK

button.

AND: 

1. Save Cam.STP as a

SOLIDWORKS® file-type.

E.g. Cam.SLDPRT. 

"Import Diagnostics"

"Save the Cam"

SOLIDWORKS: Cam-Blank

SOLIDWORKS

STEP 2: Open the Cam-Blank:

1. Open a prepared

SOLIDWORKS® part Cam-

Blank.SLDPRT. 

SOLIDWORKS: Insert Part

SOLIDWORKS

STEP 3: Add the 3D-Cam

(Cam.SLDPRT)...

2. Insert menu > Part ... ; select

“CAM.SLDPRT” 

3. Click the TICK at the top of the

SOLIDWORKS feature manager.
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SOLIDWORKS: Combine > Subtract

Cam.SLDPRT is now a feature and

a Solid Body (Cam<imported)

If the Cam-Part is on the Front Plane

(in MechDesigner) the Cam.SLDPRT

((3D-Cam) is usually in the correct ori-

entation relative to the Cam-

Blank.SLDPRT. 

If it is not, you must move the sketch (in

SOLIDWORKS®) of the Cam-Blank to the

correct Plane.

SOLIDWORKS

STEP 4: Cut the 3D-Cam from the

Cam-Blank... 

4. Insert menu > Feature > Com-

bine: 

a. Select Subtract as the

Operation Type and, 

b. In the Bodies to Com-

bine box, select 

i. Cam-Blank as the

Main-Body and 

ii. Cam<imported> as

the Body to Sub-

tract.

SOLIDWORKS: Result

RESULT:

You should see the Cam-Track in

the Cam-Blank. 

Note: It is possible that the Solid Body “Cam<imported>” and Cam-

Blank.SLDPRT are not defined on the correct Planes.

In this case, redefine the sketch-planes of “Cam.Blank” (easiest method) or

move “Cam<imported>” (more difficult to do)

To move the sketch, you can 

1. Select the sketch, CTRL+C, then pre-select a Plane or flat surface,

then CTRL V.
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To move Cam<imported>, do:

1. Insert menu > Feature > Move/Copy... and select Cam.SLDPRT as the

body to move. 

METHOD 2: Transfer the data directly to SOLIDWORKS

We do not usually recommend Method

2.

We recommend that you save the Cam

as a STEP file - see METHOD 1 - above.

STEP 1: In SOLIDWORKS®, 

Make sure the active document is

a Part document:

1. Open SOLIDWORKS® 

2. Add a new Part

3. Save the new Part

Click "Transfer Cam Blank"

STEP 2: In MechDesigner - Transfer

the Blank

In Export tab > SOLIDWORKS DATA

TRANSFER

1. Click the TRANSFER CAM BLANK

button 

We send for you the sketch-loop

and rotational-axis in the Cam-

Blank tab to SOLIDWORKS.

In the image to the left, you can

see in SOLIDWORKS: 

· 3DSketch1 which is the rota-

tional-axis 

· Revolve1 which is the feature

that revolves the sketch-loop

around the rotational-axis, into

the Solid.

See Getting Started Tutorials 6C for more

information.

Cam-Blank in SOLIDWORKS
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XYZ Curves, Surface, Knit features

Cam-Blank  and 3D-Cam

STEP 3: In MechDesigner - Transfer

the 3D-Cam 

1. Click the TRANSFER 3D-CAM

button

To make the transfer quicker,

hover to show a drop-down menu

in SOLIDWORKS®. 

For example, show the help menu

drop-down. 

We do not know why this makes

the transfer faster, but it works!

We control SOLIDWORKS to use the

data to:

1. Add the Points in each Rims to

create XYZ Curve entities.

2. Add four Surfaces features

a. two Cam Flanks; one Floor,

and one Top Surface

Note: You may need to add 'End-

Caps' to the Cams if the cam is an

indexing Cam.

3. Add the Knit-feature to knit the

Surfaces

3D-Cam cut into Cam-Blank

STEP 4: Click Remove Surfaces from

Blank button 

1. Click the REMOVE SURFACES

FROM BLANK button 

The 3D-Cam Surfaces Cut into

the Cam-Blank.

Wait! - you should now see the im-

age to the left

If you see ONLY the CAM TRACK

and not the Finished Cam (see im-

age below)

STEP 5: Save the Part In

SOLIDWORKS®  

1. Insert > Cut > With Surface 

2. Select the Knitted 3D-Cam

Surface - the last feature in the

Feature Manager. 
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3. Edit the Surface Cut feature in

SOLIDWORKS® and click the

Change Direction button. 

4. Hide the Knitted Surface fea-

ture of the 3D-Cam.

3D-Cam without Cam-Blank
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1.5.11.16 Dialog: 2D-Cam >

2D-Cam

2D-Cam - typical work-flow

Cam Work-flow

Action Help Topic

1. Add a 2D-Cam  see Add 2D-Cam

If the new 2D-CAM is one of a pair of Conjugate-Cams, or it is one flank of a

Groove-Cam:

 1.a. Add a CONJUGATE-CAM FB see Add Conjugate Cam FB  

 1.b. Edit the CONJUGATE-CAM FB to select

the two 2D-CAMS.

see Conjugate-Cam dialog

2. Select a 2D-CAM or a CONJUGATE-

CAM FB as the Power Source for the

kinematic-chain that includes the Fol-

lower 

see Configure-Power Source  

3. Review the 2D-CAM : Display, Proper-

ties, Roller-Life, Cam-Life, ...

see 2D-Cam dialog  

4. Add a Cam-Data FB see Add Cam-Data FB  

5. Edit the CAM-DATA FB to link it to a

2D-CAM - close the dialog 

see Cam-Data dialog

6. Connect wires from the output-connectors of the CAM-DATA FB to a GRAPH FB 

7. Analyze the 2D-CAM see Cam-Data dialog : Cam Ana-

lysis

8. Edit the CAM-DATA FB again to calcu-

late the Cam's Coordinates 

see Cam-Data dialog : Cam-Coordin-

ates

How to open the 2D-Cam dialog

To open the 2D-CAM DIALOG:

1. Double-click a 2D-CAM in the graphics-area or ASSEMBLY-TREE. 

OR

1. See How to Open a dialog . 

The 2D-CAM DIALOG is now open.

2D-Cam dialog

The 2D-CAM DIALOG has two formats:

SHORT format EXTENDED format

128

165

436

589

401

199

440

440

446

627
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The two tabs are:

Parameters

Display

The two NEW tabs are:

Roller Life

Cam Life

Save Cam Data button 

Save Cam Data
 

Click Save Cam Data at the top of the dialog to save the data to a CSV file-

type. The CSV file saves the parameters and the data at each step in the ma-

chine cycle. The CSV saves the Roller-Life and the Cam-Life details when you

enable Roller and Cam Lifetime. 

Time X-

Coordi

nates

 Y-

Coordi

nates

Contac

t

Force

Contact

Shear

Stress

Radius

of

Curvatu

re

Pres-

sure

Angle

Sliding

Velo-

city

Cam

Angu-

lar Ve-

locity

Inter-

feres?

s mm mm N MPa mm degree mm/s rad/s Y/N

IMPORTANT: Do NOT use the X-Y coordinates that you can save with this

dialog to manufacture the cam. Use a CAM-DATA FB to calculate and save the

Cam-Profile as XY-Point, BiArcs, and STEP file-type.

Note: 

If you open the file in Excel > Data tab > Data and Transform data group >

From Text/CSV file, use Unicode UTF-8 (65001) as the File Origin.

See also:

The output connectors of the CAM-DATA FB  for other analysis of the

2D-CAM.

2D-Cam - work-flow as a diagram

403

407

411

428

440
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1.5.11.17 -> Parameters tab

2D-Cam > Parameters tab

2D-Cam dialog > Parameters tab

Parameters tab

 CAM RANGE AND RADIUS...      
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Cam Range and Radius tab

 RADIAL CLEARANCE (MM)  Default = 0 

When RADIAL CLEARANCE   0, we calculate for you a Cam-Profile

that is offset from the true Cam-Profile.

Cam without Radial Clearance

Application:

· Groove-Cam: Clearance to fit

a Follower-Roller bearing in

the track of a Groove-Cam

between the Cam-Flanks,

· Conjugate-Cam: Clearance to

compensate for assembly tol-

erances with a Conjugate

Cam assembly - or you can

use one bearing with an ec-

centric.

· Rough-Cut: “Negative Clear-

ance” to export cam coordin-

ates for a rough-cut of a cam,

before its final cut.

Cam with 0.2mm Radial Clearance

Notes: 

a) You can also edit this parameter in the Cam-Coordinates dialog .

 

b) Barrel Follower-Roller bearings (typically a 500mm radius across

the width of the bearing) frequently have a relatively large neg-

ative tolerance bias (e.g.:  ). Even cutting a cam to

size may leave too much clearance.

 CAM R.O.C. 'SOFT-LIMIT' ( % )

446



405

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Note: default global setting: Application Settings  > General tab > Cam Ra-

dius Soft-Limits.

This parameter compares the absolute value of the 2D-CAM'S radius of

curvature (R.o.C.) with the radius of the Follower-Roller, at each point

along the 2D-CAM.

IF  

THEN the Cam-Profile is RED in the graphics-area.

Cam-Profile RED = Warning

Example:

CAM R.O.C. 'SOFT-LIMIT' ( % ) =

100%

The Cam-Profile is RED where

the Radius-of-Curvature is less

than the Roller's Radius.

YOU must make sure the 2D-CAM

does not have an under-cutting

problem.

 CAM START (default = 0) ;  CAM RANGE (default = 360)

By default, we calculate AND display 2D-CAMS from 0 to 360 of the

Master Machine Angle (MMA).

Edit these parameters to calculate and display the 2D-CAM over a dif-

ferent range of the MMA:

· CAM-START - the first point 

· CAM-START + CAM-RANGE - the last point

Cam Start <> 0; & Cam Range < 360

Examples:

· When a Cam rotates 2 × in a

machine-cycle: 

CAM START= 0 ; CAM RANGE =

180

· To calculate and display a

Slot-Cam from one end to the

other end, and only in one

direction

CAM START  ; CAM RANGE

 ENABLE LIFETIME, EDIT SAFETY-FACTOR  

341
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Enable Show Roller and Cam Lifetimes

þ SHOW ROLLER AND CAM LIFETIMES

If you enable SHOW ROLLER AND CAM LIFETIMES, we add two new tabs

to this dialog:

· ROLLER LIFE tab - see Roller Life  

· CAM LIFE tab - see Cam Life  

Also, 

In the Display tab - see Display tab > CAM DISPLAY OPTIONS   - we

remove GROOVE and NEGATIVE GROOVE, as it possible to calculate

the Life of the Inner or the Outer Flank.

Use these tabs: 

· to select a Roller calculate the life of the OUTER OR the INNER

cam-profile. 

· to 

· We display Force-Vectors. 

To hide Force-Vectors, see Forces toolbar > Force-Vectors - Dis-

play

SAFETY-FACTOR (CAM)

We apply for you the SAFETY-FACTOR (CAM) to the Cam's Contact-Stress

and the Roller's Equivalent Contact-Load

Cam Life tab

Dynamic Maximum Contact Stress ( ) = Max Contact-Stress ×

SAFETY-FACTOR (CAM)

Roller Life tab

SAFETY-FACTOR (Roller) = Safety Factor (Cam)
2

 Roller's Dynamic Equivalent Load ( ) = Equivalent Load × SAFETY

FACTOR (CAM) × SAFETY FACTOR (CAM) 

E.g.: If SAFETY-FACTOR (CAM) = 1.1 ; SAFETY-FACTOR (ROLLER) = 1.21

The SAFETY FACTOR 

The SAFETY-FACTOR should consider at least the following:

411

428

407

237
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· What drives the Cam-Shaft? Is it a constant speed servomotor or

a single-cylinder diesel engine?

· What does the Follower drive? Is it a paper-tucker, or a forging,

stamping press?

· What is the stiffness, rigidity, inertia, natural-frequency, of the

load - is the load at the end of a long, thin shaft, or a short, stub

spindle?

· What is the severity of the motion - does it have jerk continuity,

or acceleration discontinuity?

· How much backlash is there in the Cam and Follower mechanical

systems - does it use a precision Planetary gear-box with helical

gears, or forged spur gears? 

1.5.11.18 -> Display tab

2D-Cam > Display tab

2D-Cam dialog > Display tab

Display tab

 CAM VISIBILITIES 

There are two formats: SHORT and EXTENDED.

SHORT format

We show this format of CAM-VISIBILITIES when you do NOT enable

SHOW ROLLER AND CAM LIFETIMES in the Parameters tab.

Cam Visibilities when Show Roller and Cam

Lifetimes is NOT enabled

CAM DISPLAY OPTIONS :



408

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

¤ INNER - show the inside (internal or smaller) Cam-Profile only

¤ OUTER - show the outside (external or larger) Cam-Profile only

¤ GROOVE - show the INNER and OUTER Cam-Profiles 

¤ PITCH-CENTER - show ONLY the PITCH-CENTER path - see Note

You can enable also:

q PITCH-CENTER - show the INNER, or OUTER, or GROOVE, AND the

PITCH-CENTER path - see Note

q SHOW RADIUS-OF-CURVATURE - show the RADIUS-OF-CURVATURE at

the contact-point of the Follower-Roller on the Cam-Profile. 

EXTENDED format

We show this format of CAM-VISIBILITIES when you do enable SHOW

ROLLER AND CAM LIFETIMES in the Parameters tab.

We calculate the lifetime the INNER or the OUTER Cam-Profile.

Cam Visibilities when Show Roller and Cam

Lifetimes is enabled

CAM DISPLAY OPTIONS (WITH LIFETIME ENABLED)

¤ INNER - show the inside (internal or smaller) Cam-Profile only

¤ OUTER - show the outside (external or larger) Cam-Profile only

You can enable also:

q PITCH-CENTER - show the INNER, or OUTER, AND the PITCH-CENTER

path - see Note

q SHOW RADIUS-OF-CURVATURE - show the RADIUS-OF-CURVATURE at

the contact-point of the Follower-Roller on the Cam-Profile.

Note: 

The PITCH-CENTER is the path of the center-point of a Follower-Roller

bearing relative to the Cam-Part.  

The PITCH-CENTER path is meaningful only when the Follower-Profile is a

roller bearing.

 CAM DISPLAY OPTIONS 

408

408

408
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Display Cam-Profile as:

¤ CAM-PROFILE ONLY (default)

¤ MAXIMUM SHEAR-STRESS*

¤ CONTACT FORCE*
¤ PRESSURE-ANGLE

* Configure the Power Source  to calculate correctly.

CAM-PROFILE LINE THICKNESS: (default =1)

Edit the thickness of the Cam-Profile.

CAM-PROFILE COLOUR button

Edit the color of the Cam-Profile  in the graphics-area.

Different colors are useful when there are many Cam-Profiles in your

model.

TOP-TIP - rename the 2D-CAM element to the color you select for the Cam-

Profile. 

SHOW INSTANT CENTERS : For the kinemagicians! 

Without and With End-Caps

 Without End-Caps

 With End-Caps

589



410

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Enable SHOW END-CAPS check-box.

This check-box shows only when MechDesigner detects that the Cam-Pro-

file is “open”. 

A Cam-Profile is open if its start and end are not in the same place.

With Slot-Cam types, it is frequently possible to close the Cam-Profile with

End-Caps - see  image above.

Note: 

Slot-Cams can have “complications” that you must resolve before you

can export its Coordinates to SOLIDWORKS or other CAD.

Example Display Options:

¤ CAM PROFILE

Outer  and Inner  cams are continuous

lines.

Pitch-Center Path  is a dashed line.

¤  MAXIMUM SHEAR-STRESS 

 MAXIMUM SHEAR STRESS value is near

to the contact point

 Color of the cam agrees with the

color-bar

 Color-bar shows the range of the MAX-

IMUM SHEAR-STRESS 

Notes: 

MAXIMUM SHEAR-STRESS is below the sur-

face, at:

·  0.78 × Contact-Width for Line

contact

·  0.48 × Contact-Width for Ellipt-

ical contact

MAXIMUM SHEAR-STRESS is:

·  0.3 × Contact Stress for Line and

Elliptical contact
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¤ CONTACT FORCE 

 CONTACT FORCE value is near to the

contact point. 

 Color of the Cam and Color-Bar agree

with the CONTACT FORCE 

¤ PRESSURE ANGLE

 PRESSURE ANGLE is near to the contact

point.

 Color of the cam agrees with the

color-bar

 Color-bar is the scale of the PRESSURE

ANGLE

See also Pressure Angle

1.5.11.19 -> Roller Life tab

2D-Cam > Roller Life tab

Notes: 

Make sure the 2D-CAM or a CONJUGATE CAM FB is the power-source for

the Follower-Part - see Configure Power Source

The Follower-Roller bearing you select in this tab, controls the diameter of

the Follower-Roller in the model. 

Other names for a Follower-Roller bearing are: Track-Roller, Track-Fol-

lower, Cam-Follower, and others.

To Calculate the Roller Life, you must: 

PARAMETERS tab 

STEP 1: Enable SHOW ROLLER AND CAM LIFE 

STEP 2: Enter a SAFETY FACTOR (CAM)

( Parameters tab >  ENABLE LIFETIMES, EDIT SAFETY-FACTOR   ) 

Note: The SAFETY-FACTOR we apply to the Follower-Roller is equal to

the square of the SAFETY-FACTOR (CAM).

E.g: If SAFETY FACTOR (CAM) = 1.1, then the SAFETY-FACTOR (FOLLOWER-

ROLLER) = 1.21.

Top-Tip - Enter SAFETY-FACTOR = 1 to help you understand the results of

the Cam-Life and Roller Life.

ROLLER LIFE tab

589

405 403
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STEP 1: Select a Roller bearing manufacturer and Roller bearing

If you ENABLE ISO 281 MODIFICATION FACTORS:

STEP 2: Select a RELIABILITY FACTOR

STEP 3: Enter the OIL OPERATING TEMPERATURE

So that we can calculate the Operating Viscosity, you must also enter

these four parameters for the oil:

STEP 4: Enter OIL TEMPERATURE T1 and VISCOSITY AT T1 

STEP 5: Enter OIL TEMPERATURE T2 and VISCOSITY AT T2 

(Note, VISCOSITY AT T1 and VISCOSITY AT T2  are usually on the Oil's

Data-sheet.

STEP 6: Select the LUBRICATION TYPE

STEP 7: Select the CONTAMINATION LEVEL

Review the Roller's Lifetime

2D-Cam dialog > Roller Life tab 

Select a Manufacturer and Bearing Part-Number of Parameter

Roller Life tab

Select a Roller bearing.

STEP 1: Select a Follower-Roller bearing Manufacturer  
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1. Click the drop-down list box to select a Follower-Roller Bearing

Manufacturer

Available Manufacturers: SKF, INA/FAG, KOYO, NSK, THK

When you select a manufacturer, the bearing Part-Numbers and their

parameters show in the table .

STEP 2: Select a Roller Bearing from the table  

Note: Click a Header to sort by that Header. For example, click OD to

sort by Outside-Diameter.

1. Click a Part-Number from the table 

Cam-Follower Radius

& Follower-Roller Part- Number

IMPORTANT NOTES 

A. Before you select a Roller in the list of bearings, you must use the

PART-EDITOR to add a CIRCLE and add a Radius for the CIRCLE.

B. When you select a Roller in the list of bearings, the Radius dimen-

sion of the CIRCLE changes IMMEDIATELY to the OD/2 of the bear-

ing you select (± Radial Clearance ). 

C. The Part-Number of the Roller is in the graphics-area under the Ra-

dius dimension - see image above

D. The Radius dimension of the CIRCLE sketch-element that represents

the Roller is now read-only. 

To change the Radius of the Roller:

· Select a different Part-Number for the Roller bearing

or 

· Disable Show Roller and Cam Lifetimes check-box , and then

edit the Radius dimension with the PART-EDITOR.

You can see immediately the Basic Rating Life,  in the L10 FOR ROLLER:

PART NUMBER  separator.

 ISO 281 PARAMETERS 

To see these factors, select “Enable the ISO 281 Modification Factors”

We calculate for you the  and  modification factors as you enter the

parameters below.

403

405
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ISO 281 Modification Factors

 Reliability Factor (a1)

· Reliability Factor: Use the drop-down to select a percentage for the

bearing reliability.

The Reliability Factors in the drop-down list (90 to 99.95%) are those

recommended in ISO 281. 

or

· Reliability Factor: as a percentage. 

In this case, we find for you the Reliability Factor nearest to a Reliabil-

ity Factor as recommended in ISO 281.

 Operating Viscosity

The  viscosity of the oil's  (or base-oil in a grease) at the operating temper-

ature is function of its Viscosity Grade and Viscosity Index.

We calculate for you the viscosity at the operating temperature when you

enter these five parameters:

· Operating Temperature, 

· Temperature  

· Viscosity  at Temperature 
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· Temperature  

· Viscosity  at Temperature 

Rules:

·  and 

Notes: 

If you know the ISO VG of the oil, you can enter:  and

Lubricating Oil and Grease datasheets usually provide the Viscosity at

 and at .

 Lubrication Type 

Select one of these lubrication methods:

¤ OIL FILTERED ON-LINE: Circulating oil lubrication with the oil filtered

on-line before being supplied to the bearings

¤ OIL FILTERED OFF-LINE: Oil bath lubrication, or circulating oil lubric-

ation with off-line filters (or without filtration)

¤ GREASE.

ISO 281 does not consider Oil-Mist Lubrication.

 Contamination Factors for each Lubrication-Type

OIL FILTERED ON-LINE

Select the Filtration Ratio, , from the drop-down list box, 

The operating, or actual, Filtration-Ratio of the oil should be as high, and

if not higher, than the Filtration-Ratio you select. 

·  - the particle size of the contamination, calibrated to ISO 11171

·  - filtration ratio at contamination particle size 

The designation (c) signifies that the particle counters — of particles of

size  — shall be APC (automatic optical single-particle counter)

calibrated to ISO 11171.

Also, the oil system shall have cleanliness within the range indicated by

the cleanliness code according to ISO 4406.

Filtration Ratio and Filtration Code

 ; ISO 4406 Code; -/13/10

; ISO 4406 Code; -/15/12

; ISO 4406 Code; -/17/14

; ISO 4406 Code; -/19/16

OIL FILTERED OFF-LINE
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Select the Cleanliness Codes from the drop-down list box that represents

the anticipated operating conditions, according to ISO 4406.

Filtration Code

ISO 4406 Code; -/13/10

ISO 4406 Code; -/15/12

ISO 4406 Code; -/17/14

ISO 4406 Code; -/19/16

ISO 4406 Code; -/21/18

GREASE 

Select the Level of Contamination from the drop-down list box that best

represents the operating conditions.

Level of con-

tamination Operating Conditions

High cleanli-

ness

Clean assembly with careful flushing; good sealing in rela-

tion to operating conditions; re-greasing carried out con-

tinuously or at short intervals

Bearings, greased for life with effective sealing capacity in

relation to operating conditions - for example, sealed

bearings

Normal clean-

liness

Clean assembly with flushing; good sealing in relation to

operating conditions; re-greasing according to manufac-

turer’s specification

Bearings, greased for life with proper sealing capacity in

relation to the operating conditions - for example, shiel-

ded bearings

Slight to typ-

ical contamin-

ation

Clean assembly; moderate sealing capacity in relation to

operating conditions; re-greasing according to manufac-

turer’s specifications

Severe con-

tamination

Assembly in workshop; bearing and application not ad-

equately washed after mounting; poor sealing capacity in

relation to operating conditions; re-greasing intervals

longer than recommended by manufacturer

Very severe

contamination

Assembly in contaminated environment; inadequate seal-

ing; long re-greasing intervals

 ROLLER LIFE :  BEARING P/N                                  

We calculate these parameters for you when you select a Roller, and/or en-

able ISO 281 factors.



417

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Life for the seleced Roller(Cam-Follower Bearing)

Basic Rating Life, 

This states that if the bearing load, , is equal to the Basic Dynamic

Load Rating, , then there is a 90% reliability that the bearing survives 1

million rotations, if manufactured with commonly used high quality ma-

terial, of good manufacturing quality, and operating under conventional

operating conditions. 

Basic Rating Life (millions of rotations)

Operation in Hours

We also calculate the Roller life as operating hours.

Basic Rating Life (hours)

 

 Operation in Years

We also calculate the Cam-Life as operating years. One year is 8760

hours (24hours, 365 days).

Basic Rating Life (Years)

Basic Load Rating (at 90% reliability) (millions of revolu-

tions)

Basic Load Rating (at 90% reliability) (operating hours)

Basic Load Rating (at 90% reliability) (operating years)

Basic dynamic load rating (kN) of the Roller bearing

Equivalent dynamic bearing load ( kN ) (See image above

: Equiv Load)
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The load continuously changes as the Cam rotates.

Thus, we calculate for you an equivalent load.

Roller rotating speed (RPM)

The speed continuously changes as the Cam rotates.

Thus, we calculate for you an equivalent speed.

Exponent of the life equation

= 3 for ball bearings

=10/3 for roller bearings

Modified Rating Life, 

Modified Rating Life - as per ISO 281 

We must calculate for you:

·  -  a factor for Reliability - see below

·  - a factor calculated with a System Approach - see be-

low

see above for  

see below for  and  factors.

Operation in Hours

We also calculate the Roller life as operating hours.

Modified Rating Life (Hours)

 

 Operation in Years

We also calculate the Roller-Life as operating years. 

One operating year is 8760 hours (24hours, 365 days).

Modified Rating Life (Years)

Basic Life Rating (at 90% reliability) (millions of revolu-

tions)

Modified Life Rating (at  reliability) (millions of

revolutions)

Modified Life Rating (at  reliability) (operating

hours)

Basic Load Rating (at 90% reliability (operating years))

419

419



419

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Life modification factor for Reliability - see below

Life modification factor for Systems Approach - see be-

low

Basic dynamic load rating (kN) of the Roller bearing

Equivalent dynamic load ( kN )

The load usually continuously changes as the Cam ro-

tates. Thus, we calculate for you an equivalent load.

Mean roller rotating speed

The speed of a Follower-Roller continuously changes

as the Cam rotates. Thus, we calculate for you its mean

speed.

Exponent of the life equation

= 3 for ball bearings

=10/3 for roller bearings

Operating Life

The actual operating life is the life achieved by the bearing. It may differ

significantly from the life we calculate.

It is not possible to calculate the actual operating life, as there is a

range of possible installation and operating conditions. One method to

estimate the operating life is to compare the installation and operating

conditions with similar applications.

Possible factors that influence the Operating Life

· deviating operating data

· misalignment between the shaft and housing

· insufficient or excessive operating clearance

· contamination

· insufficient lubrication

· excessive operating temperature

· oscillating bearing movement with small swivel angles

· high vibration and false brinelling

· high shock loads (static overloading)

· damage to the bearing when it is installed

Bearing Life Modification Factors

Life Modification Factors for Reliability, 

The Reliability Factor is constant for all application conditions.

419

419
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The drop-down list has the standard Reliability Factor percentages (90

to 99.95%), as given in ISO 281. 

Modified Life Rating (at  reliability) (millions of revolutions)

Reliability
Failure

Probability  Factor

% % - -

90 10 1

95 5 0,64

96 4 0,55

97 3 0,47

98 2 0,37

99 1 0,25

99,2 0.8 0,22

99,4 0.6 0,19

99,6 0.4 0,16

99,8 0.2 0,12

99,9 0.1 0,093

99,92 0.08 0,087

99,94 0.06 0,080

99,95 0.05 0,077

Life Modification Factor: a System Approach, 

The Life Modification factor, , is a complex interaction between Oil or

Grease Viscosity Grade, Filtration, Contamination, Oil Operating Temperat-

ure, the Fatigue load capacity of the Roller, the rotational-speed of the

Roller, and the diameter of the Roller.

The equations given in ISO 281 to calculate these factors are empirical, com-

plex, and interrelated. All of the factors, except , are a function of the

bearing speed and bearing load. In a cam mechanism, the speed and load

on the roller continually change. Therefore, we calculate for you the factors

at each step and integrate them to find their equivalent values.

Life modification factor, using a systems approach

Fatigue Limit of Bearing (N)

Dynamic Load (N)

Viscosity Ratio (-)

Contamination Factor (-)

Fatigue Limit of Bearing,  ( )
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ISO 281 defines the fatigue load, , for a bearing as the load below which

metal fatigue does not occur. 

With poor lubrication, or contamination of the lubricant, the bearing can fa-

tigue at loads which are significantly below the fatigue limit, .

For the fatigue limit to be a valid value, the lubricant film must fully separate

the rolling elements from the raceways and that dents from contaminants

from handling do not exist on the rolling surfaces.

The contamination factor,  takes into account how the level of solid

particle contamination of the lubricant influences the calculated bearing fa-

tigue life. The particles cause indentations in the rolling surfaces of the bear-

ing, and these indentations increase the local contact stress, which reduces

the expected fatigue life.

·  means perfectly clean conditions without any indentations.

·  means severely contaminated conditions resulting in pro-

nounced indentations.

In the SKF rating life model, contamination, designated by the contamina-

tion factor,  , acts as a stress raiser, thereby reducing the fatigue load limit

to .

We then compare the reduced fatigue load limit, , to the actual bear-

ing load, , to give a fatigue resistance value of  

· Conditions that are clean and a load that is less than the fatigue load

limit give a high fatigue resistance value.

· Conditions that are contaminated and a load that is more than the fa-

tigue load limit give a low fatigue resistance value.

The stress-raising influence of contamination on fatigue depends on a num-

ber of parameters, including: bearing size, relative lubricant condition, size

and distribution of solid contaminant particles, and types of contaminants

(soft, hard, etc.). Therefore, it is not meaningful to enter a value for the con-

tamination factor  that has general validity.

If a catalog does not list the Fatigue Load Limit, and the mean bearing dia-

meter is less than . (nearly all Follower-Roller Bearings are less

than ), then we use this approximation:

Roller and needle bearings, with a Mean Diameter <

100mm.

Ball bearings, with a Mean Diameter < 100mm

Mean Diameter = (Outside Diameter + Inside Diameter) / 2 

Viscosity Ratio, 

The Viscosity Ratio, , indicates the quality of the lubricant film formation.
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The lubricant-film separates the raceway and rolling-elements. It is ex-

pressed as:

Reference Kinematic Viscosity - a function of the

bearing's diameter and its rotating speed.

Kinematic Viscosity at operating temperature - func-

tion of oil viscosity grade and temperature.

Note 1: Viscosity Ratio,  , assumes that surface finish is for good quality

Follower-Roller bearings. 

Note 2: An approximate relationship between Film Thickness Ratio  and

Viscosity Ratio, , is: 

 

Film Thickness Ratio - the ratio of the actual film

thickness to the composite roughness of the rolling

elements and raceway surfaces*. This ratio must as-

sume a “standard” surface finish the raceways and

rolling elements.

Minimum film thickness

RMS Roughness of the Rolling-Elements, or

Rolling-Raceways.

Notes: 

A Viscosity-Ratio < 0.1 is outside of the limits of ISO 281. It is near to

metal-to-metal contact.

A Viscosity-Ratio > 4 is the maximum that can be used by ISO 281. 

ISO 281 states that a Viscosity-Ratio = 4 if it is actually you calculate it to

be greater than 4. 

A Viscosity-Ratio > 4 is getting too high for bearings. The needles or

balls may slide and refuse to roll in the 'thick-oil', or the shearing of the

oil may churn and increase the oil and bearing temperatures. 

A Viscosity-Ratio in the range of  is approximately ideal.

Reference Kinematic Viscosity, 

The Reference Kinematic-Viscosity,  (sometimes called the Rated, or Re-

quired Viscosity) is the viscosity that is required to separate the surfaces, of
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the rolling elements and races in the Follower-Roller bearing.
.

It assumes that the oil is a mineral oil, with a Viscosity-Index of approxim-

ately 100.

Synthetic oils can be used. 

 if 

 if 

  - inside diameter of Follower-Roller 

  - outside diameter of Follower-Roller

Kinematic Viscosity at operating temperature, 

We calculate for you the Viscosity,  , at the Operating Temperature,  ,

from the Viscosity at two other temperatures. 

Nearly always, the two other temperatures are  and , but not ne-

cessarily.

The lubricant's data-sheet usually specifies the Viscosity at  (  )

and  (  )

You must enter all four parameters in the dialog: 

· 2 x temperature:  and   

· 2 x viscosity:  and  at temperature  and 

· Operating-Temperature: .

We calculate the Viscosity at the Operating-Temperature, .

Contamination Factor, 

If a contaminant particle moves to the inside of a bearing the rollers (or

balls), outer-race, and inner-race are prone to dent because of the small in-

ternal bearing clearances and the small rolling radii of the rollers (or balls).

An indent leads to localized stress, which will decrease the life of the bear-

ing.

The contamination may even prevent the rollers (or balls) rotating.

The contamination factors that reduce the lifetime of a Follower-Roller

bearing are a function of the:

· diameter of the Follower-Roller 

· lubricant film thickness (viscosity ratio, )

· size, type, and hardness of the particle contaminant. 

Guide values for the contamination factor are in the table below. They are

typical levels of contamination for well lubricated bearings.

Contamination and Lubrication Method.
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We can find for you the contamination factors with these lubrication meth-

ods:

· Circulating oil lubrication with the oil filtered on-line before it is

supplied to the bearings. 

· Oil bath lubrication or circulating oil lubrication with off-line fil-

ters.

· Grease lubrication.

Circulating oil lubrication with On-Line Filtration, before being supplied to

the bearings.

In order to achieve the calculated bearing rating life, the bearings must

be operated both from the beginning and after oil changes under the

assumed conditions. It is therefore important to clean the bearings and

the application thoroughly before mounting. It is also important to fil-

ter the oil before it is introduced into the system. The filter used for this

purpose should be at least as effective as the filter in the system itself.

For recirculating oil lubrication with continuous oil filtration, the con-

tamination factor,  can be determined by means of equations (or

diagrams). The diagram or equation to be used is selected on the basis

of the filter retention rate according to ISO 16889 and the oil

cleanliness code according to ISO 4406. The index (c) is the (automatic-

ally counted) particle size in  according to ISO 1171.

Oil bath Lubrication, or Recirculating Oil Lubrication, with Off-Line Filtra-

tion.

For oil bath lubrication or recirculating oil lubrication with offline filtra-

tion, the contamination factor,  , can be determined by means of

equations or diagrams. You base which diagram you select on the oil

cleanliness code. according to ISO 4406.

The filtration ratio , with particle size  in  according to

ISO 16889[6], is the most influencing factor. The contamination level

corresponds mainly to the condition of the oil before it passes the on-

line filter.

NOTE

Research concludes that it is difficult to accurately find the oil cleanliness

especially if you analyze very clean oils. It is easy to pollute an oil-

sample, with oil additives that precipitate into the oil and particle calcu-

lation.

Grease Lubrication, Contamination Factors

It is much easier to seal a bearing that is lubricated with a grease than

seal a machine that is lubricated with an oil. It is easier to design the

machine.
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With grease-lubricated Follower-Roller bearings, we differentiate

between bearings:

· that you (or the OEM) lubricate one time for the lifetime of the

bearings 

· that you must re-lubricate. 

In general terms lifetime lubrication does not depend on the bearing

but on the requirements of the particular application.

For grease lubrication, you must estimate the Contamination Level from

the descriptions below.

Step 1: Consider the potential contamination from the application.

For example, is the Follower-Roller running in an open cam-track

near to the stack of case-blanks in a Case-Packer? If yes, I would use

the Severe Contamination. 

Step 2: Find the Viscosity Ratio,  - see above

Step 3: Find mean diameter,  - see above

Step 4: Calculate the level of Contamination, 

The contamination level can be very low with open, small bearings.

Therefore, you should at least purchase Shielded Follower-Roller bear-

ings if the diameter is less than 40mm.

Simplified Values of Oil Contamination Factor , 

Contamination Level

Extremely high cleanliness: 

Particle size less than lubricant

film thickness, laboratory condi-

tions

1 1

High Cleanliness: 

Oil filtered with extremely fine fil-

ter

Equivalent to bearing greased for

life with good seals.

Very clean mounting with careful

flushing, Continuous re-lubrication

0.8 to 0.6 0.9 to 0.8

Normal Cleanliness: 

Oil filtered with fine filter. 

Equivalent to bearing greased for

life and shielded

0.6 to 0.5 0.8 to 0.6

Slight Contamination:

Oil is slightly contaminated.
0.5 to 0.3 0.6 to 0.4
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Contamination Level

Typical Contamination:

Conditions typical of bearings

without integral seals, course fil-

tering, wear particles and ingress

from surroundings

0.3 to 0.1 0.4 to 0.2

Severe Contamination: 

Bearing Environment heavily con-

taminated, Bearing inadequately

sealed

0.1 to 0 0.1 to 0

Very high or Extremely high con-

tamination
0 0

Contamination Level for Grease Lubrication

High Cleanliness: 

Very clean assembly, careful flushing; very good sealing system rel-

ative to the operating conditions; re-greasing is continuous or at

short intervals

Sealed bearings that are greased for life, with appropriate sealing

capacity for the operating conditions.

Normal Cleanliness: 

Clean assembly; good sealing system relative to the operating con-

ditions; re-greasing according to manufacturer’s specifications

Shielded bearings, greased for life with proper sealing capacity for

the operating conditions,

Slight to Typical Contamination:

Clean assembly; moderate sealing capacity relative to the operating

conditions; Re-greasing according to manufacturer’s specifications

Severe Contamination: 

Assembly in workshop; bearing and application not adequately

washed prior to mounting; ineffective seal relative to the operating

conditions; re-greasing intervals longer than recommended by man-

ufacturer

Very Severe Contamination

Assembly in contaminated environment; inadequate sealing system;

too long re-greasing

intervals

Contamination Levels, ISO 4406 (Contamination of Oil)

The table below provides scale values as a function of particle concentration

(particles/ml) - it is from ISO 4406
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A three number code defines the amount of contamination for three particle

sizes: 4, 6, and 14 Each time a number increases by 1, the quantity of

particles is doubled for a particular particle size.

Example: ISO code = 21 / 19 / 17 

This Contamination Class describes a fluid containing:

· between 10,000 and 20 ,000 particles of 4 per 1 ml sample

· between 2,500 and 5 ,000 particles of 6 per 1 ml sample

· between 640 and 1 300 particles of 14 per 1 ml sample

If the leading number is missing, then that size of particle is not counted.

Scale Number More than Up to

28 1,300,000 2,500,000

27 640,000 1,300,000

26 320,000 640,000

25 160,000 320,000

24 80,000 160,000

23 40,000 80,000

22 20,000 40,000

21 10,000 20,000

20 5,000 10,000

19 2,500 5,000

18 1,300 2,500

17 640 1,300

16 320 640

15 160 320

14 80 160

13 40 80

12 20 40

11 10 20

10 4 10

9 2.5 4

8 1.3 2.5

7 0.64 1.3

6 0.32 0.64

5 0.16 0.32

4 0.08 0.16

3 0.04 0.08

2 0.02 0.04

1 0.01 0.02

0 0 0.01
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1.5.11.20 -> Cam Life tab

2D-Cam > Cam Life tab

To Calculate Cam Life, you must : 

Parameters tab

STEP 1: Enable Show Roller and Cam Life 

STEP 2: Enter a Safety Factor (Cam)

See Parameters tab >  ENABLE LIFETIMES, EDIT SAFETY-FACTOR   

Cam Life tab

STEP 1: Enable / Disable “Allow Pitting to ~15% of the Cam Surface”

STEP 2: Select a Steel Category, Heat-Treatment, and Steel Quality

for the Cam

STEP 3: Enter the Steel's Hardness as HV, HB, or HRC, within the

Minimum and Maximum Hardness Limits

Review the Cam's Lifetime

2D-Cam dialog > Cam Life tab

Cam Life: tab

 ENABLE PITTING FACTOR 

Allow Pitting to ~15% of Cam Surface?

These steels categories allow pitting: Categories 1, 2, 3, 4, 6, 8, 9, 10, and

11 (See Cam Life Results below) 

These steel categories allow so-called non-progressive pitting, in which a

small amount of pitting occurs, and then it stabilizes. 

If you allow up to ~15% pitting, the cam-life is extended. 

When to allow pitting?

No: In mission-critical applications, for example manned flight.

No: if this is a new and important application.

405 403
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Maybe: You have experience with the application and pitting has not

occurred.

Yes: You have experience with the application and pitting has occurred

and then stabilized.

 CAM MATERIAL AND HARDNESS 

Enter the Hardness as HB, HV, or HRC

Select a Steel Category, Heat-Treatment, and Quality

 There are 14 Steel/Cast-Iron and Heat-Treatment categories, each with 3

Quality levels (ML,MQ,ME) - identical to the ISO 6336-5 Standard for Gears.

STEELS CATEGORIES AND HEAT-TREATMENT - see Example steels of each

Steel Category .

1. Normalized, Low-Carbon Wrought-Steelsa - St 

2. Normalized, Low-Carbon, Cast-Steelsa  - St(cast)

3. Black Malleable Cast-Iron - GTS (perl)

4. Nodular Spheroidal Cast-Iron - GGG ( e.g.  in image above )

5. Grey Cast-Iron - GGG

6. Through-Hardened Wrought Carbon-Steelb - V

7. Through-Hardened Wrought Alloy-Steelsb - V

8. Through-Hardened Cast Carbon-Steel - V(cast)

9. Through-Hardened Cast Alloy-Steel - V(cast)

10. Case-Hardened Wrought-Steelsc - Eh

11. Flame or Induction-Hardened Wrought or Cast-Steels (IF)

12. Nitrided Nitriding Wrought-Steelsd - NT(nitr)
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13. Through-Hardened Nitrided-Steelb - NV(nitr)

14. Through-Hardened Nitro-Carburized Wrought-Steele - (NV (nitr-

car) 

a - ISO 4948-2 (ISO10020) Part 2 - Classification of unalloyed and alloy

steels according to main quality classes and main property or application

b - ISO 683-1 - Heat-treated Steels, alloy steels and free-cutting steel Part 1

- Quenched and Tempered unalloyed steels

c - ISO 683-11 - Heat-treated Steels, alloy steels and free-cutting steel Part

11 - Wrought Case Hardening steels 

d - ISO 683-10 - Heat-treated Steels, alloy steels and free-cutting steel Part

1 - Quenched and tempered unalloyed steels

e - ISO 683-1, ISO683-10, or ISO 683-11

STEEL QUALITY

The Steel Quality Standards are:

ML  - Modest demands on the material quality and the heat treatment

process.

MQ - Material Quality and Heat-Treatment standards met by experi-

enced manufacturer.

ME  - High degree of reliability of Material Quality and Heat-Treatment

process.

The requirements to be met for different steel qualities include: Chemical

Analysis, Melting Practice, Surface Crack Detection after machining, and

Hardness. Sometimes, to confirm the analysis a test piece is prepared and

heat-treated together with cam - See ISO 6336-5.

Enter the Steel's Hardness within the High and Low Hardness Lim-

its

 Enter a Hardness value in the HB, HV, or HRC hardness scale - see im-

age above

The default Hardness is the average of the Upper and Lower Hardness

Limits

The Hardness you enter must be within the Upper Hardness Limit and

Lower Hardness Limit. The limits are specified in ISO 6336-5.

Lower H Limit   Actual Hardness (HB, HV, HRC)   Upper H Limit

In the example above, you can enter a Hardness in the range of 175-300HB,

178-315HV, or 9-32HRC.

When you enter a Hardness value under one of the Hardness Scales, the

other two Hardness Scales update automatically.

Cam-Life Results
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 INNER / OUTER  FLANK + STEEL CATEGORY # , QUALITY, AND CAT-

EGORY NAME  

The Orange Separator indicates the Flank, Steel Category, Steel Quality,

Heat-Treatment Type and/or Steel-Type with Steel Acronym are indic-

ated in the separator.

E.G:  INNER FLANK: 004 ML NODULAR / DUCTILE / SPHERICAL CAST IRON (GGG) 

Flank : Inner

Steel Category : 004

Steel Quality : ML

Steel Name : Nodular / Ductile / Spherical Cast Iron

Steel Acronym : GGG

THE RESULTS ARE:

Maximum Contact Stress (MPa - Mega-Pascals) 

When you select the Follower-Roller - see Roller-Life tab  - we can

use the combined Geometry and Materials of the Cam and the Fol-

lower-Roller to calculate the maximum contact-stress.

Maximum Dynamic Contact-Stress - (MPa - Mega-Pascals) 

Maximum Contact-Stress × Safety Factor - see Parameters tab > Enable

Lifetime, Edit Safety-Factor

Maximum Allowable Contact Stress 

A property of the Steel-Category, Heat-Treatment, and Steel Quality

that you select, together with the Surface Hardness that you enter - see

above Cam Materials and Hardness   

Dynamic / Allowable (-)

Ratio of Maximum Dynamic Contact-Stress : Maximum Allowable

Contact Stress.

We apply the ratio to the Y-axis on the plot of Life(X-axis) vs Ratio of

Dynamic/Allowable(Y-axis) - see plot below. Each Steel Category has a

different plot.

Depth of Max Shear Stress (mm)

411

405

429
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The Maximum Shear-Stress is below the surface. The Depth of Max-

imum Shear-Stress is a function of the size and shape of the contact

between the Follower-Roller and Cam-Profile.

Recommended: Minimum Depth of Surface-Hardness > ~2 × Depth

of Maximum Shear-Stress.

Maximum Shear Stress

Approximately 0.78 x Maximum Contact-Stress (depending on the con-

tact geometry).

Dynamic Shear-Stress

Maximum Shear-Stress x Safety-Factor - see Parameters tab > Enable

Lifetime, Edit Safety-Factor

S-N (Log-Log) Curves for different Steel Categories (based on ISO 6336)

Y-axis = Maximum Dynamic Contact-Stress/Allowable Contact-Stress of Steel,

Quality, Hardness

X-axis = Life in Number of Machine-Cycles

Cam Lifetime:

Y (in graph below) = Maximum Dynamic Contact Stress  Allowable

Contact Stress 

Y=1, Cam Lifetime = 1. 

1 Life of Steel Categories in Graph 1: 1.0 × 10^9 cycles, 

1 Life of Steel Categories in Graph 2: 5.0 × 10^7cycles; 

1 Life of Steel Categories in Graph 3: 5.0 × 10^6 cycles

1 Life of Steel Categories in Graph 4: 5.0 × 10^6 cycles

403
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Y > 1, Cam Lifetime is reduced.

Y < 0.85, Cam Lifetime is infinite (Greater than 10^10 cycles, 10 billion

cycles)

Life < 10^5 cycles, fatigue does not apply.

Cam-Life, N (Millions of Cam Rotations) 

Millions of Cycles, 99% reliability. 

Maximum - 10,000,000,000 (1010 rotations / 10 billion)

Cam-Life, Hrs.

Number of Hours, based on Millions of Cam-Life Rotations and

Machine Speed (RPM).

Cam-Life, Yrs.

Number of Years, based on 8760 hours per year.

Steel Categories and Example Steels (mostly ISO 6336-5)

Examples Steels that PSMotion have assigned to the different steel and cast-iron

categories. You must check that your steel is in the correct-category.

STEEL / CAST

IRON CATEGOR-

IES

MATERIAL

TYPE  (AB-

BREVI-

ATION)

STEEL

QUAL-

ITY

HARD-

NESS

RANGE

EXAMPLE STEELS

NOT FROM ISO 6336

Normalized Low

Carbon Steels 

& 

Cast Steels (St

(cast))

Wrought,

normalized,

Low Carbon

Steels

(St)

ML, MQ
110 - 210

HB St50.2, 1.0050, E295

St60-2, 1.0060, E335

St70-2, 1.0070, E360ME
110 - 210

HB

Cast Steels 

(St (cast))

ML, MQ
140 - 210

HB
GE200, 1.0420

GE240, 1.0446

GE300, 1.0558ME
140 - 210

HB

Cast Irons

Black Malle-

able Cast

Iron (pearl-

itic struc-

ture)

(GTS (perl))

ML, MQ
135 - 250

HB EN-GJMB-350-10 : HB 150

EN-GJMB-500-5 :  HB 165-215

EN-GJMB-600-2 : HB 195-245

EN-GJMB-700-2 : HB 240-290
ME

175 - 250

HB

Nodular

Spheroidal

Pearlitic 

Bainitic Fer-

ritic Cast

Iron

(GGG (perl,

bai, ferr))

ML, MQ
175 - 300

HB EN-GJS-400-15 : HB 135-180

EN-GJS-500-14 : HB 170-215

EN-GJS-600-10 : HB 190-230

EN-GJS-700-2 : HB 210-305

EN-GJS-800-2 : HB 240-335

EN-GJS-900-2

ME
200 - 300

HB

Grey 

Cast Irons
ML, MQ

150 - 240

HB

EN-GJL-200, GG20

EN-GJL-300, GG30
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STEEL / CAST

IRON CATEGOR-

IES

MATERIAL

TYPE  (AB-

BREVI-

ATION)

STEEL

QUAL-

ITY

HARD-

NESS

RANGE

EXAMPLE STEELS

NOT FROM ISO 6336

(GG)
EN-GJL-350, GG35

EN-GJL-400, GG40
ME

175 - 275

HB

Through-Hardened

Wrought Steels

Nominally >0.2%C

Carbon

Steels (V)

ML
135 - 210

HV C40E, 1.1186

C45E, 1.1191, 1045, 
MQ

135 - 210

HV

ME
135 - 210

HV

Alloy Steels

(V)

ML
200 - 360

HV

42CrMo5, 1.7225MQ
200 - 360

HV

ME
200 - 390

HV

Through-

Hardened 

Cast Steels

Nominally > 0.2%C

Carbon

Steels 

(Low to

Medium)

 (V (cast))

ML, MQ
130 - 215

HV

100Cr6

ME
130 - 215

HV

Alloy

Steels 

(V (cast))

ML, MQ,

ME

200 - 360

HV

200 - 360

HV

G25CrMo4, 

G34CrMo4, 

G35CrNiMo6-6

G42CrMo4 :1.7231

Case Hardened 

Wrought Steels

< 0.25%C

(Eh)

ML
600 - 800

HV

C14E/C10R/C15E/C15R/

17Cr3 (1.7016, AISI 5115)

16MnCr5 (1.7131), 5115, 8620

18CrMo4

20MnCr5 (1.7147)

15NiCr13 (1.5752)

17CrNi6-6 (1.5918)

18CrNiMo7-6 (1.6587)

20NiCrMo2-2, 

22CrMoS3-5

18NiCrMo5

17NiCrMo6-4,

EN36 - 1.5752 - 14NiCr4,

SAE8620, 

14NiCrMo13-4, AISI 9310, 1.6657

655M13

EN39B(835M15), 15NiCrMo16-5,

SNCM815.

MQ
660 - 800

HV

ME

660 - 800

HV

(58-

64HRC)

Flame or 

Induction

Hardened 

>0.25%C

(IF)

ML, MQ,

ME

485 - 615

HV

34Cr4 (1.7033) (530M32)

41Cr4, 34CrNiMo6

43CrMo4(1.3563)
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STEEL / CAST

IRON CATEGOR-

IES

MATERIAL

TYPE  (AB-

BREVI-

ATION)

STEEL

QUAL-

ITY

HARD-

NESS

RANGE

EXAMPLE STEELS

NOT FROM ISO 6336

Wrought or Cast

Steels

500 - 615

HV

500 - 615

HV

Nitrided Wrought

steels

Through Hardened,

Nitrided

Nitriding

Steels

(NT(nitr.))

ML
650 - 900

HV EN40B, EN41B, 

Nitralloy, N135M

31CrMo12, 42CrMoV12,

38CrAlMo

31CrMoV9. 905M39

MQ
650 - 900

HV

ME
650 - 900

HV

Through

Hardening

Steels

NV(nitr.))

ML, MQ,

ME

450 - 650

HV

450 - 650

HV

450 - 650

HV

32CrMoV13 

(Quench And Hardened)

Wrought Steels 

Nitro-Carburized

Through

Hardening

Steels

(NV(nitro-

car)

ML
300 - 650

HV

100CrMnSi6-4 (CarboNitriding)MQ
300 - 450

HV

ME
450 - 650

HV

ML  - limited demands on the material quality, number and type of inclusions,

and on the material heat treatment process during gear manufacture.

MQ - requirements met by experienced manufacturers at moderate cost

ME - requirements realized when a high degree of operating reliability is re-

quired.

Refer to ISO 6336-Part 5 for ML, MQ, ME steels qualities.
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1.5.11.21 Dialog: Conjugate-Cam-FB

Conjugate-Cam FB

See: Add Conjugate Cam FB .

What is a Conjugate Cam?

A Conjugate Cam pair

Conjugate Cams (typically two Cams)

rotate on one shaft, with each cam in

contact with a Follower-Roller, and in

which the Follower-Rollers are rigidly

attached to one Follower-Part.

For example: In the image, the blue and

orange Cams rotate together on one

shaft (the shaft is hollow!). The blue

Cam-Profile is in continuous contact

with the blue Follower-Roller, and the

orange Cam-Profile is in continuous

contact with the orange Follower-

Roller. The two Follower-Rollers are ri-

gidly attached to the green Follower-

Part.

Why use a Conjugate Cam FB?

Typically, one Cam is the Power-Source for the Follower-Part and kinematic-

chain.

However, if Conjugate Cams are the Power-Source, you must add, edit, and

configure a CONJUGATE CAM FB and then select the CONJUGATE-CAM FB as

the Power-Source. Only then should you do the force and stress analysis.

GROOVE CAMS are also conjugate-cams. However, you cannot use the In-

ner and Outer flanks of ONE 2D-CAM as the Conjugate-Cams. 

In a machine, a Groove Cam may use one or two Follower-Rollers. 

To model a Groove-Cam and also complete its force and stress analysis, you

need to add two co-axial Follower-Rollers and two Cams. You must select

the Inner Cam as one Cam-Profile, and the Outer Cam as the Conjugate

Cam-Profile. 

Then add, edit and select the Inner and Outer Cams in the CAM-CONJUGATE

DIALOG, and select the CAM-CONJUGATE FB as the Power-Source.

Cam Work-flow

Action Help Topic

1. Add a 2D-Cam  see Add 2D-Cam

If the new 2D-CAM is one of a pair of Conjugate-Cams, or it is one flank of a Groove-

Cam:

165

128
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Action Help Topic

 1.a. Add a CONJUGATE-CAM FB see Add Conjugate Cam FB  

 1.b. Edit the CONJUGATE-CAM FB to select

the two 2D-CAMS.

see Conjugate-Cam dialog

2. Select a 2D-CAM or a CONJUGATE-CAM

FB as the Power Source for the kin-

ematic-chain that includes the Follower 

see Configure-Power Source  

3. Review the 2D-CAM : Display, Proper-

ties, Roller-Life, Cam-Life, ...

see 2D-Cam dialog  

4. Add a Cam-Data FB see Add Cam-Data FB  

5. Edit the CAM-DATA FB to link it to a 2D-

CAM - close the dialog 

see Cam-Data dialog

6. Connect wires from the output-connectors of the CAM-DATA FB to a GRAPH FB 

7. Analyze the 2D-CAM see Cam-Data dialog : Cam Analysis

8. Edit the CAM-DATA FB again to calculate

the Cam's Coordinates 

see Cam-Data dialog : Cam-Coordin-

ates

How to open a Conjugate Cam dialog

To open the CONJUGATE-CAM DIALOG:

1. Double-click the CONJUGATE-CAM FB 

OR

1. See How to Open a dialog  

The CONJUGATE-CAM DIALOG is now open.

Conjugate-Cam dialog

Conjugate-Cam dialog

In the graphics-area or ASSEMBLY-TREE:

1. Click a 2D-CAM 

2. Click a different 2D-CAM 

165

436

589
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199

440

440

446

627
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The two 2D-CAMS are in one kinematic-chain and must be capable of being

the Power-Source for one other kinematic-chain.

Each 2D-CAM drives the Inner-Cam-Flank OR the Outer Cam-Flank.

3. Click  to close the dialog. 

Note 1 : If the 2D-CAMS you select do not drive the same Follower-Part, you

get this message in the Feedback Area.

Message

To do Force Analysis of the Conjugate Cams, you must select the CONJUG-

ATE-CAM FB in the CONFIGURE POWER SOURCE DIALOG.

To remove a 2D-Cam

1. Select the 2D-CAM in the list 

2. Click 
Remove Selected Cam

 Select Conjugate Cam in the Configure Power Source dialog

DEFAULT: Configure Power Source dialog

326



439

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Configure the Power Source

1. Click the Kinematics-Tree tab in the ELEMENT-EXPLORER 

2. Click the Kinematics-Chain that includes the Follower Part 

3. Right-click the Kinematic-Chain

4. Click CONFIGURE POWER-SOURCE to open the CONFIGURE POWER-

SOURCE DIALOG - see image above

The PIN-JOINT  is the DEFAULT Motor Element (Power-Source) - see im-

age above

Notice also the Motor Symbol  to the left of the PIN-JOINT - see image

above

In the CONFIGURE POWER-SOURCE DIALOG - see image below

5. Click the CONJUGATE CAM  in the list of elements - see image below

The CONJUGATE-CAM  replaces the PIN-JOINT as the Motor Element

(Power-Source) - see image below

Notice the Motor Symbol  is now to the left of the CONJUGATE-CAM -

see image below

6.  Click  to close the dialog. 

Now you can do Contact-Force Analysis for the Conjugate-Cams.

Conjugate-Cam as the Power-Source
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1.5.11.22 Dialog: Function-Block: Cam-Analysis

Cam-Data FB > Cam-Analysis

To analyze a 2D-Cam:

Action Step in this topic: 

1. Add a Cam-Data FB see STEP 1  

2. Link the Cam-Data FB to a 2D-Cam see STEP 2

3. Connect wires to a Graph FB see STEP 3

STEP 1: Add Cam-Data FB

To add a CAM-DATA FB to the graphics-area:

1. Click Kinematics FB toolbar  > Cam-Data FB 

OR 

1. Click Function-Blocks menu > Cam-Data (FB)

2. Click the graphics-area 

The CAM-DATA FB is now in the graphics-area and ASSEMBLY-TREE.

Note:

Typically, add a CAM-DATA FB for each 2D-CAM in your model.

TOP-TIP - if there is more than one 2D-CAM in your model

1. Edit the color of each 2D-CAM in your model 

2. Rename the element-name of the 2D-CAM to its color

3. AND, rename element-name of each CAM-DATA FB that you link to a

2D-CAM to the same color as the 2D-CAM.

STEP 2: Link the Cam-Data FB to a 2D-Cam

To link the CAM-DATA FB to a 2D-CAM, you must first open the CAM-DATA

DIALOG.

To open the CAM-DATA DIALOG:

1. Double-click the CAM-DATA FB 

OR

1. See How to open a dialog  

The CAM-DATA DIALOG is now open - see image be-

low.

You can see that the name of a 2D-CAM element is not in the SELECTED 2D-

CAM IS box .

Also, see the message “Select a Cam to activate this form”.

199

440

442

169

627
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Cam-Data dialog - 2D-Cam ''Not Seleted''

Click to select a

2D-Cam

 To select a 2D-CAM:

2. Click a 2D-CAM in the graphics-area or the

ASSEMBLY-TREE 

The 2D-CAM is now in the Selected 2D-Cam is box -

see  in image below.

3. Click  ( ) to close the CAM-DATA DIALOG,

OR 

3. See Calculate Cam-Coordinates  

Cam-Data FB : The name of the selected 2D-Cam is "Blue".

446
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RESULT:

In the graphics-area, the caption above the CAM-

DATA FB has two parts:

· Top (Inner in the example): the last calculated

Flank of the 2D-CAM that you have selected.

· Bottom Line (Blue in the example): the ele-

ment-name of the CAM-DATA FB - see TOP-TIP

You can:

· Analyze 5 Cam parameters - see Cam-Analysis

Parameters  

· Calculate the Cam's Coordinates - see Cam-

Coordinates dialog  

TOP-TIP: 

If you have many 2D-CAMS in your model, you can make it easier to see

which CAM-DATA FB is linked with which 2D-CAM.

1. Edit the color of a 2D-CAM - see 2D-Cam dialog : Display tab  >  DIS-

PLAY OPTION  

2. AND rename the 2D-CAM to the color of the 2D-CAM - see Rename

element

3. AND rename the CAM-DATA FB that has a link with a 2D-CAM, to the

color of the 2D-CAM

Now, it is easier to see in the graphics-area and the ASSEMBLY-TREE, the

link between 2D-CAMS and CAM-DATA FBS

STEP 3: Connect wires to a Graph FB

Analysis Parameters from Cam-Data FB

The output-connectors from the CAM-DATA FB provide over a machine-

cycle:

· F  : CONTACT FORCE : see Note 1

· : MAXIMUM CONTACT SHEAR STRESS : See Note 2

· : RADIUS-OF-CURVATURE : see Note 3

· : PRESSURE ANGLE : see Note 4

· Ue : SLIDING VELOCITY : see Note 5

Drag wires from the output-connectors of the CAM-DATA FB to a GRAPH

FB , a MATH FB  or a STATISTICS FB

442
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Make sure you select the correct Cam-Profile (INNER, OUTER, or PITCH-CENTER

PATH) in the Y–AXIS DISPLAY OPTION  of the GRAPH FB interface.

Note 1: CONTACT-FORCE

Configure the Power Source  before you analyze the CONTACT-FORCE.

If, in a GRAPH FB, the CONTACT-FORCE is  for a machine-cycle, and

the Configure Power Source is correct, change the GRAPH FB > Y-AXIS

DATA-CHANNELS  from INNER to OUTER, or vice versa.

Note 2: MAXIMUM CONTACT SHEAR-STRESS

Configure the Power Source  before you analyze the MAXIMUM SHEAR-

STRESS.

If in a GRAPH FB, the SHEAR-STRESS is  for a machine-cycle,

and the Configure Power Source is correct, change the GRAPH FB > Y-

AXIS OPTIONS from INNER to OUTER, or vice versa.

About Maximum Contact Shear-Stress

The Maximum Shear Stress is not at the surface of the Cam-Profile - it

is a little below its surface. The depth below the surface is a function of

the material properties and shapes of the contacting bodies, and the

Contact-Force.

To calculate MAXIMUM CONTACT SHEAR-STRESS, we assume that friction

is zero and the Cam-Profile and Follower Profile are perfectly smooth.

Also, we assume that the material properties of the Cam-Profile and the

Follower-Profile are:

· YOUNG'S MODULUS, 

· POISSON'S RATIO, 

Or, if you calculate the LIFE OF THE ROLLER AND CAM, we take the prop-

erties from the Steel Category in 2D-Cam dialog  > Cam-Life tab.

In the Cam-Life tab, we calculate the MAXIMUM CONTACT-STRESS, MAX-

IMUM SHEAR-STRESS, and the DEPTH OF THE MAXIMUM SHEAR-STRESS.

Note 3: RADIUS-OF-CURVATURE

By convention, the RADIUS-OF-CURVATURE (ROC) of a Follower-Roller is

positive.

When the cam is convex relative to the Roller, the ROC of the cam is

positive.

When the cam is concave relative to the Roller, the ROC of the cam

is negative.

RADIUS-OF-CURVATURE of the Pitch-Curve is not available. If you need

to know the RADIUS-OF-CURVATURE of the PITCH-CURVE, export the RA-

204

589

479

589

428
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DIUS-OF-CURVATURE of the INNER and OUTER cams to Excel, and calcu-

late the average.

Note 4: PRESSURE ANGLE

The PRESSURE ANGLE is through the center of the Follower-Roller. There

are two other PRESSURE ANGLES, which are the Contact Pressure Angle

of the INNER and OUTER Cams - these are labeled as INSIDE CONT. PR,

ANG and OUTSIDE CONT. PR, ANG in the Graph FB > Y-axis display op-

tions.

Use CONTACT PRESSURE ANGLE with Flat-Faced Follower-Profiles.

We do not calculate for you the PRESSURE ANGLE of a Stationary Cam.

Note 5: SLIDING-VELOCITY

The SLIDING-VELOCITY assumes the Follower-Profile does not roll, even

if the Profile represents a Roller; it assumes it slides over the Cam-Pro-

file. Use the SLIDING-VELOCITY to calculate the Film Thickness of the lub-

ricating oil between the Follower-Profile and Cam-Profile. If you know

the surface finish of the Cam-Profile and the Follower-Profile, you can

also calculate the Film Thickness Ratio, . This is an important para-

meter as it strongly influences the life of the cam. A Film Thickness Ra-

tio of less than 1 means that metal asperities of the Follower-Profile

and Cam-Profile contact each other, and wear occurs. 

Sliding Velocity = (Velocity of Cam-Profile – Velocity of Follower-

Profile)

Entrainment Velocity = (Velocity of Cam-Profile +Velocity of Fol-

lower-Profile) ÷ 2

Slip-Slide-Ratio = Sliding-Velocity ÷ Entrainment Velocity

TOP-TIP: 

To plot and compare the PRESSURE-ANGLE for up to 4 × 2D-CAMS:

1. Add 4 × CAM-DATA FBS and 1 × GRAPH FB to the graphics-area. 

2. Link the CAM-DATA FBS to 4 × 2D-CAms 

3. Connect a wire from the PRESSURE-ANGLE output-connector of

the 4 × CAM-DATA FBS to the 4 × Y-axis input-connectors of the 1

× GRAPH FB 

Now, in the GRAPH FB, set the scale of the Y-axes to the same minimum

and maximum values. Do this:

4. In the Graph Settings > TITLE AND INPUT SELECTION > Y-axis In-

put  drop-down, select SET ALL

In the Graph-Settings >  Y-AXIS 

5. Deselect AUTO-SCALE Y-AXIS 

481
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6. Enter 'soft-limits' for Y-MAXIMUM  and Y-MINIMUM - e.g. for

PRESSURE ANGLE, enter  +30º and –30º respectively.

Now, it easier to compare the PRESSURE-ANGLES of all 4 × 2D-CAMS, and

to see if the PRESSURE-ANGLE of a 2D-CAM is greater-than Y-MAXIMUM

and/or less-than the Y-MINIMUM values.

Contact Force / Contact Shear-Stress

After you correctly Configure the Power Source , you can find the Contact-

Force and Contact Maximum Shear-Stress between the Cam-Profile and the

Follower-Roller.

There are four methods to 

Display in the graphics-area:

METHOD 1: Forces toolbar > Display Force-Vectors  button. 

Two equal and opposite Force-Vectors radiate from the Contact-Point

between the Cam-Profile and the Follower-Roller. They are:

· the force vector that ACTS-ON the Follower-Profile and Follower-

Part

· the force vector that ACTS-ON the Cam-Profile and Cam-Part 

You must analyze if the force between the Cam-Profile and the Fol-

lower-Profile is active or not active (less than zero Newtons).

METHOD 2: Use: 2D-Cam dialog > Display tab > Cam Display Options >

Contact-Force . 

Plot with a Graph-FB:

METHOD 3: Add a Force-Data FB , select the 2D-CAM as the FORCE ELE-

MENT, plot with a GRAPH FB.

METHOD 4: Use the CAM-DATA FB to plot CONTACT FORCE from the top

output-connector with a GRAPH FB.

Contact-Force is = 0 N if Contact-Force   0 N. 

Note: 

METHOD 4 is best if you need to know if the Contact-Force is less than

or equal to zero

589

237

408

230
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1.5.11.23 Dialog: Function-Block: Cam-Coordinates

Cam-Data FB > Cam-Coordinates 

See Add Cam-Data FB  

Use a CAM-DATA FB to:

Calculate the INNER, OUTER, and/or PITCH-CENTER Cam-Profiles as:

· XY-Points

· BiArcs

Export a Cam-Profile directly to SOLIDWORKS as XY-Points or BiArcs.

Save the Cam-Coordinates to your hard-drive with these file types:

· .TXT - XY-Points and BiArcs 

· .CSV - XY-Points and BiArcs - see Note

· .DXF - XY-Points or BiArcs

· .SLDCRV  (import SOLIDWORKS as XYZ Curve

· .STP : see OPTIONS FOR: SAVE AS CAM AS A STEP FILE

Note: 

CSV delimiter (List Separator) - see Application-Settings > Number

Format tab > Data Output Format > List Separator / Delimiter Op-

tion  

We calculate for you and export the Cam-Coordinates for the 2D-CAM:

· from CAM-START (default = 0)

· to CAM+START + CAM-RANGE (default = 360) 

Edit the 2D-CAM to edit these parameters in 2D-CAM DIALOG - PARAMET-

ERS TAB .

Cam Work-flow

Action Help Topic

1. Add a 2D-Cam  see Add 2D-Cam

If the new 2D-CAM is one of a pair of Conjugate-Cams, or it is one flank of a Groove-

Cam:

 1.a. Add a CONJUGATE-CAM FB see Add Conjugate Cam FB  

 1.b. Edit the CONJUGATE-CAM FB to select

the two 2D-CAMS.

see Conjugate-Cam dialog

2. Select a 2D-CAM or a CONJUGATE-CAM

FB as the Power Source for the kin-

ematic-chain that includes the Follower 

see Configure-Power Source  

3. Review the 2D-CAM : Display, Proper-

ties, Roller-Life, Cam-Life, ...

see 2D-Cam dialog  

4. Add a Cam-Data FB see Add Cam-Data FB  

5. Edit the CAM-DATA FB to link it to a 2D-

CAM - close the dialog 

see Cam-Data dialog

128

452

341

403
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Action Help Topic

6. Connect wires from the output-connectors of the CAM-DATA FB to a GRAPH FB 

7. Analyze the 2D-CAM see Cam-Data dialog : Cam Analysis

8. Edit the CAM-DATA FB again to calculate

the Cam's Coordinates 

see Cam-Data dialog : Cam-Coordin-

ates

Cam-Data dialog: Cam-Coordinates 

If you see “Select a Cam to activate this form”, then click a 2D-CAM in the

ASSEMBLY-TREE or graphics-area to link it to the CAM-DATA FB - see Cam-Ana-

lysis

 - Cam-Coordinates toolbar ( see toolbar   below )

 - End-Caps - shows ONLY when the first XY-coordinate of the Cam is not

equal the last XY-coordinate. For example, a linear Slot-Cam.

 - Inner / Outer - status of the cams after the Cam-Coordinate calculations

( see Cam Status  )

 - Cam Options - calculate, display, and/or save the cam-profile coordinates

for the INNER, OUTER, GROOVE, or NEGATIVE GROOVE cam-type. NEGATIVE GROOVE

is for a STEP file only.

 - Radial Clearance - offset the Cam-Profile from the true Cam-Profile.

  
- # Points - calculate as XY-Points ( see toolbar   below )

OR 

 - BiArc Error - calculate as BiArcs ( see toolbar   below )

See also:  OPTIONS FOR: SAVE AS STEP FILE-TYPE .

Cam-Coordinates toolbar:

440

446
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Click icon  to switch between XY-Points and BiArcs.

Clear ALL coordinates from the table

Save Cam-Coordinate data as:

· STP(STEP)- XY Points  only

· DXF 

· CSV  

· TXT

· SLDCRV (SOLIDWORKS Curve file, tab delimited ) - XY

Points + Z-data = 0

Note: 

If this icon is not enabled, then make sure the PLATE-RADIUS

parameter is larger than the Maximum Radius of the Outer Cam.

OR: Click INNER or OUTER to recalculate the coordinates of a differ-

ent Cam-Profile, then, click again the Cam you actually want.

See STEP File Options .

Copy the Cam-Coordinates to your clipboard

If CAM OPTION  is GROOVE or NEGATIVE GROOVE, click  to

toggle between:

Calculate Cam-Coordinates for the INNER Cam-Profile.

Calculate Cam-Coordinates for the OUTER Cam-Profile.

Calculate Cam-Coordinates for the PITCH-CURVE (XY-POINTS

only).

Click  to toggle how we calculate the Cam-Coordinates for you.

Calculate as:

XY-POINTS

You enter the # POINTS  (NUMBER-OF-POINTS)

We calculate the XY Coordinates of the Cam-Profile for the NUM-

BER-OF-POINTS at equal increments of the MASTER MACHINE ANGLE.

BIARCS (see BiArcs)

452
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You enter the BIARC ERROR  

We calculate the BiArcs so that the maximum error between the

cam we calculate and the true Cam-Profile is less than, or equal to,

the BIARC-ERROR.

Before you click this button, make sure that SOLIDWORKS is open

and the active SOLIDWORKS document is a part document

(.SLDPRT).

We export the BiArcs to SOLIDWORKS as Arc sketch entities, 

OR

We export the XY-Points to SOLIDWORKS and instruct

SOLIDWORKS to use the XY-Points to add a Curve feature. 

In a SOLIDWORKS sketch, you can use Convert-Entities to convert

the Curve feature to a Spline sketch entity. See also Note 4

Usually, we calculate for you the XY Points automatically 

Usually, we calculate for you the Bi-Arcs automatically, but it takes

more time to complete.

If the TRAFFIC-LIGHT is RED, click the TRAFFIC-LIGHT icon again.

Display a preview of the Cam-Profile.

Read-only - the cam is “Open” or the cam is “Closed”.

End Caps

End Caps relate only to Slot-Cams, also known as Linear-Cams, or Ramp-

Cams.

Top-Tip - Save a Slot-Cam as a STEP file if it will not transfer to SOLIDWORKS.

End-Caps - Show

SHOW or HIDE END-CAPS

End-Caps work well when the inde-

pendent axis to the Follower moves in

one direction only - see image “End-Caps

- Show”

If the independent axis changes its dir-

ection in the middle of its travel, you

see False End-Caps in the middle of the

Slot-Cam. - see image: “Slot-Cam with

'False' End-Caps”.

Before you export Cam-Coordinates we

recommend you add a dummy slot-

cam - and move the main axis of the

Slot-Cam in one direction at Constant-

Velocity, over one machine-cycle.

456
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To make sure the Constant-Velocity is

correct: 

1. Connect a wire from a LINEAR-MO-

TION-FB to a GEARING FB 

2. In the GEARING FB, enter a GEARING

RATIO = LINEAR TRAVEL DISTANCE OF

SLOT-CAM / 360). 

3. Connect a wire from the GEARING FB

to the MOTION-DIMENSION FB as the

motion of the Slot-Cam.

As the MMA increases from 0 to 360,

the Cam travels from 0 to MAXIMUM

TRAVEL DISTANCE OF CAM (mm).

Slot-Cam with 'False' End-Cams

End-Caps - Hide

Cam Status

The cam-coordinates have been calculated. 

The Radius-of-Curvature is greater than the CAM ROC SOFT-

LIMIT parameter - see 2D-Cam dialog

The cam-coordinates have not been calculated - 

Usually after you change from # POINTS to BIARC ERROR, or

vice-versa.

It is not possible to calculate the cam-coordinates correctly, 

Possibly because of undercutting.

The cam-coordinates have been calculated.

The Cam's Radius-of-Curvature (RoC) is less than CAM ROC

SOFT-LIMIT parameter - see 2D-Cam dialog  - 

Undercutting is possible.

Cam Options 

Calculate, Display, and/or Save the Cam-Coordinates:

· INNER Cam-Profile ONLY 

403
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· OUTER Cam-Profile ONLY

· GROOVE-CAM

If you select GROOVE-CAM AND if you toggle   to

XY-POINTS, then you can also toggle   to calculate

the PITCH-CIRCLE coordinates.

· NEGATIVE-GROOVE

The Negative-Groove option applies only when you

save the Cam as a STEP file-type - see  . 

The STEP file is the space filled by the path of the Fol-

lower-Roller along the Cam-Profile (plus Radial Clear-

ance).

Note: 

This is not the same as a Rib Cam. You need to model a

Rib-Cam with Follower-Rollers, with one each side of

the Rib.

Radial-Clearance

Example Radial-Clearance

Cam with 0.2mm Radial Clearance

See also : 2D-Cam dialog > Parameters tab

> Cam Range and Radius

RADIAL CLEARANCE (MM)  Default = 0 ,

Negative or Positive

Positive Value - we re-calculate the

cam for you to give a clearance

between the Follower-Profile and the

Cam-Profile.

AND:

Negative Value - we re-calculate the

cam for you to give an interference

between the Follower-Profile and the

Cam-Profile.

403
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APPLICATIONS:

Groove-Cam - add clearance (Positive Value) for a Follower-Roller in a

Groove cam-type (See Note )

Conjugate-Cam - to add a small clearance (Positive Value) to compensate

for tolerances in the cam assembly. 

Rough-Cut - to oversize an Inner-Cam or undersize an Outer-Cam for a

Rough-cut. RADIAL-CLEARANCE should be a Negative-Value

Note: Frequently, Stud-type Follower-Rollers have a dimensional tolerance

negative  bias - for example, . You may consider that to be

enough clearance.

Cam-Coordinates

Max Chord-Error with BiArcs

  set to calculate as BiArcs

Apply this maximum BiArc-Error between the

Cam-Profile we calculate with BiArcs and the

true cam-profile.

Number of XY Points

  set to calculate as XY-Points

Calculate these number of points for the Cam-

Profile at equal increments of the MASTER-

MACHINE ANGLE.

   OPTIONS FOR: SAVE AS .STEP FILE-TYPE

Edit these parameters before you save a cam as a STP (STEP) file. 

 - FRONT FACE, BACK FACE - the face to cut the Groove-Cam into the Cam-

Plate (see more  below)

 - Dimensions of the Cam-Plate  (see more  below)

 - Schematics to indicate the Cam type, and if the PLATE-RADIUS and BORE-

RADIUS are suitable (see more  below )

 - Stationary Cam only - enter an X-OFFSET and Y-OFFSET to move the cen-

ter of the Cam-Plate (see more  below ).

 - MIN(minimum) INNER-CAM and MAX(maximum) OUTER-CAM (read-

only) - radii of the INNER and OUTER Cam-Profiles. They should help you specify

the PLATE-RADIUS and BORE-RADIUS (see more  below )

 
Dimensions for STEP file ONLY
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These images show the features of a Groove-Cam that has been exported

and opened in SOLIDWORKS:

 PLATE-DEPTH

The total depth, or thickness, of the

Cam-Plate.

 CAM-DEPTH

The depth of the Groove Cam cut into

the Cam-Plate. The width of the Cam-

Flanks.

Minimum PLATE-DEPTH – CAM-

DEPTH 2 mm

 PLATE-RADIUS

The radius of the Cam-Plate, when you

select: OUTER or GROOVE-CAM

 BORE-RADIUS

The radius of the hole through the cen-

ter of the Cam-Plate.

 Schematics of Cam type; Are the Dimensions OK or

Not-OK?



454

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Status of Cam, Blank-Radius and Bore-Radius relative to Cam-Size

The PLATE-RADIUS  parameter applies to Outer and Groove Cams only 

The BORE-RADIUS  parameter applies to all Cam types 

 GROOVE-CAM

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 

 GROOVE-CAM

 PLATE-RADIUS is NOT OK - it is less than the Maximum

Radius of the Outer Cam 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 

 GROOVE-CAM

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is NOT OK - it is greater than the Minimum

Radius of the Inner Cam 

 GROOVE-CAM

 PLATE-RADIUS is NOT OK - it is less than the Maximum

Radius of the Outer Cam 

 BORE-RADIUS is NOT OK - it is greater than the Minimum

Radius of the Inner Cam 

 INNER-CAM ONLY

 PLATE-RADIUS is 0mm

 BORE-RADIUS is 0mm - the Cam does not include a Hole

through its center

 INNER CAM ONLY

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 
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 INNER-CAM ONLY

 PLATE-RADIUS is NOT OK - this dimension is ignored with

INNER Cams 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 

You can save the STEP file.

 INNER-CAM ONLY

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is NOT OK - it is greater than the Minimum

Radius of the Inner Cam 

 You can NOT save the STEP file.

 OUTER-CAM ONLY

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 

 OUTER CAM ONLY

 PLATE-RADIUS is NOT OK - it is less than the Maximum

Radius of the Outer Cam 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 

You can NOT save the STEP file.

 OUTER-CAM ONLY

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is NOT OK - it is greater than the Minimum

Radius of the Inner Cam 

 You can save the STEP file.

 NEGATIVE GROOVE-CAM

 PLATE-RADIUS is OK - it is greater than the Maximum Ra-

dius of the Outer Cam 

 BORE-RADIUS is OK - it is less than the Minimum Radius

of the Inner Cam 
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Minimum/Maximum Radius of Cams, Offset X and Offset

Y.

· MIN INNER-CAM - Minimum radius of Inner Cam

· MAX. OUTER-CAM  - Maximum radius of Outer Cam (see also  )

These values are useful to know when you want to make sure there is a min-

imum difference between the:

· BORE-RADIUS and the minimum radius of the INNER Cam. 

· PLATE-RADIUS and the maximum radius of the OUTER Cam.

X-OFFSET and Y OFFSET

When the Cam is stationary, enter an X-OFFSET and Y-OFFSET to move the cen-

ter of the Cam-Plate relative the 0,0 of the MECHANISM-PLANE / BASE-PART.

X OFFSET = 0, Y OFFSET = 0

Read-only if the Cam is a not station-

ary. 

Image left: the Blank-Radius and

Blank-Bore with Offset-X=0,-Y=0.

X OFFSET = 20, Y OFFSET = 30

Image left: the Blank-Radius and

Blank-Bore with Offset-X=20,Y=30.

The maximum radius of the Blank-Bore

can be increased, and the minimum ra-

dius of the Blank-Radius can be de-

creased.

Notes:

Note 1: When the Cam-Part for a 2D-CAM is a rotating-Part (e.g. a Cam-

Shaft), make sure that the START-POINT) of the rotating-Part is at the PIN-

JOINT of the the Coordinates to the  

Note 4: Cam-Data and SOLIDWORKS.

When you export the Cam-Profile directly to SOLIDWORKS, the Cam will be

coplanar with the Front-Plane of the SOLIDWORKS part document.

To move the Cam-Profile to a different Plane - XY-Points:
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1. Calculate the Cam-Profile as XY-Points 

2. Save it as a SLDCRV file-type.

3. Open the SLDCRV file in EXCEL - the cam-coordinates use the A, B,

and C columns for the X, Y, and Z cam-coordinates, respectively. Z co-

ordinates are all 0s.

4. To move the Cam to the:

a. TOP Plane: Move the C column to the D column, the B column to

the C column, and the D column to the B-column (that is, swap the

B and C columns)

b. RIGHT Plane: Move the C column to the D column, the B column

to the C column, move the A column to the B column, and the D

column to the A column (that is, swap the A and C columns)

c. (and/or) To mirror the cam: Multiply the X-column data by –1)

5. Save the Data as a CSV (MS-Dos) file

6.  Close the file in EXCEL

7. Use Windows File Explorer to rename the file to file-name.SLDCRV

8. In SOLIDWORKS, do Insert > Curve > Curve Through XYZ Points... and

browse to file-name.SLDCRV

To move the Cam-Profile to a different Plane - Bi-Arcs:

After you export the BiArcs to SOLIDWORKS, you can Right-Click the BiArcs

sketch, and select 'Edit Sketch Plane' to move the sketch to a different

Plane.

Note5: The Cam as BiArc Data has six columns:

1 2 3 4 5 6

Arc Ra-

dius

mm

Arc Start

Point 

X

Coordin-

ate

Arc End

Point

X

Coordin-

ate

Arc Start

Point 

Y

Coordin-

ate

Arc End

Point 

Y

Coordin-

ate

Arc Angle

Range

Degrees



458

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.11.24 Dialog: Function-Block: Linear-Motion

Linear-Motion FB 

See Add Linear-Motion FB

The default motion-value at the output-connector from a LINEAR-MOTION

FB is equal to the Master-Machine-Angle (MMA). 

Use the LINEAR-MOTION DIALOG to edit .

The parameter, , advances or delays the output relative to the Master-

Machine-Angle.

The LINEAR-MOTION FB does not have an input-connector. 

How to open the Linear-Motion dialog-box

To open the LINEAR-MOTION DIALOG

1. Double-click the LINEAR-MOTION FB in the graphics-

area. 

OR

1. See How to Open a dialog  

The LINEAR-MOTION DIALOG is now open.

Linear-Motion dialog

Linear Motion FB dialog

START-ANGLE 

Units are degrees

Enter degrees as any real num-

ber.

A positive value advances the

output relative to the MMA.

A negative value delays the out-

put relative to the MMA.

OUTPUT-OPTIONS 

¤ RESET EACH CYCLE (default) 

Output = Master Machine

Angle + START-ANGLE  

¤ ACCUMULATE 

Output = (Revs × 360) +

MMA + START-ANGLE  

170
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1.5.11.25 Dialog: Function-Block: Gearing

Gearing FB

See Add Gearing FB

A GEARING FB applies a mathematical function to the data-values at its in-

put-connector to give different data-values at its output-connector.

The GEARING FB does not change the units of the data.

The GEARING FB can modify the data-values of all data-types.

Use the GEARING FB DIALOG to edit parameters , , and . 

The default values of , , and  do not change the output relative to the in-

put motion-values.

How to open the Gearing FB dialog-box

To open the GEARING FB DIALOG

1. Double-click the GEARING FB in the graphics-area. 

OR

1. See How to Open a dialog  

The GEARING FB DIALOG is now open.

Gearing FB dialog

Gearing FB dialog

 RATIO AND PHASE 

172

627
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Ratio and Phase

Gearing mathematical function

The GEARING FB has three parameters that you can edit.

The output from the GEARING-FB is:

    

The flow of motions-values from input, through the Gearing FB, to the out-

put is:

Gearing Parameters

 GEARING RATIO (maximum = 32,000; minimum = –32,000). See also 

in GEARING AS 'REAL' OR 'RATIO'.  

 ADD AFTER GEARING RATIO (maximum = 10,000; minimum = –10,000)

 ADD BEFORE GEARING RATIO (maximum = 10,000; minimum = –

10,000)

 GEARING AS 'REAL' OR 'RATIO' 
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Gearing as Ratio of Pulley Teeth

 Enter the GEARING RATIO in two ways: “REAL ”or “RATIO”

¤ GEARING AS 'REAL' 

¤  GEARING AS 'RATIO' 

If you select GEARING AS “REAL” :

Enter: 

 GEARING RATIO as a ± real number - see above

If you select GEARING AS “RATIO” :

Enter the number of teeth on the:

 INPUT PULLEY  as ± integer, and 0

AND

 OUTPUT PULLEY as + integer, minimum =1

We will calculate:

 GEARING RATIO =  INPUT PULLEY /  OUTPUT PULLEY

Example:

 GEARING-RATIO = 1.5

 ADD AFTER GEARING-RATIO = 83

 ADD BEFORE GEARING-RATIO = 23

If motion-value at input is= 37

Motion-value at output-connector is = 173
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1.5.11.26 Dialog: Function-Block: Motion

Motion FB

see Add Motion FB

A MOTION FB links to a motion that you select from the motions that you

have designed in MotionDesigner.

The motion-value at the input-connector to the MOTION FB points to the X-

axis of the motion you select. The motion-value at the output-connector from

the MOTION FB corresponds to the Y-axis value of the motion.

Use the MOTION FB DIALOG to select the  from a list of the Motion-

names in MotionDesigner.

How to open the Motion FB dialog

Motion FB

To open the MOTION FB DIALOG

1. Double-click a MOTION FB in the graphics-area 

OR

1. See How to Open a dialog  

The MOTION FB DIALOG is now open.

Motion FB dialog

Motion FB dialog

 MOTION PARAMETERS   

173
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SELECT MOTION 

Click the drop-down arrow  to select a motion. The names in the list

are the names of the Motion-name tabs in MotionDesigner.

Default motion: We select for you the left-most name of the Motion-

name tabs.

AFTER EACH MOTION CYCLE  

A Machine-Cycle is one cycle of the Master-Machine Angle from 0 to

360. 

You can increase the motion-values.

If the X-axis of the motion-design is from 0 to 360, and the Y-axis is a

progressive (indexing) motion of one index, then if

¤ RESET OUTPUT: (default) 

Start Position of Machine-Cycles #N = Start Position of Machine-

Cycle #1

¤ Accumulate Output : 

Start-Position of Machine-Cycles #N = End-Position of Machine-

Cycles #N-1 

* START-POSITION: See MotionDesigner > BLEND-POINT or SEGMENT ED-

ITOR > Y-AXIS VALUES ...

OUTPUT DATA-TYPE 

¤  MOTION  (default, for ROCKERS and SLIDERS)

¤  LINEAR *

¤  ROTARY *

*  You must select LINEAR or ROTARY if you connect a wire from the MO-

TION FB to a MOTION-PATH FB or a MATH FB.

464
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Notes : 

Usually, the motion-values at the input to a MOTION FB increases at a

constant rate from 0 to 360, again and again. 

However, the motion-values at the input may increase, decrease, and

stay at a constant value, within one machine-cycle.

For example, the motion-data at the input to a MOTION FB can be from:

· a different MOTION FB, or 

· a POINT-DATA FB , or 

· a MEASUREMENT FB , 

... in which case the motion-values may increase and decrease.

 PATTERN  

Ignore this separator

 QUERY  

ENTER Y-AXIS VALUE 

The values in the box (below) are the X-axis values that relate to the Y-axis

value for the SELECTED MOTION - see  MOTION PARAMETERS  

Note:

If we cannot find an X-axis value from the Y-AXIS VALUE that you enter,

we will report “FAILED TO FIND ROOT : POSSIBLY OUTSIDE Y RANGE” at the

bottom of the MOTION FB DIALOG.

Also in the Message area, we will report Topic: GET X-VALUE FAILURE ;

Message: FAILED TO FIND ROOT

"Reset" or "Accumulate" after each Motion-Cycle?

We can explain with an example.

1. Design an Indexing Motion in MotionDesigner with two Segments: 

Segment 1: Index (X-axis: 0-240 ; Y-axis: 0-90) 

Segment 2: Dwell (X-axis: 240-360 ; Y-axis: 90) 

2. Connect a LINEAR-MOTION FB to a GEARING FB 

3. Connect the GEARING FB to a MOTION FB

197

193



465

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

4. Connect the MOTION FB to a MOTION-DIMENSION FB that controls a rotat-

ing Motion-Part (Rocker).

5. Edit the BASE-VALUE in the MOTION-DIMENSION dialog to 0º.

6. Edit the MOTION FB:

· Select the Indexing Motion (see 1, above)

· Select RESET as the AFTER EACH MOTION-CYCLE parameter

7. Edit the GEARING FB:

· Enter GEARING RATIO = 4 (enter 4 because the motion is 0 to 90, and 4

× 90 = 360)

8. Cycle the model with ALT+C on your keyboard.

RESULT: 

As the MMA increases from 0 to 360, the:

· output motion-values from the GEARING FB increase from 0 to

1440 ( GEARING RATIO × 360 ) 

· output motion-values from the MOTION FB increase from 0 to 90,

and jumps to 0

Therefore, the indexing-shaft (Rocker) jumps to 0º four times, at the

end of each machine-cycle, after it rotates to 90º.

9. Edit the MOTION FB. 

· Select ACCUMULATE as the AFTER EACH MOTION-CYCLE parameter.

10. Cycle the model with ALT+C on your keyboard. 

RESULT:

As the MMA increases from 0 to 360, the:

· output from the GEARING FB increases from 0 to 1440 ( GEARING

RATIO(4) × 360 ) 

· indexing-shaft indexes 4 times: from 0 to 90, 90 to 180, 180 to

270, and 270 to 360.
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1.5.11.27 Dialog: Function-Block: Motion-Dimension

Motion-Dimension FB

see Add Motion-Dimension FB

A MOTION-DIMENSION FB adds the motion-value at its input-connector to a

constant we call the BASE-VALUE, to give the total motion-value at its out-

put-connector.

We use the total to control the position of a Motion-Part - a Rocker or a

Slider. 

Use the MOTION-DIMENSION DIALOG to: 

· edit the value of the constant, *

· optionally, negate 

· optionally, negate , the motion-value at the input-connector.

The Motion-Dimension FB icons in the graphics-area

There are two different icons in the graphics-area for a MOTION-DIMENSION

FB. They are:

A MOTION-DIMENSION FB that controls the angular position of a Rocker

A MOTION-DIMENSION FB that controls the linear position of a Slider

How to open the Motion-Dimension dialog

To open the MOTION-DIMENSION DIALOG: 

1. Double-click the Linear or Angular MOTION-DIMENSION FB in the

graphics-area 

OR

1. See How to Open a dialog  

The MOTION-DIMENSION DIALOG is now open.

Motion-Dimension dialog

174
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Motion-Dimension dialog

The MOTION-DIMENSION (of the Rocker or Slider) = BASE-VALUE

(read-write) + (Input) Motion-Value (read-only)

The motion-value at the output-connector is equal to the MOTION-DIMEN-

SION.

 BASE AND MOTION VALUES 

 BASE-VALUE (read-write)

A constant that you can add to the motion-value at the input-con-

nector.

 MOTION-VALUE (read-only)

The motion-value at the input-connector.

 BASE-VALUE + MOTION-VALUE (read-write)

BASE-VALUE + MOTION-VALUE = MOTION-DIMENSION at the output-

connector.

 DIRECTIONS 

 NEGATE MOTION-VALUES

¤ POSITIVE MOTION-VALUES : MOTION-VALUE × 1 ( default )

¤ NEGATIVE MOTION-VALUES : MOTION-VALUE × –1

 NEGATE BASE-VALUES
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¤ POSITIVE BASE-VALUE : BASE-VALUE × 1 ( default )

¤ NEGATIVE BASE-VALUE -  BASE-VALUE × –1

Note:

The default positive direction of a:

Rocker is counter-clockwise

Slider is in the direction of the arrowhead on the SLIDE-JOINT. See Positive

Direction of Sliders
188
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1.5.11.28 Dialog: Function-Block: Motion-Path

Motion-Path FB

see Add Motion-Path FB

The motion-values at the input-connector to a MOTION-PATH FB control the

position of a Motion-Point along a sketch-path. 

The MOTION-PATH FB can also add the motion-value at its input-connector

to a constant*. 

Use the MOTION-PATH DIALOG to edit the value of the constant, *.

Optionally, use the MOTION-PATH DIALOG to control and specify the length

of a sketch-path or sketch-loop - typically a belt.

It it important to know the data-type of the motion-values at the input-con-

nector. They should be Linear or Rotary - see Motion FB dialog

When the data-type is:

· Linear(mm) : the displacement of the MOTION-POINT is equal to the Linear

motion-value

· Rotary(degrees) : the displacement of the MOTION-POINT is equal to the

Rotary motion-value × total length of sketch-loop / 360

See more: Data-Type and Motion-Points

How to open the Motion-Path dialog

To open the MOTION-PATH DIALOG

1. Double-click the MOTION-PATH FB in the graphics-area 

OR

1. See How to Open a dialog  

The MOTION-PATH DIALOG is now open.

 Motion-Path dialog

Motion-Path dialog

There are usually two tabs:

Point Parameters

Length Control

If a TRANSITION-CURVE is a

sketch-element in the sketch-

loop, you will see three tabs.

Transition-Curves

Point Parameters tab

191
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 POINT PARAMETERS 

 # MOTION-POINTS: | Default = 1

To edit the number of MOTION-

POINTS along the sketch-loop.

1. Increase or decrease the # OF

MOTION-POINTS  

2. Click 
Re-Generate Motion-Points

 button  at the bottom of POINT

PARAMETERS separator. 

We distribute the MOTION-POINTS

equally along the PHASE-RANGE

 and LENGTH-RANGE  of the sketch-

loop.

If you Re-Generate Motion-Point,

and ther is a PIN-JOINT between a

PART and a MOTION-POINT, you

must add the PIN-JOINT again.

 PHASE RANGE | Default = 360 which

is equivalent to the total length of the

sketch-loop

 LINEAR-RANGE | Default = Length of

the sketch-loop.

When # MOTION-POINTS >1, the MO-

TION-POINTS are distributed equally

along the PHASE-RANGE and LINEAR-

RANGE of the sketch-loop.

1. Edit the PHASE RANGE  (deg) 

OR

1. Edit the LINEAR RANGE  (mm) 

When you edit PHASE-RANGE , the

LINEAR-RANGE updates automatic-

ally, and vice-versa.

These two parameters indicate the pro-

portion of the sketch-path over which to

distribute MOTION-POINTS (when # MO-

TION-POINT >1).

These parameters distribute MOTION-

POINTS (when # MOTION-POINTS > 1) over

a range (length) that is different to the

total-length of the sketch-path.
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The distribution of the MOTION-POINTS is best illustrated with examples.

We urge you to EXPERIMENT.

EXAMPLE

Say : Actual length of a sketch-loop is 127.5mm

The NUMBER OF MOTION-POINTS = 3  

Default: PHASE-RANGE =360 (and LINEAR-RANGE = 127.5) 

The 3 MOTION-POINTS are equally spaced over 127.5mm. The dis-

tance between each MOTION-POINT = 127.5/3 = 42.5mm

Position of MOTION-POINT #1 = 0MM, MOTION-POINT #2 = 42.5MM,

and MOTION-POINT #3 = 85.0MM

Edit PHASE-RANGE = 120 (and LINEAR-RANGE = 42.5) 

The 3 MOTION-POINTS are distributed over a linear-length of  =

42.5mm

The distance between each MOTION-POINT is 42.5/(3-1) = 21.25mm 

Position of MOTION-POINT #1 = 0MM, MOTION-POINT #2 = 21.25, and
MOTION-POINT #3 = 42.5MM

PHASE OFFSET (DEG)  | Default = 0

LINEAR OFFSET (MM)  | Default = 0

PHASE OFFSET and LINEAR OFFSET move ALL of the MOTION-POINTS

along the sketch-loop. The OFFSET value indicate the position of MO-

TION-POINT #1 when the motion-value at the input-connector of the

MOTION-PATH FB is equal to 0; or when a wire is not connected to its in-

put-connector. 

PHASE-OFFSET: equates the length of the sketch-loop to 360 de-

grees of a circle.

LINEAR-OFFSET: equates the length of the sketch-loop to its actual

linear length. 

EXAMPLE - we urge you to EXPERIMENT.

A sketch-loop is 127.5mm long. There is 1 MOTION-POINT.

· A PHASE-OFFSET=40 (deg) moves the MOTION-POINT #1 to 127.5×40  

360=14.16mm along the sketch-loop. All other MOTION-POINTS

move by the same distance. 

· A LINEAR-OFFSET=40 (mm) moves the MOTION-POINT #1 to 40mm

along the sketch-loop. All other MOTION-POINTS move by the same

distance.

Re-generate Motion-Points
 button

If you edit the NUMBER OF MOTION-POINTS  parameter, you must click

the Regenerate Motion-Points button. 

 POINT LIST AND DATA DISPLAY 
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HEADERS: NAME | INDEX | PHASE

(read-only)

· Name : the element-name of each
MOTION-POINT.

If you click on a MOTION-POINT in

the list, it shows as the Selected-

Color in the graphics-area.

· Index : the number of the MO-

TION-POINT

· Phase : the relative displacement

along the sketch-path, relative to

the MOTION-POINT #1

DISPLAY MOTION-POINT #1 AS

You can show the position of MO-

TION-POINT #1 as it move along the

sketch-loop.

¤ SHOW NOTHING - nothing shows

above the MOTION-POINT #1

¤ SHOW DISTANCE - the linear posi-

tion above MOTION-POINT #1 as it

moves along the sketch-loop

¤ SHOW PHASE - the angular phase

above MOTION-POINT #1 as it

moves along the sketch-loop

Length Control tab

 CONTROL LENGTH OF PATH 

You can select a dimension to control the length of the sketch-loop that is

associated with the MOTION-PATH FB.

The dimension you select is called the CONTROL-DIMENSION - see Note 1:

Control-Dimension

IMPORTANT

In the PART-EDITOR, the sketch-loop should be fully defined before you

select the CONTROL-DIMENSION.

Then, as you edit the CONTROL-DIMENSION, the shape of the sketch-

loop is more predictable - see Note 1 
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START: Length Control 

 / 

STOP: Length Control

To control the length of the Motion-

Path with a Dimension:

1. Click the 
START Length Control 

 BUTTON  

We open the PART-EDITOR for

you.

2. Click a dimension in the graph-

ics-area that can control the

total length of the sketch-loop -
see NOTE 1

We close the PART-EDITOR for

you. 

The Dimension name of the CON-

TROL-DIMENSION  is now below

the button . 

For example, DimPtoP4 

The value of the CONTROL-DIMEN-

SION (read-only) is now in box 

For example, 225

When you do not want to control the

length of the Motion-Path with a di-

mension:

1. Click 
STOP Length Control

  

NOTE 1: CONTROL-DIMENSION

RULE: The CONTROL-DIMENSION MUST be.

DimPtoP# the distance between two POINTS

DimL# the length of a LINE

Or, the CONTROL-DIMENSION MUST NOT be:

DimPtoL# the perpendicular distance form a POINT to a LINE, or a

POINT to the X-axis, or a POINT to the Y-axis

DimLtoL# the distance between two parallel LINES

AnglePPP#

AngleLtoL#
an angle

A dimension that is gray before you select it. 
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For example, a Design-Set already controls the dimen-

sion.

PARAMETERS

CONTROL-DIMENSION LENGTH - read-only

The value of the CONTROL-DIMENSION.

ACTUAL PATH LENGTH - read-only

The length of the sketch-loop associated with the MOTION-PATH FB.

TARGET PATH LENGTH

We recommend you use the Spin-Box tool to edit the TARGET-PATH

LENGTH with a small Spin- Increment.- e.g. 10mm

If the SPIN-BOX TOOL does not show, double-click and double-click

again in the data-box.

Round and then edit the length of the sketch-loop associated with

the MOTION-PATH FB - see NOTE 2 

CONTROL-DIMENSION MIN  / MAX  - see Note 3 below

When you select the CONTROL-DIMENSION:

· CONTROL-DIMENSIONS MINIMUM  is estimated as 0.5 × CON-

TROL-DIMENSION - see NOTE 3.

· CONTROL-DIMENSIONS MAXIMUM  is estimated as 2.0 × CON-

TROL-DIMENSION - see NOTE 3.

If required:

Edit the CONTROL-DIMENSION MINIMUM  and MAXIMUM  limits -
see NOTE 2. 

 BELT TOOTH PITCH 

BELT-TOOTH-PITCH

 The BELT-TOOTH-PITCH does not

change the belt length. 

The diameter of a PULLEY is a func-

tion of the NUMBER OF TEETH AND
BELT TOOTH-PITCH.

 See Pulley dialog

Notes 2 and 3 

NOTE 2: TARGET PATH-LENGTH

Edit the TARGET PATH-LENGTH with small increments. If the ACTUAL PATH

LENGTH does not change, see NOTE 3

NOTE 3: CONTROL-DIMENSION MINIMUM and/or CONTROL-DIMENSION

MAXIMUM

582
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If the Actual Path Length does not change, you may see the message in

FEEDBACK-AREA (below the graphics-area)

The default values for the CONTROL-DIMENSION MIN or CONTROL-DI-

MENSION MAX are such that the ACTUAL-PATH LENGTH can be equal to the
TARGET PATH LENGTH. 

However, it is possible that the Root-Finding Math to calculate the Control-

Dimension to find the ACTUAL-PATH LENGTH from the TARGET PATH LENGTH is

confused!

To reset the Root-finding Math:

· Increase or decrease the CONTROL-DIMENSION MIN/MAX, then try to

edit the TARGET-PATH-LENGTH again.

· You may need to edit these values to be almost equal to the actual

length of the CONTROL-DIMENSION.

Transition Curve tab

This tab will show If there is a

TRANSITION-CURVE in the

sketch-loop.

# SPROCKET TEETH

Maximum = 11 ; Minimum

= 3 

 CHAIN LINK-LENGTH

When the TARGET PATH

LENGTH is set, you can

enter the CHAIN-LINK

LENGTH to give an integer

number of teeth.

MOTION-PATH AND DATA TYPES

 DATA-TYPE AND MOTION-POINTS 

The position and motion of MOTION-POINTS along the sketch-loop is a func-

tion of the Data-Type at the input-connector to the MOTION-PATH FB. 

The Data-Type at the input-connector must be LINEAR or ROTARY.

DATA-TYPE = LINEAR 

The position of the MOTION-POINT #1 along the sketch-loop has a scale

of: 1mm at input = 1mm along sketch-loop

 the position of the MOTION-POINT #1 along the sketch-loop = mo-

tion-value at input-connector(mm)
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DATA-TYPE = ROTARY 

The position of MOTION-POINT #1 along the sketch-loop has a scale of:

1deg at input = Length of sketch-loop / 360 

the position of the MOTION-POINT #1 along the sketch-loop = mo-

tion-value at input-connector(degrees) × (Length of the sketch-

loop /360)

The Motion-Point moves along the total length of the sketch-loop

when the input is 360. 
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1.5.11.29 Dialog: Function-Block: Graph

Graph FB

see Add Graph FB

Use a GRAPH FB to plot Kinematic Motion-Data, Kinetostatic Force-Data and

Cam-Data.

There are:

è 4 × Y-axis input: the top four(4) input-connectors.

è 1 × X-axis input: the bottom input-connector controls the X-axis for all of

the graphs. 

If you do not connect a wire to the X-axis input-connector, the X-axis is one

machine-cycle, 0 – 360.

How to open the Graph Interface

To open the GRAPH FB DIALOG

1. Double-click the GRAPH FB in the graphics-area. 

OR

1. See How to Open a dialog . 

The GRAPH INTERFACE is now open.

Graph Interface

Grap dialog/interface

202
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 Y–axes: Colors and Scales

There is one Y-axis scale for each wire that you connect to an Y-axis input-

connector. Maximum = 4

Y-axis scales | Left >> Right  >>>  Wires at Y-axis input-connector | Top >>

Bottom.

· The color of each Y–axis scale is the same as the graph. 

Edit axis colors in Graph Setting dialog . 

· Default: the Y-axes auto-scale to the data at the input-connector. 

Edit Minimum / Maximum values with Graph Setting dialog . 

 Y–axis: Data-Channels (Drop-Down): See also Y–axis Data-Channel Display

Options

Each wire that you connect to an input-connector has up to 3 Data-Channels.

1. Click the drop-down arrow to select which Data-Channel to plot for

each wire that you connect to an input-connector. 

 Digital Readout (D.R.O.):

The X–axis value and the Y1-axis to Y4-axis values in the Digital Readout are

those values of the graph at the position of the vertical cursor  

The Number-Format for the X–axis and Y–axis values are configured in Edit

menu > Application Settings | Number Format tab.

 Graph Area:

There is a graph for each wire you connect to a Y-axis input-connector.

 Graph toolbar:

 Save data as

 Print graphs

 Graph Settings dialog

 Zoom-Out 

 Zoom-In

 Zoom-Extents

 Pan Left

 Pan Right

 Copy Graph Data to Clipboard – see below

 Vertical-Cursor

When you click or drag your pointer in the graph-area :

480
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· the Vertical-Cursor moves with your pointer

· the Digital-Readouts  are equal to the X-axis and Y-axis values of the

Vertical-Cursor 

· the MASTER MACHINE ANGLE continuously updates to equal the X-axis

value of the Vertical-Cursor

· the kinematic-chains that are kinematically-defined move to agree with

the MASTER MACHINE ANGLE.

 Graph Data in Clipboard

To list the graph data-values , 

1. Click the right-most icon in the Graph toolbar .

There is one data-point for each Machine Step - see Machine-Settings

dialog > Number-of-Steps .

You can Paste the data:

· to Excel, or Notepad, ...

· to the MotionDesigner Data-Transfer Table

From the Data-Transfer Table, you can paste the data:

· as a dumb Overlay-Trace to compare it with a motion

· to a Position List, Acceleration List, or Z Raw Data segment-type, and

link it to a MOTION-PART or MOTION-POINT.

Y-Axis Data-Channels:

Each wire that you connect to a GRAPH FB has three(3) data-channels.

Use the drop-down arrow to select which Y-Axis Data-Channel  to plot for

each Y-axis.

The Data-Channels that are available are a function of the Function-Block

and wire you connect at the input to the Graph FB.

DATA-CHANNELS:

Kinematic Function-Blocks  (Linear-Motion, Gearing, Motion, Motion-Di-

mension) you can plot:

· Linear or angular position 

· Linear or angular velocity

· Linear or angular acceleration

Measurement FB  or Point-Data FB  you can plot:

· Linear or angular position

· Linear or angular velocity

· Linear or angular acceleration

Cam-Data FB

· Pressure Angle. 

You can plot three Pressure Angles – See Pressure Angle

351
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193 197

199
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· Radius-of-Curvature. 

You can plot the Radii-of-Curvature of the Inner and the Outer Cam.

· Contact Cam Force

· Maximum Contact Shear Stress. 

· Sliding-Velocity 

Plot the Sliding-Velocity between the Cam-Profile and Follower-Profile for

the INNER Cam and the OUTER Cam.

Force-Data FB

The output form a FORCE-DATA FB is a function of the element with which it

is linked. See Force-Data FB dialog

If you link a FORCE-DATA FB to a: 

Ÿ PIN-JOINT with a Motor, you can plot the Application Load.

Ÿ SLIDE-JOINT with a Motor, you can plot the Application Load

Ÿ Joint that does not have a Motor, you can plot: 

þ Total Force ( F
T
 =  (F

X
2 + F

Y
2)

þ Force along the X-coordinate of a Point: F
X

þ Force along the Y-coordinate of a Point: F
Y

Ÿ 2D-CAM: you can plot the Cam Contact Force

Ÿ SPRING FB: you can plot the Total Force, X Force, Y Force acting on the

Anchor-Point.

Why are the Y–axis values in the DRO  different to the vector-values

in the main graphics-area?

The values may be slightly different because, in the graph, the X–axis and Y–

axis values at the D.R.O. must jump from 'machine -step' to 'machine-step'.

See Machine Settings dialog > Number-of-Steps .

In the graphics-area, the vector values are calculated for the value of the

Master Machine Angle, which may not coincide with a machine step.

1.5.11.30
 
- > Graph Settings

Graph FB > Settings

How to open the Graph-Settings

1. Click Graph toolbar > Graph Settings icon  in the Graph toolbar

to open the Graph Settings dialog.

The settings are: 

· Graph Title / Name

· Color of each graph line

· Maximum and Minimum scale for each Y-axis

· Maximum and Minimum scale for the X-axis

230
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Graph-Settings dialog

Graph-Settings dialog

 TITLE AND Y-AXIS INPUT SELECTION 

GRAPH TITLE

The GRAPH TITLE - for example, Pressure Angle, shows above the graph

plots.

Y–AXIS INPUT

Click the drop-down to select for which Y-AXIS INPUT you want to edit

You can select:

· Y1 to Y4 

or 

· Set all : to apply the same Y-AXIS and X-AXIS settings to ALL Y-axis in-

puts.

 Y-AXIS &  X-AXIS 
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The Y-axis parameters apply one the Y-AXIS INPUT or ALL Y-AXIS INPUTS

(if you select SET ALL)- see Title and Input Selection

 Y-AXIS: 

AUTO-SCALE Y-AXIS: check-box

þ Auto-scale Y-minimum / Y-minimum values for a Y-AXIS INPUT

q Enter the Y-MAXIMUM and Y-MINIMUM values for a Y-AXIS INPUT 

Enter values for Y MAXIMUM and Y MINIMUM when the AUTO-SCALE Y-AXIS

 check box is Clear

GRAPH LINE COLOR: 

Click the button and use the Windows® pop-up color picker to select a

different color.

Top Tip 1: 

Select Set all in the Y-AXIS INPUT drop-box, and set the MAXIMUM and MIN-

IMUM for the all of the Y-axes to be equal for all graphs. 

For example: the wire to all of the input-connectors is PRESSURE-ANGLE from

different 2D-CAMS. Then, it is easy to see on the graph which 2D-CAM ex-

ceeds the limits for PRESSURE-ANGLE. 

Top-Tip 2: 

The RADIUS-OF-CURVATURE of a 2D-CAM can be a very large value. The large

values are not important. The small values are more important. 

Set the MAXIMUM and MINIMUM values at approximately 3 × the radius of a

Follower-Roller.

481
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 X–AXIS: 

The X-axis values apply to ALL graph plots.

AUTO-SCALE X-AXIS:

þ Auto-scale the X-MAXIMUM and X-MINIMUM values for the X-AXIS. 

q Enter the X-MAXIMUM and X-MINIMUM values for the X-AXIS
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1.5.11.31 Dialog: Function-Block: Point-Data

Point-Data FB

see Add Point-Data FB

The POINT-DATA FB measures the kinematic motion-values of a POINT*

with respect to the Mechanism Plane.

The POINT-DATA FB has three output-connectors. The data at the output-

connectors, from top to bottom, are:

è motion-values parallel to the X-axis

è motion-values parallel to the Y-axis

è Magnitude of the motion-values equal to:

o  (X2 + Y2)

Note: Kinematic Motion-Values are the Position, Velocity, and Acceleration

of the POINT*.

* The POINT should be a child to a PART that is kinematically-defined.

* POINT, START-POINT, END-POINT, CENTER-POINT, or MOTION-POINT.

How to open the Point-Data FB dialog

To open the POINT-DATA DIALOG

1. Double-click the POINT-DATA FB in the graphics-

area 

OR

1. See How to Open a dialog  

The POINT-DATA DIALOG is now open.

Point-Data dialog

Point-Data dialog; without Point

SELECT A POINT:

1. Click the POINT in the graph-

ics-area whose motion you

want to measure.
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Point-Data dialog; with Point

When the POINT in the selection-box: 

2. Click  to close the POINT-

DATA DIALOG 

Different ways to use the Point-Data FB 

The data at the output-connectors includes the Position, Velocity, and Accelera-

tion values. 

Connect wires from the output-connectors to the input-connector of:

1: a GRAPH FB  : to plot the Position, Velocity, and Acceleration of

the POINT in the X and Y–axis directions (see: Top-Tip)

2: a MOTION FB : to use the motion-values as the independent (X-

axis) of a Motion.

3: a MOTION-DIMENSION FB or a MOTION-PATH FB : to use the mo-

tion-values as a motion of a MOTION-PART or MOTION-POINT.

4: a: a MATH FB : to use the motion-values to calculate another func-

tion that is not available directly to you.

b: a MATH FB : to convert the data-type from motion-values to a

different data-type. E.g. Force(N).

Top-Tip : To plot Position, Velocity, AND Acceleration of a POINT in one

GRAPH FB:

1. Drag three wires from one of the output-connectors of the

POINT-DATA FB to three different input-connectors of a

GRAPH FB. 

2. In the GRAPH FB interface, use the Y–axis display options

to plot a different motion-derivative for each input.

See also : Connecting FBs

202
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1.5.11.32 Dialog: Function-Block: CAD Control

CAD Control FB

see Add CAD-Control FB .

Use a CAD CONTROL FB to synchronize Distance or Angle mates in a

SOLIDWORKS® assembly document with the motion of PARTS in a

MechDesigner model.

You can control up to four(4) SOLIDWORKS® mates with one CAD-CONTROL

FB.

Why use a CAD-CONTROL FB? You can use the powerful Evaluation / Valid-

ation Tools in SOLIDWORKS® to check the clearance between a Follower-

Roller and the flanks of a 3D-Cam, for example.

Note the SOLIDWORKS® mates respond very slowly. Increment the model

very slowly when you using the CAD-CONTROL FB.

See Getting Started Tutorial 6C3: Examine 3D-Cam Clearances

CAD-Control dialog

STEP 1: Connect wires to the input-connectors of the CAD-Control FB from

other FBs in your model. 

The motion-values at the output of a FB you connect should control a Motion-

Dimension and be equivalent to a Distance or Angle Mate in SOLIDWORKS that

you want to control.
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To control a Distance (or Angle) Mate, set the OUTPUT DATA TYPE in each Motion

FB dialog  to Linear (or Rotary).

STEP 2: Open the SolidWorks Assembly.

STEP 3: Double-Click a CAD-Control FB in the graphics-area, to open this

dialog

If necessary, click DIMENSION and CAD MODEL PATH to expand the dialog. 

STEP 4: Click the Refresh button.

When you click the REFRESH button, we find for you all of the Dimension

and Angle mates in your SOLIDWORKS® Assembly model.

STEP 5: Click the Available Dimensions down-arrow button to see the mates

that have been found in the SolidWorks® Assembly model.

STEP 6: Click, in the Available Dimension list, each Dimension or Angle mate

you want to control.

Repeat to select and control a maximum of 4 mates.

Note: Select the mates in the same order (sequence) as the wires

Mate1 = Wire 1(top); Mate 2 = Wire 2; Mate 3 = Wire 3; Mate 4 = Wire

4(bottom).

The mates show in the CAD-DIMENSION NAMES TO DRIVE box.

If the mates are not in the same sequence as the wires you can click the

Clear CAD Dimensions button. 

You can select the mates again.

STEP 7: Click the Drive CAD Enabled check-box at the top of the dialog.

DO NOT CLOSE THE DIALOG

You can only control the mates with this dialog open.

The position of the parts in the SOLIDWORKS® Assembly model move* when

you move your model in MechDesigner.

STEP 8: Click  at the top of the dialog when you have finished using the

evaluation and analysis tools in SOLIDWORKS®. 

* Only use the Home, Step Back or Step-Forward buttons in the Run toolbar.

Do not use the Cycle button.
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1.5.11.33 Dialog: Function-Block: Statistics

Statistics FB

See Add Statistics FB

If you can connect a wire to a GRAPH FB to plot the data over a complete ma-

chine-cycle ...

  ... then you can also connect a wire to a STATISTICS FB to show the statistical

data for the complete machine-cycle.

Compare with Element Properties dialog , which displays the data-values at

the MASTER MACHINE ANGLE only.

After you add the STATS FB to the graphic-area, there are three more steps you

need to do to get Statistics for a Data-Channel on a wire.

STEP 0: Connect a wire to the input of the Statistics FB.

A wire that you connect from the output-connector of a FB to the input-con-

nector of the STATISTICS FB has three Data-Channels. 

For example, the three Data-Channels at the output-connector of a MOTION-

DIMENSION FB are the three linear or angular motion-derivatives of the MO-

TION-DIMENSION

STEP 1: Select the Data-Channel

 STEP 1. Open the Statistics dialog 

To open the STATISTICS FB DIALOG

1. Double-click the STATISTICS FB in the graphics-area 

OR

1. See How to Open a dialog  

The STATISTICS FB DIALOG is now open.

Statistics FB dialog

 CHANNEL / DERIVATIVE 

 STEP 2. Click the Derivative drop-down and select the derivative for

which you want Statistics 

209
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Derivative Data-Channel

Dis.  Linear Displacement or Angular Displacement; or

Torque 

Vel.  Linear Velocity or Angular Velocity; or Force X

Acc.  Linear Acceleration or Angular Acceleration; or Force Y

* The Data-Channels in the drop-down box are always: Dis, Vel, and Acc ,

even if the actual units are different. The actual units: 

· For a KINEMATIC-FB are three(3) motion-derivatives

· For a FORCE-DATA FB are Total Force/Torque, Force X, Force Y.

Ignore the other SEPARATORS in the dialog.

 STEP 3. Click  to close the STATISTICS DIALOG 

STEP 2: Show the Statistics Properties

Statistic Properties dialog

 STEP 1. Open the Properties box 

1. CTRL + Click the STATISTICS FB in the graphics-area 

The STATISTICAL PROPERTIES form is now open.

Read the Statistical Properties for the Data-Channel of the wire that is

connected to its input-connector.

Mean

Ans Max

Maximum

Minimum

RMS

Standard Deviation

Standard Error
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Maximum Sum

Note: to edit the NUMBER-FORMAT for the Statistics Properties, use:

APPLICATION-SETTINGS > NUMBER-FORMAT > DATA-OUTPUT FORMAT > DI-

GITS and PRECISION
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1.5.11.34 Dialog: Function-Block: Polynomial-Fit

Polynomial-Fit FB

See also: Add Polynomial Fit FB

Before you use this tool, I recommend you save your work.

Then save it again with a new model file-name.

About Polynomial FB

The POLYNOMIAL FIT FB finds a concatenated series of Polynomials (5th order)

that are approximately equal to the data at its input-connector.

After you do a Polynomial-Fit, you can:

· Transfer Polynomials directly to MotionDesigner as a new Motion

name-tab.

· Connect a wire from the output-connector of the POLYNOMIAL-FIT FB

to the input-connector of a different FB.

· Export the motion-values that you calculate as a text-file.

· Export the values for position, velocity, and acceleration at the beginning

and end of each polynomial segment as a CSV file.

· Export the polynomials segments in a format suitable for the Schneider-

Electric EPAS4 servo-controller.

How to open the Polynomial-Fit dialog

After you add a  POLYNOMIAL-FIT FB to the graphics-

area:

1. Double-click the POLYNOMIAL-FIT FB in the

graphics-area 

OR

1. See How to Open a dialog  

The POLYNOMIAL-FIT DIALOG is now open.
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Polynomial-Fit dialog

Polynomial-Fit FB dialog/interface.

The Polynomial-Fit dialog:

 Acquire and Save Toolbar - acquire and save results.

 Analysis of Results - RMS errors and the number of Polynomials.

 Settings for Polynomial Fitting Algorithms - tolerances, limits, and

range for polynomial fitting.

 Graph Plots: for the input-data and the calculated data from the Poly-

nomials.

 Graph toolbar - view and save the graph-data in different ways.

 Graph Legend. - graph plot color scheme for original data and fitted

Polynomials, for each motion-derivative

Acquire and Save toolbar
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Acquire and Save Results toolbar

The toolbar buttons are:

 Acquire (Capture, Get One Cycle) : 

Click this button to acquire data at the input-connector for one ma-

chine-cycle - this is the Raw-Data.

  Fit Polynomials to Data : 

Click to Fit Polynomials to the Raw-Data - see Settings for Polynomial

Fitting Algorithms .

 Stop Algorithms : (see also Auto-Run)

The algorithms usually fit polynomials within a few seconds. If you do

not see the results after a few seconds, then click this button to stop the

algorithms.

  Save Coefficients :

Click to save the results to a CSV file, or a EPAS4 file that is suitable for

a Schneider Electric servo-controller.

 Auto-Run :

Immediately allow the algorithms to find the polynomials that fit the

data to the accuracy as specified, and with less or equal to the max-

imum number of polynomials.

 Send Polynomials to MotionDesigner : 

Send the Polynomials to MotionDesigner as a new motion. Add a new

Motion name-tab.

Note on Blend-Point Control-Buttons: After you send the Polynomials

to MotionDesigner, none of the Match Control Buttons are active. In-

stead, the Start motion-value of a segment, is equal to the End motion-

value of the previous-segment. Obviously, you can choose to Match the

motion-values as part of your motion-design process.

Analysis of Results

Number of Fitted Polynomials in Fit (read-only)

The actual number of Polynomials in the numerical solution.
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See also: Maximum Polynomial Count in the Settings for Polynomial

Fitting Algorithms.

RMS Position Error, RMS Velocity Error, RMS Acceleration Error (read-

only). 

They give the RMS (Root of the Mean of the Square) error as a percent-

age for each motion-derivative between the Polynomial that we fit to the

data, and the raw-data at the input-connector.

Settings for Polynomial Fitting Algorithms 

Parameters to enter before you click Fit Polynomials to Data (button  in

the Acquire and Save toolbar , above)

 Position, Velocity, Acceleration buttons. 

Click each button to identify the motion-derivatives to which you want

to Fit Polynomials. 

 Position, Velocity, Acceleration Tolerance %

Enter the tolerance, as a %, for each motion-derivative, within which the

Fitted Polynomials should represent the data at the input-connector. 

 Machine Angle Range

494
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Optionally, reduce the range for which you want to calculate Polynomi-

als

 Number of Points 

The number of data points that are calculated from the Polynomials, to

plot the graphs.

 Point in Tolerance Sample of Points 

The number of points that the algorithm uses to fit each polynomial to

the data at the input-connector.

 Maximum number of Polynomials. 

Upper limit of the number of Fitted-Polynomials in the data.

 Minimum Segment Width. 

Lower Limit for the width of a Segment

 Split Segment at Zero Acceleration / Velocity check-boxes

Force the solutions to split the motion (add a new Segment) at which

the Acceleration / Velocity crosses zero - positive to negative and vice

versa.

Graph toolbar

The toolbar buttons are:

 Print Graphs : Print the graphs immediately to the default printer

  Save Graph Data: Save the Data to a text file.

 Zoom Out and Zoom In to the Graph Details

  Pan Left and Pan Right : Click to save the results to a CSV file, or a

EPAS4 file that is suitable for a Schneider-Electric servo-controller.

 Zoom Extents 

 Toggle display:  Plot three separate graphs OR Plot three stacked on-

top of each other

 Toggle display: Do show Graph Legend OR Do NOT show Graph Le-

gend

Graph Legend
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Graph plot color scheme for 

· original, or input, data 

· fitted data calculated from the fitted poly-

nomials

· each motion-derivative

· Cursor - you can click ON a graph of each

motion-derivative to show a cursor. 

The X-Y data-values of the active cursor is

above the graphs.
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1.5.11.35 Dialog: Function-Block: Parameter-Control

Parameter-Control FB

See: Add Parameter-Control FB

The PARAMETER-CONTROL FB has one input-connector.

The motion-values at the input-connector can control:

· a DIMENSION when the Driven Parameter is a DIMENSION 

· an EXTRUSION DEPTH when the Driven Parameter is a PROFILE

· an EXTRUSION-OFFSET when the Driven Parameter is an EXTRUSION. 

How to open the Parameter-Control dialog

To open the PARAMETER-CONTROL DIALOG

1. Click the PARAMETER-CONTROL FB in the graphics-area or the

ASSEMBLY-TREE. 

The PARAMETER-CONTROL FB is now in the SELECTION-WINDOW

2. Right-click the PARAMETER-CONTROL FB element in the SELECTION-

WINDOW 

3. Click Edit element in the shortcut menu

OR

See How to Open a dialog . 

The PARAMETER-CONTROL DIALOG is now open.

Parameter-Control dialog

Parameter-Control dialog

Three parameters are controlled by the motion-values at the input-connector

The sections in the PARAMETER CONTROL DIALOG are the

 ENABLE / DISABLE check-box

216
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 TOP-BOX - we add the PROFILES and EXTRUSIONS that you select in the

ASSEMBLY-TREE and/or graphics-area to the TOP-BOX.

Then, you must select (click) which of those elements that are in the

TOP-BOX you want to control. When you select an element in the TOP-

BOX, we add it to the BOTTOM-BOX as a Driven Parameter.

 BOTTOM-BOX - A list of the Driven Parameters, Solve Element, and

Control Actions that we control with the motion-values at the input-

connector to the PARAMETER CONTROL FB.

 CONTROL ACTIONS - the actions that the PARAMETER-CONTROL FB con-

trol with the motion-values at the input-connector to the PARAMETER-

CONTROL FB.

 DELETE - to remove an element from the dialog - select the element,

then click the DELETE X icon.

How to use Parameter-Control dialog

To enable the FB

þ  Enabled

1. Click the check-box to enable the PARAMETER-CONTROL DIALOG. 

To control a Dimension 

1. MECHANISM-EDITOR: Click the sketch-element that has a DIMENSION

(that you have added with the PART-EDITOR ) 

OR

2. PART-EDITOR: Click the DIMENSION, or the sketch-element with a DI-

MENSION.

In the BOTTOM-BOX

· The DIMENSION is the Driven-Parameter

· The PART is the Solve-Element

· Update Dimension is as the Control-Action

To control the Extrusion-Depth of a Profile/Extrusion:

1. MECHANISM-EDITOR: Click a PROFILE. 

The PROFILE and EXTRUSION show in the Top-Box. 

2. Click the PROFILE in the Top-Box. 

In the Bottom-Box: 

· The PROFILE shows as the Driven-Parameter

· The Extrusion shows as the Solve-Element

· Update Extrusion-Depth shows as the Control-Action

To control the Extrusion-Offset of a Profile/Extrusion:

1. MECHANISM-EDITOR: Click the PROFILE. 

The PROFILE and EXTRUSION show in the Top-Box. 
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2. Click the EXTRUSION in the Top-Box. 

In the Bottom-Box: 

· The EXTRUSION shows as the Driven-Parameter

· The Extrusion shows as the Solve-Element

· Rebuild Solid shows as the Control-Action - this is actually the

EXTRUSION-OFFSET.

To delete an element:

1. Click an element in the Top-Box or the Bottom-Box. 

2. Click  

We remove for you the ELEMENT and PARAMETER from the PARAMETER-

CONTROL DIALOG.
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1.5.11.36 Dialog: Function-Block: Pattern

Pattern FB

See Add Pattern FB  

Use a PATTERN FB to make Copies of PROFILE/EXTRUSIONS (MD-SOLIDS) and/or

CAD-SOLIDS at different phases of the machine-cycle - see SOLIDS, 

· The PATTERN FB anticipates the motion of each Copy and puts each Copy at

a position that corresponds to its phase of the machine-cycle.

· The PATTERN FB can show or hide a Copy for a machine-cycle.

· The PATTERN FB can use a timing-chart to show or hide Copies as they pass

through different phases of the machine-cycle.

Use Visibility toolbar > Show Solids in Mechanisms  to see the Copies that we

generate for you with the PATTERN FB.

How to open the Pattern FB dialog

Open the PATTERN FB DIALOG:

1. Click the PATTERN FB in the ASSEMBLY-TREE. 

The PATTERN FB is now in the SELECTION-WINDOW

2. Right-click the PATTERN FB element in the SELECTION-WINDOW

 

3. Click Edit element in the shortcut menu

OR

1. See How to Open a dialog . 

The PATTERN FB DIALOG is now open.

Pattern dialog

Pattern FB dialog

 There are two tabs in the PATTERN FB DIA-

LOG:

Pattern Elements

Phase Visibilities

Pattern Elements tab

ENABLE AND PATTERN TYPE 

213
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1. Click ENABLE check-box to make the PATTERN dialog active 

PATTERN TYPE:

2. Click SPACE PATTERN or PHASE PATTERN.

These two options take a snap-shot of the path of a SOLID. The Pattern

shows copies of the SOLID at equal increments of its path in the ma-

chine-cycle.

¤  SPACE PATTERN (Note: I rarely use this option!)

When you cycle the model:

a) Each copy of the SOLID moves locked to the PART 

OR 

¤  PHASE PATTERN 

a) Each copy of the SOLID moves along the path of the SOLID.  

b) Each copy of the SOLID is at a different advanced position in the

machine-cycle.

PATTERN ELEMENTS 

Pattern-Elements

PATTERN-ELEMENTS
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SOLID elements from which we make for you copies for the Space Pat-

tern or Phase Pattern.

There are two categories of SOLID elements you can add as PATTERN

ELEMENTS: 

· MD-SOLIDS - PROFILE/EXTRUSIONS - you MUST select the EXTRU-

SION 

· CAD-SOLIDS - SOLIDS you import onto a CAD-LINE - you can se-

lect the CAD-SOLID or the CAD-LINE.

MOTION TO LINEARIZE

A MOTION FB  can linearize the motion of the SOLIDS in PATTERN-ELE-

MENTS . EXPERIMENT!

· If the SOLIDS in the PATTERN-ELEMENTS  move as you expect, do not

add a MOTION FB.

· If the SOLIDS in the PATTERN-ELEMENTS  do not move as you expect,

do add a MOTION FB - but this may not solve the problem!

Add SOLIDS to the PATTERN-ELEMENTS box

Pattern-Elements toolbar

1. Pattern-Elements toolbar: Click the Padlock  to unlock the toolbar 

2. Graphics-area: SHIFT + Click PROFILE elements to add EXTRUSION ele-

ments that you cannot see 

OR

2. Graphics-area: CLICK EXTRUSION elements that you can see to add EX-

TRUSION elements 

OR 

2. Graphics-area or ASSEMBLY-TREE: Click CAD-LINES onto which a CAD-

SOLID has been imported. 

3. Pattern-Elements toolbar: Click the Padlock  to lock the toolbar and

box. 

SOLID elements are now in the PATTERN ELEMENTS box as EXTRUSIONS

and/or CAD-LINES.

To add a MOTION FB to the MOTION TO LINEARIZE box  

Pattern-Elements toolbar

1. Pattern-Elements toolbar: Click the Padlock  to unlock the Pattern-

Elements toolbar. 
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2. Graphics-area or ASSEMBLY-TREE: Click a MOTION FB 

3. Pattern-Elements toolbar: Click the Padlock  to lock the Pattern-Ele-

ments toolbar and box. 

A MOTION FB is now in the MOTIONS TO LINEARIZE box

To remove a SOLID  or MOTION FB

Pattern-Elements toolbar

1. Pattern-Elements toolbar: Click the Padlock  to unlock the Pattern-

Elements toolbar. 

2. Click to select a PATTERN-ELEMENT or a MOTION FB in the boxes

3. Click the REMOVE SOLID  or the REMOVE MOTION FB  button in the

Pattern-Elements toolbar

4. Pattern-Elements toolbar: Click the Padlock  to lock the Pattern-Ele-

ments toolbar and box. 

Phase Visibilities tab

PHASES are the number of copies of the PATTERN-ELEMENTS and the machine-

angles to show or hide them.

PHASES 

# COPIES: from 1 to 100 : 
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The number of copies of the PATTERN-ELEMENTS in the Pattern.

The format of the PHASES separator is slightly different for the SPACE PAT-

TERN and the PHASE PATTERN.

IF SPACE PATTERN

 START ANGLE, FINAL ANGLE: 

· The COPIES show at equal intervals from the START ANGLE to the

FINAL ANGLE.

IF PHASE PATTERN

FINAL ANGLE = ?- default =360.

The concept of a Motion-Period is important.

If FINAL ANGLE is 360, then the Motion-Period is equal to 1 Machine-

Cycle

If FINAL ANGLE is, for example, 20º, the Motion-Period is 20º.

· The # COPIES show at regular intervals within one Motion-Period,

from MMA=0 to FINAL ANGLE.

· The PHASE PATTERN repeats one time for each Motion-Period or 36  

20 = 18 times in 1 Machine-Cycle. 

· You can show or hide each PATTERN ELEMENT within each Motion-

Period - see PHASE VISIBILITY separator.

HIDE SOURCE PATTERN ELEMENT:

SOURCE PATTERN ELEMENTS are the SOLIDS (CAD-Solids and/or MD-Solids)

that you select in the model as PATTERN-ELEMENTS, and show in the PATTERN

ELEMENTS separator of the Pattern-Elements tab .

Nearly always, enable HIDE SOURCE PATTERN-ELEMENT. This is because the

COPY #1 and the SOURCE PATTERN-ELEMENT are at the same position

1. Click a PATTERN-ELEMENT in the PATTERN ELEMENTS  separator and

Pattern-Elements tab . 

It should show in the PHASE-VISIBILITIES  separator (to see you have se-

lected it).

2. Click the HIDE SOURCE PATTERN ELEMENT check-box.

COPIES BOX

· To hide a Copy for the total Motion-

Period, click a  next to the phase angle

of a Copy to show a .

· To show a Copy for the total Motion-

Period, click a  next to the phase angle

of a Copy to show a .

   PATTERN VISIBILITY

501
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Phase-Visibilities > Pattern-Visvibility

Note: PATTERN VISIBILITY  shows only if

you select PHASE PATTERN - see Enable and

Type.

Use PATTERN VISIBILITY to show or hide a

PATTERN-ELEMENT for different periods

within the Motion-Period. 

To edit the Visibility of a PATTERN-ELEMENT:

1. Click an EXTRUSION or CAD-LINE in the PATTERN ELEMENTS box - see Pat-

tern-Elements tab  

The element - EXTRUSION or CAD-LINE - must show in the PATTERN-ELEMENT

TO EDIT  box.

2. Click the EDIT VISIBILITY OF PATTERN-ELEMENT... button .

The Pattern Visibility interface is now open.

You can now edit the Visibility of the element that is in the PATTERN-ELEMENT

TO EDIT  box.

How to use the Pattern Visibility interface

Refer to the image below:

 Pattern-Element box (top-left)- is the name of the PATTERN-ELEMENT

you are editing.

 Phase Visibility Timing Chart - the chart controls the Visible-Period(s) of

the PATTERN-ELEMENTS.

As an example:

In the image below, there is one Visible-Period of the PATTERN-ELEMENT

“EXTRUSION”,  from 0º to 360º.

500

500

500
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There are two(2) NODES that control the timing of each Visible-Period.

 Node at the Start of Visible-Period - Start-Node 

 Node at the End of Visible-Period - End-Node 

To edit a Visible-Period for the PATTERN-ELEMENT you must edit the timing

of the Start-Node and/or End-Node.

STEP   1. (Example) Edit the Start-Node and End-Node to define a Visible-

Period.

1. Click the Start-Node . 

When the Start-Node is Red ... 

2. Edit the NODE'S TIMING  to control the start of the Visible-Period

for the PATTERN-ELEMENT .

Then 

3. Click the End-Node  

When the End-Node is Red ...  

3. Edit the NODE'S TIMING  to control the end of the Visible-Period

for the PATTERN-ELEMENT .

The image below shows the new timing of the Visible-Period for the PAT-

TERN-ELEMENT (EXTRUSION).

It starts at 50 and end at 150 in the Machine-Cycle.

STEP   2. (Example continued...) Add a new Visible-Period

- see image above.

1. Click  ADD NODE  button 

2. Click the PHASE VISIBILITY CHART in a free area  which is not in the

Visible-Period (e.g. between 150 and 360) - see cursor in the image

above.
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There is now a new Visible-Period in the PHASE-VISIBILITY CHART - see im-

age below.

STEP   3. (Example continued...) Edit the Start-Node and End-Node to

define the timing of the new Visible-Period.

1. Click the Start-Node  or End-Node  of the new Visible-Period

When a Node is Red ... 

2. Edit the NODE'S TIMING

Do 1 and 2 again to define the new Visible-Period for the PATTERN-ELE-

MENT

The image below shows the two Visible-Periods in the PHASE-VISIBILITY

CHART for the PATTERN-ELEMENT (EXTRUSION) 

Visible Period  - starts at 50 and ends at 150

Visible-Period  - starts at 200 and ends at 300

STEP   4. (Example continued...) Delete a Visible-Period 

1. Click the Start-Node or End-Node of the Visible Period you want to

delete. 

In the image above the End-Node  of Visible-Period  is Red ... 

2. Click DELETE-NODE 

We delete Visible-Period  from the PHASE-VISIBILITY CHART

The image below shows one Visible-Period in the the PHASE-VISIBILITY

CHART for the PATTERN-ELEMENT (EXTRUSION) 

You can now Click  to close the Pattern Visibility interface.
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Pattern Visibilities - example

Imagine a chain wrapped around a circular, 12-hour, analog, clock. There are 12

hours and 12 chain-links in the chain.

The chain moves continuously around the circular clock. 

To add the 12 copies of the Pattern-Element (see Pattern-Elements tab chain-

links is the SOURCE PATTERN-ELEMENT (SOLID).

· Edit Phase Visibilities tab > PHASES separator > # COPIES to edit the num-

ber of chain-links on the chain - in this example, 12 copies to give 12

chain-links. 

You will see in the box below the angle of the 12 Copies, when the MMA=0. 

· Click a copy in the table. 

The  changes to a   for each copy you click. 

A  next to the copy means you can see the copy move around the clock -

however, see also PATTERN VISIBILITIES 

A  next to the copy means you can not see the copy, as it moves ALL the

way around the clock.

· Nearly always, enable HIDE SOURCE PATTERN-ELEMENT.

· Use PATTERN VISIBILITY to hide each chain-link, one link after the next link,

as it moves between hours, for example, between 6 and 9 o'clock.
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1.5.11.37 Dialog: Function-Block: Math (with Calculator)

Math FB (with Calculator)

See Add Math FB  See also :  Tutorial 18: Math FB

Use a MATH FB to add new math functions.

Use a MATH FB to change units of a Data-Type. For example, change units

from motion (P, V, A) to Force (Newtons) units, and connect a MATH FB to a

SPRING FB . 

A CALCULATOR interface can help you select different functions.

How to open the Math FB dialog

 

To open the MATH FB DIALOG:

1. Double-click the MATH FB in the graphics-area 

OR

1. See How to Open a dialog  

The MATH FB DIALOG is now open.

Math FB dialog

Math FB dialog

Math FB Interface

ADD INPUT button

1. Click the 
Add Input

 button to add an input-connector to the MATH FB.

You need one input-connector for each variable or parameter in your

equation.

Note:

If you connect a wire from a MOTION FB to the input-connector of a

MATH FB, then select LINEAR or ROTARY as the OUTPUT DATA-TYPE in the

MOTION FB.

215

234

627

http://mechdesigner.support/index.htm?maths_fb.htm
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ADD OUTPUT button

1. Click the 
Add Output

 button to add an output-connector from the MATH

FB. 

You need one output-connector for each output. 

UPDATE button  

1. Click the 
Update

 button when you: 

· Change the OUTPUT DATA-TYPE 

· Edit an Equation

OUTPUT DATA-TYPE

The units of the OUTPUT DATA-TYPE apply to ALL of output-connectors from

the MATH FB.

To select a different OUTPUT DATA-TYPE

1. Click the drop-down box  

2. Select the OUTPUT DATA-TYPE 

Note:

 Inside the MATH FB, all units are SI units. 

A change to the OUTPUT DATA-TYPE may change the values at the output-

connector of the MATH FB.

Equations

Output Data-Type, Output-Connectors, Data-Channels

The OUTPUT DATA-TYPE controls the units of ALL output-connectors.

Each output-connector has three(3) Data-Channels.

You can write one equation for each Data-Channel.

For example: 

If you select LINEAR COORDINATES as the OUTPUT DATA-TYPE, then the output

of ALL equations have Linear Units

If you have two(2) output-connectors, there are 6 equations.

· The units for Data-Channels Q0[Dis.] and Q1[Dis.] are Displacement, with

units of 

· The units for Data-Channels Q0[Vel.] and Q1[Vel.] are Velocity, with units

of 

· The units for Data-Channels Q0[Acc.] and Q1[Acc.] are Acc, with units of

· Data-Channels/Equations 0, 1, 2 are for the Output-Connector #1

· Data-Channels/Equations 3, 4, 5 are for Output-Connector #2

Wire Numbers / input-connectors and Data-Channels
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The image below shows three Wires connected to three Input-Connectors.

3 Wires, 3 Input-Connectors

Each wire has 3 Data-Channels

WIRE NUMBERS - refer to the image.

Wire numbers start at 0

· Input-Connector 1 is for Wire 0 -

connected to the TOP input-con-

nector

· Input-Connector 2 is for Wire 1

· Input-Connector 3 is for Wire 2 -

connected to the BOTTOM input-

connector

DATA-CHANNELS

Each wire has 3 data-channels. 

Each DATA-CHANNEL is designated a letter:

· p = Data-Channel 1

· v = Data-Channel 2

· a = Data-Channel 3

The format of an Equation references a WIRE-NUMBER and a DATA-CHANNEL: 

 DATA-CHANNEL (WIRE-NUMBER)

EXAMPLE - Entries in an Equation: 

p(0) : p refers to DATA-CHANNEL 1 ; and (0) refers to INPUT-CONNECTOR 1

a(2) :  a refers to DATA-CHANNEL 3 ; and (2) refers to INPUT-CONNECTOR 3

v(1) :  v refers to DATA-CHANNEL 2 ; and (1) refers to INPUT-CONNECTOR 2

How many input and output-connectors?

As an example, to calculate Power :

P =   .  

Power (N.m./sec) = Torque(N.m.) × Angular Velocity (rad/sec)

Torque and Angular-Velocity are inputs to the equation.

Power is the output. 

You need two input-connectors and one output-connector.

Edit the MATH FB to open the MATH FB DIALOG.

1. Add two Input-Connectors with the ADD-INPUT button 

2. Select Power as the OUTPUT DATA-TYPE

3. Click the UPDATE button
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Prepare the model (see above)

1. Add a ROCKER - see Tutorial 1 

2. Edit the CAD-LINE of the ROCKER, to open the CAD-LINE DIALOG.

In CAD-Line dialog > Mass Properties tab  > USER MASS PROPERTIES :

Enter a value for the Mass.

Enter X and Y values to move the Center-of-Mass away from the START-

POINT (origin) of the CAD-LINE.

3. Add a FORCE-DATA FB to the model ; open the FORCE-DATA DIALOG ;

select the PIN-JOINT, and select the POINT in the BASE-PART to find the

Torque that acts-on the BASE-PART. 

See image above - the DATA-CHANNELS on the WIRE of the FORCE-DATA FB

and the MOTION-DIMENSION FB

The MATH FB uses SI units for all data 'inside'. 

Enter the Equation

Click the first equation in the MATH FB

The EQUATION-EDITOR opens - see below.

You need to enter this equation:

Q0 [Power] = p(0)*v(1)

367
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p(0) = Channel 1 (p = Torque), Wire-Number 0 (top input-connector)  

×

v(1) = Channel 2 (v = Angular Velocity), Wire-Number 1 (input-connector

below top) 

SYNTAX and VALID Equations

Click UPDATE button to confirm that the syntax of the equation  correct.

For example, it may not have correct number of parentheses. The reason

is given as a message in the Feedback-Area .

The  at the left of each equation shows that the syntax is correct.

IMPORTANT 

Data from Motion FBs 

If you connect a wire from a MOTION FB to the input of a MATH FB, Set

the OUTPUT DATA-TYPE in the MOTION FB to LINEAR or ROTARY.

MORE ABOUT UNITS 'inside' the Math FB

The data-values at the output connector of a MATH FB an be confusing for

these reasons:

A: SI Units

Inside the MATH FB, the units are SI. 

B: SI Units are converted to the ENGINEERING UNITS of the OUTPUT-

DATA-TYPE.

The SI units and values that are internal to the MATH FB are converted

back to Engineering Units  for the OUTPUT DATA-TYPE that you select.

Example:

· If a MOTION FB is set to Rotary, and the output from it is 90º, then the

value internal to the MATH FB is 1.57radians.

· If the MOTION FB is set to Linear, and the output from it is 100mm, the

value internal to the MATH FB is 0.1m.

Example continued...

If you multiply these values in the MATH FB dialog, the internal result is

0.157.

· If the OUTPUT DATA-TYPE is set to ROTARY COORDINATES, the output is

9º. 

· If the OUTPUT DATA-TYPE is set to LINEAR COORDINATES, the output is

157mm

The reason? 0.157rads (inside the Math FB) = 9º (outside the Math FB).

C: If you connect an output with ROTARY-COORDINATES to a Slider:

Rotary units to move a Linear Slider!

326

351
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In the MATH FB, if you set the OUTPUT DATA TYPE to ROTARY COORDIN-

ATES, then 0.157 is 0.157rads internally to the Math FB. It is 9º at the out-

put, when the Engineering-Units are degrees. 

If you connect the MATH FB to a MOTION-DIMENSION FB to move a Slider,

then the 9º is 9mm.

D: If you connect an output with LINEAR-COORDINATES to a Rocker:

Linear Units to move a Rotary Rocker!

In the MATH FB, if you set the OUTPUT DATA TYPE to LINEAR COORDINATES,

then 0.157 is 0.157m internally. It is 157mm at the output when the Engin-

eering-Units are mm.

If you connect the MATH FB to a MOTION-DIMENSION FB to move a

Rocker, then 157mm is 157º.

Equation-Editor with Calculator

Equation-Editor with Calculator

The EQUATION-EDITOR provides a few of the common mathematical functions

you can add to each equation.

When open and close brackets show within a function button, you should enter

a value that is constant or a value that changes over a machine-cycle. For

Example: 

Sin( )

You can enter a constant. E.g. Sin(3.14)

You can also enter a variable. E.g. Sin(p(1))

p(1) is data-channel #1 of input-connector #2.

Calculator Functions 
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1. Position, Velocity, and Acceleration Values for a linear or angular in-

put

· P( ) ; V( ) ; A( )

2. Standard Algebra

· Arithmetic: +, –, , *

· Power: ^

· Brackets: ( )

3. Boolean

· > : <output> = 1 if <value 1> > <value 2>, else 0

· < : <output> = 1 if <value 1> > <value 2>, else 0

4. Trigonometry (all inputs in radians) 

· Standard: Sin( ), Cosine( ), Tangent( )

· Hyperbolic: Sinh( ), Cosh( ), Tansh( )

· Inverse: ArcSin( ), ArcCos( ) , ArcTan2( ; )

5. Limit (input ; maximum value ; minimum value) : 

<output> = <input> if <input> is less than maximum value AND more

than minimum value.

<output> = <maximum-value> if <input> is greater than maximum

<output> = <minimum-value> if <input> is less than minimum

6. OverLimit (input ; limit-value) : 

 <output> = <input> if <input> is 'greater than limit-value'

 <output> = <limit-value> if <input> is 'less than limit-value'

7. UnderLimit (input ; limit value) : 

 <output> = <input> if <input> is 'less than limit-value'

 <output> = <limit-value> if <input> is 'greater than limit-value'

8. Limits (input ; maximum value ; minimum value) : 

<output> = <input> if <input> is 'greater than maximum value' OR

less than minimum value'.

<output> = <maximum-value> if <input> is 'less than maximum' AND

'more than minimum-value

<output> = <minimum-value> if <input> is 'greater than minimum-

value AND 'less than maximum-value'

9. Numerical Keypad 

10. 1...9, 0,  .

11. Abs( ) 
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12. Mag( ; ) (assumes the two values are 'orthogonal' and uses Pythagoras

to find the 'resultant')

13. Sqrt( );

14. DegToRad( )

15. RadToDeg( )

Limit Functions:

LIMIT Func-

tion

Limit (input ;

maximum

value ; min-

imum value) : 

<output> =

<input> if

<input> is less

than max-

imum value

AND greater

than minimum

value.

<output> = <maximum-value> if <input> is greater than maximum

<output> = <minimum-value> if <input> is greater than minimum

Note that the arguments in the Limit Function are SI units for the units in the

model.

For example, 75 millimeters in the model is 0.075 meters in the function.

UNDER-LIMIT

Function

UnderLimit

(input ; limit

value) : 

<output> =

<input> if

<input> is

'less than

limit-value'

<output> =

<limit-value>

if <input> is

'greater than limit-value'
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OVER-LIMIT

Function

OverLimit (in-

put ; limit-

value) : 

<output> =

<input> if

<input> is

'greater than

limit-value'

<output> =

<limit-value>

if <input> is

'less than limit-value'
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1.5.11.38 Dialog: Function-Block: Briefcase

Briefcase FB

See: Add Briefcase  

Use a BRIEFCASE FB to hide other Function-Blocks from the graphics-area. 

You can use one BRIEFCASE FB to hide all of the Function-Blocks. However, I

usually add one BRIEFCASE FB for each machine function. 

You can also hide a BRIEFCASE FB inside a different BRIEFCASE FB.

How to open the Briefcase FB dialog

Open the BRIEFCASE FB dialog:

1. Double-click a BRIEFCASE FB in the graphics-area 

OR

1. See How to Open a dialog  

The BRIEFCASE DIALOG is now open.

Briefcase FB dialog

Briefcase FB dialog

DISPLAY OPTIONS

 << WRITE A LABEL >> (For example: TRANSLATING-LINK)

Enter a name to remind you of what the Function-Blocks in the

Briefcase do in your model.

The label you enter shows above the BRIEFCASE FB in the graphics-area

after you add Function-Blocks to the BRIEFCASE FB.

 BACKGROUND COLOR and TRANSPARENCY

Use the BACKGROUND COLOR button to edit the color of the BRIEFCASE

WINDOW-FRAME -see example below.

208

627
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Use the TRANSPARENCY slider to edit the transparency/opacity of the
BRIEFCASE WINDOW-.

 SHOW-FUNCTION-BLOCKS IN A WINDOW-FRAME

þ Select SHOW FUNCTION-BLOCKS IN A WINDOW-FRAME to show the

BRIEFCASE WINDOW-FRAME 

q Clear SHOW FUNCTION-BLOCKS IN A WINDOW-FRAME to hide the

BRIEFCASE WINDOW-FRAME 

New Functionality

SHORT-CUT - to toggle ““SHOW FB IN A WINDOW FRAME

1. Press your SHIFT key on your keyboard 

2. Move your mouse above a BRIEFCASE FB 

3. Click your mouse

ADD / REMOVE FUNCTION-BLOCKS

Add FBs to the Briefcase

1. Click the PADLOCK  to unlock the BRIEFCASE FB 

The PADLOCK  icon is now unlocked - see image.

2. Click FBS in the graphics-area

We move each FB you click from the graphics-area to the FUNC-

TION-BLOCKS  box in the BRIEFCASE FB.

3. Click the PADLOCK  to lock the BRIEFCASE FB 

Remove FBs from the Briefcase:

1. Click a FB in the FUNCTION-BLOCKS  box 

2. Click the CROSS  button.

The FB returns to the graphics-area, outside of the BRIEFCASE WIN-

DOW-FRAME.

3. Do 1 - 3 again to remove different FBS.

Arrange FBs in the Briefcase Display Window.
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1. Click SHOW FUNCTION-BLOCKS IN A 'WINDOW-FRAME' check-box  -

see above.

2. Click the ARRANGE FBS  button 

The FBS are now arranged in a linear array in the graphics-area. 

You may need to drag FBS to arrange the FBS in the linear array.

Add all those FBs that are connected with wires 'upstream' of a FB

1. Click a FB in the FUNCTION-BLOCKS box  

2. Click the ADD ALL UPSTREAM icon 

The FBS that are connected to the input-connector of the FB you select

are now in the FUNCTION-BLOCK box.

Add all those FBs that are connected with wires 'downstream' of a FB

1. Click a FB in the FUNCTION-BLOCKS box  in the BRIEFCASE 

2. Click the ADD ALL DOWNSTREAM icon 

The FBS that are connected to its output-connector are now in the FUNC-

TION-BLOCK box.

Remove all FBs from the Briefcase

1. Click the REMOVE ALL icon  .

The FBS are now in the graphics-area again.

EXAMPLE:

Function-Blocks in the "Briefcase Window-Frame"

 BRIEFCASE FB and label: TRANSLATING-LINK.

 BRIEFCASE WINDOW-FRAME is a colored box, with a blue border.

· The window re-sizes as you drag, add, or remove FUNCTION-BLOCKS.

· Drag the BRIEFCASE FB  to move the BRIEFCASE WINDOW-FRAME  
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1.5.11.39 Dialog: Function-Block: Point-Cloud

Point-Cloud FB

See Add Point-Cloud

Do two steps in the POINT-CLOUD DIALOG:

STEP 1: IMPORT-DATA (TXT file-type).

For example, import the X,Y coordinates of a cam-profile, which you have

measured with a Coordinate Measurement Machine (CMM).

STEP 2: FIT-A-CURVE TO THE DATA

We fit for you a smooth Curve to the data that you import, with a Fourier Har-

monic-Series.

How to open the Point-Cloud dialog

Open the POINT-CLOUD DIALOG:

1. Double-click a POINT-CLOUD FB in the graphics-area 

OR

See How to open a dialog

The POINT-CLOUD DIALOG is now open.

Point-Cloud dialog

Point-Cloud dialog

STEP 1: Import Data 

STEP 2: Fit Curve to Data 

STEP 1: Import Data

Do A, B, and C.

Import and Browse buttons

A. BROWSE...

Click the BROWSE... button to find a

data-file.

The data-file must by an ASCII, or

TXT file-type.

The file-name you select shows in

the DATA-FILE (READ-ONLY) box. 

A preview of the data in the file is in

the box below.

B. EDIT FILE-FORMAT 

206

627
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Example File Format

Any Header in the data-file is not

imported.

The data should be rows of data-

points - see Data-Points below

You can remove extra data from

columns/rows with the EDIT FILE-

FORMAT box. See File Formats

below.

C: IMPORT BUTTON

When the File Format is correct (see

below), click the IMPORT button to

import the POINT-CLOUD data-file. 

We plot for you the POINT-CLOUD

on the PART to which the POINT-

CLOUD FB is a child.

The Point-Cloud plot is a continu-

ous line in the graphics-area.

See also: Messages

Data-Points

The File Format must include at least these terms:

· (x) (y) : if each data-point is an X and Y coordinate

OR

· (Radius) (Angle) : if each data-point is a Radius and Angle coordinate.

Characters that are ignored in the data-file:

· Header lines, when entered as text.

· ASCII characters that are NOT : . , -, 0–9, in all lines.

Optional: Data Offset and Scale option

Options: 

X , Y 

When you add a POINT-CLOUD, you

select a PART. The PART has an ori-

gin - its START-POINT - where its XY

coordinates are (0,0)

If the origin of the POINT-CLOUD has

an offset relative to the origin of

the PART, you can remove the offset.

Enter -X, -Y, the negative of the off-

set.

Or, to offset the POINT-CLOUD, by

(X,Y), enter (X,Y) values.

523

524
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FILE ROTARY UNITS ; FILE LINEAR UN-

ITS

Select the units that match those of

the original POINT-CLOUD data-file.

File Formats:

PRE-SELECT A FILE FORMAT

To help you with the formatting, you can use the PRE-SELECT A FILE

FORMAT from the drop-down list-box.

When any of these formats do not represent the format of the data in

your data-file, then edit the format in the Edit File Format box directly.

Example: Data-Files and File-Formats and Enter File Format.

EXAMPLE 1: Data-File:

 Enter File Format: () () (x) (y)

Why?

 Line 1 Is Not imported - text only

(A, B, C, ... Z)

 Line 2 Is Not imported - text only

(A, B, C, ... Z)

 Line 3: Column 1 and Column 2: Are Not imported because

of () () in the File Format () ()

(x) (y) removes these two

Columns

 Line 3: Column 3 and Column 4 Are Imported because the

(x) (y) in the File Format () ()

(x) (y) identify that these

Columns as x, y data

 Lines 4, 5, 6, ... Equal to Line 3
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EXAMPLE 2: Data-File 

Data Format: N100 G00 X10 Y25 Z27

Enter File Format: () () (x) (y) ()

Why?

N100 G00 X10 Y25 Z27 Letters - not imported (A, B, C, ... Z)

N100 G00 X10 Y25 Z27 Column 1, Column 2, and Column 5 -

not imported - the () in the File

Format () () (x) (y) ()

10 25  Imported - the (X) and (Y) in the File

Format () () (x) (y) ()

Feedback Messages:

STEP 2: Fit Curve to Data

When you import Point-Cloud data, the chart  shows the Points, the Curve,

Nothing, or Points + Curve

In the chart below, the Continuous Curve does not follow the Point-

Cloud data - it is planned and to see the different charts ONLY. 

The two charts show as one chart after you successfully Fit the

Continuous Curve to the Point-Cloud data when you increase the

number of Harmonics.
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Point-Cloud dialog > Fit Curve to Data tab

Parameters

 ORIGINAL DATA ACCURACY 

This is a judgment you must make. Start with 0.1 then reduce it to

approximately 0.001 - but see Original Data Accuracy  for more

thoughts.

 AUTO-FIT check-box and FIT CURVE button 

Usually, click the AUTO-FIT button to make it active - see options

 Increase the # HARMONICS 

Edit the # HARMONICS  

The difference between the Continuous-Curve and the Imported

Data decreases as you increase the # Harmonic .

 FIT-QUALITY =0 >> 1  

When FIT QUALITY TRAFFIC LIGHT is Green, ...

or 

When the number in the FIT-QUALITY NUMBER BOX  is near to, or

equal to, one(1), ...

... STOP - do not increase the number of Harmonics.

 DISPLAY OPTIONS

Click one of the four radio-buttons

¢ SHOW NOTHING 

¢ POINTS ONLY

526
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¢ POINTS AND CURVE

¢ CURVE ONLY

The view of the Continuous-Curve and the POINT-CLOUD in the

graphics-area match the P, V, or A  button.

Steps to do in Fit Curve

A. Edit the # Harmonics

þ AUTO-FIT Check-box

The CURVE updates immediately each time you edit the # HARMON-

ICS 

q AUTO-FIT check-box is clear.

The CURVE only updates when you click FIT CURVE  

B. Repeat A

Increase the # Harmonics until the FIT-QUALITY =~1, and the

TRAFFIC-LIGHT is Green or Orange.

We recommend the Maximum # Harmonics < # Data-Points in the

Point-Cloud / 3.

VELOCITY and ACCELERATION GRAPHS and FILTER WIDTH

The default plot is Position. If you want to plot the Point-Cloud and the

Curve as Velocity or Acceleration ( ), then click the V or the A icon.

Even if the Fit Quality = 1, you can continue to increase the number

of # Harmonics to improve the fit of the Velocity and/or Acceleration

Curve to the Point-Cloud.

However, we recommend the Maximum # Harmonics = # Points in

the Point-Cloud/3.

If the plot of the Velocity or Acceleration data is noisy you can smooth

the noise (remove the noise) with the Filter-Width . This may help you

identify the original Motion-Law. 

Original Data Accuracy

Thoughts:

· Consider an Original Data Accuracy of 0.1, then reduce it to ap-

proximately 0.001. 

· Do not enter a value that is more accurate than the original ac-

curacy of the data. For example, if the data has 2 d.p. , then 0.05

OK, and 0.001 is not a sensible value. However, experiment, as

you find that more accuracy gives you better results.

· Is the skill of the person that measured the Cam-Profile a factor?

· Is the Cam-Profile clean? Is the Cam-Profile worn? Is the Cam-

Profile damaged?
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Machine Measurement Accuracy Approximations: per 100mm Dia-

meter of Cam Diameter:

· Temperature-Controlled (18-22ºC) CMM approximately 0.2 -

2µm

· Non-temperature-controlled CMM approximately 2 - 10µm (~h4

for a 100mm shaft)

· Portable CMM approximately 5 - 20µm (~h5-h6 for a 100mm

shaft)

· Test Rigs are variable, but you should aim for approximately 20 -

100µm (~h8-h9 for a 100mm shaft)
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1.5.11.40 Dialog: Function-Block: Design-Set

Design-Set FB

See Add Design-Set

Use DESIGN-SETS to edit a number of dimensions and parameters in one

place - with the DESIGN-SET DIALOG.

Add to a DESIGN-SET those dimensions and parameters that you believe to

be important to the outcome of a design-objective. 

You can add more than one DESIGN-SET.

Question:

Why use a DESIGN-SET?

Answers: Three good reasons:

A. Frequently, you edit the same dimensions and parameters in a model many

times to improve a design objective. You can add and edit them directly

with a DESIGN-SET. 

B. If you need to open the model after a period of time, a DESIGN-SET reminds

you of which dimensions and parameters are important to your design.

Also, you can give your model to a different engineer, and tell him to ONLY

edit the dimensions and parameters in the DESIGN-SET.

C. When dimensions are in a DESIGN-SET, you cannot only edit them with the

DESIGN-SET.

IMPORTANT

After you add a DIMENSION to a DESIGN-SET, you CAN ONLY use the DESIGN-

SET to edit that DIMENSION.

To edit a DIMENSION in the PART-EDITOR again, you must delete the DIMEN-

SION from the DESIGN-SET. 

A DIMENSION that is in the DESIGN-SET is gray in the PART-EDITOR - to indic-

ate you cannot edit it.

TOP-TIPS: 

1. Rename each dimension to a name that will help you know its function in

the DESIGN-SET. 

2. Rename each DESIGN-SET to remind of its design-objective.

See SHOW DIMENSION-NAMES  , and SHOW FUNCTION-BLOCK NAMES

How to open the Design-Set FB dialog

217

343 345
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Edit the DESIGN-SET FB

1. Double-click the DESIGN-SET FB in the graphics-area 

OR

1. See How to Open a dialog  

The DESIGN-SET DIALOG is now open.

Design-Set dialog

Design-Set toolbar

Design-Set dialog - LOCKED

Design-Set dialog - UNLOCKED

When you open the DESIGN-SET DIALOG, the toolbar is locked. It is NOT act-

ive.

The Design-Set toolbar icons - when active - are:

 : ADD ELEMENT-ROW

 : DELETE ELEMENT-ROW

 :  PADLOCK : LOCK / UNLOCK TOGGLE

 : REBUILD MODEL

 :  OK, CLOSE, UNDO EDITS, HELP

To enable the Design-Set toolbar icons

1. Click the PADLOCK icon . 

The icons in the toolbar are colorized and the DESIGN-SET interface is active.

Add or Delete Element-Rows

627
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Design-Set - 2 Element Rows

To add Element-Rows

1. Click the PADLOCK  - the toolbar is now colorized. 

2. Click ADD ELEMENT-ROW  one time for each dimension or para-

meter you want to add to the DESIGN-SET. 

In the image above, there are two Element-Rows .

The active Element-Row.

The active Element-row  has a white box around its perimeter.

To make a different Element Row the active Element-Row:

1. Click in the Select in graphics  label - or the parameter name 

To delete an Element-Row

1. Click the Select in Graphics label to make it the active Element-Row

2. Click DELETE ELEMENT-ROW

Link a Dimension to an Element-Row

1. If necessary, open the DESIGN-SET DIALOG 

2. Click the Select in graphics label of an Element-Row, so that it is the

active Element-Row.
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3. Edit a PART

4. Click the arrowhead of a DIMENSION in the PART-EDITOR 

Result:

The Dimension name  replaces the Select in graphics (DimPtoP4)

The Dimension Units name replace the Property Value (DimUnits)

The Dimension value  replaces the  Property Value (42.87580515)

The Locked Padlock  is colorized. In this state, you cannot overwrite

this Element-Row. 

The next Element-Row is the Active Element-Row (a white box is

around the Element-Row)

Maximum and Minimum 'Hard-Limits'

Maximum and Minimum 'Hard-Limits'

It is frequently useful to set maximum and minimum limits for each dimen-

sion or parameter in the Design-Set.

To edit the Maximum and Minimum limits:

1. Click the up/down arrow Min-Max button  - see image above

The Minimum and Maximum data-boxes are now active.

2. Edit the Minimum and Maximum values.

3. Continue to edit the Dimension  - but now it cannot be less-than the

Minimum or more-than the Maximum values.

Replace a Dimension or Parameter

To replace a Dimension or Parameter in an Element-Row with a different Di-

mension or Parameter.

1. Click the Dimension name to make it the Active Element-Row. 

2. Click a Locked Pink Padlock  it changes to an Unlocked Grey Pad-

lock. 

3. Click a different Dimension or Parameter in your model and graphics-

area.

4. Click the Unlocked Grey Padlock  so it is a Locked Pink Padlock.
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Parameter Lists in different Element-Types:

In addition to dimensions, you can link parameters from dialogs for different ele-

ment types with a Design-Set.

For example: Parameters of FBs, Parameters of a Gear-Pair, Parameters of a CAD-

Line, and other elements.

Link a Parameter (from a dialog-box) with an Element-Row

Select the Element-Type:

1. Open the DESIGN-SET DIALOG 

2. Click the Element-Row to make it the Active Element-Row

3. Click the PADLOCK icon in the Design-Set toolbar, to unlock the DESIGN-

SET.

4. Click the ELEMENT-TYPE in the graphics-area or the ASSEMBLY-TREE 

If the Element-Type has only one(1) PARAMETER

The PARAMETER passes immediately into the Element Row. 

If the Element-Type has two(2) or more PARAMETERS:

A list of PARAMETERS that you can select show in a box.

See below: 'Parameter Lists in different-elements' below. If you cannot

identify the PARAMETER from its name, then experiment.

1. Click the PARAMETER in the list 

2. Click the  button to close the PARAMETER box

The PARAMETER name and its value shows in the Element-Row in the

DESIGN-SET.

Available Element-Types and their Parameters

Linear-Motion Function-Block

When you click a LINEAR MOTION FB, you add: 

· LINEAR MOTION as the Element Name

· OUTPUTSTART_UNITS as the parameter.

OUTPUTSTART_UNITS   START-ANGLE parameter in the LINEAR-MOTION DIALOG.

Motion-Dimension Function-Block

When you click a MOTION-DIMENSION FB, you add:

MOT-DIM ROCKER (or SLIDER) as the Element Name

BASEUNITS as the parameter.

BASEUNITS   BASE-VALUE in the MOTION-DIMENSION DIALOG.
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Gearing Function-Block

Gear-Pair

 Do not select Phase1 or Phase2 for

the Design-Set.

Rack-Pinion / Ball-Screw

CAD-Line

Pulley

When you click a PULLEY, you add 
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· PATH JOINT as the Element Name 

· TOOTH-COUNT as the parameter.

TOOTH-COUNT   NUMBER OF PULLEY TEETH parameter in the PULLEY DIALOG.
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1.5.11.41 Dialog: Function-Block: Continuous-Crank

Continuous-Crank

See also Add Continuous-Crank

Usually, in a multi-part mechanism, you design the motion for a Tool-Part

(the Part with the tooling), and MechDesigner applies Inverse-Kinematics to

calculate the motion of a follower or a servomotor.

The follower usually oscillates or reciprocates.

A servomotor may also oscillate. However, there is also the case in which the

servomotor rotates completely, but with a non-uniform rotating speed. This

is a special-case. To enable this special-case, the rotating part must be the

correct length, and its motion, also derived by inverse-kinematics from the

motion of the Tooling, is more complex.

This is one application of the CONTINUOUS-CRANK FB.

How to open the Continuous-Crank FB dialog 

Edit the CONTINUOUS-CRANK FB:

1. Double-click the CONTINUOUS-CRANK FB in the

graphics-area 

OR

1. See How to Open a dialog  

The CONTINUOUS-CRANK DIALOG is now open.

Continuous-Crank dialog

Continuous-Crank dialog - not enabled

STEP 1: Select Crank Behavior

and Direction 

CRANK BEHAVIOR

CONTINUOUS - the PART rotates

continuously.

REVERSING - the PART rotates to

~180º, and then return back to

~0º.

CRANK DIRECTION 

If CRANK BEHAVIOR is CONTINU-

OUS, then:

COUNTER-CLOCKWISE - the

PART rotates in the

Counter-Clockwise direc-

tion

221

627
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CLOCKWISE - the PART ro-

tates in a Clockwise direc-

tion

If CRANK BEHAVIOR is REVERS-

ING, to change Crank closure,

see Change-Dyad Closure .

Continuous-Crank dialog- enabled

STEP 2: Activate the Not Selected

box 

1. Click in the box labeled

Not Selected

THE BOX IS NOW ORANGE. You

can now select a PART.

STEP 3: Click a Part that you want

to be the Continuous-

Crank

1. Click a PART in the graph-

ics-area or ASSEMBLY-TREE. 

The Continuous-Crank PART

must have a PIN-JOINT that

joins it to the BASE-PART.

The PART immediately changes

its length so that it can rotate

continuously or oscillate by 180º.

If there is a problem, see Mes-

sages at the bottom of the dia-

log.

STEP 4: Confirm the behavior is

as expected 

1. Do Run toolbar > Cycle

Continuously (ALT+C)

STEP 5: Click  to close the dia-

log.

Messages at the bottom of the

dialog: 

When you select a PART as the

Continuous Crank, there is be a mes-

sage at the bottom of the dialog.

119
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Message Mean-

ing

Valid The
PART

can be

a

Continu-

ous

Crank

Failed assign pivot-Point We

could

not find

for you

the ro-

tating-

axis.

Impossible crank length:

Geometry is inconsistent

For ex-

ample,

the MO-
TION-
PART

does

not

move,

and

thus the

length

of the

Crank

must

zero(0).

Continous-Crank dialog
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1.5.11.42 Dialog: Function-Block: Spring

Spring FB

See Add Spring FB

Use a SPRING FB to apply a force between two POINTS. The name that we use for

the two POINTS is ANCHOR-POINTS.

Force units are defined in the Machine-Settings dialog > Engineering Units  - de-

fault Force units are Newtons (N).

See also: 

Machine Settings > Engineering Units

Configure Power Source

How to open the Spring FB dialog

In Mechanism-Editor:

1. Double-click the SPRING-FB in the

graphics-area 

OR

1. See How to Open a dialog  

Note: It is not necessary to connect a wire to the input-connector or from

the output-connectors of the SPRING FB. The input and output-connectors

provide extra functionality - see Here

The SPRING DIALOG is now open.

Spring dialog

Spring FB dialog

SPRING PARAMETERS 

234

352

352

589

627

540
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þ Check-box to enable the SPRING FB.

SPRING-RATE: 

Force Contribution:

= SPRING-RATE ×  | SPRING-LENGTH – FREE-LENGTH |

SPRING-LENGTH is the distance between the two anchor-points. 

The Force always tries to move the anchor-point to the FREE-LENGTH

(They cannot, of course).

FREE-LENGTH:

The natural length of the Spring, when it is not joined to the ANCHOR-

POINTS. 

CONSTANT-FORCE: 

A positive force PULLS the ANCHOR-POINTS together (o>>> + <<<o)

A negative force PUSHES the ANCHOR-POINTS apart (o<<< — >>>o)

VELOCITY PARAMETERS 

COULOMB (CONSTANT) FRICTION FORCE (Ff =  .Fn )

A CONSTANT FORCE that is opposite to the direction of the motion. 

You can use it to approximate a Friction-Force.

Note: Friction Force is NOT constant in general. Friction-Force is pro-

portional to the Contact-Force between two bodies, and the Contact-

Force is not generally constant.

VISCOUS COEFFICIENT (Fv V ( N/(mm/s) )

A Force that is proportional to the relative velocity between the POINTS.

The Force is opposite to the direction of motion.

For example, if the DAMPING COEFFICIENT = 4 and the VELOCITY IS +100MM/S,

(anchor points moving away from each other), the force pulling the points

together is a force of 400N.

DRAG FACTOR (Fd V2) ( N/((mm/s)2 ) )
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A Force that is proportional to square of the relative velocity between

the POINTS. For example, air resistance.

The Force is opposite to the direction of motion.

For example, if the DRAG FACTOR = 4, and the VELOCITY = +100MM/S (anchor-

points are moving apart), then the force pulling the anchor-points together

is a force of 40000N.

INPUT AND OUTPUT-CONNECTORS

OUTPUT-CONNECTORS

The SPRING-FB has two output-connectors.

TOP : 
Distance, Velocity, Acceleration of the dimension

between the ANCHOR-POINTS.

BOTTOM : 

Total Force, Force-X, Force-Y acting on ANCHOR-

POINTS.

OR 

Driving-Force = Linear Motive Force, if you configure

the SPRING FB as a LINEAR MOTOR - see Configure Power

Source

INPUT-CONNECTOR - see more at Spring FB dialog

The SPRING-FB has one input-connector.

Connect a wire to the input-connector of a SPRING FB to add a Force-

Function to the Total-Force that is exerted by the SPRING-FB. 

The units of the data-values at the input-connector must be Force, for

example, Newtons. 

If necessary, use a MATH FB to convert values and units to Force units.

For example: To convert 100mm at the input to a MATH FB to 100N, you

must:

1. Change the Output Data Type to Force (N) - see Math FB dialog

> Output data-type  

AND

2. Multiply the input-value by 1000 to convert 0.1m to 100N

589

540

510
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1.5.11.43 Dialog: Function-Block: Force-Data

Force-Data FB

See: Add Force-Data FB  , Configure Power Source

Use the FORCE-DATA FB to measure the Force that acts ON a POINT at a Joint,

Spring, or the Contact-Point of a 2D-CAM.

To use the FORCE-DATA FB correctly, you must also do CONFIGURE POWER

SOURCE . 

How to open a Force-Data dialog

To open a FORCE-DATA DIALOG:

1. Double-click the FORCE-DATA FB in the

graphics-area. 

OR

2. See How to Open a dialog

The FORCE-DATA DIALOG is now open.

Force-Data dialog

Force-Data dialog

 SELECTION 

STEP 1. Select a Force Element: 

A Force-element is a: JOINT, CAM,

GEAR, RACK, BALL-SCREW or a SPRING

1. Click a Force element in the

graphics-area or the ASSEMBLY-

TREE. 

The Force element should now be in the

SELECT FORCE ELEMENT box

<<< in the image: Pin-Joint is the Force

element

In the box below:

A list of AVAILABLE POINTS, each with a

Point Owner

Each AVAILABLE POINT is a child to the

Force element

STEP 2. Select a Point: 

230 232

589

627
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1. Click a POINT in the AVAILABLE-

POINTS box, above

A POINT should now be in the SELECTED

FORCE OUTPUT ELEMENTS box

The output from the FORCE DATA FB is

the Force ACTING ON the selected

POINT.

List of AVAILABLE-POINTS for each type of Force element

· PIN-JOINT - there are 2 AVAILABLE POINTS

Each POINT that makes the PIN-JOINT.

· SLIDE-JOINT - there are 4 AVAILABLE POINTS

Two POINTS on each LINE that make the SLIDE-JOINT.

· 2D-CAM  - there are 0 AVAILABLE POINTS

The CONTACT POINT is assumed.

· SPRING FB  - there are 2 AVAILABLE POINTS 

The POINT that anchors each end of the SPRING FB.

128

234
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1.5.11.44 Dialog: Point Properties

Point Properties

Use the POINT-PROPERTIES DIALOG to:

· Show the Velocity Vectors and Acceleration Vectors of a POINT*. 

· Show the magnitude of the Velocity Vector, or, the Velocity Vector with re-

spect to the X, Y or Z axis.

· Find the X and Y coordinates of a POINT* on the XY-Plane of the MECHAN-

ISM-EDITOR.

· Find the x, y, and z coordinates of a POINT* on the xyz-axes of the PART to

which the POINT is a child.

· Edit the x, y, and z coordinates of a POINT* in a PART - but ONLY if the pos-

ition of the POINT* is not limited by ANY dimensions or ANY constraints.

* POINT, START-POINT, END-POINT, CENTER-POINT.

How to open the Point Properties dialog

To open the POINT PROPERTIES DIALOG

1. Double-click the POINT in the graphics-area 

OR

1. See How to Open a dialog  

The POINT PROPERTIES DIALOG is now open.

Point Properties dialog

Point-Properties dialog

 KINEMATIC VECTORS 

627



544

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

VELOCITY and ACCELERATION VECTOR

 check-boxes

q SHOW VELOCITY VECTOR - evalu-

ated at each machine step with

closed-form algorithms

q SHOW ACCELERATION VECTOR -

evaluated at each machine step

with closed-form algorithms

q SHOW NUMERICAL VECTORS - cal-

culated numerically with a

simple difference algorithm. 

NOTE: 

Usually, do not show the NUMERICAL

VECTORS. If you do show them, you will

need use the Machine-Angle Indicator

to jog the MMA backwards and for-

wards a small angle to calculate the

values correctly.

If you show VELOCITY and ACCELERATION VECTORS, or both:

· The length of the VECTOR is proportional to the POINT'S instantan-

eous Velocity and Acceleration.

· The direction of the VECTOR is in the direction of the Velocity and

Acceleration

· The magnitude of the VECTOR is at the arrowhead

See Edit menu >Application-Settings > Graphics > Display Colors to

edit the color of the vectors.

SCOPE

Calculate and display the Velocity and Acceleration Vectors relative to

the: 

· LOCAL xyz axes - MECHANISM AXES (default)

· GLOBAL XYZ axes - MODEL AXES.

VELOCITY VECTOR OPTIONS

Display Velocity Vectors as: 

· MAGNITUDE (default) of the Velocity, or

· X COMPONENT only of the Velocity, or

· Y COMPONENT only of the Velocity, or

· Z COMPONENT only of the Velocity

These can be useful to compare the X (or Y or Z) velocity components of a

POINT with the velocity of a Conveyor, for example.
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Velocity and Acceleration Vectors

Scale and Length of Vectors

Edit the length of the vectors, use the

buttons in the Feedback-Area :

Velocity / Acceleration

buttons

V Click  to increase or  to de-

crease the length of the Velocity

Vector

A Click  to increase or  to de-

crease the length of the Acceleration

Vector 

See: App-Settings > Graphics tab  >

DISPLAY COLORS | VEL/ACC VECTORS

 MECHANISM COORDINATES (READ-ONLY) 

The POINT'S Mechanism Coordinates (X,

Y, Z ) are relative to the Origin of the

MECHANISM-PLANE (XY-Plane of the

MECHANISM-EDITOR), and also the BASE-

PART.

The X, Y, Z dimensions are read-only.

 POINT COORDINATES: READ-WRITE 

Point with Constraints

A POINT with Constraints

If you have used the PART-EDITOR to

add one or more constraints or di-

mensions to locate the POINT in the

PART, ...

... you cannot edit the POINT'S x, y,

or z coordinates in this dialog.

Point without Constraints

326

345
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A POINT without Coordinates

If the POINT does not have a con-

straint or dimension to locate the

POINT in the PART, ...

...  you can edit the position of the

POINT in this dialog.

LOCK AND EDIT POINT'S POSITION:

¤ LOCK AND EDIT HERE

You can only edit the POINT'S X,

Y and/or Z coordinates in this

dialog.

You cannot add a constraint or

dimension to the POINT in the

PART-EDITOR.

¤ EDIT IN PART-EDITOR 

You cannot edit the POINT'S X, Y

and/or Z coordinates in this dia-

log.

You can only use the PART-ED-

ITOR to add constraints and di-

mensions to locate the POINT.
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1.5.11.45 Dialog: Dimension

Dimension dialog

Use the DIMENSION DIALOG to edit a DIMENSION.

The DIMENSION DIALOG opens immediately when you add a DIMENSION to a

sketch-element.

IMPORTANT: 

You cannot open the DIMENSION DIALOG when a command is active - even if

Add Dimension is the active command.

Deselect all commands to edit a DIMENSION. E.g. Right-click your mouse, or

press the ESC key on your keyboard.

How to open the Dimension dialog (in the Part-Editor)

Edit a dimesnion

In the PART-EDITOR, to open the DIMENSION
DIALOG:

1. Deselect ALL commands 

2. Double-Click the arrowhead of a DI-

MENSION 

OR

1. See How to Open a dialog  

Note: Nothing happens if you click the dimension number - R34.46 in the

image above.

The DIMENSION DIALOG is now open.

 Dimension dialog

Dimension dialog

To edit the DIMENSION parameter-value in the DIMENSION DIALOG, do

one or all of these: 

· Enter a value, and press the enter key ( ) on your keyboard, OR

· Enter an equation, and press the enter key ( ) on your keyboard,

OR

· Use the Spin-Box tool, OR

627
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· Right-click the data-box, and use the Zero / Round / Copy / Paste

shortcut menu

See also: How to edit a parameter in a dialog 631
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1.5.11.46 Dialog: Blend-Curve

Blend-Curve

See also Add Blend-Curve

About the Blend-Curve

A BLEND-CURVE is a sketch-element that has a START-POINT and an END-

POINT.

Use the BLEND-CURVE DIALOG to edit geometric-properties AT its START-

POINT and AT its END-POINT. The properties you can edit are its:

· ANGLE 

· CURVATURE 

· CURVATURE RATE 

· VELOCITY SCALING - a parameter that influences the overall shape

between the START-POINT and END-POINT.

Typically, you merge the START-POINT and/or END-POINT of the BLEND-CURVE

with other sketch-elements. 

The default geometric-properties make sure that the BLEND-CURVE has geo-

metric continuity  with adjacent sketch-elements.

CASE 0 : You do NOT merge the BLEND-CURVE with another sketch-ele-

ment. You can edit these geometric-properties at its START-POINT and END-

POINT:

· ANGLE (default = 0)

· CURVATURE (default = 0)

· CURVATURE RATE (default = 0)

CASE 1 : You do merge the START-POINT and/or END-POINT of the BLEND-

CURVE with a LINE.

· ANGLE is equal to the angle of the LINE

· CURVATURE is equal to zero

· CURVATURE RATE is equal to zero

CASE 2 : You do merge the START-POINT and/or END-POINT of the BLEND-

CURVE with an ARC.

· ANGLE is equal to the tangent of the ARC 

· CURVATURE is equal to 1 / Radius of the ARC (m)

· CURVATURE RATE is equal to zero

CASE 3 : You do merge the START-POINT and/or END-POINT of the BLEND-

CURVE with a BLEND-CURVE.

Edit the END-POINT of a BLEND-CURVE that you merge with the START-

POINT of an adjacent, or following, BLEND-CURVE.

 In the BLEND-CURVE DIALOG, edit the:

286
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· ANGLE : Disable the END-POINT ANGLE check-box: edit the ANGLE -

the angle of the adjacent BLEND-CURVE with equal the angle you

enter.

· CURVATURE : Disable the END-POINT CURVATURE check-box: edit

the CURVATURE - the curvature of the adjacent BLEND-CURVE with

equal the curvature you enter.

· CURVATURE-RATE : Disable the END-POINT CURVATURE-RATE check-

box: edit the CURVATURE-RATE - the curvature-rate of the adjacent

BLEND-CURVE with equal the curvature-rate you enter.

You can edit the geometric-properties

· Exactly : with the Blend-Curve dialog  

· Approximately : with the Blend-Curve drag-handles .

Edit Exactly

Open the Blend-Point dialog

In the PART-EDITOR or the MECHANISM-EDITOR:

1. Double-click the BLEND-CURVE in the

graphics-area 

OR

1. See How to Open a dialog  

The BLEND-CURVE DIALOG is now open.

Blend-Curve dialog

Blend-Curve dialog

There are two separators:

  START-POINT...

  END-POINT...

The parameters are the same for the

two separators.

550
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 START POINT ...  / END POINT ...

ANGLE (UNITS: º):

BLEND / FREE check-box:

þ (DEFAULT) The ANGLE of the

BLEND-CURVE (at its START-

POINT / END-POINT) is equal to

the ANGLE of the adjacent

sketch-element 

q Edit the ANGLE of the BLEND-

CURVE (at its START-POINT / END-

POINT).

CURVATURE K (UNITS:1 METER):

BLEND / FREE check-box:

þ(DEFAULT) The CURVATURE of

the BLEND-CURVE (at its START-

POINT / END-POINT) is equal to

the CURVATURE of the adjacent

sketch-element.

qEdit the CURVATURE for the

BLEND-CURVE (at its START-

POINT / END-POINT).

CURVATURE-RATE DK DS (UNITS: 1  

M^2):

BLEND / FREE check-box:

þ The CURVATURE-RATE of the

BLEND-CURVE (at the START-

OINT / END-POINT) is equal to the

CURVATURE-RATE of the adjacent

sketch-element 

q (DEFAULT) Edit a CURVATURE-

RATE for the BLEND-CURVE (at its

START-POINT / END-POINT).

VELOCITY SCALING (NO UNITS)

Increase VELOCITY-SCALING to in-

flate the balloon!

Decrease VELOCITY-SCALING to de-

flate the balloon!

VELOCITY SCALING does not have

units. 
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Default = 1 ; Maximum = 10 ; Min-

imum 0.01

Edit Approximately

Enable / disable Blend-Curve drag-handles

Drag handles in the Graphic-Area

To show the Drag-Handles

1. Click the BLEND-CURVE one time

 

Now, you can see the Drag-Handles at

the START-POINT and the END-POINT 

There are two(2) Drag-Handle types:

 Arrowhead Drag-Handle

 Circle Drag-Handle (difficult to

see)

Blend-Curve drag-handles

Arrowhead Drag-Handle

Arrowhead Drag-Handles - this con-

trols the ANGLE and the VELOCITY-SC-

ALING FACTOR

1. Double-click an Arrowhead

Drag-Handle to enable it. 

When the Drag-Handle is blue,

it is enabled.

2. Drag the blue arrowhead relat-

ive to the START-POINT (or END-

POINT): 

 Rotate the arrowhead about

the START-POINT (or END-POINT) to

control the ANGLE of the BLEND-

CURVE.

 Move the arrowhead away

from the START-POINT (or END-

POINT) to increase the VELOCITY-

SCALING FACTOR

3. Double-click the Arrowhead

Drag-Handles again. 

When the Drag-Handle is

green, it is disabled.
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Circle Drag-Handle

Circle Drag-Handle - this controls the

CURVATURE

1. Double-click a Circle Drag-

Handle (difficult to see!) 

When the Drag-Handle is blue

(difficult to see!), it is enabled.

At the default position (vertic-

ally-up), the CURVATURE = 0 (a

straight-line).

2. Drag the blue circle around

the START (OR END-)POINT: 

 In a clockwise direction to in-

crease the +ve CURVATURE

 In a counter-clockwise direc-

tion to increase the -ve
CURVATURE

When the blue circle is vertically-

down the CURVATURE is a large

+ve or –ve value.

3. Double-click the Circle Drag-

Handle again. 

The Drag-Handle is now green.

You cannot drag the handle.

Note on Curvature and Curvature-Rate

Curvature and Curvature-Rate

CURVATURE (k) ; the inverse of RADIUS-OF-CURVATURE (R);

The Radius-of-Curvature and Curvature of simple sketch-elements are

constant. For example:

· Radius-of-Curvature of a Line = ; Curvature of a Line = 0 ;

· Radius-of-Curvature of an Arc or Circle = Radius ; Curvature of a

Circle = 1 Radius

To add numbers: 

· A Circle of Radius = R20mm : Radius-of-Curvature=20mm, Curvature

=1/0.02m = 50/m.

CURVATURE-RATE = dk/ds

Curvature-Rate : the rate-of-change of curvature (k) with respect to the

displacement (s) along the curve.

The Radius-of-Curvature and Curvature of a simple sketch-elements

(Lines and Circle/Arcs) are constant
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The Radius-of-Curvature and Curvature of general sketch-elements,

typically a named curve, e.g. Splines, Bezier-Curves, can continually

change along their length.

Blend-Curve

The Blend-Curve is the only sketch-element you can add with which you

can control its Curvature and Curvature-Rate.
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1.5.11.47 Dialog: Import SOLIDWORKS Sketch FB

Import SOLIDWORKS Sketch FB

See also : Add Import SOLIDWORKS Sketch FB

See also: CAD-Line > DXF tab

Use the IMPORT SOLIDWORKS SKETCH FB to import sketches from a

SOLIDWORKS document.

Limits: 

· Imports Lines and Arcs 

· Cannot import Blocks, Parabolas, Ellipses, ...

· Maximum of approximately 20 sketch-elements

· Construction and center-lines import as Lines

· Constraints do not import 

· By default, all Points, Lines, and Arcs are Locked. To unlock, see Point Prop-

erties dialog .

How to open the Import SOLIDWORKS Sketch dialog 

Import SOLIDWORKS Sketch FB in

PART-EDITOR

1. MECHANISM-EDITOR: Edit the

PART to which you have added

the IMPORT SW SKETCH FB 

2. PART-EDITOR: Double-click the
IMPORT SW SKETCH FB

OR

2. See How to Open a dialog  

The IMPORT SOLIDWORKS SKETCH DIALOG is now open.

Import SolidWorks Sketch dialog

STEP 1: In SOLIDWORKS

1. Edit a SOLIDWORKS sketch to

make it active 

This image shows the active sketch in

SOLIDWORKS.

289
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Import SolidWorks sketch dialog

STEP 2. Import the active in

SOLIDWORKS 

IMPORTANT: 

The sketch must be active in

SOLIDWORKS.

In the IMPORT SOLIDWORKS SKETCH DIA-

LOG:

1. Click button  

Document name  - a copy of the

active SOLIDWORKS document

(SLDPRT) file-name 

Sketch name  a copy of the act-

ive sketch name, as it is in the

SOLIDWORKS feature-tree

Button  is colorized.

2. Click button  

WAIT until the SOLIDWORKS sketch

shows in your PART-EDITOR. 

Button  is now colorized.

If you edit the sketch in SOLIDWORKS :

3. Click button  to Refresh, or Up-

date the sketch 

Note: To use the same IMPORT SW

SKETCH FB to import a different

SOLIDWORKS sketch:

4. Click button  to clear the Docu-

ment name and the sketch-name

from  and  

This image shows the active sketch in the

MechDesigner graphics-area.
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1.5.11.48 Dialog-Transition-Curve

Transition Curve

see Add Transition Curve

How to open the Transition-Curve dialog

Edit Transition-Curve

Use the PART-EDITOR, to open the TRANS-

ITION-CURVE DIALOG

1. Edit the PART that includes the TRANS-

ITION-CURVE.

2. Click a TRANSITION-CURVE element

(the curve or the Line at its 'center') in

the graphics-area

In the SELECTION-WINDOW:

3. Right-click the TRANSITION-CURVE

4. Click Edit element. in the shortcut

menu

OR

1. See How to Open a dialog  

The TRANSITION-CURVE DIALOG is now open.

Transition-Curve dialog

Gearing FB dialog

 ANALYSIS  

293
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Ratio and Phase

Curvature

q SHOW CURVATURE CURVE ON TRANSITION

Enable to show the Curvature as a curve that is offset from the TRANS-

ITION-CURVE sketch-element.

We do not show the actual curvature value.

Messages:

· This Transition-Curve has valid geometry  

The Curve always has valid geometry.

Valid Geometry

TRANSITION CURVE PARAMETERDS 

NUMBER OF TEETH IN ADJACENT SPROCKET (#)

CHAIN LINK LENGTH (mm)

1 - Transition-Curve 

2 - Mirror Transiiton-Curve

q MIRROR POINTS

Enable to mirror the TRANSITION

CURVE to the other side of the LINE

that you drag when you do Add

Transition-Curve.

For example, in the image:

Curve  is the TRANSITION-CURVE

that is a mirror of TRANSITION-CURVE

  

ADVANCED 

Read-Only - DESIGN-ANGLE

The angle between:

 - a line perpendicular to the line

you add when you do Add

Transition-Curve

 - a line from the CENTER-POINT of

the TRANSITION-CURVE to the

END-POINT of the TRANSITION-

CURVE.
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1.5.11.49 Dialog: Ball-Joint

Ball-Joint

See: Add Ball-Joint . Tutorial 12: Design a Spatial Mechanism

Use the BALL-JOINT for spatial mechanisms. 

You must add a BALL-JOINT to each end of one PART. 

Connecting-Part : the derived name of a PART that has a BALL-JOINT at each

end.

One of the two BALL-JOINT joins the Connecting-Part to a PART (frequently, a

Motion-Part) in a different MECHANISM-EDITOR.

The other BALL-JOINT, at the other end of the Connecting-Part, joins it to a

PART in the active MECHANISM-EDITOR.

How to open the Ball-Joint dialog

There are two BALL-JOINTS, with one at

each end of a Connecting-Part.

The BALL-JOINT element symbol may be

“inside” the symbol of the Connecting-

Part.

1. Move your mouse-pointer above

the end of the Connecting-Part

until the symbol for the BALL-JOINT

is red - see image. 

2. Click the symbol for the BALL-JOINT

. 

The BALL-JOINT element should be

in the SELECTION-WINDOW 

3. Right-click the BALL-JOINT in the

SELECTION-WINDOW 

4. Click Edit Element in the shortcut

menu.

Ball-Joint in the Selection-Window

The BALL-JOINT DIALOG is now open.

114
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Ball-Joint dialog

Ball-Joint dialog

BALL DIAMETER

Diameter of the Ball symbol in

graphics-area.

BALL-DIAMETER does NOT change

the Kinematic-Analysis.

BALL OFFSET (±)

Perpendicular distance (±) from the

MECHANISM PLANE to the center of

the BALL-JOINT.

BALL-OFFSET does change the

Kinematic-Analysis.

BALL MASS

Mass of the BALL-JOINT.

Its center-of-mass is coplanar with

the MECHANISM-PLANE. even if the

BALL-OFFSET 0.

Example of Ball-Offset : Z = 10mm

<<< the image shows the model from

the left view - View toolbar > View Left

(Shortcut : F7).

 BALL-JOINT : on the MECHANISM-

PLANE when BALL-OFFSET = 0mm.

 In the image the BALL-OFFSET =

+10mm in the +Z-axis direction.

When to use the BALL-OFFSET parameter?

The symbols of all other Kinematic elements are on the MECHANISM-

PLANE. However, the center of a BALL-JOINT is frequently not on the MECH-

ANISM-PLANE. The kinematic-analysis is correct only when the distance to

the center of the BALL-JOINT from the MECHANISM-PLANE is also correct.

See also: Ball-Joint Configurations

1.5.11.50 Dialog: Magnetic-Joint

Magnetic-Joint

Terminology

MAGNETIC-JOINT : A MAGNETIC-JOINT pulls a circular PROFILE to be in

continuous contact with an irregular PROFILE (or

CURVE). 

The circular PROFILE and irregular PROFILE (or

CURVE) are in different kinematic-chains. After you
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add a MAGNETIC-JOINT, the motion of the two kin-

ematic-chains are related by the contact between

the circular and irregular PROFILES (or CURVE).

Irregular Shape : The Irregular Shape can be PROFILE from a sketch-

loop, or a CURVE that we calculate from a Point-

Cloud. 

Point-Cloud : X-Y or coordinates. Use a POINT-CLOUD FB to

import the Point-Cloud coordinates.

CURVE : The smooth shape that we calculate for you from

the Point-Cloud coordinates - see POINT-CLOUD

DIALOG .

How to open the Magnetic-Joint dialog

See also: Add Magnetic-Joint .

Before you edit a MAGNETIC-

JOINT: 

1. Click the HOME key on your

keyboard to move the

MMA to zero. 

2. Click a MAGNETIC-JOINT

FB in the graphics-area (see

image to the left)

The MAGNETIC-JOINT element

is in the SELECTION-WINDOW

3. Right-click the MAGNETIC-

JOINT element in the SELEC-

TION-WINDOW

4. Click Edit element in the

shortcut menu.

OR

1. See How to Open a dialog  

Note: There are three states for the MAGNETIC-JOINT icon in the graphics-

area.

Magnetic-Joint is enabled and we find a solution.

Magnetic-Joint is enabled but we do not find a solution.

Magnetic-Joint is disabled.

484

99
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Magnetic-Joint dialog

Magnetic-Joint dialog

The Magnetic-Joint dialog has

three separators:

 FOLLOWING OPTIONS 

 RADIUS CONTROL 

 ADVANCED 

 FOLLOWING OPTIONS 

þ ENABLE MAGNETIC-JOINT

check-box

The circular PROFILE is in continuous

contact with the irregular PROFILE or

POINT-CLOUD .

q DISABLE MAGNETIC-JOINT

check-box

The circular PROFILE moves to the

BASE-VALUE (Linear or Angular posi-

tion) as specified by the MOTION-DI-

MENSION FB that was in continuous

contact with the irregular PROFILE.

OUTSIDE

The circular PROFILE  moves to the

external (outer) side of the irregular
PROFILE .

INSIDE

The circular PROFILE  moves to the

internal (inner) side of the irregular
PROFILE .

Note: 

The INSIDE option does not find a

solution as successfully as the OUT-

SIDE option.

 RADIUS CONTROL 

206
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Optionally, edit the effective radius of

the Circular PROFILE.

q NOT OVERRIDING CIRCLE RADIUS

(default)

þ MODIFY CIRCLE RADIUS

For example:

RADIUS = 0MM

When the RADIUS is 0mm, the center

of the Circular PROFILE moves along

the Irregular Profile as normal.

RADIUS = 3MM

When the RADIUS is 3mm (for ex-

ample), the center of the Circular

Profile is 3mm inside the Irregular

Profile.

This is useful if you use a CMM machine

with a probe diameter that is different

to the Follower-Roller, and the CMM

software does not have Probe Com-

pensation.

When the CMM data does not com-

pensate for the Probe Diameter, you

would enable Modify Cycle Radius to

recreate the contact between the ir-

regular-Profile and the Follower-

Roller.

Offset Profile Radius = Radius of Ac-

tual Follower-Roller – Radius of

CMM Probe

R = Rcf – Rp

Rcf = Follower-Roller Radius; 

Rp = CMM Probe Radius.

ADVANCED  (WITH NOTES)
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4 Possible Contact Solutions between

Circular-Profile and a simple

Irregular-Profile

Notes: 

When you add a MAGNETIC-JOINT,

we use for you numerical techniques

to find the contact of the Circular

Profile with the Irregular Profile.

To humans, it is easy to see the con-

tact that you want. But mathematic-

ally, even when the Irregular-Profile

is a simple shape, there are usually a

minimum of 4 solutions - see image

to the left. MechDesigner may find

the solution you want, or a solution

you do not want, or even fail to find

a solution at all.

BEFORE YOU ADD THE MAGNETIC-

JOINT - it is best to edit the BASE-

VALUE parameter in the MOTION-

DIMENSION FB, to put the Circular

Profile within 0.5 x Radius of Circu-

lar-Profile. 

To edit the starting position of the Cir-

cular-Profile

1. Run menu > Home (or use the

Alt+H keyboard shortcut) to

put the MMA at 0.

2. Open the MOTION-DIMENSION

DIALOG  to be controlled by

the MAGNETIC-JOINT.

3. Edit the BASE-VALUE to posi-

tion the Circular-Profile to be

  0.5 × Radius of the Circular-

Profile from the Irregular-Pro-

file.

The factors in ADVANCED help us to find

for you the solution you want.

RESET RANGE FACTOR (DEFAULT = 2) 

This factor limits the range of values

within which to search for a solution

for the MOTION-DIMENSION, when

the model is at the HOME position

(MMA = 0). 

Magnetic-Joiont dialog

Advanced parameters
466
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A RESET RANGE FACTOR = 1 is equal

to the 1 × Radius of the Circular

Profile. 

The smaller RESET RANGE FACTOR,

the nearer you should edit the BASE-

VALUE to put the Circular Profile to

the Irregular-Profile before you

add the MAGNETIC-JOINT.

RUNNING RANGE FACTOR (DEFAULT

= 1)

MechDesigner must find a solution

for contact between the Circular

and Irregular-Profiles at all steps in

the machine-cycle. There are fre-

quently at least 4 solutions - see im-

age, left and top.

However, the solution at any step in

the machine-cycle should not be

hugely different from the previous

solution.

Use the RUNNING RANGE FACTOR to

limit the range of MOTION-DIMEN-

SION values within which to search

for a solution from the previous

solution, at each step of the solution

cycle.

RUNNING RANGE FACTOR = 1 is equi-

valent to 1 × Radius of Circular-Profile

that is contact with the Irregular-Pro-

file.

Reduce the RUNNING RANGE FACTOR

if the Circular-Profile does not re-

main in contact with the Irregular-

Profile, as you cycle the model.
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1.5.11.51 Dialog: Gear-Pair

Gear-Pair

See: Add Gear-Pair

Gear Terminology

Gear-Wheel (or Gear) : A rotating-Part with gear-teeth at a fixed diameter. You

control its diameter with the number-of-teeth and module.

GEAR-PAIR : Two inter-locking gear-wheels. Their teeth have External or

Internal mesh. The angular velocity of each gear-wheel is

related by the number-of-teeth on each gear-wheel, and the

type of mesh.

Driving Part : The rotating-Part that is kinematically-defined, and whose

motion you control (even if it is stationary) before you do

Add Gear-Pair.

Driven Part : The rotating-Part whose motion you control by the motion

of the Driven-Part, the NUMBER-OF-TEETH on each gear-

wheel in the GEAR-PAIR, and the MESH.

Gear-Mesh (or Mesh) : Inter-locking gear-teeth of a GEAR-PAIR that transmit torque

and motion from the Driving Part to the Driven Part.

External Mesh : The gear-teeth of the two gear-wheels point outwards from

their centers-of-rotation.

Internal Mesh : The gear-teeth of one gear-wheel point inwards towards its

center-of-rotation.

Simple Gear-Pair : Two gear-wheels that rotate about two fixed centers.

Epicyclic Gear-Pair : One gear-wheel orbits around the center of the other gear-

wheel.

How to open the Gear-Pair dialog

Example External Gear-Pair

Edit the GEAR-PAIR:

1. Double-click a GEAR-PAIR in the

graphics-area or ASSEMBLY-TREE. 

OR

1. See How to Open a dialog  

The GEAR-PAIR DIALOG is now open.

141
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Gear-Pair dialog

Gear-Pair dialog

There are three tabs in the GEAR-PAIR

DIALOG. 

Define tab

Adjustments tab

Parameters tab

Define tab

 GEAR MESH AND # TEETH   

GEAR MESH - see Terminology above

o EXTERNAL

OR

o INTERNAL

 Read-only

GEAR CENTER-DISTANCE 

 See also CENTER-DISTANCE CALCULA-

TION in Adjustments tab

NUMBER-OF-TEETH, Z
1
 (Minimum =5)

The NUMBER OF-TEETH on the input-

gear - usually the Driving-Gear

NUMBER-OF-TEETH, Z
2
 (Minimum = 5)

The NUMBER OF-TEETH on the output

gear - usually the Driven-Gear

 GEAR SEGMENTATION PARAMETERS 

568
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Notes: 

A GEAR-SEGMENT must not rotate

fully. It must oscillate.

GEAR # SEGMENTATION 

¤ COMPLETE GEAR - a normal, or

full gear

¤ GEAR SEGMENT - a gear that is not

complete, it has fewer teeth.

Gear 1 and/or Gear 2 can be a GEAR-

SEGMENT

To reduce the number-of-teeth of

Gear 1 and/or Gear 2:

1. Select GEAR-SEGMENT for Gear

1 and/or Gear 2

2. Edit the START-ANGLE : Min-

imum = 0, Maximum = 360

3. Edit the SEGMENT RANGE : Min-

imum = 0; Maximum 360

Adjustments tab

 ADJUSTMENTS  

GEAR-SLIP (DEGREES)

These parameters rotate Gear 1 and

Gear 2 around at the PIN-JOINT.

This parameter rotates the gear

teeth. It does NOT rotate the PART. I

have never used this parameter.

 TOP-TIP: 

If you add a Gear-Slip to one Gear,

then, to keep the gears in mesh: 

Gear-Slip 2 = – (# Teeth,z1 / #

Teeth, z2) × Gear-Slip 1

E.g.: Gear-Slip 1 = 2 degrees, # Teeth,

z1 = 120, # Teeth, z2 = 40.

Gear-Slip 2 = –(120/40)*2 = –6 de-

grees.

CLEARANCE (MOVE GEARS APART)
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This parameter changes the length of the Line-of-Centers, the center-

distance, between the Gears.

Usually, CLEARANCE is a +ve value for External Gears, and a –ve value for

Internal Gears. See Notes on recommended backlash.

An alternative way to change the clearance is to reduce (by machining) the

size of the gear-teeth and not to change the center-distance. We do not in-

clude for you a parameter with this deign option. However, it is the standard

method to provide backlash in commercial gear-boxes. Talk with the gear

supplier, machinist.

Center-Distance Calculation

If EXTERNAL MESH, then CENTER-DISTANCE = Clearance + (Module×(Number-

of-Teeth Gear1+Number-of-Teeth Gear2)÷2)

If INTERNAL MESH, then CENTER-DISTANCE = Clearance + (Module×(Number-

of-Teeth Gear1-Number-of-Teeth Gear2)÷2)

Notes: 

Recommend Backlash / Clearance.

· Minimum: 0.006 × (center-distance)0.5

· Maximum: 0.024 × (center-distance)0.5

Also, I have read that:

· Minimum normal backlash = 0.03 × module + 0.05 mm

If the torque reverses each machine cycle, then you should aim for the min-

imum recommended backlash.

Parameters tab

 GEAR TOOTH PARAMETERS 
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MODULE , m 

Module, m = P.C.D (in mm) Number-

of-Teeth. 

If you increase module, the diameter of

the Gears increases.

The module of the gears in the GEAR-

PAIR are equal.

PRESSURE-ANGLE   - default = 20º 

Standard gears are 20º. 

Other standards are: 

· 14º, 17.5º (weaker, quieter), 

· 22.5º and 25º (stronger, noisier).

ADDENDUM, ha - default = m. 

The radial height of the gear tooth

from the Pitch Circle to the top of

the tooth.

DEDENDUM, hf - default = m × 1.25. 

The radial depth of the gear tooth

below the Pitch Circle to the root of

the tooth. 

The DEDENDUM is usually larger than

the ADDENDUM to give a working-

clearance for the teeth.

If 0.25<m<1, Dedendum is usually =

m × 1.4

If m>1, Dedendum is usually = m ×

1.25

ROOT-RADIUS, rf - Default is 0.3 × m

The small fillet between the Flank

and the Root of the Gear Tooth. 

Note: In reality, if the gear is manufac-

tured from a Hob/Rack Cutter, then the

root of the gear is a Trochoid.

# POINTS ALONG PROFILE

The number of facets and points

along the gear tooth flank (and

around the two Root Radii). 

To display Gears more accurately,

increase the number of points. Gen-

erally, do not increase the number
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of Points along the Profiles without

a good reason.

4 is OK. 10 is accurate, but not usu-

ally needed. 

For information:

WORKING CLEARANCE = DEDENDUM -

ADDENDUM

WORKING DEPTH = ADDENDUM × 2

TOTAL DEPTH = ADDENDUM +

DEDENDUM

 GEAR PARAMETERS   

ALL READ-ONLY

CONTACT-RATIO: 

Contact-Ratio should not be less

than 1.1. Contact-Ratio should be a

minimum of 1.2 for working gears.

WORKING CLEARANCE = DEDENDUM -

ADDENDUM 

[Note: the units should be [m] not

[mm], or let Working-Clearance[mm] =

Working-Clearance × 1000]

The distance between the top land

of a gear tooth and the bottom land

of the gear with which is meshed.

GEAR 1 PCD AND GEAR 2 PCD

PCD = Pitch Circle Diameter. 

PCD = Module × Number-of-Teeth,

(m×z)

NORMAL BACKLASH (MM)

This is the gap (backlash) between

the gear-flanks you can measure

with a 'feeler gauge'.

NORMAL BACKLASH is a function of

the CENTER DISTANCE ADJUST-

MENT  parameter ONLY.

ANGULAR BACKLASH - GEAR 1 (DEG)

J 1

568
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This parameter gives the maximum

rotation of Gear 1 if you do not

move Gear 2. 

ANGULAR BACKLASH is a function of

the CENTER DISTANCE ADJUST-

MENT  parameter ONLY.

ANGULAR BACKLASH - GEAR 2 (DEG)

This parameter gives the maximum

rotation of Gear 2 if you do not

move Gear 1. 

ANGULAR BACKLASH is a function of

the CENTER DISTANCE ADJUST-

MENT  parameter ONLY.

CONTACT-RATIO

The Contact-Ratio gives the number-of-teeth that are in contact, on average,

as they pass through the meshing point. A contact ratio between 1 and 2

means that contact alternates between one and two pairs of teeth. Gears

that have a high contact-ratio are smoother and quieter. The contact-ratio

of an Internal Gear-Pair is higher than that of a similar External Gear-Pair.

If the Contact-Ratio is too low, then consider these options: 

· Decrease the pressure-angle

· Increase the number-of-teeth

· Increase the working-depth

USEFUL GEARING CALCULATIONS AND EQUATIONS

Gearing Equations

TO OBTAIN FROM KNOWN USE THIS

FORMULA

Pitch Diameter Module, m, number-of-teeth, N D = mN

Circular Pitch Module p
c
 = m. = N

Module Diametrical Pitch, Pd m = 25.4 P
d

Number-of-Teeth Module, m, Pitch Diameter, D N = D m

Addendum Module, m a = m

Dedendum Module, m b = 1.25m

Outside Diameter Module, m, Pitch Diameter, D, or

number-of-teeth, N

D
o
 = D + 2m = m

(N + 2)

Root Diameter Pitch Diameter, D, Module, m D
R
 = D – 2.5m

Base Circle Diameter Pitch Diameter and Pressure

Angle

Db = D cos  

568

568
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TO OBTAIN FROM KNOWN USE THIS

FORMULA

Base Pitch Module, m, and Pressure Angle,

 

p
b
 = m   cos  

Tooth Thickness at 

Standard Pitch Diameter 

Module, m T
std

 = m   2

Center Distance Module, m, number-of-teeth, N C = m . (N
1
 + N

2
)  

2 

Contact Ratio for Spur

Gears

( 1 < CR < 2 )

Outside Radii, Base Circle Radii,

center Distance, Pressure Angle

CR = ( R
01

2 – R
b1

2 +

 R
02

2 – R
b2

2 – C sin

m cos   

Backlash (linear) Change in center Distance,  C B = 2( )tan  

Backlash (linear) Change in Tooth Thickness,  T B =  T

Backlash (linear) along 

Line-of-action 

Linear Backlash along Pitch

Circle, B

B
LA

 = B cos   

Backlash, Angular Linear Backlash, D B
a
 = 6880 B D

(arc minutes) 

Min. No. of Teeth 

for No Undercutting 

Pressure Angle,  N
c
 = 2 sin2  

Nc (20º) = ~17 Teeth

Useful Gearing Definitions

Term Definition

Addendum: the height of the gear tooth above the pitch circle

diameter

Backlash: the angle the output-shaft of the gearbox can move

without the input-shaft moving

Base Circle: an imaginary circle used in involute gearing to gener-

ate the involute that forms the tooth profiles

Bevel Gears: used for right-angle applications. There are two types

of bevel gears which are straight and spiral

Center-Distance: distance between the axes of two meshed gears -

Length of the Line-of centers

Circular Thickness: the thickness of the tooth on the pitch circle.

Dedendum: the depth of the tooth below the diameter of the

pitch circle.

Diametrical Pitch: the teeth per inch of the diameter of the pitch circle

Differential Gear: a bevel gear which allows two shafts to rotate at a

different speed.
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Term Definition

Gear: a wheel with teeth that meshes with another wheel

with teeth to translate motion.

Gear center: the center of the pitch circle.

Gear Train: two or more gears meshed by their teeth. A gear train

generates power speed through the meshed gears ro-

tating

Gear Ratio: the ratio between the numbers of teeth of meshing

gears.

Helical Gear: gear with the gear teeth cut at angles

Line of Contact: the line or curve along which two tooth surfaces are

tangent to each other

Involute: the curve which describes a line which is unwound

from the circumference of the gear

Pinion: a small cogwheel which fits into a larger gear or

track.

Pitch Circle: the curve of intersection of a pitch surface of revolu-

tion and a plane of rotation

Pitch Diameter: the diameter of the pitch circle

Pitch Radius: the radius of the pitch circle

Planetary Gears: a system that consists of three components: the sun

gear, ring gear, and two or more planet gears. The

sun gear is in the center, the ring gear is the outer-

most gear, and the planet gears are the gears sur-

rounding the sun gear inside the ring gear.

Pressure Angle: the angle between the line-of-action and the normal

(90º, perpendicular) to the surface of the tooth

Spiral Bevel Gears: shafts whose axes are perpendicular (90º) to each

other and are used in right-angle applications

Spur Gear: connect parallel shafts which have involute teeth that

are parallel to the shaft

Sun Gear: a gearwheel that rotates around its own axis and has

other gears (planet gears) that rotate around it

Torsional Strength: the measure of the amount of torque that a radial

shaft can sustain during its rotation in a mechanical

system

Working Depth: the max depth a tooth of one gear extends into the

tooth gear of a mating gear

Worm Gear: a gear with one or more teeth with screwed threads
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Gear Modifications

Image Term

Crowning:

End-Relief

Topping and Semi-Topping

End Radius and Edge Radius/End Relief

Top Round/Semi-topping

Circular Pitch = pitch circle circumfer-

ence(pi.d) / number of teeth(z) ; p =  .d
/ z

Module = Pitch Diameter(d) / Number of

Teeth(z) ; m = d/z

Circular Pitch(p) / Module(m) ; p/m =  
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Image Term

Pitch Diameter(d) = module(m) × number

of teeth(z) ; d = m.z
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1.5.11.52 Dialog: Rack-Pinion / Ball-screw

Rack-Pinion / Ball-Screw

See: Add Rack-Pinion

After you add a RACK-PINION element, you can (optionally) convert it to a BALL-

SCREW and NUT.

A PINION is a gear-wheel with teeth that engage with a straight gear, or RACK.

A BALL-SCREW is a shaft with threads that engage with a NUT that can move

along the screw.

The motion of the RACK (or PINION) controls the motion of the PINION (or

RACK).

Or, the motion of the BALL-SCREW (or NUT) controls the motion of the NUT (or

BALL-SCREW).

Use the RACK-PINION DIALOG to edit the parameters for the RACK and PINION

(module, number, ...), or a BALL-SCREW (Pitch, Diameter, ...).

How to open the Rack-Pinion dialog

After you add a RACK-PINION, you will need

to edit its parameters - see Add Rack-Pin-

ion . 

To edit the RACK-PINION:

1. Double-click a RACK-PINION in the

graphics-area or ASSEMBLY-TREE. 

OR

1. See How to Open a dialog  

The RACK-PINION DIALOG is now open.

Rack-Pinion / Ball-Screw dialog

Rack-Pinion / Ball-Screw dialog

The format of the Rack-Pinion dialog

changes when you enable:

· Rack-Pinion (default)

OR

· Ball-Screw

Rack-Pinion enabled:

136

136

627
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 TOOTH PARAMETERS 

MODULE = P.C.D. ÷ NUMBER-OF-TEETH

on PINION

Rack/Pinion Ratio (degrees), per Rack

Displacement (mm).

Read-only:

RACK/PINION RATIO (deg/mm) - num-

ber of degrees the Pinion must ro-

tate to move the Rack by 1mm.

PITCH CIRCLE DIAMETER (mm) - the ef-

fective diameter of the Pitch Circle

of the Pinion. The abbreviation is

P.C.D.

P.C.D. (mm) = Number-of-Teeth ×

Module

PRESSURE ANGLE (Default = 20º). 

The Pressure Angle of gears is usu-

ally 20º. Other standard Pressure-

Angles are: 14º, 17.5º (weaker,

quieter), and 22.5º, 25º (stronger,

noisier).

ADDENDUM (Usually = Module). 

The height of the gear tooth from

the Pitch-Circle to the tip of the

tooth.

DEDENDUM (Usually = Module × 1.25

(Module>1)). 

The depth of the gear tooth below

the Pitch-Circle to the root of the

tooth. 

The DEDENDUM is larger than the AD-

DENDUM to give clearance for the
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tooth-tip of the two gears that en-

gage with each other.

ROOT RADIUS (Usually = 0.3 × Module)

The small fillet between the Flank

and the Root of the Gear Tooth.

POINTS PER TOOTH FLANK

The number of points on each In-

volute of each gear tooth. 6 is OK.

More points make your model

slower to edit.

 RACK AND PINION PARAMETERS 

NUMBER-OF-TEETH, PINION:

The number-of-teeth on the PINION. 

As you increase the number-of-

teeth, the PCD increase, unless you

also edit the Module.

SHIFT THE RACK BY:

Move the RACK along its pitch-line

by # number-of-teeth.

NUMBER-OF-TEETH, RACK:

The NUMBER-OF-TEETH on the RACK. 

Edit the NUMBER-OF-TEETH on the

RACK so that it stays in mesh with the

PINION for a machine-cycle

ALIGN MESH:

When you add two(2) RACKS to

one(1) PINION, you usually see

two(2) PINIONS on the same axis. If

you want to see one(1) PINION, click

one of these options:

¤ SHIFT RACK

¤ SHIFT PINION

¤ DO NOT SHIFT

RACK ON THE:

The positive-direction of Rack-Pin-

ion and Ball-Screw model are spe-

cified when you select RIGHT or LEFT.

¤ RIGHT (default) 

When the PINION (Ball-Screw Shaft)

rotates Counter-Clockwise, the RACK
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(Ball-Screw Nut) move in the Posit-

ive-Direction of the SLIDE-JOINT.

¤ LEFT  

When the PINION (Ball-Screw Shaft)

rotates Clockwise, the RACK (Ball-

Screw Nut) move in the Negative-

Direction of the SLIDE-JOINT.

Ball-Screw enabled :

 BALL SCREWS PARAMETERS 

The symbol in the graphics-area for a

Ball-Screw is a Helix/Screw.

There are two parameters:

· BALL-SCREW LEAD (mm) - distance

the SLIDING-PART moves after one(1)

rotation of the ROTATING-PART.

· BALL-SCREW DIAMETER (mm) - dia-

meter of the BALL-SCREW symbol in

the graphics-area.

The length of the BALL-SCREW is equal

to the length of the LINE in the SLIDING-

PART - see Add Rack-Pinion .

The Nut (SLIDING-PART) of the BALL-

SCREW moves in the Positive-Direction

of the SLIDE-JOINT when the RACK-

SIDE  is set to RIGHT - see General

tab

136

579

579
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1.5.11.53 Dialog: Pulley

Pulley

See Add Pulley

Use the PULLEY DIALOG to edit the NUMBER-OF-TEETH on a PULLEY.

Pulley / Belt Terminology

Term : Definition

PULLEY : When you do Add Pulley, we add for you the outline of a

PULLEY, with teeth, to a rotating-Part - see also Types of

Pulley

The rotating-Part of a PULLEY must rotate about the CEN-

TER-POINT of an ARC that is on the sketch-path of a Belt.

Belt : A sketch-path to represent the path of the Belt. The mo-

tion of a MOTION-POINT along the sketch-path repres-

ents the motion of the Belt. 

We relate the angular motion of each PULLEY to the linear motion of the Motion-Point

on a Belt by the radius of each PULLEY. 

To control the radius of each PULLEY, you can control its NUMBER-OF-TEETH and the

TOOTH-PITCH of the Belt. 

Types of Pulley

You can do Add Pulley to a rotating-Part that is kinematically-defined (Type 1) or is

not kinematically-defined (Type 2). 

Type 1: A Driving-Pulley : Before you do Add Pulley, the rotating-Part is kinematic-

ally-defined.

After you do Add Pulley, we control the linear motion of

a Belt from the angular motion of the rotating-Part (Driv-

ing-Pulley).

Add a maximum of one Driving-Pulley to a Belt.

Type 2: A Driven-Pulley : Before you do Add Pulley, the rotating-Part is not kin-

ematically-defined.

After you do Add Pulley, we control the angular motion

of a rotating-Part (Driven-Pulley) from the linear motion

of the Belt.

How to open the Pulley dialog

Double-Click a Pulley

After you add a PULLEY, you will need to

edit the NUMBER-OF-TEETH - see Add

Pulley . 

To edit the PULLEY:

1. Double-click a PULLEY in the

graphics-area or ASSEMBLY-

TREE. 

OR

160

160
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1. See How to Open a dialog  

The PULLEY DIALOG is now open.

Pulley dialog - and no Transition-Curve in the sketch-path

Pulley dialog

PULLEY PARAMETERS 

NUMBER-OF-TEETH

The NUMBER-OF-TEETH around the circumfer-

ence of the PULLEY. 

The NUMBER-OF-TEETH and TOOTH-PITCH (see

MOTION-PATH FB ) control the P.C.D of the

PULLEY and the radius of the ARC in the sketch-

path.

PITCH-CIRCLE-DIAMETER (PCD) - read-only

The diameter of the Pitch-Circle, which is co-

radial with the neutral line, or pitch axis, of the

Belt.

BELT PARAMETERS  

TOOTH PITCH - read-only ( Edit with the Motion-Path

dialog  )

The linear distance between two adjacent

teeth on the belt.

BELT LENGTH - read-only

The total length of the belt. It is equal to the

length of the sketch-loop that wraps around

the PULLEYS. 

The length of the belt will change as you edit

the NUMBER-OF-TEETH on a PULLEY.

You can select a dimension that will control

the BELT-LENGTH with the MOTION-PATH DIA-

LOG .

Pulley dialog - and Transition-Curve in the sketch-path

627

469

474

474
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Pulley dialog

SPROCKET PARAMETERS

FILLET RADIUS - the radius that

blends with the root of the tooth.

ANGULAR OFFSET - to rotate the pul-

ley / sprocket so that the Motion-

Points engage with the root of the

tooth.

ROLLER RADIUS - the radius of the

Follower-Roller that can engage with

the root of the tooth if you want to

add a convert the Transition Path to a

2D-Cam.

SPROCKET THICKNESS - the extrusion

depth to use when you save the

Sprocket as a STEP file.

1.5.11.54 Dialog: Feedscrew [ Scroll]

Feedscrew ( Scroll)

See Add Scroll

We have labeled the dialog as Feedscrew and Scroll because they are both com-

mon terms.

Other terms include: Worms, Infeed Screws, Gusanos, and Tortillas sin fin.

Use the Feedscrew (Scroll) dialog to:

· Set the number-of-points along the feedscrew surface for each 'rim'

· Set the Start and End - the 'range' - of the 3D-Cam

· Edit the display of the feedscrew in the graphics-area

· Export the feedscrew to SOLIDWORKS®

· Rebuild the feedscrew with the current or active settings.

· Save the feedscrew data that defines the surface mesh.

To Open the Feedscrew dialog

1. Double-click a FEEDSCREW in the GRAPHICS-AREA 

OR

1. see How to open a dialog  

150

627
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Feedscrew dialog

 Buttons at top of dialog

Rebuild and Save Data buttons

· Use the Rebuild button to 

o re-calculate the points along

each 'rim' when you change a

parameter

o before you use the Save Data

button

o before you transfer the Feed-

screw to SolidWorks

· Use the Save Cam button to save

the feedscrew mesh data as text

files.

NUMBER OF POINTS 

Preamble:

· We specify a Feedscrew with a sur-

face.

· There are a number of lines, that

we call Rims, along the feedscrew

surface.

· There is one Rim for each Motion-

Point as defined by the Motion-

Path FB.

· There are a number-of-points

along each Rim.

Parameters:

NUMBER-OF-POINTS: 

Number-of-points along each Rim. -

860 in dialog to left

SCREW START/END 

Preamble:

When you add a Feedscrew, we calcu-

late for you the surface for a complete

cycle of the MMA : 0 – 360

Use this separator to edit the range of

the MMA for which you want to calcu-

late the feedscrew.

The NUMBER-OF-POINTS along each rim

does not change. 
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Parameters:

FEEDSCREW START-ANGLE

· Edit the Start-Angle

FEEDSCREW END-ANGLE

· Edit the End-Angle 

DISPLAY 

Preamble: 

The 'MechDesigner Display' edits how the

surface of the Feedscrew shows in the

graphics-area. 

Controls:

'Surfaces' ; 'Rims' check-boxes

Use the check-boxes to Show or Hide
Surface, and Show or Hide Rims.

Solids: show or hide, with the color in the 'color'

control, and with the Transparency given by the

'Slider'.

Rims: show or hide the Rims along the Feed-

screw.

Color

· Use the Windows color picker to se-
lect a color for the Feedscrew and
Rims. 

Transparency

· Use the slider to change the Trans-
parency of the Feedscrew.

SOLIDWORKS DATA TRANSFER 

Preamble: When you have set the correct

parameters in this dialog: Number-of-

Point and Start/End Angles, then you can

export the Feedscrew to SOLIDWORKS. To

do this

1. Open SOLIDWORKS 

2. Add and Save a new Part 

3. Make sure the new Part is the 'act-

ive' document in SOLIDWORKS

Buttons:

Create Feedscrew Blank in SolidWorks

· We export for you the sketch of

the Feedscrew Blank and its Axis-

of-Rotation'
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· We instruct SOLIDWORKS for you to

use the Feedscrew Blank and Axis

to add a 'Revolved' feature

Create Feedscrew Surface in SolidWorks

· We export for you the XYZ data of

each Rim to a 'Curve' feature

· We instruct SOLIDWORKS for you to

use the Curves to Insert a Boundary

Surface feature.

Cut Feedscrew Surface into Blank.

· We instruct SOLIDWORKS for you to
cut the Revolved feature with the
Boundary Surface 

See Troubleshooting below .

SOLIDWORKS PATHS 

Preamble: 

After you have sent the Feedscrew to

SOLIDWORKS, it is often useful to link

the its file-name in SOLIDWORKS with

the Feedscrew element that is in

MechDesigner. At a later date, when

you open this Feedscrew dialog again,

you can reopen the part in
SOLIDWORKS.

Buttons:

Get Cad Part Path button: Click this

button to link the CAD file-name in

SOLIDWORKS with the Feedscrew.

The file-name, with its full path, is put

into the 'Path of Feedscrew in

SOLIDWORKS is :

Open Cam Part button: Click this but-

ton to open the part with the file-

name in the 'Path of Feedscrews in

SOLIDWORKS is' box.

Before this is possible: 

1. You have previously transferred a

Feedscrew to SolidWorks and saved

the file, 

AND 

2. You have already clicked the button

'Get Cad Part Path' button.

587
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Trouble-shooting the Feedscrew in SOLIDWORKS 

The last command: 'Cut Feedscrew Surface into Blank'  may

not work.

CHECK 1: In SOLIDWORKS, inspect the length of the Scroll

Blank  relative to the Scroll-Surface .

In the image to the left, the left of the Scroll-Blank  is to

the left of the end of the Scroll-Surface . 

In this case, the 'Cut Scroll Surface from Blank' (button  in

dialog) does not work. 

You must, in SOLIDWORKS, or MechDesigner

1. Edit the sketch of the Scroll-Blank   

I prefer to edit the sketch in SOLIDWORKS.

2. Move the end of the sketch to the right of the end of the

Scroll-Surface. 

In this sketch, I have added a dimension between the end of

the Scroll-Surface and the left of the Sketch-Blank.

To help, I have, in SOLIDWORKS,

dragged the 'Revolve' feature to

below 'Feed-Screw Scroll Bound-

ary-Surface'. 

Then, as I edit the sketch for the

Sketch-Blank I can see the end

of the Scroll-Surface. 

CHECK 2: After you close the sketch and rebuild the model.

the Surface-Cut feature in SOLIDWORKS might cut to the in-

correct side of the Scroll-Surface - see image to the left. In

this case:

1. Edit the Feed-Screw

Scroll Boundary-Surface

feature in SOLIDWORKS 

2. Click the direction arrow

- see image- to reverse

the direction of the Cut.

In the image, you can see the Scroll-Blank has been cut cor-

rectly by the Scroll-Surface.

However, the Feed-Screw Scroll Boundary-Surface feature is

still shown in the model

CHECK 3: Edit the Feed-

Screw Scroll Boundary-Sur-

face feature to hide it from

the display.
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See image.

Finally, the scroll is correct.
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1.5.11.55 Dialog: Configure Power Source

Configure Power Source

See How to open the Configure Power Source dialog

When you want MechDesigner to calculate for you the forces at joints, 2D-CAMS,

SPRINGS, PULLEYS, you must make sure the Power-Source is at the correct joint or

element.

If you do not Configure the Power-Source to be at the correct joint or ele-

ment, the forces that we calculate for you are not correct!

Power Sources

Each degree-of-freedom in a kinematic-chain that is kinematically-defined

has a power-source.

In the default case, the power-source is a motor at the joint (PIN-JOINT or

SLIDE-JOINT) whose motion you control with a MOTION-DIMENSION FB. A

power-source can also be a 2D-CAM, SPRING, or PULLEY element.

If the power-source is not at the correct joint or element, use the CONFIG-

URE POWER SOURCE DIALOG to change it to the correct joint or element.

If the Power-Source element is a : 

· PIN-JOINT - we calculate for you the Torque (Application-Torque) that

you need at the output from a Motor and Gearbox  - see Gearbox and

Servo-Sizing .

· SLIDE-JOINT - we calculate for you the Motive-Force that you need from

a Linear-Motor.

· 2D-CAM / CONJUGATE CAM - we calculate for you the Contact-Force,

Contact-Stress, Cam-Life, and Roller-Life - see 2D-Cam dialog

· SPRING - we calculate for you the Motive-Force (if you you configure the

SPRING as a Linear-Motor).

Configure Power Source dialog

You must Configure the Power Source for each degree-of-freedom in each

Kinematic-Chain. 

There are two tabs in the CONFIGURE POWER SOURCE DIALOG:

Power Source tab

MOTION DIMENSIONS

651

592

401
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Configure Power Source dialog > Power Source

MOTION-DIMENSIONS and MOTOR ELEMENTS Box 

In box , even if the MOTOR ELEMENT to the right of a MOTION-DIMENSION is

correct, please do 1 and 2

1. In box  - Click a MOTION-DIMENSION - ROCKER or SLIDER - to make

it active

2. In box  - Click a MOTOR ELEMENT 

The MOTOR ELEMENT in box  is now the POWER-SOURCE for the active

MOTION-DIMENSION in box  .

See also :  Tutorial 13 - Forces: introduction.

See also : Machine elements toolbar > Add Conjugate-Cam FB . 

Display Colors tab

Configure Power Source dialog > Display Colors tab

For each PART you can:

165

http://mechdesigner.support/index.htm?md-using-forces.htm
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· Change the color of the PART-OUTLINE and FORCE-VECTORS that act

on the PART.

· Display the FORCE-VECTORS that act on the PART: 

· at the Joint

· as a Polygon of Forces

· or both: at the Joint and as a Polygon of Forces

(The Polygon of Forces does not help me much!).

OR 

· Hide the FORCE-VECTORS that act on the PART 
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1.5.11.56 Dialog: Servo-motor and Gearbox Sizing.

Kinetostatic Torque and Speed

Note: The options for a Linear Motor with a SLIDE-JOINT will be available in a later

release.

Use the KINETOSTATIC TORQUE AND SPEED DIALOG to:

· Plot the Torque-Speed curve for the Application Load, in four quadrants

· Select a Planetary Gearbox manufacturer and model

· Select a Servomotor manufacturer and model.

· Plot the Gearbox Load Torque-Speed curve, in four quadrants

· Plot the Servomotor Torque-Speed curve, in four quadrants.

· Calculate the Duty-Cycle as a percentage of the machine-cycle

· Calculate the RMS Torque.

Note: Use this tool with one degree-of-freedom kinematic-chains. Email PSMo-

tion if the kinematic-chain has two or more degrees-of-freedom, each with a ser-

vomotor.

How to open the Kinetostatic-Torque and Speed dialog

STEP 1: Enable:

· Force toolbar > Force-Vectors: Calculate

· Force toolbar > Force-Vectors: Display

You should see a Motor  at a PIN-JOINT - see image below. The Motor

is a Power-Source.

If your servo-motor on your actual machine is not at that PIN-JOINT, you

need to move the Motor symbol to the correct PIN-JOINT.

STEP 2: If required, move the Motor symbol to the correct joint

See Force toolbar > Configure Power Source

Configuring the Power Stage is a major change to the model configura-

tion. 

It is good idea to Save the model, and Reopen the model.

STEP 3: Open the Kinetostatic Torque-Speed dialog:

229

237

232
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1. Click the Motor  in the graphics-area 

The PIN-JOINT shows in the SELECTION-WINDOW. 

2. Right-Click the PIN-JOINT 

3. Click Edit element in the shortcut menu.

The KINETOSTATIC TORQUE-SPEED DIALOG is now open.

Application (Load) Torque vs Speed plot

FOUR QUADRANT: TORQUE(LOAD) vs SPEED

The plot is Torque vs Speed of the Application Load, in four-quadrants. The

Application Load does NOT include the load to drive the inertia and friction

of a Servomotor and Gearbox. 

Why Four Quadrants?

When inertia is the dominant load, and the motion moves the load back and

forth, the four quadrants are:

  + Torque and + Speed : accelerating the load in the positive direc-

tion 

  – Torque and + Speed : decelerating the load in the positive direction

  – Torque and – Speed : accelerating the load in the negative direc-

tion 

  + Torque and – Speed : decelerating the load in the negative direc-

tion 

STEP 1: Auto-Filter and Range-Factor

Auto-Filter check-box

The Auto-Filter check-box is at the top and right of the dialog.

q  Auto-Filter OFF - we list all of the gearboxes provided by the manu-

facturer you select

þ Auto-Filter ON - we list only those gearboxes that have a Torque Ca-

pacity

· that is greater than the “Lower torque, t2m” 
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AND

· that is equal or less than the “Range-Factor × Lower-Torque ” 

Range Factors

The Range-Factor is at the top of the dialog.

Thus, the capacity of the Gearboxes that are listed for you are summar-

ized by:

Application-Load Gearbox Capacity Application-Load × Range-

Factor

Example: Auto-Filter ON, Range-Factor: 1.3

Lower Gearbox Torque Capacity = Equivalent Application (Load)

Torque (21.495 N.m.)

Upper Gearbox Torque Capacity = Range Factor × Equivalent Applica-

tion (Load) Torque (1.3 × 21.495 = 27.944 N.m.)

STEP 2: Select a Gearbox Manufacturer

Select a Gearbox Manufacturer  

There are four Gearbox manufacturers: APEX, Neugart, Vogel, and Wit-

tenstein

Note: If you need us to list a different Gearbox Manufacturer, then please

email us.

STEP 3: Select a Gearbox Model

Select a Gearbox Model 

Gearbox manufacturer and Gearbox model part numbers

When you select a Gearbox Manufacturer, and Auto-Filter is ON, and

you have entered a Range-Factor, the list of Gearboxes is limited to

those whose capacity can satisfy these in-equalities:
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Manufacturer The selected Gearbox Manufacturer

Model 

The selected the Gearbox Part Number

Each manufacturer has a different Model

Part-Number format. 

Series Series - from the selected Model

i # Gearbox Ratio from the Model

T2N Nm
Rated Torque at

output-shaft

- data sheet -

T2MAX Nm
Max. Torque at out-

put-shaft 

 - data sheet -

n2N RPM
Rated Speed at out-

put-shaft

 - data sheet / i -

n2MAX RPM
Max. Speed at out-

put-shaft 

 - data sheet / i - 

T2max   T2MAX   RF × T2max 

Maximum Application (Load) Torque   Maximum Output Torque of the

Gearbox   Range-Factor × Maximum Application (Load) Torque

T2m   T2N   RF × T2m

Equivalent Application (Load) Torque   Rated Output Torque Capacity of

the Gearbox   Range-Factor × Equivalent Application (Load) Torque 

n2max× i   n1MAX 

Maximum Application (Load) Speed × Gearbox Ratio (i)   Maximum Input

Speed of the Gearbox 

n2n × i   n1N 

Average Application (Load) Speed (or Equivalent, Mean) × Gearbox Ratio

(i)   Rated Input Speed of the Gearbox

Gearbox Parameters Check List.
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Gearbox Parameters Summary Sheet

After you select a Gearbox model, its Gearbox Parameters Summary Sheet

show. This form is read-only. 

On the left of the sheet, there should be four(4) ×  to indicate that the

Gearbox has the capacity to drive the Application Load and satisfies the

4 requirements.

 Peak Torque Maximum Application Torque

 Rated Torque Equivalent Application Torque

 (Max Output Speed) Maximum Application (Load) Speed

 (Rated Output Speed) Equivalent Application (Load) Speed

Notes: Speed parameters in brackets ( ) are referred to the output-shaft.

They are calculated from the Gear-Ratio of the Gearbox. 

Other Parameters include:

· Backlash

· Stiffness

· Efficiency

· Shaft Diameter - the input-shaft diameter, which is not in the list until

you select a Servomotor.

· Inertia - referred to the input, which is not in the list until you select a

Servomotor.

Note: Not all Gearbox manufacturers provide all of these parameters.
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Gearbox Output Torque vs Speed plot

Torque-Speed plot at Output of Gearbox.

When you select a Gearbox, the Torque (N.m.) vs Speed (RPM) plot changes

to indicate whether the Gearbox has the capacity to drive the Application

Load.

The color code is :

· Green : Torque AND Speed of the Load Rated Gearbox Capacity

· Amber : Torque OR Speed of the Load Rated Gearbox Capacity  

Maximum Gearbox Capacity

· Red : Torque OR Speed of the Load Maximum Gearbox Capacity

Torque-Speed at Gearbox at Output with Gearbox Limits

Gearbox Torque and Speed Limits.

The Show Gearbox Limits check-list box is located above the Gearbox selec-

tion box.

q  Show Gearbox Limits ENABLED 
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The axes are auto-scaled to the Maximum Torque and Speed, at the

output of the Gearbox.

þ Show Gearbox Limits DISABLED

The axes are auto-scaled to the Maximum Torque and Speed Capacity,

referred to the output of the Gearbox.

This helps you compare the Torque and Speed Capacity of the Gearbox with

the Application Load.

The Limits of Torque and Speed are shown as boxes.

Before you select a servomotor, the limit boxes and their color codes indic-

ate the:

· Dark Blue : Maximum Torque and Speed capacity of the Gearbox

· Light-Blue : Rated (or Nominal) Torque and Speed capacity of the

Gearbox

· Light-Brown : Equivalent Torque and Speed of the Application Load

STEP 4: Select a Servo-motor Manufacturer

Select a Servomotor Manufacturer  

There are many Servomotor manufacturers from which to select.

When you select a Servomotor Manufacturer, we find for you those Servo-

motors that have the Torque and Speed Capacity required by the Applica-

tion Load.

Servo-motor manufacturers and Servo-motor part numbers

Note: If you need us to list a different Servomotor Manufacturer, then please

email us.

STEP 5: Select a Servo-motor Model

Select a Servomotor Model
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When you select a Servomotor Manufacturer, and Auto-Filter is ON, and

you have entered a Range-Factor, the list of Servomotor is limited to those

whose capacity can satisfy these in-equalities:

Manufacturer The Selected Manufacturer

Model 
The Selected the Model. 

Each manufacturer has a different model format. 

Series Series - from the Selected Model

d1 mm Motor Shaft Diameter - data sheet -

Tn Nm Rated Torque - data sheet -

Tmax Nm Max. Torque - data sheet -

Nn RPM Rated Speed - data sheet -

Nmax RPM Max Speed - data sheet -

d1max  D    d1min

The Servomotor Shaft Diameter, D, must fit directly into the Gearbox, d1.

Note: Precision Planetary Gearboxes can accept a range of shaft diameters

at their input. The Gearbox inertia, which is referred to its input, is different

for each shaft diameter.

Tmax   Tmot max   RF × Tmax 

Maximum Application Load Torque referred to the Gearbox input-shaft 

   Maximum Servomotor Torque Capacity  

 Range-Factor × Maximum Application Load Torque referred to the

Gearbox input-shaft

Tm  TN   RF × Tm

Equivalent Application (Load) Torque referred to the Gearbox input-shaft

  Rated Servomotor Torque Capacity  

 Range-Factor × Equivalent Application (Load) Torque referred to

the Gearbox input-shaft 

n1max   Nmax

Maximum Application Speed referred to the Gearbox input-shaft   Max-

imum Servomotor Speed 

n1N   N1N

Average Application Speed (or Equivalent, Mean)   Rated Servomotor

Speed
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Pn   Pr

Application Power < Servomotor Power Capacity

Servo-motor Parameters Check List.

Servo-motor Parameters Summary Sheet

When you select a servomotor model, its Servomotor Parameters Summary

Sheet show. This form is read-only. 

To the left of the sheet, there should be five(5) ×  to indicate that the Ser-

vomotor has the capacity to drive the Application Load and also satisfies

those 5 × requirements.

Peak Servomotor Torque Maximum Application (Load) ÷ i

Rated Servomotor Torque Equivalent Application (Load) Torque ÷ i

Max Servomotor Speed Maximum Application (Load) Speed × i

Continuous Servomotor Speed Equivalent Application (Load) Speed ×

i

Rated Power > Nominal Load Power.

Other Parameters include:

· Vdc - Bus Voltage for Drive

· Jm - Servomotor Inertia

· D - Servomotor shaft diameter.

Servomotor Torque vs Speed plot
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Torque-Speed plot of Servo-motor

When you select a Servomotor, colors of the dots for the Torque (N.m.) vs

Speed (RPM) plot changes to indicate whether the Servomotor has the Ca-

pacity to drive the Application Load or not.

The color code is :

· Green : Torque AND Speed of the Load Rated Servomotor Capacity

· Amber : Torque OR Speed of the Load Rated Servomotor Capacity

Maximum Servomotor Capacity

· Red : Torque OR Speed of the Load Maximum Servomotor Capacity

Motor Torque and Speed Limits.

The Show Motor Limits check-list box is located above the Motor selec-

tion box.

q  Show Motor Limits ENABLED 

The axes are auto-scaled to the Maximum Torque and Speed, at the

Servomotor Drive Shaft.

þ Show Motor Limits DISABLED
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The axes are auto-scaled to the Maximum Torque and Speed Capacity

of the Selected Servomotor

This helps you compare the Torque and Speed Capacity of the Servomo-

tor with the Application Load referred to its input-shaft.

The Limits of Torque and Speed are shown as boxes.

·  Purple  : Maximum Torque and Speed capacity of the Servomotor

·  Pink : Rated (or Nominal) Torque and Speed capacity of the Servo-

motor

· Light-Brown : Equivalent Torque and Speed of the Application Load

Why the Motor Torque is different to the Mechanism Torque

The Torque we calculate for you when you Display Force-Vectors  is the

torque to move the mechanism only. This is the Application Torque. The Ap-

plication Torque does not include the Torque to move the motor and gear-

box. It is necessary to add the Torque to accelerate the motor and the gear-

box to the Torque in the graphics-area.

Clearly, the Torque to move a motor depends on the inertia of the motor

and gearbox and the gearbox ratio.

The higher the gear ratio, the less Application Torque the motor 'sees'. But

the motor must run faster and accelerate more. This influences the overall

power, and the system efficiency.

More on Torque vs Speed Curves 

The performance characteristics of a brushless servo motor (motor/drive

combination) are described by a torque/speed operating envelope. 

As shown below, the colored areas of the curve identify the Exceeded Duty,

Continuous Duty, and Intermittent Duty working areas of the system.

Exceeded Duty

To maximum speed and/or the maximum torque, of the gearbox and/or

Servomotor must be exceeded. Usually, to make sure this cannot happen,

there is a Current (amps) Limit on the Power Drive.

Continuous Duty Zone (S1)

The continuous duty zone is bounded by the maximum continuous stall

torque up to the intersection with the intermittent duty line. The continu-

ous torque line is set by either the motor’s maximum rated temperature,

or the drive's rated continuous current output, whichever is less. 

The system maximum continuous or 'voltage line' is set by the voltage

rating of the drives, the line voltage supplied, and the motor winding. 

The system can operate on a continuous basis anywhere within this area,

assuming the ambient temperature is 40°C or less. 

Intermittent Duty Zone (S5)

63



603

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

The intermittent duty zone is bordered by the peak-stall torque and the

system voltage line. The peak torque line is set by either the drives’ peak

current rating, which the drive can give for a limited time, or the max-

imum rated peak current for the motor, whichever is less. Higher torque

levels may be achievable at higher power levels.

Typical Torque / Speed Duty Capability of a Brushless

Servomotor.

Peak Torque: ( 
PS

 ) The Peak Torque the Motor and Gearbox at Stall Speed

Continuous Stall Torque: ( 
CS

 ). The Continuous Torque the Motor and

Gearbox can give Continuously at Stall Speed.

Maximum Speed: ( 
MAX

 ) Maximum possible speed of the Motor and

Gearbox. Not attainable when the voltage is limited by the drive.

Knee Speed: ( 
K
 ) The Speed at 'knee' in peak envelope that is the intersec-

tion of the Peak Torque with the Voltage Torque/Speed Limit Line.

Continuous Rated Torque:( 
CR

 ). The Continuous Torque at the Speed of

the Rated Power.

Rated Speed: ( 
R
 ) The Rated Speed or Speed at Rated Power. The motor

can operate at this speed with the supply voltage.

How we calculate the Motor Torque and Motor Speed

The Reflected Inertia at the Motor shaft can be constant or it can continu-

ously change in a machine-cycle.

With Constant Inertia Mechanical Systems, it is easy to calculate Inertia

Torque.

With mechanisms, the Torque is dependent on reflected inertia that is a

function of Acceleration, Velocity, and Position.

PSMotion has developed algorithms to calculate these, which give a true

indication of the reflected inertia at a motor shaft for even the most

complex mechanisms.

The equations below, are calculated at every instant in a machine-cycle.
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Usually, you aim to make the Reflected Load Inertia = (Motor + Gear-

box) Inertia.

However, when the Load Inertia is not constant, it is more difficult to se-

lect the Motor and Gearbox.

Speed:

 
m
 = N ×  

L
 

 
m
 = N .  

L 

Torque

T
m
 = -  

m
 (J

G
 + J

M
) + sign(T

VD
)

T
L
 = (T

MD
 N )  

T
T
 = T

m
 + T

L

N  = Gear Ratio

 
m 

= Motor Angular Velocity

 
L
 = Load Angular Velocity

T
T
  = Total Torque

T
m
 = Motor Torque

T
L 
 = Load referred to Motor Shaft

T
VD

 = Viscous 'Drag' Torque. It is al-

ways opposite to the direction of

motion

T
MD

 = Torque derived by your model

at the Motor Shaft ( f{P
L
 ,  

L, 
 

L 
} )

J
G
  = Inertia of Gearbox

J
M
  = Inertia of Motor

 
m
 = Motor Acceleration

 
L
 = Load Acceleration

   = Gearbox Efficiency
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1.5.11.57 Dialog: Movie

Movie

When you continuously-cycle a model, commercial video-recording software may

not record each step in a machine-cycle. Also, it is difficult to record exactly one

machine-cycle. The Movie command solves these problems.

Use the MOVIE DIALOG to: 

· position and size a “frame” in the graphics-area that you want to re-

cord the movie

· browse to a path and enter a file-name for the movie

· control how many images you want to capture for the movie in each

machine-cycle

· control the start and end of the movie as a function of the Master-

Machine-Angle.

Record and save:

· a movie as a GIF file-type

OR

· a sequence of images as PNG, JPG, JPEG, or BMP file-type

We append to the file-name a number to each image. The numbers we

append are 000, 001, 002, ... .

OR

· save one image as a snapshot of the model.

Notes:

The GIF format produces a large file when the size and the number of

frames are large.

Top-Tips

· Before you start the Movie command, move the Master-Machine-

Angle to zero(0). Click Run menu > Home or ALT+H keyboard short-

cut.

· Do not append the file-name with a number

Movie dialog

Make-Movie dialog

When you start the Movie command, you

open the MOVIE DIALOG immediately.

You also see a rectangle in the graphics-

area. 

The rectangle is the FRAME. 

You record everything inside the FRAME. 
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You can edit the size and position of the

FRAME and number of FRAMES in the

movie.

 FRAME SIZE AND POSITION 

1. Use the PRE-SELECT A FRAME SIZE...

drop-down list-box to select a

typical frame size. 

OR 

1. Edit the WIDTH and HEIGHT of the

frame. 

2. Edit the LEFT and TOP of the

frame. 

The rectangle / frame should now be

the correct size and position.

 FILE-NAME AND FILE-TYPE 

1. Click the FILE-NAME and FILE-

TYPE... button

In the Windows® Save as dialog:

a. Browse to a File-path and

enter a File-name

b. Use the Save as type list-box

to select a file-type.

Select a GIF, PNG, JPG, JPEG, or

BMP file-type

c. Click the Save button

The FILE-PATH and FILE-NAME are now in boxes .

Note: 

GIF is recorded as a movie; 

PNG, JPG, JPEG, BMP are recorded as a number of images equal to the

NUMBER OF FRAMES - see below.

 MAKE MOVIE... 
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1. Edit the NUMBER-OF-FRAMES box

(Default = 30 Frames, Minimum=5

; Maximum=10000) 

2. Edit the START-ANGLE ( Default = 0

; Minimum > 0, Maximum  

Machine End-Angle )

3. Edit the END-ANGLE ( Default =

360 ; 720 Maximum > Min-

imum) 

4. Select 

o INCLUDE LAST FRAME , or

o EXCLUDE LAST FRAME

Experiment! View the movie in your

Video Player to see if there is a stutter

at the end of the movie.

MAKE MOVIE button

5. Click the
 

Make Movie
 
button 

When you click the 
Make Movie

 button: 

a) We move the model to the START-ANGLE. 

b) We compile the movie (GIF file-type), or save the images (PNG, JPG,

BMP file-types), at equal increments of the machine-angle, from the

START-ANGLE to the END-ANGLE.

Please WAIT while we save for you the file(s) to your PC / Laptop.

OR

SINGLE SHOT button

5.  Click the
 

Single Shot
 button 

When you click the 
Single Shot

 button, we save for you a SINGLE SNAPSHOT

of the model at the active Master-Machine Angle.

To compile the images as a movie.

To compile PNG images as a movie, I use Avidemux 2.6 - a free tool that you

can download from the internet. My lawyer tells me I cannot recommend it.

In Avidemux 2.6:

1. Open the first image in the sequence of images - for example, HINGE-

A000.PNG 

Open the first image only. AVIDEMUX2.6 automatically imports the other im-

ages in the numbered sequence.
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2. Save the movie with the MP4 movie format. 

Save the Movie file with the same frame-size as the recorded images.

MP4, with the x264 codec, is the recommended format for YouTube®. 
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1.5.11.58 Dialog: Element Properties

Element Properties dialog.

The Element Properties dialog is a list of an element's motion and force data

at the MASTER MACHINE ANGLE.

Elements Properties are read-only, and include: 

o P : a Position, or linear value

o V : a Vector

o  : a Real Number

o |n| : Absolute Real Number

o X, Y,   

The Element Properties dialog can stay open to read the properties at differ-

ent Master-Machine Angle.

Note: 

From MD16-1-372:

When you hover above an element in the graphics-area, the Element Proper-

ties show in the Extend-Hints box  in the Feedback Area.

How to open the Element Properties dialog

In the graphics-area:

 + Click an element 

Element Properties dialog (read-only) 

At the top of the dialog you can see the Element's Name, the name of the

Element's PART, and Element's MECHANISM.

The Element is a child to the Element's PART, and the PART is a child to the

Element's MECHANISM.

Wire Element Properties dialog 

326
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CTRL + Click a wire 

Wires connect and transfer, usually, Motion or Force data between Func-

tion-Blocks.

A wire has a 3 Data-Channels, with three data-values.

For example, the Data-Channels of a wire that controls the motion of a

Motion-Part are Linear or Angular Displacement, Velocity, and Accelera-

tion.

Part Element Properties dialog 

CTRL + Click a Part-Outline 

Properties:  (P - Position)

· Kinematic: Angle, Angular Velocity, and Angular Acceleration of PART

relative to the Mechanism-Plane

· Instant Center: The PART has an instant center of rotation: X and Y co-

ordinates of the instant-center in the Mechanism-Plane 

· Centroid: X and Y coordinates of the Center of Mass in the Mechan-

ism-Plane.

· Mass: Value - Real Number

· Inertia: Value - Real Number.

Pin-Joint Element Properties dialog 
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CTRL + Click a Pin-Joint 

Property: 

· Power On: True or False (T or F) - if the PIN-JOINT is a Power Source -

see Configure Power Source

· Broken: True or False (T or F) - if the PIN-JOINT does not solve

(Broken)  at this instant in the machine-cycle

· Solved: True or False (T or F) - if the PIN-JOINT is a child to a kin-

ematic-chain that is kinematically-defined

· Bearing Force 

o Fx and Fy ; Vectors in Mechanism Coordinates 

· Torque

o Tz ; Vector normal to Mechanism Plane (if the PIN-JOINT is the

Power Source)

Slide-Joint: Element Properties dialog 

CTRL + Click a Slide-Joint

Properties:

· Power On: True or False (T or F) - if the SLIDE-JOINT is the Power

Source - see Configure Power Source

· Broken: True or False (T or F) - if the SLIDE-JOINT does not solve

Broken)  at this instant in the machine-cycle

· Solved : True or False (T or F) - if the SLIDE-JOINT is a child to a kin-

ematic-chain that is kinematically-defined

· Drive Force Fx ; Force along positive direction of SLIDE-JOINT, if the

Power Source is the SLIDE-JOINT

589

318

589

318



612

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Point: Element Properties dialog 

CTRL + Click a Point

Properties:  (P - Position ; V- Vectors)

· P Part Pos: Position of the Point; Part Coordinates

· P Mech Pos: Position of the Point; Mechanism Coordinates

· P Glob Pos: Position of the Point; Global Coordinates (Z does not

show!)

· V Velocity, V Acceleration

o i,j: the coordinates of the Velocity / Acceleration Vector, X and Y

directions; Mechanism Coordinates

o |n|: the magnitude of the Velocity / Acceleration Vector

o  : the direction of the Velocity / Vector

Line: Element Properties dialog 

CTRL + Click a Line.

Property: (V- Vectors)

· Line Data: 

o : the change in x and y from the LINE'S START-POINT and
END-POINT

o |n|: the length of the LINE

o the angle of the LINE in the Mechanism-Plane

· Kinematic:
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o the angle of the LINE in the Mechanism-Plane

o : angular velocity of the LINE

o : angular acceleration of the LINE

Circle: Element Properties dialog 

CTRL + Click a Circle.

Property: (P - Position)

· Radius: 

o |n|: the Radius of the CIRCLE

· center:

o x and y : the position of the center of the CIRCLE in Mechanism

Plane

Arc: Element Properties dialog 

CTRL + Click an Arc.

Property: (P - Position)

· Radius: 

o |n|: the Radius of the Circle

· center: 

o x and y : the position of the center of the ARC in the Mechanism-

Plane

· Start
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o x and y : the position of the START-POINT of the ARC in the Mech-

anism-Plane

o : the angle of the START-POINT from the center of the Arc

· End

o x and y, the position of the END-POINT of the ARC in the Mechan-

ism-Plane

o : the angle of the END-POINT from the center of the ARC

Cam: Element Properties dialog 

CTRL + Click a 2D-Cam.

Property: (P - Position)

Contact 1 and 2: 

o x and y: the coordinates of the contact between the Inner and

Outer Cam-Profiles and the Follower-Profile.

Pressure Angle 1 and 2: 

o : the Pressure Angle of the Follower-Roller with the Inner and

Outer Cam-Profiles

Curvature 1 and 2: 

o |n| : the Radius of Curvature of the Inner and Outer Cam-Profiles

Force 

o Fx and Fy : the Contact Force of the Cam on the Roller, given in

the X and Y directions, with Mechanism Coordinates

If you have selected a Follower-Roller and Steel Type for a 2D-CAM with the

2D-CAM DIALOG:

Roller L10 Lifetime [Hrs] - Lifetime in Hours of the Follower-Roller,

Lubrication Conditions, and Factor-of-Safety that you select in the 2D-

CAM DIALOG .411
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Cam Lifetime [Hrs] - Lifetime in hours of the Cam-Profile (Outer or Inner),

with the Steel Type, Heat-Treatment, Quality, Hardness, and Factor-of-

Safety that you enter in the 2D-CAM DIALOG.
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1.5.11.59 Dialog: Select Elements

Select Elements

If, when you select elements to do a command, there is ambiguity as to which

ELEMENT(S) to actually use for the command, the SELECT ELEMENTS DIALOG

opens automatically. 

It lists all of the elements that you select, including the POINTS you want to select.

You must CTRL + Click all of the elements you need to do the command.

Select-Elements dialog

Select-Elements dialog

In the SELECT-ELEMENTS DIALOG: 

1.  + Click ALL of the elements you need to do the com-

mand. 

The  is colorized only after you select the elements that are compat-

ible with the active command.

2. Click  to close the SELECT-ELEMENTS DIALOG

If the COMMAND-MANAGER is also active:

3. Continue to select the elements, as required. 

and / or

4. Click  in the COMMAND-MANAGER to complete the command.
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1.5.11.60 Dialog: Delete Dependent Elements

Delete Dependent Elements

Warning for Delete Dependents

Many elements depend on (need) other elements

The Delete Dependents dialog is a warning to you that, if you want to delete an

element, you will also delete one or more other elements.

You can:

· Delete element and Dependents- click the  button

OR

· Cancel Delete - click the  button

For example: 

When you add a PIN-JOINT, you select two POINTS in two different PARTS.

If you want to delete the one of the POINTS that needs the PIN-JOINT, you are

warned that you also delete the PIN-JOINT.
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1.5.11.61 Dialog: View References

Show Element References

See also: Delete Dependent Elements

Many elements reference, or need, other elements.

Show Element References is a list of those elements that a more complex ele-

ment needs.

For example, when you add a PIN-JOINT, you select one POINT from two differ-

ent PARTS. Therefore, the Reference Elements of the PIN-JOINT are the two

POINTS.

Selection--Window: Right-Click

To Show Element References for an element:

1. Click an ELEMENT in the graphics-area, or the ASSEMBLY-TREE 

The element should be in the SELECTION-WINDOW.

Right-click the ELEMENT in the SELECTION-WINDOW 

2. Click Show Element References in the shortcut menu

The List References for: element-name shows.

EXAMPLE: Element References for a 2D-Cam

617
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The example shows the: 

· Reference Element name

· Number 

· Reference Element Type

· Reference Element Owner
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1.5.11.62 Dialog: Tutorials

Download Tutorials

To open the Download Tutorials dialog

File toolbar > Download Tutorial Videos

File menu > Download Tutorial Videos

Download Tutorials dialog

When the Download Tutorials dialog opens:

1. Click a video on the left of the dialog.

If this is the first time you have downloaded that video. please wait until it

downloads to your hard drive.

If, at a different time, you click to play the same video, it should play imme-

diately from your hard drive.

Video display too small?

If the video dialog is too small, drag the right and bottom sides of the dia-

log to increase its size.

Where do the Videos download to?

The default path is <LocalAppData> \ Tutorials\ *.mp4

To change the download path, see Application-Settings > General tab >

File Options separator > Tutorial Video Directory .

Download Tutorials dialog

341
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1.5.12 How to... and FAQs

How to... and FAQs

General: How to... and FAQs

How to ...

... edit and save my Styling

... open a dialog

... edit a Parameter in a dialog.

... Rename an Element

FAQs

What are the System Requirements?

Why are there so many files with the same file-name?

Why is it taking a long time to add or edit elements?

Cam Terminology

Model-Editor: How to... and FAQs

How to ... 

How do I stop the solids turning red when I move my mouse over

them?

FAQs

Why can I not SHIFT+Drag to Spin (or CTRL+Drag to Pan) the

model?

Mechanism-Editor: How to... and FAQs

How to ...

... show Velocity and Acceleration Vector

... edit a 2D-Cam, Gear-Pair, Profile

... edit Profiles and Extrusions

... change the assembly configuration of a mechanism

... move a Motion-Dimension (and not the FB)

... export a Cam directly to SOLIDWORKS

... model a Pin in a Slot

... to export my Cam as a Smooth Curve to SOLIDWORKS/Solid

Edge

FAQs

What do the different colors of Part-Outlines mean?

What is the hierarchy of Extrusions?

What are different 2D-Cam elements?

Why can I not see the Base-Part properly?
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Why can I not add an Angle or Linear Motion-Dimension FB?

How many Mechanism-Editors can I add?

How many Kinematic-Chains can I add to a Mechanism-Editor?

Why are values in the graphics-area different in a Graph FB?

Part-Editor: How to... and FAQs

How to ...

... edit the Length of a Part

... delete Sketch-Elements

... delete Constraints

... add a Sketch-Loop

FAQs

How many Parts can I edit at a time?

Why edit a Part?

How to start the Part-Editor to edit a Part?

Can I edit (and other questions relating to) the Part-Outline?

What are the color codes for sketch-elements in the Part-Editor?

Why is a dimension 'negative' in the Dimension dialog?

Why do I need to add geometry to the Base-Part?
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1.5.12.1 General: How to and FAQs

General FAQs

How to...

... edit and save my Styling

... open a dialog

 ... edit a Parameter in a dialog

... Rename an Element

FAQs

What are the System Requirements?

Why are there so many files with the same file-name?

Why is it taking a long time to add or edit elements?

What terminology do you use for Cam mechanisms?

1.5.12.1.1  How to...

How to...?

... edit and save my Styling

... deselect the active command

... open a dialog

 ... edit a Parameter in a dialog

... rename an Element

... save a DXF file of the Mechanism and / or a Part.

624

627

631

634

636

638

639

640

624

626

627

631

634

635



624

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.12.1.1.1  ... edit, save, and move my Styling

How to edit your Settings, Styles and Theme.

We can use the term “Styling” for the Style, Theme, and Settings.

Each time you exit MechDesigner, we save for you your Styling to

MechDesigner.INI and MechDesigner.XML.

MechDesigner uses the Styling automatically the each it starts. 

Styling Definitions:

Theme : Border, Icon, and dialog colors

To select a Theme:

1. Edit menu > Application Settings : General tab >

THEME SETTINGS  > Target Theme 

2. Select a theme from: 

Windows, Charcoal Dark Slate, Aqua Light Slate, Win-

dows10 Dark, Tablet Dark, Slate Classico, Windows10

Slate Gray, Windows 10.

This help uses Charcoal Dark Slate.

3. Exit and Restart MechDesigner.

Style : To Load a Style

1. Click the  button to open:

Dark.XML - use with dark themes, for example, Charcoal

Dark Slate. 

Light.XML - use with light themes, for example, Aqua

Light Slate.

my-style-name.XML - a style you have saved previously.

To Save a Style

1. Click the  button to save

2. Save the changes you have made to my-style-

name.XML.

Do NOT overwrite Dark.XML or Light.XML.

Application

Settings : 

Other settings that become part of your Styling: 

1. Application-Settings > Graphics tab > DISPLAY COL-

ORS 

2. Edit icon-sizes, number-formats, and colors for differ-

ent element types

Note: 

<CommonAppData> is usually C:\ProgramData\PSMotion\

If you cannot see C:\ProgramData\ ... then, in Windows File Explorer©:
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a) Click the View tab 

b) Click the Hidden Items check-box in the Show/hide group-box. 

Save your Styling

To save your styling:

1. Edit menu > Application-Settings : Click the  button at the bot-

tom of the dialog. 

2. Save your styling to e.g.: <CommonAppData>\Style\my-style-

name.XML 

DO NOT OVERWRITE the Dark.XML or Light.XML styles in this path. 

Move your Styling

To move your styling:

On the workstation with the “Styling” that you want to move:

1. Save your Styling - see above

2. Exit MechDesigner 

3. Navigate to <CommonAppData>\PSMotion\style\

4. Copy and Paste to a memory stick or network drive: my-style-

name.XML

5. Navigate to <LocalAppData> e.g. C:\users\<username>\Ap-

pData\Local\PSMotion\IniFiles\

6. Copy and Paste to a memory stick or network drive:

MechDesigner.INI and MechDesigner.XML. 

On the destination workstation:

1. Navigate to <LocalAppData> e.g. C:\users\<username>\Ap-

pData\Local\PSMotion\IniFiles\

2. Copy and Paste from the memory-stick or network drive:

MechDesigner.INI and MechDesigner.XML

3. Navigate to <CommonAppData> e.g. C:\documents\Pro-

gramData\PSMotion\style\

4. Copy and Paste from the memory stick or network drive: my-style-

name.XML

Load the styling:

1. Start MechDesigner

2. Click Edit menu > Application-Settings : Click the  button, at

the bottom of the dialog.

3. Explore to <CommonAppData>\PSMotion\style\

4. Find and load My-style-name.XML

The Theme, Style and Settings are now the new “Styling”, which will load

automatically as defaults.

625
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1.5.12.1.1.2  ... deselect the active command

How to deselect the active command.

Usually, you cannot edit an element when there is an active command to add

an element.

You must deselect the active command before you can edit an element.

To deselect a command:

1. Right-click you mouse 

OR

1. Click the ESC key on your keyboard 

OR

1. Start a new command 
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1.5.12.1.1.3  ... open a dialog

Edit an element - open the element's dialog

To edit an element, you must open the element's dialog. There are many meth-

ods.

With each method, you must select the element. You can select the element in

three places: 

· Graphics-Area

· Assembly-Tree 

· Selection-Window

It may be helpful to use a Selection-Filter to filter for the type of element you

want to edit.

See Selection-Filters

How to open a dialog:

Do one of these methods:

Method 1: Use the Selection-Window

1. Click the element you want to edit (see also the SHIFT-CLICK excep-

tion below) in the graphics-area or the ASSEMBLY-TREE 

The element is now in the SELECTION-WINDOW

2. Right-click the element in the SELECTION-WINDOW

A shortcut menu shows next to your pointer

3. Click Edit element in the shortcut menu

The element's dialog opens.

Method 2: Double-Click the element

Summary: 

To open the dialog, double-click one element in the:

· Graphics-Area

· ASSEMBLY-TREE

· SELECTION-WINDOW

68



628

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Double-click in the graphics-area

EXAMPLE: EDIT A MOTION-DIMEN-

SION FB

Double-Click in the graphics-area

1. Move your mouse-pointer

above the ELEMENT so that only

the element you want to edit

changes color to the Selection

Color (see Application-Settings

> Graphics tab  > Display Co-

lors) 

2. Double-click the element 

If it is difficult to double-click only the

element in the graphics-area:

· Use Selection Filters  to filter

for the element type you want

to edit.

· Use Display Filters to hide

other element types

OR 

Double-click in the Assembly-Tree

1. Double-click the ELEMENT in the

ASSEMBLY-TREE. 

Double-Click in Assembly-Tree

Double-Click in Selection-Window

OR

Double-click in the Selection-Win-

dow

1. First, click the ELEMENT in the

graphics-area or the ASSEMBLY-

TREE one time so that it shows

in the SELECTION-WINDOW. 

When the ELEMENT is in SELECTION-

WINDOW,

2. Double-click the ELEMENT in the

SELECTION-WINDOW. 

Method 3: Right-Click the element

Summary: 

1. Right-click the ELEMENT in the SELECTION-WINDOW, the ASSEMBLY-TREE

and graphics-area 

2. Click Edit-Element in the shortcut menu.

345

68
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Click, then Right-Click in Assembly-Tree

EXAMPLE: EDIT A MOTION-DIMEN-

SION FB

In the Assembly-Tree:

1. Click to select the ELEMENT in

the ASSEMBLY-TREE 

2. Right-click the ELEMENT

In the shortcut menu:

3. Click Edit Element

Right-click in the graphic-area

In the graphics-area:

1. Click the graphics-area to

deselect all elements 

2. Hover + Right-click an ELEMENT.

 

The shortcut menu shows. 

In the shortcut menu:

3. Click Edit Element 

Method 4: Edit toolbar > Edit Element tool 

You must pre-select the element you want to edit.

1. Click the element you want to edit in the SELECTION-WINDOW,

ASSEMBLY-TREE or graphics-area 

2. Click Edit toolbar > Edit Element icon

Click element in Graphic-Area

Click element in Assembly-Tree

For example:

To edit a GEARING FB:

1. Click the GEARING FB in the

SELECTION-WINDOW 

OR 

1. Click the GEARING FB in the

graphics-area 

OR

1. Click the GEARING FB in the

ASSEMBLY-TREE 

Click 'Edit-Element' icon in Edit menu

Then

2. Click Edit toolbar > Edit Element

 

The GEARING-FB DIALOG is now open.

Special Cases:

To edit a dimension in the Part-Editor
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Double-click Arrowhead

1. Make sure you deselect all other com-

mands. 

Frequently, Add Dimension is the active

command. You must deselect it. 

E.g click the ESC key on your keyboard.

2. Double-Click the arrowhead of a DIMEN-

SION to open the DIMENSION DIALOG 

If you try to click the dimension number -

R34.46 in the image to the left - MechDesigner

does not respond.

To edit a Gear-Pair or 2D-Cam

When you click a GEAR-PAIR or 2D-CAM,

it is possible to click four ELEMENTS:

· the GEAR-PAIR (or 2D-CAM) - select it

in the SELECTION-WINDOW

· a POLYLINE - you can only add or

update the shape of a POLYLINE

· a PROFILE and EXTRUSION - you can

only edit the EXTRUSION

To edit an Extrusion

Shift-click a Profile

To edit an EXTRUSION that you cannot

see, but you can see its PROFILE or
AUTO-PROFILE.

1. SHIFT-CLICK the PINK PROFILE ELE-

MENT 

The PROFILE AND EXTRUSION ELEMENTS

are now in the SELECTION-WINDOW. 

2. Right-click the EXTRUSION ELEMENT

in the SELECTION-WINDOW 

3. Click Edit element in the shortcut

menu.

Reasons you cannot edit an element

You cannot edit an ELEMENT when:

· A different dialog is open. Close all other dialogs. (ALT+F4 if you cannot

see the dialog).

· You double-click two or more elements. You open none or one dialog.

· A command is active, in the COMMAND-MANAGER. You must complete or

cancel that command.

· You cannot edit the element - for example, a SLIDE-JOINT
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1.5.12.1.1.4  ... edit a Parameter in a dialog

Edit a parameter in a dialog

In this example, the parameter-name is DIMENSION in the DIMENSION DIA-

LOG, and the parameter-value is 300.

Dimension dialog

In the image, I have added three colored boxes.

300  PARAMETER-VALUE - the value in the data-box.

10

 Spin-Increment - the change to the PARAMETER-VALUE

each time you click a Spin-Box arrow - see Spin-Box

tool

 Spin-Box tool: see more Spin-Box tool

If you cannot see the Spin-Box tool: 

Double-click, with your mouse-pointer in the data-box, to toggle from

show to hide, and then from hide to show the Spin-Box.

Double-click to hide Spin-Box

< >
Double-

Click Double-click to hide Spin-Box

How to edit parameters in a dialog.

There are three different methods to edit a value in a parameter box.

Method 1: Keyboard

Dimension dialog-box

Enter a value directly:

1. Use your keyboard to enter a value

in the data-box 

2. Press the Enter key (  ) on your

keyboard to update the parameter

to the new value

You must press the Enter key.

632
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Equation in Dimension box

Enter a value as a symbolic equation:

1. Use your keyboard to enter a sym-

bolic-equation in the data-box 

2. Press the Enter key (  ) on your

keyboard to update to the new

value

You must press the Enter key.

SYMBOLIC PARAMETERS FOR AN EQUATION:

· Simple Arithmetic: +, –, *, / 

· ^ (power), Sqrt()

· Trigonometric (Angles are Radians): pi, Sin(), Cos(), Tan(), Sinh(),

Cosh(), Tansh(), ArcSin(), ArcCos(), ArcTan2( ; )

Method 2: Spin-Box tool

Spin-Box arrowhead buttons (in the CYAN-BOX)

Spin-Box tool 

 Top, Left arrowhead: 

Subtract the Spin-Increment  from

the PARAMETER-VALUE  

 Top, Right arrowhead: 

Add the Spin-Increment  to the
PARAMETER-VALUE

 Bottom, Left arrowhead: 

Divide the Spin-Increment  by 10

 Bottom, Right arrowhead: 

Multiply the Spin-Increment  by

10

EXAMPLE:

Edit the PARAMETER-VALUE

Click the Top, Left arrowhead

PARAMETER-VALUE - Spin-Increment (1) = new PARAMETER-VALUE

67.12345 – 1 = 66.12345

Click the Top, Right  arrowhead two times: 

PARAMETER-VALUE + Spin-Increment  + Spin-Increment   = new PARA-

METER-VALUE

66.12345 + 1  + 1 = 68.12345

Edit the Spin-Increment

Click the Bottom, Left arrowhead

Spin-Increment / 10 = new Spin-Increment 
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1 / 10 = 0.1 

Click the Bottom, Right  arrowhead two times: 

Spin-Increment * 10 * 10 = new Spin-Increment 

0.1 * 10 * 10 = 10 

WARNING: The model re-builds each time you click the top arrowhead but-

tons in the Spin-Box tool. If the model is complex, it can take a long time to

update the model.

Method 3: Zero / Round / Copy / Paste

To see the Zero / Round / Paste / Copy

shortcut menu:

Right-click with your mouse-

pointer inside the parameter box 

· Zero - the parameter-value

changes to zero(0), or the smal-

lest possible value for the

parameter.

· Round - the parameter-value

changes to the nearest value

that is exactly divisible by the

Spin-Increment 

In the image, the Spin-Incre-

ment is 10. Therefore, the para-

meter value will change from

67.12345 to 70.

· Copy - to copy the parameter-

value to your clipboard.

· Paste - to paste your clipboard

to the parameter-value.
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1.5.12.1.1.5  ... rename an element

See Rename dialog
335
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1.5.12.1.1.6  ... save the elements to a DXF file

The elements you can save to a DXF file. 

It is possible to save the layout of these elements in a MECHANISM-EDITOR to a

DXF file.

· PART and BASE-PART XY-axes

· CAD-LINES, CIRCLES, and ARCS sketch-elements in each PART (NOT SPLINES

or BLEND-CURVES)

· 2D-CAMS (as line segments)

· POLYLINES of 2D-GEARS and GEAR-PAIRS (as line segments)

To save a DXF of the Mechanism-Editor:

1. Select the ASSEMBLY-TREE 

2. Select the MECHANISM-EDITOR you want to save as a DXF file

Before the next step, make sure that the MECHANISM element is in the Selec-

tion-Window. 

3. Select File menu > Save as

The Save as type should already be set to DXF

4. Enter a file name for the DXF file.

To save a DXF of a Part

1. Select the ASSEMBLY-TREE 

2. Select the PART you want to save as a DXF file

Before the next step, make sure that the MECHANISM element is in the Selec-

tion-Window. 

3. Select File menu > Save as

The Save as type should already be set to DXF

4. Enter a file name for the DXF file

To save a Gear-Pair to the DXF file

You must add a POLYLINE to the GEAR-PAIR  -see MD-Solids> Add / Update

Polyline

Then save the MECHANISM or PART elements to a DXF file - see above

1.5.12.1.2  FAQs

FAQs

What are the System Requirements?

Why are there so many files with the same file-name?

Why is it taking a long time to add or edit elements?

Cam Terminology

246
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1.5.12.1.2.1  What are the system requirements?

System Requirements

Operating System : Windows 10, 11

64-bit only

PC Memory (RAM) : Minimum 8GB

Recommended: 16GB and more

Hard Drive Space : Minimum: 20GB of available space

Recommended: 100GB or more - keep your

hard drive healthy.

Recommended: SSD - Solid State Disk

Graphics Card : High-performance Graphics-Card GPU

OpenGL 3.5+

Minimum: 2GB VRAM

Recommended: 16GB VRAM.

Screen Resolution : Minimum : 1920 × 1080 

Recommended : 4K (3840 × 2160)

Windows DPI Setting : If Screen Resolution is 1920 × 1080 , then set

to 100%

If Screen Resolution is 4K, then set to Win-

dows DPI to 150%. 

Shortcut for Display-Settings: Right-click Win-

dows Desktop, select Display settings.

Windows Permissions

Installation : Administrator Rights.

Download Help : 

Download Tutorials : 

Administrator Rights to download the Local

Help and Tutorials with the Help menu

1. Right-click the MD application open 

2. Click Run as Administrator in the

shortcut-menu

General Running : Administrator Rights are not needed.

However, you do need an internet connection.

MechDesigner occasionally checks your li-

cense with CopyMinder.

Software Protection

We use CopyMinder® for our software protection.

When you buy MechDesigner, we email you a Product Key. 
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You need the Product-Key to run MechDesigner the first time, or to move

MechDesigner to a different computer.

If you have a Network-License (also called a Floating-License), your I.T. de-

partment should install MechDesigner. I.T. should keep the Product Key. 
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1.5.12.1.2.2  Why are there so many files with the same file-name?

Why so many CXL and MTD files?

If you use Windows Explorer or File Explorer to find your model, you may

find many files with the same name, but different file extensions.

Question: 

Why so many files?

Answer: 

The CXL and the MTD are the last saved or the active model in RAM.

The other files are backup files.

For example, if the number of backup files is 3, you can see:

· CXL.3 & MTD.3 (oldest), CXL.2 & MTD.2, CXL.1 & MTD.1 (most recent).

· ~CXL and ~MTD, which we replace with the active model files (CXL &

MTD) every number of commands.

To control the number of backups, auto-save, and number of commands

between each auto-save:

· Application-Settings > General tab > FILE OPTIONS > : MAXIMUM #

BACKUP FILES.

· Application-Settings > General tab > FILE OPTIONS > : ENABLE

AUTO-SAVE 

· Application-Settings > General tab > FILE OPTIONS > : # COM-

MANDS TO AUTO-SAVE

WARNING : You overwrite the original model with each Auto-Save.
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1.5.12.1.2.3  Why is it taking a long time to add elements?

Tips for Working with Large Models:

· Disable Auto-Rebuild . Then experiment. You can continue to add many

elements successfully when rebuild is not active. Use Rebuild-Now

 every 4-5 commands to rebuild.

· Number-of-Steps  : Make 90 steps, or even less. You do not need many

steps as you build the model.

· Disable Show Solids in Mechanisms  : You do not need to show the

SOLIDS to add elements, to review the kinematics, or to calculate Forces.

· Image Quality  : If you must show MD-SOLIDS, then experiment with

the Image-Quality. Do this when there are many SOLIDS in the model.

· Spin-Box tool . Do not use the Spin-Box tool. The model re-calculates

with each click of the Spin-Box. Use your keyboard to enter new values in

each data- box.

1.5.12.1.2.4  Why is the model so 'dull'?

System Requirements

Occasionally, when you open a model,

the kinematic-elements are “dull”. 

You can manually correct this with the

Lighting conditions in Model Options

dialog.

You can also try this much faster

method.

In the Quick Access toolbar, or Visibility

toolbar:

Toggle on and off “Show Solids in

Mechanisms ”.

You can see that the sketch-elements

are now much brighter.

49
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1.5.12.1.2.5  Cam-Terminology

Cam Terminology

Terms : Definitions

Cam (or Cam-Part) : 
The PART to which you add the  (2D-CAM) to generate

the shape of the Cam-Profile.

Cam-Shaft :

 

The most common Cam-Part. It is a rotating-Part (a

shaft), to which you add the 2D-CAM (or 3D-CAM) as a

Cam-Profile. A Cam-Shaft usually rotates with a con-

stant angular-velocity.

Cam-Profile : 
The Cam-Flank and surface that is an extrusion of a 2D-

CAM (or 3D-CAM) which is in continuous contact with

the Follower-Profile.

Track-Cam or Groove-Cam : 
A groove that is cut into a Cam-Blank with an Outer

and an Inner Cam-Profile. A Follower-Roller fits in the

groove.

Follower (or Follower-Part) : The PART that supports the Follower-Profile. 

Follower Kinematic-Chain 

(or Kinematic Mechanism) : 

The Follower-Part and the other PARTS that you join to

the Follower-Part, to move the Tooling or Tool-Part.

Follower-Profile : 
The surface of a machine component that is rigidly con-

nected to the Follower-Part. The surface is in continu-

ous contact with the Cam-Profile.

Follower-Roller : 
A Follower-Profile that is cylindrical or barrel-shaped

that is rigidly connected to the Follower-Part.

Flat-faced Follower : 
A Follower-Profile that is a flat surface that is rigidly

connected to the Follower-Part.

Translating Follower : A Follower-Part that that moves along a straight axis.

Reciprocating Motion : A Translating Follower with a non-progressive motion.

Rotating Follower : A Follower-Part that rotates about a fixed axis.

Oscillating Motion : A rotating-Part with a non-progressive motion.

Progressive Motion : 
A motion, usually followed by a Dwell, that moves the

Follower-Part progressively in one direction.

Non-Progressive Motion : 
A motion that returns the Follower-Part to its original

position after each machine cycle.

 Indexing : A progressive motion, usually rotating.

Indexer : 

A device whose input is a constant-speed (usually)

Cam-Shaft and output is a rotating-Part with a pro-

gressive motion. The input rotates one time to index

the output one time. The index-angle is such that 360º/

(Index-Angle) is an integer. 

Cam-Blank : 
The material from which you cut the shape of the Cam-

Profile.
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1.5.12.2 Model Editor: How to... and FAQs

Model-Editor FAQs

How do I stop the solids turning red?

I cannot SHIFT+Drag to Spin (or CTRL+Drag to Pan) the model. Why?

1.5.12.2.1  How to stop Solids turning red

How to stop Solids turning Red as your mouse-pointer moves over

them.

In the MODEL-EDITOR, SOLIDS turn to the Selection-Color as you mouse-over

them (default color in Application-Settings > Graphics tab ) 

To stop this, filter for an element that is not in the MODEL-EDITOR. 

For example, Filter for Points. POINTS are not in the MODEL-EDITOR, and

therefore SOLIDS are not selected as you move your mouse-over them. 

See Filters menu (Filters toolbar) > Filter Points .

1.5.12.2.2  I cannot SHIFT+Drag to Spin or CTRL+Drag to Pan the model

You will find you cannot Spin or Pan your model with the Drag technique if your

mouse is above an element such that it changes to the Selected-Color. 

Make sure your mouse-pointer (cursor) is not above any other element before

you Mouse-Button-Down to start to drag.

Note: 

We recommend you use your keyboard arrow-keys (up-down-left-right) to

Spin the model - see more : Keyboard shortcuts .

641
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1.5.12.3 Mechanism Editor:  How to... and FAQs

Mechanism-Editor: How to ... and FAQs

How to ...

... show Velocity and Acceleration Vector ?

... edit a 2D-Cam, Gear-Pair, Profile?

... edit Profiles and Extrusions?

... change the assembly configuration of a mechanism?

... move a Motion-Dimension (and not the FB)?

... export a Cam directly to SOLIDWORKS?

... model a Pin in a Slot?

... to export my Cam as a Smooth Curve to SolidWorks/Solid Edge

... open the Configure Power Source dialog?

FAQs

Why can't I SHIFT+Drag to Spin (or CTRL+Drag to Pan) the model?

What do the different colors of Part-Outlines mean?

What is the hierarchy of Extrusions?

What are different 2D-Cam elements?

Why can I not see the Base-Part properly?

Why can I not add an Angle or Linear Motion-Dimension FB?

How many Mechanism-Editors can I add?

How many Kinematic-Chains can I add to a Mechanism-Editor?

Why are values in the graphics-area different in a Graph FB?

Troubleshooting

Profiles are not above the sketch-loops

Badly faceted sketch-elements .
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1.5.12.3.1  How to...

How to...

... connect Function-Blocks with wires

... show Velocity and Acceleration Vector

... edit a 2D-Cam, Gear-Pair, Profile

... edit Profiles and Extrusions

... change the assembly configuration of a mechanism

... move a Motion-Dimension (and not the FB)

... model a Pin in a Slot

... to export my Cam to SolidEdge

... open Configure Power-Source dialog

1.5.12.3.1.1  ... connect Function-Blocks with wires

How to connect Function-Blocks:

Double-click to watch Video Clip

1.5.12.3.1.2  ... show Velocity & Acceleration Vectors

How to show Velocity and Acceleration Vectors

You can show the Velocity and Acceleration Vectors of any moving POINT *.

The POINT must be a child to a kinematic-chain that is kinematically-defined.

To show the Velocity or Acceleration Vectors:

1. Edit the POINT to open the Point Properties dialog.

See How to edit an element

* POINT, START-POINT, END-POINT, CENTER-POINT, MOTION-POINT

1.5.12.3.1.3  ... edit a 2D-Cam, Gear-Pair, or Profile

How to edit a 2D-Cam / Gear-Pair with Polyline and Profile elements.

When you add a POLYLINE to a 2D-CAM* and then add a PROFILE to the

POLYLINE**, there are three coincident elements. 

This topic describes how to edit, update, and delete these elements so that

their shapes are coincident.

* 2D-CAM and GEAR-PAIR, throughout this topic, unless noted otherwise.

** There is also an EXTRUSION as a child to the PROFILE element.

Element 1: 2D-CAM (or GEAR-PAIR)

The shape of the 2D-CAM is a function of the motion and geometry of the Fol-

lower.

643

643

643

645

647

647

647

648

651

543

627


How toConnect FBs-Aa.gif



644

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

If you edit a parameter that changes the shape of the 2D-CAM, the POLYLINE

does NOT automatically change its shape.

To update the shape of the POLYLINE, you must do Add / Update Polyline

again - Solids menu > Add / Update Polyline . 

The PROFILE updates to the new shape of the POLYLINE automatically.

If you delete the 2D-CAM, the POLYLINE and PROFILE/EXTRUSION elements re-

main in the graphics-area.

Element 2: POLYLINE

If the shape of the 2D-CAM changes, do Add Polyline again to update its

shape to that of the 2D-CAM - see Solids menu > Add / Update Polyline .

To delete the POLYLINE, you must edit the Cam-Part.

If you delete a POLYLINE, in the PART-EDITOR, you are warned that you will also

delete the PROFILE/EXTRUSION elements. 

Elements 3/4: PROFILE / EXTRUSION

You can delete the PROFILE. You will also delete the EXTRUSION.

You cannot edit the shape of the PROFILE as it is controlled by the shape of the

POLYLINE, which, in turn, is controlled by the shape of the 2D-CAM.

You can edit the EXTRUSION, but not its shape - see Extrusion dialog .

To delete an EXTRUSION you must delete the PROFILE.

To edit the 2D-Cam OR the Extrusion:

2DCam>Polyline>Profile>Extrusion

The Extrusion is visible in graphics-

area .

In the graphics-area:

1. Click the 2D-CAM you want to

edit - or the edge of the EXTRU-

SION 

All four elements (2D-CAM,

POLYLINE, PROFILE, EXTRUSION)

show in the SELECTION-WINDOW

In the SELECTION-WINDOW:

2. Right-click the 2D-CAM that you

want to edit 

OR 

2. Right-click the EXTRUSION you

want to edit 

Then:

3. Click Edit Element in the short-

cut menu

The Extrusion is NOT visible in graph-

ics-area.

2DCam>Polyline>Profile>Extrusion
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In the graphics-area:

1. SHIFT + Click the 2D-CAM you

want to edit - or the edge of

the EXTRUSION 

All four elements (2D-CAM,

POLYLINE, PROFILE, EXTRUSION)

show in the SELECTION-WINDOW

In the SELECTION-WINDOW:

2. Right-click the 2D-CAM that you

want to edit 

OR 

2. Right-click the EXTRUSION you

want to edit 

Then:

3. Click Edit Element in the short-

cut menu 

4 Elements in Selection-Window

Part, 2D-Cam, Profile, and Extrusion

elements in the Assembly-Tree

In the Assembly-Tree:

1. Find and expand the PART ele-

ment in the ASSEMBLY-TREE 

2. Click the 2D-CAM or the EXTRU-

SION in the ASSEMBLY-TREE

3. Right-click the 2D-CAM or the
EXTRUSION

4. Click Edit Element in the short-

cut menu

1.5.12.3.1.4  ... edit Profiles and Extrusions

How to edit Extrusion elements

NOTE: 

An EXTRUSION is a child to a PROFILE.

· You can ONLY EDIT EXTRUSIONS 

· You can ONLY DELETE PROFILES, which also deletes its child EXTRU-

SION.

310
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Edit the Extrusion

SHIFT+CLICK Profile element

GRAPHICS-AREA - OPTION 1:

The image to the left shows PROFILES con-

tours (Pink is the default color) in the

graphics-area. The EXTRUSION is not in the

graphics-area.

1. MECHANISM-EDITOR: Click a Mechan-

ism name-tab

2. MECHANISM-EDITOR: Spin the View to

show the Pink PROFILE contours in the

graphics-area 

3. SHIFT+ Click a PROFILE

4. SELECTION-WINDOW: Make sure the

PROFILE and EXTRUSION show in the
SELECTION-WINDOW

5. SELECTION-WINDOW: Right-click the
EXTRUSION in the SELECTION-WINDOW

6. SELECTION-WINDOW: Click Edit ele-

ment in the shortcut menu

Profile AND Extrusion in

Selection-Window

GRAPHICS-AREA - OPTION 2:

1. MECHANISM-EDITOR: Hover + Click one

PROFILE/EXTRUSION 

2. MECHANISM-EDITOR: Right-Click the

PROFILE/EXTRUSION in the graphics-

area

3. MECHANISM-EDITOR: Click Edit Ele-

ment in the shortcut menu

ASSEMBLY-TREE - OPTION 3:

1. MECHANISM-EDITOR: In the graphics-

area, click the PART that is the parent

to the PROFILE 

In the ASSEMBLY-TREE, the PART element

shows with a square around the Element

icon. 
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2. ASSEMBLY-TREE: Expand the tree for

the PART to show the PROFILE and EX-

TRUSION elements

3. ASSEMBLY-TREE: Right-click the EXTRU-

SION 

4. ASSEMBLY-TREE: Click Edit element in

the shortcut menu

Delete a Profile? 

Delete the Profile (and the Extrusion)

1. MECHANISM-EDITOR: Click a PROFILE in

the ASSEMBLY-TREE or the graphics-

area 

The PROFILE shows in the SELECTION-WIN-

DOW.

2. Right-Click the PROFILE 

3. Click Delete element in the shortcut

menu

1.5.12.3.1.5  ... change the assembly configuration of a mechanism

How to change the Assembly-Configurations of a Mechanism.

Mechanisms, with the same number and length of PARTS, and number and

types of joints, can be arranged in different configurations.

We call this the mechanisms closures, or the Dyad Closure.

See : Change the Closure of a Dyad

1.5.12.3.1.6  ... move a Motion-Dimension (not the FB)

How to move a Motion-Dimension that controls the position of a

Rocker or Slider.

This topic is “How to move the MOT-DIM FB in the graphics-area”.

You can simply drag nearly all FBS in the graphics-area. How the MOT-DIM FB

behaves differently.

To move the MOTION-DIMENSION (that is, the dimension only)

CTRL + Drag the MOTION-DIMENSION FB

OR

To move only the FB 

· Drag the MOTION-DIMENSION FB

1.5.12.3.1.7  ... model a Pin in a Slot

How to model a Pin in a Slot

119
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See INTERNET LINK  MechDesigner: Getting Started Tutorial 2A: Four-Bar

Kinematic-Chains STEP 2.8 Kinematic-Chains: Model a Pin in a Slot.

1.5.12.3.1.8  ... export a Cam to SOLIDWORKS

How to export a Cam to SOLIDWORKS or Solid Edge

Calculate the coordinates of the cam profile with a Cam-Data FB .

You can calculate the cam profile as a series of Points or as a series of BiArcs.

To export the cam profile data to SOLIDWORKS from

MechDesigner as a series of Points

1. Make sure SOLIDWORKS is open, and a Part document, existing or new,

is the active document.

2. Open a CAM-DATA DIALOG

3. Link a 2D-CAM to the CAM-DATA FB

4. Calculate the Cam-Coordinates at EQUAL INCREMENTS of the Master

Machine Angle - say 360 for a typical plate size of cam

5. Click the “Send to SOLIDWORKS” button in the Cam-Data FB toolbar

The data in SOLIDWORKS is a Curve feature.

The Curve feature is on the XY-

Plane, which is the Front View in

SOLIDWORKS.

Note: To move the Curve feature to the

XZ or the YZ Plane. In the CAM-

COORDINATED DIALOG: 

1. Save the Data as a SLDCRV file-

type (in the Cam-Data FB > Save

)

2. Edit the data in Excel®, and

swap the X-data, or Y-data, and

the Z-data

3. Save the data to NotePad®

In SOLIDWORKS:

4. Click Insert menu > Curve >

Curve Through XYZ Points

5. Import the data, and close the

Curve feature dialog

6. Select a Plane that is coplanar or

parallel to the Curve feature

7. Start a sketch on the Plane

8. Use Convert Entities in

SOLIDWORKS® sketch editor

446
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9. Extrude the Curve.

You can see the Cam does not have any

facets.

To import into other CAD

Open Excel®

1. Open the file, with file-type as... *.TXT 

2. Select delimiter, as a ',' or 'tab'.

You want the 'X' and 'Y' Cam Points in separate columns. 

Experiment with the import options if necessary.

3. Tidy up the data, remove headers etc.

4. Move all the data so the first X Point starts at Cell A1, and the first Y

Point at B1.

5. If necessary, make the first and last X and Y points equal - you may

need to add a row of data.

6. Add a Column for the Z-Axis, and fill it with Zeros (0).

Experiment as necessary. 

7. If necessary, scale the Cam-Data to the units you are working in your

CAD. 

8. Save your data to an Excel® spreadsheet.

9. Save your Data to a NotePad® file.

You  may be able to import the Excel® or the NotePad® file into your CAD.

Import Cam Data into Solid Edge

Insert Object / Curve by Table

Select:

1. Surfacing tab Curves group Keypoint Curve By Table 

2. On the Insert Object dialog, set the Create from File option and click

OK.

Browse to and Open your Excel® spreadsheet 

Curve by Table uses an Excel spreadsheet to define a construction curve.

The spreadsheet, which is embedded in the Solid Edge document, allows

you to more easily import your data.
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Solid Edge: Curve by Table Parameters dialog

CURVE BY TABLE PARAMETERS

Curve Fit

· Linear Segment

Creates line segments between the data points in the table.

· Smoothing Off

Applies the direct curve fit method to the data points in the table. Using

this method, the curve passes directly through the points.

· Smoothing On

Applies the 'least squares' curve fit method to the data points in the

table. When you select this option, you enable the tolerance drop list.

Using this method, the curve path is controlled by the tolerance value

and does need to touch the points.

· Tolerance

Allows you to specify a tolerance for the Smoothing On option. It is the

maximum distance the curve can deviate from the points.

Curve End Conditions

· Open
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To specify an open curve. For example, the first and last data points do

not touch each other or any part of the curve.

· Closed 

To specify a closed curve. For example, the first and last data points can

touch one another or any part of the curve. When this option is set, the

Periodic and Natural options are available.

· Periodic

Connects the first data point with the last data point to make a smooth

tangent closed curve.

· Natural

Creates a closed curve without a tangent condition.

Note: The Curve by Table feature fails if the first and last data points in the

spreadsheet are coincident. If you select 'Closed', delete the last point in the

table if it is coincident with the first point.

Coordinate System

Allows you to select coordinate systems to offset the curve data to. Make

the coordinate system prior to creating the curve through table of points.

Number-of-points

Records the total number-of-points in spreadsheet.

Possible Problems with Curve by Table

The following are possible error messages resulting from Curve by Table:

· Invalid Geometry: Edit Feature Inputs

The data points in the spreadsheet are incorrect. Check the spreadsheet

and make certain you have input at least two rows of X,Y,Z coordinates,

have not skipped any cells, and have not entered data points that define

a curve that runs back through itself either in 2D or 3D.

· Curve Is Self Intersecting

The curve runs back through itself in 2D or 3D. Change the data points in

the spreadsheet.

· Units Set Out Of Range

The units are too large. Make sure the diameter of the model is less than

five kilometers.

· Curve By Table Feature Failed

Closed and Periodic options are set on the Curve Table Parameters dia-

log, and the first and last data points in the spreadsheet are coincident.

Change one of the coincident data points.

1.5.12.3.1.9  ... open Configure Power Source dialog

How to open the Configure Power Source dialog

You must first select a Kinematic-Chain in the KINEMATICS-TREE.

1. Click the KINEMATICS-TREE in the Element-Explorer  
315
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2. Click the Kinematic-Chain whose Power Source you want to specify

The color of the Kinematic-Chain  should now be  blue .

When the color of the Kinematic-Chain  is  blue , you can use three different

methods to open the CONFIGURE POWER SOURCE DIALOG:

METHOD 1 : Forces toolbar / menu

1. Click Force toolbar  / menu > Configure Power Source

icon

METHOD 2 : Shortcut menu

Configure Power Source from

Kinematics-Tree

1. Right-click the  Kinematic-

Chain  

2. Click Configure Power

Source in the shortcut

menu 

METHOD 3 : Key combination

1. Press the ALT+P keyboard shortcut on your keyboard. 

The CONFIGURE POWER SOURCE DIALOG is now open.

226
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1.5.12.3.2  FAQs

FAQs

Why can't I SPIN or PAN the model with the Drag technique?

What do the different colors of Part-Outlines mean?

What is the hierarchy of Extrusions?

What does Kinematically-Defined mean?

I cannot select a Part-Outline? What do I do?

What are different 2D-Cam elements?

Why can I not see the Base-Part properly?

Why can I not add an Angle or Linear Motion-Dimension FB?

How many Mechanism-Editors can I add?

How many Kinematic-Chains can I add to a Mechanism-Editor?

Why are values in the graphics-area different in a Graph FB?

1.5.12.3.2.1  Why can't I SHIFT+Drag to Spin (or CTRL+Drag to Pan) the model

Shift+Drag and CTRL+Drag do not work?

Occasionally, you cannot Spin or Pan your model with the SHIFT+Drag or

CTRL+Drag, keys on your keyboard.

There are two possible reasons:

A. Your mouse-pointer is above an element (e.g. a PLANE), before you press

the SHIFT or CTRL DE: STRG key.  

Make sure your mouse-pointer (cursor) is not above an element before you

Mouse-Button-Down to start to drag or pan.

OR

B. A bug - MechDesigner just stops responding to the keyboard and mouse

controls as we expect.

We cannot find why this happens. 

You must re-start MechDesigner.

Note: 

We recommend you press the left-arrow, right-arrow, up-arrow, and down-

arrow keys  on your keyboard to Spin the model by 10º each click (or Shift +

Click = 90º , Ctrl + Click = 30º)

See also : Keyboard shortcuts

1.5.12.3.2.2  What is a Part-Outline and why different colors?

What is a Part-Outline?

The PART-OUTLINE is the symbol for a PART.  You can not edit the shape of

PART-OUTLINES. 
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You select PART-OUTLINES:

· to edit a PART with the PART-EDITOR

· to add a more complex element, e.g. a PULLEY.

An added PART:

Added Part: Part-Outline, and elements

 An “Oval” Part-Outline: the symbol of a PART you have added to the

model.

The other elements and symbols in a PART you add to the model are:

 START-POINT and  END-POINT of the PART

 CAD-LINE from the START-POINT to the END-POINT

 X-axis and Y-axes: at the START-POINT (origin)

The BASE-PART: 

Base-Part - Part Outline

 “Rectangular” Part-Outline : the symbol and shape of the BASE-PART.

 X-axis and Y-axes at the origin of the BASE-PART.

Colors of Part-Outlines

You can edit the colors of PART-OUTLINES for those PARTS that are kinematic-

ally-defined and not kinematically-defined.

In the Application Settings dialog , we use these terms:

· “Part Solved” for a PART that is kinematically-defined

· “Part Not Solved” for a PART that is not kinematically-defined

When you display Forces, we automatically change the colors of all PART-

OUTLINES to have different colors. 

345
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Free (1) / Completely-Free(3)

Blue Part-Outlines - or approximately

Blue.

The PART is NOT kinematically-

defined.

Blue PARTS are:

· Completely-Free  - without a

Joint

· Free  - with a Joint, but not

kinematically-defined

· Part Not Solved

2 Parts kinematically-defined

Green Part-Outlines - or approxim-

ately Green

The PART is kinematically-defined.

Other names for Green PARTS are:

· kinematically-defined  

· Part Solved

Note: The BASE-PART is always kinemat-

ically-defined and. therefore, Green.

Part-Outlines : Forces Vectors

Multi-colored Part-Outlines

Each PART has a random color when, in

the Forces Toolbar , you:

· Enable Calculate Forces  

AND

· Display Force-Vectors  

The color of the Part-Outline is the

same as the color of the Force-Vector

that acts-on the PART.

1.5.12.3.2.3  What is the hierarchy of Extrusions?

What is the Hierarchy of Extrusion?

The Parent to Child hierarchy is as follows:

MODEL > PLANE > MECHANISM > PARTS > (sketch-loop) > (Auto) PROFILE >

EXTRUSION or HOLE

There are a number of elements that must 'co-exist' to add Extrusions to model

solids. It is helpful to understand the:

· Commands that you need to use

· Elements that MechDesigner adds to the model for you.

226
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Command 1 : 

Add sketch-elements to LINES, CAD-LINES, ARCS, CIRCLES

to define the shape of a sketch-loop

OR 

Add Polyline to a 2D-CAM or a GEAR-PAIR

 MechDesigner : 
è

Sketch-Loops: 

...we recognize for you a sketch-loop

Command 2 : è

Add Profile: 

You select a sketch-element that

is one sketch-element in a

sketch-loop

MechDesigner : è

Extrusions: 

...we add an EXTRU-

SION with Add-Pro-

file

Command 3 : 

è

Add

Holes:

Through
EXTRU-

SIONS

See Tutorial 4 How to add sketch-loops

1.5.12.3.2.4  What does kinematically-defined mean?

What does kinematically-defined mean?

When the Mobility of a kinematic-chain is zero, it is kinematically-defined.

In summary: All PARTS in the model must be kinematically-defined before you

should analyze any kinematic and force data.

There are two kinematic-states of PARTS.

Not kinematically-defined : The Mobility of a PART is one or more.

kinematically-defined : The Mobility of a PART is zero. 

Mobility of a Kinematic-chain = # Degrees-of-Freedom – # Motion-Dimen-

sions.

# Degrees-of-Freedom of a kinematic-chain 

N = Number of PARTS

J= Number of JOINTS

1.5.12.3.2.5  I cannot select the Part-Outline! What to do?

Why can I not select the Part-Outline?

With some graphic-cards, you cannot select the PART-OUTLINE easily.

Basic Checks

672
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· Do you have a Selection-Filter selected? - See Filters menu > Selection-

Filters 

· Are you using an Intel graphics-card? - See Help menu > About > Graph-

ics tab > Graphics-Card

Your laptop may have two graphics-cards. If this is the case, force your

laptop to use the other graphics-card (that is, NOT the Intel) when you start

MechDesigner.

Alternative Methods

If the Basic Checks are not helpful, then there are three other METHODS to se-

lect a PART-OUTLINE, or PART. 

METHOD 1: 

METHOD 1: Select near start-Point.

The Arc near the Part's start-Point

method

1. Move your pointer above the arc

of the PART-OUTLINE - see image

 

2. Double-Click your mouse

or 

2. Click your mouse 

The PART should be in the SELEC-

TION-WINDOW

3. Right-Click the PART 

4. Click Edit element in the shortcut

menu

METHOD 2: 

METHOD 2:  Double-click the Y-axis

The Y-axis method.

1. Double-click the Y-axis to edit a

PART, 

METHOD 3:
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METHOD 3: Select in the Assembly-Tree

The Assembly-Tree method.

In the ASSEMBLY-TREE:

1. Right-Click the PART 

2. Select Edit element in the short-

cut menu

1.5.12.3.2.6  What are the different 2D-Cam elements?

2D-Cam: Elements, Properties, Parameters, Analysis, Coordinates

These are the different elements and Function-Blocks you need to know, and how

they are related.

Usually, do these steps

1. Add a 2D-CAM - see Add 2D-Cam  

If the new 2D-CAM is one of a Conjugate-Cam pair, or one Flank of a

Groove-Cam (BODY-CLOSED CAM) then:

 1.a. Add a CONJUGATE-CAM FB 

 1.b. Edit the CONJUGATE-CAM FB to add the the flanks of two 2D-CAMS -

see Conjugate-Cam dialog . 

Then:

2. Select the 2D-CAM or the CONJUGATE-CAM as the Power Source for the

Follower - see Configure-Power Source  

Then:

3. Open the 2D-CAM DIALOG  to review 2D-CAM'S PROPERTIES. 

2D-CAM PROPERTIES dialog: 

· Display the INNER OR OUTER, INNER AND OUTER, PITCH-CIRCLE 

· Display Cam-Profile as PROFILE-ONLY, PRESSURE ANGLE, CONTACT-

FORCE, SHEAR-STRESS

· Indicate at Contact-Point the PRESSURE ANGLE, CONTACT-FORCE,

SHEAR-STRESS, RADIUS-OF-CURVATURE

· Display COLOR, LINE THICKNESS of CAM-PROFILE

· ROLLER LIFE: Edit the Roller manufacturer, Roller model, Oil/Grease

Lubrication Temperature, Oil/Grease Viscosity Properties, Oil/Grease

Contamination.

· CAM LIFE: Edit the Cam's Steel Category/Type, Steel Quality, Steel

Heat-Treatment, Steel Hardness.

Then:

4. Add a CAM-DATA FB - see Add Cam-Data FB  

128
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5. Link a 2D-CAM to the CAM-DATA FB - see Link the Cam-Data FB to a 2D-

Cam

Then:

6. Connect wires from the CAM-DATA FB to a GRAPH FB to analyze 5 differ-

ent parameters of the 2D-CAM - see Cam-Analysis Parameters  

7. Calculate the Cam-Coordinates - see Cam-Coordinates dialog  

Output-Connectors from CAM-DATA

FB:

è CONTACT-FORCE 

è CONTACT-SHEAR-STRESS 

è RADIUS-OF-CURVATURE 

è PRESSURE-ANGLE 

è SLIDING VELOCITY 

Calculate Cam-Coordinates

è Save as DXF, TXT, STEP 

è Transfer Cam directly to

SOLIDWORKS

è Save as: XY-Coordinates, Bi-

arcs, STEP

1.5.12.3.2.7  Why can I not see the Base-Part properly?

Reasons the Base-Part does not show correctly.

Why is the Base-Part not Green?

The Base-Part is not Green!

If the BASE-PART is a not Green, it is

possible that Force-Vectors: Display is

enabled.

 Force toolbar > Force-Vect-

ors: Display is enabled 

 

1. Click to disable Force Vectors:

Display

RESULT

Force toolbar >Force-Vect-

ors: Display is disabled

The BASE-PART should be Green.

Why is half of the Base-Part hidden by a Plane?

Base-Part partial hidden by a Plane.

If the BASE-PART is partly hidden by a

PLANE, then:

Visibility toolbar > Show

Solids in Mechanism is en-

abled 

When you enable Show Solids in

Mechanism, we also show PLANES. 

To hide PLANES, do:

440

442

446
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Disable Visibility toolbar >

Show Solids in Mechanism

to hide SOLIDS and PLANES.

AND / OR 

Disable Display toolbar >

Display Planes to hide Planes

Why is the Base-Part not Green?

The Base-Part is not green.

The Part-Outline of the Base-Part is in a

different Mechansim-Editor.

You can see Kinematic and sketch-ele-

ments of other MECHANISM-EDITORS

when these are enabled:

 Enable Show other

Kinematic and Sketch-Elements -

(Visibility toolbar)

Click to disable.

 AND 

Enable Mechanism name-tab light-

bulb in the other MECHANISM-ED-

ITOR (Right-click Mechanism name-

tab)

1.5.12.3.2.8  I cannot add an Angle (or Linear) Motion Dimension FB. Why?

Motion-Dimension: Commands and Elements.

You must select three elements when you add a MOTION-DIMENSION FB as a

Rocker. They are:

· A PIN-JOINT...

· ...followed by two LINE sketch-elements.

However, you may find you cannot select one of the LINES to complete the com-

mand. 

This can happen when:

· there is already a MOTION-DIMENSION FB at the PIN-JOINT 

· the POINT at the PIN-JOINT is not a child to the LINE that radiates from the

PIN-JOINT.

· the PIN-JOINT that you select is not a PIN-JOINT between the two LINES you

want to select.

Read this topic:  Add Motion-Dimension  for more details.179
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1.5.12.3.2.9  How many Mechanism Editors can I add?

How many Mechanism-Editors/Tabs can I add?

You can add as many Mechanism-Editors and Tabs to as many Planes as you

like. 

It is possible to design complete machines in one Mechanism-Editor. Alternat-

ively, you can model a machine with many Mechanisms Editors, each contribut-

ing a kinematic-chain.

The model to the left shows 47 Mechanism-Editors.

1.5.12.3.2.10  How many Kinematic-Chains in a Mechanism Editor?

How many Kinematic-Chains can I add to each Mechanism-Editor?
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You can add as many Kinematic-chains as you need to model your machine.

Within the capacity of your PC and RAM.

For example, in the image to the left, I have modeled 160 kinematic-chains on

one Mechanism-Editor - all Sliders with a Motion

1.5.12.3.2.11  Why are Graph values different in the graphics-area?

In the graphics area, we evaluate the values exactly at the Master Machine

Angle.

In a Graph FB we evaluate the values at each machine-step.  See Machine

Settings dialog > Number-of-Steps .

The Master Machine Angle can be any angle from 0 to 360. which may not

be equal to the angle of step in the machine-angle 

The values that you can display in the graphics-area and plot with a Graph

FB include:

· Velocity vectors

· Acceleration vectors

· Force vectors

· Torque vectors

· Angle Motion-Dimension of a Rocker

· Linear Motion-Dimension of a Slider

· 2D-Cam Radius of Curvature

· 2D-Cam Pressure Angle

· 2D-Cam Contact-Force

· 2D-Cam Contact-Stress

· 2D-Cam Sliding-Velocity

351
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1.5.12.3.3  Troubleshooting

Troubleshooting

Profile elements are not above the sketch-loops. What do I do?

The sketch-elements have large facets. What to do?

1.5.12.3.3.1  Profiles are not above the sketch-elements

Problem: 

The position of the PROFILE and the EXTRUSION elements are not above the

sketch-loops or Polylines.

Solutions:

Sketch-loops

1. Click the Home key on your keyboard, or do Run menu > Home - to move

the Master Machine Angle to zero.  

2. Open the PART with the sketch-loops in the PART-EDITOR, and then close

the PART-EDITOR immediately. 

3. Click Rebuild Now  to rebuild the model. 

Polylines

1. Click the Home key on your keyboard, or do Run menu > Home - to move

the Master Machine Angle to zero.  

2. Click the 2D-CAM or GEAR-PAIR that you want to move to the correct posi-

tion.

3. Click Rebuild Now to rebuild the model.

1.5.12.3.3.2  Badly-Faceted Sketch-elements

Problem:

The CIRCLE and ARC sketch-elements have large facets. 

Solution: 

Open the PART with the sketch-elements in the PART-EDITOR, and then close

the PART-EDITOR immediately. 

663

663

50



664

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.5.12.4 Part Editor: How to... and FAQs

Part-Editor: How to... and FAQs

How to...

... start the Part-Editor to edit a Part

... edit the Length of a Part

... delete Sketch-Elements

... delete Constraints

... add a Sketch-Loop

FAQs

How do I know I am using the Part-Editor?

Why edit a Part?

How many Parts can I edit at a time?

Can I edit (and other questions relating to) the Part-Outline?

What are the color codes for sketch-elements in the Part-Editor?

Why is a dimension 'negative' in the Dimension dialog?

Why do I need to add geometry to the Base-Part?

My sketch has disappeared! What do I do?

What are the colors used in the Part-Editor?
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1.5.12.4.1  How to...

How to...

... start the Part-Editor

... edit the Length of a Part

... delete Sketch-Elements

... delete Constraints

... add a Sketch-Loop
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1.5.12.4.1.1  ... start the Part-Editor

How to start (open) the Part Editor

Use the PART-EDITOR to edit one PART at a time. 

To edit a different PART:

1. Exit (close) the PART-EDITOR - see also How to exit (close) the Part-Editor

2. Select and edit a different PART.

Video: How to start the Part-Editor:

Double-click to watch

How to start the Part-Editor - more details

Do one these methods.

METHOD 1: Edit-Part tool 

STEP 1: Click a PART-OUTLINE  in the

graphics-area 

STEP 2: Click Edit toolbar >  Edit Part

 (MD17: Toggle "Part-Ed-

itor")

You can now use the PART-EDITOR to

add, edit, or delete sketch-elements

and constraints in the PART-EDITOR. 

See How to delete Constraints

Note: The (MD17: Toggle "Part-Editor") icon is to the left of the

graphics-area.

See also: How to close the Part-Editor: Method 1

METHOD 2: Selection-Window  

STEP 1: Click a Part-Outline 

STEP 1: Select the Part

In the graphics-area: 

1. Click the PART-OUTLINE  ( or

at  with some graphic-cards).

OR

Assembly-Tree:

1. Click the PART element 

STEP 2: In the Selection-Window 

1. Find the PART from the list of

elements in the SELECTION-WIN-

DOW  

263
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STEP 2: Right-click the Part in the

Selection-Window, Click Edit element

2. Right-click the PART element

In the shortcut menu

3. Click Edit Element 

The PART is now open in the PART-ED-

ITOR.

METHOD 3: Double-Click 

Double-click a Part-Outline in the

graphic-area

STEP 1:

Double-click ... in the graphics-

area:  

1. Double-click the PART-OUTLINE

 

OR

1. Double-click a LINE, ARC, or

CIRCLE SKETCH-ELEMENT  that

is in the PART 

OR

1. Double-click the Y-AXIS  of

the PART 

The PART is now open in the PART-

EDITOR.

OR

Double-click ... in the Assembly-

Tree: 

1. Double-click the PART element 

The PART is now open in the PART-

EDITOR.

Double-click a Part in the

Assembly-Tree

If you double-click a:

CAD-Line  ... the CAD-Line dialog  opens

Blend-Curve  ... the Blend-Curve dialog  opens

Point  ... the Point Properties dialog  opens

More than one element ... nothing happens.

METHOD 4: Right-Click

364
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Hover+ Right-click a Part-Outline in the

graphic-area

In the graphics-area:

1. Move your mouse above the

PART-OUTLINE 

Note: With some graphic-cards, move

your mouse to the arc at the end of the

PART-OUTLINE near to the START-POINT

of the PART and CAD-LINE.

2. Right-Click the PART-OUTLINE 

3. Click Toggle “Part-Ed-

itor” (MD16: Edit in Part-Editor)

from the shortcut menu.

The PART is now open in the PART-ED-

ITOR.

Occasionally, there is a problem with a Graphic-Card

With some graphics cards, you cannot select the PART-OUTLINE to edit a

PART. Try these methods:

Select the Part-Outline near start-Point.

METHOD 1: Graphics-area

1. Move your mouse-pointer above

the arc of the PART-OUTLINE near

to the Part-axes -(see image) 

2. Double-click your mouse

METHOD 2: Selection-Window

1. Move your pointer above the arc

of the PART-OUTLINE - see image

 

2. Click your mouse one time.

In the SELECTION-WINDOW:

3. Right-Click the PART

4. Click Edit element

OR Double-click the Y-axis

METHOD 3: 

OR

1. Double-click the Y-axis.
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Select a Part in the Assembly-Tree

Method 4:

OR

In the ASSEMBLY-TREE

1. Right-Click the PART 

2. Select Edit element in the short-

cut menu.
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1.5.12.4.1.2  ... edit the Length of a Part

How to edit the Length of a Part, or to edit a Dimension

You must edit the PART in the PART-EDITOR to edit the length dimension of the

PART.

STEP 1: Select the Part and start the Part-Editor

Part in Mechanism-Editor

There are many ways to start the PART-ED-

ITOR - see here .

E.g.

1. Double-Click the PART-OUTLINE of

the PART you want to edit 

STEP 2: Edit the dimension 

The length of the PART is the dimension of the CAD-LINE that is coincident with

the X-axis of the PART.

Double-click arrowhead of dimension

1. Double-Click the arrowhead of the

dimension 

The DIMENSION DIALOG opens.

2. Enter a new dimension 

There are four(4) methods you can use to

enter a new value to edit the dimension:

A: Enter a new dimension with your key-

board 

B: Enter an equation with your key-

board 

C: Use the spin-box tool 

D: Right-click the data-box, then click

Zero, Round, Copy or Paste. 

Notes: 

A and B: Direct and Equation: Click the

ENTER key ( ) on your keyboard to up-

date the dimension to the new value.

C: Spin-Box: The dimension AND the

model updates immediately - if the model

is large, there is a delay after each click.

D: Round: The dimension changes to the

nearest value that is exactly divisible by the

Spin-Increment.

Dimension dialog-box

259
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Dimension dialog-box - contextual

menu

Enter an equation for the dimension

More on EQUATIONS:

You can enter:

· Simple Arithmetic: +, –, *,   

· Powers: ^, Sqrt()

· Trigonometric (Angle in Radians)

o Sin(), Cos(), Tan(), 

o Sihn, Cosh, Tansh

o ArcSin(), ArcCos(), ArcTan2( ; )

Usually 3.14159 is accurate enough for .

1.5.12.4.1.3  ... delete Sketch-Elements

How to delete Sketch-Elements:

To delete ONE sketch-element - and you can select one sketch-element.

1. Click the sketch-element in the graphics-area

2.  Click the Delete key on your keyboard 

To delete ONE sketch-element, but you select more than one sketch-ele-

ment:

1. Click the sketch-element in the graphics-area 

The element shows in the SELECTION-WINDOW.

2. Right-click the sketch-element you want to delete in the SELECTION-

WINDOW

A shortcut menu shows next to your pointer:

3. Click Delete element in the shortcut menu

To delete MULTIPLE sketch-elements:

1. Drag a window to select multiple sketch-elements in the graphics-

area 

2. Click the Delete key on your keyboard
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1.5.12.4.1.4  ... delete Constraints

How to delete a sketch Constraint

You cannot see Geometric-Constraints in the graphics-area.

1. SHIFT + Click a sketch-element in the graphics-area 

The sketch-element AND the constraints that you have added to it show

in the SELECTION-WINDOW.

2. Right-click the constraint in the SELECTION-WINDOW 

3. Click Delete element in the shortcut menu

Note: 

If a Constraint has been added to a Point (a POINT, START-POINT, END-

POINT or CENTER-POINT), then you must click the Point to see the con-

straint in the SELECTION-WINDOW.

1.5.12.4.1.5  ... add a Sketch-Loop/Sketch-Path

General definitions:

A sketch-loop is a closed, continuous 'string' of sketch-elements that you join

end to end.

A sketch-path is an open, continuous 'string' of sketch-elements that you join

end to end.

Merge-Points

You must merge the START-POINT or END-POINT of one sketch-element with

the START-POINT or END-POINT of an adjacent sketch-element.

The Merge-Points command removes one POINT at each 'joint' between the

adjacent sketch-elements.

There are two ways to merge two POINTS: 

· Dynamically (recommended) - as you add the sketch-elements, with

the Hover Technique

· Later - in the PART-EDITOR and use Geometry toolbar > Merge-

Points  

Why add a sketch-loop or sketch-path?

You can add a PROFILE to a sketch-loop.

You can add a MOTION-PATH FB (with a MOTION-POINT) to a sketch-path or

sketch-loop.

Why sketch-loops fail?

Condition 1:  Points are not Merged

Two POINTS are coincident, or just happen to be at the same position in a

PART.

Condition 2: Branches 

291
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You CANNOT merge three or more POINTS into one POINT - for example,

the ends of three LINES or ARCS.

Condition 3: Figures-of-Eight

A sketch-element cannot cross over another sketch-element in the same

sketch-loop.

This condition does not apply to a sketch-path.

Condition 3: Zero thickness

Sketch-Loop: A sketch-element cannot touch another sketch-element in

the same sketch-loop.

Sketch-Path: This condition does not apply to a sketch-path.

Example sketch-loops 

Circle

The CIRCLE is a sketch-loop. 

After you add a PROFILE to the CIRCLE, you can

use it as a Follower-Roller.

Lines

LINES joined, with Points merged.

Lines and Arcs

LINES and ARCS, with Points merged.

Arcs and Arcs

ARCS and ARCS, with Points merged.

1.5.12.4.2  FAQs

FAQs

How do I know I am using the Part-Editor?
676
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Why edit a Part?

How many Parts can I edit at a time?

Can I edit (and other questions relating to) the Part-Outline?

What are the color codes for sketch-elements in the Part-Editor?

Why is a dimension 'negative' in the Dimension dialog?

Why do I need to add geometry to the Base-Part?

My sketch has disappeared, what do I do?

What are the colors used in the Part-Editor?

1.5.12.4.2.1  How many Parts can I edit at one time?

How many Parts can I edit at a time?

You can edit one PART at a time.

To edit a different PART, you must:

1. Close the PART-EDITOR to return to the MECHANISM-EDITOR 

2. Select a different PART to edit in the PART-EDITOR

1.5.12.4.2.2  Why edit a Part?

Why edit a Part?

There are many reasons to edit a PART. 

In all cases, use the PART-EDITOR to edit the PART.

Edit the Length of a Part

Edit the PART to edit the length of the CAD-LINE,

which is the length of the PART.

See also: Edit the Length of a Part

Add a Point and/or Line to locate Pin-Joints, Slide-Joints, and Ball-

Joints

You can add new LINES, CAD-LINES, and POINTS to

locate joints in the PART.

You MUST add a minimum of one sketch-ele-

ment to the BASE-PART for a PIN-JOINT or SLIDE-

JOINT between the BASE-PART and a PART you

add to the model.

Trace Points 

674
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You can add a POINT to a PART and then view the

trace of that POINT on the MECHANISM-PLANE

during a machine-cycle.

See Add Trace-Point .

Sketch-Loops / Sketch-Paths

You must sketch a sketch-loop before you can

add a PROFILE / EXTRUSION.

Use the PART-EDITOR to add the sketch-elements

for the sketch-loop.

Follower-Profiles

Each Cam needs a Follower-Profile. 

Add a sketch-loop for the Follower-Profile -

typically a CIRCLE.

You must also sketch the shape of the Cam-

Blank when you add a 3D-CAM.

Plot exact Kinematic Data

For any POINT* that you add to a PART, you can:

· Show the instantaneous kinematic vectors

(Velocity and Acceleration) of the POINT

with the POINT PROPERTIES DIALOG  

· Plot motion-values of Position, Velocity

and Acceleration throughout the ma-

chine-cycle with the POINT-DATA FB  or

MEASUREMENT FB  that you connect to a
GRAPH FB

* POINT, START-POINT, END-POINT, CENTER-POINT,

and MOTION-POINT.

Add a CAD-Line

You can add CAD-LINES to any PART. You can use the CAD-LINE to import

DXF-Drawings, SOLIDWORKS parts, or STL file-types. 

CAD-LINES can be coincident with each other, or at different positions in the

PART.

122
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There is a CAD-LINE between the START-POINT and END-POINT of every PART

you add to the model.

Constraint Based Editing Tools for Mechanism Synthesis

See Mechanism-Synthesis.

· Three, Four and Five Position Synthesis

· Coupler Curve and Coupler Point Synthesis

· Function Generation

To add sketch-elements for a Measurement FB dimension 

Occasionally, you must add sketch-elements to

PARTS to measure the distance with a MEASURE-

MENT FB. See Add Measurement FB . 

The output from a POINT-DATA FB is position, ve-

locity and acceleration of a POINT.

You can use the output of a MEASUREMENT FB or

POINT-DATA FB as the independent variable (X-

axis) of a different FB.

Add a Point or Line for a Spring FB

Add a POINT or LINE to anchor a SPRING FB.

Add a sketch-loop for a Motion-Path and Motion-Point.

A MOTION-PATH FB adds a MOTION-POINT to a

sketch-path in a PART.

1.5.12.4.2.3  How do I know I am using the Part-Editor?

How do I know I am using the Part-Editor and not the Mechanism-Ed-

itor?

193
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Part in Mechanism-Editor

Mechanism-Editor:

· The Mechanism tab should indicate

the Mechanism-Editor is active.

· There is more than one PART - usu-

ally.

· There is a Part-Outline around each

PART.

· The XY-axes, at the START-POINT of

each PART, are relatively small.

Part in Part-Editor

Part-Editor:

· The Mechanism tab changes to a

Part-Outline when you start the

Part-Editor. 

· You cannot see the PART-OUTLINE.

· The XY-axes are relatively large.

· There is a DIMENSION for the length

of the CAD-LINE of a PART that you

have added to the model.

1.5.12.4.2.4  Can I edit (and other questions relating to) the Part-Outline?

Can I edit the Part-Outline? ... and other questions that relate to the

Part-Outline.

Part-Outline of three Parts in the

Graphics-Area

Can I edit the Part-Outline?

NO. 

The PART-OUTLINE is the symbol for the PART element.

When do I need to click the Part-Outline?

You select the PART-OUTLINE to edit the PART.

You may need to click the PART-OUTLINE to select as the PART when you

add more complex elements.

E.g.: Select the PART-OUTLINE as the Cam-Part, when you do Add 2D-

Cam.

Can I change the size of the Part-Outline symbol?
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YES. Use the Application Settings > Accessibility tab > Graphic > Sym-

bol Display Size

Must I display Part-Outlines?

NO. 

To hide PART-OUTLINES, see Display Filters > Show/Hide Part-Out-

lines .

You can double-click the Y-axis to edit a PART.

You must display PART-OUTLINES to display Force-Vectors .

Can I hide individual Part-Outlines?

No.

Can I change the color of a Part-Outline?

Only when you display Force-Vectors. You can use the CONFIGURE POWER

SOURCE dialog to edit the color of individual PARTS.

When you do not display Force-Vectors, we recommend you use the de-

fault colors of PART-OUTLINES for PARTS that are kinematically-defined /

solved (a type of Green), and for PARTS that are not kinematically-

defined / not solved (a type of Blue).

1.5.12.4.2.5  Why is the dimension 'negative' in the Dimension dialog'?

Why is my dimension negative?

 There is a  –ve sign if the distance to a sketch-element is in a negative quad-

rant !!!

In practice, do NOT delete the – sign, but edit the dimension in the normal

way.

However, to explain the negative dimension in the negative quadrant .... .

Each LINE has a X-Y coordinate-system. The coordinate-system's:

· 0,0 is its START-POINT

· +X-axis is from its START-POINT(1) to its END-POINT(2)

· +Y-axis is at +90º from the X-axis, on the Mechanism-Plane.

When you add a dimension that is a

perpendicular distance from a LINE, the:

· dimension is +ve when the di-

mension is in the +Y-axis (blue

area in the image).

· dimension is –ve when the di-

mension is in the –Y-axis (green

area in the image).

In the top image there is a Blue LINE(1 to 2) on the X-axis of the PART. A:

· dimension from the LINE(1 to 2) to a POINT a or b is positive

347
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· dimension from the LINE(1 to 2) to a POINT c or d is negative

A PART'S X-axis AND Y-axis also each

have its own coordinate-system! 

Each axis is identical to that of a LINE.

The bottom image shows the Coordin-

ate-System of the Y-axis

The local +x-axis of the Y-axis of a

PART is along the Y-axis!

In the bottom image:

· dimensions from the Y-axis to

POINTS a and b are positive.

· dimensions from the Y-axis to

POINTS c and d are negative.

1.5.12.4.2.6  Why do I need to add Geometry to the Base-Part?

Why do I need to add geometry to the Base-Part?

1. Why is there not a CAD-LINE in the BASE-PART? 

We do not want you to automatically add Joints to the Origin of the
BASE-PART.

2. Why? 

For the BASE-PART, we have found it to be useful to add POINTS and LINES

that are not at the Origin or along the X-axis or Y–axis.

3. Why? 

You can edit the dimensions later, and also add the dimensions to a

DESIGN-SET .

4. Why edit POINTS and LINES in the BASE-PARTS? 

a) Edit the dimension and move the Joints, if the POINTS or LINES are

used for Joints 

b) Move the PLANE and MECHANISM-EDITOR in the Machine Frame, if a

LINE is used for a new PLANE and MECHANISM-EDITOR.

1.5.12.4.2.7  My sketch has disappeared. What do I do?

Trouble-shoot the sketch-editor.

Where is my Sketch?

217
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Incorrect Arc

To recover a sketch that changes in an unexpec-

ted way:

Use Edit menu > Undo , or CTRL + Z on

your keyboard.

Sometimes the Sketch collapses to a small dot. 

Use Edit menu > Undo , or CTRL + Z on

your keyboard.

Sometimes the Sketch expands to the size of a

planet. 

Use Edit menu > Undo , or CTRL + Z on

your keyboard.

Correct Arc - After Undo

Note:

Below:

BLUE means the geometry is Not Solved. 

BLACK means the geometry is Fully Solved.

Why is my sketch BLACK when it should be BLUE?

Sometimes, a sketch-element is BLACK but you know it should be BLUE. You

should be able to add a dimension or constraint to it, but you cannot.

Or, a sketch-element is BLUE when it should be BLACK. 

The best solution is to do one of these actions:

· Delete the sketch-element and add it again.

· Shift-Click the sketch-element so it and the constraints that you have

added to it show in the SELECTION-WINDOW

· Right-click a constraint, or the sketch-element, and select Delete Ele-

ment in the shortcut menu.

OR

· Use Edit menu > Undo  or CTRL + Z

Then add a different constraint. 

You can add the same constraint again, or use a different constraint, to

see if the sketch-element turns BLACK.

In our defense, the PART-EDITOR is continuously improved.

Why is my sketch Blue, and I cannot add any more constraints?'

Sometimes, a sketch-element is BLUE but you cannot add more constraints.

You might be able to drag a sketch-element that is blue, but when you come

to add a new constraint, MechDesigner does not accept it.
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In this case, a new constraint may remove two degrees-of-freedom, but the

sketch has only one remaining degree-of-freedom.

Example:

Add Coincident Constraint between the center-Point of a Circle and a

Point at the end of a Line.

If: the CENTER-POINT of the CIRCLE has a COINCIDENT CONSTRAINT with the
LINE

Then: it is not possible to also add a COINCIDENT-CONSTRAINT with the

START-POINT or END-POINT of the LINE

1. SHIFT + Click the LINE or the CENTER-POINT of the CIRCLE so the COIN-

CIDENT-CONSTRAINT shows in the SELECTION-WINDOW 

2. Delete the COINCIDENT CONSTRAINT using the SELECTION-WINDOW

1.5.12.4.2.8  What are the color codes of the Part-Editor?

Color-codes of Elements in the Part-Editor

You can control the Color for the two states of Geometry. 

· Geometry Under Defined - typically, near to Blue 

· Geometry Fully Defined - typically, near to Green

See Application-Settings > Graphics tab > DISPLAY COLORS 

A dimension is Gray if it:

· has been added to a DESIGN-SET

· is the length of the LINE between the center of two gears in a GEAR-

PAIR 

· is the radius of a PULLEY

· controls the length of a MOTION-PATH

Other Colors

· Reference Geometry is Orange

1.6 MotionDesigner Reference & User Interface

MotionDesigner: Main User Interface

We update the MechDesigner model for you immediately as you use edit a

motion in MotionDesigner.
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MotionDesigner (Click to Expand or Collapse)

MotionDesigner :

 Blend-Point and Segment, Edit, File, and View toolbars

 Motion name-tabs  - see also Rename Motion

 Motion-toolbar

 Machine Speed - edit in MechDesigner > Edit menu > Machine-

Settings

 Motion Values at Pointer

  Position, Velocity, Acceleration, Jerk (P.V.A.J) Motion-Graphs.

MotionDesigner: Float or Dock

MotionDesigner is docked to the right of the application-window when you

start MechDesigner.
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To Float MotionDesigner :

1. Click MechDesigner > Visibility menu / toolbar > Dock /

Float MotionDesigner 

MotionDesigner is now floating. 

2. Re-size and re-position MotionDesigner. 

We remember the size and position for you when you float Mo-

tionDesigner again.

To Dock MotionDesigner :

1. Click MechDesigner > Visibility toolbar > Dock / Float Mo-

tionDesigner

MotionDesigner is now docked again to the right of the ap-

plication-window.

 MotionDesigner: Toolbars

MotionDesigner toolbars

Toolbar Expand / Collapse bar (x4)

Blend-Point & Segment toolbar

View toolbar

File toolbar

Edit toolbar

Motion toolbar  is below the graphs

 MotionDesigner: Motion name-tabs

4 x Motion name-tabs

In the image, there are four Motion name-tabs - to give four motions.

Motion0 - the name of the default motion.

Motion1, Motion2, Motion3, Motion4, ... the default names for motions

that add with Add Motion .
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Y Axis and X Axis - two motions have been renamed from the default

name.

See Add Motion  and Open and Append  

See also: How to Rename a Motion

 MotionDesigner: Motion toolbar

Use to :

· Select a Motion-Law for a segment

· Confirm the width of a Motion - MOTION-WIDTH

· Evaluate the Motion values as a function of the X-axis value.

See more: Motion toolbar

 MotionDesigner: Motion-Values at Pointer

Motion-values at your pointer

1. Move your mouse-pointer above a

motion graph plot-line, or to a

BLEND-POINT. 

The X and Y motion-values show near to

your pointer.

See also: Motion-Value Evaluator
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1.6.1 Terminology and Symbols

 MotionDesigner Terminology:

Segments

A Segment: from X1 to X2

Motions are split into SEGMENTS. 

Each SEGMENT has a SEGMENT-WIDTH.

SEGMENTS join together, end-to-end (they concatenate), to create a mo-

tion, usually over one machine-cycle of 360º

You must select a MOTION-LAW for each SEGMENT with the Motion-Law

Selector .

The mathematical-function of the MOTION-LAW, and its motion-values at its

start and end, control the shape of the SEGMENT.

SEGMENT-EDITOR

The SEGMENT EDITOR edits the SELECTED-SEGMENT.

You can use the SEGMENT-EDITOR to edit the:

· SEGMENT-WIDTH (X2 – X1)

· motion-value Y1 at X1 

· motion-value Y2 at X2

· MOTION-LAW 

Depending on the MOTION-LAW, you may be able to control its:

· motion-values Y1 and Y2 of one or all of its motion-derivatives: P, V,

A, J.

· SEGMENT-PARAMETERS ( not all MOTION-LAWS )

· SEGMENT RANGE ( not all MOTION-LAWS ) 

Blend-Points

A Blend-Point: at X1

Motions are split at BLEND-POINTS

A BLEND-POINT does NOT have a SEGMENT-WIDTH.

741
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A BLEND-POINT has one X-axis value (X1 in the image) and two Y-axis val-

ues (Y1 at the end of the PREVIOUS-SEGMENT, and Y2 at the start of the SELEC-

TED-SEGMENT) - see image above

BLEND-POINT EDITOR

The BLEND-POINT EDITOR controls the motion-values of the BLEND-POINT

at the start (beginning, left side) of the SELECTED-SEGMENT.

Use the BLEND-POINT EDITOR to edit the:

· value X1 

· motion-value Y1 at the End of Previous-Segment of one or all of its

motion-derivatives: P, V, A, J

· motion-value Y2 at the Start of Selected-Segment of one or all of its

motion-derivatives: P, V, A, J

Other Terminology

MOTION-LAW :  

(CAM-LAW) : 

You must select a MOTION-LAW for each

SEGMENT. Each type of Motion-Law has

a name. The MOTION-LAW should be

able to satisfy the motion requirements

for your design. Each MOTION-LAW is a

mathematical function. The MOTION-

LAW, together with the motion-values

at its start and end, control the motion-

values between each BLEND-POINT. 

We use the term MOTION-LAW rather

than Cam-Law as you can also apply

your motion-design to a Hydraulic or

Air Cylinder, Servomotor, ....

Motion-Derivative : Velocity, Acceleration, and Jerk the

three motion-derivatives of Position.

SEGMENT EDITOR : Use the SEGMENT EDITOR to edit the

SEGMENT-WIDTH, to select the MOTION-

LAW, to edit the SEGMENT-PARAMETERS,

and to edit the motion-values at the

Start of the Selected-Segment and at

the End of the Selected-Segment.

BLEND-POINT EDITOR : Use the BLEND-POINT EDITOR to edit

motion-values of the BLEND-POINT that

is at the start of the SELECTED-SEGMENT.

Edit X-axis value and the Y-axis mo-

tion-values at the “End of the Previous-

Segment,” Y1, and at the “Start of the

Selected-Segment,” Y2. 
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SELECTED-SEGMENT : The SEGMENT to which you apply the

motion-values that are in the SEGMENT

EDITOR. 

The BLEND-POINT EDITOR applies its mo-

tion-values to the BLEND-POINT that is

at the start of the SELECTED-SEGMENT.

In the motion graphs, the SELECTED-SEG-

MENT is a different color to the other

segments.

PREVIOUS-SEGMENT : The SEGMENT that precedes (is to the

left of / is earlier than / is before) the

SELECTED-SEGMENT. If the SELECTED-SEG-

MENT is the first SEGMENT, then the PRE-

VIOUS-SEGMENT is the last SEGMENT.

NEXT-SEGMENT : The SEGMENT that follows (is to the

right of / is later than / is after) the

SELECTED-SEGMENT. If the SELECTED-SEG-

MENT is the last SEGMENT, then the

NEXT-SEGMENT is the first SEGMENT.

“End of the Previous-Segment” : Refers to the last motion-value of the

SEGMENT that is one SEGMENT earlier

than the SELECTED-SEGMENT. 

If the SELECTED-SEGMENT is Segment 1,

then End of the Previous-Segment is

the motion-value at the end of the mo-

tion.

“Start of Selected-Segment” : Refers to the first motion-value of the

SELECTED-SEGMENT.

Match, Flow : To force (with a Control-Button in the

the motion-value at the start of a SEG-

MENT to be equal to the motion-value

at the end of the PREVIOUS-SEGMENT.

We can Match motion-values of any or

all motion-derivatives. 

Symbols 

There are two triangles at each BLEND-POINT. 

BLEND-POINT

ACTIVE BLEND-POINT - has an outline. The BLEND-POINT that is at the

start of the SELECTED-SEGMENT.

The Start of a Segment. The symbol may be GREEN, BLACK, CLEAR,

or GREY.
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The End of a Segment. The symbol may be BLACK, CLEAR, or GREY.

Note: To increase the size of the symbols, see: Active-Motion-Settings > Ac-

cessibility tab > Line and Symbol Sizes > Symbol Size.

1.6.2 Program and Active Motion Settings

Th Active Motion Settings dialog is in the Edit toolbar . It contains the settings

that configure the active motion and also the MotionDesigner program in gen-

eral. 

We save the settings each time you save a MechDesigner model and each time

you exit MechDesigner.

It is a good idea to check these settings before you start to design a motion.

Active Motion Settings

Edit toolbar > Active Motion Settings 

Each motion has settings.

Active Motion Settings dialog

There are four tabs:

· Motion

· Advanced

· Number-Format

· Accessibility

Note: The settings become the default settings when you exit MechDesigner.

Motion tab                                       

Motion name-tab (read-write)

MOTION NAME

MOTION NAME (read-write) (default =

Motion0, Motion1, ... )

Enter a new MOTION NAME with your

keyboard. 

Press the ENTER key on your key-

board. 

The new Motion-Name is now the Mo-

tion name-tab.

730
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MOTION CYCLE DATA

NUMBER-OF-POINTS (read-write) ( de-

fault = 360)

The NUMBER-OF-POINTS along the

active motion graph. 

Note: 

Enter NUMBER-OF-POINTS = 361 to

put a Motion-Point exactly on each

machine-degree in the Data Trans-

fer Table .

RPM [ CYCLES/MIN ] (read-only) 

RPM : Machine cycles per minute.

See: MechDesigner - Edit

menu>Machine Settings>Cycling

Parameters>Cycles/Min

SECONDS / CYCLE ( read-only ) 

SECONDS / CYCLE = 60 / CYCLES/MIN

MOTION UNITS

X–AXIS UNITS: ( default = degrees )

Units available: counts: sec, msec,

cycle, degree, radian.

Y–AXIS UNITS: ( default = degrees or mm

)

Units available: mm, cm, m, inch,

degree, radian, cycle, count

POSITION : Units

VELOCITY : Units/s

ACCELERATION : Units/s2

JERK : Units/s3

Note: 

Change from Angular to Linear Un-

its, or vice versa: If you change from

Angular Units to Linear Units, then

The motion does not have a differ-

ent physical value when you select

different Y-AXIS UNITS. E.g. 90mm

becomes 0.090m, or 3.543inches.

Advanced tab                          

744
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X-AXIS PARAMETERS

[UNITS] AT START ( default = 0 )

 Edit Unit data-type in Motion tab

>  Motion Units 

Y-AXIS PARAMETERS 

COUNTS / DEGREE ( default =1 )

Edit Unit data-type in Motion tab

>  Motion Units 

COUNTS AT START ( default = 0 )

Edit Unit data-type in Motion tab

>  Motion Units 

Number Format tab                      

NUMBER FORMAT 

FORMAT ( default : General )

See Number Format 

PRECISION (default = 15 )

See Precision 

DIGITS (default = 10 )

See Digits 

Accessibility tab                      

COLORS 

þ Show Grid : Enable to show the

horizontal and vertical grid lines

in the graph-plot area.

Colors : edit with Windows Color Pick-

er® :

· Line: of all segments, but not the

SELECTED-SEGMENT 

· Grid: the horizontal and vertical

Grid-Lines

· Axis Color : X and Y-axis text

· Background: the graph area

· Selected: the SELECTED-SEGMENT

(typically Red)

· Overlay: see Overlay-Trace

731
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LINE AND SYMBOL SIZES

LINE THICKNESS (default = 1 ; Maximum

 = 8 )

The plot thickness, in pixels, of the

motion segments

SYMBOL SIZE (default = 2 ; Maximum =

8 )

The scale/size of the BLEND-POINT

symbols
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1.6.3 BLEND-POINT (NODE) EDITOR

BLEND-POINT (NODE) EDITOR

See also: SEGMENT EDITOR .

How to open the BLEND-POINT EDITOR

METHOD 1: Use the toolbar icon

Blend-Point Editor icon

MD16

1. Click Blend-Point & Segment

toolbar > Open Blend-Point Ed-

itor 

MD17-Blend-Point and

Segment toolbar

MD17

1. Click Blend-Point & Segment

toolbar > Open Blend-Point Ed-

itor 

The BLEND-POINT EDITOR is now open.

BLEND-POINT (NODE) EDITOR 

The BLEND-POINT EDITOR edits the motion-values of the BLEND-POINT that is

at the start of the SELECTED-SEGMENT. 

You can change the BLEND-POINT (and SELECTED-SEGMENT) with the NEXT and

PREVIOUS arrows  - see image below.

704
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BLEND-POINT EDITOR

BLEND-POINT NUMBER 

Each BLEND-POINT and SEGMENT has a number. The BLEND-POINT at the start

of the motion is BLEND-POINT # 1 - see X-AXIS VALUES > MOTION-START. 

The BLEND-POINT NUMBER is the BLEND-POINT at the start of the SELECTED-

SEGMENT.

The number of BLEND-POINTS is equal to the number of SEGMENTS.

X-AXIS VALUES    - See Blend-Point - X-axis Controls

Summary

MOTION START (default = 0)

Edit to move BLEND-POINT # 1 and the whole motion relative to 0 on

the X-axis.

X-AXIS 

Edit to move the active BLEND-POINT along the X-axis. 

The active BLEND-POINT is at the start of the SELECTED-SEGMENT.

See also Warning .

Units: See Active-Motion-Settings > Motion tab > Motion Units

Y-AXIS VALUES    - See Blend-Point - Y-axis Controls

Summary

695

696
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Use the BLEND-POINT EDITOR to edit the mo-

tion-values at the:

 End of the PREVIOUS-SEGMENT 

AND / OR 

 Start of the SELECTED-SEGMENT

The motion-derivatives ( P V A J ) that you can edit are a function of

the:

· Motion-Law

· Y-axis Control-Buttons settings

To use the BLEND-POINT EDITOR efficiently, it is important to under-

stand how to use the Y-axis Control-Buttons .

PREVIOUS / NEXT / OK / HELP buttons 

PREVIOUS: 

Make the PREVIOUS-SEGMENT the SELECTED-SEGMENT. 

Change the BLEND-POINT NUMBER by – 1

NEXT: 

Make the NEXT-SEGMENT the SELECTED-SEGMENT. 

Change the BLEND-POINT NUMBER by + 1

 Close the BLEND-POINT EDITOR

 Open the MotionDesigner contextual help

709

709
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1.6.3.1 Blend-Point Editor: X-axis Values

BLEND-POINT EDITOR :   X-AXIS VALUES  

When you edit the X-AXIS value of a BLEND-POINT, you change the SEGMENT-

WIDTH of the PREVIOUS-SEGMENT AND the SELECTED-SEGMENT.

You do NOT change the MOTION-WIDTH. 

However, please read the Warning - Bumping Blend-Points

 X-AXIS VALUES 

X-axis values of Blend-Point #3

MOTION START 

Edit the MOTION-START  value to move the motion along the X-axis.

We make the X-AXIS  value of Blend-Point #1 equal to the MOTION-START

 value.

We do not change the MOTION-WIDTH.

X-AXIS 

Edit to move the BLEND-POINT of BLEND-POINT #  along the X-AXIS - how-

ever, see SPECIAL CASE and WARNING

The other BLEND-POINTS do not move - however, see WARNING

Special Case

X-AXIS value of BLEND-POINT #1

BLEND-POINT  #1

· You CANNOT edit the X-AXIS value of BLEND-POINT #1.

· we force the X-AXIS value of BLEND-POINT #1 to be equal to the MO-

TION-START value. 

However:

If you attempt to increase the X-AXIS value BLEND-POINT #1  (move it to

the right) ...

... you increase the SEGMENT-WIDTH  of the PREVIOUS-SEGMENT* and

decrease the SEGMENT-WIDTH of the SELECTED-SEGMENT.

If you attempt to decrease the X-AXIS value of BLEND-POINT #1 (move it

to the left) ...

696
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... you decrease the SEGMENT-WIDTH of the PREVIOUS-SEGMENT* and

increase the SEGMENT-WIDTH of the SELECTED-SEGMENT.

* : in this special-case, the PREVIOUS-SEGMENT is the segment to the left of

SEGMENT #1.

WARNING 

“Bumping” BLEND-POINTS !

If you edit the X-AXIS value of a BLEND-POINT and it bumps into an adjacent

BLEND-POINT (left or right):

· the active BLEND-POINT AND the adjacent BLEND-POINT move to-

gether along the X-axis.

· AND the SEGMENT-WIDTH of the PREVIOUS-SEGMENT (or NEXT-SEG-

MENT) will be very short (e.g. 0.0000036 degrees) and invisible to you.

· AND the MOTION-WIDTH increases by a small amount (e.g. the MO-

TION-WIDTH increase to 360.0000036 degrees).

To separate the BLEND-POINTS, edit the X-AXIS value of the BLEND-POINT

again.

The MOTION-WIDTH does NOT revert to 360 degrees.

To make the MOTION-WIDTH equal to 360 again, you must use the SEG-

MENT EDITOR  to edit the SEGMENT-WIDTH  of each segment.

EXAMPLE:

Motion-Start and X-axis Value of Blend-Point #3

BLEND-POINT NUMBER 

The number of the BLEND-POINT at the start of the SELECTED-SEGMENT.

704 707
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The BLEND-POINT NUMBER is # 3

Note: 

We frequently use “#” as short-hand for “number”.

X-AXIS VALUES   

 MOTION START is the X-axis value of BLEND-POINT NUMBER 1. MOTION

START is at 0 degrees.

 X-AXIS value of the BLEND-POINT #3 is 180 degrees.

As you edit the X-AXIS value BLEND-POINT #3, it moves to the left(<) or to the

right(>).

To avoid “bumping” BLEND-POINT #3 into BLEND-POINT #2 or #4, the X-AXIS

value of BLEND-POINT #3 should be:

· Always more than the X-AXIS value of BLEND-POINT NUMBER #2. Min-

imum > 90 degrees.

· Always less than the X-AXIS value of BLEND-POINT NUMBER#4. Max-

imum < 270 degrees.

For “bumping”, see WARNING , above.

See also: How to edit a value in a data-box .

696
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1.6.3.2 Blend-Point Editor: Y-axis Values

Blend-Point Editor:  Y-AXIS VALUES 

It is important to know that each BLEND-POINT has two Y-axis motion-values

 . 

There is a motion-value at the:

· End of the Previous-Segment 

AND at the:

· Start of the Selected-Segment 

Also, because there are four motion-derivatives, there are eight (8) motion-values

at each BLEND-POINT.

Example

Position graph, Position motion-values, Position Control-Buttons

The image shows the:

· Position motion-graph 

· Position Y-axis motion-value and data-boxes 

· Position Control-Buttons 

The image does not show the:

· Velocity, Acceleration, and Jerk motion-graphs

· Velocity, Acceleration, and Jerk motion-value data-boxes

· Velocity, Acceleration, and Jerk Control-Buttons

Y-AXIS VALUES 

Position Motion-Graph
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The Position motion-graph shows the Blend-Point with two motion-values.

 END POSITION (of the PREVIOUS-SEGMENT) = 10mm

 START POSITION (of the SELECTED-SEGMENT) = 30mm

Position Motion-Values

The Position motion-derivative has two motion-values and data-boxes

 END POSITION (of the PREVIOUS-SEGMENT) = 10mm

 START POSITION (of the SELECTED-SEGMENT) = 30mm

Position Control Buttons 

See more at Control Buttons: States and Patterns

The Control-Buttons for the Position motion-derivative allows you to edit

the two motion-values.

 END CONTROL BUTTON in the Do Edit state. 

You can edit the motion-value at the END OF THE PREVIOUS-SEGMENT. 

This control-button has three(3) states - Do Edit, Do Not Edit, and Can

Not Edit

 MATCH CONTROL button in the Do Not Match state

The END-POSITION and the START-POSITION motion-values can be differ-

ent.

This control-button has two(2) states - Do Match and Do NOT Match

 START CONTROL button - in the Do Edit state.

You can edit the motion-value at the START OF THE SELECTED-SEGMENT. 

This control-button has three(3) states - Do Edit, Do Not Edit, and Can

Not Edit

700
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1.6.3.3 Blend-Point Editor: Control-Button States

Blend-Point Editor Control-buttons

Whether you can control the motion-values of a BLEND-POINT is a function of the:

A. Motion-Law 

B. Motion-Derivative 

C. Control-Buttons states

You must understand how to use the Control-Buttons in the BLEND-POINT

EDITOR (and the SEGMENT EDITOR ).

CONTROL-BUTTONS

EACH motion-derivative (P V A J) has THREE Control-Buttons.

Each Control-Button has different states. Please read carefully the definitions

in this table.

 Definition: 

DO edit End (motion-value) of Previous-Segment : It IS possible

and DO control the motion value

DO NOT edit End (motion-value) of Previous-Segment : It IS

possible, bu DO NOT control the motion value 

CAN NOT edit End (motion-value) of Previous-Segment : It IS

NOT possible to control the motion-value

DO NOT Match : DO NOT FORCE the Start (motion-value) of the

Selected-Segment TO EQUAL the End (motion-value) of the Pre-

vious-Segment

DO MATCH : DO FORCE the Start (motion-value) of the Selec-

ted-Segment TO EQUAL the End (motion-value) of the Previ-

ous-Segment

DO edit Start (motion-value) of Selected-Segment : It IS possible

and DO control the motion value

DO NOT edit Start (motion-value) of Selected-Segment : It IS

possible, but DO NOT control the motion value 

CAN NOT edit Start (motion-value) of Selected-Segment : It IS

NOT possible to control the motion-value

709
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Control-Button States: Patterns: 1- 9

The Control-Buttons can have nine different patterns. 

Pattern 1

 

 

 

 

 

   Start of Selected-Segment : Possible but DO NOT control

the value

 
 End of the Previous-Segment   Start of the Selected-Seg-

ment

    End of Previous-Segment : Possible but DO NOT control a value 

Pattern 2

 

 

 

 

 

   Start of Selected-Segment : Possible but DO NOT control

the value

 
 End of the Previous-Segment   Start of the Selected-Seg-

ment

    End of Previous-Segment : Possible and DO control the value 

Pattern 3

 

 

 

 

 

  Start of Selected-Segment : Possible and DO control the

value

  
 End of the Previous-Segment   Start of the Selected-Seg-

ment

   
 End of Previous-Segment : Possible but DO NOT control the value

 

Pattern 4
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    Start of Selected-Segment : Possible and DO control the

value

  
 End of the Previous-Segment   Start of the Selected-Seg-

ment

   End of Previous-Segment : Possible and DO control the value 

Pattern 5

 

 

 

 

 
     Start of Selected-Segment : NOT possible to control the

value

 
 End of the Previous-Segment = Start of the Selected-Seg-

ment

   End of Previous-Segment : Possible but DO NOT control the value

 

Pattern 6

 

 

 

 

 
    Start of Selected-Segment : NOT possible to control the

value

  End of the Previous-Segment = Start of the Selected-Seg-

ment

   End of Previous-Segment : Possible and DO control the value 

Pattern 7



703

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

 

 

 

 

 

    Start of Selected-Segment : NOT possible to control the

value

  End of the Previous-Segment = Start of the Selected-Seg-

ment  

  End of Previous-Segment : NOT possible to control the value 

Pattern 8

 

 

 

 

 
   Start of Selected-Segment : Possible but DO NOT control

the value

   End of the Previous-Segment   Start of the Selected-Seg-

ment 

  End of Previous-Segment : NOT possible to control the value 

Pattern 9

 

 

 

 

 
   Start of Selected-Segment : Possible and DO control the

value

   End of the Previous-Segment   Start of the Selected-Seg-

ment 

  End of Previous-Segment : NOT possible to control the value 
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1.6.4 SEGMENT EDITOR

SEGMENT EDITOR

See also : BLEND-POINT (NODE) EDITOR .

How to open the SEGMENT EDITOR

METHOD 1: Use the toolbar icon

MD16-Segment-Editor

command

MD16

1. Click Blend-Point & Segment

toolbar > Open Segment Editor 

MD17-Blend-Point and

Segment toolbar

MD17

1. Click Blend-Point & Segment

toolbar > Open Segment Editor 

The SEGMENT EDITOR is now open.

METHOD 2: Click the Segment in the motion-graph

1. Move your mouse-pointer over the

graph line of a SEGMENT. 

A short section of the segment becomes red

 

2. Click your mouse-button

The SEGMENT EDITOR is now open.

SEGMENT EDITOR

We immediately update the model for you as you edit motion-values with the

SEGMENT EDITOR.

You can change the SELECTED-SEGMENT and BLEND-POINT with the NEXT and

PREVIOUS arrows  - see below.

Note:

If you can see all of the ORANGE SEPARATORS that should be available for the

Motion-Law:

1. Click one of the ORANGE SEPARATORS two times to collapse and expand it. 

You should then see all of the ORANGE SEPARATORS that are available with that

Motion-Law.
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SEGMENT-EDITOR

SEGMENT NUMBER 

The SEGMENT NUMBER is the number of the SELECTED-SEGMENT.

The motion and parameter values in the SEGMENT-EDITOR apply to the

BLEND-POINTS at the start and end of the SELECTED-SEGMENT.

X-AXIS VALUES    

Summary

SEGMENT START (read-only) - the X-axis value at the start of the SELEC-

TED-SEGMENT

SEGMENT-WIDTH - the duration - in X-axis units - of the SELECTED-

SEGMENT - See more here   

SEGMENT END (read-only) - the X-axis value at the end of the SELECTED-

SEGMENT

SEGMENT MOTION-LAW  

707
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Summary

Motion-Law Selector

Use the drop-down box to select the MO-

TION-LAW for the SELECTED-SEGMENT.

WARNING

After you select a MOTION-LAW, click

somewhere in the motion graph area

to remove the  focus  from the Mo-

tion-Law Selector list-box.

See more: Segment Motion-Laws

Y-AXIS VALUES  

Summary

A Segment(3)

The SEGMENT EDITOR edits motion-values at

the:

 Start of the SELECTED-SEGMENT , and the

 End of the SELECTED-SEGMENT 

Which of the motion-derivatives ( P V A J ) you

can edit is a function of the:

· Motion-Law

· Y-axis Control-Buttons settings

See more Segment Y-axis Values / Control Buttons

SEGMENT RANGE   

Not available with all Traditional Motion-Laws

See more Segment-Range

SEGMENT PARAMETERS   

Not available with all Traditional Motion-Laws

See more: Segment-Parameters

PREVIOUS / NEXT / OK / HELP buttons 

 Make the PREVIOUS-SEGMENT be the SELECTED-SEGMENT 

 Make the NEXT-SEGMENT be the SELECTED-SEGMENT 

 Close the SEGMENT EDITOR and apply the new motion-values and

parameter settings to the SELECTED-SEGMENT.

 Open the contextual help for the SEGMENT-EDITOR.

755
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1.6.4.1 Segment Editor: X-axis Values / Segment-Width

Segment Editor :  X-AXIS VALUES  

Edit the period of a segment with the SEGMENT-WIDTH parameter.

SEGMENT-EDITOR - X-axis Values - Segment-Width Parameter

 X-AXIS VALUES 

 SEGMENT START (read-only)

E.g. SEGMENT START  = 90 degrees

 SEGMENT-WIDTH 

The duration, in X-axis Units , of the SELECTED-SEGMENT.

E.g. SEGMENT-WIDTH  = 90 degrees

 SEGMENT END (read-only)

E.g. SEGMENT END  = SEGMENT-START  + SEGMENT-WIDTH  = 90+90

= 180 degrees

WARNING: 

When you edit the SEGMENT-WIDTH you also change the MOTION-WIDTH. 

If you do not want the MOTION-WIDTH to change, you must edit the SEG-

MENT-WIDTH of a minimum of two segments.

 X-axis Units

Control the X-axis units with Active-Motion-Settings > Motion tab > Motion

Units > X-axis

707
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The default X-axis Units are degrees.

See also: Segment-Range , Segment-Parameters ,  Y-AXIS VALUES 
712 715
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1.6.4.2 Segment-Editor: Segment Motion-Law

Segment Editor :  SEGMENT MOTION-LAW 

All segments have a motion-law - see Motion-Laws

Motion-Law Selector

Use the drop-down list-box to select the Mo-

tion-Law for the SELECTED-SEGMENT.

WARNING

After you select a Motion-Law, click some-

where in the motion graph area to remove

the  focus  from the Motion-Law Selector

list-box.

See: Motion-Laws

1.6.4.3 Segment Editor: Y-axis Values / Control-Buttons

Segment Editor :  Y -AXIS VALUES 

Edit the motion-values at the Start of the Selected-Segment and/or the End

of the Selected-Segment.

SEGMENT-EDITOR - POSITION ONLY: Example Y-axis Values

 Y-AXIS VALUES 

Y-axis motion-values of Position, Velocity, Acceleration, Jerk. 

 START (motion-value of motion-derivative): 

E.g. : START POSITION  = 5mm (see image above)

 END (motion-value of motion-derivative): 

E.g. : END POSITION  = 15mm (see image above)

755
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CONTROL BUTTONS   for Position, Velocity, Acceleration, Jerk.

See more at Control Buttons: States and Patterns

 MATCH CONTROL button - to control the motion continuity from the

PREVIOUS-SEGMENT to the SELECTED-SEGMENT. 

This button has two possible states: 

Do Force the motion-value at START OF THE SELECTED-SEGMENT to equal

the motion-value at the END OF THE PREVIOUS-SEGMENT

Do NOT Force the motion-value at START OF THE SELECTED-SEGMENT =

motion-value at the End of the Previous-Segment

 START CONTROL button - to control the motion-value at the START OF

THE SELECTED-SEGMENT. 

This button has three possible states:

Do control (the motion-value at the) START OF THE SELECTED-SEGMENT

Do NOT control (the motion-value at the) START OF THE SELECTED-SEG-

MENT

Not possible to control (the motion-value at the) START OF THE SELEC-

TED-SEGMENT

 END CONTROL button - to control the motion-value at the END OF THE

SELECTED-SEGMENT. 

It has three possible states:

Do control (the motion-value at the) END OF THE SELECTED-SEGMENT

Do NOT control (the motion-value at the) END OF THE SELECTED-SEG-

MENT

Not possible to control (the motion-value at the) END OF THE SELECTED-

SEGMENT

See also BLEND-POINT EDITOR CONTROL BUTTONS

700
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Segment Editor: Possible Control-Button Settings
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1.6.4.4 Segment Editor: Segment-Range

Segment Editor :  SEGMENT-RANGE 

The SEGMENT RANGE separator is available with many (not all) Traditional Mo-

tion-Laws .

Parameters: 

START-RANGE: default = 0

END-RANGE: default = 1

The SEGMENT-RANGE parameters control the phases at which to start and end

the mathematical-function of the motion-law.

One application of SEGMENT-RANGE the parameters is to design Asymmetrical

Motions - see below .

Default Segment Ranges

START-RANGE 0 END-RANGE 1

0 START RANGE < END RANGE 1

START-RANGE and END-RANGE parameters do NOT change the SEGMENT-

WIDTH.

Example:

The images below show the acceleration graph of a MODIFIED SINUSOID

motion-law with different SEGMENT-RANGE parameter values.

Note: the SEGMENT-WIDTH does NOT change when you edit the SEGMENT-

RANGE parameter.

1) Standard Mod Sine

STANDARD Modified Sinusoid.

SEGMENT-WIDTH = 120º-30º = 90º

· START-RANGE = 0.0

· END-RANGE = 1.0
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2) Start Range = 0.2 ; End-Range = 1

Modified-Sinusoid with 20% clipped from its Start.

SEGMENT-WIDTH = 120º-30º = 90º

· START-RANGE = 0.2 - to remove 20% from the start of the MODI-

FIED-SINUSOID mathematical function

· END-RANGE = 1.0

Start Range = 0.0 ; End-Range = 0.8

Modified-Sinusoid with 20% clipped from its End.

SEGMENT-WIDTH = 120º-30º = 90º

· START-RANGE = 0.0

· END-RANGE = 0.8  - to remove the 20% from the end of the MODI-

FIED-SINUSOID mathematical function

See also: Segment Editor: Segment-Width , Segment Editor: Parameters

Asymmetric Motion - Example

For example: use an Asymmetric Modified-Sinusoid to accelerate rapidly and

decelerate more gradually, or vice versa.

You split a symmetric Modified-Sinusoid segment into two segments, and then

use the SEGMENT-RANGE parameters to change the phase of the crossover to

design the Asymmetric Modified-Sinusoid. 

In the image below there is a Rise and Return motion. 

· The Rise is an Asymmetric Modified Sinusoid (0 - 180º). The  crossover is

at 60º.

· The Return is a Symmetric Modified Sinusoid (180 - 360º). The crossover

is at 270º.

707 715
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Asymmetric Mod-Sine   |   Symmetric Mod-Sine

Asymmetrical Mod-Sine Segments : 

SEGMENT 1

Machine angle :  (  of total Asymmetric motion-

law )

Displacement :   (  of total Asymmetric Dis-

placement )

START-RANGE = 0 ; END RANGE = 0.5

SEGMENT 2
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Machine angle :  (  of total Asymmetric mo-

tion-law )

Displacement :   (  of total Asymmetric

Displacement )

START-RANGE = 0.5 ; END RANGE = 1.0

Characteristics Values: Asymmetric and Symmetric Compared.

Velocity Coefficient : 

Acceleration Coefficient :

Deceleration Coefficient : 

1.6.4.5 Segment Editor: Segment-Parameters

Segment Editor :  SEGMENT PARAMETERS 

The SEGMENT PARAMETERS separator is available with many (not all) Traditional

Motion-Laws .

The actual SEGMENT-PARAMETERS are unique to the Motion-Law.

Their details are described with each Motion-Law.

The best way to learn about the different SEGMENT PARAMETERS is to experiment

with their values.

Segment-Parameters with the Sine-Constant Acceleration-Cosine motion-law

The image above shows the three SEGMENT-PARAMETERS for the SINE-CON-

STANT-ACCELERATION-COSINE  motion-law. 

The CONSTANT-FRACTION parameter, refers to the Non-Zero Constant Accelera-

tion, and not the Zero Constant-Acceleration.

Note:

Commercial Indexers frequently use a Modified-Sine with motion-law with

20%, 33%, 50%, or 66% Constant-Velocity of the index-period. 

A period of Constant-Velocity:

· reduces the maximum velocity and a 

· reduces a Cam's Pressure-Angle. 

· increases the minimum width between the cam-tracks of a Globoidal-

Cam, to increase the width of the rib.

In MotionDesigner, you can enter any percentage of Constant Velocity.

See also: Segment-Range , Segment-Width
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1.6.5 Blend-Point & Segment toolbar

Blend-Point & Segment toolbar

MD16

MD17

SEGMENT EDITOR

BLEND-POINT EDITOR

Insert Blend-Point

Insert Blend-Point At

Insert Segment

Append Segment

Delete Segment

Data Transfer Table

About Blend-Points (Nodes) and Motion-Values

Each BLEND-POINT has:

ONE X-axis value( ) for all motion-derivat-

ives

TWO Y-axis values( ) for each motion-

derivative

 is a Y-axis value at the END of the Previ-

ous-Segment 

AND

 is a Y-axis value at the START of the
SELECTED-SEGMENT

The two Y-axis values can be:

· forced to be equal, or 

· forced to be different, or 

· not specified, or 

· one is specified and the other not spe-

cified

· one or the other is not possible to be

specified
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To control the X-axis value and the Y-axis-val-

ues of each BLEND-POINT, use the:

· BLEND-POINT EDITOR   

AND / OR 

· SEGMENT EDITOR

692
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1.6.5.1 Segment: Insert

Insert Segment

Use Insert-Segment to add a new SEGMENT that immediately to the left of the

SELECTED-SEGMENT.

Insert Segment

1. Click Blend-Point & Segment toolbar > Insert

Segment 

A new SEGMENT is now immediately to the left of the
SELECTED-SEGMENT.

The new SEGMENT is now the SELECTED-SEGMENT.

Notes: 

The SEGMENT-WIDTH of the new segment is 90º *

The new MOTION-WIDTH is 90º wider *

Use the SEGMENT EDITOR  to reduce the SEGMENT-WIDTH of one or more

segments, to reduce the MOTION-WIDTH again.

To add a new segment, but do NOT increase the MOTION-WIDTH, use

· Insert Blend-Point at  or

· Insert-Blend-Point .

*  90º or an equivalent for other X–axis units

1.6.5.2 Segment: Append

Append Segment

Use Append-Segment to add a new SEGMENT to the end of the motion, after

the last SEGMENT.

Append Segment

1. Click Blend-Point & Segment toolbar > Ap-

pend Segment 

A new SEGMENT is now at the end of the motion,

after the last SEGMENT. 

The new SEGMENT is now the SELECTED-SEGMENT.

Notes: 

The SEGMENT-WIDTH of the new segment is 90º *.

The new MOTION-WIDTH is 90º wider *.

Use the SEGMENT EDITOR  to reduce the SEGMENT-WIDTH of one or more

segments, to reduce the MOTION-WIDTH again.

To add a new SEGMENT, and not change the MOTION-WIDTH, use:

· Insert Blend-Point at  or

· Insert-Blend-Point .
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*  90º or an equivalent for other X–axis units

1.6.5.3 Segment: Delete

Delete Segment

Use Delete-Segment to remove the SELECTED-SEGMENT.

Delete Segment

Use your mouse to select a SEGMENT. It is now the SELEC-

TED-SEGMENT.

To delete the SELECTED-SEGMENT: 

1. Click Blend-Point & Segment toolbar > De-

lete Segment 

The SELECTED-SEGMENT has been removed from the

motion.

Notes:

The SEGMENT WIDTH of the PREVIOUS-SEGMENT increases by the SEGMENT-

WIDTH of the SEGMENT that you delete.

The MOTION-WIDTH does not change.

You do not get a warning.

731
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1.6.5.4 Blend-Point: Insert

Insert Blend-Point (approximately)

Add a new BLEND-POINT, and to split one segment into two segments.

To add a BLEND-POINT at the X-AXIS VALUE that you click with your mouse.

Insert Blend-Point

'Approximately'

1. Click Blend-Point & Segment toolbar > Insert

Blend-Point 

2. Move your mouse-pointer to the place on

motion-graph at which you want to Insert a

new BLEND-POINT.

3. Click the motion-graph.

RESULT

A new BLEND-POINT splits the SEGMENT at the X-axis of

your mouse-pointer. The SEGMENT becomes two SEG-

MENTS. 

The two SEGMENTS have the same motion-law.

Recommended: Use the BLEND-POINT EDITOR  to

move the BLEND-POINT to an exact X-axis value .

See also: 

Insert Blend-Point at

TOP-TIP: Motion Planning

1.6.5.5 Blend-Point: Insert at

Insert Blend-Point at (exactly)

Add a new BLEND-POINT, and to split one segment into two segments.

You must enter an X-AXIS VALUE for the new BLEND-POINT in the INSERT

BLEND-POINT AT... DIALOG

Insert Blend-Point AT

STEP   1. Do Insert Blend-Point at... 

1. Click Blend-Point & Segment toolbar >

Insert Blend-Point at ... 

The INSERT BLEND-POINT AT... DIALOG is open.

MD16 The default X-AXIS VALUE in the dialog is at

the mid-point of the SELECTED-SEGMENT.

However, to add a new BLEND-POINT, you

must edit the X-AXIS VALUE in the dialog.

STEP   2. Edit the X-axis value for the new

Blend-Point

Do

1. Enter an X-AXIS VALUE with your

keyboard
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MD-16:

 
Insert Blend-Point at... dialog

MD17

MD-17:

 
Insert Blend-Point at... dialog

2. Press the “Enter” key on your

keyboard

And/or do:

1. Use the Spin-Box tool to edit

the X-axis value 

When the X-AXIS VALUE for the new

BLEND-POINT is correct:

2. Click  to close the dialog 

Notes:

After you add a new BLEND-POINT, you

can also edit its X-AXIS VALUE with the

BLEND-POINT EDITOR  

You cannot enter an X-AXIS VALUE for

the BLEND-POINT that is: 

· Less than the MOTION-START  

· Greater than MOTION-WIDTH

+ MOTION-START

See-also: TOP-Tip: Motion Planning 
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1.6.5.6 Open Data-Transfer Table

Open Data Transfer Table 

Use this command to open the Data Transfer Table

Use the Data Transfer Table to export and to import motion-files.

MD16

MD16

Blend-Point and

Segment toolbar

MD17

MD17

Blend-Point and

Segment toolbar

To open the Data Transfer Table:

1. Click Blend-Point & Segment toolbar > Data Transfer Table icon.

The Data Transfer Table is now open - see more: Data Transfer Table 744
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1.6.6 File toolbar

File toolbar

MD 16

MD16: File toolbar

MD 17

MD17: File toolbar

Add New Motion  

Open and Append Motion

Save all  - See Note

Save all as...  - See Note

Save Active Motion as...  - See Note

Print Active Motion

Print all Motions

Delete Active Motion

Notes: 

When you save a model:

· we use the CXL file-extension for the MechDesigner model

· we use the MTD file-extension, with the same file-name as the

MechDesigner model, for the motions in MotionDesigner

You can also save one or all motions with: 

· MOTIONDesigner > File toolbar > Save all as  ... to save all of the

motions to a different file-name.

· MOTIONDesigner > File toolbar > Save Active Motion  ... to save

one motion to a different file-name. 

Why save a motion to a different file-name?

E.g. If a motion-design is complex you may want to save a motion, then

re-import it to experiment with different motion-values.

You can use the motion you re-import as the basis for a different

product, size, format, or machine.

1.6.6.1 File: Add New Motion

Add New Motion

To add a new Motion name-tab.
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Add New Motion

1. Click File toolbar > Add New Motion

Motion name-tabs

The new Motion name-tab is now the active Motion

name-tab.

The new Motion name-tab is to the right of all

other Motion name-tabs.

The new Motion name-tab is the default motion

with four Flexible-Polynomial  segments.

See also: 

Motion name-tabs

Open and Append

1.6.6.2 File: Open and Append

Open and Append Motion

To open motion files you have saved to append to those existing Motion name-

tab(s).

1. Click File toolbar > Open and Append

See also: Add Motion

Open and Append Motion file-types

MTD: MotionDesigner file-type

The MTD file may include any number of motions. Each motion in the

MTD file will add a Motion name-tab.

DA: Jetter file-type

TXT: Logix 5000 Cam file (beta-testing) file-type

SHP: Camlinks & Motion file-type

1.6.6.3 File: Save All Motions

Save All

To save all motions to one file.

1. Click File toolbar > Save All

MotionDesigner files-types are MTD file-type.
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Note: We save for you all of your motions to the MTD

file-type when you save the MechDesigner model.

See also: Open And Append , Save All As , Add Motion , Save , Close

1.6.6.4 File: Save All Motions As...

Save all as ...

To save all motions to one file with a new file-name:

1. Click File toolbar > Save All as ...

Note: When you save the MechDesigner model to a CXL file, we also save for

you all of the motions in MotionDesigner to one MTD file with the same file-

name as the CXL file.

See also: Save All , Save Active Motion , Delete/Remove , Add Motion  ,

Open and Append

Save as Motion file-types

MTD: MotionDesigner file-type

Save all of the Motions to one MTD file.

DA: Jetter file-type

Save as the Jetter Automation file-type - see below.

TXT: Logix 5000 Cam file (beta-testing) file-type

Save as the Allen-Bradley (Rockwell) Logix 5000 Cam file-type.

Jetter File-Type Dialog-box

724 725 723 727 729
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WRITE COMMENTS TO FILE

Click the check-box if you want the DA file to explain the function and

parameter of each line

HEADER DATA BOX

Use the check-box to write, as text, at the top of the DA file:

· File Path - the path is in the box- it is read-only.

- or -

· Project Name - you must write the Project Name in the box

REGISTER NUMBER AT START BOX

Enter a Register Offset in the box

OK, CLOSE, CANCEL OR HELP BUTTONS

MotionDesigner saves each motion to a different file. The file-name is

the Motion name-tab.

Notes on the DA file

All motion-type are saved as the Polynomial file-type, with their coefficients.

If the segment is a Traditional Motion-Law of the Harmonic Type, for ex-

ample Modified-Sinusoid, then:

1. The actual Mod-Sine segment is divided into sub-segments. 

 The Blend-Points for the sub-segments are at the 'natural' positions

within the Segment.

2. The sub-segments are saved as Polynomials. 

The Polynomial coefficients minimize the error between the actual Seg-

ment and the Polynomial Segment.
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For example:

· Modified-Sinusoid Motion-Law has three sub-segments

· Modified-Trapezoidal Motion-Law has five sub-segments

To review the BLEND-POINTS and the sub-segments, do Open and Ap-

pend  and select the DA file-type after you save it.

1.6.6.5 File: Save Active Motion

Save Active Motion

To save the active Motion only:

1. Click File toolbar > Save Active Motion

See also: MOTION FILE-TYPES, below 

See also:  Save All  , Save  

Save Active Motion File-Types:

MTD: MotionDesigner File-Type.

The active motion is saved to the MTD file-type

DA: Jetter File-Type

This is the Jetter Automation file-type - see below.

TXT: Logix 5000 Cam file (beta-testing)

This is the Allen-Bradley (Rockwell) Logix 5000 Cam file-type.

Jetter File-Type Dialog-box
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Jetter .DA  Save as interface

When you select DA as the file-type, this interface opens.

You have the option to enter these parameters:

WRITE COMMENTS TO FILE

Click the check-box if you want the DA file to explain the function and

parameter of each line

HEADER DATA box

Use the check-box to write, as text, at the top of the DA file:

· File Path - the path is in the box- it is read-only.

- or -

· Project Name - you must write the Project Name in the box

REGISTER NUMBER AT START BOX

Enter a Register Offset in the box

OK, Close, Cancel or Help buttons

MotionDesigner saves the motion as a .DA file-type. The file-name is the

same as the Motion name-tab.

Notes on the DA file

All motion-types are saved as a polynomial file-type, with their coefficients.

If the segment is a Traditional Motion-Law of the Harmonic Type, for ex-

ample Modified-Sinusoid, then:

1. The actual Mod-Sine segment is divided into sub-segments. 

 The Blend-Points for the sub-segments are at the 'natural' positions

within the Segment.
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2. The sub-segments are saved as Polynomials. 

The Polynomial coefficients minimize the error between the actual Seg-

ment and the Polynomial Segment.

For example:

· Modified-Sinusoid Motion-Law has three sub-segments

· Modified-Trapezoidal Motion-Law has five sub-segments

To review the Blend-Points and the sub-segments, you can do: Open and

Append  and select the DA file-type after you save it.

1.6.6.6 File: Print

Print Active Motion

File toolbar > Print Motion

Prints the active Motion

1.6.6.7 File: Print All

Print All Motions

File toolbar > Print ALL Motions

Print ALL of the motions.

1.6.6.8 File: Delete Active Motion

Delete Active Motion

WARNING - there is NO WARNING !!!

There is no WARNING that you will DELETE the Mo-

tion name-tab 

and

You cannot undo DELETE ACTIVE MOTION!!!

File toolbar > Delete Active Motion IMMEDIATELY

1. Click the name-tab of the motion that you want to delete 

2. Click File toolbar > Delete Active Motion

Notes:  

· You cannot delete all Motions name-tabs - one Motion name-tab must

be available.

· You cannot delete a motion that has a link with a MOTION FB (in

MechDesigner).
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1.6.7 Edit toolbar

Edit toolbar

MD16

MD16: Edit toolbar

MD17

MD17: Edit toolbar

Undo

Redo

Active Motion Settings  / Configure Motion / Re-

name Motion  

Sweep Display

Auto-Update

Display Motion Chart

1.6.7.1 Edit: Undo

Undo

Edit toolbar > Undo 

... to undo the previous motion edit. 

You can continue to undo more edits.

Note: 

You may need to click in the MotionDesigner applica-

tion window before you can use Undo.

See also: Redo

1.6.7.2 Edit: Redo

Redo

Edit toolbar > Redo 

1. Click Edit toolbar > Redo to redo the last undone

command.

You can continue to redo all undone commands.

Note: 
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Each Motion name-tab has its own stack you can Redo.

See also: Undo , Command History

1.6.7.3 Edit: Active Motion Settings

Active Motion Settings

Edit toolbar > Active Motion Settings 

Each motion has settings.

Active Motion Settings dialog

There are four tabs:

· Motion

· Advanced

· Number-Format

· Accessibility

Note: The settings become the default settings when you exit MechDesigner.

Motion tab                                       

Motion name-tab (read-write)

MOTION NAME

MOTION NAME (read-write) (default =

Motion0, Motion1, ... )

Enter a new MOTION NAME with your

keyboard. 

Press the ENTER key on your key-

board. 

The new Motion-Name is now the Mo-

tion name-tab.

MOTION CYCLE DATA

NUMBER-OF-POINTS (read-write) ( de-

fault = 360)

The NUMBER-OF-POINTS along the

active motion graph. 

Note: 

Enter NUMBER-OF-POINTS = 361 to

put a Motion-Point exactly on each

machine-degree as defined by the

MMA.

RPM [ CYCLES/MIN ] (read-only) 
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RPM : Machine cycles per minute.

See: MechDesigner - Edit

menu>Machine Settings>Cycling

Parameters>Cycles/Min

SECONDS / CYCLE ( read-only ) 

SECONDS / CYCLE = 60 / CYCLES/MIN

MOTION UNITS

X–AXIS UNITS: ( default = degrees )

Units available: counts: sec, msec,

cycle, degree, radian.

Y–AXIS UNITS: ( default = degrees or mm

)

Units available: mm, cm, m, inch,

degree, radian, cycle, count.

POSITION : Units

VELOCITY : Units/s

ACCELERATION : Units/s2

JERK : Units/s3

Note: 

Change from Angular to Linear Un-

its, or vice versa: If you change from

Angular Units to Linear Units, then

The motion does not have a differ-

ent physical value when you select

different Y-AXIS UNITS. E.g. 90mm

becomes 0.090m, or 3.543inches.

Advanced tab                          

X-AXIS PARAMETERS

[UNITS] AT START ( default = 0 )

 Edit Unit data-type in Motion tab

>  Motion Units 

Y-AXIS PARAMETERS 

COUNTS / DEGREE ( default =1 )

Edit Unit data-type in Motion tab

>  Motion Units 

COUNTS AT START ( default = 0 )

Edit Unit data-type in Motion tab

>  Motion Units 

Number Format tab                      
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NUMBER FORMAT 

FORMAT ( default : General )

See Number Format 

PRECISION (default = 6 )

See Precision 

DIGITS (default = 3 )

See Digits 

Accessibility tab                      

COLORS 

þ Show Grid : Enable to show the

horizontal and vertical grid lines

in the graph-plot area.

Colors : edit with Windows Color Pick-

er® :

· Line: of all segments, but not the

SELECTED-SEGMENT 

· Grid: the vertical and horizontal

Grid-Lines

· Axis Color : X and Y-axis text

· Background: the graph area

· Selected: the SELECTED-SEGMENT

(typically Red)

· Overlay: see Overlay-Trace

LINE AND SYMBOL SIZES

LINE THICKNESS (default = 1 ; Maximum

 = 8 )

The plot thickness, in pixels, of the

motion segments

SYMBOL SIZE (default = 2 ; Maximum =

8 )

The scale/size of the BLEND-POINT

symbols

1.6.7.4 Edit: Sweep-Display

Sweep-Display

Use to evaluate exact P, V, A, J motion-values at any X-axis value as defined

by the CURSOR-POSITION parameter. 
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As you edit the X-axis value with the CURSOR-POSITION parameter, a vertical

cursor shows on the motion graphs at the X-axis value.

BUG: The Cursor does not sweep correctly when MOTION-START 0.

See Blend-Point Editor > X-axis Values > Motion-Start .

To open the Sweep-Display dialog:

1. Click Edit toolbar > Sweep-Display

icon 

Sweep-Display dialog

SWEEP-DISPLAY 

CURSOR POSITION

The X-axis value at which to evaluate exact

motion-values.

POSITION, VELOCITY, ACCELERATION, JERK (read-

only)

The exact POSITION, VELOCITY, ACCELERA-

TION, and JERK motion-values at the X-axis

value as defined by the CURSOR-POSITION.

The advantage of the Sweep Display is that

you can see a vertical cursor on the motion

graphs at the X-axis value.

The advantage of the Motion-Value Evaluator

is that you can enter an X-axis value greater

than the last X-axis point - see Notes below.

See also: Motion-Width , Number of Steps ,

Motion-Value Evaluator

Notes:

Edit DIGITS and PRECISION of the motion-values with:

Edit toolbar > Active Motion Settings > Number Format tab | Number-

Format separator .

Maximum CURSOR POSITION =  MOTION-WIDTH – NUMBER OF STEPS / MO-

TION-WIDTH.

For example: If MOTION-WIDTH = 360. and:

NUMBER-OF-STEPS = 360; Maximum CURSOR POSITION   359

NUMBER-OF-STEPS = 3600; Maximum CURSOR POSITION   359.9

1.6.7.5 Edit: Rebuild Motions

Auto-Update Motion
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Edit toolbar > Rebuild icon 

Enable - to rebuild the model as you edit a motion-

value. 

or 

Disabled - to edit motion-values quickly. 

The model may not update to the new motion-value

after each edit. 

1.6.7.6 Edit: Display Motion Chart

Motion Chart

Edit toolbar > Display Motion-Chart

Display all of the motions in a chart.

You can choose to display all of the P, V, A, or J

charts for each motion.

You can choose to display the motions above or

over each other.

You also Print the chart.
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Click to Expand and Collapse

Motion Charts shown ''above'' each other.

Select which motion-derivative to display in the Motion

Timing Chart.

Print, Save as, Zoom-Out,

Zoom-In, Pan Left, Pan Right,

Zoom Extents, Toggle: Display

across each other or Display

above each other.

Plot Parameters

PLOT PARAMETERS: - click to show these options:

 Enable to show the Motion as indicated in 

 Enable the Major Grid for the Motion in 

 Enable the Minor Grid for the Motion in 
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 The Motion (in this case “All” of the Motions) to ap-

ply the setting .

 Drop-down to select which motion, or All, to apply

the settings .
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1.6.8 View toolbar

View Toolbar

MD16

MD16: View toolbar

MD17

MD17: View toolbar

Show/Hide Position Graph

Show/Hide Velocity Graph

Show/Hide Acceleration Graph

Show/Hide Jerk Graph

Zoom Out

Zoom In

Zoom Extents

Pan Left

Pan Right

Notes on Motion Graphs

You must show a minimum of one motion-derivative graph.

If you show more than one graph:

· the Position graph is above all other graphs

· the Velocity graph is below the Position graph, and/or above the Acceler-

ation, and/or Jerk graph

· the Acceleration graph is below the Velocity graph, and/or above the Jerk

graph

· the Jerk graph is below all other graphs

1.6.8.1 View: Show Position Graph

Show Position

View toolbar > Show POSITION Graph

Show or Hide the POSITION graph.

Terminology:  

· POSITION is the location relative to a datum, similar to an X, Y, Z co-

ordinate.

· DISPLACEMENT is the movement from one position to a different

position.
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See also: Show Velocity , Show Acceleration , Show Jerk

1.6.8.2 View: Show Velocity Graph

Show Velocity

View toolbar > Show VELOCITY Graph

Show or Hide the VELOCITY graph.

Note: 

VELOCITY is the rate-of-change of POSITION with respect to time. 

See also: Show Position , Show Acceleration , Show Jerk

1.6.8.3 View: Show Acceleration Graph

Show Acceleration

View toolbar > Show ACCELERATION Graph

Show or Hide the ACCELERATION graph.

Note: 

ACCELERATION is the rate-of-change of VELOCITY with respect to

time. 

See also: Show Position , Show Velocity , Show Jerk

1.6.8.4 View: Show Jerk Graph

Show Jerk

View toolbar > Show JERK Graph

Show or Hide the JERK graph.

Note: 

JERK is the rate-of-change of ACCELERATION with respect to time. 

See also: Show Position , Show Velocity , Show Acceleration

1.6.8.5 View: Zoom-In

Zoom-In

View toolbar > Zoom-In

Expand the X–axis (NOT the Y-axis) to see less of the motion.

See also: Zoom-Out , Zoom Extents , Pan Left , Pan Right

1.6.8.6 View: Zoom-Extents

Zoom-Extents

View toolbar > Zoom Extents

739 739 739
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Scale the X-axis to equal the Motion-Width.

See also: Zoom-In , Zoom-Out , Pan Left , Pan Right

1.6.8.7 View: Pan Left

Pan-Left

View toolbar > Pan Left

Move the X-axis of the motion graph to the right.

This tool does not change the timing of the motion.

To change the timing of the motion, see:

Blend-Point Editor > X-axis values > Motion-Start.

See also: Zoom-In , Zoom-Out , Zoom Extents , Pan Right

1.6.8.8 View: Pan Right

Par Right

View toolbar > Pan Right

Move the X-axis of the motion graph to the left.

This tool does not change the timing of the motion.

To change the timing of the motion, see: 

Blend-Point Editor > X-axis values > Motion-Start.

See also: Zoom-In , Zoom-Out , Zoom Extents , Pan Right

1.6.8.9 View: Zoom-Out

Zoom-Out

View toolbar > Zoom-Out

Contract the X–axis (NOT the Y-axis) to see more of the motion.

See also: Zoom-In , Zoom Extents , Pan Left , Pan Right

739 740 740 740
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1.6.9 Motion toolbar

Motion toolbar

The Motion toolbar is below the graphs.

To see all of the Motion toolbar, you may need to increase the width of Mo-

tionDesigner. 

You can do one of the following:

· Drag the left edge of the MotionDesigner graphs, to the left.

· Float (undock) MotionDesigner - see MechDesigner > Visibility menu >

Float or Dock MotionDesigner.

MD16

MD16: Motion toolbar

MD17

MD17: Motion-toolbar

 Motion-Law Selector

 Motion-Width  (read-only)

 Motion Value Evaluator  (read-write)

1.6.9.1 Motion Law Selector

Motion-Law Selector

Motion-Law Selector list box

It is below the Motion graphs, at the left side of the Motion toolbar.

Before you can use the Motion-Law Selector:

741
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1. Click a above or below a segment to move the program focus to Mo-

tionDesigner.

2. Click above or below a segment to make it the SELECTED-SEGMENT

Now, use the Motion-Law Selector to:

· Identify the MOTION-LAW of the SELECTED-SEGMENT 

AND/OR

· Use the drop-down to select a different MOTION-LAW for the SELEC-

TED-SEGMENT 

See also Motion-Laws

1.6.9.2 Motion-Width

Motion-Width (read-only)

MOTION-WIDTH =   SEGMENT-WIDTHS

IMPORTANT

Most typically, the MOTION-WIDTH = 360. Then, the timing of the mo-

tion will equal the timing of the Master-Machine-Angle (MMA)

To edit the MOTION-WIDTH, you must use the SEGMENT EDITOR  to

edit the SEGMENT-WIDTH of one or more segments. 

If MOTION-WIDTH is to equal one machine-cycle.

And the X-AXIS UNITS are:

Degrees: MOTION-WIDTH =360

Radians: MOTION-WIDTH =

Seconds: MOTION-WIDTH = 60 / (CYCLES / MINUTE)

Milliseconds: MOTION-WIDTH = 60 000 / (CYCLES / MINUTE)

CYCLE/MINUTE

See MechDesigner:  Edit menu > Machine-Settings > Cycling Paramet-

ers.

To edit the X-axis Units:

Active Motion-Settings > Motion tab > Motion Units > X-axis
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1.6.9.3 Motion-Value Evaluator

Motion-Values Evaluator

Machine-Angle(1) : Evaluate Motion-Values(2)

For any real number you enter as a MACHINE-ANGLE , we evaluate for you

the exact motion-values  (P, V, A, J).

See also: Motion-Values at Pointer , Sweep-Display
684 733
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1.6.10 Data Transfer Table

Data Transfer Table

Use the Data Transfer Table to:

· Import data from a GRAPH FB, or from a different application, e.g.

NotePad, Excel, to the table and then to a List segment-type

· Export motion data from a motion-graph to the table and then save or

copy the data.

· Display data in the table as a dumb-graph over a motion-graph - see

Overlay Trace

Open the Data Transfer Table

MD16

MD16

Blend-Point and

Segment toolbar

MD17

MD17-

Blend-Point and

Segment toolbar

To open the Data Transfer Table:

1. Click Blend-Point & Segment toolbar > Data Transfer Table icon. 

The Data Transfer Table is now open.

Data Transfer Table

Data Transfer Table

Note: X-axis,  Row 0 is at the Motion-Start .

Data Transfer Table toolbar
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Clear all data from the table : Remove all the data from the Data

Transfer Table.

Save data to a CSV, TXT, or DAT file-type : Save all of the data in

the motion-graphs to a CSV, TXT, or a DAT file-type.

Open and load data from a CSV, TXT, DAT file-type : Load data in

a CSV, TXT, or DAT file-type, and paste into the table.

Copy all data to clipboard : Copy all data in the Data Transfer

Table to the Windows© clipboard. 

Copy selected data to clipboard : Copy the selected data to the

Windows© clipboard.

Cut selected data to clipboard : Remove selected data from the

Data Transfer Table and copy to the Windows© clipboard.

Paste clipboard to table : Paste data in the Windows© clipboard to

the Data Transfer Table, starting at the active cell.

Delete selected data from table : Delete the selected data from the

Data Transfer Table. 

Get data from List segment-type : The SELECTED-SEGMENT must be a

List Segment-Type. 

Put data to a List segment-type : The SELECTED-SEGMENT must be a

List Segment-Type. 

Get all displayed P,V,A,J motion-data : Transfer to the Data Trans-

fer Table the motion-values of the motion graphs in the active motion

- see also: Note 1, below.

Get all displayed P,V,A,J segment-data : Transfer to the Data Trans-

fer Table the motion-values of the motion-derivative graphs that

show, for the SELECTED-SEGMENT only  - see also Note 1, below.

Show data as an Overlay-Trace  : Display the motion-values that

are in the Data Transfer Table as an OVERLAY-TRACE. You can toggle

this icon to show or hide the OVERLAY-TRACE.

An OVERLAY-TRACE is a dumb graph that shows with the active motion

graph.

Toggle: Include/Ignore last value in Data Transfer Table  

Often you want to transfer the motion-values that are in the Data

Transfer Table to another application - see also Note 2, below. With a

non-progressive motion, your application may need:

· the last and first data points to be equal, or
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· the last and first data points to be not equal.

Notes: 

1. Only data from those motion-derivatives that are showing as graphs.

2. You may need to increase or decrease the Number of Points  in the

motion by 1 to get a motion-value exactly at each machine degree or

millisecond - e.g. from 360 to 361 Points

Data Transfer Table: Shortcut menu

Right-click in the Data Transfer Table to show the shortcut menu.

Copy Selected Data to

the Clipboard

Clear all data from

table

Load data from a CSV

or TXT file-type

Save to Text File

Copy all data to clip-

board  

Copy selected data to

clipboard

Cut selected data from

table

Paste data from clip-

board to table

Delete selected data

from table

Get all displayed P,V,A,J

segment data

Toggle: include/ignore

last value in Data Trans-

fer Table

Get all displayed P,V,A,J

motion data

Show Data as an Over-

lay Trace

What happens when you PUT data to a List segment-type

When you PUT data to a List segment-type:

· MotionDesigner recalculates for you the data in your list to put the

correct number of points, which are proportional to the SEGMENT-

WIDTH of the List Segment-Type.

· MotionDesigner numerically calculates for you all motion-derivat-

ives from the data.

The minimum number-of-points (rows) you can transfer to a List Seg-

ment-Type is 6. We recommend many more than 6 points.
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Get data from Motion / Segment

When you GET data from the motion or a segment:

NUMBER-OF-COLUMNS: X-axis + each displayed motion-derivative

NUMBER-OF-ROWS (Motion): = NUMBER-OF-STEPS in ACTIVE MOTION

SETTINGS

NUMBER-OF-ROWS (Segment): = NUMBER-OF-STEPS × SEGMENT-WIDTH

/ MOTION-WIDTH

1.6.10.1 Clear all data from the table

Clear All data from the Data Transfer Table

 Click to clear, or remove, all data from the Data Transfer Table.

1.6.10.2 Save data to a CSV or TXT file-type

Save All Data or Save Selected Data to a Text File

Click to Save all data in the table to a file. 

You can save the data as these file-types: CSV, TXT, or DAT.

The data does not need to be in the Data Transfer Table.

File-type Description Data

CSV 

Comma Separated Values 

Numbers separated with

the List separator

Index Number, X-axis value, Mo-

tion-Value at X-axis value for each

graph. 

TXT
Numbers separated with

List Separator

Index Number, X-axis value, Mo-

tion-Value at X-axis value for each

graph. 

DAT
Compatible with Camlinks

DAT file-type

Index Number, X-axis value, Mo-

tion-Value at X-axis value for each

graph. 

1.6.10.3 Load a CSV or TXT file-type

Open a Text File

Open a file that is a CSV, TXT, or DAT file-type.

The data in the file fills the table from the active cell in the Data

Transfer Table

Usually, use the data in a segment that is a List Segment-Type or an Overlay

Trace .

List Segments-Types are: 

731
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· Position List  : MotionDesigner numerically differentiates the data

to create Velocity, Acceleration, and Jerk.

· Acceleration List  : MotionDesigner numerically integrates the

data to create Velocity and Displacement.

· Z Raw-Data  : MotionDesigner numerically differentiates the data

to create Velocity, Acceleration, and Jerk.

1.6.10.4 Copy all data to clipboard

Copy all Data

Copy all data in the Data Transfer Table to the Windows® Clipboard.

1.6.10.5 Copy selected data to clipboard

Copy Selected Data

Save data to the Windows® Clipboard.

Select the Data:

1. Click a cell in the table 

2. SHIFT+Click a different cell 

The data is now selected.

3. Click this icon in the Data Transfer toolbar.

The selected data is now on your Clipboard.

1.6.10.6 Cut selected data from table

Cut Selected Data from Table to Clipboard

Use to cut the Selected Data* from the table and place on your Win-

dows Clipboard.

You can:

· Paste the data to a computer application, such as Notepad®,

WordPad®, Word®, Excel®, etc.

· Paste the data back into the Data Transfer Table.

* Selected Data: 

1. Click a cell in the table 

2. SHIFT+Click a different cell

The highlighted data is now the Selected Data.

See also: 

Data Transfer: Copy , 

Data Transfer: Paste
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1.6.10.7 Paste data from clipboard to table

Paste Data to Table

Paste data from your clipboard to the Data Transfer Table.

1. Click a cell in the table 

2. Click the icon to paste the data 

The data is now in the Data Transfer Table. 

See also: 

Data Transfer: Cut  

Data Transfer: Copy

1.6.10.8 Delete selected data from table

Delete Selected Data from Data Transfer Table

Delete selected data* from table.

* To select data: 

1. Click a cell in the table 

2. SHIFT+Click a different cell

The Selected Data is now the Selected Data.

See also: 

Data Transfer: Copy  

Data Transfer: Paste

1.6.10.9 Get data from List Segment-Type

Get Data from a List Segment-Type

Note: This icon is in the toolbar only when the SELECTED-SEGMENT is a List

Segment-Type.

Get List Data : to get the data that you originally put to the List Seg-

ment-Type with the Put List Data  icon. 

List Segment-Types are:

· Position-List  

· Acceleration-List  

· Z-Raw-Data

See also: 

Put List Data  

Get Segment Data
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1.6.10.10 Put data to List Segment-Type

Put Data to a List Segment-Type

This icon is in the toolbar only when the SELECTED-SEGMENT is a List Seg-

ment-Type.

Put List Data : to put data* that you select from the Data Transfer

Table to a List Segment-Type.

To Select data: 

1. Click a Header to select all of the data under that header that

column 

2. Click Put Data to List Segment

OR

1. Click a cell in the table  

2. SHIFT + Click a different cell* in the table

The highlighted data is now the Selected-Data.

3. Click Put Data to List Segment 

After you put the data-points to the List Segment-Type,  :

1. MotionDesigner re-samples your data to allocate the number

of motion-points that are proportionate to the SEGMENT-WIDTH

and Number-of-Points in the Motion  

2. Calculates all motion-derivatives

* The minimum number-of-points you can select in the Data Transfer

Table is 6. 

You should usually put many more than 6 points to the List Segment-

Type.

List Segment-Type are

· Position-List

· Acceleration-List  

· Z-Raw-Data

See also:

Get List Data

Get Motion Data

Get Selected-Segment Data

Overlay-Trace

1.6.10.11 Get motion data from displayed graphs

Get Motion Data from displayed Graphs
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Get Motion Data

Transfer to the Data Transfer Table the motion-values of the complete

motion and of the displayed graphs.

· # Columns: X-axis + each motion-derivative that is displayed as

a graph.

· # Rows : Number-of-Steps

See Active Motion Settings > Motion tab > Motion Cycle Data  >
Number-of-Steps

Number Format : see Active Motion Settings > Number-Format tab >
NUMBER-FORMAT   > Precision / Digits

Units : see Active Motion Settings > Motion tab > MOTION-UNITS  >

X-Axis / Y-Axis units

1.6.10.12 Get Segment Motion Data

Get Segment Data from Graphs 

Get Segment Motion-Data

Transfer to the Data Transfer Table the motion-values of each motion-

derivative for the SELECTED-SEGMENT.

· # Columns : X-axis + each motion-derivative that is displayed as

a graph.

· # Rows : NUMBER-OF-STEPS  × SEGMENT-WIDTH(DEGREES) / 360

Number Format : see Active Motion Settings > Number-Format tab >
NUMBER-FORMAT   > PRECISION / DIGITS

Units : see Active Motion Settings > Motion tab > MOTION-UNITS  >

X-AXIS / Y-AXIS UNITS

1.6.10.13 Show data as Overlay-Trace

Overlay-Trace

Show the data that is in the Data Transfer Table as a dumb graph together

with the active Motion.

The dumb graph is the Overlay-Trace.

Note: 

The MTD or ZXL file-types do not save the Overlay-Trace or the data in the

Data Transfer Table. 

If the data is important, and the data is not available from a Motion graph or

a GRAPH FB (MechDesigner) then we recommend that you put the data  to

a new Motion of one segment that is a List Segment-Type . Also, rename

the new Motion to Overlay-Trace, or a name to remind you that the data is

intended for an Overlay-Trace in a different motion.
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Position, Velocity, Acceleration motion-values for

Overlay-Trace.

Overlay-Trace (in Orange) and the active Motion

To show an Overlay-Trace

1. Make sure there is data in the Data Transfer Table (see Pre-

pare the Data for an Overlay Trace , below) 

2. Click the Overlay-Trace icon in the toolbar.

The data shows as the Overlay-Trace together with the active

motion. 

3. Click in the graph to scale the graphs correctly. 

The active-motion and the Overlay-Trace rescale to their

maximum and minimum values. 

To hide the Overlay-Trace:

1. Click the Overlay-Trace icon again 

We disable the plot of the Overlay-Trace.

To edit the color of the Overlay-Trace
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MotionDesigner > Edit toolbar > Active Motion Settings  > Access-

ibility tab > Overlay Trace color button.

 Prepare the Data for an Overlay Trace

The data in the Data Transfer Table should be arranged as follows:

· Data in Column 2, from Row 0, displays in the Position graph.

· Data in Column 3, from Row 0, displays in the Velocity graph.

· Data in Column 4, from Row 0, displays in the Acceleration graph.

· Data in Column 5, from Row 0, displays in the Jerk graph.

Note: 

· The Overlay-Trace shows even if the data in Columns 2,3,4,5 are not

motion-derivatives of each other.

· The Overlay Trace shows only for each column of data in the Data

Transfer Table - we do not calculate other motion-derivatives for

you.

Overlay-Trace example:

To show the motion-values of Motion0 as an Overlay Trace in Motion1.

If necessary:

1. Click File toolbar > Add Motion  to add a Motion1 as a new mo-

tion name-tab 

2. Click View toolbar  > P, V, A, J buttons to show all motion-derivat-

ives in Motion1

3. Click Motion0 name-tab to make it the active motion

4. Click View toolbar > P, V, A, J buttons to show all motion-derivatives

in Motion0

Open the Data Transfer Table.

5. Click Blend-Point and Segment Editor toolbar > Data Transfer

Table .

Get the motion-values from Motion0 into the Data Transfer Table.

6. Click Data Transfer Table > Get Motion Data .

The Data Transfer Table fills with the motion-values for each motion-de-

rivative in Motion0.

Make Motion1 the active motion.

7. Click Motion1 name-tab to make it the active motion

Show the data that is in the Data Transfer Table as the Overlay-Trace in

Motion1.

8. Click Data Transfer Table > Overlay Trace button

The motion-values of Motion0 are now an Overlay Trace in Motion1.

9. Click in the Graph of Motion1 to re-scale Motion1 and the Overlay

Trace.
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The graphs rescale to show the maximum and minimum of the Motion1

and the Overlay-Trace.

1.6.10.14 Get Last Point

Toggle: Do Transfer or Do Not Transfer Last Motion Point

OR

A Toggle for when you GET Motion-Data :

· Do transfer the last motion data point from the motion graphs

to the Data Transfer Table.

OR

· Do not transfer the last motion data point from the motion

graphs to the Data Transfer Table.

Example: 

1. Edit the NUMBER OF POINTS = 361.

The NUMBER-OF-POINTS parameter is set in the Active Motion Settings >

Motion tab.

2. Toggle IN the Get Last Point

3. Click Get Motion Data

The number of rows in the Data Transfer Table = 0 to 360, a total of 361

rows

4. Click Clear Data from the Table

5. Toggle OUT the Get Last Point

6. Click Get Motion Data

The number of Rows in the Data Transfer Table = 0 to 359, a total of 360

Rows

Frequently, when you want to transfer the motion-data in the Data Transfer

Table to another application, your other application may need: 

· the last row in the table to be equal to the first row in the table

or

· the last row in the table to be equal to the last point in the motion 

See also:

See Active Motion Settings > Motion tab > Motion Cycle Data  >
NUMBER-OF-POINTS
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1.6.11 Motion Laws / Cam-Laws for Segments

Motion-Laws - also called Cam-Laws.

Select the Motion-Law for each segment with the Motion-Law Selector  or

the Segment-Editor .

Each Motion-Law is a mathematical expression that defines how an output

variable (Y-axis) changes as a function of an input variable (X-axis). 

The mathematical expressions evaluate EXACTLY the displacement, velocity,

acceleration, and jerk motion-values for all X-axis values. You do not need to

know any mathematics. 

For convenience, we can separate the motion-laws into three groups. 

Traditional Motion-Laws

The Traditional Motion-Laws (also named Standard Motion-Laws) have

been used for many years in cam mechanisms for Rise and Return segments,

usually with a Dwell segment before and/or after.

The Traditional Motion-Laws are based on:

· Trigonometric Functions

· Polynomials Functions

Traditional Motion-Laws:

1. Constant-Acceleration & Deceleration  - Polynomial Function 

2. Constant-Velocity  - Polynomial Function

3. Cubic  - Polynomial Function

4. Cycloidal  - Trigonometric Function

5. Cycloidal Constant-Velocity 50%  -Trigonometric Function

6. Dwell  - Polynomial Function

7. Modified-Sinusoid  - Trigonometric Function

8. Modified-Trapezoidal  - Trigonometric Function

9. Polynomial 2-3  - Polynomial Function

10. Polynomial 3-4-5  - Polynomial Function

11. Polynomial 4-5-6-7  - Polynomial Function

12. Polynomial Low Impact Crossover  - construct with two Flexible-Poly-

nomial segments

13. Quadratic  - Polynomial Function

14. Ramp  - Trigonometric Function

15. Simple-Harmonic  - Trigonometric Function

16. Sine-Constant-Cosine Acceleration  - Trigonometric Function

You can edit the SEGMENT PARAMETERS in the SEGMENT EDITOR to

get:

a. SCCA with Constant-Velocity 20%, 33%, 50%, 66%.... - 

17. Sine-Squared  - Trigonometric Function
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18. Sinusoidal  - Trigonometric Function

19. Triple-Harmonic  - Trigonometric Function

You can edit the SEGMENT PARAMETERS in the SEGMENT EDITOR to

get a motion-law similar to:

a. Triple Harmonic - Modified Trapezoidal  

b. Triple Harmonic - Modified Sine  

c. Triple Harmonic - Zero Jerk at Crossover

20. Flexible Polynomial 

Use to design a Throw motion-law, in which a return segment follows

immediately after a rise segment.

YOU must design Throw motion-laws with two Flexible Polynomial

segments. These are examples:

a. Throw: Quick-Return 1 - Finite Jerk @ Start / End  

b. Throw: Quick-Return 2 - Zero Jerk @ Start / End

c. Throw: Rapid-Return 1: Finite-Jerk @ Start/End/Mid-Point

d. Throw: Rapid-Return 1: Zero Jerk @ Start/End, Finite Jerk @ Mid-

Point

e. Low Impact at Crossover  Low Impact at Crossover uses two Flex-

ible-Polynomial segments to give one Rise motion-law. The Jerk is

zero when the Acceleration changes to Deceleration.

Special Motion-Laws

These meet the needs of specific applications.

25. Y–Inverse-Sinusoid  : when applied to the motion of a crank, it gives a

constant linear velocity at the tip of a crank. Only one Y-Inverse-Sinusoid

segment per crank rotation. 

26. CV Inverse Crank  : similar to the Y-Inverse-Sinusoid, One or more

Crank-Constant-Velocity segment per motion.

27. Flexible-Polynomial  - a VERY useful motion-law - see also Motion-

Laws 20 a-e

28. Ramp  - also a useful motion-law - see also Motion-Law 5, Cycloidal

CV50

29. Asymmetric Motion-Laws

List Segment-Types

You can import your own motion-values to a List Segment-Type:

29. Position-List  

30. Acceleration-List  

31. Z-Raw-Data
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When to use the Flexible Polynomial OR a Traditional, or the both Mo-

tion-Laws?

Flexible-Polynomial is the default motion-law. It is very powerful. We re-

commend that you learn how to use it effectively and efficiently. 

Traditional Motion-Laws have advantages in some circumstances.

We recommend that you use:

· All Flexible-Polynomials - to give powerful and flexible motion-

design possibilities

OR

· All Traditional Motion-Laws - the easiest to design a Rise and Return

type motion

OR

· A mixture of Flexible-Polynomial and Traditional Motion-Laws -

most difficult motion-design but may have advantages

German Technical VDI guidelines 2143 Parts 1 and 2

The Motion-Laws available in MotionDesigner exceed the German Tech-

nical VDI-guidelines 2143 Papers (Part) 1 and 2. Also bear in mind, that a

motion at the Follower or Servomotor is usually found by MechDesigner

with Inverse-Kinematics. When this is the case, the motion at the Follower or

Servomotor is not the same as that of the motion-design that is given to the

tooling, or Tool-Part.
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1.6.11.1 Acceleration-List [Import Data]

Acceleration List

See also: Position-List , Z-Raw Data

MOTION-DESCRIPTION

The ACCELERATION LIST is a List Segment-Type .

Use it to import Acceleration data.

See Position-List  to learn how to Import data to a List Segment-Type.

MOTION-VALUES

We integrate (numerically) your data for you to calculate and show the Ve-

locity and Position graphs.

We re-sample your data to give the correct number-of-points in the seg-

ment, such that:

Number-of-Points in the Acceleration List Segment = SEGMENT-WIDTH

× NUMBER-OF-STEPS in Motion / 360

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

SAMPLING ACCELERATION-DATA - RECOMMENDATIONS.

Acquire acceleration-data of a machine component with an Accelero-

meter Sensor.

· We recommend a DC-Accelerometer Sensor that gives an output from

0 to 1000Hz. 

· From 0Hz is important. At 0Hz, you can turn the accelerometer over to

use ±g (gravity) to calibrate it (g = ~9811mm/s/s).

· Import the data for one machine cycle. You can use an Encoder on a

machine shaft to trigger the start and end the Acceleration Data acquis-

ition.

· You get better results if you sample the data from a Dwell to a Dwell. 

· Although there are mathematical techniques to compensate for any

bias in the Acceleration Data, we do not use them when we integrate

the your Acceleration data to get Velocity and Position.

803 834
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1.6.11.2 Constant Acc and Dec Motion-Law [Parabolic]

Constant-Acceleration and Constant-Deceleration Cam-Law,

Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law .  Its name is often give Constant-Accelera-

tion, or Triangular Velocity.

It has the lowest nominal maximum Constant Acceleration of the Dwell-

Rise-Dwell type motion-laws. For this reason, historically, it was recom-

mended for cam motion-design. It is still commonly used for Servo and

Stepper motions.

However, it has many disadvantages - see Application-Notes, below.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY & END VELOCITY 

START ACCELERATION & END ACCELERATION 

START JERK & END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

START-RANGE 

END- RANGE

0 START-RANGE < END-RANGE 1

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755
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Constant-Acceleration - Constant-Deceleration Motion-Law -

Parabolic Motion (Cam-Law)

Motion-Law Coefficients

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

The Constant-Acceleration motion-law was used in the past because it has

the lowest nominal acceleration of the Traditional Motion-Laws. However,

it has infinite-jerk at three points: at its start, end, and at its crossover. This

makes it a very poor choice form a dynamic-response viewpoint. Infinite-

Jerk incites vibrations in any mechanical system. We do not recommend

this motion-law if the Period-Ratio is less than 10, or even 20.

Dynamic Performance

The actual acceleration of a payload is significantly more than the

nominal Constant-Acceleration value because of induced vibrations. For

this reason, this motion-law should only be used in applications where

inertia effects are insignificant.

Pressure-Angle Considerations

This motion-law produces a relatively large pressure-angle - and so

might need a large cam for a given lift. The pressure-angle for this mo-
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tion-l varies quite severely throughout this Motion-Law indicating that

it is unsuitable for roller follower applications because of the severe ac-

celerations imposed on the roller that induce roller slip.

Drive-Torques

This law performs badly in terms of drive torque considerations. This

law has a discontinuity in Drive Torque, indicating shock loading and

noise in operation. Particularly notable is the sudden reversal of the in-

ertia torque factor, and hence of the torsional strain energy, at the cros-

sover of the motion segment. These reversals contribute to noise, shock

loading, and vibration during operation.
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1.6.11.3 Constant-Velocity

Constant-Velocity Cam-Law, Motion-Law

This is a Polynomial motion type.

See also : Constant-Velocity: Two Positions .

MOTION-DESCRIPTION

The Velocity is constant for the period of the SEGMENT-WIDTH. 

MOTION-VALUES

You CAN control the:

START-POSITION 

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

START-VELOCITY 

The START-VELOCITY usually flows from the END-VELOCITY of the PREVI-

OUS-SEGMENT 

You CANNOT control the:

END-POSITION 

The END-POSITION is a calculated from the START-POSITION, START-VELO-

CITY, and SEGMENT-WIDTH

END-VELOCITY 

The END-VELOCITY is equal to its START-VELOCITY

START ACCELERATION = END-ACCELERATION = 0

START-JERK = END-JERK = 0

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

Example - VELOCITY CONTINUITY

1. Use the Motion-Law Selector  to change the motion-law of a segment

to a CONSTANT-VELOCITY.

2. Click above or below the segment in the motion-graphs.

The CONSTANT-VELOCITY segment is now the SELECTED-SEGMENT.

3. Open the BLEND-POINT EDITOR

1. Set the Match Control Button to Flow / Match - see image 

The Velocity at the Start of the Selected-Segment is now forced to be

equal to the Velocity at the End of the Previous-Segment.

765
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741
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The Start Velocity becomes read-only.

2. Edit the End Velocity  

You should see that the Start-Velocity  is equal to the End-Velocity.

Blend-Point Editor: Velocity Equal at Blend-Point.

Smooth Flow of Velocity at Blend-Point

Equal Gradients of Position Graph at Blend-Point

Example 2 - VELOCITY DIS-CONTINUITY

Definition of a Motion Dis-continuity: 

The motion-values change instantly, such that there is a step between two adja-

cent motion-values. The motion-discontinuity is associated with a motion-deriv-

ative. E.g. A motion has a Velocity discontinuity

A Velocity discontinuity is NOT recommended, of course. There is infinite ac-

celeration at the Velocity discontinuity - which is mechanically not possible.

A Velocity discontinuity puts a kink in the Position graph.

An example of a Velocity Dis-Continuity.

1. Use the Motion-Law Selector  to change a motion-law of a segment to

a CONSTANT-VELOCITY.

741
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2. Click above or below the segment in the motion-graphs.

The CONSTANT-VELOCITY segment is now the SELECTED-SEGMENT.

3. Open the BLEND-POINT EDITOR

4. Set the MATCH CONTROL-BUTTON to DO NOT MATCH

5. Enter a START-VELOCITY  value that is not equal to the END-VE-

LOCITY  value.

Blend-Point Editor: Velocities at Blend-Point are not Equal

Step in Velocity Graph, & Kink(corner) in Position Graph.

Step in gradient at Blend-Point in Position-Graph.
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1.6.11.4 Constant-Velocity : Two Positions

Constant-Velocity | Two Position

See also : Constant-Velocity .

MOTION-DESCRIPTION

Use the Flexible-Polynomial to define a segment that has Constant-Velo-

city between Two-Positions.

The Velocity is calculated from the SEGMENT-WIDTH and the difference

between the END-POSITION and START-POSITION.

You must make sure the Velocity at the end of the PREVIOUS-SEGMENT is

equal to the velocity of this segment.

The Acceleration and Jerk Values at the start and end of the segment are

zero.

MOTION-VALUES

You CAN control the:

START-POSITION 

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END-POSITION

You CANNOT control the:

START-VELOCITY & END-VELOCITY

START-ACCELERATION & END-ACCELERATION

START-JERK & END-JERK

SEGMENT EDITOR: Control-Buttons for a 'Two Position |

Constant-Velocity motion-law.

1. Use the Motion-Law Selector  to select a Flexible-Polynomial

motion-law 

2. Select the Segment 

3. Open the SEGMENT EDITOR

762
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4. Deselect MATCH-VELOCITY, MATCH-ACCELERATION, and MATCH-

JERK (FLOW) Control-Buttons

5. Deselect START VELOCITY, START ACCELERATION, and START JERK

 Control-Buttons

6. Deselect END-VELOCITY, END-ACCELERATION, AND END-JERK

Control-Buttons

7. Edit the START-POSITION and END-POSITION values

8. Edit the X-AXIS values.

2 Position, Constant-Velocity

BUT Step Change in Velocity

Note: 

When the Constant-Velocity segment is one segment of a complete ma-

chine-cycle use a GEARING FB, to replace a MOTION FB  - assuming a LIN-

EAR-MOTION FB is connected to the input of the GEARING FB.

When GEARING-RATIO = 1 (in the GEARING FB DIALOG), the output equals

its input, it increases steadily from 0 to 360.

If, for example, you enter GEARING RATIO = 270/360, the output increases

steadily from 0 to 270, when its input increases steadily 0 to 360.

Thus, you can see it is easy to use a GEARING FB to output a Constant-Velo-

city for a complete a machine-cycle. 
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1.6.11.5 Cubic Motion-Law

Cubic Cam-Law, Motion-Law

MOTION-DESCRIPTION

A Traditional Motion-Law . The Jerk motion-values of this motion-law

are constant.

Use it when you want the Jerk to be a constant value, or the Acceleration to

change linearly.

When the Velocity at its start and end are equal zero, it is the same as the

Polynomial 2-3 .

MOTION-VALUES

You CAN control the:

START POSITION

The START POSITION usually flows from the END POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

START VELOCITY

The START VELOCITY usually flows from the END VELOCITY of the PREVI-

OUS-SEGMENT

END VELOCITY

You CANNOT control the:

START ACCELERATION & END ACCELERATION 

START JERK & END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

755
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Cubic Motion-Law
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1.6.11.6 Cycloidal Motion-Law

Cycloidal Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law . 

A motion with continuous Velocity and Acceleration from start to end.

There is a Jerk discontinuity at its start and end.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY & END VELOCITY 

START ACCELERATION & END ACCELERATION 

START JERK & END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

START-RANGE

END-RANGE

0   START-RANGE < END-RANGE 1

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755
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Cycloidal Motion-Law (Cam-Law)

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

Dynamic Performance

This Motion-Law is recommended in applications where the period ra-

tio is near to 5, but the input drive is stiff and the shaft speed does not

fluctuate significantly under load. It has a good acceleration character-

istics at the load and should be used in systems where low residual vi-

bration (vibration after the end of the motion segment) is desired.

Pressure Angle Considerations

It gives a relatively large pressure angle - and so might need a large

cam for a given lift and predetermined pressure angle limits, to reduce

it. 

Drive Torques

This Motion-Law is recommended in applications where no sudden

change of input torque is a requirement. Its torque characteristics are
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particularly good in relation to the other Traditional Motion-Laws when

the period ratio is less than approximately 10.
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1.6.11.7 Cycloidal-CV50 Motion-Law

Cycloidal-CV50 Cam-Law, Motion-Law

MOTION-DESCRIPTION

A Traditional Motion-Law .  Use the Ramp  Motion-Law to design a

CYCLOIDAL-CV50.

The Cycloidal-CV50 has three phases:

· Phase 1: Acceleration : first ½ wave of a Sine function : 25% of the

Segment-Width.

· Phase 2: Zero Acceleration, Constant Velocity : 50% of the Segment-

Width.

· Phase 3: Deceleration : last ½ wave of a Sine function : 25% of the
Segment Width

A motion with continuous Velocity and Acceleration, from start to end, The

Jerk is finite at its start and end.

Its peak Acceleration is quite high, but its peak Velocity is quite low.

MOTION-VALUES

You CAN control the:

Select the RAMP Motion-Law  :

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY & END VELOCITY - by definition, they are zero(0)

START ACCELERATION & END ACCELERATION  - by definition, they are zero(0)

START JERK & END JERK  - by definition, they are finite

SEGMENT PARAMETERS

The SEGMENT-PARAMETER values in the Ramp  motion-law to give the

Cycloidal CV50 motion-law.

START-FRACTION × 100 = % of SEGMENT-WIDTH 

END-FRACTION × 100 = % of SEGMENT-WIDTH

SEGMENT-RANGE

START-RANGE 

END- RANGE

755 808

808

808



773

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

0 START-RANGE < END-RANGE 1

Cycloidal-CV50 (50% is Constant-Velocity (with Ramp

Motion-Law / Cam-Law

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES:

Dynamic Performance

The Cycloidal CV50 Motion-Law is recommended in applications

where you need the peak velocity to be low when compared to others.

It has a large Peak Acceleration, with a short duration, thus more likely

to induce vibrations.

Pressure Angle Considerations

It gives a relatively low pressure angle - because of its low peak velo-

city.

Drive Torques
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This Motion-Law is not recommended in many applications as it gives a

sudden change in torque. The input transmission rigidity would need to

be high.
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1.6.11.8 Dwell Motion-Law

Dwell Cam-Law, Motion-Law

MOTION DESCRIPTION

Dwell is a Traditional Motion-Law . It is a Polynomial Motion-Law.

The DWELL motion-law has a constant POSITION, or zero displacement.

By definition, its motion-values for VELOCITY, ACCELERATION, and JERK are

zero throughout the SEGMENT-WIDTH.

MOTION-VALUES

You CAN control the:

START POSITION 

The START POSITION usually flows from the POSITION at the end of the

PREVIOUS-SEGMENT 

You CANNOT control the:

END POSITION - by definition, it is equal to the Position at its Start

START VELOCITY & END VELOCITY - by definition, they are zero(0)

START ACCELERATION & END ACCELERATION  - by definition, they are zero(0)

START JERK & END JERK  - by definition, they are zero(0)

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

APPLICATION NOTES:

Use a Dwell when you want a tool to be stationary.

However, Dwell segments are used too frequently.  Why?

The other segments become shorter in duration, and their peak accelera-

tions also increase. Shorter segment are more likely to induce vibration in

the mechanism. The Peak Torque of the drive-shaft also increases, and re-

verses from a positive to a negative torque more rapidly. This can lead to

wind-up and over-run of the drive-shaft. 

TOP-TIP

Try not to use a Dwell segment unless you need a tool to be absolutely sta-

tionary for at least 20° range of the X-axis. 

If the dwell is less than 20°, then. as an alternative, try to delete the Dwell

segment. Then, use segments that are before and after the 'dwell' that have

zero jerk-values at the Blend-Point that replaces the Dwell segment.

755
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1.6.11.9 Flexible-Polynomial Motion-Law

Flexible-Polynomial Cam-Law, Motion-Law

MOTION DESCRIPTION

You can use the FLEXIBLE-POLYNOMIAL motion-law as a segment for

most applications.

For each motion-derivative (P, V, A, J), you can use the BLEND-POINT EDITOR

or the SEGMENT EDITOR to:

· specify the motion-value at the start and/or end of the Flexible-

Polynomial segment.

· not specify the motion-value at the start and/or end of the Flexible-

Polynomial segment.

· match / force the motion-value at the start of the Flexible-Polyno-

mial segment to be equal to the motion-value at the end of the
PREVIOUS-SEGMENT

You can use the Flexible-Polynomial to emulate a motion-law that is

based on the other Polynomial Functions, which are:

· Dwell , Constant-Velocity , Cubic , Quadratic , Throw ,

Poly 345  and Poly 4567  motion-laws.

See Tutorial: Introduction to the Flexible-Polynomial Motion-Law.

MOTION-VALUES 

You CAN control the:

START POSITION and END POSITION

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION

START JERK and END JERK

You CANNOT control the:

None

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

775 762 767 806 780
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Flexible-Polynomial 
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1.6.11.10 Throw Motion-Law

The Throw Motion-Law

Unlike other motion-laws, the Throw motion-law rises AND immediately re-

turns.

To design a Throw motion-law we use two Flexible Polynomial segments.

This provides you with many motion-design options.

Throw motion-laws:

· have zero velocity and acceleration at the start and end, and

· have continuous acceleration at the mid-point, and 

· acceleration is usually not zero at the mid-point.

To give different motion characteristics, you can control the Jerk values at the

start and end of the Rise and Return, and also Jerk continuity at its mid-point.

· Throw Quick-Return 1

· Throw Quick-Return 2

· Throw Rapid-Return 1

· Throw Rapid-Return 2

· Low Impact at Crossover
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1.6.11.10.1  Throw Quick-Return: 1: Finite Jerk @ Start/End Motion-Law

Throw Quick-Return 1 - Finite Jerk at Start and End

Throw Quick-Return 1 - Finite Jerk at Start and End.

This Throw Quick-Return 1 is the classic Rise-Return motion-law. It has a

Quick-Return when compared to two Polynomial 345 segments because it

has a negative acceleration at its maximum displacement - at the transition

from Rise to Return.

Throw Quick Return 1 - Finite-Jerk at Start and End

MOTION-VALUES OF EACH MOTION-DERIVATIVE

Start of rise segment 1 :

· Position = 0

· Velocity = 0

· Acceleration = 0

· Jerk = Unspecified ( Actual value = 320 mm/s/s/s )

Mid-Point :

· Position = 1

· Velocity = 0

· Acceleration = Unspecified ( Actual value = –26.666 mm/s/s )

OR Acceleration = –20 mm/s/s 
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· Jerk = 0

End of return Segment 2 :

· Position = 0

· Velocity =0

· Acceleration = 0

· Jerk = Unspecified ( Actual value = –320 mm/s/s/s )

See also: 

· Throw: Quick Return: Zero Jerk @ Start/End/Mid-Point

· Throw: Rapid Return: Finite Jerk @ Start/End/Mid-Point

· Throw: Rapid Return: Smooth-Start/End

782

784

786
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1.6.11.10.2  Throw Quick-Return: 2: Zero Jerk @ Start/End/Mid-Point

Throw: Quick-Return with Zero Jerk at its Start and End

The Throw Motion-Law

Unlike the other motion-laws, the Throw motion-law rises from its Start-Posi-

tion to its maximum displacement, and then returns to its Start-Position.

Use two Flexible Polynomial segments to design the Throw motion-law.

Usually, the two segments have equal durations, but it is not necessary.

Throw: Quick-Return 1 - Zero Jerk at Start and End.

Because you use two Flexible-Polynomial segments to design the Throw mo-

tion-law, you can enter different motion-values and motion-constraints at its

start, its maximum displacement, and at its end.

All Throw motion-laws have zero velocity and acceleration at their start and

end.

This Throw motion-law also has zero Jerk at its start and end.

This Throw has a Quick-Return because it has a negative acceleration at its

maximum displacement - the transition from Rise to Return.

See also: 

· Throw: Quick Return 1 Finite Jerk @ Start/End/Mid-Point

· Throw: Rapid Return: Finite Jerk @ Start/End/Mid-Point

· Throw: Rapid Return: Smooth-Start/End

Throw: Quick-Return - Zero Jerk at its Start-and End.

780

784

786
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THROW: Quick-Return Zero Jerk Start, Middle, End

MOTION-VALUES OF EACH MOTION-DERIVATIVE

Start of rise segment 1 :

X =0

· Position = 0

· Velocity = 0

· Acceleration = 0

· Jerk = 0

Mid-Point :

X=180 (you can move the X-axis value of the mid-point)

· Position = 1

· Velocity = 0

· Acceleration = Unspecified (Actual value = -40.0mm/s/s )

· Jerk = 0

End of return Segment 2 :

X=360

· Position 2 = 0

· Velocity  = 0

· Acceleration = 0

· Jerk = 0
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1.6.11.10.3  Throw Rapid-Return 1: Finite-Jerk @ Start/End/Mid-Point Motion-Law

Throw: Rapid-Return Finite Jerk

The Throw Motion-Law

Unlike other motion-laws, the Throw motion-law rises from its Start-Position

to its maximum displacement, and then returns to its Start-Position.

To give you maximum flexibility, use two Flexible Polynomial segments to

design the Throw motion-law. Usually, the two segments have equal dura-

tions, but it is not necessary.

Throw: Rapid-Return 1 - Zero Jerk at Start and End.

Because you use two Flexible-Polynomial segments to design the Throw mo-

tion-law, you can enter different motion-values and motion-constraints at its

start, its maximum displacement, and at its end.

This Throw has a Quick-Return because it has a LARGE negative acceleration,

and unspecified Jerk, at its maximum displacement - the transition from Rise

to Return.

See also: 

· Quick Return 1: Finite Jerk @ Start/End/Mid-Point

· Quick Return 2: Zero Jerk @ Start/End/Mid-Point

· Rapid Return 2: Smooth-Start/End

Two Segment 'Rapid-Return Motion 1

780

782

786
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MOTION-VALUES OF

EACH MOTION-DERIV-

ATIVE

Start of Rise segment 1

:

· Position = 0

· Velocity = 0

· Acceleration = 0

· Jerk = Unspe-

cified ( Actual

value =

260.6m/s/s/s )

Middle Blend-Point *:

· Position = 1

· Velocity = 0

· Acceleration =

Unspecified

(  Actual value =

-58.84mm/s/s )

· Jerk = Unspe-

cified ( Actual

value =

±521.167mm/s/s/

s )

End of Return segment

2 :

· Position 2 = 0

· Velocity = 0

· Acceleration = 0

· Jerk = Unspe-

cified ( Actual

value = -

260.6mm/s/s/s )

* Edit the X-axis value

of the middle Blend-

Point to give an asym-

metrical motion.
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1.6.11.10.4  Throw Rapid-Return 2: Zero-Jerk @ Start/End Motion-Law, Finite at
Mid-Point

Throw: Rapid-Return with Zero Jerk

The Throw Motion-Law

Unlike other motion-laws, the Throw motion-law rises from its Start-Position

to its maximum displacement, and then returns to its Start-Position.

To give you maximum flexibility, use two Flexible Polynomial segments to

design the Throw motion-law. Usually, the two segments have equal dura-

tions, but it is not necessary.

Throw: Rapid-Return 2 - Zero Jerk at Start and End, unspecified at its

mid-point.

Because you use two Flexible-Polynomial segments to design the Throw mo-

tion-law, you can enter different motion-values and motion-constraints at its

start, its maximum displacement, and at its end.

All Throw motion-laws have zero velocity and acceleration at their start and

end.

This Throw motion-law also has zero Jerk at its start and end.

This Throw has a Quick-Return because it has a LARGE negative acceleration,

and unspecified Jerk, at its maximum displacement - the transition from Rise

to Return.

The Throw type motion-law it typically symmetrical. You can make it asym-

metrical, if you move the X-axis value at its mid-point. 

See also: 

· Throw Quick Return 1: Finite Jerk @ Start/End/Mid-Point

· Throw Quick Return 2: Zero Jerk @ Start/End/Mid-Point

· Throw Rapid Return 1: Finite-Jerk @ Start/End/Mid-Point

Two Segment 'Rapid-Return with Zero Jerk at Start/End,  2'

780

782

784
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MOTION-VALUES OF

EACH MOTION-DERIV-

ATIVE

Start of rise segment 1 :

· Position = 0

· Velocity = 0

· Acceleration = 0

· Jerk = 0

Mid-Point :

· Position = 1

· Velocity = 0

· Acceleration =

Unspecified (Ac-

tual value = -

98.mm/s/s )

· Jerk = Unspe-

cified (Actual

value =

±1303mm/s/s/s )

End of return Segment

2 :

· Position 2 = 0

· Velocity = 0

· Acceleration = 0

· Jerk = 0 
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1.6.11.11 Low Impact Crossover Motion-Law

Low Impact at Crossover.

Impact, Overrun, and Crossover.

Crossover is the timing at which acceleration becomes a deceleration, and

vice versa.

At crossover, machine components traverse backlash to impact with each

other. 

As the Torque reverses, the application inertia may drive the motor. The mo-

tor may accelerate so that, for a short period, the motor rotates faster than

intended. This is called overrun. As a result, the velocity and acceleration of

the Follower may also be greater than intended.

A motion-law with Low Jerk at Crossover means the acceleration changes

less rapidly at crossover - which means the Jerk is low at crossover. As the ac-

celeration is low for a longer period, the velocity changes less rapidly, to re-

duce Impacts and Overrun.

Low Impact at Crossover.

Low or Zero Impact at Crossover motion-law is not available in the Motion-

Law Selector . Use two Flexible Polynomial motion-laws.

Velocity and Acceleration are zero at the start and end.

Acceleration and Jerk are zero at the mid-point.

The Low Impact at Crossover is typically symmetrical. You can make it asym-

metrical if you move the X-axis and the Position at the mid-point. The max-

imum Velocity should not change, but the maximum Acceleration and Jerk

values increase. 

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

Two Flexible Polynomial segments to give Low Jerk at Crossover mo-

tion-law.

741
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Low Jerk at Crossover (with two Flexible-Polynomial Segments)

MOTION-VALUES OF

EACH MOTION-DE-

RIVATIVE - Normal-

ized values

Start of rise segment 1

:

X = 0 ( 0º )

· Position = 0

· Velocity = 0

· Acceleration =

0

· Jerk = Unspe-

cified  ( Actual

value = 80

mm//s/s/s )

Mid-Point :

X = 0.5 (180º ) 

· Position = 0.5

· Velocity = Un-

specified ( Ac-

tual value =

1.6667 mm/s )

· Acceleration =

0

· Jerk = 0

End of return Seg-

ment 2 :

X = 1 ( 360º )

· Position = 1

· Velocity = 0

· Acceleration =

0

· Jerk = Unspe-

cified  ( Actual

value = 80

mm//s/s/s )
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1.6.11.12 Modified-Sinusoid Motion-Law

Modified-Sinusoid Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law . Its name is often reduced to Mod-Sine.

A motion with continuous Velocity and Acceleration, from start to end. The

Jerk is finite at its start and end.

MOTION-VALUES

You CAN control the:

START POSITION -

 The START POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT 

END POSITION 

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

START-RANGE 

END- RANGE

0 START-RANGE < END-RANGE 1

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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Modified-Sinusoid Cam-Law / Motion-Law

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

The Modified Sinusoid motion-law has finite jerk throughout the segment. 

It has an relatively low peak velocity, but a relatively high value of the

nominal acceleration.

Dynamic Performance

This Motion-Law is a good general purpose type particularly in applica-

tions where the period ratio is between 5 and 10, particularly if the in-

put drive is flexible or it has backlash. It performs well with respect to

residual vibration after the segment is complete.

Pressure Angle Considerations

This one of the Traditional Motion-Laws that produce a relatively small

pressure angle, and so a small cam for a given lift and pre-prescribed

maximum pressure angle. 

Drive Torques
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The nominal drive torque characteristics and the actual torque values

are low even for low values of Period Ratio are good for this motion-

law. The low peak values and the smooth variation of drive torque dur-

ing the motion-law further emphasize the suitability of this motion-law

where the input drive is flexible or has backlash.

More information:

The Acceleration function is a series of Sinusoid functions.

· a ¼ Sine wave function, starting from zero acceleration, for 12.5% of

the SEGMENT-WIDTH. 

· a ½ Cosine function, for 75% the SEGMENT-WIDTH

· a ¼ Sine wave function, returning to zero acceleration, for 12.5% of the
SEGMENT-WIDTH.
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1.6.11.13 Modified-Trapezoidal Motion-Law

Modified-Trapezoid Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law . Its name is often reduced to Mod-Trap.

A motion with continuous Velocity and Acceleration, from start to end. The

Jerk is finite at its start and end. Its peak acceleration is moderate.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

START-RANGE 

END- RANGE

0 START-RANGE < END-RANGE 1

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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Modified Trapezoid Cam-Law / Motion-Law

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

The Modified Trapezoidal motion-law has finite jerk throughout the seg-

ment. 

It has an average peak nominal acceleration compared to the other Tradi-

tional Motion-Laws. 

Dynamic Performance

This Motion-Law is a good general purpose type particularly in applica-

tions where the period ratio is above about 5. 

It is not good in applications where the input drive has backlash or is re-

latively flexible. As long as the drive satisfies these conditions, then this

segment exhibits low residual vibrations.

Pressure Angle Considerations

This is one of the Traditional Motion-Laws that produce a relatively

large pressure angle - and so might need a large cam for a given lift

and pre-prescribed maximum pressure angle. 
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Drive Torques

This Motion-Law exhibits a rapid reversal of inertia torque at the cros-

sover (mid) point. 

Only the Constant-Acceleration Motion-Law is more rapid, of the Tradi-

tional Segments. It is unsuitable to drive heavy masses at high speeds

(even though the maximum acceleration is low). The rapid reversal of

torque may give rise to severe vibrations and shock loading especially

if the period ratio is less than 10. 

More information:

The acceleration function of the Modified-Trapezoidal is:

· 0.125 of SEGMENT-WIDTH - 1/4 Sine function

· 0.250 of SEGMENT-WIDTH - Constant-Acceleration

· 0.250 of SEGMENT-WIDTH - 1/2 Cosine function

· 0.250 of SEGMENT-WIDTH - Constant-Acceleration

· 0.125 of SEGMENT-WIDTH - 1/4 Sine function
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1.6.11.14 Polynomial 2-3 Motion-Law

Polynomial 2-3 Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law .  Its name is often reduced to Parabolic Velo-

city, or Poly 23.45.

A motion with continuous Velocity, from start to end. 

There are large Acceleration-Discontinuities, with infinite jerk, at its start

and end.

It gives a low peak velocity, but a high peak Acceleration. 

It has a low Jerk value at the crossover point (the mid-point).

Its Torque characteristic is very good.

MOTION-VALUES

Use the Control-Buttons and the Flexible Polynomial motion-law

Flexible-Polynomial Control-Buttons for POLYNOMIAL 2-3

Edit the START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

Edit the END POSITION 

Use the Control-Buttons to force the START-VELOCITY and END-VELOCITY to

Zero (units/s)

Deselect the START-ACCELERATION, END-ACCELERATION, START-JERK, and

END-JERK Control-Buttons.

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

755
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See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law

See also :  Tutorial 9: Asymmetrical Motions

Polynomial 2-3

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

Dynamic Performance:

This Motion-Law is not recommended for applications where the

period-ratio < 10, 

There are large Acceleration-Discontinuities, with infinite Jerk, at its

start and end. 

Pressure Angle Considerations

This is a Traditional Motion-Law that produces a relatively low pressure

angle

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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Drive Torques

The torque characteristics of this motion law are good compared to

other traditional motion-laws, when. 
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1.6.11.15 Polynomial 3-4-5 Motion-Law

Polynomial 3-4-5 Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law .  Its name is often reduced to Poly-345.

A motion with continuous Velocity and Acceleration, from start to end. The

Jerk is finite at its start and end. It has finite Jerk throughout. 

It gives a relatively low nominal peak velocity, but a relatively high peak

nominal Acceleration. It has a relatively low Jerk value at the crossover

point (the mid-point). It is commonly used in high-speed mechanisms. 

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law

See also :  Tutorial 9: Asymmetrical Motions

755

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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Polynomial 3-4-5 Motion-Law / Cam-Law

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

Dynamic Performance:

This Motion-Law is recommended for applications where the period ra-

tio is less than 10, particularly where the input drive is stiff and the shaft

speed does not fluctuate significantly under load.

It has good acceleration characteristics and is suitable for applications

that need low levels of residual vibration.

Pressure Angle Considerations

This is a Traditional Motion-Law that produces a relatively large pres-

sure angle - and so might need a larger cam for a given lift and pre-

prescribed maximum pressure angle. 

Drive Torques

The torque characteristics of this motion law are good compared to

other traditional motion-laws, when the period ratio is less than 10. IT is

recommended when no sudden change in torque is allowed.
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1.6.11.16 Polynomial 4-5-6-7 Motion-Law

Polynomial 4-5-6-7 Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law .  Its name is often reduced to Poly-4567.

A motion with continuous Velocity and Acceleration, from start to end. The

Jerk is finite at its start and end. It has finite Jerk throughout. 

It has a high maximum-velocity, high maximum-acceleration, high cros-

sover jerk. Only the MODIFIED-TRAPEZOIDAL (of those with finite Jerk) has

a greater crossover jerk.

At its start and end, the Y-axis values do not change much with a signific-

ant X–axis change - e.g. 0.02% Y-axis with 5% X-axis change. 

Therefore, a cam needs accurate machine if it is to reproduce this segment.

A larger cam often helps, or an encoder with a high resolution.

If possible, increase the SEGMENT-WIDTH  to reduce its maximum Velo-

city, Acceleration and Jerk values.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755
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Polynomial 4-5-6-7 Motion-Law / Cam-Law

Motion-Law Coefficients

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

Dynamic Performance: 

This Motion-Law is recommended in applications where the period ra-

tio is between about 5 and 10. It has a low residual vibration. However,

the high peak acceleration means every effort should be made to in-

crease the duration of the segment.

Pressure Angle Considerations

This has a relatively large maximum-acceleration and maximum velo-

city, which increase the maximum pressure-angle.

Drive Torques

It has a high peak torque.



803

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

1.6.11.17 Position List [Import Data]

Import Data: Position List

The POSITION LIST is a List Segment-Type.

The POSITION-LIST is a segment that uses the Data Transfer Table to import your

data as the motion-values.

Other List Segment-Types are Z-Raw-Data  and Acceleration-List

STEP   1. Add a new Motion

Add New Motion

See also Add Motion

STEP   2. Delete Segments

Usually, the data you want to import is for one motion cycle. 

In that case, you need one segment in the motion.

1. Delete three segments from the default motion-law. 

See Delete Segment

STEP   3. Change the Motion-Law of the segment to Position-List 

In the Motion-Law Selector :

1. Select POSITION LIST 

STEP   4. Import your motion-values (data) into the Data Transfer Table  

1. Open the Data Transfer Table

2. Click the cell in the first row and left column of the Data Transfer

Table to make it the active cell.

To transfer data from a data file:

3a : Copy & Paste data from your clipboard into the Data Transfer Table

OR 

3a : Use the toolbar icon Load Data from a CSV or TXT file-type  

OR

3a : Get all displayed P, V- A J Segment-Data  or Get all displayed P, V ,

A, J Motion Data  from a different Motion name-tab.

Motion-values (data) are now in the Data Transfer Table.

STEP   5. Transfer the data from the Data Transfer Table to a Position List seg-

ment-type.

To transfer all of the data:

1. Select the Position motion-values in the Data Transfer Table

834 758

723

719

741

744

747

751

750
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To select the data, you can click the header in the Data Transfer

Table with the Position motion-values.

2. Click Put Data   in the Data Transfer Table toolbar. 

Data Transfer Table toolbar

Note : The GET DATA and PUT DATA icons show only when the seg-

ment is a List Segment-Type.

OR

To transfer a section of the data:

1. CLICK the first data-point you want to paste 

2. SHIFT+CLICK the last data-point you want to paste

When the cells are active:

3. Click Put List Data   in the Data Transfer Table toolbar. 

Note : GET DATA and PUT DATA icons show only when the segment is a

List Segment-Type. 

STEP   6. SCALE the data.

After you transfer the data, the minimum and maximum values are equal to

the actual values in your data.

However, you can also scale the data.

To scale the data:

If the actual First and Last data points are EQUAL:

Scale-Factor and Position-List

Use when First = Last data point.

1. Open the SEGMENT EDITOR 

2. Expand  SEGMENT PARAMETERS 

3. Edit the Scale Factor parameter.

Notes:

If required, to see the SEGMENT PARAMETERS, expand and collapse

the SEGMENT MOTION-LAW  .

A SCALE FACTOR = 1 scales the data to the actual minimum and max-

imum values.

750

750
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You can edit the START POSITION to offset the data on the Y-axis

You can edit the MOTION-START (BLEND-POINT EDITOR, only) value to

move the data along the X-axis.

The Velocity, Acceleration and Jerk values scale automatically.

If the actual First and Last data points are NOT EQUAL

SEGMENT EDITOR : Start and End Positions of a

Position-List segment

1. Start the SEGMENT EDITOR or BLEND-POINT-EDITOR 

2. Edit the START-POSITION and END-POSITION
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1.6.11.18 Quadratic Motion-Law

Quadratic Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law . This is a Polynomial motion-law.

The Velocity increases or decreases linearly.

Acceleration is constant, but it is discontinuous at its start and end.

Jerk is generally zero, but has infinite Jerk at its start and end.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

START VELOCITY

You CANNOT control the:

END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

755
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Quadratic Motion-Law

In the image above of 1 Quadratic segment, the motion-values are:

· START POSITION = 0mm

· END POSITION = 1mm

· START VELOCITY = 0mm/s

APPLICATIONS

Segments with Constant Acceleration, Linearly Increasing-Velocity, or Lin-

early Decreasing Velocity.

You can use this to model a Part under the influence of a Constant-Acceler-

ation, or a constant force or torque.
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1.6.11.19 Ramp Motion-Law

Ramp Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law . 

The Ramp motion-law has three phases:

Phase 1: Acceleration : first ½ wave of a Sine function (see Segment-Para-

meters)

Phase 2: Zero Acceleration : Constant Velocity

Phase 3: Deceleration : last ½ wave of a Sine function : (see Segment-

Parameters)

You can design an Asymmetric Segment, in which the Phase 1 is longer or

shorter than Phase 2.

Velocity and Acceleration are continuous from start to end. 

Jerk is finite but discontinuous at the start and end of Phase 1 and of Phase

3.

MOTION-VALUES

You CAN control the:

START-POSITION  

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END-POSITION

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

START-FRACTION × 100 = % of SEGMENT-WIDTH to accelerate from zero-

velocity* to maximum-velocity

END-FRACTION × 100 = % of SEGMENT-WIDTH to decelerate from max-

imum-velocity to zero-velocity**

START-FRACTION + END FRACTION  1

 Constant-Velocity Fraction = 1 – START-FRACTION – END-FRACTION

* if START-RANGE = zero

** if END-RANGE = zero

755
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SEGMENT-RANGE

START-RANGE 

END- RANGE

0   START-RANGE < END-RANGE 1

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law

See also :  Tutorial 9: Asymmetrical Motions

1 x Ramp Segment, Symmetrical

Applications

Asymmetric Segments, in which the Acceleration phase is longer or shorter

than the Deceleration phase.

Motion with a long displacement, in which the maximum-velocity is less

than other motion-laws.

Asymmetrical Example (see image below)

· START-FRACTION END-FRACTION 

· START-FRACTION = 0.7

· END-FRACTION = 0.3

· START-FRACTION + END-FRACTION = 1 

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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 CONSTANT-VELOCITY % = 0%

E.g.: RAMP Segment: Start-Fraction = 0.7, End-Fraction = 0.3

(Constant-Velocity Fraction = 0)
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1.6.11.20 Simple-Harmonic Motion-Law

Simple Harmonic Motion Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law .

This Motion-Law has the lowest maximum velocity of all the Traditional

Motion-Laws. However, it also produces infinite jerk at its start and end. 

This makes it a poor choice form a dynamic viewpoint if you use it

between Dwell segments in a Dwell-Rise-Dwell type motion.. However,

you can usefully apply it between Flexible-Polynomial segments, with

which it is possible to remove the acceleration discontinuities at its start

and end.

MOTION-VALUES

You CAN control the:

START-POSITION 

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END-POSITION

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755

712

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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Simple-Harmonic-Motion Motion-Law

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coeffi-

cient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

Dynamic Performance:

This law should be used in applications where inertia loading is not very

significant. When Period-Ratio is less than 10, this law will give shock

loading, noise, and vibration during operation.

The actual acceleration at the load being driven by this Motion-Law is

always more than the nominal value, and for this reason, this segment

should only be used in mechanical applications where inertia effects

are insignificant.

Pressure Angle Considerations:

This is one of the Traditional Motion-Laws that produce a relatively

small pressure angle - and so might allow a smaller cam for a given lift.



813

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

OR for a given limit to Pressure-Angle, this motion-law can give a smal-

ler cam, and/or a shorter motion segment.

Drive Torques:

When considering drive torques in isolation, the nominal torque for this

Motion-Law is the best of Traditional Motion-Laws - it has both the

lowest value and the smoothest variation throughout the segment.

However, the motion discontinuities at its beginning and end cannot be

ignored, as these will lead to shock loading.

For compliant systems of high speed systems (Period Ratio between 2

and 10) the Modified Sine and the Cycloidal  are preferred. 
790 769
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1.6.11.21 Sine-Constant-Cosine (SCCA) Motion-Law

Sine-Constant-Cosine Acceleration (SCCA) Cam-Law, Motion-

Law - a Traditional Motion-Law

MOTION DESCRIPTION

The SEGMENT-PARAMETERS make this motion-law very flexible. It is possible

to get many of the Traditional Motion-Laws that are based on Sine and

Cosine harmonics.

See below: Segment-Parameters for Traditional Motion-Laws . 

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

The SCCA motion-law is a defined by a sequence of trigonometric seg-

ments in acceleration motion-derivative. The motion-law is symmetrical,

thus the sequence is:

From 0.0 X 0.5 of the Segment-Width

a. Sine Fraction 

b. Constant Fraction 

c. Cosine Fraction:

d. Zero Acceleration

From 0.5 X 1 of the Segment-Width

d. Zero Acceleration 

c. Cosine Fraction 

b. Constant Fraction 

a. Sine Fraction 

Example Motion-Law - see image below

a = 0.25 ; 25% : TOTAL SINE ACCELERATION FRACTION

755

816
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b = 0.25 ; 25% : TOTAL CONSTANT ACCELERATION FRACTION

c = 0.25 ; 25% : TOTAL COSINE ACCELERATION FRACTION

  d = 1 – a – b – c = 0.25 ; 25% TOTAL ZERO ACCELERATION FRACTION

Rules for the segment parameters:

SEGMENT-PARAMETERS may be zero, but not all.

SEGMENT-PARAMETERS cannot be negative. 

SEGMENT-RANGE

START-RANGE

END-RANGE

0   START-RANGE < END-RANGE 1

An Example Sine Constant-Cosine Acceleration Law.
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Example motion with Sine-Constant-Cosine Motion Law with Segment

Parameters: Sine Fraction a=0.25, Constant b=0.25, Cosine Fraction c=0.25

Segment Parameters to give other Traditional Motion-Laws.

MOTION-LAW: 

Coefficients Parameters

Cv Ca a b c

Modified Trapezoidal 2 4.89 0.25 0.5 0.25

'Lazy' Modified

Trapezoidal 
2 4.88 0.333 0.333 0.333

Modified-Sine 1.760 5.5 0.25 0 0.75

Modified-Sine CV 20% 1.528 5.999  0.2 0 0.6

Modified-Sine CV 33% 1.404 6.616  0.1667 0 0.5

Modified-Sine CV 50% 1.275 8.0127 0.125 0 0.375
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Modified-Sine CV 66% 1.168 11.009 0.0833 0 0.25

Cycloidal 2 6.2832 0.5 0 0.5

Cycloidal CV 50% 1.333 8.378 0.25 0 0.25

Constant Acceleration-

Deceleration 
2 4 0 1 0

Trapezoidal Velocity

CV33%
1.5 4.5 0 0.6667 0
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1.6.11.22 Sine-Squared Motion-Law

Sine-Squared Cam-Law, Motion-Law

MOTION DESCRIPTION

A Traditional Motion-Law .

The maximum velocity and maximum acceleration are large when com-

pared with other motion-laws. However, it has zero crossover jerk.

At the start and end of this Motion-Law, the Y-axis does not change very

much with a significant X–axis change. E.g. 0.02% Y-axis after 5% X-axis

change. 

Therefore, to accurately reproduce the Motion-Law, it needs precise ma-

chining, a large cam, or an encoder with a high resolution. If possible, in-

crease the SEGMENT-WIDTH  by ~20% to reduce the maximum Velocity,

Acceleration, and Jerk values.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

None

SEGMENT-RANGE

None

See also :  Tutorial 5: Edit the Start of a Traditional Motion-Law.

See also :  Tutorial 9: Asymmetrical Motions.

755

707

http://mechdesigner.support/index.htm?mt-tutorial-5-edit-start-standard-segment.htm
http://mechdesigner.support/index.htm?tutorial-9-asymmetrical-motions.htm
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Sine-Squared Motion-Law / Cam-Law

MOTION-LAW COEFFICIENTS

Velocity Coefficient : 

Acceleration Coefficient : 

Jerk Coefficient : 

Jerk at Crossover : 

APPLICATION NOTES

Dynamic Performance: 

This Motion-Law is recommended in applications where the period ratio is

greater than 10.

Pressure Angle Considerations

This has a relatively large maximum-acceleration and maximum velocity,

which increases the maximum pressure-angle.

Drive Torques

It has a high peak torque.
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1.6.11.23 Sinusoidal Motion-Law

Sinusoid Cam-Law, Motion-Law

MOTION DESCRIPTION

This is a Traditional Motion-Law .

This motion-law is a Sinusoid or Sine-Wave. The SEGMENT-PARAMETERS can

define the number of Sinusoids, the phase at which the Sinusoid starts, and

the amplitude of the Sinusoid.

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

You CANNOT control the:

END POSITION

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

PHASE - (degrees)

Enter the circular degrees at the start of the segment

NUMBER-OF-CYCLES - (360 degrees / Cycle)

Enter NUMBER-OF-CYCLES

One machine-cycle = 360 of the circular sinusoidal function.

AMPLITUDE

This is the Maximum amplitude of the Sine wave

Amplitude = Peak-to-Peak / 2

SEGMENT-RANGE

START-RANGE

END- RANGE

0 START-RANGE < END-RANGE 1

755
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SINUSOID  segment 

Amplitude =0.5 ; Number of Cycles = 1, Phase = 0
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1.6.11.24 Triple-Harmonic Motion-Law

Triple-Harmonic Motion-Law

MOTION DESCRIPTION

The Triple-Harmonic Motion-Law is a Traditional Motion-Law.

It can approximate the Cycloidal , Modified-Trapezoidal , Modified

Sine , Polynomial 3-4-5  motion-laws by using the SEGMENT-PARA-

METERS

MOTION-VALUES

You CAN control the:

START POSITION

The START-POSITION usually flows from the END-POSITION of the PREVI-

OUS-SEGMENT.

END POSITION 

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

Three Segment-Parameters:

 FIRST HARMONIC

 SECOND HARMONIC

 THIRD HARMONIC (calculated automatically from FIRST HARMONIC

and SECOND HARMONIC)

SEGMENT-RANGE

START-RANGE

END- RANGE

0 START-RANGE < END-RANGE 1

769 793

790 799
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TRIPLE HARMONIC

1st Harmonic = 4.983 ; 2nd Harmonic = 2.6 ; 3rd Harmonic = 0

Triple Harmonic as Approximate Motion-Laws

Cycloidal

Parameter 1 (First Harmonic): 

Parameter 2 (Second Harmonic): 0.0

Parameter 3 (Third Harmonic): 0.0

Modified Trapezoidal

Parameter 1 (First Harmonic): 6.04

Parameter 2 (Second Harmonic): 0.0

Parameter 3 (Third Harmonic): 0.73

Modified Sine

Parameter 1 (First Harmonic): 5.1968

Parameter 2 (Second Harmonic): 1.769

Parameter 3 (Third Harmonic): 0.6057

Polynomial 3-4-5
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Parameter 1 (First Harmonic): 5.9

Parameter 2 (Second Harmonic): 0.704

Parameter 3 (Third Harmonic): 0.9

Triple Harmonic and other Motion-Laws

Zero-Jerk at Start, End and Cross-over

Parameter 1 (First Harmonic): 

Parameter 2 (Second Harmonic): 0.0

Parameter 3 (Third Harmonic): 

Zero-Jerk at Cross-over

Parameter 1 (First Harmonic): 4.9832

Parameter 2 (Second Harmonic): 2.6

Parameter 3 (Third Harmonic): 0.0

Zero-Jounce* at Start

Parameter 1 (First Harmonic): 7.79

Parameter 2 (Second Harmonic): -2.29

Parameter 3 (Third Harmonic): -1.08

* Jounce is a term used for rate-of-change of Jerk. 
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1.6.11.24.1  Triple-Harmonic: Modified Sine Motion-Law

Triple-Harmonic: Approximate Modified Sine

This motion is approximately equal to the Modified-Sinusoid  motion-law.

1. Select the TRIPLE HARMONIC in the Motion-Law Selector  

2. Open the SEGMENT EDITOR .

3. Edit the SEGMENT PARAMETERS :

· FIRST HARMONIC = 5.1968

· SECOND HARMONIC = 1.7690

· THIRD HARMONIC = 0.6057

We calculate the THIRD HARMONIC for you/

SEGMENT-PARAMETERS

Segment-Parameters that approximate the Modified Sinusoid

motion-law.

790

741

704

715
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Pseudo Modified-Sinusoid motion-law from 3 Harmonics.

Summary

This motion-law is continuous and symmetrical.

It is near to the traditional Modified Sinusoid Cam-Law . 

However, because it has only three harmonics, it is smoother at the higher deriv-

atives.

The maximum velocity is slightly lower and the nominal acceleration is slightly

higher than the Modified-Sinusoid motion law.

1.6.11.24.2  Triple-Harmonic: Modified Trapezoidal Motion-Law

Triple-Harmonic: Approximate Modified Trapezoidal

This motion is approximately equal to the Modified-Trapezoidal  motion-law.

1. Select the TRIPLE HARMONIC in the Motion-Law Selector  

2. Open the SEGMENT EDITOR.

3. Edit the SEGMENT PARAMETERS :

· FIRST HARMONIC = 6.04 (optionally 5.96)

790

793

741

715
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· SECOND HARMONIC = 0.0

· THIRD HARMONIC = 0.7296 (optionally 0.9696)

We calculate the THIRD HARMONIC for you.

SEGMENT-PARAMETERS: 

Segment-Parameters that approximate the Modified Trapezoid

motion-law

Pseudo Modified-Trapezoid motion-law from 3 Harmonics.

Summary

This law is continuous to Acceleration.

The output motion is near to the traditional Modified Trapezoidal Acceleration

Cam-Law . However, it can be described by one mathematical function.

The maximum velocity is the same as the traditional law, but the nominal accel-

eration is slighter greater.

793
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1.6.11.24.3  Triple-Harmonic: Zero-Jerk-at-Crossover Motion-Law

Triple-Harmonic: 'Approximate Zero-Jerk at Crossover'

Crossover : the point at which the Acceleration changes to Deceleration, or

vice-versa

When Jerk is zero as the acceleration changes from a positive value to a negat-

ive value, we say the Motion-Law has Zero Jerk at Crossover. Acceleration

changes slowly.

When acceleration changes slowly, and it is also near to zero, the velocity also

changes slowly. 

If there is backlash in the mechanical transmission between the follower and the

tool, then backlash is traversed as the force changes from a positive action to a

negative action. Since the velocity happens to be changing slowly, the impact

velocity should also be small, with this motion-law. 

Note: the Force changes when the total force on the mechanical element

changes sign. The force in the system is not only a function of the Motion-Law.

The Force may also include: constant, spring, damping and other forces).

To use this Motion-Law:

1. Select Triple Harmonic

2. Open the SEGMENT EDITOR.

3. Edit the SEGMENT PARAMETERS :

FIRST HARMONIC =

SECOND HARMONIC = 0.0

THIRD HARMONIC = 

We calculate the THIRD HARMONIC for you.

SEGMENT PARAMETERS

Harmonic Settings that give an Acceleration with Zero Jerk at

Crossover

715
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Pseudo Zero Jerk at Start, End and at Crossover from 3 Harmonics.
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1.6.11.25 Y-Inverse-Sinusoid [Special]

Y–Inverse-Sinusoid

Note: The Y-Inverse-Sinusoid motion-law is usually applied to a rotating part,

e.g. a Crank. There can be only one Y-Inverse-Sinusoid segment in each motion. 

See also : Constant Crank Velocity

MOTION-DESCRIPTION

We can explain this motion-law if we project the motion of a Point that is

at the end of a rotating Crank onto a Line.

When a Crank rotates with Constant angular velocity, the motion of a

Point that we project onto any Line is Simple-Harmonic-Motion.

When the Crank rotates with the Y-Inverse-Sinusoid motion-law, the

motion of a Point that we project onto a particular Line is Constant

Linear Velocity.

MOTION-VALUES

You CAN control the:

START-POSITION - control with the SEGMENT-PARAMETERS - see below.

END-POSITION - control with the three SEGMENT-PARAMETERS - see below.

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

SEGMENT PARAMETERS

Example Segment Parameters

Schematic of Crank made to give a

constant linear velocity ...

Angle  is to Blue line relative to any

other line, as defined by the BASE-

VALUE of the MOTION-DIMENSION FB. 

RADIUS OF ROCKER (Example is

100mm) 

The Radius of the Rocker (rotat-

ing-Part) controls the minimum

and maximum distance from the

rotating-axis of the Green point, at

the end of the Rocker, projected

onto the Blue line.

836
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START-POSITION  (Example SP=–

50mm)

Directional Distance from the ro-

tating-axis of the Green point pro-

jected onto the Blue line when the

Green point starts to move with

Constant-Velocity along the Blue

line.

END-POSITION  (Example EP =

50mm) 

Directional Distance from the ro-

tating-axis of the Green point pro-

jected onto the Blue line when the

Green point ends moving with

Constant-Velocity along the Blue

line.

We calculate for you the angles 

and  for the Rocker relative to the

Blue Line, from the START-POSITION

and END-POSITION.

Note: 

The Crank rotates Counter-Clockwise when START-POSITION is Negative and

END-POSITION is Positive.

The Crank rotates Clockwise when END-POSITION is Negative and START-

POSITION is Positive.

SEGMENT-RANGE

START-RANGE 

END- RANGE

0 START-RANGE < END-RANGE 1

Play Video of Y-Inverse-Sinusoid Example


PSMotion Ltd

Y-Inverse-Sinusoid.mp4
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Y-Inverse Sinusoid

Example: with two segments.

Crank rotates in a Counter-Clockwise direction

Constant-Velocity Starts at 50mm to Left of Crank-Center (angle 120º) 

Constant-Velocity Ends at 50 to Right of Crank-Center (angle 60º)

SEGMENT 1:

· X-axis Start = 0 ; End = 90º

The Y–INVERSE SINUSOID SEGMENT-PARAMETERS are: 

· RADIUS OF ROCKER = 100mm, START POSITION = -50,  END POSITION =

50mm. 

With these SEGMENT-PARAMETERS:

· The Y–axis is 120º†, when the MASTER MACHINE ANGLE (MMA) is 0º . 

· The Y–axis is 60º, when the MASTER MACHINE ANGLE is 90º .

SEGMENT 2:

· X-axis Start = 90º, End = 360º (0º)

A FLEXIBLE-POLYNOMIAL

· The Y–axis is 60º, when the MASTER MACHINE ANGLE is 90º (= end of SEG-

MENT 1)

· The Y–axis –240º when the MASTER MACHINE ANGLE is 360º .
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Thus the Crank makes a full rotation from +120 to -240 in a counter-clock-

wise direction.
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1.6.11.26 Z-Raw-Data [Import Data]

Import Data: Z-Raw-Data

Z-RAW-DATA is a List Segment-Type.

The Z-RAW-DATA is a segment that uses the Data Transfer Table to import your

data as the motion-values.

See also: Acceleration-List , Position-List , Tools: Data Transfer ,

STEP   1. Import your data to the Data Transfer Table

1. Use the Motion-Law Selector  to select Z-RAW-DATA for a segment. 

2. Open the Data Transfer Table

3. Click the cell at the left and top row (cell equivalent to A1) of the Data

Transfer Table to make it the active cell.

To import your data to into the Data Transfer Table. 

4. Do:

a. Copy and Paste your data into the Data Transfer Table 

or do:

a. Open a CSV, TXT or DAT (Camlinks based)  file 

or do:

a. Get Motion-Values  from a different motion or segment 

Note: In your original data, include as many decimal points as possible.

The data is now in the Data Transfer Table 

STEP   2. Move your data to the Z-Raw-Data segment from the Data Transfer

Table

1. Click the Pos HEADER in the Data Transfer Table to select the column of

data 

2. Click Put List Data   in the Data Transfer Table toolbar. 

To move a sub-section of the data:

1. Click the first data point you want in move to the Z-Raw-Data 

2. SHIFT + Click the last data point you want to move to the Z-Raw-Data 

3. Click Put List Data  in the Data Transfer Table toolbar

Note : Get Data and Put Data icons show only when the segment is a List

Segment-Type 

Data-Transfer Table toolbar 

The data is a plot in the Z-Raw Data segment in the motion graph.

RESULT: MotionDesigner : 

758 803 744

741

747

750

750
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· Does nothing if you select less than 5 data-points. MotionDesigner tells

you to select more data-points!

· Transforms the data to calculate motion-values that coincide with the

motion-values in the segment.

· Numerically differentiates the data to create Position, Velocity, Acceler-

ation, and the Jerk motion-values.

In the Data Transfer Table:

· You can use the Get Motion Data  button or the Get Segment Data

button to get the new Position, Velocity, Acceleration, and Jerk motion-

values that MotionDesigner has calculated for you from your data.

· When the segment is a List Segment-Type, you can use the Get List

Data  button to move the original data back to the table.

Example of Z-Raw Data Segment

750 751

749
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1.6.11.27 CV Inverse Crank [Special]

CV (Constant-Velocity) Inverse Crank

MOTION-DESCRIPTION

We can explain this motion-law if we project the motion of a Point, that is

at the end of a rotating Crank, onto a Line.

When a Crank rotates with Constant angular velocity, the motion of a

Point that we project onto any Line is Simple-Harmonic-Motion.

When the Crank rotates with the CV-INVERSE-CRANK motion-law, the

motion of a Point that we project onto a particular Line is Constant

Linear Velocity.

MOTION-VALUES

START POSITION - control with the SEGMENT-PARAMETERS - see below.

END POSITION - control with the SEGMENT-PARAMETERS - see below.

You CANNOT control the:

START VELOCITY and END VELOCITY 

START ACCELERATION and END ACCELERATION 

START JERK and END JERK 

The actual velocity, acceleration, and jerk values, and the distance the Point

moves along the LINE are a function of the:

· SEGMENT-WIDTH 

· Length of the Rocker/Crank

· SEGMENT-PARAMETERS

SEGMENT PARAMETERS

Typical Segment-Parameters for the CV Inverse-Crank motion-law

Svchematic to help you understand how

to use the CV Inverse Crank motion-law.
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The SEGMENT-PARAMETERS are ANGLES:

MIN VEL  (MINIMUM VELOCITY) 

The ANGLE relative to the BASE-VALUE  angle that you control with the

MOTION-DIMENSION FB at which the Crank rotates with Minimum-Velo-

city.

REL START  (RELATIVE START)

The ANGLE, relative to the angle you control with MIN VEL , at which

Point  starts to move along the Orange Line with Constant-Velocity.

REL END  (RELATIVE END) 

The ANGLE, relative to the angle you control by MIN VEL , at which

Point  ends the move along the Orange Line with Constant-Velocity.

Note: 

The Crank rotates Counter-Clockwise when REL. START is Negative and

REL. END is a Positive.

The Crank rotates Clockwise when REL. START is Positive and REL. END is

Negative.

SEGMENT-RANGE

START-RANGE 

END- RANGE

0 START-RANGE < END-RANGE 1

Example motion with 2 x CV Inverse-Crank motion-laws
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EXAMPLE 

Two CV Inverse Crank segments in one Motion.

SEGMENT : Constant-Velocity Inverse-Crank

· X-AXIS : 0 TO 90º

Segment Parameters are: 

· ANGLE OF MINIMUM VELOCITY = 90º

· RELATIVE START ANGLE = –30º

· RELATIVE END = 30º

With these Parameters:

· X-AXIS = 0º ; Y–AXIS = 60º. 

· X-AXIS =90 ; Y–AXIS = 120º

SEGMENT : Flexible-Polynomial

· X-AXIS : 90 TO 180º

· Y-AXIS AT START P=120. V, A, J flow from the end of the Constant-Crank-

Velocity Segment.

· Y-AXIS AT END 240º

SEGMENT : Constant-Velocity Inverse-Crank

· X-axis : 180 to 270º

Segment Parameters are: 

· ANGLE OF MINIMUM VELOCITY = 270º

· RELATIVE START ANGLE = –30º

· RELATIVE END = 30º

With these Parameters:

· X-AXIS = 180º ; Y–AXIS = 240º

· X-AXIS = 270 ; Y–AXIS = 300º

SEGMENT : Flexible-Polynomial

· X-AXIS : 90 TO 180º

· Y-AXIS P AT START = 300º.  V, A, J flow from the end of the Constant-

Crank-Velocity Segment.

· Y=AXIS AT END = 420º. 
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1.6.12 Motion-Law Coefficients

MOTION-LAWS COEFFICIENTS

Use Motion-Law Coefficients DE: Kennwert to compare motions that you design

with the Traditional Motion-Laws.

Motion-Law Coefficients

Velocity Coefficient 

Acceleration Coefficient

Jerk Coefficient

The Motion-Law Coefficients are the maximum motion-values for the mo-

tion-derivatives when the motion has a:

· Motion Time Period of 

and an

· Output Displacement of  

Actual Maximum Velocity, Acceleration, and Jerk

You can calculate the actual maximum motion-values of each motion-derivat-

ive if you know the Actual Displacement (  ), the Actual Period (  ), and the

Motion-Law Coefficient for a rise or return motion segment.

Actual Maximum Velocity =

Actual Maximum Acceleration =

Actual Maximum Jerk =

Torque Coefficients

Output Torque Coefficient  - E.g. the torque that rotates the swinging

arm of a follower.

The Output Torque Coefficient considers the dynamic-response of a load

when the mass or mass moment of inertia is dominant. The coefficient is the

approximate ratio between the maximum acceleration of the dynamic-re-

sponse and the maximum acceleration of the command. 

Input Torque Coefficient - E.g. the torque at the output of a gearbox

connected to the Cam-Shaft.

Note on Input Torque Coefficient

The maximum torque of a motion-law is important. The rate-of-change

of torque at crossover from acceleration to deceleration is more import-

ant.
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A positive input torque on the cam-shaft winds-up (twists) the cam-shaft.

A negative torque winds-down (untwists) the cam-shaft. 

When the Torque changes from a positive to a negative value - at the

crossover - backlash is traversed. The speed of the drive-motor may in-

crease rapidly as the torque is released from it and then, after the Back-

lash has been traversed, becomes driven by the load. If the speed of the

motor does increase, then the motion-law is also distorted. The max-

imum deceleration increases when the driving-shaft momentarily in-

creases its speed. 

Power

Constant Power

Power - constant Torque and constant Angular

Velocity

Power - constant Force and constant Linear-Ve-

locity

Variable Power

Of course, Torque and Angular Velocity at the Follower continuously change

throughout the motion. Thus, the Power at the output shaft also changes con-

tinuously.

Use the suffix  to indicate an instant in the motion, then the Instantaneous

Power, when calculated at the output is:

Instantaneous Power - varying Torque and An-

gular Velocity

Instantaneous Power - varying Force and Lin-

ear-Velocity

Total Load Torque or Load Force are found from values of inertia, mass, and

acceleration. 

However, the:

· Acceleration continually changes throughout the motion - of course. 

· Load Inertia and Mass, referred to the driven-shaft, can be constant (e.g.

Dial-Plate) or can continually change (e.g. Toggle mechanism). 

In the general case, the Load Inertia and Mass that reflect to the Follower var-

ies throughout the motion.

Use the suffix 'i' to indicate any instant in the motion, the instantaneous Load

Torque and Load Force are:

Load Torque with changing Load Inertia and An-

gular Acceleration.

Load Force with changing Load Mass and Linear

Acceleration
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Also, the instantaneous Load Power is:

Load Power with changing Load Inertia, Angular

Acceleration, and Angular Velocity.

Load Power with changing Load Mass, Linear Ac-

celeration, and Linear Velocity.

When reflected Load Inertia is not a function of the motion, the Power-Coeffi-

cient is less complex.

The instantaneous Load Power, with constant reflected Load Inertia or Load

Mass is:

Load Power with constant Load Inertia, Angular

Acceleration, and Angular Velocity.

Load Power with constant Load Mass, Linear Ac-

celeration, and Linear Velocity.

Power Coefficient

Power Coefficient

MOTION COEFFICIENTS OF THE TRADITIONAL MOTION-

LAWS

Motion-

Law Name

Velocity Coef-

ficient

Acceleration

Coefficient

Torque Coef-

ficient

Power Coeffi-

cient

Constant

Accelera-

tion Para-

bolic

2 4 2 8

Simple

Harmonic

1.570796

( /2)

4.934803

( 2/2)
0.785 3.8758

Cycloidal 2 6.283185 1.298 8.1621

Modified

Trapezoid
2 4.888124 1.655 8.0894

Polynomial

3-4-5
1.875 5.773503 1.159 6.6925
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Motion-

Law Name

Velocity Coef-

ficient

Acceleration

Coefficient

Torque Coef-

ficient

Power Coeffi-

cient

Polynomial

4-5-6-7
2.1875 7.5132 1.431 10.750

Modified

Sine
1.759603 5.527957 0.987 5.4575

SINE-CONSTANT-COSINE ACCELERATION (SCCA) with

CONSTANT VELOCITY

Edit the SEGMENT PARAMETERS  (in the SEGMENT EDITOR ) of the SINE-CON-

STANT-COSINE ACCELERATION  (SCCA) Motion-Law to give many of the pop-

ular motion cam-laws for industrial cams. 

Motion-

Law Name

Coefficients SCCA Parameters (Factors)

Velocity

Coefficient

Cv

Accelera-

tion Coeffi-

cient

Ca

a b c

Modified-

Sine

CV 0%

1.760 5.528 0.25 0 0.75

Modified-

Sine 

CV 20%

1.528 5.999  0.2 0 0.6

Modified-

Sine 

CV 33%

1.404 6.616  0.1667 0 0.5

Modified-

Sine 

CV 50%

1.275 8.0127 0.125 0 0.375

Modified-

Sine 

CV 66% 

1.168 11.009 0.0833 0 0.25

Cycloidal 

CV 50%
1.333 8.378 0.25 0 0.25

Trapezoida

l Velocity

CV 33%

1.5 4.5 0 0.6667 0

715 704

814
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3-HARMONIC MOTION-LAWS

Edit the SEGMENT PARAMETERS  (in the SEGMENT EDITOR ) of the Triple

Harmonic Motion-Law to give alternatives to some of the popular motion-

laws.

Motion-

Law

Name

Coefficients Harmonic

Velocity

Coeffi-

cient

Cv

Acceler-

ation

Coeffi-

cient

Ca

1st 2nd 3rd

3-Har-

monic 

Modi-

fied

Trapezo

idal

2.0 5.16 5.96 0 0.9696

3-Har-

monic 

Modi-

fied

Sine 

1.72 6.07  5.1968 1.7690 0.6057

3-Har-

monic 

Zero-

Jerk at

Cros-

sover

2.0 9.42  0

715 704
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1.6.13 How to? and other FAQs...

How to and other FAQs

How to .... ?

1. How to Rename a Motion .

2. How to Float or Dock MotionDesigner .

3. How to design a Motion - First Steps  

4. How to edit a value in a data-box

5. How do I edit the start of the motion so it does not start at 0.  

6. How to quickly find the motion-values .

FAQs

1. What is 'Motion-Design'?  

2. Where is the Spin-Box in the Segment / Blend-Point Editor?

846

847

848

850

853

854

858

859
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1.6.13.1 How to?

How to .... ?

1. How to Rename a Motion ?

2. How to Float or Dock MotionDesigner ?

3. How to design a Motion- First Steps ?

4. How to edit a value in a data-box ?

5. How do I edit the start of the motion so it does not start at 0. What is

'Motion-Design' ?

6. How to Improve a Motion?

7. How to find the Motion-Values anywhere in the Motion or a Segment,

between the Blend-Points ?

846

847

848

850

853

858

870

854
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1.6.13.1.1  How to Rename a Motion

To Rename a Motion

The default motion names are not very helpful, and do not remind you in which

mechanism it is used.

 To rename a motion.

1. Right-click a motion graph-area or its Motion name-tab 

2. Click Rename in the shortcut menu

Motion: Rename dialog

3. Enter a new name in the Rename dialog

4. Click the  at the top to close the Rename dialog

OR

1. Do Edit toolbar > Active Motion-Settings > Motion tab > MOTION

NAME > Motion name

731

731
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1.6.13.1.2  How to Float or Dock MotionDesigner

How to Float MotionDesigner.

You can float and dock MotionDesigner with a tool that is in MechDesigner.

1. Click the Visibility menu or Visibility toolbar 

2. Click Float / Dock MotionDesigner button.

To re-dock MotionDesigner:

1. Click the Visibility menu or Visibility toolbar 

2. Click Float / Dock MotionDesigner button.
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1.6.13.1.3  How to Design a Motion - First Steps.

Motion Design

It is always important to try to improve the design of your motion when you need

to improve the performance of a machine. 

First Steps

To design a motion:

1. Plan and sketch the Motion for the tooling, on paper, over one machine-

cycle

Note on the sketch:

· The Motion's name - usually relate the motion's name to the function of

the tooling or the interaction with the packaging. Try to make the name

short.

· Each segment, with its approximate timing on the X-axis.

· The key positions of the tooling on the Y-axis. Example names for the pos-

itions may be: Out, In, Contact, ...

· If a segment has a velocity requirement - e.g. to track a pack during heat-

sealing

· If a segment has a minimum time-periods - e.g. for heat-sealing jaws

· If the motion-cycle is progressive (indexing) or non-progressive (rise and

return)

2. Use the Blend-Point Editor, to set the Y-axis position value of each Blend-

Point to zero, then close the Blend-Point Editor.

3. If you need more than four segments, use Insert-Blend-Point command to

split the motion into the number of segments you believe you need- or

delete a segment if you need fewer segments.

4. Use the BLEND-POINT EDITOR to make sure the MATCH CONTROL-BUT-

TONS are active for Position, Velocity, Acceleration for each BLEND-

POINT  - to make sure there is motion-continuity.

5. If the motion is a progressive motion, set the BLEND-POINT #1 to Do NOT

Match.

6. If a segment has a particular motion-law , e.g. Constant-Velocity, use the

MOTION-LAW SELECTOR to change the motion-law.

7. Use the BLEND-POINT EDITOR to define the approximate X-axis value of

each BLEND-POINT and the SEGMENT-WIDTH for each segment. Begin to

define the duration of each segment making some shorter and others

longer. The total duration remains as 360°.

8. Edit the Y-axis motion-values of each segment with the Blend-Point Editor

and/or Segment Editor - to fully satisfy the motion requirements.

9. Make sure that none of the segments give a large spike in Acceleration

compared to the other segments

10. If possible, avoid Jerk-discontinuities. 
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11. If possible, remove short Dwell segments. Try to replace with Zero Velo-

city, Acceleration, and Jerk at the Blend-Point.

See also: What is a motion?

 

858
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1.6.13.1.4  How to edit a parameter value in dialog

Parameters values in a dialog.

You edit motion-values or parameter-values in exactly the same way as in all

dialog-boxes.

This image is the DIMENSION DIALOG that you use in MechDesigner.

It has one parameter (DIMENSION) and data-box (currently set to 300).

In this image of the DIMENSION DIALOG,

I have added a 'window' to highlight

the PARAMETER BOX.

The three areas of the PARAMETER BOX

are:

300

PARAMETER VALUE

- the data-value

that you edit and

apply to the ele-

ment.

10

SPIN-INCREMENT

VALUE - edit with

the arrows at the

bottom of the

Spin-Box con-

trol

 SPIN-BOX CON-

TROL: arrowheads

- see below

If you cannot see

the Spin-Box:

· Double-

click in

the PARA-

METER

VALUE

box.

· Again,

double-

click, if re-

quired.

How to edit parameters in a dialog.

There are three different procedures you can use to edit a parameter in a dia-

log.

Method 1: Enter the Parameter Value with your Keyboard

851

851
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Enter a value directly:

1. Use your keyboard to enter the

data-value 

2. Press the Enter key on your key-

board to update to the new

value

You must press the Enter key.

Enter a value as a symbolic equation:

1. Use your keyboard to enter an

equation 

2. Press the Enter on your keyboard

to update to the new value

You must press the Enter key

Symbolic parameters for an Equation:

· Simple Arithmetic: +, –, *, / 

· ^, Sqrt()

· Trigonometric (Angles are Radians), Sin(), Cos(), Tan(), Sinh, Cosh,

Tansh, ArcSin(), ArcCos(), ArcTan2( ; )

Method 2: Use the 'Spin-Box' tool

If you cannot see the Spin-Box tool

< >

Double-click inside the data-box to toggle from show to hide and from

hide to show the Spin-Box tool.

Spin-Box arrowhead buttons (in the CYAN-BOX)

 TOP : LEFT arrowhead to subtract (–) the PARAMETER-VALUE  by the
SPIN-INCREMENT

 TOP : RIGHT arrowhead to add (+) the PARAMETER-VALUE  by the SPIN-

INCREMENT

 BOTTOM : LEFT arrowhead to divide (÷) the SPIN-INCREMENT  by 10

 BOTTOM : RIGHT arrowhead to multiply(×) the SPIN-INCREMENT  by 10
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EXAMPLE:

Edit the PARAMETER-VALUE

· Click the Top & Left  arrowhead: Subtract the Spin-Increment(1)

from the PARAMETER-VALUE  

PARAMETER-VALUE after one click: 67.12345 – Spin-Increment =

66.12345

· Click the Top & Right  arrowhead two times: Add the Spin-Incre-

ment(1)   to the PARAMETER-VALUE   2 x

PARAMETER-VALUE after one click: 66.12345 + 2 × Spin-Increment =

68.12345

Edit the Spin-Increment

· Click the Bottom & Left  arrowhead: Divide the Spin-Increment by

10  

Spin-Increment value after one click: 1 ÷ 10 = 0.1

· Click the Bottom & Right  arrowhead two times: Multiply the Spin-

Increment by 10  2 x

Spin-Increment value after one click: 0.1 × 10 x 10 = 10

WARNING: The model re-builds each time you click the top arrowhead but-

tons in the Spin-Box tool. If the model is complex, it may be a long time to

update the model.

Method 3: Use the Zero/Round shortcut menu

To see the Zero / Round / Paste / Copy

:

1. Right-click inside the data-box 

The Zero / Round / Copy / Paste

shortcut-menu shows.

· Zero - the parameter-value be-

comes zero(0), or the smallest

possible value for the para-

meter-value

· Round - the parameter-value

becomes the nearest value that

is exactly divisible by the Spin-

Increment. The Spin-Increment

is below the data-box - ten(10)

in the image 

· Copy - to copy the parameter-

value to your clipboard.

· Paste - to paste the parameter-

value from your clipboard. 
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1.6.13.1.5  How to start a motion at Xº that is not 0º

How to start a motion at an X-axis value that is not zero?

Frequently, the timing of a motion means the X-axis value of Blend-Point #1, the

start of  Segment #1, cannot be at 0. 

In this case you want to move BLEND-POINT #1 from 0.

To move BLEND-POINT #1 to a value that is not 0, edit the MOTION-START para-

meter in the BLEND-POINT EDITOR. 

The motion moves along the X-axis of the graph by the MOTION-START para-

meter.

The plot of the motion will start at 0, somewhere between two BLEND-POINTS.

STEP   1. Open the Blend-Point Editor

Blend-Point Editor icon

Use the toolbar.

1. Click Blend-Point & Segment toolbar >

Start Blend-Point Editor 

The BLEND-POINT EDITOR is now open. 

STEP   2. Expand the X-AXIS VALUES separator 

STEP   3. Edit the Motion-Start-parameter

MOTION START 

Edit MOTION- START to move BLEND-POINT #1 and all of the motion

moves relative to the MASTER MACHINE ANGLE.
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1.6.13.1.6  How to find the motion-values anywhere in the motion/segment?

To find Motion-Values.

There are 4 methods to find the Y-axis motion-values at an X-axis value.

Method 1: Motion-Values at Pointer

Motion-values at your pointer

1. Move your mouse-pointer above a

motion plot-line, or to a BLEND-

POINT. 

The X-axis and Y-axis motion-values show

near to your pointer.

Method 2: Motion-Values Evaluator

Machine-Angle(1) : Evaluate Motion-Values(2)

For any real number you enter as a MACHINE-ANGLE , we evaluate for you

the exact motion-values  (P, V, A, J).

You may need to increase the width of the MotionDesigner panel. 

Or, you can Float MotionDesigner - See MechDesigner > Visibility menu >

Float/Dock MotionDesigner.

Method 3: Use the Sweep-Display

Note: 

The SWEEP-DISPLAY works best for a motion that start at 0, and has a Mo-

tion-Width of 360.

To open the SWEEP-DISPLAY:

1. Click Edit toolbar > Sweep-Display

icon 
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Sweep-Display dialog

SWEEP-DISPLAY 

CURSOR POSITION

The X-axis value at which to evaluate

exact motion-values.

POSITION, VELOCITY, ACCELERATION, JERK

(read-only)

The exact POSITION, VELOCITY, ACCELER-

ATION, and JERK motion-values at the X-

axis value as defined by the CURSOR-

POSITION.

A vertical cursor shows in the graphs at the

X-axis value as defined by the CURSOR

POSITION.

Method 4: Open Data Transfer Table 

Blend-Point and Segment

toolbar

To open the Data Transfer Table:

1. Click Blend-Point & Segment toolbar > Data Transfer Table icon.

The Data Transfer Table is now open.

Data Transfer Table

Look up in the list the X-axis value for which you want to know the Y-axis

motion-values.
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If you want more accuracy,, then increase the NUMBER OF POINTS in Active

Motion Settings dialog > Motion tab > Motion Cycle

To find the X-axis values from a Y-axis positional value

There is one method. You must use a MOTION FB in MechDesigner.

You can enter the Y-axis of the Position motion-derivative.

In MechDesigner:

1. Add a Motion FB to the graphics-area 

2. Open the MOTION FB DIALOG

3. In the  MOTION PARAMETER  separator, click the drop down arrow in

the SELECT A MOTION box, and select a Motion whose X-axis value

you need to know at a particular Y-axis value.

4. In the   QUERY  separator, enter a Y-AXIS VALUE (Position motion-

derivative, only)

If one or more X-axis values exist at the Y-axis value, then we show the

values in the box below.

X-axis values from a Y-axis value

731
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1.6.13.2 FAQs

FAQs

1. What is 'Motion-Design'?  

2. Where is the Spin-Box in the Segment / Blend-Point Editor?

858
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1.6.13.2.1  What is 'Motion Design'?

What is Motion Design

There are many disciplines that use the term Motion Design: E.g. Graphic Design,

Dance Choreography.

However, in MotionDesigner, you usually design motions for machine elements.

In machinery, all the machine parts have mass and inertia. As such, the forces that

develop between machine elements as a result of their motions are also import-

ant. Parts with inertia must be moved carefully, especially as speeds are increased.

If motions are not designed carefully, machine elements vibrate needlessly.

MotionDesigner 

MotionDesigner provides all of the tools to design motions for high-speed,

multi-axis machines, such as those found in the packaging, assembly, and textile

industries. 

What is Motion Design?

1. A motion is a sequence of positions for a machine element - or a Rocker

or Slider in MechDesigner. 
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2. A motion-design satisfies a number of position, velocity, acceleration,

and/or jerk specifications for the angle or distance between two parts

throughout a machine cycle.

3. When the number of motion specification become extensive or complex,

it is difficult to find one mathematical function that can satisfy the motion

specification throughout a machine cycle.

4. Therefore, it is convenient to split a motion into segments. Segments are

joined end-to-end (concatenated, to give the technical term). The number

of segments in the machine-cycle is dependent on the number of differ-

ent motion requirements in the machine-cycle. 

5. The process of splitting into segments is called segmentation. The image

above shows a motion split into 4 segments.

6. Each segment may have a different mathematical function, which is its

motion-law. Select the motion-law that can satisfy the motion specifica-

tion during its segment period.

7. A Motion-Law may have different parameters that you can edit to satisfy

different motion specification.

8. A Blend-Point is at the instant when one segment ends and another starts.

9. There are two editors in MotionDesigner

· Segment Editor

· Blend-Point-Editor

1.6.13.2.2  Where is the Spin-Box in the Segment-Editor/Blend-Point Editor?

Where is the Spin-Box tool in the Segment and Blend-Point Editor?

In the SEGMENT EDITOR and the BLEND-POINT EDITOR, it is convenient to edit

motion-parameters with the Spin-Box tool.

However, the Spin-Box tool may not show at the right-side of the motion-para-

meter.

To show or hide the Spin-Box tool

If the Spin-Box tool is not to the right-side of a

motion-parameter:

1. Double-Click with your mouse-pointer in

the data-box.

Again ... The first time you double-click, the Spin-Box

does NOT show.

2. Double-Click again with your mouse-

pointer in the data-box.

Now the Spin-Box should show.

704
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1.6.14 Motion Design Considerations

Motion Design Considerations

1. Refresher on Blend-Point and Segments  

2. Segment Blending and Motion (Dis)Continuity  

3. Motion-Laws Compared

4. Motion Design - Dynamic Considerations

5. How to Improve a Motion

1.6.14.1 Refresher: Blend-Point and Segments

A Refresher on Segments and Blend-Points in Mo-

tionDesigner

It is almost impossible to design a motion for a machine-cycle with one mathem-

atical function.

Therefore, you usually split, or divide, the machine-cycle into a series of motion-

periods that you join end-to-end to give a complete machine cycle. 

We use the term SEGMENT for a motion-period. We use the the term BLEND-

POINT for the instances at the start and end of each SEGMENT.

You can then use a different mathematical-function for each motion-period.

We use the term MOTION-LAW or CAM-LAW for the mathematical-function.

Not only do motion-designers need to control when and where to split the mo-

tion into different Segments, they must also select the mathematical function that

can best satisfy the motion requirements at all points in the machine-cycle, nut

just at the Blend-Points.

The mathematical-functions, from which you can select, have been chosen by

PSMotion to meet the different requirements of most machine designs, each with

different applications or advantages. 

860
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1.6.14.2 Segment Blending and Motion-Continuity

Segment Blending and Motion Continuity

see also: Impact, Acceleration Shock, How to Blend Two Segments

Motion-Law Discontinuity

Motion Discontinuity Definition.

A motion discontinuity is one in which the Y-axis of a motion-derivative has

two values at one instant on its X–axis. The name of the motion-discontinu-

ity refers to the lowest motion-derivative at which the motion-discontinuity

occurs.

In the image above, the motion-law uses the Constant Acceleration & De-

celeration Motion-Law. It has three(3) acceleration discontinuities. The mo-

tion discontinuity of the acceleration at the mid-point is the most aggress-

ive, as it changes from the maximum acceleration to the maximum decelera-

tion.

In the image below, the motion also has an Acceleration-Discontinuity. 

All motion-discontinuities can be  can be eliminated (up to Jerk) if you use

the Flexible-Polynomial motion-law.

861



862

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Segment Discontinuity

Segment Blending

Segment Blending considers the motion-values at the Blend-Points. 

It is recommended that you design your motions with at least Position, Velo-

city, and Acceleration continuity. 

Jerk continuity may also be appropriate, but not in all circumstances.

IMPORTANT  - In MotionDesigner, It is possible to design a motion with motion-

discontinuities at any motion-derivative, even Position. 

A Position motion-discontinuity is only needed with a progressive (indexing) mo-

tion, in which the position at the end of the index motion is different to the posi-

tion at the start of the index motion. Clearly, the mechanical system does not

move from one position to the next in zero time. It does not have a positional

motion-discontinuity.

Position Continuity

A Step-change in Position?

Mechanical systems cannot respond to a Position-Discontinuity - to

move from one position to a different position in zero time! It would be

a magic trick! Cartoon characters can do this motion, but not mechanical

systems. A Cam would need a step in it.

You must use at least the Match Control button in the Segment and

Blend-Point Editors to give Position-Continuity.

Velocity Continuity

A Step-change in Velocity?

Mechanical system cannot respond to a Velocity-Discontinuity. You are

trying to make the system respond as if it has been hit. 
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A Servo motor would need to change its speed instantly, with infinite ac-

celeration. This is unattainable.

A Cam would have a corner, or kink.

Acceleration Continuity

A Step-change in Acceleration?

Mechanical systems do not like Acceleration-Discontinuities. Any mech-

anical system will vibrate.

Do this experiment to see an Acceleration-Discontinuity:

1. Clamp (or hold down) a 300mm ruler at one end, so it hangs over the

edge of a table. 

2. Release a coin from zero height onto the ruler, near to its end.

The velocity-impact is zero because you release the coin from zero-

height.

The ruler experiences a step change in force (gravitational force) as

you release the coin on to it.

The ruler vibrates with a displacement amplitude of about two times

the final resting position of the ruler with the coin on it

Jerk Continuity

 A Step-change in Jerk?

Finally, it is sometimes required that adjacent segments have Jerk-

Continuity.

Jerk-Continuity gives the least mechanical vibration in the mechanical

system, at the expense of higher peak nominal accelerations. 

When Jerk is Zero at the start of a segment, there is only a tiny change of

the Position graph for the first 10º of input. It is almost a dwell for the

first 10º.

If it frequently possible to increase the duration of a segments with Jerk-

Continuity, and thereby reduce the accelerations.
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1.6.14.3 Motion-Laws Compared

Motion-Laws.

A motion usually has a number of segments that are joined end-to-end at

Blend-Points. You select the motion-law for each segment with the Motion-

Law Selector .

A common question is 'Which motion-law is best?'

When the motion is complex, with many segments that must satisfy different

position, velocity, and acceleration requirements, it is almost impossible to

answer the question: 'Which motion-law is best?'.

However, when the motion is simple, when the segments are designed for a

Dwell-Rise-Return-Dwell motion, then it is easier to select a motion-law that

is best for the mechanical system.

Which Motion-Law?

With many of the motion-laws, especially the “Traditional Motion-Laws” ,

you can only control the position at the start and end of the segment. If you

compare the each Traditional Motion-Law , you will notice their displacement

plots are almost the same!

You may ask: Why are there so many motion-laws when each provides

nearly the same result?'.

Actually, it is the acceleration plot, and not the displacement plot, that is more

important.

While their displacement plots are nearly the same, their Velocity plots are

noticeably different, and their Acceleration plots are significantly different. 

The SHAPE of the ACCELERATION plot has a significant influence on the dy-

namic response of the mechanical system. 

For this reason, name of a TRADITIONAL MOTION-LAW, relates to the shape

of the Acceleration plot.

When the motion is simple, it is easier to explore the advantages and disad-

vantages of each motion-law.

See also: General Design Information Manual( coming 2019): Design of Cam Mechanical

Systems.

Initial Selection

The relative ratings of five commonly used Traditional Motion-Laws. You can

use the ratings to help you select a law at the initial stage of a machine

design. The ratings range from1 (bad) to 5 (excellent). The ratings apply to

Dwell-Rise Dwell type motions.

Of the motion-laws in the table, the Modified Sine(MS) is the best for general

purposes. Its particular merit is that it is very tolerant of a bad input drive and

transmission (elasticity, backlash, stiffness, inertia). It is frequently the first

choice for designers and is almost always used by commercial manufacturers

of cam-operated indexing mechanisms.

741
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Additionally, you can look at the Motion-Law Coefficients  of the common mo-

tion-laws. These indicate the relative peak values of the Velocity and Accelera-

tion.

Cam-Law

Designa-

tion

Peak

Acceler-

ation

Output

Vibra-

tion

Peak

Velocity

Impact Input

Torque

Input

Vibra-

tion

Residual

Vibra-

tion

Constant

Acc &

Dec

5 1 2 1 1 1 1

Simple

Har-

monic

3 1 4 4 5 2 1

Modified

Trapezoid 3 3 2 2 2 3 3

Modified

Sinus-

oid

2 4 3 4 4 4 4

Cyc-

loidal
1 5 2 3 3 4 5

Explanatory Notes

Peak Acceleration

This merit rating applies to the nominal maximum output acceleration

during the motion period, calculated by the motion-law equation.

Output Vibration

Output vibration is superimposed on the nominal output acceleration,

thereby increasing the nominal peak value. The vibration severity de-

pends on the elasticity and operating speed of the mechanism. The merit

rating applies to mechanisms of average rigidity running at fairly high

speed.

Peak Velocity

Peak Velocity is the nominal maximum output velocity during the motion

period, calculated by the motion-law equation. Its value is also increased

by superimposed vibration.

Impact / Backlash

Impact forces occur at the locations of backlash in the mechanism when

the changeover from acceleration to deceleration occurs. The severity of

the impact depends on how gradually the changeover takes place. That

is, how low the jerk is at point of impact. Strictly speaking, it is the

changeover from positive to negative force or torque that matters, but in

839
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most high speed systems, that almost coincides with the acceleration

changeover.

Input Torque

The nominal input torque of a mechanism varies throughout the motion

period and is a function of the output load profile, and the velocity pat-

tern. The peak acceleration and the peak velocity do not coincide and

neither coincides with the peak input torque. Motion-Laws with good,

that is low, acceleration do not necessarily have good input torque.

Input Vibration

The elasticity and backlash of the input transmission can cause serious

'over-run'. This is when the sudden reversal of the input torque at the

changeover from acceleration to deceleration - or load - causes the cam

to jump forwards before it can transmit a decelerating force to the out-

put. The more gradual that the nominal input torque changes over, the

less severe is the overrun and its consequences.

Residual Vibration

Residual Vibration takes place in the dwell period immediately following

the motion period in high speed or elastic systems. Its amplitude de-

pends on the vibration generated during the motion period, and the de-

gree of damping present in the output transmission. It is very difficult to

add sufficient damping to high speed mechanisms to eliminate residual

vibration, so the choice of a motion-law is vital in some cases.

1.6.14.4 Motion: Dynamic Considerations

Dynamic Response and Considerations

We can use vibration terminology to describe the dynamic response of a mech-

anical system to a motion command. 

Nominal Motion: The motion command you want a mechanical part to fol-

low. This is your motion-design from MotionDesigner.

Transient Motion: The dynamic response of the mechanical system within the

period of the motion command.

Residual Vibration: The dynamic response of the mechanical system after the

motion-command. This term usually applies to the dwell period after an in-

dexing motion period.

Dynamic Performance

When we look at the Dynamic-Performance, it is easier to discuss the acceleration

of the motion-command and the motion-response.

All mechanical systems have a degree of elasticity, mass, and mass moment of in-

ertia. The means that the acceleration response of the system is greater than that

of the acceleration command. This is a reality of all mechanical systems.

The Dynamic Performance is a function of many factors, that include:

· the speed of the drive shaft (cycle speed),
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· the natural frequency of the mechanical system (derived from its stiffness

and mass, or its rigidity and mass moment of inertia).

· the segment period (time) in the motion-command

· the continuity of the motion-law

· the magnitude of the movement (lift) = the LEAST significant. 

The maximum allowable operating speed is also influenced by the manufacturing

accuracy of a cam-profile. The adverse effect of profile inaccuracies is aggrav-

ated as the machine-speed increases. Very stiff mechanisms (to give a high nat-

ural frequency) are to be preferred in all cases, provided the cam-profile is

smooth.

Residual Vibration

Vibrations do not stop when the motion segment is finished! Residual vibra-

tion levels should be considered. If high vibration levels are experienced by

the system in a dwell immediately after a segment, then frequently the ma-

chine tooling may be out of position while another mechanism attempts to in-

teract with it. Some designers then redesign the motion with an even longer

dwell (= shorter motion segment) to give a longer time for the vibrations to

cease. However, this is not usually good solution to the problem as accelera-

tions increase, and the Period-Ratio decreases.

Period Ratio

In order to provide an accurate definition of the dynamic-performance of a

mechanism, we use a non-dimensional parameter called Period-Ratio.

The Period-Ratio is the:

The Period (time duration) of the motion segment divided by the Period

(time duration) of the fundamental vibration of the following system. 

A high Period-Ratio is always better than a low one.

Period-Ratio > 10 : indicates a combination of a stiff, low mass system, oper-

ating at a medium or low cam-shaft speed. 

5 < Period-Ratio 5 < 10  : a combination less stiffness, greater driven mass/in-

ertia, and greater cam-shaft speed.

Period Ratio < 5 : a combination of low stiffness, high mass/inertia, and/or

high speed cam-shaft

Motion Continuity

When the motion-law of the motion command is continuous in position, velocity,

and acceleration, and if the Period-Ratio is more than 20, the acceleration of the

mechanical system approaches the acceleration as predicted by the Motion-Law.

The dynamic response of the follower system may be neglected when determin-

ing actual accelerations. 

However, in the case of the Simple-Harmonic-Motion  and the Constant-Accel-

eration motion-laws , which are not continuous in acceleration, the acceleration

of the dynamic-response is always significantly more than the acceleration of the

motion-command, even if the Period-Ratio is greater than 20. 

811

759



868

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130

Motion-Laws that are discontinuous in acceleration (infinite jerk), at any point

in their cam profile, produce vibrations of the mechanical-system. The actual

acceleration/deceleration of the driven system is up to 2 times the nominal

acceleration when driven by a cam motion with infinite jerk. 

Pressure Angle Considerations.

The pressure angle and the way in which it varies throughout a motion depends

upon the basic dimension of the cam, the type of the follower (roller, or flat

faced) and, to a lesser extent on the particular motion-law.

Drive Torque

The operating torques for a cam system depends on the Motion-Law.

In general, you want the cam-shaft to rotate as near as possible to constant-velo-

city. You should design the input drive system to reduce the effect of the varying

Drive Torque on the speed of the cam-shaft. 

Typically, the drive shaft should be short, and have a large a diameter as possible.

Add a flywheel to the input near to the Cam. 

Maximize the rotating speed of the drive motor with a gear-box. The armature of

the motor acts as a flywheel. The Load Torque (and its variation), referred to the

motor are minimized. 

There are three Torque factors to consider:

Constant Load Torque Factor

This is the component of torque required to overcome the constant compon-

ent of the external load on the Follower. The constant load is usually due to

the weight of the following system (or the referred weight), the load at the

start of the motion due to any spring constraint, and also friction. This is usu-

ally the least significant of the three, for a 'normal' cam driven system - but it

depends on the other two!

Inertia Torque Factor

This is the component of torque required to accelerate the mass of the fol-

lower assembly. It is usually the most significant in normal systems - but that

depends on the others!

Spring Stiffness Torque Factor

This component is due to the linear change of spring constraint with the fol-

lower movement. This factor is based on the minimum spring force required

at the point of maximum deceleration to maintain contact between the fol-

lower and the cam. The spring, might be an 'air-cylinder' which might be

either a 'constant force' or as a 'fixed air mass'.

The magnitude of the total drive torque gives some indication of the amount

of torsional deflection in the drive shaft and therefore the amount of segment

motion distortion that may occur. The distortion tends to attenuate (reduce)

the accelerations and amplify (increase) the decelerations of the follower. An

abrupt reversal of torque (e.g. due to backlash in the drive train) results in tor-
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sional vibration in the driving shaft which is transmitted through the cam to

the driven system. Such distortions can be reduced by increasing the torsional

stiffness of the shaft and by increasing the mass moment of inertia, especially

near the cam.

Motion distortion can result from shaft bending/flexing ( due to cam contact

forces)The shaft size and the position of its support bearings should be chosen to

minimize any distortion of the cam-shaft.

Motion distortion can also result from the deflection of the Follower support

shaft due to the pressure angle and cam contact-force.

Jerk 

The rate-of-change of the strain-energy is related to the maximum value of jerk

in the motion.

Jerk should be considered in addition to the system's rigidity/stiffness, and its op-

erating speed.

Jerk values can be compared for different motions. Such as the:

· Start and End Jerk: At the start and end of a motion or segment

· Maximum Jerk: Motions with zero jerk at the start, may have a large max-

imum acceleration. The mechanical system strains more when the acceler-

ation is increased.

· Crossover Jerk: The value of jerk as the acceleration changes sign from

positive to negative, or vice versa. Low values of crossover jerk are benefi-

cial for systems with backlash. Backlash typically traverses as and after the

velocity reaches its maximum and begins to reduce. Motion-Laws with low

crossover jerk values usually also have lower maximum velocity values.  A

low peak velocity means a reduced impact as the backlash completes its

traverses.

· Steps in Jerk: For many of the Traditional Motion-Laws , jerk changes in-

stantaneously from zero to some finite value immediately after the motion

segment starts. Steps in jerk induce vibrations in the mechanical system

being driven. Other motions start and end with infinite jerk, which is an

even worse. 

· Infinite Jerk: Motion-Laws that have a step in acceleration also have infin-

ite jerk-values at the acceleration step. We have already stated that accel-

eration continuity is important.
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1.6.14.5 To Improve a Motion

Improve the Motion

This is a very subjective problem. A good motion for one application may not al-

ways be a good motion for another.

An attempt to answer the question of “How to improve a motion?”

Assumptions:

· The motion is for a machine, and not for the animation of a cartoon char-

acter.

· The motion is intended for a machine where the machine elements recip-

rocate, oscillate, index, or the speed modulates in some way. Each ma-

chine element has mass, mass moment of inertia, stiffness, and backlash.

· The inertia forces are dominant - or at least 80% of the total load.

General Advice:

· Remove all Velocity motion-discontinuities. 

· Remove all Acceleration motion-discontinuities.

· Use a minimum number of segments. 

o Always ask yourself: “Can I reduce the number of segments?” 

o Always ask yourself: “Can I delete a Dwell Segment?” - especially short

dwells.

· Reduce the number of motion constraints. E.g. Do you need to control the

position of a Blend-Point - possibly you only need to control its velocity.

· Try to make the maximum acceleration values of each segment similar to

each other. This is not always possible or desirable. But consider balancing

the motion to give similar motion durations or peak accelerations, or both.

· When different tools must interact in some way, consider moving a tool

further than you need to, if you can also give it more time. This is often a

very powerful way to reduce accelerations of tools.

For example, if you increase the displacement by 20% and increase the dur-

ation by 20%, the maximum velocity will not change, but the maximum ac-

celeration will reduce by 20%.

Why select different Motion-Laws?

A motion-law might:

· give more flexibility for you to control the motion-derivatives at the

Blend-Points.

· suit the mechanical system. For example, the motion-law might have a

“low peak maximum velocity”.

· give a good dynamic response to the mechanical system. For example, the

motion-law might have a good response to system backlash, low drive

stiffness.
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· agree with a company preference(!) - for example Modified Sinusoid is of-

ten a company preference.

Note:

I nearly always design my motions with Flexible-Polynomial segments as they

give me almost all of the flexibility I need.

1.6.15 TOP-TIPS

TOP-TIP #1

When you start using MotionDesigner, it is easy accidentally to design a mo-

tion with a very short-segment that you cannot see in the graph, and that you

do not know or want in your motion.

To see if there is a very short SEGMENT:

1. Open the BLEND-POINT EDITOR or the SEGMENT EDITOR 

2. Click the NEXT button, to move the SELECTED-SEGMENT across the com-

plete motion

If you click the NEXT button, but you cannot see the SELECTED-SEGMENT in the

motion graphs, then you have found a very short segment. 

3. Click the Delete Segment  button to remove the very short segment

TOP-TIP #2

On paper, plan you motion over one machine-cycle before you begin with

MotionDesigner.

From your plan, you should:

1. Know if the motion is a progressive or non-progressive motion (indexing

type, or Rise and Return type) 

2. Know how many segments you need in your motion - over a full machine

cycle.

3. Approximate the X and Y-axis positions of each Blend-Point. 

1.6.16 Motion-Law Equations

Motion-law Equations

When there is an equation for each derivative of a motion-law, the output of each

motion-derivative can be evaluated exactly and quickly from one input.

For example:

If the normalized input, x, is 0.5467321892, then it is possible to evaluate ex-

actly the normalized values of Position,Velocity, Acceleration, and Jerk for any

of the motion-laws.

Motion-Laws

The important motion-laws are:

· Dwell

719

872
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· Constant Velocity

· Constant Acceleration -Constant Deceleration

· Simple Harmonic Motion

· Cycloidal

· Polynomial 2-3

· Polynomial 3-4-5

· Polynomial 4-5-6-7

· Modified Sinusoid

· Modified Trapezoid

Motion Functions

Actual Velocity, Acceleration, and Jerk

You can calculate the actual motion-values of each motion-derivative if you know

the Actual Displacement (  ), the Actual Period (  ), and the motion function

Actual Position =

Actual Velocity =

Actual Acceleration =

Actual Jerk =

Dwell

 ; 

 ; 

 ; 

Constant Velocity

 ; 

 ; 

 ; 

872

873

873
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Constant-Acceleration, Constant-Deceleration (CACD)

Simple Harmonic Motion (SHM)

Cycloidal 

Polynomial 2-3
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Polynomial 3-4-5

Polynomial 4-5-6-7

Modified Sinusoid
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Modified Trapezoid



876

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

MechDesigner & MotionDesigner Help -17.1.130



877

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

Index

- . -
.~CXL     38

.~MTD     38

.CXL     38

.CXL.1     38

.DXF     36, 38

.GIF     42

.JPEG     42

.LXL     38

.LXL Library File     35

.MP4 x264     42

.MTD     38

.MTD.1     38

.PNG     42

.ZXL     38

- 2 -
2D-Cam    

Terminology     128, 199, 222, 640

Work-flow     128, 199, 222, 401, 402, 436, 446

2D-Cam Analysis    

Contact-Force     440

Contact-Stress     440

Pressure Angle     440

Radius of Curvature     440

Sliding-Velocity     440

2D-Cam Analysis Notes    

Note 1: Contact Force     443

Note 2: Maximum Shear Stress Assumptions     443

Note 3: Radius of Curvature     443

Note 4: Pressure Angle     444

Note 5: Entrainment-Velocity, Ue     444

Note 5: Sliding Velocity, Ue/2     444

2D-Cam Analysis Parameters    

Contact Force     442

Maximum Shear-Stress     442

Pressure-Angle     442

Radius-of-Curvature     442

Sliding-Velocity     442

2D-Cam Coordinates    

Cam: BiArcs, Chord Error     446

Cam: Export to SolidWorks     446

Cam: Save as DXF     446

Cam: Save as STEP     446

Cam: Save as TXT, ASC     446

Cam: XY-Points, # Points     446

Slot-Cam     446

Toolbar     447

2D-Cam Coordinates Notes    

Note 1: 0,0 of Cam-Coordinates     456

Note 4: Export to SOLIDWORKS data     456

Note 5: Cam as Arcs - Cam-Data     457

2D-Cam dialog    

Cam Life     401

Cam Life - Cam Life Results     430

Cam Life - Cam Material and Hardness     429

Cam-Life tab     428

Cam-Life-: Allow Pitting:?     428

Display     401

Display as Cam-Profile     408

Display as Contact-Force     408

Display as Pressure-Angle     408

Display as Shear-Stress     408

Display Cam Range     403

Display Groove     407

Display Inner     407

Display Outer     407

Display Pitch-Curve     407

Display Radius-of-Curvature     407

Enable Roller and Cam Lifetime calculations     405

Enter Cam-Stress Safety-Factor     405

L10: cycles, hours, years     416

Lnm: cycles, hours, years     416

Minimum Radius Warning     403

Parameters     401

Parameters tab     403

Radius - Undercutting Warrning     403

Roller L10 Lifetime     416

Roller Life     401

Roller Lifetime     412

Roller Lnm Lifetime     416

Roller Manufacturer     412

Roller Part-Number, Diameter, ...     412

Roller tab     412

Save Cam Data button     402

2D-Cam Life    

Example Steels and Categories     433

2D-Cam:    

Cam Analysis     199

Cam-Coordinates     199

- 3 -
3D-Cam    

Preparation     133

Terminology     128, 199, 222, 640

3D-Cam > Cam tab     385

3D-Cam > Display tab     391

3D-Cam > Export tab     393

3D-Cam dialog     384, 385

Cam Mesh Density Parameters     385
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3D-Cam dialog     384, 385

Clearances - Radial, Top, Bottom     389

Display in graphics-area     391

Flank Length     390

Rebuild 3D Cam     394

Save as STEP fi le     394

Save XYZ Data to Files     394

SOLIDWORKS Data Transfer.     393

SOLIDWORKS Paths     393

Taper Roller     386

- 4 -
4 x Assembly Configurations of an RRP Dyad     120

4 x Closures of RRP dyad     120

4-Quadrant Torque-Speed     592

- A -
Acceleration Vector     543

Accelerator keys     26

Active Motion Settings     731

Active Motion Settings > Accessibil ity tab    

Colors     690, 733

Graph Line Thickness     690, 733

Symbol Sizes (Blend-Points)     690, 733

Active Motion Settings > Advanced tab    

'Counts' at Start     689, 732

Counts/Cycle     689, 732

Counts/degree     689, 732

'Units' at Starts     689, 732

Active Motion Settings > Motion tab    

Number-of-Steps in Motion     731

X-axis Units     731

Y-axis Units     731

Active Motion Settings > Number Format tab    

Digits     690, 732

Number Formatting     690, 732

Precision     690, 732

Active Motion Settings >Motion tab    

Number-of-Steps in Motion     688

X-axis Units     688

Y-axis Units     688

Add    

2D-Cam     128

3D-Cam     133

Auto-Profiles     244

Ball-Screw     577

Bevel Gears     146

Conjugate Cam FB     165

Gear-Pair     141

Magnetic-Joint     99

Magnet-Joint     99

Motion-Dimension FB - Special Procedures     179

Motion-Dimension FB to Pin-Joint: General Pocedure  

 
 174

Motion-Dimension FB to Slide-Joint - General
Procedure     176

Pin-Joint - General case     102

Pin-Joint - Special Case     102

Plane to a Line     93

Plane to a Plane     92

Pulley     160

Rack-Pinion     136

Scroll  - Preparation     150

Slide-Joint - General Case     110

Slide-Joint - Special Case     110

Add Joint type:    

Ball      114

Linear     110

Pin     102

Prismatic     110

Revolute     102

Rotary     102

Slide     110

Spherical     114

Add Part     108

Add Plane (Mechanism-Editor)    

Plane to Line     92

Plane to Part's X-axis, Y-axis     92

Plane to Plane     92

Add Plane (Model-Editor)    

Plane to Plane     82

Analyze the Force at a Joint.     230

Application-Settings    

Accessibil ity tab     341

Auto-Profiles tab     341

General tab     341

Graphics tab     341

Number-Format tab     341

Application-Settings: Accessibil ity tab    

Hide menus or toolbars     347

Hints Show/Hide     347

Icon Size     347

Language     347

Sounds On/Off     347

Symobl Size     347

Text Size     347

Application-Settings: Auto-Profiles tab    

Ball-Joint Radius (Default)     349

Bearing Size - BasePart Joint (Default)     349

Bearing Size - Moving Joint (Default)     349

Defualt Sizes     349

Extrusion Depth (Default)     349

Part-Offset     349
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Application-Settings: General tab    

Cam-Follower Radius Warning (Default)     341

DXF Units (Default)     341

Enable Auto-save     341

Image Quality (Default)     341

Number of Backup Files     341

Number-of-Commands to Auto-save     341

Application-Settings: Graphics tab    

Graphic Colors     345

Graphic Options     345

Application-Settings: Number-Format tab    

Data Output Format     343

Dimension Font     343

Dimension Format     343

List Separator (Data and Cam-Coordiantes)     343

Number Format     343

Show Dimension (element) Names     343

Vector Number Format     343

Assembly-Tree    

Element icon     316

Element name     316

Elements added to the model     316

Select Elements     316

Auto Rebuild     49

Auto Update     49

Auto-Profiles     244

Add     244

Delete     244

Auto-save     341

- B -
Backup    

File Open     32

Backup fi le-names     32

Ball-Joint dialog    

Ball-Diameter     559

Ball-Mass     559

Ball-Offset     559

Barrel Cam     384

Blend-Curve     286

Drag-Handles     284

Edit Approximately with Drag-Handles     552

Edit Exactly with Dialog-box     550

What is?     287

Why use?     287

Blend-Curve dialog    

Angle     549

Curvature     549

Curvature Rate     549

Velocity-Scaling     549

Blend-Curve Drag-Handles     286

Blend-Point and Segment toolbar:    

Add a segment after the last segment     718

Add segment to left of Selected-Segment     718

Append Segment     718

Delete the Selected-Segment     719

Insert Blend Point approximately (with
Mouse-Pointer)     720

Insert Blend-Point exactly at...     720

Insert Segment     718

Open Data-Transfer Table     722

Toolbar     716

BLEND-POINT EDITOR     692

BLEND-POINT EDITOR:    

Blend-Point #     693

Blend-Point Number     693

Control Button Patterns     700

Control Button States     700

WARNING -"Bumping" Blend-Points     696

X-axis motion-value     695

Y-axis Control-Buttons     698

Y-axis motion-values     698

Briefcase dialog    

Add/Remove FBs     518

Display Options     518

Briefcase FB dialog     518

Browse to PSMotion Account.     76

Bugs and Slugs     20

- C -
CAD    

Solids     337

Synchronize all  Solids from CAD     337

CAD-Control dialog     486

CAD-Line    

DXF tab     372

Move CAD-Solid     383

CAD-Line - DXF tab    

Align DXF with CAD-Line     373

Convert DXF Elments to MD Lines and Arcs     374

Element Selection     372

CAD-Line dialog     364

Import SOLIDWORKS fi le     365

Mass Properties tab     367

SOLIDWORKS Configurations     365

SOLIDWORKS tab     365

STL Import     376

Total Mass Properties from CAD     370

CAD-Line -Import STL File     377

Cam Law     755

Cam Law: Constant Acceleration     759

Cam Law: Constant Velocity     762, 765

Cam Law: Cubic     767



880

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

Index

Cam Law: CV Inverse-Crank     836

Cam Law: Cycloidal     769

Cam Law: Cycloidal CV 50%     814

Cam Law: Cycloidal CV50     772

Cam Law: Dwell     775

Cam Law: Flexible Polynomial     777

Cam Law: Low Impact at Crossover     788

Cam Law: Modified Sine CV 20%     814

Cam Law: Modified Sine CV 33%     814

Cam Law: Modified Sine CV 50%     814

Cam Law: Modified Sine CV 66%     814

Cam Law: Modified Sinusoid / Mod Sine     790

Cam Law: Modified Trapezoid / Mod Trap     793

Cam Law: Polynomial 23     796

Cam Law: Polynomial 345     799

Cam Law: Polynomial 4567     801

Cam Law: Quadratic     806

Cam Law: Ramp     808

Cam Law: SCCA     814

Cam Law: Simple Harmonic Motion     811

Cam Law: Sine-Constant-Cosine     814

Cam Law: Sine-Squared     818

Cam Law: Sinusoidal     820

Cam Law: Throw     779

Cam Law: Throw 1     780

Cam Law: Throw 2     782

Cam Law: Throw 3     784

Cam Law: Throw 4     786

Cam Law: Trapezoidal Velocity     814

Cam Law: Triple Harmonic     822

Cam Law: Triple Harmonic Modified Sine     825

Cam Law: Triple Harmonic Modified Trapezoidal     826,
828

Cam Terminology     640

Cam-Calculation    

Calculation Status     450

Cam-Coordiantes dialog-box     447

Cam-Coordinates    

Export a Smooth Cam     648

Solid Edge: Curve by Table, Insert XYZ data     648

SolidWorks: Insert Curve XYZ     648

STEP fi le Options.     452

Cam-Data dialog     440

Cam-Data FB    

Link wto a 2D-Cam     440

Cam-Data Function-Block     440

Cam-Law Coefficients     839

Cam-Laws     741

Camlinks: Show / Hide     213

Cannot start the Part-Editor     261, 668

Change Closure of Assur-Group     119

Change Closure of Dyad     119

Check for Updates     76

Chinese Traditional font    

SOLIDWORKS: name of Configuration feature     365

Chordal Action     293

Clipping     70

Clock     458

Close     48

Closure     119

Colors    

Part-Outlines     653

Command-Manager     313

Configure Power Source     232, 323

Colors for Vectors     590

Conjugate Cam     438

Configure Power Source - R10     589

Configure Power Source dialog     589

Conjugate-Cam dialog     436

Connecting-Part - Length     117

Connecting-Part - Radius     117

Constraint toolbar    

Add Coincident     306

Add Concentric     305

Add Equal     304

Add Horizontal     298

Add Mid-Point     301

Add Parallel     303

Add Perpendicular     302

Add Tangent     300

Add Vertical     299

Continuous-Crank dialog     535

Rotate Crank - inverse-kinematics     535

Continuous-Crank FB     221

Copy sketch-elements     125

Coupler Curve     122

Crank    

Clockwise / Counter Clockwise     172

CSV - Motion Timing Diagram.     43

Curvature and Curvature Rate Notes     553

Curve     122

Cylindrical Cam     384

- D -
Data Import - Point-Cloud     521

Data-box    

Contextual menu     631

Data-Channels    

Data on Wires     167

Data: Units     167

Data: Wire Channels     167

Data-Transfer Table    

Export Motion Data     744

Import Motion Data     744
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Data-Transfer Table    

Open Motion TXT, CSV, DAT fi le-types     744

Overlay-Trace     744

Save  motions as TXT, CSV, DAT fi le-types     744

Data-Value    

Edit     631

Data-Values and Data-Channels     166

Definition    

kinematically-defined     656

Positive direction of Slider     188

Delete    

Coincident Constraint     306

Concentric Constraint     305

Equal Constraint     304

Geometric Constraint     297

Geometry Constraint     297

Horizontal Constraint     298

Mid-Point Constraint     301

Parallel Constraint     303

Perpendicular Constraint     302

Sketch Constraint     297

Tangent Constraint     300

Vertical Constraint     299

Delete Dependent Elements     617

Delete-Element     54

Design-Set dialog     528

Add Element-Rows     529

Lock / Unlock Design-Set     529

Rebuild     529

Remove Element-Rows     529

Dialog    

2D-Cam     401

2D-Cam - Cam Life tab     428

2D-Cam - Display tab     407

2D-Cam - Parameters tab     403

2D-Cam - Roller Life tab     411

3D-Cam     384

ACTIVE-MOTION SETTINGS     731

Application-Settings     341

Apply settings to Input Y#     481

Ball-Joint     559

Ball-Screw     577

Blend-Curve     549

BLEND-POINT EDITOR     692

CAD-Line     364

CAD-Line - Display Option tab     381

CAD-Line - DXF tab     371

CAD-Line - Mass Properties tab     367

CAD-Line - SOLIDWORKS tab     365, 376

Cam-Coordinates     446

Cam-Data     440

CamLinks     37

CONFIGURE MOTION-SETTINGS     731

Configure Power Source     589

Conjugate-Cam FB     436

DATA-TRANSFER TABLE     744

Dimension     547

Download Example Models     76

DXF Layer Editor     376

DXF-Element     354

Extrusion     360

Feedscrew / Scroll      583

Function-Bloc : CAD Control FB     486

Function-Block : Briefcase FB     518

Function-Block : Continuous-Crank FB     535

Function-Block : Design-Set FB     528

Function-Block : Force-Data FB     541

Function-Block : Gearing FB     459

Function-Block : Graph FB     477

Function-Block : Linear Motion FB     458

Function-Block : Linear Motor     538

Function-Block : Math FB     509

Function-Block : Motion FB     462

Function-Block : Motion-Dimension FB     466

Function-Block : Motion-Path FB     469

Function-Block : Parameter-Control FB     497

Function-Block : Pattern FB     500

Function-Block : Point Cloud FB     521

Function-Block : Point-Data FB     484

Function-Block : Polynomial-Fit FB     491

Function-Block : Spring FB     538

Function-Block : Statistics FB     488

Gear-Pair     566

Graph Settings     481

Graph Title     481

Gusanos     583

Import SOLIDWORKS sketch FB     555

Infeed Screw     583

INSERT BLEND-POINT AT     720

Machine Settings: Cycling Parameters     351

Machine-Settings     351

Magnetic-Joint     560

Make Movie     605

Mass-Properties - User defined     368

Model Options     337

Motion FB     462

Motion-Path FB     469

OK, Cancel, Reset, Help     332, 627

Plane     356

Point Properties     543

Point Vectors and Positions     543

Point-Cloud, Curve-Fitting Tool     521

Profile     360

Pulley     581

Rack-Pinion     577

Rename     335
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Dialog    

Rename Element     335

SEGMENT EDITOR     704

Select Elements     616

SWEEP-DISPLAY     733

Tortil las sin fin     583

Transition-Curve     557

View References     618

Worm     583

Dialogs     332

List of ...     332

Diametric Pitch     566

Dimension    

Angle - 2 Lines     269

Angle - 3 Points     269

Arc radius     269

Circle radius     269

Horizontal     269

Horizontal Distance     272

Line length     269

Parallel     269

Parallel Distance     272

Perpendicular [Point to Line]     269

Perpendicular Distance     272

Point to Point     272

Two Points     269

Vertical     269

Vertical Distance     272

Direction of Gravity Vector     85

Display DXF File     371

Display toolbar     67

Download Local Help     72

Download Off-Line 'Local Help'     76

Download SolidWorks Type Libraries     76

Drag    

Add Part     109

Driven Dimension     193

DXF    

Terminology     371

DXF Drawing    

Cannot see.     373

DXF Element    

Edit DXF Units     355

Edit File     355

DXF Element Name - example     373

DXF Layers    

Colors     376

Show / Hide     376

Dyad    

Closure     647

- E -
Edge Angle Limit     377

How to improve CAD-Solid appearance.     379

How to reduce STL fi le-size     379

Edit    

Magnetic-Joint     560

Edit a CAD-Line     364

Edit Element     53

Special Case     629

Edit menu    

Application-Settings     57

Auto Rebuild     49

Delete element     54

Edit element     53

Machine-Settings     56

Rebuild Now     50

Redo     55

Show Command History     51

Undo     55

Edit Phase of Motion     172

Edit Plane    

Angle     356

Move Plane to end-Point     356

Offset     356

Parameters     356

Rotate about X-axis     356

Rotate about Y-axis     356

Rotate about Z-axis     356

Edit Scale of Motion     172

Edit value of a parameter     631

Editor    

Mechanism     88

Model     79

Part     257

Element    

CAD-Line     364

Delete     54

Delete Profile     647

DXF-Element     354

Kinematic-Data     609

Properties     609

Rename     634

Element Explorer    

Assembly Tree     315

Geometry Tree     315

Kinematics Tree     315

Elements     98

View References     311

Element-Visibil ity toolbar     61

Engineering Units     351
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Evaluate Motion-Values     733

Exit     48

Exploring the Kinematics-Tree     319

Export 3D-Cam to:    

SOLIDWORKS     384

STEP     384

Extrusion    

Depth     360

Mass     360

Offset     360

Save as STEP fi le     360

Extrusion dialog     361

Color     362

Extrusion-Depth     361

Extrusion-Offset     361

Graphics Quality     362

Mass     363

Mass Properties     363

Material Density     363

Moment of Inertia     363

Opacity     362

Part-Offset     361

Show/Hide     362

Extrusion Mass     360

Extrusion Mass Moment of Inertia     360

- F -
FAQ     621

Lighting     639

Why so dull?     639

FAQ  - Model-Editor:    

Why can't I Spin or Pan the model with the Drag
technique?     641

FAQ - Mechanism-Editor:     653

2D-Cam - Road-map of different elements     658

How many Kineamtic-chains can I add?     661

How many Mechanism-Editors can I add?     661

I cannot select the Part-Outline. What to do?     656

Motion-Dimension FB - Problem, Troubleshooting    
660

Solid Modelling and hierarchy of Extrusions     655

What are the different colors for Part-Outlines?     653

What does kinematically-defined mean?     656

Why are the Vector values in the graphics-area
differnt to those in a Graph FB?     662

Why can I not see all  of the BasePart?     659

Why cannot I add a Motion Dimension FB     660

Why can't I Spin or Pan the model with the Drag
technique?     653

Why is the BasePart not Green?     659

FAQ - Part-Editor:    

About Negative dimension     678

Can I edit the Part-Outline?     677

Colors used in the Part Editor?     681

How do I know I am using the Part-Editor?     676

How many Parts can I edit at one time?     674

Trouble-shooting     679

Why edit a Part?     674

Why isn't there any Geometry in the Base-Part?     679

FAQ ...    

What are the System Requirements     636

Why is taking so long to add or edit my model?     639

Why so many fi les?     638

FAQs    

General     635

Part-Editor     673

What is a Motion?     858

Where is the Spin-Box tool?     859

FAQs, How....?    

General     623

Feedback Area    

Animation Speed     326

Extended Hints (Tool-Tips)     326

Force and Torque Arrow Vector     326

Master Machine Angle     326

Message Window     326

Feedback Area - Clear Messages from Message Area     326

Feedback Area - Extended Hints     326

Feedback Area - Message Area     326

Feedback Area - Vector Scales    

Scale Force & Torque Vectors     327

Scale Velocity & Acceleration Vectors     327

Feedback Area -Animation Speed Slider     328

Feedscrew dialog    

Feedscrew Data Transfer to SOLIDWORKS     585

Feedscrew Range     584

Mesh Density     584

SolidWorks Paths     586

Surface,Rims, Colour, Transparency.     585

File Locations     14

File menu     31

Exit     48

Import Library Model     45

Make Movie     42

New     32

Open     32

Open .CXL     32

Open .CXL.1     32

Open .MTD     32

Open .MTD.1     32

Open .ZXL     32

Open DXF File     36

Open LXL Library File     35

Open MEC fi le-types     37

Print Screen Image     42
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File menu     31

Printer Setup     42

Save     38

Save as     39

Save Screen Image     42

Save Timing Diagram.     43

File toolbar     31

Filters    

Dimensions     68

Selection Filters     68

Filters menu     67

Follower-Roller    

Reliabil ity Factor, a1     419

Follower-Roller Manufacturers:    

FAG     412

INA     412

KOYO     412

NSK     412

SKF     412

THK     412

Force at a Point     541

Force Data FB    

Select Joint, Cam, or Spring     230

Select Point     230

Force toolbar    

Spring FB     234

Force Vector - Colors     589

Force Vectors    

Colors of the Vectors and Part-Outlines.     238

Display     237

Show if active...     237

Force Vectors - show/hide     589

Forces menu     226

Configure Power Source     232

Force Vectors: Calculate     229

Force Vectors: Display     237

Force-Data FB     230

Spring FB     234

Forces toolbar    

Add Force Data FB     230

Configure Power Source     232

Force Vectors: Calculate     229

Force Vectors: Display     237

Function-Block    

Gearing     459

Function-Block menu    

Cam-Data FB     199

Gearing FB     172

Graph FB     202

Linear-Motion FB     170

Measurement FB     193

Motion Dimension FB     174

Motion Dimension FB - Special Case     174

Motion Dimension Rocker     174

Motion Dimension Slider     174

Motion FB     173

Motion-Path FB     191

Point-Data FB     197

Function-Blocks menu     165

Briefcase FB     208

CAD Control FB     219

Continuous-Crank FB     221

Design-Set FB     217

Math FB     215

Parameter-Control FB     216

Pattern FB     213

Point-Cloud FB     206

Polynomial Fit FB     211

Statistics FB     209

Furgusen     133

- G -
Gear Centres: Distance between Centres     566

Gear Design Parameters     566

Gear Segments     566

Gearbox Database     592

Gearbox-Sizing     592

Gearing Definitions     566

Gearing Equations     566

Gearing FB     459

Gearing FB dialog     459

Gear-Pair dialog     567

Addendum     566

Adjustments     568

Dedendum     566

Define tab     567

External     566

Gear Mesh     566

Gear Mesh and # Teeth     567

Gear Segmentation Parameters     567

Internal     566

Line-of-Centres     566

Mesh     566

Module     566

Number-of-Teeth     566

Parameters - Gear-Tooth     569

Pressure Angle     566

Read-Only Gear-Parameters     571

Gears    

Terminology     141, 566

General Menus and Toolbars     30

Geometry menu     265

Arc     282

Blend-Curve     286
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Geometry menu     265

CAD-Line     279

Circle     278

Coincident     306

Concentric     305

Constraint: Merge Points     291

Dimension     269

Equal     304

Horizontal     298

Line     277

Mid-Point     301

Parallel     303

Perpendicular     302

Point     275

SOLIDWORKS Import Sketch     289

Spline     284

Tangent     300

Transition-Curve     293

Vertical     299

Geometry toolbar    

Add Arc     282

Add Blend-Curve     286

Add CAD-Line     279

Add Circle     278

Add Dimension     269

Add Line     277

Add Point     275

Import SOLIDWORKS Sketch     289

Merge-Points     291

Transitkion Curve     293

Geometry-Tree    

Constraints     324

Dimensions     324

Sketch-Elements     324

Globoidal Cam     133, 384

Graph dialog    

Graph toolbar     478

Graph FB    

Data-Channel Options     204

Graph-Settings     480

Graph FB dialog     477

Y-axis display options     479

Graph Interface     203

Graph of Force Data     477

Graph of Motion data     477

Graph Settings    

Graph Automatic Axes     480

Graph Axes     480

Graph Line Colour     480

Graph Min - Max     480

Graph Title     480

Y-Axis and X-Axis Scales     481

Graphics-Area     79

Gravity Vector Direction     85

- H -
Help About dialog    

SOLIDWORKS Type-Libraries     74

Help menu    

About     72, 74

Edit Language DataBase     72

Local Help     72

On-line Help     72

Tutorials     620

Hints     313

Hot keys     26

Hotkeys     26

Hover Technique     291

How to ...     621

Add a 2D-Cam     128

Add a Part     109

Add a sketch-loop     672

Add Constraints     296

Add dimensions to sketch-elements     270

Add Pin-Joint - Special-Case     107

Change Dyad Closure     647

Change the assembly configuration of mehanism    
119

Change the Closure of a Dyad / Mechanism     119

Connect Function-Blocks     166, 643

Delete / Remove an Auto-Profile     242

Delete a Constraint     297

Delete a Profile     645

Delete an Extrusion     255

Delete Constraints     296

Delete Geometric Constraints     672

Delete sketch-elements     671

Deselect the active command     626

Design a Motion.     848

Dimension a Point     270

Display Acceleration Vectors     643

Display Velocity Vectors     643

Drag a Trace-Point     275

Edit a 2D Cam     643

Edit a Ball-Joint     114

Edit a Dimension     547

Edit a dimension.     270

Edit a parameters with the Spin-box tool     632

Edit a Value in a data-box     850

Edit an Extrusion     255

Edit an Extrusion Element     645

Edit the Length of a Connecting-Part     117

Edit the Length of a Part     670

Edit the Radius of a Connecting-Part     117

Edit the start of the motion     853
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How to ...     621

Edit the value of a parameter     631

Edit, Save, and Move my Settings / Styling / Theme    
624

Exit (close) the Part-Editor     263

Find the Motion-Values anywhere in a motion.     854

Float or Dock MotionDesigner     847

Hover and Merge Points     672

Improve a Motion Design     870

Link a motion to move a Part     329

Merge Points     672

Merge Points for a Sketch-loop     672

Model a Pin in a Slot     647

Move a Mechanism Editor to a different Plane     35

Move a Motion-Dimension     647

Open a dialog     627

Open the Blend-Point Editor     692

Open the Configure Power Source dialog     651

Open the Magnetic-Joint FB.     561

Open the Segment Editor     704

Rename a Motion.     846

Rename an element     634

save elements to a DXF fi le     635

Scroll      150

Select a different Motion-Laws     741

Show/Hide different types of element     61

Start the Part-Editor - Methods 1 to 4     259, 666

Start(open) the Part-Editor     259, 666

Stop Solids turning red in the Model-Editor.     641

Use the Control Buttons     700

Use the Spin-box tool     632, 851

How to ...?    

General     623

Mechanism-Editor     643

Part-Editor     665

- I -
Import    

DXF     36

DXF Drawings     364

Mass Properties from CAD model     364

MEC     37

SHP     37

SOLIDWORKS Parts and Assemblies     364

SOLIDWORKS Sketch     289

STL fi le     364

Import Library File interface     46

Import Library Model     45

Import Mass Properties from CAD     369

Import motion-values to a Position List segment-type    
803

Import motion-values to a Z-Raw Data List segment-type    
834

Import motion-values to an Acceleration List segment-type

 
   758

Import SOLIDWORKS document    

Color     381

Coordinate Systems and SOLIDWORKS     366

Display Options     381

Import File Quality from SOLIDWORKS     366

Show / Hide     381

Transparency     381

Inch the Machine-Angle     327

Instructions     313

Internet Menu     76

Inverse-Kinematics    

Continuous-Crank     535

- J -
Jog the Machine-Angle     327

Joint    

Ball-Joint     114

Linear Slide     110

Magnet     99

Magnetic     99

Prismatic     110

Slide     110

Spherical-Joint     114

- K -
Keyboard Short Cut    

ALT+ C : Run or Cycle Machine     58

B : Step Backward     58

F : Step Forward     58

Home : Move the Master MAchine Angle to 0     58

Keyboard Shortcut    

INS : Add Part     108

Insert key : Add Part     108

Kinematic elements toolbar     98

Add Trace-Point     122

Ball-Joint     114

Change Dyad Closure     119

Magnetic-Joint     99

Part     108

Pin-Joint     102

Reference Geometry     125

Slide-Joint     110

Kinematic FB toolbar    

Cam-Data FB     199

Clock     170

Gearing FB     172

Graph FB     202
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Kinematic FB toolbar    

Linear-Motion FB     170

Measurement     193

Motion-Dimension FB     174

Motion-Path FB     191

Point-Data FB     197

Kinematic FB tooolbar    

Motion FB     173

Kinematics toolbar     98

Kinematics Tree    

Brocken Chains     320

Dyads     318

Geared Rocker     318

Kinematically Defined Chain     318

Kinematic-Chains     318

Motion-Parts     318

Rocker     318

Slider     318

Solved Chains     320

Known Bugs     20

- L -
Lighting    

Ambient     337

Diffuse     337

Edit     337

Model     337

SolidWorks Lighting     337

Specular     337

XYZW     337

Line of Centres     566

Linear Motion dialog     458

Line-of-Centres     141

List Segment-Type    

Acceleration List     758

Position List     803

Z-Raw Data     834

List Segment-Types     756

Locus     122

Low Impact at Crossover     788

- M -
Machine elements toolbar     127

2D-Cam     128

3D-Cam     133

Ball-Screw     136

Conjugate Cam FB     165

Feedscrew     150

Gear-Pair     141

Gear-Pair [Bevel]     146

Pulley     160

Rack-Pinion     136

Scroll      150

Machine Settings dialog    

Cycling Parameters     351

Engineering Units     352

Note 1: Machine vs Animation Speed     353

Note 2: Number-of-Steps - Warning / Reminder     353

Note 3: Engineering Units     353

Machine Speed     351

Machine-Clock     458

Machine-Settings dialog    

Cycle Speed     351

Cycles / minute     351

Engineering Units     351

Kinematic Speed     351

Machine Speed     351

Number-of-Steps     351

Parts per Minute     351

RPM     351

Simulation Speed     351

Units     351

Magentic-Joint     99

Magnetic Joint     99

Magnetic-Joint dialog    

Advanced     563

Curve Follow Inside     560

Curve Follow Outside     560

Curve Following     560

Path Following Options     562

Probe Compensation     560

Radius Control     560, 562

Magnet-Joint     99

Make Movie     42

Make Movie dialog    

End-Angle     606

File-types     605

Frame Position     606

Frame Size     606

Include Last Frame?     606

Movie File-name     606

Movie File-type     606

Movie or Single-Shot     606

Number of Frames     606

Number of Images     606

Start-Angle     606

Mass Properties    

Center-of-Mass     367

Inertia     367

Mass     367

Mass Moment of Inertia     367

Radius of Gyration     367

Master Machine Angle / Revs    
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Master Machine Angle / Revs    

Approximate Machine Angle     327

Exact Machine Angle     327

Math FB dialog     509

Add Input-Connector     509

Add Output-Connector     510

Calculator     514

Connectors     509

Equation-Editor     510, 514

Output Data-Type     509, 510

Output Units     510

Units     510

Update Button     510

Update Equations     510

MD-Solid (Extrusion)     360

MD-Solids menu     239

Add Polyline     246

Auto-Layer     240

Auto-Profile     242

Hole     251

Profile / Extrusion     253

Show or Hide Extrusion     249

MD-Solids toolbar    

Auto-Layer     240

Auto-Profile     242

Hole     251

Polyline     246

Profile / Extrusion     253

Show or Hide Extrusion     249

Measure    

Force     541

Statistics of Data     488

Measure (Driven-Dimension)    

Angle: Three Points - (Internal and External)     193

Angle: Two Lines     193

Angle: Two Points     193

Distance: Line and Point     193

Distance: Two Points     193

Measurement FB    

Angle - Line to Line     195

Angle - Point to Point     194

Dimension - Length     194

Dimension - Radius     194

Distance - Line to Line (Parallel)     194

Distance - Point to Line     194

Distance - Point to Point     194

Measurements in Mechanism Editor    

Angle: Three Points     193

Angle: Two Lines     193

Angle: Two Points     193

Distance: Line and Point     193

Distance: Two Points     193

MEC     37

Mechanism menu     95

2D-Cam     128

3D-Cam     133

Add Mechanism     85

Add Mechanism (Editor)     95

Add Plane     82, 92

Ball-Joint     114

Ball-Screw     136

Change Dyad Closure     119

Conjugate Cam FB     165

Feedscrew     150

Gear-Pair     141

Gear-Pair [Bevel]     146

Kinematic     98

Magnetic-Joint     99

Mechanism (Editor)     95

Part     108

Pin-Joint     102

Pulley     160

Rack-Pinion     136

Reference Geometry     125

Scroll      150

Slide-Joint     110

Trace-Point     122

Mechanism Synthesis     215

Mechanism-Editor:     88

FAQs, How to ...?     642

Mechanisms menu     90

MechDesigner Reference Help     11

MechDesigner Reference Help: R17     25

MechDesigner.chm     72

MechDesigner.INI     57

MechDesigner.XML     57

Memo    

Close     331

Open     331

Memo: Automatically Open on Start     331

Menu    

Add > Geometry     265

Add > Geometry > Constraints     296

Display Filters     67

Edit     49

File     31

Filters     67

Forces     226

Function-Blocks     169, 206

Help     72

Internet     76

MD-Solids     239

Mechanism     127

Mechanism > Add Mechanism     85

Mechanism > Add Plane     82, 92

Model elements     91
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Menu    

Run     58

Selection Filters     67

View     70

Merge fi les     45

Merge-Points    

Sketch-loop     291

Model    

Lighting     339

Model elements toolbar     81

Add Mechanism     85

Add Plane     82, 92

Mechanism (Editor)     95

Model elements toolbar [Mechanism-Editor]:     91

Model-Editor     79

How to stop Solids turning Red     641

Model-Editor:    

FAQs, How to...?     641

Modeling FB toolbar    

Briefcase FB     208

CAD Control FB     219

Continuous-Crank FB     221

Design-Set FB     217

Math FB     215

Parameter-Control FB     216

Pattern FB     213

Point-Cloud FB     206

Polynomial Fit FB     211

Statistics FB     209

Stats FB     209

Modelling FB toolbar     206

Motion Advance     170

Motion Analysis    

Measurement FB     193

Point Data FB     197

Motion Continuity along Curve     549

Motion Delay     170

Motion Design Considerations:     860

Blend-Points and Segments     860

Dynamic-Considerations     866

Motion Blending     861

Motion Continuity     861

Motion Smoothing     861

Period Ratio     866

Residual Vibration     866

Segment Blending     861

Motion FB    

Motion-Path FB and Range     475

Output Data-Type     475

Motion FB > Motion-Parameters    

Accumulate Output     462

Output Data-Type     462

Reset Output     462

Select Motion     462

Motion FB dialog     462

Motion Law - see Cam-Law     755

Motion name-tab     683

Motion Retard     170

Motion Study    

Measurement FB     193

Point Data FB     197

Motion Symbols     685

Motion Terminology     685

Motion toolbar    

Motion-Law Selector     741

Motion-Value Evaluator     743

Motion-Width     742

Motion Values at Pointer     684

Motion: Advance, Before, Earlier     172

Motion: Data-Transfer Table     744

Clear Data     747

Copy Data     748

Copy Data in table to Clipboard     748

Cut Data     748

Delete Data     749

First-Last Point Toggle     754

Get 'List' Data in Sgement     749

Get Motion Data     750

Get Segment Data     751

Import Data     747

Load Data     747

Overlay-Trace     751

Paste Data in Clipbard to Table     749

Put Data     750

Put Data to List Segment     750

Save Data     747

Motion: Delay, After, Later     172

Motion: Edit toolbar     730

Active Motion Settings     731

Auto-Update     734

Redo     730

Sweep-Display     733

Undo     730

Motion: File toolbar     723

Add New Motion     723

Delete Active Motion     729

Open & Append Motion     724

Open .DA, .MTD, .SHP fi le-types.     724

Print All  Motions     729

Print Motion     729

Save Active Motion...     727

Save all  motions as...     725

Save all  motions...     724

Save as Jetter DA fi le type     727

Save Motion Motion As: .da,.mtd,.shp     727

Motion: Motion toolbar     741
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Motion: View toolbar     738

Acceleration Graph     739

Jerk Graph     739

Pan Left     740

Pan Right     740

Position Graph     738

Show Acceleration     739

Show Jerk     739

Show Position     738

Show Velocity     739

Velocity Graph     739

Zoom Extents     739

Zoom-in     739

Zoom-out     740

MotionDesigner    

...from MechDesigner     329

Dock or Float     66

Redock     681

Undock     681

MotionDesigner FAQs     844

MotionDesigner How to...     844

MotionDesigner R17.1    

Welcome     681

MotionDesigner Reference Help     11

MotionDesigner Reference:     688

MotionDesigner Toolbars     683

Motion-Dimension dialog     466

Motion-Law Coefficients    

Ca, Cv, Cc, Pc, Q     839

Motion-Law Equation    

CACD     873

Constant Acceleration-Constant-Deceleration     873

Constant-Velocity     872

Cycloidal     873

Dwell     872

Modified Sionusoid     874

Modified Trapezoid     875

Mod-Sine     874

Mod-Trap     875

Polynomial 2-3     873

Polynomial 3-4-5     874

Polynomial 4-5-6-7     874

SHM     873

Simple Harmonic Motion     873

Motion-Law Select     741

Motion-Law:    

Acceleration List     758

Constant Acceleration     759

Constant Velocity     762

Constant Velocity - Specify 2 Positions     765

Constant-Jerk     767

Cubic     767

CV Inverse-Crank     836

Cycloidal     769

Cycloidal CV50     772

Dwell     775

Flexible Polynomial     777

Low Impact at Crossover     788

Mod Sine     790

Mod Trap     793

Modified Sinusoid     790

Modified Trapezoidal     793

Parabolic     759

Polynomial 23     796

Polynomial 345     799

Polynomial 4567     801

Position List     803

Quadratic     806

Quick-Return 1: Finite Jerk     780

Quick-Return 2: Continuous Jerk     782

Ramp     808

Ramp as Aysmmetric motion-law     808

Ramp as Cycloidal CV50 motion-law     808

Rapid-Return 1: Finite Jerk Start/End/Mid-Point     784

Rapid-Return 2:, Smooth-Start/End     786

SCCA     814

SCCA as Traditional Motion-Law     814, 816

SHM     811

Simple Harmonic Motion     811

Sine-Constant-Acceleration-Cosine.     814

Sine-Squared     818

Sinusoidal     820

Throw     779

Throw 1     780

Throw 2     782

Throw 3     784

Throw 4     786

Triple Harmonic     822

Triple Harmonic: 'Modified Trapezoidal'     826

Triple Harmonic: 'Zero-Jerk at Cross-over'     828

Triple-Harmonic: 'Modified-Sine'     825

Y-Inverse-Sinusoid     830

Z-Raw Data     834

Motion-Laws    

Standard     755

Traditional     755

Motion-Laws Compared     864

Motion-Path dialog     469

Data Dispaly in Graphic Area     471

Point List     471

Motion-Path FB    

Belt Tooth-Pitch     474

Control Path Length with Dimension     472

Dialog box     469

Point Parameters     470

Motor Database     592
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Motor Elements     589

Move a Point along a Curve / Sketch     469

Move a Point along a sketch-path     469

Movie    

Step Forward     58

- N -
Negative Dimensions - why?     678

New File     32

Normal Constraint     302

Normalized Motion Coefficients     839

Number of Graph Steps or Points     351

Number of Teeth: Rack-Pinion     577

Number-of-Steps in a Machine Cycle     351

- O -
Open a motion, add it as a new Motion name-tab.     724

Open CAD-Line dialog     364

Open Camlinks MEC File-type     37

Open dialog    

Selection-Window     627

Open DXF File     32

Open DXF File-Type     34

Open LXL - Library File     32

Open: Allen-Bradley Logix 5000 TXT fi le-type     724

Open: Jetter DA fi le-type     724

Optimization     217

Overlay-Trace    

Prepare the Data     753

- P -
Parameter-Control dialog     497

Parameter-Value    

Edit     631

Part    

Colors     653

Connecting-Part     117

Part-Editor     257

Geometry toolbar     265

Rules of Merge-Points and Coincident Points     297

Sketch-elements toolbar     265

Part-Editor:    

FAQs, How to...?     664

Over-Constrain sketch-elements     297

Part-Outline    

Colors     653

Path     122

Pattern dialog     500

Enable Pattern     500

Motions to Linearize     501

Pattern Elements tab     500

Pattern Type     500

Pattern Visibil ities - Phases     503

Pattern Visibil ity     504

Phase Visibil ity tab     503

Select Pattern-Elements     501

Pattern FB    

Add     213

dialog     500

Pin-Joint    

Compound Pin-Joint     103

Pin-Joint - Special Case     103

Two or more Coincident Pin-Joints     103

Plane Definition:    

Angle from Line     357

Offset from Plane     356

Plot Graphs     477

Plot motion and force values over a machine-cycle.     202

Point Acceleration     543

Point Data dialog     484

Point Force     541

Point Locus     122

Point Motion Vectors    

Acceleration, Velocity     543

X Velocity Component     543

Y Velocity Component     543

Z Velocity Component     543

Point Positi ion    

Fix Constraint     543

Lock & Specify     543

Position in Mechanism Coordinates     543

Position in Part Coordinates     543

Point Position - Mechanism Coordinates     545

Point Position in Part Coordinates     545

Point Position.     545

Point Velocity     543

Point-Cloud and Curve Following     560

Point-Cloud dialog     521

Data Accuracy - Thoughts and Approximations     526

Data-File Formats     523

Feedback Messages     524

Fit Curve to data     524

Import Data     521

Message     524

Point-Cloud Options     522

Points    

centre-Point     275

end-Point     275

start-Point     275

Polygonal Action     293

Polynomial 23     796

Polynomial Fit dialog    
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Polynomial Fit dialog    

Acquire and Save toolbar     492

Algorithm Settings     494

Graph toolbar     495

RMS Erorr P.V.A. results     493

Settings     494

Positive direction of Sliders     174

Preferences     57

Print graphics-area.     42

Printer Setup     42

Program-Settings     688

Project Explorer    

Command-Manager     308

Element-Explorer     308

Selection-Window     308

Pulley / Belt    

Terminology     160, 581

Pulley dialog    

Number of Teeth on Pulley     582

Number-of-Teeth     581

Read Only: Belt Length     582

Read Only: Drive or Driven Pulley?     582

Read Only: Tooth Pitch     582

Release 10     582

- Q -
Query     464

- R -
Rack and Pinion Gear Parameters     579

Rack Pinion Design Parameters     577

Rack-Pinion dialog    

Addendum     577

Ball-Screw parameters     580

Dedendum     577

Enable Rack-Pinion OR Ball-Screw.     577

Gear Mesh     577

Gear Tooth tab     578

Mesh     577

Module     577

Number-of-Teeth     577

Pressure Angle     577

Ramp     808

Ram-P dyad     191

Ram-R dyad (Scissor-Lift Cyclinder)     191

Rebuild Now     50

Redo     55

Remove element     54

Rename    

Dialog     335

Rename Element     335, 634

Rename motion     683

Report a Bug     76

Request a Feature     76

Reset to Factory Setting     57

Restore size of Maximised 'Open' or 'Save As..' dialog.     31

Reverse-Engineer Cams     99

Right-Angle Constraint     302

Robot Path     191

Roller Gear Drive     133

Roller Lifetime    

a1     413

aiso     413

Contamination-Factors     413

ISO 281 Modification Factors     413

Oil Temperature     413

Oil Viscosity     413

Reliabil ity Factor     413

Run menu    

Cycle     58

Home     58

Run     58

Step Backward     58

- S -
Save    

File     38

Save 3D-Cam as:    

SLDCRV file-type     384

STEP fi le-type     384

Save as     39

.CXL     39

.DXF     39

.DXF Mechanism     39

.DXF Part     39

.LXL     39

.MTD     39

.ZXL     39

Save as .ZXL     48

Save as...    

ZXL fi le-type     40

Save Extrusion as STEP fi le     360

Save Jetter Automation Motion File     727

Save Library File     39

Save motions for Timing Diagram.     43

Save Rockwell [Allen-Bradley] Logix 5000 Cam file     727

Save screen-image (screen-shot) of graphic-area as:    

BMP     42

GIF     42

JPG     42

PNG     42



893

MechDesigner & MotionDesigner Reference Help 
 
                                                                                                                                               PSMotion Ltd © 2004 - 2025

Index

Save the Style     625

SEGMENT EDITOR     704

SEGMENT EDITOR:    

Control-Button - Possible Settings     711

Motion-Law Selector     709

Segment Number     705

Segment-End     707

Segment-Parameters     715

Segment-Range     712

Segment-Start     707

Segment-Width     707

Y-axis Control-Buttons     709

Y-axis motion-values     709

Segment-Range and Asymmetric Motion     713

Select Elements     616

Select Element-types     68

Selected-Segment    

Delete     719

Selection Filters toolbar     67, 68

Selection-Window     310

Selection-Window shortcut menu    

Delete Element...     310

Edit Element...     310

Rename Element     310

Show or Hide Exrtusion     310

View References     310

Servo Motor Sizing     592

Servomotor Sizing     592

Settings     57

Short cuts     26

Shortcuts     26

Show    

Point Acceleration     543

Point Velocity     543

Show / Hide    

Profile/Extrusions     66

Solids     66

Show / Hide Solid Elements in Mechanism-Editors     66

Show or Hide Kinematic Vectors     543

Show/Hide other Mechanisms in Mechanism-Editor     63

Show/Hide other sketch-elements of other Parts in
Part-Editor     63

SHP     37

Sketch Constraint    

Coincident     306

Concentric     305

Equal     304

Horizontal     298

Mid-Point     301

Parallel     303

Perpendicular     302

Tangent     300

Vertical     299

Sketch Curvature Continuity     549

Sketch Element: Arc     282

Sketch Element: Blend-Curve     286

Sketch Element: CAD-Line     279

Sketch Element: Circle     278

Sketch Element: Line     277

Sketch Element: Point     275

Sketch Element: Spline     284

Sketch Element: Transition-Curve     293

Sketch-Element    

Arc     282

Blend-Curve     286, 549

CAD-Line     279

Circle     278

Line     277

Point     275

Points and Trace-Points     275

Polyline     246

Smoothness     287

SOLIDWORKS Import Sketch     289

Spline     284

Transition-Curve     293

Slide-Joint    

Slide-Joint Special Case     111

Smooth Curve     549

Solids menu    

Add Auto-Profiles     244

Solids toolbar    

MD-Solids     239

SOLIDWORKS    

CAD File Synchronization     337

Import SolidWorks File     337

Synchronize All  Files     337

SolidWorks Type Libraries     76

SolidWorks Type Library     75

SOLIDWORKS: Import Sketch     289

Special Motion-Laws     756

Spin-Box    

Hide and Show     851

How to use the Spin-Box.     631

Where is the Spin-Box?     631

Spin-Increment     631

Spline - alternative     549

Spline Drag-Handles     284

Spring / Linear Motor     538

Spring FB    

Constant Force     234

Coulomb Friction     234

Drag Froce     234

Free-Length     234

Input-Connector     540

Output-Connectors     540

Spring-Rate     234
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Constant-Force     538

Free-Length     538
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Spring FB > Velocity Parameters    

Constant 'Friction' Force     539

Damping Coefficient     539

Drag Factor     539

Spring FB dialog    

Constant Force     538

Drag Force     538

Enable Spring     538

Free Length     538

Friction Force     538

Spring Force Parameters     538

Spring Rate     538

Viscous Force     538

SSP Assur Group     114

SSP Dyad     114

SSR Assur Goup     114

SSR Dyad     114

Standard Motion Laws     755

Statisitics FB dialog     488
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Channel / Derivative     488

Strategies to reduce CAD-Solid fi le-size     376
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Settings     624

Style     624

Theme     624
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Blend-Point     687

Synchronize CAD Files     337
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2D-Cam     128, 199, 222, 640

3D-Cam     128, 199, 222, 640

DXF     371

Gears     141, 566

Pulley / Belt     160, 581

Timing Diagram.xlsx     43

Toggle Hints / Help menu     72

Toolbar    
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Edit     49

File     31

Filters     67

Forces     226

Geometry     265

Kinematic elements     98

Kinematic FBs     169

Machine elements     127

MD-Solids     239

Model elements (Mechanism-Editor)     91

Model elements (Model-Editor)     81

Modeling FBs     206

Run     58

View     70
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Torque-Speed Curves     592

Trace     122

Trace Point     122

Trace-Point    
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Transition-Curve dialog    
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Transition-Path     475

Trouble-shoot Constraints     265

Trouble-shoot Geometry     265

Troubleshooting    

Feedscrews     587

Trouble-shooting    

Mechanism-Editor     663

Troubleshooting - Mechanism-Editor:    

Faceted sketch-elements     663

Profiles are not above the sketch-loop.     663

Trouble-shooting sketch     679

Type Libraries    

Check for Correct Version     75
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Undo     55

Units     351

DXF Drawing Units     354

Update Motion Quickly     734

Useful Gearing Calculations and Equations     572

User Library Path     341

User Preferences     57
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Acceleration     543
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Velocity Vector     543
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Hover + Drag to merge points     672

How to Add a Motion Dimension Function-Block     179

How to Add Pin-Joint     103

Use the Merge-Points tool     672

View menu     70

View References     311, 618

View toolbar     70

icons     70

Visibil ity menu    

Dock or Float MotionDesigner     66

Show Solids in All  or Active Mechanism-Editor only    
66

Visibil ity toolbar     60

Dock or Float MotionDesigner     66
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Show / Hide Torque Vectors     63
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Show Model as Shaded only     65

Show Model as Wire-Frame only     65

Show other Kinematic and sketch-elements     63

Show Solids of All  or Active Mechanism Only     66

Show/Hide Force Vectors     63

Show/Hide other Kinematic and Sketch-Elements     63

- W -
Warning1     244

Why is the dimension 'negative'.     678

Windows Permissions.     13

Windows Settings     13

Working with Large Models     734

Workspace     79

- X -
X-axis value from Y-axis input     464
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